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1 General information on VideoCAD 8 Professional

VideoCAD is a multifunctional tool for professional video surveillance system design,
modeling parameters of video image and video equipment. 
 

VideoCAD allows even the beginners to use the new opportunities appearing to be hard to
obtain without it due to the complexity of calculations and therefore not being used even by
the skilled engineers of CCTV. 
 

VideoCAD practically boosts the quality of CCTV design to a new level which appears to be
beyond any competition with those lacking the program.

Four VideoCAD versions are offered:
 

VideoCAD 8 Professional - the most powerful, professional version with many unique tools.
VideoCAD 8 Lite  - basic version offers the most useful and easy-to-master tools for CCTV
design;
VideoCAD 7 Starter  - easiest, low cost version;
VideoCAD 7 Starter II Kit  - is like the Starter version but with several valuable features  in
addition. Starter II version is offered only in a k it with  IP Camera CCTV Calculator and VideoCAD
Plugin for SketchUp;

 

VideoCAD 8 Professional is registered with USB dongle. All other VideoCAD versions are registered
only by personal registration code. This code doesn't depend on computer hardware or a dongle. This
code is valid on any computer.
 

VideoCAD Starter, VideoCAD Starter II Kit and VideoCAD Lite can be upgraded to VideoCAD 8
Professional at discount price.
 

Licenses of VideoCAD 8 Professional and VideoCAD 8 Lite  allows free use of the demo versions
for educational purposes, for research, theses, writing articles, etc. non-profit activities. 

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

 

The main features of VideoCAD 8 Professional:

Calculations
 

Calculating geometric parameters  of camera view area in any camera position.

Calculating size of the active area of the image sensor in dependence of the aspect ratio of the

31

45

45 45

289

http://www.cctvcad.com/CCTVCAD_Calculator.html
http://www.cctvcad.com/CCTVCAD-Import_3D_models.html
http://www.cctvcad.com/CCTVCAD-Import_3D_models.html
http://www.cctvcad.com/CCTVCAD-Information.html
http://www.cctvcad.com/CCTVCAD-Information.html
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image sensor and the aspect ratio of the output image of the camera.

  

Calculating horizontal projection sizes of person detection, identification and license plate reading
areas.

Calculating Depth of Field  of each camera of the project.454
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Calculating the image size on display of any object  in camera view area in percentage of display
size, pixels and millimetres (inches in case of Imperial format). 

Calculate length  and electric parameters of cables . 

507

590 515
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Calculate light power and illumination produced by illuminators .

Working with 2D projections
 

Use 2D Graphics window with CAD interface . Use a lot of 2D/3D constructions and CAD tools,
line types, font types, snaps , horizontal and vertical projections, up to 10 layouts in each
project, unlimited number of layers .

461

161

209

276
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Display on the 2D layout results of calculations : view area projections, person detection and
identification areas, depth of field limits, test object, cables and luminaries.
 

Display by separate colors and hatch styles different regions of spatial resolution  and field-of-
view size. There are prepared spatial resolution patterns according to the following criteria: Home
Office Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.

3

177
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Construct the horizontal projection of  camera control areas including shadows  from obstacles
on the scene. 

Choose the best positions and calculate control areas of PTZ cameras , Dome cameras and 360
degree cameras.

178

583
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Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras  (fisheye, 360°/180°).

 

Modeling camera rotation  around the main optical axis. 
 

626

297
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Modeling lens distortion . Modeling influence of the lens distortion on view area shape, on view
area projection shape and spatial resolution distribution.Correct modeling wide-angle lenses with
strong distortion.

3D modeling layout and camera view areas
 

VideoCAD has special 3D World  window with standard tools for 3D navigation  (Orbit, Move,
ZOOM, Walk, Look around, Zoom frame).  With the help of the window you can observe the
layout in 3D representation. You can work on the project in usual 2D projections and watch it in 3D.
You can "walk" on the floors of 3D models of buildings and study every detail.

 

654

342 343
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3D visualization of the camera view area surface  taking into account spatial resolution,
shadows, lens distortion.

3D visualization of the active camera coverage  on the environment taking into account spatial
resolution, shadows, lens distortion.

346

348
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3D visualization of control areas of PTZ cameras , Dome cameras and 360 degree cameras.

Visualization of camera coverage area and spatial resolution distribution on the surrounding objects
of panoramic cameras  (fisheye, 360°/180°).

583

626
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Free cutting  3D layout by six planes to provide access to any point of complex 3D buildings.

 

Working with multilevel  3D layouts and terrains with complicated vertical structure.

352

600
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Possibility of loading prepared 3D models  (a person, a car, etc., ). You can add your own 3D
models from 3ds max and Sketchup .

Possibility of using  3D models-territories , to place inside them cameras, constructions and
other 3D models.

Modeling images from cameras based on camera parameters and scene

conditions
 

Modeling observed scene  parameters (illumination, visibility limitations).

259

599

600

371
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Model luminaires  considering spectrum of radiation and spectral sensitivity of image sensors,
including discharge lamps with complex spectrum and infrared LED illuminators.

Model camera parameters  (spectral response, number of pixels, resolution, minimum
illumination  at known signal/noise ratio, IRE and aperture, maximum signal/noise ratio,
electronic shutter, AGC, BLC, gamma, day/night cameras,frame rate , interlace scan, global
shutter and rolling shutter).

461

329

334

375
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Model lens parameters  (focal length, aperture, auto iris DC and Video Drive, resolution).

Visually control modeled resolution with the help of the Test chart

339

388
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Model images from megapixel cameras  with number of pixels exceeds Windows screen
number of pixels (Up to 100 megapixel and more!) with PiP  (Picture in Picture) and without
PiP. 

See examples: 5 megapixels,10 megapixels, 25 megapixels. 

573

391

http://cctvcad.com/Files/images/Camera5MP.png
http://cctvcad.com/Files/images/Camera10MP.png
http://cctvcad.com/Files/images/Camera25MP.png
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Calculate and model depth of field  of each camera in project.

 

Model brightness , contrast, compression, horizontal and vertical sharpness.

454

381

http://cctvcad.com/Files/images/Camera25MP.png


General information on VideoCAD 8 Professional 19

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Model moving objects , camera frame rate , create animated images  with moving 3D
models.

 

Model blur and distortion  of moving 3D models depending on camera parameters (exposure
time, interlacing, rolling shutter).

203 575 386

585
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 Modeling images taking into account lens distortion  (barrel and pincushion). Correct modeling
wide-angle lenses with strong distortion.

Simulation of image resolution and view area limits of panoramic cameras  (fisheye,
360°/180°).

Obtain Image Model  for each camera in the project based on models of scene and equipment. 

Design operator interface
 

Design operator interface using the Monitor window .

654

312

357

407
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Modeling size and resolution  of monitors.
 

Create animated monitor models  as html files with moving 3D models and different frame rates
of each camera. See an example of animated monitor (file size about 4 Mb).

Import from other CAD programs

 Locate cameras and cables on the prepared layouts  in *.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf.  AutoCAD *.dxf *.dwg  formats.
 

For backgrounds in AutoCAD *.dxf *.dwg  formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.
 

Import  constructions  from a 2D background in AutoCAD formats to 3D VideoCAD constructions
automatically. Use of this tool allows to reduce efforts of outlining background to convert it to 3D
constructions.

411

577

222

224

http://cctvcad.com/monitor/Monitor_1.html
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Import 3D models of objects and 3D models of territory  using VideoCAD plugin for SketchUP
.

Import raster images  to display them in 3D.

602 599

205
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Import camera model parameters to the Table of camera models via copying and pasting
from Excel.

Export
 

Export  the 2D drawing into any of the following formats:*.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif,  *.pdf (raster and vector), AutoCAD *.dxf, AutoCAD *.dwg, PLT (HPGL/2), CGM (Computer
Graphic Metafile), SWF (Adobe Flash).
 

Advanced export to AutoCAD formats. At exporting to AutoCAD DWG and DXF formats, cameras
and illuminators are exported as blocks. The most important parameters of cameras and
illuminators are recorded to the block attributes. VideoCAD layers, fonts and line types are
exported.
 

When you export a drawing with a background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers  or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
 

Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing  in AutoCAD format as a background;
2. Import  AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
4. Export  the obtained drawing to AutoCAD format to work with it in AutoCAD.

428

219

486

222

224

219
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Export to DXF file 3D view areas  and camera coverage  taking into account lens distortion,
spatial resolution, and shading.
 

This feature allows the convenient scheme of work with combination of 3D BIM Software
(SketchUP) + VideoCAD.

1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with
the original layout in 3D.

Export images from the 3D World  window to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
png. Size in pixels of the exported file can exceed  the Windows screen size.
 

Export 3D images  from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.png.
Size in pixels of the exported file can exceed  the Windows screen size.
 

Export animated image models  with moving 3D models to animated gif. See an example of
animated monitor (file size about 4 Mb).
 

Export images from monitors  to *.bmp, *.jpg,*.gif,*.tif,*.png.

354 355

342

354

360

573

360

412

http://cctvcad.com/monitor/Monitor_1.html
http://cctvcad.com/monitor/Monitor_1.html
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Export images from monitors to animated monitor models  as html files, with moving 3D models,
taking into account frame rate of each camera.
 

Obtain the text report  with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
 

Get a  report in PDF format , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See  example of PDF report.
 

Obtain the cable report .
 

Copy the Camera list with most important parameters  to MS Excel, MS Word and other
software.

Get detailed adjustable table  of all initial and calculated parameters of cameras in project. Print
the table or export it to *.txt, *.csv,*.rtf, *.xls, *.htm formats.

577

216

216

271

509

443

http://www.cctvcad.com/Files/Project1.pdf
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Printing
 

Printing  the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
 

Printing image models from cameras  and monitors .
 

Printing 3D images from the 3D World  window.
 

Printing the Table of cameras  and the Table of camera models  as a whole or by selected
fragments.

Database of camera models
 

Maintain database of camera models , assign different models to cameras in project, compare
models with each other. 

226

360 412

356

450 429

419
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VideoCAD will help you: spare the means and win tenders due to optimization of cameras' quantity in
projects and increase of their efficiency, reduce time expended and boost design quality, cut down
the amount of controversial situations with customers and accelerate their solution.
 

VideoCAD can be used for the prompt, but exact calculations of view area projections to draw on a
location plan when performing a graphical part of CCTV project. It can be also used to perform
scrupulous analysis complicated cases to choose the most suitable camera location and lens
parameters. 
 

VideoCAD is employed by security firms, army, police, universities and security department of many
companies worldwide.
 

VideoCAD is effective for CCTV designer training .
 
It is more than you need? See:

VideoCAD Lite , Differences between VideoCAD 8 Professional and VideoCAD 8 Lite
VideoCAD Starter II ,  Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II
VideoCAD Starter , Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter

Differences between versions of VideoCAD
 

What is new in VideoCAD

645

31 53

45 75

49 85

53

89

http://www.cctvcad.com/CCTVCAD-Customers.html
http://www.cctvcad.com/CCTVCAD-Customers.html
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2 General information on VideoCAD 8 Lite

VideoCAD Lite is a basic version offers the most useful and easy-to-master tools for CCTV design.
 

If VideoCAD Professional  version seems too complicated or slow, try the Lite version! It does not
contain complex tools. At the same time VideoCAD Lite is a powerful tool, not a very restricted
version. 
 

VideoCAD Lite is less demanding of computer resources because of absence of resource-intensive
tools. However, these tools when they are not needed, can be disabled  in version Professional
too.
 

VideoCAD 8 Lite is registered only by personal registration code. This code doesn't depend on
computer hardware (HID) or a dongle. This code is valid on any computer.
 

VideoCAD Lite purchased separately can be upgraded to more powerful Professional version.
 

VideoCAD Starter, VideoCAD Starter II Kit  can be upgraded to VideoCAD Lite at discount price.
 

One license of VideoCAD 8 Lite purchased separately allows to use the program on two workplaces
nonsimultaneously (work and home computers) if both workplaces belong to one person.
 

VideoCAD 8 Lite demo allows to change lens focal length of cameras. Licenses of VideoCAD 8
Professional and VideoCAD 8 Lite  allows free use of the demo versions for educational
purposes, for research, theses, writing articles, etc. non-profit activities. 

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

The main features of VideoCAD 8 Lite:

Calculations
 

Calculating geometric parameters  of camera view area in any camera position.

More accurate modeling cameras taking into account the size of active area of the image sensor in
dependence of the aspect ratio of the image sensor and the aspect ratio of the output image of the
camera.

3

650

289

http://www.cctvcad.com/VideoCAD_Lite.html
http://www.cctvcad.com/VideoCAD_Lite.html
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Calculate length  and electric parameters of cables . 

Working with 2D projections
 

Use 2D Graphics window with CAD interface . Use a lot of 2D/3D constructions and CAD tools,
line types, font types, snaps , horizontal and vertical projections, up to 10 layouts in each
project.

590 515

161

209
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Display on the 2D layout results of calculations of view area projections.
 

Display by separate colors and hatch styles different regions of spatial resolution  and field-of-
view size. There are prepared spatial resolution patterns according to the following criteria: Home
Office Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.

177
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Construct the horizontal projection of  camera control areas including shadows  from obstacles
on the scene. In VideoCAD Lite  obstacles can be constructions only. In VideoCAD Professional

 3D models also can be obstacles.

Choose the best positions and calculate control areas of PTZ cameras , Dome cameras and 360
degree cameras.

178

3

583
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Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras  (fisheye, 360°/180°).

3D modeling layout and camera view areas
 

3D visualization of the location plan and camera view areas in the 3D Video  window by other
cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view areas from
the side.

626

357
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Possibility of loading prepared 3D models  (a person, a car, etc., ). You can add your own 3D
models from 3ds max and Sketchup .

In special 3D models  window you can create 3D model projections  with specified resolution.
You can load 3D models from files, save 3D models to files, create copies of 3D models

259

599

397 401
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Modeling images from cameras based on camera parameters and scene

conditions
 

Model camera parameters: number of pixels and compression.

Simulation of image resolution and view area limits of panoramic cameras  (fisheye, 360°/180°).312
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Obtain Image Model  for each camera in the project based on models of scene and equipment. 

Design operator interface
 

Design operator interface using the Monitor window .

Modeling size and resolution  of monitors.

357

407

411



General information on VideoCAD 8 Lite 39

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Import from other CAD programs

 Locate cameras and cables on the prepared layouts  in *.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf.  AutoCAD *.dxf *.dwg  formats.
 

For backgrounds in AutoCAD *.dxf *.dwg  formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.
 

Import 3D models of objects and 3D models of territory  using VideoCAD plugin for SketchUP
.

Import raster images  to display them in 3D.

Import camera model parameters to the Table of camera models via copying and pasting
from Excel.
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Export
 

Export  the 2D drawing into any of the following formats:*.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif,  *.pdf (raster), AutoCAD *.dxf.
 

Export 3D images  from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.png.
 

Export images from monitors  to *.bmp, *.jpg,*.gif,*.tif,*.png.
 

Obtain the text report  with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
 

Get a  report in PDF format , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See  example of PDF report.
 

Obtain the cable report .
 

Copy the Camera list with most important parameters  to MS Excel, MS Word and other
software.

Printing
 

Printing  the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
 

Printing image models from cameras  and monitors .
 

Printing the Table of camera models  as a whole or by selected fragments.

Database of camera models
 

Maintain database of camera models  with the most important parameters (22 fields for each
camera model). You can add your models, assign different models to cameras in project, compare
models with each other. 
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Download VideoCAD 8_Lite demo version

Need more? See: VideoCAD Professional , Differences between VideoCAD 8 Professional
and VideoCAD 8 Lite
 

It is more than you need? See:
VideoCAD Starter II ,  Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II

VideoCAD Starter , Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter

Differences between versions of VideoCAD
 

What is new in VideoCAD
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3 General information on VideoCAD 7 Starter II

VideoCAD Starter II - advanced version of VideoCAD Starter .
 

VideoCAD Starter II differs from the Starter version by presence of  additional features  formerly
available in the Lite and Professional versions only. 
 

VideoCAD Starter II is registered only by personal registration code. This code doesn't depend on
computer hardware (HID) or a dongle. This code is valid on any computer.
 

VideoCAD Starter II is offered only in a kit of three programs - VideoCAD Starter II Kit. This Kit
includes:
 

VideoCAD Starter II;
IP Camera CCTV Calculator;
VideoCAD Plugin for SketchUp.

VideoCAD Starter II can be upgraded to more powerful Lite  and Professional  versions. You
can also upgrade from version VideoCAD Starter  to VideoCAD Starter II Kit. To get this upgrade
you should purchase VideoCAD Plugin for SketchUp and IP Camera CCTV Calculator if you have not
purchased them yet.

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

With VideoCAD 7 Starter II you can:
 

Choose the most suitable lenses, heights and locations for camera installation to provide the
required parameters of view areas.

 

Calculate the horizontal projection sizes of view areas to draw them on the location plan.
 

Display by separate colors different regions of spatial resolution  and field-of-view size.
 

Choose visually a relative location of cameras using the graphics window  with CAD interface. 
 

Locate cameras on the prepared layouts  in *.bmp, *.jpg, AutoCAD *.dxf *.dwg formats.
 

Obtain a drawing  containing horizontal projection of site layout with the camera images,
calculated view areas, and with coordinate grid to be used in graphical path of the project.

 

Export  the obtained drawing into any of the following formats: *.bmp, *.jpg. Saving the drawing
 in the Graphics windows with resolution exceeding Windows screen resolution.

 

Copy the Camera list with most important parameters  to MS Excel, MS Word and other
software.

 

Construct three dimensional models  of real scenes.
 

Use many 3D models  (people, cars, bus, furniture, turnstile, tree, grass). You can add other 3D
models from 3ds max and Sketchup .

Spare the means and win tenders due to the reduction of cameras' quantity in projects
and increase of their efficiency. 
Reduce time expended and boost design quality. 
Cut down the amount of controversial situations with customers and accelerate their
solution.
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Download VideoCAD Starter II demo version

Need more? See:
VideoCAD Lite ,  Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II
VideoCAD Professional , Differences between VideoCAD 8 Professional and VideoCAD 8
Lite

It is more than you need? See: VideoCAD Starter , Differences between VideoCAD 7 Starter
II and VideoCAD 7 Starter

 

Differences between versions of VideoCAD
 

What is new in VideoCAD
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4 General information on VideoCAD 7 Starter

VideoCAD Starter  - the easiest, low cost version of VideoCAD.
 

VideoCAD Starter is less demanding of computer resources because of absence of resource-
intensive tools. 
 

VideoCAD Starter is registered only by personal registration code. This code doesn't depend on
computer hardware or a dongle. This code is valid on any computer.
 

VideoCAD Starter can be upgraded to more powerful Lite  and Professional  versions. You can
also upgrade from version VideoCAD Starter to VideoCAD Starter II Kit  To get this upgrade you
should purchase VideoCAD Plugin for SketchUp and IP Camera CCTV Calculator if you have not
purchased them yet.

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

With VideoCAD 7 Starter you can:
 

Choose the most suitable lenses, heights and locations for camera installation to provide the
required parameters of view areas.

 

Calculate the horizontal projection sizes of view areas to draw them on the location plan.
 

Display by separate colors different regions of spatial resolution  and field-of-view size.
 

Choose visually a relative location of cameras using the graphics window  with CAD interface. 
 

Locate cameras on the prepared layouts  in *.bmp, *.jpg formats.
 

Obtain a drawing  containing horizontal projection of site layout with the camera images,
calculated view areas, and with coordinate grid to be used in graphical path of the project.

 

Export  the obtained drawing into any of the following formats: *.bmp, *.jpg.
 

Copy the Camera list with most important parameters  to MS Excel, MS Word and other
software.

 

Construct three dimensional models  of real scenes with the possibility of loading prepared 3D
models  (a person, a car).

Spare the means and win tenders due to the reduction of cameras' quantity in projects
and increase of their efficiency. 
Reduce time expended and boost design quality. 
Cut down the amount of controversial situations with customers and accelerate their
solution.

Download VideoCAD7 Starter demo version

Need more? See:
VideoCAD Starter II , Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter

VideoCAD Lite ,  Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II
VideoCAD Professional , Differences between VideoCAD 8 Professional and VideoCAD 8
Lite
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Differences between versions of VideoCAD
 

What is new in VideoCAD
 

What is new in VideoCAD
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5 Differences between versions of VideoCAD

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

Differences between VideoCAD 8 Professional  and VideoCAD 8 Lite

Calculations
 

Calculating horizontal projection sizes of person detection, identification and license plate reading
areas.

Calculating Depth of Field  of each camera of the project.

Calculating the image size on display of any object  in camera view area in percentage of display
size, pixels and millimetres (inches in case of Imperial format). 
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Calculate light power and illumination produced by illuminators .

Working with 2D projections
 

Graphical editing state of the Active camera  . In this case the objects in the horizontal
projection rotate so that the direction of the camera lens main optical axis becomes parallel to a
screen plane, and the bounds of active camera view area are marked with lines of double
thickness. The graphical editing state enables a detailed analysis of view area using the test
object , in the vertical projection it becomes possible graphical calculation of depth of field,

 spatial resolution analysis and field-of-view sizing  at any point of view area. In the
graphical editing state the Test object is visible in the 3D Video .
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Ability to display horizontal projection of the view area as two sections  by planes on the
minimum and maximum heights of the view area (Camera 23). One of the sections is drawn by a
transparent filling, the other in the form of hatching. In many camera positions such representation
is more informative than standard volume projection (Camera 22).

175
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Constructions, 3D models and cameras can be distributed by layers . Each layer can have its
own Base height . All constructions belong to the layer will be shifted in 3D by the Base height.
This feature is useful in work with multilevel 3D constructions. In addition to the Base height, each
layer has the following parameters : Active, Enabled, Visible, Hidden, Snap, Shadows, 3D
Visible, Color.

Display on the 2D layout results of calculations : person detection and identification areas, depth
of field limits, test object, cables and luminaries.
 

Construct the horizontal projection of  camera control areas including shadows  from obstacles
on the scene. In VideoCAD Lite  obstacles can be constructions only. In VideoCAD Professional

 3D models also can be obstacles.
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Modeling camera rotation  around the main optical axis. 
 

Modeling lens distortion . Modeling influence of the lens distortion on view area shape, on view
area projection shape and spatial resolution distribution.Correct modeling wide-angle lenses with
strong distortion.

An option for drawing regions of spatial resolution in the Graphics windows in ascending
resolution - High resolution on top . With this option enabled all cameras remain visible despite
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the shading of projections of different cameras. While regions with higher spatial resolution are
drawn on the top.

Usual drawing High resolution on top

3D modeling layout and camera view areas
 

VideoCAD Professional has special 3D World  window with standard tools for 3D navigation  (
Orbit, Move, ZOOM, Walk, Look around, Zoom frame).  With the help of the window you can
observe the layout in 3D representation. You can work on the project in usual 2D projections and
watch it in 3D. You can "walk" on the floors of 3D models of buildings and study every detail.

 

342 343
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3D visualization of the camera view area surface  taking into account spatial resolution,
shadows, lens distortion.

3D visualization of the active camera coverage  on the environment taking into account spatial
resolution, shadows, lens distortion.
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3D visualization of control areas of PTZ cameras , Dome cameras and 360 degree cameras.

Visualization of camera coverage area and spatial resolution distribution on the surrounding objects
of panoramic cameras  (fisheye, 360°/180°).
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Free cutting  3D layout by six planes to provide access to any point of complex 3D buildings.

 

Working with multilevel  3D layouts and terrains with complicated vertical structure.
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Possibility of using  3D models-territories , to place inside them cameras, constructions and
other 3D models.

The Base height  in the camera geometry parameters. All heights related to a camera  (height of
installation, heights of the lower and upper bounds of view area, heights of person detection,
identification, license plate reading areas) counted from the base height. The Base height together
with layers  is used in work with multilevel 3D constructions.

More capabilities of the 3D models  window. In the window you can create 3D model
projections  with specified brightness, create projection in the form of faces, points and lines.
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Ability to make projections in the form of sections of 3D models  at the specified range of
heights. These projections of 3D models of buildings can be used as background for placing
cameras in the Graphics window.  

401
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Ability to create 3D model projections with exceeding  Windows screen resolution. 
Possibility to create a projection of individual area of 3D model with even higher resolution using 
PiP  (Picture in Picture) tool.
To use the 3D models as territories, and their projections as a background, a new ability to block

 the projection of certain 3D models from selection by mouse click was added.  
Ability to consider a 3D model as obstacle in the calculation of shadows .
In the 3D Models window you can also  earn  3D models using 3D interface similar to the 3D
World  window.
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Modeling images from cameras based on camera parameters and scene

conditions
 

Modeling observed scene  parameters (illumination, visibility limitations).

Model luminaires  considering spectrum of radiation and spectral sensitivity of image sensors,
including discharge lamps with complex spectrum and infrared LED illuminators.
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Model camera parameters  (spectral response, number of pixels, resolution, minimum
illumination  at known signal/noise ratio, IRE and aperture, maximum signal/noise ratio,
electronic shutter, AGC, BLC, gamma, day/night cameras,frame rate , interlace scan, global
shutter and rolling shutter).
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Model lens parameters  (aperture, auto iris DC and Video Drive, resolution).

Visually control modeled resolution with the help of the Test chart
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Model images from megapixel cameras  with number of pixels exceeds Windows screen
number of pixels (Up to 100 megapixel and more!) with PiP  (Picture in Picture) and without
PiP. 

See examples: 5 megapixels,10 megapixels, 25 megapixels. 
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Calculate and model depth of field  of each camera in project.

 

Model brightness , contrast, horizontal and vertical sharpness.
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Model moving objects , camera frame rate , create animated images  with moving 3D
models.

 

Model blur and distortion  of moving 3D models depending on camera parameters (exposure
time, interlacing, rolling shutter).

203 575 386
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 Modeling images taking into account lens distortion  (barrel and pincushion). Correct modeling
wide-angle lenses with strong distortion.

Design operator interface
 

Create animated monitor models  as html files with moving 3D models and different frame rates
of each camera. See an example of animated monitor (file size about 4 Mb).

Import from other CAD programs

Import  constructions  from a 2D background in AutoCAD formats to 3D VideoCAD constructions
automatically. Use of this tool allows to reduce efforts of outlining background to convert it to 3D
constructions.

Export
 

Export  the 2D drawing into any of the following formats: *.pdf (vector), AutoCAD *.dwg, PLT
(HPGL/2), CGM (Computer Graphic Metafile), SWF (Adobe Flash).
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Advanced export to AutoCAD formats. At exporting to AutoCAD DWG and DXF formats, cameras
and illuminators are exported as blocks. The most important parameters of cameras and
illuminators are recorded to the block attributes. VideoCAD layers, fonts and line types are
exported.
 

When you export a drawing with a background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers  or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
 

Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing  in AutoCAD format as a background;
2. Import  AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
4. Export  the obtained drawing to AutoCAD format to work with it in AutoCAD.

Export to DXF file 3D view areas  and camera coverage  taking into account lens distortion,
spatial resolution, and shading.
 

This feature allows the convenient scheme of work with combination of 3D BIM Software
(SketchUP) + VideoCAD.

1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with
the original layout in 3D.

486

222

224

219

354 355



Differences between versions of VideoCAD 73

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Export images from the 3D World  window to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
png. Size in pixels of the exported file can exceed  the Windows screen size.
 

During export 3D images  from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
png, size in pixels of the exported file can exceed  the Windows screen size.
 

Export animated image models  with moving 3D models to animated gif. See an example of
animated monitor (file size about 4 Mb).
 

Export images from monitors to animated monitor models  as html files, with moving 3D models,
taking into account frame rate of each camera.

Get detailed adjustable table  of all initial and calculated parameters of cameras in project. Print
the table or export it to *.txt, *.csv,*.rtf, *.xls, *.htm formats.
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Printing
 

Printing 3D images from the 3D World  window.
 

Printing the Table of cameras  as a whole or by selected fragments.

Database of camera models
 

Maintain database of camera models  with extended parameters (up to 117 camera parameters),
assign different models to cameras in project, compare models with each other. 

Registration
 

VideoCAD 8 Professional is registered with USB dongle. All other VideoCAD versions are
registered only by personal registration code. This code doesn't depend on computer hardware or a
dongle. This code is valid on any computer.
 

You can install VideoCAD 8.2 Professional on many computers, but launch on one computer with
dongle connected. One license of VideoCAD 8 Lite, purchased separately, allows to use the
program on two workplaces nonsimultaneously (work and home computers) if both workplaces
belong to one person - owner of the license.

Demo version
 

You can't change lens focal length, lens aperture, image sensor format, aspect ratio and light
sensitivity in the demo-version of VideoCAD Professional. You may install the demo-version of
VideoCAD Professional to test and evaluate it for 30 days; after this time you must either buy the
license to use the VideoCAD Professional permanently or delete the demo version from your hard
drive.
 

In the demo version of VideoCAD 8 Lite changing lens focal length and image sensor is allowed.
Instead of this, saving working project to a file is prohibited and there is a limit on the maximum
number of cameras (5) in one project.
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Differences between VideoCAD 8 Lite  and VideoCAD Starter II

Calculations
 

More accurate modeling cameras taking into account size of active area of the image sensor in
dependence of the aspect ratio of the image sensor and the aspect ratio of the output image of the
camera. Model cameras with non standard image sensor size  and aspect ratio.

  

Calculate length  and electric parameters of cables . 

Working with 2D projections
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Use more than 30 additional constructions and CAD tools (Point, Horizontal line, Vertical line,
Line segment, Angle, Double line, Arc, Mask, Filling, Text, 3D image, Inclined rectangle, Change
installation height, Change view area upper bound, Change view area lower bound, Copy with base
point, Cut with base point, Scale, Mirror, Change line type, Hide camera names, Cameras over
constructions, Bring to front, Send to back, Hide, Align, Combine in block, Destroy block, Find
text, Hidden state of objects, Numerate cameras, Length calculation of line segments,Merge
contour, High resolution on top).

Work with vertical projection  of the site plan.187
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More convenience in editing on the layout 3D models, Rectangle, Wall, Aperture in wall, Stairs,
Mask, Filling, 3D Image. You can scale them and rotate around its axis using the square grips and
pink circle.

Use Titles  and texts  on the drawing. Different fonts  are supported.
 

Use up to 10 layouts  in each project.
 

Use up to 30 spatial resolution patterns  in each project. Each pattern can contain up to 10
regions. Adjust object height  in the patterns,  height of measuring spatial resolution ,
direction (horizontal or vertical) of  measuring spatial resolution. The Spatial resolution box contains
models of field-of-view images  for each region in current pattern.
 

There are prepared spatial resolution patterns according to the following criteria: Home Office
Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.
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Use gradient color and hatching for visualization of spatial resolution.
 

Show view area projections by different colors and hatch styles, using different line types. 
 

Use different camera icons ( fixed, PTZ, outdoor..). 

Construct the horizontal projection of  camera control areas including shadows  from obstacles
on the scene. In VideoCAD Lite  obstacles can be constructions only. In VideoCAD Professional

 3D models also can be obstacles.
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Choose the best positions and calculate control areas of PTZ cameras , Dome cameras and 360
degree cameras.

Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras  (fisheye, 360°/180°).
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Adjust keyboard shortcuts  for each item in the Main menu. 
 

Adjust visibility  of buttons on the Toolbar.

3D modeling layout and camera view areas
 

3D visualization of the location plan and camera view areas in the 3D Video  window by other
cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view areas from
the side.

In special 3D models  window you can create 3D model projections  with specified resolution.
You can load 3D models from files, save 3D models to files, create copies of 3D models
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Support of 3D models with textures, transparent texture and opacity of materials. New version of 
VideoCAD Plugin for SketchUP with possibilities of export textures, transparent textures,
opacity of materials and scaling. 

Modeling images from cameras based on camera parameters and scene

conditions
 

Simulation of image resolution and view area limits of panoramic cameras  (fisheye, 360°/180°).312
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Obtain Image Model  for each camera in the project based on models of scene and equipment. 

Design operator interface
 

Design operator interface using the Monitor window .

Modeling size and resolution  of monitors.
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Import from other CAD programs

 Locate cameras and cables on the prepared layouts  in formats  *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf. Upgraded AutoCAD import modules can read much more CAD files.
 

For backgrounds in AutoCAD *.dxf *.dwg  formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.
 

Import raster images  to display them in 3D.

Import camera model parameters to the Table of camera models via copying and pasting
from Excel.

Export
 

Export  the 2D drawing into any of the following formats: *.emf, *.wmf, *.png, *.gif, *.tif,  *.pdf
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(raster), AutoCAD *.dxf.
 

Export images from monitors  to *.bmp, *.jpg,*.gif,*.tif,*.png.
 

Obtain the text report  with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
 

Get a  report in PDF format , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See  example of PDF report.
 

Obtain the cable report .

Printing
 

Printing  the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
 

Printing image models from cameras  and monitors .
 

Printing the Table of camera models  as a whole or by selected fragments.

Database of camera models
 

Maintain database of camera models  with the most important parameters (22 fields 22 fields for
each camera model). You can add your models, assign different models to cameras in project,
compare models with each other. 

Registration
 

One license of VideoCAD Starter II allows to use VideoCAD Starter II on one computer. One
license of VideoCAD 8 Lite, purchased separately, allows to use the program on two workplaces
nonsimultaneously (work and home computers) if both workplaces belong to one person - owner of
the license.
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Package contents 
 

VideoCAD Starter II is offered only in a kit of three programs - VideoCAD Starter II Kit. This Kit
includes: 

    VideoCAD Starter II;
    IP Camera CCTV Calculator;
    VideoCAD Plugin for SketchUp.

Demo version
 

 In the demo version of VideoCAD 8 Lite there is a limit on the maximum number of cameras (5) in
one project.
 

License of VideoCAD 8 Lite allows free use of the demo version for educational purposes, for
research, theses, writing articles, etc. non-profit activities. 

 

Differences between VideoCAD 7 Starter II  and VideoCAD 7 Starter

Possibility of using 3D models  from version Lite (people, trees, cars etc.).
 

Possibility of import 3D models and scenes from SketchUp and Autodesk 3ds MAX; VideoCAD
Plugin for  SketchUp is included in the VideoCAD Starter II Kit.

 

Loading background  in AutoCAD *.dxf and *.dwg formats.
 

Saving the drawing  in the Graphics windows with resolution exceeding Windows screen
resolution.

 

Additional constructions and CAD tools: Rotakin  (without modeling rotation), Copy  and
 Paste  constructions and cameras.

 

Modeling number of pixels  and JPEG compression  in the 3D window.
 

Displaying examples of images  in the Spatial resolution box (resolution only).
 

Modeling cameras with any image sensor sizes and aspect ratio.
 

Modeling images from cameras turned by 90 degrees .

VideoCAD Starter II is offered only in a k it of three programs - VideoCAD Starter II Kit. This Kit
includes:
 

    VideoCAD Starter II;
    IP Camera CCTV Calculator;
    VideoCAD Plugin for SketchUp.

Download VideoCAD 8 Professional demo version

Download VideoCAD 8_Lite demo version
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Download VideoCAD 7 Starter II demo version

Download VideoCAD 7 Starter demo version

What is new in VideoCAD 89

http://www.cctvcad.com/Files/videocad_starter2demo.zip
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6 What is new in VideoCAD

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

What is new in VideoCAD 8.2 Lite  (April 2016)
 

What is new in VideoCAD 8.1  (18 May 2015)
 

What is new in VideoCAD 8.0  (September 2014)
 

What is new in VideoCAD 7.0  (March 2011)
 

What is new in VideoCAD 6.1  (October 2008)
 

What is new in VideoCAD 6.0  (October 2007)
 

What is new in VideoCAD 5.0  (April 2006)
 

What is new in VideoCAD 4.0  (April 2005)
 

What is new in VideoCAD 3.0  (June 2004)

8.L. What is new in VideoCAD 8.2 Lite

New features of VideoCAD 8 Lite have been chosen from features, available in VideoCAD 8
Professional.  In addition: The registration rules  have been simplified, Functional and license
restrictions of the demo version  have been reduced,  Upgrade  from VideoCAD Starter
and VideoCAD Starter II Kit   to VideoCAD Lite  and VideoCAD Professional  has been
allowed.

MORE PRECISE MODELING  IMAGE SENSOR SIZES AND ASPECT RATIO OF MODERN
CAMERAS
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8L.1 The following parameters have been separated:
 

image sensor size and size of active area of the image sensor; 
aspect ratio of image sensor and aspect ratio of output image of the camera. 

8L.2 The Image sensor format box has been renamed to the Image sensor size .
8L.3 New abilities to specify the size of image sensor  through arbitrary sensor format (type) in
inches or through the length of diagonal in millimeters, or through width and height in millimeters. 
8L.4 New ability to set aspect ratio of image sensor separately from the aspect ratio of output
image for a given format in inches or length of diagonal of the image sensor.
8L.5 New ability to set the Crop factor  to model image sensors with active area does not
touch the edges of the image sensor.
8L.6 Detailed guide  of specifying the active area size of image sensors of modern cameras
has been added.
8L.7 The Sensor and Distortion box has been renamed to Sensor and Lens . Its interface
has been changed. 
8L.8 The Image sensor calculator  was added.

IMPROVING USABILITY OF WORKING WITH 3D MODELS AND CONSTRUCTIONS IN
EDITING STATE
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8L.9 Switching 3D models  from the selected state  to the editing state  by double
clicking on its projections was added (previously it was possible to switch a 3D model to the
editing state only from the normal state ).
8L.10 In the editing state , 3D models  are displayed with square grips and pink circle.
You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.

8L.11 In the  3D Video  views of 3D models in editing state and in the selected state differ.

8L.12 New possibility to rotate around its axis in editing state Rectangle, Wall, Aperture in wall,
Stairs, Mask, Filling, 3D Image. 

MODELING VIEW AREA AND CAMERA POSITION

8L.13 The Style of line type  assigned to a
camera determines not only style of lines, but
hatching style of view area projection. 
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8L.14 The Maximum distance  of drawing view area is added to the camera geometry
parameters. This distance limits view area in 2D and 3D drawings. It is convenient in case of
infinite view areas.
8L.15 The ground is no longer the lowest possible height limiting view area. Height of installation,
heights of the lower and upper bounds of view area can be negative. A camera can see from under
the ground and under the ground.

8L.16 Constructing the horizontal projection of  camera control areas including shadows  from
obstacles on the scene. In VideoCAD Lite  obstacles can be constructions only. In VideoCAD
Professional  3D models also can be obstacles.

8L.17 Choosing the best positions and calculate control areas of PTZ cameras , Dome
cameras and 360 degree cameras.
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MODELING PANORAMIC CAMERAS (FISHEYE, 360°/180°)

8L.18 Simulation of image resolution and view area limits of panoramic cameras  in the 3D
Video.

8L.19 Model spatial resolution of panoramic cameras in the 3D Video window.

626
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8L.20 Simulation of the horizontal projection of the view area and visualization of the spatial
resolution distribution of panoramic cameras  in the Graphics window.

8L.21 New icons  for panoramic cameras were added  and  .
8L.22 In the Sensor and Lens  box a new
Panoramic panel was added. On the panel the
Pan and Tilt angles of panoramic camera
installation can be specified.

8L.23 To the list of camera model parameters : Type>Fixed, PTZ,Dome, Mini a new panoramic
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item was added,
8L.24 To the list of camera model parameters: Lens>Type a new fisheye item was added,
8L.25 Lens focal length boxes in the Graphics window and the Camera geometry box are colored

in Aqua when the active camera is panoramic. .
8L.26 In reports  panoramic cameras have fisheye word instead of lens focal length value;

WORK WITH 3D MODELS

8L.27 Support of 3D models with textures, transparent texture and opacity of materials. 
8L.28 New version of VideoCAD Plugin for
SketchUP was released with possibilities of
export textures, transparent textures, opacity
of materials and scaling. 
 

8L.29 Import of new 3D models was simplified. The special 3D models  window was added  for
creation of 3D model projections. In the window , you can create 3D model projections  with
specified resolution.  In the 3D Models window you can also : save 3D model to a file, make
copy of the 3D model.
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8L.30 Tools related to 3D models were moved to special branch  of the main menu.
8L.31 Ability to distribute  3D models by folders in the menu.
8L.32 Loading  files of 3D models via a dialog box.
8L.33 3D model file name can contain spaces.
8L.34 During placing or editing 3D models, on the Current construction parameter panel  the

3D Models button   appears to quick open the 3D Models window  .

3D VIDEO WINDOW

8L.35 A window, which shows models of camera images, named 3D Window in the past, was
renamed to the 3D Video  window.
8L.36 3D visualization of the location plan and camera view areas in the 3D Video  window by
other cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view
areas from the side.
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8L.37 In the main menu of the 3D Video window, in View submenu, a new 3D view areas  item
was added. It allows to enable visualization of view areas of other cameras.
8L.38 In the main menu of the 3D Video window, in View submenu, a duplicating Ground
item was added for quick hiding the ground surface in the 3D Video window.
8L.39 In the main menu of the 3D Video window, in Image submenu, a new Copy to clipboard
item was added.
8L.40 In the PTZH  mode a camera is panned and tilted by moving mouse cursor on the image
with left mouse button pressed..
8L.41 Background representation in the 3D Video window was improved.
8L.42 Ability to switch  image generation thread: in separated thread or in the main thread.

SPATIAL RESOLUTION

8L.43 Ability to specify spatial resolution in
spatial resolution patterns not only vertically
but also horizontally. To do this, a new switch

 to the Spatial resolution box was added.

8L.44 Numbers of pixels horizontally and vertically can be specified.
8L.45 Additional Spatial resolution patterns  were added based on the Standards: 

Australian Standard AS4806: Closed Circuit Television;
European Standard EN50132-7;
ISO/IEC 19794 Biometric data interchange formats.
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8L.46 As a result of right-click on the Pattern  combo box a pop up menu will appear.
Selecting the Default patterns item, you can erase all changes in the patterns and return to the
patterns set by default.
8L.47 To the Spatial resolution box  new
test images were added.

IMPORT AND EXPORT TO AUTOCAD

8L.48 Import module was upgraded. Up to AutoCAD DWG 2015 formats are supported.
8L.49 The dialog box Scale background was renamed to the Adjust background . For
backgrounds in DWG or DXF formats, abilities to choose Layout in the background, control
visibility of layers, hide texts were added. For backgrounds  in PDF format you can choose page
and resolution of the background.
8L.50 Export module  was updated.

IMPORT AND EXPORT TO OTHER FORMATS

8L.51 Supporting PDF files to use as background  including multi-page PDF files.
8L.52 Export  to PDF (raster). 
8L.53 Export   tab in the Options box is divided into two sub-tabs: "DXF" and "BMP,WMF,
EMF,GIF,TIFF,PNG,JPG,rPDF". 
8L.54 To the options of export to BMP, JPG, EMF, WMF, GIF, TIFF, PNG, rPDF possibility to
set hatch step factor  was added. 
8L.55 In the 3D Image  you can load images in BMP, JPG, PNG, GIF TIF  (early BMP and
JPG). Transparency  of PNG files is supported.
8L.56 New PDF report  was added. Unlike the Text report , the PDF Report can include
images from the cameras, fragments of layouts with camera placed, a cover with logo. Report
parameters and the structure of information in the report is configurable. See example of PDF
report.

PRINTING

8L.57 New mode Use buffer  was added. Using this mode, you can get the correct results and
print transparent gradient fills, projections of 3D models even on printers do not support these
tools, including most of free virtual printer to print to PDF.
8L.58 New mode Scale Hatching  was added. Using this mode, you can get the correct
hatching even on printers do not support scaling hatching.
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8L.59 Menu item Print setup  remains enabled even VideoCAD can not get access to the
current printer. 

DATABASE OF CAMERA MODELS

8L.60 Maintain database of camera models  with the most important parameters (22 fields for
each camera model). You can add your models, assign different models to cameras in project,
compare models with each other. 

MISCELLANEOUS

8L.61 Ability to change the minimum and maximum heights of several objects at once through
changing their line type. If during changing the line type of selected objects by the Change line
type  tool, to press and hold Ctrl, then the selected objects will also change their minimum
and maximum height according to the chosen line type . If Ctrl is not pressed, the heights remain
unchanged.
8L.62 Autosaving  the project in specified intervals during running the program in a chain of
files (up to 100 copies of the project are saved and rewritten in the regular intervals around the
ring). 
8L.63 Image update with lots of rotated projections of the 3D models was accelerated.
8L.64 New construction - Stairs .
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8L.65 Added a possibility to draw legends
of Spatial resolution patterns on the layouts.

8L.66 New tool Merge contour  was added.
8L.67 New possibility to adjust transparence  of filling view area projections  in the Graphics
window.
8L.68 A mode to improve visibility of thin lines  at scaling background in BMP, JPG, PDF
formats.
8L.69 The cursor coordinates in the lower left corner of the Graphics window are displayed
rounded to the second decimal place . 
8L.70 The Export to Text  menu item was renamed to Text report.  
8L.71 In the Text report  for each camera  additional lines were added: layer, the base height ,
angle of rotation around its axis, number of pixels.  
8L.72 Child windows "sticks" to the screen edges.
8L.73 An option of changing registration code  via the Main menu was added.
8L.74 Titles of the 3D video window includes camera resolution in pixels.
8L.75 Detected bugs were fixed.
8L.76 The Help system was updated.
8L.77 Examples of work with VideoCAD  in the Help were updated according to the new
features. Several new examples were added.
8L.78 Project format of VideoCAD7 - *.vc7 is supported. There are possibilities of export  and
import  of the previous project format *.vmp, supported by versions from 4 to 6.
8L.79 The program was tested under Windows 8 and Windows 10. 

SIMPLIFYING REGISTRATION RULE

8L.80 VideoCAD 8 Lite is registered only by personal registration code as well as
VideoCAD Starter. This code doesn't depend on computer hardware or a dongle. This code
is valid on any computer.
8L.81 One license of VideoCAD 8 Lite, purchased separately, allows the use of the program on
two workplaces nonsimultaneously: work and home computers if both workplaces belong to one
person.

CHANGING DEMO VERSION RESTRICTIONS

8L.82 In the demo version of VideoCAD 8 Lite changing lens focal length and image sensor is
now allowed. Instead of this, saving working project to a file is prohibited and a limit on the
maximum number of cameras (5) in one project is added.
8L.83 Licenses of VideoCAD 8 Professional and VideoCAD 8 Lite  allows free use of the
demo versions for educational purposes, for research, theses, writing articles, etc. non-profit
activities. 

 RULES OF UPGRADE

8L.84 The Rules of upgrade from previous VideoCAD versions to VideoCAD 8 Lite: 

For the customers who have purchased VideoCAD Lite (or upgraded to VideoCAD Lite) after 01
January 2016 upgrade to VideoCAD 8 Lite is free. 
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For the customers who have purchased  VideoCAD Lite (or upgraded to  VideoCAD Lite)
before 01 January 2016 updating cost makes half of the VideoCAD 8 Lite cost. 
For the customers who has VideoCAD3..VideoCAD6 and didn't upgrade to VideoCAD 7 Lite,
updating cost makes 3/4 of VideoCAD 8 Lite cost. 
For the customers, whose original valuable suggestions have found application in VideoCAD
8.0, the additional discount for upgrade is given. 
Upgrade of VideoCAD plugin for SketchUP is free with upgrade to VideoCAD 8 Lite.

8.1. What is new in VideoCAD 8.1

MODELING IMAGE SENSOR SIZES AND ASPECT RATIO OF MODERN CAMERAS
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8.1.1 The following parameters have been separated:
 

image sensor size and size of active area of the image sensor; 
aspect ratio of image sensor and aspect ratio of output image of the camera. 

8.1.2 The Image sensor format box has been renamed to the Image sensor size .
8.1.3 New abilities to specify the size of image sensor  through arbitrary sensor format (type)
in inches or through the length of diagonal in millimeters, or through width and height in
millimeters. 
8.1.4 New ability to set aspect ratio of image sensor separately from the aspect ratio of output
image for a given format in inches or length of diagonal of the image sensor.
8.1.5 New ability to set the Crop factor  to model image sensors with active area does not
touch the edges of the image sensor.
8.1.6 Detailed guide  of specifying the active area size of image sensors of modern cameras
has been added.
8.1.7 The Sensor and Distortion box has been renamed to Sensor and Lens . Its interface
has been changed. 
8.1.8 The Image sensor calculator  was added.

IMPROVING USABILITY OF WORKING WITH 3D MODELS AND CONSTRUCTIONS IN
EDITING STATE

8.1.9 Switching 3D models  from the selected state  to the editing state  by double
clicking on its projections was added (previously it was possible to switch a 3D model to the
editing state only from the normal state ).
8.1.10 In the editing state , 3D models  are displayed with square grips and pink circle.
You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.
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8.1.11 In the 3D World  and 3D Video  views of 3D models in editing state and in the
selected state differ.

8.1.12 New possibility to rotate around its axis in editing state Rectangle, Wall, Aperture in wall,
Stairs, Mask, Filling, 3D Image. 

OTHER

8.1.13 Import and export modules of AutoCAD were upgraded. Some improvements were added.
8.1.14 An inaccuracy of snap  operation during construction of walls and aperture in wall has
been fixed.
8.1.15 New tool Merge contour .
8.1.16 Printing on some virtual PDF printers has been improved.

RULES OF UPGRADE

8.1.17 Upgrade from VideoCAD 8.0 is offered free-of-charge. Upgrade from earlier versions is
performed according to rules  of upgrade up to VideoCAD 8.0

8. What is new in VideoCAD 8.0

MODELING VIEW AREA AND CAMERA POSITION
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8.1 Ability to display horizontal projection of
the view area as two sections  by planes on
the minimum and maximum heights of the view
area (Camera 23). One of the sections is
drawn by a transparent filling, the other in the
form of hatching. In many camera positions
such representation is more informative than
standard volume projection (Camera 22).

8.2 When the projection of the view area is displayed as two sections  by horizontal planes
located at height of lower  and  upper  bounds, the shading from obstacles appears as
shadows from objects on these planes.
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8.3 When visualizing spatial resolution with two
levels, lower section is not at the view area
lower bound but at the height of measuring
spatial resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

8.4 If the height  of measuring spatial
resolution is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in previous versions ).

8.5 Simulation of camera rotation  around the main optical axis. Even a slight turn significantly
changes the view area projection. 
 

8.6 The Style of line type  assigned to a
camera determines not only style of lines, but
hatching style of view area projection. 
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8.7 The Maximum distance  of drawing view area is added to the camera geometry
parameters. This distance limits view area in 2D and 3D drawings. It is convenient in case of
infinite view areas.

8.8 The ground is no longer the lowest possible height limiting view area. Height of installation,
heights of the lower and upper bounds of view area can be negative. A camera can see from under
the ground and under the ground.

8.9 The Base height  is added to the camera geometry parameters. All heights related to a
camera  (height of installation, heights of the lower and upper bounds of view area, heights of
person detection, identification, license plate reading areas) counted from the base height. The
Base height together with layers  is used in work with multilevel 3D constructions.

MODELING LENS DISTORTION
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8.10 Simulating lens distortion . Distortion is especially pronounced in the short-focus lenses
and may lead to significant deviation of form of view area of real cameras from regular pyramid.
8.11 Modeling the influence of lens distortion on a 3D image model (pincushion and barrel
distortion), the shape of the view area and its projections, on the distribution of spatial resolution.

8.12 Correct modeling wide-angle lenses with strong distortion.
8.13 The Special sensor size box was renamed to the Sensor and Distortion . 
8.14 The order of calculation in the Sensor and distortion box was changed. You can enter any
image sensor size, then from it the calculated view angles and the aspect ratio are calculated.
8.15 To the Sensor and distortion box a box with a calculated diagonal angle was added.. 
8.16 To the the Sensors and distortion box
new Distortion  panel was added. On the
panel you can specify Real view angles from
the camera and lens specifications. Distortion
is calculated from the ratio between the
calculated and real angles.

8.17 In the  PTZH  mode, FOV frame is
drawn taking into account lens distortion.

8.18 The following camera model parameters were added: Distortion>ON , horizontal,
vertical, diagonal real angles .
8.19 Using PiP  and Real frame size  for simulating real camera number of pixels with
distortion.

3D WORLD WINDOW
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8.20 New 3D World  window with  3D navigation . There are the main tools for 3D navigation
(Orbit, Move, ZOOM, Walk, Look around, Zoom frame).  In the window you can observe the
layout in 3D representation. You can work on the project in usual 2D projections and watch it in
3D. You can "walk" on the floors of 3D models of buildings and study every detail.
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8.21 3D visualization of the camera view
area surface  taking into account
spatial resolution, shadows, lens
distortion.

 

8.22 3D visualization of the active
camera coverage  on the environment
taking into account spatial resolution,
shadows, lens distortion.

 

8.23 3D visualization of control areas of
PTZ cameras , Dome cameras and
360 degree cameras.

 

8.24 Free cutting  3D layout by six planes to provide access to any point of complicated 3D
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buildings.

 

8.25 Export images from the 3D World  window to any of the following formats: *.bmp, *.jpg,*.
gif,*.tif,*.png. Size in pixels of the exported file can exceed  the Windows screen size.
8.26 3D camera view area and camera coverage constructed in the 3D World taking into account
distortion, spatial resolution and shading can be exported to a DXF file  for insertion into a 3D
project processed in another 3D program. This important feature makes possible to use
VideoCAD to build 3D models of the view areas for designers working with any 3D design
software that support import DXF files, including SketchUP .

 

MODELING PANORAMIC CAMERAS (FISHEYE, 360°/180°)

8.27 Simulation of image resolution and view area limits of panoramic cameras  in the 3D
Video.
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8.28 Simulation of the horizontal projection of the view area and visualization of the spatial
resolution distribution of panoramic cameras  in the Graphics window.

8.28 Visualization of camera coverage area and spatial resolution distribution of panoramic
cameras  on the surrounding objects in the 3D World window.

312

626



VideoCAD112

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

8.30 New icons  for panoramic cameras were added  and  .
8.31 In the Sensor and Distortion  box a
new Panoramic panel was added. On the panel
the Pan and Tilt angles of panoramic camera
installation can be specified.

8.32To the list of camera model parameters : Type>Fixed, PTZ,Dome, Mini a new panoramic
item was added,
8.33 To the list of camera model parameters: Lens>Type a new fisheye item was added,
8.34 Lens focal length boxes in the Graphics window and the Camera geometry box are colored

in Aqua when the active camera is panoramic. .
8.35 In reports  panoramic cameras have fisheye word instead of lens focal length value;

LAYERS
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8.36 Constructions, 3D models and cameras
can be distributed by layers . 
8.37 Each layer can have its own Base height

. All constructions belong to the layer will
be shifted in 3D by the Base height. This
feature is useful in work with multilevel 3D
constructions.
8.38 In addition to the Base height, each layer
has the following parameters : Active,
Enabled, Visible, Hidden, Snap, Shadows, 3D
Visible, Color.
8.39 To the main and pop-up menus of the
Graphics window the Move to Active layer
item was added to move constructions and
cameras between layers.

 

WORK WITH 3D MODELS

8.40 Possibility of using  3D models-territories
, to place inside them cameras,

constructions and other 3D models.
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8.41 Support of 3D models with textures,
transparent texture and opacity of materials. 

8.42 New version of VideoCAD Plugin for
SketchUP was released with possibilities of
export textures, transparent textures, opacity
of materials and scaling. 
 

8.43 Import of new 3D models was simplified. The special 3D models  window was added  for
creation of 3D model projections. In the window , you can create 3D model projections  with
specified resolution, brightness, create projection in the form of faces, points and lines.
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8.44 Ability to make projections in the form of sections of 3D models  at the specified range of
heights. These projections of 3D models of buildings can be used as background for placing
cameras in the Graphics window.  
8.45 Ability to create 3D model projections with exceeding  Windows screen resolution. 
8.46 Possibility to create a projection of individual area of 3D model with even higher resolution
using PiP  (Picture in Picture) tool.
8.47 To use the 3D models as territories, and their projections as a background, a new ability to
block  the projection of certain 3D models from selection by mouse click was added.  
8.48 Ability to consider a 3D model as obstacle in the calculation of shadows .
8.49 In the 3D Models window you can also : save 3D model to a file, make copy of a 3D
model, earn  3D models using 3D interface similar to the 3D World  window.
8.50 Tools related to 3D models were moved
to special branch  of the main menu.
8.51 Ability to distribute  3D models by
folders in the menu.
8.52 Loading  files of 3D models via a dialog
box.
8.53 3D model file name can contain spaces.
8.54 During placing or editing 3D models, on
the Current construction parameter panel

the 3D Models button   appears to quick
open the 3D Models window  .

 
MODELING RESOLUTION OF CAMERAS AND LENSES
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8.55 Ability to obtain full-size  image models of cameras with number of pixel exceeding
Windows screen size, without using PiP. See examples of exported files: 5 megapixels,10
megapixels, 25 megapixels.
This feature can be useful to model real resolution model of images with distortion .

8.56 Resolution modeling algorithms were reworked.
8.57 As an unit of measuring resolution instead of actually ambiguous TVL (TV lines), the Lines
per Picture Height (LPH) is used. For analog cameras the LPH is the same as "actual" TV
lines, ie the number of vertical lines fit within the part of picture width equals to the picture height.
8.58 Accuracy of modeling resolution in LPH was increased. When you set the image resolution
in LPH, you can also set the drop of contrast in % .
8.59 In modeling the camera resolution in LPH, it is possible to model as only horizontally
resolution (for analog cameras) as the resolution in both directions  (for IP cameras).  
8.60 The Test chart  EIA1956 is tied to the frame height and saves equal aspect ratio
regardless of the aspect ratio of the simulated images that allows you to watch resolution of the
simulated images in LPH (lines per picture height) in any aspect ratios of the frame.
8.61 Size in pixels of the Test chart  EIA1956 is increased twice.
8.62 Ability to display the Test chart EIA1956 in  reduced-size  (up to 64 times), what extends
the range of estimates resolution using the test chart up to 100 000 LPH.
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8.63 Simulating lens resolution  in line pair
per millimeter at specified contrast drop by
MTF (10%, 20%, 30%, 50%).

8.64 The following camera model parameters were added: Rolling shutter>Up (scan direction)
; Resolution>LPH  (lines per picture height); Resolution>Contrast % ;

Resolution>Horizontal only ; Lens>Resolution>lp/mm  (line pair per mm);
Lens>Resolution>Contrast % .
 
3D VIDEO WINDOW

8.65 A window, which shows models of camera images, named 3D Window in the past, was
renamed to the 3D Video  window.
8.66 In the main menu of the 3D Video window, in Image submenu, a new Real frame size
item was added. If it is checked, then saving the image in the 3D video window will be with the
number of pixels of the camera, which can exceed the screen size in Windows. This item is also
used to simulate resolution of image with lens distortion . 
8.67 In the main menu of the 3D Video window, in View submenu, a duplicating Ground  item
was added for quick hiding the ground surface in the 3D Video window.
8.68 In the main menu of the 3D Video window, in Image submenu, a new Copy to clipboard
item was added.
8.69 View area faces of cameras are invisible in the 3D Video window, they are visible in the 3D
World  window.
8.70 In the PTZH  mode a camera is panned and tilted by moving mouse cursor on the image
with left mouse button pressed..
8.71 Background representation in the 3D Video window was improved.
8.72 Ability to switch  image generation thread: in separated thread or in the main thread.
8.73 Ability to model Rolling Shutter  with line scan order from up to down was added.
8.74 Accuracy of positioning PiP  and accuracy of working  PiP together with Rolling Shutter
was increased.
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SPATIAL RESOLUTION

8.75 Ability to specify spatial resolution in
spatial resolution patterns not only vertically
but also horizontally. To do this, a new switch

 to the Spatial resolution box was added.

8.76 To the Option box an option of switching  direction of the spatial resolution calculation in
dependence of the camera rotation around its optical axis was added. 
8.77 Additional Spatial resolution patterns  were added based on the Standards: 

Australian Standard AS4806: Closed Circuit Television;
European Standard EN50132-7;
ISO/IEC 19794 Biometric data interchange formats.

8.78 As a result of right-click on the Pattern  combo box a pop up menu will appear. Selecting
the Default patterns item, you can erase all changes in the patterns and return to the patterns
set by default.
8.79 The Vertical resolution of camera  field in the Spatial resolution box was renamed to the
Vert. (Horiz) number of pixels .
8.80To the Spatial resolution box  new test
images were added.

8.81 Spatial resolution visualization on the view
area faces and on the active camera coverage
in the 3D World  window.
8.82 Spatial resolution visualization taking into
account  lens distortion .
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8.83 A new option for drawing regions of spatial resolution in the Graphics windows in ascending
resolution - High resolution on top  was added. With this option enabled all cameras remain
visible despite the shading of projections of different cameras. While regions with higher spatial
resolution are drawn on the top.

Usual drawing High resolution on top

IMPORT AND EXPORT TO AUTOCAD

8.84 Import module was upgraded. Up to AutoCAD DWG 2015 formats are supported.
8.85 The dialog box Scale background was renamed to the Adjust background . For
backgrounds in DWG or DXF formats, abilities to choose Layout in the background, control
visibility of layers, hide texts were added. For backgrounds  in PDF format you can choose page
and resolution of the background.
8.86 Export module  was updated and reworked. Export to AutoCAD was improved. Export
accuracy was increased.
8.87 Cameras with view areas are exported as AutoCAD blocks, view area bounds are exported
as polylines. In attributes of the block the most important parameters of the camera are recorded:
Name, Model, Lens focal length, Height of installation, Base height, Heights of view area lower
and upper bounds, View angles, Number of pixels, Spatial resolution pattern, Quality level. 
8.88 Illuminators are exported as AutoCAD blocks. In attributes of the block the most important
parameters of the  illuminator are recorded: Lamp type, Number and power of lamps, Height of
installation. 
8.89 Distribution by layers , set in VideoCAD is saved. 
8.90 Hatching and filling of shadows  are saved.  
8.91 Styles and weights of lines  set in VideoCAD are saved.
8.92 Point of origin is saved. 
8.93 Grid is exported as AutoCAD block with attributes.
8.94 In the exported file the references to raster insertions are saved: background and 3D model
projections. Raster images are exported along with DXF or DWG file into a separate directory.
8.95 In addition to the DXF format, export to the following vector formats was added: DWG, vector
PDF, PLT (HPGL/2), CGM (Computer Graphic Metafile), SWF (Adobe Flash). 
8.96 When you export a drawing with the  background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers  or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
8.97 Possible scheme of the combining AutoCAD + VideoCAD:

1. Load drawing  in AutoCAD format as a background;
2. Import  AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
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4. Export  the obtained drawing to AutoCAD format to work with it in AutoCAD.

8.99 Export to DXF file 3D view areas  and
camera coverage  taking into account lens
distortion, spatial resolution, and shading.
 

This feature allows the convenient scheme of
work with combination of 3D BIM Software
(SketchUP) + VideoCAD.

1. Export layout as a 3D model-territory
through SketchUP and loading it into
VideoCAD.
2. Adding cameras with 3D view areas in
VideoCAD.
3. Export 3D view areas in DXF format,
loading them into 3D BIM Software and
combining with the original layout in 3D.

8.99 Import  constructions  from a 2D background in AutoCAD formats to 3D VideoCAD
constructions automatically. Use of this tool allows to reduce efforts of outlining background to
convert it to 3D constructions.
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IMPORT AND EXPORT TO OTHER FORMATS

8.100 Supporting PDF files to use as background  including multi-page PDF files.
8.101 Export  to PDF (raster and vector), AutoCAD DWG, PLT (HPGL/2), CGM (Computer
Graphic Metafile), SWF (Adobe Flash). 
8.102 Because of the increased number of export options, Export   tab in the Options box is
divided into two sub-tabs: "DXF,DWG,PLT,CGM,SWF,vPDF" and "BMP,WMF,EMF,GIF,TIFF,
PNG,JPG,rPDF". 
8.103 To the options of export to BMP, JPG, EMF, WMF, GIF, TIFF, PNG, rPDF possibility to
set hatch step factor  was added. 
8.104 In the 3D Image  you can load images
in BMP, JPG, PNG, GIF TIF  (early BMP and
JPG). Transparency  of PNG files is supported.
8.105 New PDF report  was added. Unlike the Text report , the PDF Report can include
images from the cameras, fragments of layouts with camera placed, a cover with logo. Report
parameters and the structure of information in the report is configurable. See example of PDF
report.

PRINTING

8.106 New mode Use buffer  was added. Using this mode, you can get the correct results and
print transparent gradient fills, projections of 3D models even on printers do not support these
tools, including most of free virtual printer to print to PDF.
8.107 New mode Scale Hatching  was added. Using this mode, you can get the correct
hatching even on printers do not support scaling hatching.
8.108 Menu item Print setup  remains enabled even VideoCAD can not get access to the
current printer. 

MISCELLANEOUS

8.109 Ability to change the minimum and maximum heights of several objects at once through
changing their line type. If during changing the line type of selected objects by the Change line
type  tool, to press and hold Ctrl, then the selected objects will also change their minimum
and maximum height according to the chosen line type . If Ctrl is not pressed, the heights remain
unchanged.
8.110 Autosaving  the project in specified intervals during running the program in a chain of files
(up to 100 copies of the project are saved and rewritten in the regular intervals around the ring). 
8.111 Image update with lots of rotated projections of the 3D models was accelerated.
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8.112 New construction - Stairs .

8.113 Added a possibility to draw legends
of Spatial resolution patterns on the layouts.

8.114 New possibility to adjust transparence  of filling view area projections  in the Graphics
window.
8.115 A mode to improve visibility of thin lines  at scaling background in BMP, JPG, PDF
formats.
8.116  In the Test object box  at calculation of the part of frame occupied by the test object, tvl
(TB- lines ) and p ( pixels) are not used.
8.117 The Quality level combo box with a list of quality level was removed from the Camera
geometry box. You can assign a quality level to the active camera in the Quality levels
box.
8.118 The item Assign to active camera was removed from the pop up menu of the Quality
levels table . A quality level is assigned when you select a line with the quality level name. To
save your selection, click Save. To cancel - click Cancel. 
8.119 In the graphical editing state  of the active camera, selection and rotation of the active
camera is blocked to prevent displacement of the background, constructions and cameras relative
to each other on other layouts.
8.120 The cursor coordinates in the lower left corner of the Graphics window are displayed
rounded to the second decimal place . 
8.121 The Export to Text  menu item was renamed to Text report.  
8.122 In the Text report  for each camera  additional lines were added: layer, the base height ,
angle of rotation around its axis, number of pixels.  
8.123 When lens distortion  is modeled, the exported text file  contains real angles taking
into account the distortion and in parentheses calculated angles.
8.124 Child windows "sticks" to the screen edges.
8.125 Maximum number of lamp in a illuminator  was increased up to 250 for modeling LED
illuminators.
8.126 An option of changing registration code  via the Main menu was added.
8.127 An option of typing sensor size  in millimeters was described in the Help system.
Checking invalid sensor sizes was added.
8.128 Detected bugs were fixed.
8.129 The Help system was updated.
8.130 Examples of work with VideoCAD  in the Help were updated according to the new
features. Several new examples were added.
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8.131 Project format of VideoCAD7 - *.vc7 is supported. There are possibilities of export  and
import  of the previous project format *.vmp, supported by versions from 4 to 6.
8.132 The program was tested under Windows 8. 

 RULES OF UPGRADE

8.133 The Rules of upgrade from previous VideoCAD versions to VideoCAD8: 

For the customers who have purchased VideoCAD7 (or upgraded to VideoCAD7) after 01 July
2014 upgrade cost makes a difference between cost of VideoCAD8 and VideoCAD7. 
For the customers who have purchased VideoCAD7 (or upgraded to VideoCAD7) before 01
July 2014 updating cost makes half of the VideoCAD8 cost. 
For the customers who has VideoCAD3..VideoCAD6 and didn't upgrade to VideoCAD7,
updating cost makes 3/4 of VideoCAD8 cost. 
Upgrade Lite version to Professional is paid in addition.
For the customers, whose original valuable suggestions have found application in VideoCAD
8.0, the additional discount for upgrade is given. 
Upgrade of VideoCAD plugin for SketchUP is free with upgrade to VideoCAD 8.

VideoCAD 8 Professional can work only with USB Senselock  dongle. HID registration
with the Professional version is not applied. Senselock dongles from VideoCAD 6.XX and
VideoCAD 7.XX are supported.  In case of absence of USB Senselock dongle it is necessary to
purchase it. Guardant dongles are not supported by VideoCAD 8.0. 

 

VideoCAD 8 Lite  can work with USB Senselock dongle  and with the HID registration. 
 

VideoCAD 8 Starter  and VideoCAD 8 Starter II  are registered only by personal
registration code, without dongle, without hardware locking. 

7. What is new in VideoCAD 7.0

 NEW PROJECT FORMAT

7.1 New project file format *.vc7. There are possibilities of export  and import  of the previous
project format *.vmp, supported by versions from 4 to 6.
7.2 Unlimited quantity of cameras in one project. In the previous versions each project could
contain no more than 100 cameras.
7.3 Unlimited quantity of constructions on each layout.  In the previous versions each layout could
contain no more than 5000 constructions.
7.4 Quantity of line types  is increased to 2000.

 SPEED OPTIMIZATION

7.5 Resource-intensive operations are allocated in separate threads. This allows working in the
graphics window without delays and also get considerable gain in efficiency on modern multicore
processors.
7.6 3D image  generation is allocated in a separate thread. This allows working in the graphics
window with opened 3D window without delays for redrawing 3D images.  The priority of the 3D
window thread can be switched . During image generation in the 3D window on the 3D window
button  blinking red frame appears.
7.7 New items were added to the 3D window's main menu: Speed>Disable image processing
and Update image only by clicking . These items duplicate the same items in the Options box.
When image processing is disabled the 3D image redraw speed considerably increases. 
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7.8 Possibility of two-stage image generation  in the 3D window. At the first stage the image
without processing is quickly generated and displayed. Then resource-intensive per-pixel
processing is carried out and the processed image is shown.
7.9 In the PTZH frame  mode image processing is disabled to increase speed of image
redrawing. Titles are disabled too. 
7.10 The algorithm of modeling sensitivity of megapixel cameras is accelerated.
7.11 Image redrawing in the Graphic window was accelerated too. Bottlenecks were optimized.

CALCULATING SHADOWS IN THE VIEW AREA

7.12 Constructing horizontal projection of
camera control area taking into account 
shadows , arisen from obstacles on the
scene environment.  In three dimensions,
shadows from any constructions (including 3D
models) can be automatically calculated and
displayed.
7.13 New definitions are introduced: Camera
control area and Control area projection.
Camera control area forms by subtracting
shadows of environment objects (uncontrolled
areas) from camera view area  .
7.14 Constructing the Camera control areas of 
PTZ (dome) cameras taking into account
shadows, created by obstacles on the scene
environment. The tool is also useful for
choosing the best location for fixed cameras to
make reachable required areas.
7.15 In the Line type properties there is new
item: Shadow . If the item is checked then
all constructions made by this line type are
considered as obstacles at calculating
shadows.
7.16 On the Current construction parameter
panel when a 3D model is editing, there is
additional checkbox- Shadow . If the
checkbox is checked, then the 3D model is
considered as an obstacle at calculating
shadows.
 

Shadows - a new powerful yet easy-to-use
tool of VideoCAD 7. Shadows are calculated
for all positions of cameras, shading objects
can be located at any point of space. You
should only enable calculation of shadows.

 COLORS, FILLING AND HATCHING OF VIEW AREA PROJECTIONS
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7.17 View area projection of different cameras
can have different color  according to
parameters of line type of these cameras (in
case of disabled spatial resolution
visualization).
7.18 View area projection can be
semitransparent. The Fill projection  button
and corresponding item of the main menu have
a drop-down list in which it is possible to
choose blend filling or hatching view area
projection. 

 
VISUALIZATION OF SPATIAL RESOLUTION AND FIELD OF VIEW SIZE

7.19 Camera view area can be divided into regions  filled by different color and (or) type of
hatching. Regions can differ depending on the following criteria:
 

 spatial resolution (pixels/meters, pixels/foot);
 vertical field of view size (meter, foot);
 vertical number of pixels covered by an object of the specified height (meter, foot);
 the part of the frame (%) covered by an object of the specified height (meter, foot).

 

7.20 The spatial resolution is measured at the specified height and can be displayed in the
Horizontal projection in all modes. In the Vertical projection the spatial resolution is displayed in
the loaded (active) camera editing mode only.
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7.21 The new Spatial resolution box  was
added in which it is possible to create and edit
patterns of spatial resolution and field of view
size visualization. In the box there are prepared
spatial resolution patterns according to the
following criteria: Home Office Scientific
Development Branch, Home Office Guidelines
for identification, P 78.36.008-99. Also in the
box there are examples of images of group of
people are automatically displayed for each
region of spatial resolution. Different patterns
can be assigned to different cameras.
7.22 View area projections can have gradient
colors . In this case key colors of the
gradient correspond to the colors in the
assigned pattern from the Spatial resolution
box.

MODELING RESOLUTION OF MEGAPIXEL CAMERAS

7.23 On the Image parameter panel a new tab
PiP  (Picture in Picture) was added. The PiP
mode allows to model in the 3D window images
with resolution exceeding the 3D window
resolution and even the resolution of the
Windows screen. 
7.24 Digital ZOOM  in the PiP mode allows
to additionally magnifying specified area on the
3D window for detailed analysis.
7.25 If the image resolution differs from the 3D
window size and artificial decrease of resolution
is performed or the PiP is displayed, in the 
Titles  of the 3D window in separated lines
the image resolution and the screen resolution
are displayed.
 

7.26 New values of resolution in the drop-down lists. Lists of resolution are stored in files H_res.txt
and V_res.txt in the VideoCAD installation directory. To add new resolution it is possible to edit
these files. As well as in the previous versions you can type any resolutions by the keyboard.

 MODELING MOVEMENT

7.27 You can specify speed and direction of movement for 3D models  in a velocity vector form
and in a numerical form.
7.28 On the Current construction parameter panel when choosing 3D models there is an additional
Speed  box. 
7.29 Frame rate  was added to the camera parameters.
7.30 It is possible to model movement of 3D models and rotation of the Rotakin  object.
7.31 Visual estimation  in the Graphics window how many times moving object will get into the
frame, depending on speed and direction of movement of the object, location and frame rate of the
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camera and the view area form.
 

   

7.32 Exposure time  and Row time  of Rolling shutter were added to camera parameters.
7.33 It is possible to model blur of moving 3D models (motion blur) and rotating Rotakin depending
on the speed, direction of movement and exposure time of camera. 
7.34 When modeling exposure time in the 3D window Titles current exposure time value is
displayed.
7.35 Modeling distortions  of moving 3D models and rotating Rotakin from Rolling shutter and
Global shutter.
7.36 Modeling interlace distortions  of moving 3D models and rotating Rotakin.
 

CREATION OF ANIMATED IMAGES
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7.37 Possibility of creation of animated images
with moving 3D models.
7.38 On the Image parameter panel, View tab
the Number of frames  box was added.
7.39 When the Number of frames is more than
one, in the 3D window's titles  the Frame
rate value is displayed and in the 3D window
animated image with specified Frame rate is
generated.
7.40 Animated images can be saved  as
animated GIF files and displayed on the
Monitor window.

See an example of animated monitor
(file size about 4 Mb).

NEW IN THE MONITOR WINDOW

7.41 Scaling the Monitor window in Windows 7 was improved.
7.42 New sizes  of monitors were added.
7.43 Possibility of setting resolution  of digital monitors.
7.44 During loading monitors it is possible to interrupt the long operation, having pressed ESC.
7.45 It is possible to set correcting factor  for exact modeling physical sizes of monitors.
7.46 Displaying on the monitors animated  images with moving 3D models.
7.47 Saving  image of the monitors in formats *.gif, *.tif, *.png.
7.48 Exporting images on the monitors to the  *.html  file with static or animated images.
Camera’s images are saved in the camera's original resolutions in the form of separate files PNG
or animated GIF. 

See an example of animated monitor (file size about 4 Mb).

NEW OBJECTS AND TOOLS

7.49 New object - Rotakin   - an animated rotating test target for visual estimation of spatial
resolution and motion distortions on the 3D images. In the Options box it is possible to change
rotation speed of the Rotakin.
7.50 New object - Wall .  It allows drawing walls with different thickness. 
7.51 New object - Aperture in Wall .  It allows making in 3D walls any apertures, for example for
windows and doors.
7.52 New object - Polyline .  It allows drawing line segments continuously.
7.53 New tool - Scale .  It allows scaling selected constructions relative to a base point.
7.54 New tool - Mirror . It allows getting mirror copies of selected constructions relative to a
horizontal or vertical line.
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7.55 Existing Copy and Cut tools are renamed to Copy with base point  and to Cut with base
point . 
7.56 New Copy  and Cut  tools were added. In the new tools the base point is set
automatically at the center of copied objects.
7.57 Several new 3D models  were added to the library. 

CABLE REPORT 

7.58 Possibility of using in the project a lot of brands of cables. Line types  can be considered
as cables.
7.59 Possibility of drawing main cables, which is not associated with cameras.
7.60 Possibility of getting the Cable report . The report contains lengths of all cables separated
by brands and cameras, including the main cables. 
7.61 Continuous drawing cables . The end of each segment is the start of the following one. To
stop drawing cable press ESC.

 DEPTH OF FIELD IN THE HORIZONTAL PROJECTION

7.62 The Height  parameter was added to the depth of field parameter list. At the set Height the
analysis of depth of field is performed do display the depth of field bounds in the Horizontal
projection. The height can be different for different cameras. 
7.63 When the Depth of field box  is opened, all cameras in the horizontal projection have
displayed borders of the sharpness area, hyperfocal distance, focus distance measured at the set
height.  In the vertical projection the borders of the sharpness area, hyperfocal distance, focus
distance are displayed in the loaded (active) camera editing mode.
7.64 It is possible to specify focus distance by clicking on the view area horizontal projection of the
loaded (active) camera. The Specify focus plane  button is always accessible.
7.65 When the Specify focus plane button is pressed, during cursor movement over the view area
horizontal projection of loaded (active) camera, on the Status bar  the resolution under the
cursor limited by the depth of field is displayed.
7.66 In the Depth of field box the new Default  button was added. As a result of clicking this
button, default values will be assigned to input parameters in the Depth of field box: the boundary
resolution = 0.7*horizontal pixel count, focus distance = hyperfocal distance, height = AUTO
(middle height of the camera's view area).

NEW IN TABLE OF CAMERAS AND TABLE OF CAMERA MODELS

7.67 A new menu for switching visibility  of separate columns was added.
7.68 Several new possibilities of filtering  data in the tables.
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7.69 Several new parameters of camera model were added: Exposure time at measuring sensitivity
, Maximal frame rate , Row time  (parameter of the Rolling Shutter).

7.70 To the Table of cameras these three new parameters of model were added and in addition:
Current frame rate , Name of the assigned Spatial resolution pattern , Signal cable brand
and Power cable brand .  

 INTERFACE IMPROVEMENTS

7.71 Possibility to adjust  visibility of buttons on the Tool bar.
7.72 When Alt is pressed , it is possible to move drawing in the Graphics window using arrow
keys and to change scale using plus and minus keys irrespective of the input focus.
7.73 In the PTZH frame  mode of the 3D window you can pan and tilt the camera by moving the
image in the 3D window with left mouse button pressed like moving drawing in the Graphics
window.
7.74 In the Options box the Default  button was added. Using this button you can assign default
values to all parameters on the opened tab.
7.75 Sign of the Scaling factor when turning the mouse wheel  in the Option box determines the
reaction for direction of rotation the mouse wheel in the Graphics window.
7.76 Manual scaling 3D window in Windows 7 was improved. 
7.77 On the Processing  tab of the Image parameter panel and in the Sensitivity and resolution

 box between combo boxes with horizontal and vertical numbers of pixels, new buttons with a
cross were added. These buttons are intended for fast calculation of vertical number of pixels from
the specified horizontal number of pixels and on the contrary. Calculation is carried out using the 
Aspect Ratio .
7.78 On the View tab of the Image parameter panel near to a box with the horizontal number of
pixels , the calculated value of vertical number of pixels and the Aspect ratio are displayed.
7.79 At the left top corner of the Tool bar the Save project  button was added for convenient
regular saving the current project to a file.
7.80 Links to the last 10 used project files are accessible in the Main menu>Project .
7.81 Accuracy of 3D model selection in the Graphics window was improved.
7.82 In the Main menu>Help  new items with links to our web site and VideoCAD user forum in
the Internet were added.

UNDO

7.83 Buffer of last operations (UNDO) stores now all parameters of cameras. 
7.84 Depth of the undo buffer can be adjusted on the Miscellaneous  tab of the Options box.
This depth can be up to last 50 operations.
7.85 The REDO  button was added for moving in the UNDO buffer in the opposite direction.

 NEW FORMATS OF IMPORT AND EXPORT

7.86 Support of import as background  and export  drawing in the following formats: EMF +,
GIF, TIFF, PNG. Blend color and gradient color are supported.
7.87 Support of export drawing to JPG format (Import of the JPG format is present in the previous
versions).
7.88 Possibility of saving  image from the 3D window in formats: GIF, animated GIF, TIF and
PNG.
7.89 Possibility of saving  image from the Monitor window in formats: GIF, TIF, PNG, HTML with
PNG, HTML with animated GIF.

 CHANGES
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7.90 When editing by points a rectangle , an inclined rectangle  or 3D image , the
rectangle remains rectangular by default. By pressing Ctrl it is possible to edit separate points and
to change distance between lines. In the previous versions it was on the contrary.
7.91 Double line  rotates as a whole, with keeping distance between lines that is more
convenient at construction of walls.
7.92 When editing by points a double line, it rotates as a whole by default. Keeping Ctrl it is
possible to edit separate points and to change distance between lines. In the previous versions it
was on the contrary.
7.93 The Post  in the 3D window is hidden by default. It is possible to show post on the View
tab of the Image parameter panel.
7.94 Setting of export to raster formats on the Export  tab of the Options box by default
correspond to an exact copy of the screen.
7.95 At the moment of closing the Image parameter panel the According to camera parameters
box on the Processing tab becomes marked automatically and all parameters on this tab get
values from the loaded (active) camera. This is to avoid mess with displaying resolution of loaded
(active) and inactive cameras. 
7.96 Name of the loaded (active) camera is not red colored when exporting and printing.
7.97 When modeling interlaced fields , the vertical resolution of video sensor  (if it is set)
decreases twice. In the previous versions the vertical resolution of the whole image in the 3D
window was decreased.
7.98 From the Camera  tab of the Image parameter panel duplicating controls are removed to
clear a place for new tools. The controls remain on the Sensitivity and resolution  box.

RENAMINGS

7.99 The Loaded camera term is changed to the Active camera.
7.100 Menu item Project> Export is renamed to Project> Export to Text .
7.101 Button Actual view area projections and the corresponding Main menu item are renamed
to Fill projections .
7.102 The Interface tab in the Options box is renamed to Miscellaneous .
7.103 Coaxial cable is renamed to the Signal cable (the Russian version).

 UTILITIES

7.104 Utilities for measuring camera and image parameters were separated out from VideoCAD in
the separate product - CCTVCAD Lab Toolkit .
7.105 Utilities in the CCTVCAD Lab Toolkit become more stable in Windows 7.
7.106 The Video analyzer has a possibility of automatic measuring signal/noise ratio of static
image or live video on the computer screen, in a window of any third party program. 
7.107 In the Image analyzer, showing separate image lines as a oscilloscope can be separated by
color.
7.108 In the Spectrum analyzer, a possibility of calculating spectral efficiency of infra-red LEDs of
different wavelength for different image sensors was added.
7.109 In the Spectrum analyzer, spectral sensitivity curves of modern CMOS and CCD megapixel
image sensors (SONY, Cypress, Micron) were added.
7.110 The technique of measuring sensitivity  of cameras was refined on the base of practice of
measuring the sensitivity of IP cameras. A new method of measuring the sensitivity using the
Video analyzer was added.
7.111 Procedures for measuring camera exposure time  and the row time of rolling shutter  of
IP cameras were developed.

MISCELLANEOUS
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7.112 Possibility to make camera and luminaries icons  scalable together with the other
constructions on the drawing. In this case the size of icons is specified in meters (foots). This
possibility allows setting the exact sizes and positions of icons and names of cameras for
exporting and printing.
7.113 Possibility of assigning scalable fonts  to the camera names and specifying displacement
of camera names in meters (foots) for scalable icons and in pixels for no scalable icons
separately.
7.114 Displaying background  in the 3D window was improved. 
7.115 A new possibility of adjusting resolution  of a vector background (in AutoCAD format) in
the 3D window.
7.116 In the Options box on the 3D tab a slider was added which allows adjusting realism of
modeling  depth of field, exposure time and rolling shutter.
7.117 In the Sensitivity and resolution box a new camera parameter Exposure time at measuring
sensitivity  was added. 
7.118 In the exporting text file  for each camera the following information was added: Horizontal
angle of camera, Coordinate X, Coordinate Y, Model, Producer and Cost.
7.119 In the Camera list  box new parameters were  added: lens focal length and vertical
number of pixel. Now you can copy the camera list to the Windows clipboard to paste in MS
Excel, MS Word and other software.
7.120 Help system was considerable improved; a lot of pictures were added.
7.121 Examples of work with VideoCAD  in the Help were updated according to the new
features. Several new examples were added.
7.122 Program was adapted for modern wide-screen monitors with high resolution.
7.123 Program was tested under Windows 7. Detected incompatibilities are eliminated.

 RULES OF UPGRADE

7.124 The Rules of upgrade from previous VideoCAD versions to VideoCAD7: 

For the customers who have purchased VideoCAD6 (or upgraded to VideoCAD6) after 01
January 2011 upgrade cost makes a difference between cost of VideoCAD7 and VideoCAD6. 
For the customers who have purchased VideoCAD6 (or upgraded to VideoCAD6) before 01
January 2011 updating cost makes half of the VideoCAD7 cost. 
For the customers who has VideoCAD3..VideoCAD5 and didn't upgrade to VideoCAD6, updating
cost makes 3/4 of VideoCAD7 cost. 
Upgrade Lite version to Professional is paid in addition.
For the customers, whose original valuable suggestions have found application in VideoCAD 7.0,
the additional discount for upgrade is given. 

VideoCAD 7 Professional can work only with USB Senselock  dongle. HID registration
with the Professional version is not applied. Senselock dongles from VideoCAD 6.XX are
supported.  In case of absence of USB Senselock dongle it is necessary to purchase it.
Guardant dongles are not supported by VideoCAD 7.0. 

 

VideoCAD 7 Lite  can work with USB Senselock dongle  and with the HID registration. 
 

VideoCAD 7 Starter  and VideoCAD Starter II  are registered only by personal
registration code, without dongle, without hardware locking. 

6.1 What is new in VideoCAD 6.1

6.1.1 VideoCAD_Lite  is released.  VideoCAD_Lite  is an inexpensive version of VideoCAD with
limited features. VideoCAD_Lite offers only the most useful and easy-to-master tools for CCTV
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design.

6.1.2 A new possibility to assign any model to all selected cameras  simultaneously

6.1.3 A possibility to change the following parameters of all selected cameras  simultaneously:
lens focal length, Image sensor size, installation height, parameters of view area, quality level. 

6.1.4 Exposure time range  is expanded up to 1 sec. for convenience in modeling modern IP
cameras with increased exposure time.

6.1.5 Line color in the 3D window  is displayed on the Line type panel .

6.1.6 Changing Number  and Model Name  is disabled on the Used models tab in the Table
of camera models . Earlier such changes resulted in loss of the model from the model list.

6.1.7 If size of video sensor is standard, at closing the Special sensor size  box, the standard
designation of the sensor size is kept.

6.1.8 The Help system is updated.

6.1.9 VideoCAD installer is updated.

6.1.10 Found bugs are fixed: running under a user account, error at starting VideoCAD by double
clicking on a project file, an erroneous message ' Your graphics card does not support this tool ',
directory path of jpg images saving is not kept, error at editing text on the drawing.

6.1.11 Updating from VideoCAD 6.0 is offered free-of-charge. Updating from earlier versions is
performed according to rules  of updating up to VideoCAD 6.0.

6. What is new in VideoCAD 6.0

IllUMINATION AND LUMINARIES

6.1 Modeling background scene illuminantion , considering type and direction of light source,
separately for day and nighttime. 

6.2 Luminaries  modeling considering lamp type and light efficiency, including discharge lamps
with complex spectrum of radiation.

6.3 Different wavelength Infrared LED illuminators  modeling.

6.4 Illuminator calculation box  for creating luminaire models and calculating their parameters.

CAMERA, LENS AND DVR PARAMETERS

6.5 Camera parameters  modeling (spectral response; number of pixels; resolution; minimum
scene illumination at known signal-to-noise ratio, IRE and aperture; maximum signal-to-noise ratio;
electronic shutter; AGC; Back Light Compensation; gamma correction).

6.6 Lens parameters modeling (focal length; aperture; Auto Iris DC and Video Drive). Calculating
and modeling Depth of field  based on calculated aperture.
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6.7 Modeling cameras , switching into black and white mode in case of low illuminance: day/
night with removable IR filter and easy day/night with permanent IR filter.

6.8 Enhanced modeling of DVR parameters  (vertical and horizontal digitization, brightness,
contrast, compression, vertical and horizontal sharpness). 

6.9 Modeling specific distortions which are arisen as a result of mismatching output image size
and number of pixels  on camera's video sensor.

6.10 Modeling images based on scene, lens, camera and DVR models. Calculating  and
modeling  signal-to-noise ratio and contrast.

6.11 Image models at different illumination levels are tested  against real video cameras. Very
high level of coincidence has been achieved.

UTILITIES

6.12 Image analyzer  tool allows measuring signal-to-noise ratio, brightness and brightness
amplitude of an image, size and contrast of an object relative to background, building histogram,
calculating image size at different compression levels, analyzing certain lines of an image similarly
to oscilloscope, as well as modifying certain image parameters. By analyzing saved images using
this tool it's possible to calculate sensitivity and resolution of a real camera for precise modeling in
VideoCAD.

6.13 Live video analyzer  tool allows measuring brightness, average brightness and noise in
certain point, as well as screen frame rate in window containing live video created by any program.

6.14 Lamp spectrum analyzer  tool allows to determine the spectral efficiency of any light
source for various camera types based on spectral power distribution curve. Determined value of
spectral efficiency is used in VideoCAD for precise modeling various types of light sources.

CAMERAS

6.15 Table of camera models  support (over 100 parameters for each model), ability of assigning
models for project cameras. It's possible to adjust a view of model table by hiding unnecessary
columns. Table of models supports sorting and filtering. Automatic calculation of sums of power
consumption and prices. Ability of printing tables and their parts, importing and exporting into
Excel, Word, *.txt, *.csv, *.htm.  

6.16 Modern IP cameras support (16:9 Aspect Ratio , different image sensor sizes and
aspect ratio, high image resolution).

6.17 Criteria in Quality levels concerned with limiting image resolution (maximum vertical field of
view size, minimal parts of screen occupied by a license plate and a face) are related to the
number of pixels for modeling and comparing digital cameras with different resolution. These
criteria are now known as: Minimal vertical resolution (pixel/meter) , Minimal vertical size of face
image (pixels)  and Minimal vertical size of license plate image (pixels) . 
 
6.18 Varifocal and ZOOM lens support. Adjusting  lens focal length by moving view area
bound on a layout within set limits using a mouse.

6.19 Icons for internal, outdoor and PTZ cameras may be different .
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6.20 For each camera icon by various line types  can be set. Thus, the camera icons can vary
in color and line thickness.

6.21 Lens focal length  range has been widened to 1000mm.

IMPORT AND EXPORT

6.22 A background  in *.dwg AutoCAD™ 2007 format support, AutoCAD™ PROXY records
support, loading speed of complex *.dxf files is improved. Bug fixed. All ANSI code pages support,
and other improvements concerned with *.dxf and *.dwg files import.

6.23 Export  to*.dxf file is improved. It's possible to set camera icons and illuminator size in
AutoCAD™ units. Ability of exporting large background files.

3D MODELS AND 3D WINDOW

6.24 Several new 3D models  were added, including dark-skinned person for testing the ability
of detecting dark-skinned people at low illumination.

6.25 3D models now can be scaled  in any direction.
 
6.26 3D models can be placed in vertical projection . Models placed in vertical projection will not
be visible in 3D window. 

6.27 Convenient 3D model  selection from the tool bar.

6.28 Raster images  in the 3D window. Usual photos and pictures in *.bmp or *.jpg format can
be placed in 3D space. Raster images can be transparent, and can replace difficult-to-make 3D
models. Raster images can be scaled, placed at any angle, used for modeling variety of objects,
from banknotes and plates to a complex background. 

6.29 Background can be visible  in the 3D window.

6.30 Redraw 3D image only by clicking  mode is convenient in case of complex scenes and\or
slow computers, when image repainting in 3D window takes much time.

6.31 Fixed fuzzy drawing PTZH frame  and titles in the 3D window when using certain video
cards.

6.32 Image parameter panel  with View, Scene, Camera, Processing tabs. Panel can be
activated by right-click or double-click on the 3D window.

6.33 Setting visibility of different objects in the 3D window on View  panel.

6.34  View, scene and equipment parameters are set individually  for each camera. Quality
levels no longer include 3D image parameters.

WINDOWS

6.35 Quality level box  contains corresponding quality level criteria.. 

6.36 Sensitivity and resolution  box with camera and lens parameters.

171

294

222

485

202

283

202

169

205

385

482

387

370

385

371

505

329



VideoCAD136

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

6.37 Camera parameter box has been renamed to Camera geometry . Inherited from older
versions unnecessary interface elements have been removed. Additionally, this box allows to
change aspect ratio , image sensor sizes  and view angles.

6.38 Modeling 16:9  format monitors. Switching day/night  illumination modes on the Monitor
window.

6.39 Tab quantity in the Options box  has been increased.

6.40 Model column has been added to the table in the Camera list  box. Column width can be
adjusted by the mouse. Icon box and  Table of camera models button have been added to the
Cameras list box.

6.41 Appropriate camera is loaded by double-clicking on the Camera list  box. To rename
camera use appropriate pop-up menu item.

6.42 Camera type box has been added to the New camera  box. When creating new camera,
line type can be chosen for it's icon on the Line type panel .

REPORTS AS A TABLE

6.43 Interactive adjustable table  reports including any camera parameter sets. Various types of
tables can be formed by hiding unnecessary columns. Tables support sorting and filtering.
Automatic calculation of sums of power consumption, cable lengths and prices. Ability of printing
tables and their parts, importing and exporting into Excel, Word, *.txt, *.csv, *.htm. Convenient
editing parameters by double-clicking on any cell.

TOOLS

6.44 A New Tool for automatic name generation  and camera serial numeration on layouts.
Various numeration templates and rules.

6.45 A New Tool for counting length sum  of line segments of specified line type. Thus any line
type can be used as a cable.

6.46 A New tools for switching draw order of constructions and cameras:Cameras over
constructions , Bring to front , Send to back . These tools simplify work with complex 3D
models of buildings, grass, etc., where another 3D models can be placed above (or inside) them.

6.47 Show all  tool considers not only cameras, but the background and constructions as well.

6.48 Change line type  tool can change icon line type of selected cameras.

6.49  In order to model windows and transparent objects, inclined rectangle  in the 3D window
can be transparent by 70%.

6.50 Edit  button will appear on the Current construction parameters panel when drawing
construction is complete. Click this button to edit last drawn construction.

INTERFACE

6.51 Assigning and editing keyboard Shortcuts  for items in Graphics window main menu.
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6.52 Rotating cameras  in both planes by moving view area bound on the layout using the
mouse.

6.53 Adjusting lens focal length  by moving view area bound on the layout using the mouse.

6.54 Loading and saving directories are stored. When recalling same operation stored directory is
opened.

6.55 Horizontal and vertical scroll bars and scaling by + - keys to simplify work on portable
computers.

6.56 Tabs  in the Graphics window for fast switching, creating and deleting layouts. Layouts
button has been removed from the Tool bar.

6.57 A combo box  on the Tool bar for fast loading of any camera. Using pop-up menu of the
combo box it is possible to search the camera on the layout.

6.58  A combo box  on the Tool bar for fast assigning a model to the loaded camera.

6.59 Enhanced selecting and loading cameras on the layout using the mouse. Cursor snaps to a
camera icon with higher priority, and it's highlighted with red rectangle.

6.60 Priority of mouse selection  of close objects is presetted: 1. Cameras; 2. Constructions; 3.
Text; 4. 3D models.

6.61 A New algorithm of selecting constructions , located over each other. In order to select
another construction it is necessary to click the same point again.

6.62 Snap sensitivity  can be adjusted for convenient work with different screen resolutions and
mouse accuracy. The snap to a camera has a priority.

6.63 Following info is displayed at the bottom of the Graphic window on the Status bar  when
moving cursor close to a camera icon: name, model name and basic parameters of the camera. 

6.64 Field of view size  on the Status bar in loaded camera edit mode now is displayed when
moving the cursor over view area in vertical projection, not only when clicking.

6.65 Move  mode is set after creating new camera . It's convenient to place new camera on
the layout instantly. 

6.66 ESC key stops current operation. If an operation is not performed, Select/edit  mode is
switched on.

6.67 Current line type  is stored before placing 3D models, cameras and illuminators, and is
restored after placing.

6.68 In case of editing height  values on the Current construction parameter panel during
drawing, new height value will be kept when drawing is complete. Other parameters of construction
located on the Current construction parameters panel are kept as well.

6.69 Loaded camera icon's color is changed to red.

6.70 View>All camera cables  and View>Loaded camera cables  menu item states are not
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stored individually for each camera; they are stored in common project settings.

INHERITED ELEMENTS

6.71 Fast scaling mode by rotating pressed mouse-wheel is disabled due to inconvenience of work
with certain mouse types.

6.72 Title button has been removed from the Tool bar. It  is possible to show/hide titles  using
the main menu item.

6.73 Saving Resolution and Edit Image menu items have been removed from the Main menu.
Resolution can be changed in the Options box on Export  tab.

6.74 Measurement format by default box has been removed from the Options box . When
creating new project, measurement format concurs with measurement format in the current
project.

6.75 Layout combo box has been removed from the New camera  box. The layout of creating
camera always concurs with the current layout. 

6.76 Camera>Save as item has been removed from the Main menu.

OTHER

6.77 VideoCAD Help system is now in Html Help format for compatibility with Windows Vista.

6.78  Help system has been redesigned taking into account user's suggestions and new program
features. Examples  have been renovated.

6.79 Many functions are improved, detected errors are corrected. 

6.80 VideoCAD 6.0 can read projects, created in VideoCAD 4.xx and VideoCAD 5.XX.

6.81 VideoCAD 6.0 has been tested on Windows Vista. All incompatibilities found have been
eliminated. 

6.82 The regulations of upgrading  previous VideoCAD versions to VideoCAD 6:
 

The cost of upgrading amounts the difference between the costs of previous VideoCAD versions
(VideoCAD 3.02, VideoCAD 4.0 or VideoCAD 5.0) and VideoCAD 6.0.
Considerable discounts are offered to the users, whose valuable suggestions have found
application in VideoCAD 6.0. 
At upgrading it is necessary to exchange USB dongle.  

5. What is new in VideoCAD 5.0

5.1 Monitor window  has been added. Monitor window logically finishes the information transfer
process in video surveillance system "from a real object to an operator" and thus, allows to model
the video surveillance system as a hole.

5.2 The new tool in 3D window - PTZH frame  allows operating a camera in 3D window similarly
to PTZ one and additionally to change camera's installation height. Together with the Monitor
window this tool offers a new method  of 3D CCTV design.
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5.3 There is a new opportunity to carry out Depth-of-field  3D modeling.

5.4 There is a new opportunity to carry out 3D modeling visibility  limited by rain, snow, fog
according to the Meteorological Visibility.

5.5 Current construction parameters panel  allows creating and editing constructions by input of
parameters. 

5.6 The Load camera box is essentially modified and renamed to the Camera list box . The
following options are added: 3D image show, search, sorting.

5.7 Snap panel  allows fast switching of snaps during drawing.
 
5.8 An option to set heights in 3D window  separately for each construction, irrespective to a
line type.

5.9 The new tool - Inclined rectangle  allows modeling 3D inclined objects.

5.10 The new tool - Filling  allows creating fillings and hatchings.

5.11 Print preview box  is updated. There is a new option to save exact position of the drawing
and adjustment for reprinting. The print area displacement caused by Line type panel and Font
type panel is eliminated. 

5.12 The new 3D models : a boy and a truck.

 

5.13 The new tools: Combine to block  and Destroy block .

5.14 VideoCAD 5.0 can use files of the following CAD formats as a background :
 

*.dxf  AutoDesk DXF Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006.
*.dwg AutoDesk DWG Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006.

5.15 DWG and DXF reference images, SHX fonts, DXF Autocad Table, Hatch gradients,
Unicode fonts (important especially for languages based on hieroglyphs - Chinese, Korean,
Japanese etc.) are supported in CAD background .

5.16 Visibility of Camera view area  in 3D window can be switched independently of View area
visibility  in Graphics window. 

5.17 Displaying cameras' names  and titles can be switched separately..

5.18 Option to switch on/off the display of view area  and view area projections for all selected
cameras simultaneously. 

5.19 Selected camera changes the color together with it's view area.

5.20 Construction of person detection area  is carried out more precisely, considering additional
inflection of bound. 

5.21 Option to move constructions and cameras in Select/Edit  mode, without switching to
Move mode.
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5.22 While working only with cameras we have a new option to lock constructions . 

5.23 The tool Find loaded camera is updated and renamed to Show loaded camera .

5.24 Number of redrawings in 3D window is reduced for increasing program's speed. For forced
redrawing, click the image in 3D window. 

5.25 Exact position of the drawing is stored at finishing the work with the program and restored at
restart.

5.26 Reloading speed of cameras is increased. 

5.27 The range of drawing scaling is expanded. 

5.28 The range of focal lengths of lens is expanded.

5.29 Many functions are improved, detected errors are corrected. 

5.30 VideoCAD 5.0 can read projects, created in VideoCAD 4.xx.

5.31 The regulations of updating previous VideoCAD versions to VideoCAD 5.0:
 

The cost of updating amounts the difference between the costs of previous VideoCAD
versions (VideoCAD 3.02 or VideoCAD 4.0) and VideoCAD 5.0.

 

For users, whose valuable suggestions have found application in VideoCAD 5.0, updating is free
of charge.

4. What is new in VideoCAD 4.0  

4.1 There is a possibility of full value 3D designing  of a video surveillance object with  loading
prepared 3D models  (a man, car and other) and getting images from cameras in the project.  

4.2 It has become possible to model the 3D image quality from each camera through the image
quality parameters , based on the real videosignal distortions. 

4.3 Line type parameters  include minimum, maximum height and color in the 3D window.
The number of line types has increased to 100. 

4.4 There are new system fonts  and line types :
title font in the 3D window;
sharpness area line;
focus plane line;
hyperfocal distance line;
3D model line.

4.5 Test object  became 3D parallelepiped. Test object can be seen in the 3D window.

4.6 There is the depth-of-field  and hyperfocal distance calculation.

4.7 There is a support for all *.dwg file formats as a background : *.dwg AutoDesk Release
12, 13, 14 , 2000, 2002, 2004.
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4.8 It has become possible to export  obtained drawing to the file of *.dxf format on several
layers. It is convenient to process the obtained file in AutoCAD.  

4.9 It has become possible to change the scale factor  of nonscalable elements when
exporting. 

4.10 There is a new function of saving drawing - Save as background .

4.11 It has become possible to print and export together with the prepared frames with Title-
Blocks.

4.12 The scaling range and grid step is expanded. Now maximum grid step is 500 m, and
maximum area displaying on the screen is 15x20 km (more than 200 square kilometers). 

4.13 It has become possible to change the scale factor  when clicking the button Zoom in,
Zoom out and by turning the mouse wheel. 

4.14 There are new means of navigation Show all , Find text  and Zoom window . 

4.15 Image refreshing is realized without blinking  due to the using the graphics buffer. 

4.16 The speed of image repainting with a big number of video cameras is increased. 

4.17 The text  scaling accuracy has become higher. Now Title Blocks and other tables can be
filled without a risk of strings getting out of the frames.  

4.18 It has become possible to select one or more constructions located  one over another.  
 
4.19 The Main window is renamed to The camera parameters box . When launching
VideoCAD first Graphics window loads. For  showing the camera parameters box the button Show
Camera parameters box   is used. 

4.20 Real view area  filling now is not solid, but as hatching. Due to this it doesn't shade other
objects.  

4.21 Graphics background files  themselves, not the references to their loading, are included in
the project file.    

4.22 All information on program settings (line types, fonts, etc.) is included in the project. 

4.23 The current project is saved now in the VideoCAD database and at the next program
launching the last project, on which you worked, will be available and exactly in the place, on
which you broke the work.    

4.24 There is a context help not only for the menu items, but also for the tools on the tool bars.
To get the context help for the button click it by the right mouse button and then by the appeared
Item "What's this?". 
     The context help is still available for the menu items and other interface elements. To get the
context help for the menu item or the interface element select it and press F1.  

4.25 Now the recommended operating system is Windows XP. When working in other operating
systems big graphics file displaying errors are possible. 

219

480

222

226

480

246 247 162

480

201

189

289

186

175

222



VideoCAD142

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

4.26 From the tool bar  and the main menu  of the graphics window unnecessary buttons and
items are deleted.   

4.27 Default parameters of quality levels  are changed. 

4.28 Examples are  remade taking into account new possibilities of the program. The example of
the person identification criteria determination  according to the real image  is included. 

4.29 Many functions are improved, detected errors are corrected.    

4.30 Multilingual version of VideoCAD 4.0 has the possibility of registration with the dongle .  

4.31 VideoCAD MAP is released. VideoCAD MAP is a graphical interface for security systems on
the basis of VideoCAD technology. VideoCAD MAP includes all possibilities of VideoCAD and
many other additional functions, is partly compatible with VideoCAD by the projects and integrated
in the Russian Integrated security system "Intellect".    

4.32 The regulations of updating previous VideoCAD versions to VideoCAD 4.0:
 

For buyers of VideoCAD 1.0, i.e. for our first buyers, the updating is free-of-charge.
For the others the cost of updating amounts the difference between the costs of VideoCAD
3.02 and VideoCAD 4.0.
For those, who have bought more than one VideoCAD licenses at once, the updating is
chargeable only for one license. Other licenses can be freely updated.      

3. What is new in VideoCAD 3.0

3.1 The opportunity of loading  the prepared layouts as a background in *.bmp, *.jpg, *.emf,
*.wmf, *.dwg, *.dxf formats was introduced. To display *.dwg and *.dxf files the CAD Import
module by CAD Soft Tools  http://www.cadsofttools.com was used.

3.2 The obtained drawing can be saved  in *.bmp, *.wmf, *.emf formats or copied   to
clipboard in *.bmp, *.emf  formats.

3.3 The opportunity of quality printing , including the one on several pages to glue them was
introduced.

 
3.4 The opportunity of using  texts  was introduced.

3.5 The opportunity of using various fonts  and line types   was introduced.

3.6 New object is a Mask . The masks allow to cover any part of a drawing. It is possible to
draw new constructions over masks.

3.7 New objects is a Circle , an  Arc , a Double line .

3.8 New operations are  Align , Move loaded camera name .

3.9 The opportunity to undo  the last four operations was introduced.

3.10 The opportunity of using a constant coordinate system , that is  not dependent on the
loaded camera, was introduced.
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3.11 The speed of redrawing the drawing containing many constructions and cameras was
increased.

3.12 The size of a project file was reduced.

3.13 The maximal quantity of objects on each plan was increased up to 5000 and the maximal
quantity of cable segments of each camera was increased up to 500.

3.14 The opportunity of precise scaling using Ctrl   was introduced.

3.15 The opportunity of quick navigation using the mouse wheel was introduced.

3.16 The opportunity of operating with inches and feet  was introduced.

3.17 The opportunity of changing  the size of a rectangle without distorting its shape was
introduced. 

3.18 The displaying view area edges , view area projection bounds  and view area actual
projections  can be switched on/off separately.

3.19 The opportunity of copying and pasting  constructions, cables and texts between projects
was introduced. 

3.20 Many existing functions have been improved, discovered errors have been corrected.
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7 Definitions

Camera view area
 

A dimensional figure in shape of a near-
pyramid with vertex abutting the camera lens
and bisector, coinciding with the main optical
axis of the camera lens. 
Any object within the view area will be
displayed on the screen, if it is not shaded by
other objects on the scene.

View area has the form of a regular pyramid
only if lens distortion  is negligible. The lens
distortion complicates the form of the view
area. 

 

View area projections
 

Horizontal projection of the view area can be displayed as a volume projection (Projection) or in
the form of two sections of the view area on two levels (2 levels). Type of displaying for the active

camera  is selected in the pop up menu of the    View area projection bounds  button.
 

In the case of the volume projection
(Projection):
 

It is displayed as projection to horizontal plane of
a view area part, which is residing between the
view area upper  and lower bounds
specified in parameters  in the Camera
Geometry box .
 

View area horizontal projection is calculated
according to the rule:
 

A point on the horizontal projection is considered
visible if a vertical segment, formed by this point
in the range of heights from the view area lower
bound height  to the view area upper bound
height , is visible wholly.
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In the case of 2 sections (2 levels):
 

Instead of the volume horizontal projection, two
sections on the view area upper bound height

 and on the view area lower bound height
are displayed simultaneously.

 

Camera control area
 

A complex dimensional figure inside view area.  
Camera control area forms by subtracting shadows
of environment objects (uncontrolled areas) from
the camera view area.
Any object within the control area will be displayed
on the screen.
 

In the Graphics window  VideoCAD
calculates Horizontal projection  of the control
area.  In the  3D World  window, the Camera
control area is represented in 3D by  View area
faces  and Active camera coverage .

Control area horizontal projection 
 

 Horizontal projection of the control area can be
displayed as a volume projection (Within
projection) or in the form of two sections of
the view area on two levels (2 levels).  Type of
displaying for the active camera  is selected

in the pop up menu of the    Shadow
button.

In the case of the volume projection (Within
projection):
 

Projection to horizontal plane of a control area
part, which is residing between the view area
upper  and lower bounds  specified in
parameters  in the Camera Geometry box .
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Control area horizontal projection is calculated
according to the rule:
 

A point on the horizontal projection is considered
visible if a vertical segment, formed by this point
in the range of heights from the view area lower
bound height  to the view area upper bound
height , is visible wholly.

In the case of 2 sections (2 levels):
 

Projection of the control area is displayed by 
two sections  of the view area by the
horizontal planes located at the lower  and 
upper  bounds of view area.  Shadows from
obstructions are deducted from these sections.
 

See also: 3D World> 3D View area , 3D
World> Active camera coverage .

Projections of person detection area
 

Projections to horizontal and vertical planes of a view area part meeting person detection criteria
.

 

Projections of person identification area
 

Projections to horizontal and vertical planes of a view area part meeting person identification criteria
.

 

Projections of license plate reading area
 

Projections to horizontal and vertical planes of a view area part meeting license plate reading
criteria .

 

Camera Field of View
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A flat figure limited by view area bounds and residing in a
plane, perpendicular to the main optical axis of camera
lens.
 

The field of view has rectangular form only if lens
distortion  is negligible. The lens distortion complicates
the form of the field of view. 

 

Camera resolution in LPH - lines per picture height
 

Lines per Picture Height (LPH) - is an unit of measuring image resolution. It equals the
number of distinct lines in the image (the sum of the black + white lines ) were placed at the size
equal to the height of the frame.
 

Analog cameras have limited vertical resolution because of a fixed number of horizontal lines ,
therefore, the resolution is a number of vertical lines along the horizontal, not over the entire width
of the frame but along a part of the width equals to the height of the frame.
In this case, the Lines per Picture Height equal to the television lines (TV - lines ) .
If we assume number of lines across the whole width , the number of lines must be divided by the
ratio of the horizontal to the vertical frame size (Aspect Ratio ).
 

In VideoCAD camera resolution   is determined by the number of lines per picture height (LPH),
wherein the contrast of the lines drops to a predetermined portion of  contrast of the widest lines
( 10 %, 20 %, 30 %, 50 %).
In the 3D Video window you can watch the resolution LPH using the Test chart  that is set up
so that visually displays the resolution in LPH regardless of aspect ratio.

 

Image sensor size and size of active area of the image sensor
 

The Image sensor size in VideoCAD implies the size of the entire light sensitive area of the
image sensor, which can form an image with the maximum number of pixels horizontally and
vertically.
 

Active area of the image sensor in VideoCAD implies an area of image sensor on which in a
given mode of the camera the image is formed. The sizes of the active area may be less than or
equal to the image sensor size. Active area can differ in different modes of operation of the same
camera.
 

Exactly the active area size and lens focal length  determines the angles of view, and
through them influences on the results of camera modeling. Accuracy of specifying the active
area size greatly affects the accuracy of modeling the camera.
 

Aspect ratio of the active area of image sensor is identical with the aspect ratio of the
output image of the camera, but can differ from the aspect ratio of the image sensor.
 

On the figure on the right you can see the image
sensor size and the active area of the image
sensor in case of the image sensor has aspect
ratio of 4:3, but the output image from the camera
has aspect ratio of 16:9.
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See also: Specifying active area size of the image sensor

Camera tilt angle
 

 Camera tilt angle is a calculated parameter and can not be edited directly. The camera tilt angle
is an angle between the main optical axis of camera lens and a horizontal. 
 

Camera inclination is defined not by the tilt angle
but by the three parameters:  
 

Height of installation ;
View area upper bound distance
View area upper bound height

 

Zero ground
 

Zero height level, relative which  the base height of layer , base height of cameras  and
ground height  in the 3D World window are determined.
 
Relative the base height of layer, heights of all constructions  on this layer, illuminators
and 3D models  are determined. 
Relative the base height of camera, heights associated with the camera: installation height ,
view area lower bound  and upper bound  heights, the height of the criteria of detection ,
dentification  and license plate reading , measurement height of spatial resolution ,
height of the test object  are determined.

 

Background
 

It is a prepared horizontal site plan in any of the following formats:
 

*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format  (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.pdf - cross-platform electronic document format from Adobe Systems;
*.jpg, *.png, *.gif, *.tif  - the compressed image (e.g., a digital picture of the plan, scanned
image);
*.wmf, *.emf, *.emf+ - Windows Metafile (export to *.wmf is supported by the majority of the
Windows  graphics applications).
 

Over the background, cameras, constructions and 3D models can be drawn.
 

AutoCAD DXF and DWG formats allows additional possibilities:
lines and polylines from the buckground can be imported to VideoCAD constructions using 
Import DXF / DWG background  tool;
VideoCAD cameras and constructions can be added  to the AutoCAD background to special
layers;
you can control  visibility of layers of such background, hide texts.

 

Compatiability with AutoCAD versions
 

VideoCAD 8.0 can use files of the following CAD formats as a background:
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*.dxf  AutoDesk DXF Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006, 2007, 2008, 2009, 2010,
2011, 2012, 2013, 2014, 2015.
*.dwg AutoDesk DWG Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006, 2007, 2008, 2009,
2010, 2011, 2012, 2013, 2014, 2015.

 

Software registration by personal registration code  (applied for all versions

except VideoCAD Professional)
 

After installing the program you must enter personal pair of the name and the registration code,
which is valid on any computer. USB dongle is not required.
 

If the license provides limited number of workplaces, attempt to run the program on more
computers may produce error. 

 

Software registration on USB Dongle basis  (applied for VideoCAD

Professional)
 

The program is operable on any computers to which port the dongle is connected. So you can
carry the program from computer to computer, modernize computer, etc.  
 

In the past USB dongle was used for VideoCAD6, VideoCAD 7 Lite, VideoCAD 7 Professional.
Now it is used for VideoCAD 8 Professional only.
 

When you purchase a new license of VideoCAD 8 Professional Kit, one license of VideoCAD 8
Lite  can be supplemented free of charge. This minimizes the inconvenience of having to use
the USB dongle with VideoCAD Professional.
 

The dongle should be connected to the USB port of you computer.
 

You can get more information on USB dongles in the USB dongle  topic.
 

Software protection on HID identifiers basis (not used for new licenses)
 

In the past HID protection was used for VideoCAD1..VideoCAD6, VideoCAD 7 Lite. Now it is not
used for new licenses.
 

The registration is realized with the tie to your computer parameters. After computer change, hard
disk formatting or other serious upgrade you will need a reserve registration. 
 

Although the number of reserve registrations is limited to two, the registration counter cleaning is
regularly realized. So you won't lose the purchased program in any case. If you spend all reserve
registrations before the registration counter cleaning, you will have to wait for the next registration
counter cleaning to continue using the program. 

 

You may exchange the variant on the HID protection to the variant with the dongle protection,
paying in addition for the cost of the dongle and delivery.    
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8 Getting started

These illustrated teaching articles with step by step instructions will help you to get started with
VideoCAD quickly:

The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
The principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification
area, license plate reading area. Spatial resolution.""(*.pdf) 
The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf) 
The principles of CCTV design in VideoCAD. Part 4. Illumination and camera sensitivity in CCTV"(*.
pdf)
The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving objects."(*.pdf)
The principles of CCTV design in VideoCAD. Part 6. Lens distortion in CCTV design."(*.pdf)

See also: Examples of work  with VideoCAD , CCTVCAD Software on Youtube

VideoCAD employs a context-sensitive help system. This means that the program tries to direct
you to the portion of the help system that is most likely to answer your question, based on what you
are viewing or doing. 
To get detailed information about any component, box or menu item, move the input focus (mouse
cursor) to the component and press F1.
To get detailed information about any button on the Tool bar, right click on it then choose What's

this? pop-up item.

527

http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part1.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part2.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part2.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part3.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part4.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part6.pdf
https://www.youtube.com/channel/UCzUpVg--DCi-1Q_y0mZ0Zmw
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9 Interface

The VideoCAD 8 Professional interface consists of the Graphics window  and the
additional windows and boxes:
 

Camera Geometry
Sensor and Lens
Sensitivity and Resolution
Spatial resolution
3D Video
3D World
3D Models
Monitor window
Table of Camera Models
Table of Cameras
Depth of field calculation box
Illuminator calculation box
Options box
Person detection area size box
Person identification area size box
License plate reading area size box
Quality level parameters box
Criteria editing box of person detection area  
Criteria editing box of person identification area  
Criteria editing box of license plate reading area  
Test object box
Camera list
Serial numeration of cameras
Layouts
Layers
Signal cable length calculation box
Power cable electrical parameters and length calculation box
Length calculation of line segments
Image sensor calculator

You can open any window or box from the Graphics window.

VideoCAD employs a context-sensitive help system. This means that the program tries to direct
you to the portion of the help system that is most likely to answer your question, based on what you
are viewing or doing. 
To get detailed information about any component or menu item, move the input focus (mouse cursor)
to the component and press F1.
To get detailed information about any button on the Tool bar, right click on it then choose What's
this? pop-up item.
 
Mouse: 
 

Any Wheel Mouse is particularly convenient when changing parameters and moving along layouts in
the graphics window.
 

In all the windows except for the Graphics window the use of mouse is almost the same as when
using it with other Windows programs. The use of mouse in the graphics window is reviewed in the
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9.1 Graphics window

 
 

It is the main window of the program. 
The window is designed for the visual cameras' view area and control area representation and
analysis, visual choice of lens parameters and camera locations, calculation of cable parameters and
a 2D drawing preparation to be pasted into graphical path of the project.
During 3D modeling , all work of placing and editing 3D models is carried out in the Graphics
window too.
 

The graphics window contains:
 

Graphics area
Main menu
Tool bar
Status bar
Line type panel
Font type panel
Current construction parameters panel
Layout tabs
Layers
Horizontal and vertical scroll bars 
Snap panel
Keyboard shortcuts
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9.1.1 Graphics area

See  Graphics area location .
 

The graphics area contains two projections of the current layout . 
 

A thick black line designating the ground in vertical (upper) projection parts these two projections. 
 

You can hide any projection using the tools Hide horizontal projection   and Hide vertical

projection   or using the corresponding items of the Main menu .
 

Main work is carried out as a rule in the horizontal projection. Vertical projection is used only in
some cases.  In the Vertical projection cameras and constructions are shown relative to the ground
without taking into account  base heights of layers  and base heights of cameras .

Navigation
Coordinate systems
Types of objects
Possible states of objects

Normal state
Selected state
Editing state ( active state of cameras )
Hidden state

Graphical editing state of active camera

Navigation
 

Wheel Mouse is particularly convenient when working in the graphics window. Using the Wheel
mouse you can change drawing scale with the simultaneous zooming in the drawing sections

pointed by the cursor.  
 

If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation. 
If Ctrl is pressed, the scale changes with the less step which is convenient for the precise drawing
positioning before printing  or saving . 
 

The Step and direction of scaling can be changed in wide range via Scale factor  in the Options
box.

You can move the drawing by pressing and holding down the mouse wheel (or the middle
button). If Ctrl is not pressed, the entire drawing is dragged, if Ctrl is pressed, the horizontal
projection is dragged only.

You can move drawing using horizontal and vertical scroll bars.
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
 

To increase any screen area press in the corner of the
area and hold the right mouse button then move the
mouse with the right button pressed. At the same
time you will see zoom window. After releasing the
button, the area inside the zoom window will be shown
on the full screen.

 

There is an opportunity of quick navigation with the help of text markers .
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Since all the constructions in VideoCAD are made by two clicks, but not by pressing and release
the mouse button (as in most CAD programs), so it is very convenient to combine constructions
with quick navigation. 

 

To show all cameras and constructions, use item of the Main menu or Pop-up menu: Scale>
Show all .

Coordinate systems
 

The graphics area allows to use 2 coordinate systems :
 

Fixed coordinate system
Float coordinate system attached to the Active camera

 

In case of Fixed coordinate system, the origin of coordinates does not vary when changing the

active camera. The origin of coordinates is displayed by two icons  in horizontal and vertical
projections. You can change a point of origin after choosing the menu item View > Set origin .
 

In case of the coordinate system attached to the active camera, the origin always coincides
with the active camera location. It is convenient when studying its view area.
A grid  is fixed to the origin of coordinates, and the counting of the cursor current
coordinates in the status bar  starts from the origin.

Types of objects
 

The graphics area may contain the following objects:
 

Cameras
Constructions
3D objects
Illuminators
Backgrounds
Cables
Texts
Titles

 

Possible states of objects
 

All the objects except for the backgrounds and titles can take one of the following states:
 

Normal ;
Selected ;
Editing  (active state of camera);
Hidden ;
Graphical editing state  of active camera.

 

You can change object's state with the help of the Select/Edit  tool.
To hide objects use the Hide  Main menu item.

To switch the active camera to the graphical editing state use the Edit active camera  
button .

Normal state
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An object is displayed in its usual color. Editing
and moving is not possible.

 

Selected state
 

An object is displayed in pink color. It is
possible to delete, drag, move, rotate,
change draw order, scale, mirror and copy
the object. 
  

Several objects can be selected at a time.
 

You can select objects by clicking or by
capturing by the selection window in the

Select/Edit  mode.
 

See Select/Edit  for details.
 

Selected Illuminator displays its Light
intensity distribution curve.

 

If a 3D  model  has non zero speed, then

the velocity vector is displayed.

 
If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model passes
per second (crimson arrow).
If 3D model is in the normal state, the length

of the velocity vector equals to the distance

which the 3D model passes for the period
between successive frames of the Active
camera  (black arrow).
 

The length of the velocity vector of a 3D model in the normal state is inversely proportional to the 
frame rate  of the active camera. Thus we can see how many times the moving 3D model gets
into the frame of the active camera.

Editing state ( active state of cameras ) 
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Object's base points are marked with pink
grips, camera name and icon are marked
with red color, texts are displayed in pop-up
frame. 
 

In the editing state, 3D models  are
displayed with square grips and pink circle.

The editing state can be taken only by one of
the objects and one camera at a time. 
One of the cameras is always Active.
 

Switching an object to the editing state is
performed by double clicking the object in the

Select/Edit  mode. 

To switch  circle  into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
To switch arc  into the editing state you need to double-click on its center or on either of its
two ends.
To switch illuminator  to editing state double-click on its center.

How to edit objects

 

You can change the shape and geometrical sizes of the objects and edit the texts. The line
types  of the objects and the fonts  of the texts can be changed, too.  
To edit an object click beside a base point with a grip and move the cursor. After clicking for
the second time, the changed object will be saved.
When on one side of a construction a circle appears, the construction can be rotated around
its axis by gripping the circle by the mouse.

When editing a rectangle  or a mask , then several points will move at a time, the
rectangle or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
 

When editing the Double line  or Wall , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved. 
 

When clicking the text  twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.

To edit parameters of illuminators   move pink grips keep Ctrl
pressed.
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You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the
3D model, as well as in the selected state.. Sizes of 3D models can be edited with the help of
the Current construction parameter  panel or by changing line type .

 

You can edit the  velocity vector  of 3D model in editing state
by moving its terminus.

 
 It is possible to change object's parameters in editing state on the current construction
parameters panel  which automatically appears in the bottom of graphics window.
You can edit the object by changing parameters on the panel.

Active camera

 

Pay attention that the icon of one of cameras is highlighted in red, and icons of other
cameras are colorless. One of cameras is always active.

 

The active camera parameters are
displayed in the Camera Geometry box
, Sensitivity and Resolution , Depth of
field box , Spatial resolution .
The active camera itself is displayed on
the foreground in the Graphics window. 

In the 3D Video  there is an image from the active camera.

To switch camera to active state double-click on the center of its
lens.
You can fast activate any camera in the project using the Active
camera  combo box on the Tool bar. To activate a camera,
just choose its name in the list. 
To find the active camera on the layout, right click on the combo
box then choose Find camera item.

The active camera parameters can be changed both using the boxes and graphically with the
tools of the Active camera group .  With the help of the View  button group you can
change the appearance of view area projections of the active camera.

For tilting and panning the active camera on the layout in Select /edit  mode:
 

Move the cursor to the pink grip in the middle of the view area
bound. Thereupon, the point will be outlined by red square;
Click on it by mouse;
Move the cursor;
To stop tilting or panning click once again on a point where the
middle of the view area bound is to be located.

To change lens focal length  of the active camera on the layout in Select /edit
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mode:
 

Move the cursor to any orange grip on the ends of view area
bound. Thereupon, the point will be outlined by red square;
Click on it by mouse;
Move the cursor;
To stop changing focal length click once again on a point where
the end of view area bound is to be located.

Hidden state
 

An object is displayed on the background in light
grey color. 3D objects are displayed as grey
frames. The rest characteristics are similar to those
of normal state. 
 

The hidden state is used to conceal the
temporarily interfering objects. 
 

Constructions in the hidden state is not exported 
to AutoCAD formats .
 

The snap Extension  is disabled for hidden
objects.
 

Several objects can be hidden at a time.
 

To hide an object use Select/Edit  and Hide
tools.

See also: Layers - Hidden ;

Graphical editing state of active camera
 

The Active camera  can take the Graphical editing state . In this case the objects in the
horizontal projection rotate so that the direction of the camera lens main optical axis becomes
parallel to a screen plane, and the bounds of active camera view area are marked with lines of
double thickness. 
 

The lower  and upper  bounds of view area displayed by horizontal green lines.
If the active camera has spatial resolution  displayed, the horizontal red line indicates height
of spatial resolution measurement.
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The graphical editing state enables a detailed analysis of view area using the test object , in
the vertical projection it becomes possible graphical calculation of depth of field,  spatial
resolution analysis and field-of-view sizing  at any point of view area. In the graphical editing
state the Test object is visible in the 3D Video .
 

In the graphical editing state  of the active camera, selection and rotation of the active camera is
blocked to prevent displacement of the background, constructions and cameras relative to each
other on other layouts.
 

To switch active camera to the graphical editing use the Edit active camera   button .
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9.1.2 Tool bar

 

See Tool bar location .
 

Visibility of buttons on the Tool bar can be adjusted on the  Toolbar  tab of the Options box.

'Project' button group
 

  Save project

"Camera" button group

 

  New

  Save to project

  Camera list

  Table of cameras
Combo box Active camera

"View" button group
 

  View area edges

   View area projection
bounds

   Fill projections

   Spatial resolution

   Shadow

  3D view area

  Person detection area

  Person identification area
 

  License plate reading
area

  Test object

  Layers
Combo box Model of active
camera

  Table of camera models

Combo box Lens focal length

  Camera Geometry

  Sensitivity and
Resolution

  Spatial resolution

  Depth of field

  3D Video

  3D World

  Monitor window

"Grid" control element
group

 

   Grid selected step box

  ON/OFF mode of
automatic grid step selection

 

  ON/OFF grid displaying
 

"Edit" button group  
 

  Stop operation

  Erase  

  Select/Edit

  Cut

  Copy  

  Paste

  Move

  Rotate

  Scale

  Mirror

  Move to active layer

"Construction" button
group

 

  Point

  Horizontal line

  Vertical line

  Line segment

  Polyline

  Angle

  Rectangle

  Inclined rectangle

  Double line

  Wall

  Aperture in Wall

  Circle

  Arc

  Stairs

  Focal plane

  Optical axis

  Text

  Mask

  Filling

  3D model

  3D image

  Rotakin

  Illuminator

  Field-of-view size in point

  Test object location  

  Signal cable

  Power cable

  Global snaps

"Active camera" control
element group

 

  Change installation height
 

  Change view area upper
bound

  Change view area lower
bound  

  Move active camera

  Show active camera

  Edit active camera

"Scale" button group
 

  Move drawing

   Zoom in/zoom out

'Undo' button group

  Undo

  Redo
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  Hide vertical projection

  Hide horizontal projection
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9.1.2.1 Tools

 

See Tool bar location .
 

Visibility of buttons on the Tool bar can be adjusted on the  Toolbar  tab of the Options box.

'Project' button group

   Save project
 

Save working project to a file.

"Camera" button group
 

  New
 

Create new camera with default parameters. 
 

 In the dialog box appeared you can change
camera number, name, type of the camera
which determines the kind of icon by which it
will be displayed. If necessary, you can enter
additional information on the created camera
(for example: purpose, a place and features of
installation). 

 

Later it is possible to change name, number, type of the camera and the additional information in
the Camera list  box.
Cameras can be numerated sequentially with the help of the Numerate cameras  tool.
Cameras are displayed by different icons only if the Display camera type  box in the Options
box  is marked.
 

On the Line type panel  it is possible to choose line type  by which the icon of the camera
and View area projection bounds  will be drawn. When displaying spatial resolution  is
disabled, projection will be filled  (hatched) by the color of assigned line type. Later it is possible
to change line type using Change line type  tool.
Hatch style  is determined by style of a line type , assigned to the camera (solid, dash, dot,
dash dot etc.).
 

After entering all necessary data click OK, to cancel the operation click Cancel.
 

If there is already a camera with chosen number in the current project, VideoCAD will ask to
specify, whether you would like to rewrite it.  
After camera creation specify by clicking a place for the new camera on the layout.
Just after camera creation the moving mode will be switched on. When placing will be completed,

click   Select/Edit  button or press ESC.
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It is convenient to create new cameras with already set parameters by copying  and pasting
existing ones.

 

At the moment of placing new camera  or pasting  copied camera, its base height  is set
to the  base height of the active layer . 

  Save to project
 

All the specified and calculated parameters of the Active camera  and layout are saved to
the current project. 
 

Saving is performed automatically at many operations.

  Camera list
 

Clicking this button opens Camera list box, in which camera list of current project is displayed.
Active camera  is highlighted by red frame. Any camera can be activated, removed, renamed,
found on layouts, it is possible to show 3D image from any camera. It is also possible to sort
cameras in the list. For carrying out any manipulations with the camera first select its name in the
list by single clicking.
 

See more: Camera list

  Table of cameras
 

Show interactive Table of parameters of all cameras in the project. The table can be exported to *.
txt, *.csv, *.htm, *.rtf, *.xls formats.
 

See more: Table of cameras

  Active camera combo box
 

Using the combo box, you can fast activate any camera in the project. To activate a camera, just
choose its name in the list. 
To find the active camera on the layout, right click on the combo box then choose Find camera
item.

"View" button group
 

  View area edges
 

Show the Active camera view area edges, calculated according to parameters  in the Camera
Geometry box. 
 

Line type can be changed in the options box .
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When View area projection bounds  is
disabled, but Shadows  is enabled, the View
area edges  is shown simplified in the form
of two rays if the angle of camera rotation
around its axis  is multiple of 90 degrees
(Camera 2) or in the form of one ray if the angle
of camera rotation around its axis  is not
multiple of 90 degrees  (Camera 3).

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then for this camera the
line type of View area edges is taken from the
Options box>Lines>System line types>Bounds

. This line type is assigned to new cameras
by default (Camera 32 on the figure).
 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, the View area edges of this camera is
drawn by this line type assigned to the camera,
as well as the View area projection bounds
and camera icon.  (Camera 33...38).
 
Thus you can draw different cameras and their
view areas by different colors, thickness and
line style.

 

A button state at the moment of camera saving determines whether the view area edges of the
given camera will be displayed when this camera is inactive.
 

If selected cameras exist on the current layout, except the active camera, this button changes

view  and operates the visibility of View area edges of all selected cameras simultaneously. 

   View area projection bounds
 

Show the bounds of the Active camera view area projections or sections of the view area on two
levels calculated according to parameters  in the Camera Geometry box.

 

Submenu of the button:
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1.   Projection  - show View area projection
bounds of the active camera. 
 

Projection is calculated according to a
simple rule:

 

A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of
heights from the view area lower bound
height  to the view area upper bound
height , is visible wholly.

 

2.  2 levels - simultaneously show 2

sections of the view area by 2 horizontal
planes, located on the height of the lower
and upper  bounds of the view area.
 

The upper section is shown by thick lines.
If in the submenu of the Fill projections
button Filling is chosen, the section of the
lower plane is displayed as filling, and the
section of the upper plane as hatching
(Camera 35).

 

If in the submenu of the Fill projections
button Hatching is chosen, the section of
the lower plane is displayed as hatching,
and section of the upper plane as filling
(Camera 36).

 

When visualizing spatial resolution  with two
levels, the lower section is not at the view area
lower bound but at the height of measuring
spatial resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
 

if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in  VideoCAD7 and earlier
versions ) .
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Difference between the View area projection bounds and Shadows  buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
 

3. Off. - don't show.
 

When View area projection bounds is disabled, but Shadows  is enabled, the View area
edges  is shown simplified in the form of two rays if the angle of camera rotation around its
axis is multiple of 90 degrees or in the form of one ray if the angle of camera rotation around
its axis  is not multiple of 90 degrees.
 

If the line type of camera  coincides with default line type for camera icons, specified in the
Options box , then for this camera the line type of View area projection bounds is taken
from the Options box>Lines>System line types>Bounds . This line type is assigned to new
cameras by default.
 
If another line type was assigned to the camera, the View area projection bounds of this
camera is drawn by this line type assigned to the camera, as well as the View area edges  and
camera icon.
  

A button state at the moment of camera saving determines whether the bounds of the given
camera view area projections will be displayed when this camera is inactive.
 

If selected cameras exist on the current layout, except the active camera, this button changes

view  and operates the visibility of View area projection bounds of all selected cameras
simultaneously. 

  Fill projections

Hatch or fill by blend color view area projections of active camera  ( if these projections exist)
calculated according to parameters in the Camera Geometry  box.
 

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then hatching (filling)
projections of this camera is performed by grey
color by default (Camera 30 on the figure).
 

If another line type was assigned to the
camera, then hatching (filling) projections of
this camera is performed by a color of this line
type assigned to the camera. (Camera 41,42).

If the Spatial resolution  is enabled, then
colors of hatching (filling) projections is 
determined by Spatial resolution parameters
(Camera 43).

 

Drop-down menu:
 

1.   Ha tching   - hatch projections.
 

2.  Fill ing  - fill projections by blend semitransparent color.
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If the Hatching item is chosen, but in the drop-
down menu of the Spatial resolution  button
the Gradient item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.

Transparence of filling in the Graphics window
can be adjusted in the Options box .
Transparence of filling in the  3D World window
can be adjusted in the 3D World .
 

 If in the submenu of the View area projection
bounds  button, 2 levels is chosen then:

If in the submenu Filling is chosen, the
section of the lower plane is displayed as
filling, and the section of the upper plane as
hatching (Camera 35).

 

If in the submenu Hatching is chosen, the
section of the lower plane is displayed as
hatching, and section of the upper plane as
filling (Camera 36).

 

3. Off - don't hatch and fill view area projections.
 

If Off is chosen in the Fill projections and
Shadows , then filling view area faces  in
the  3D World  is not shown. 

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then for this camera Filling
is performed by Gray color and Hatching by 
DiagCross style. (Camera 32)
 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, then for this camera filling is
performed by a color determined by  color of
the line type and hatch style is determined by 
style of the line type (Camera 33...38).
 
Thus you can fill and hatch projections of
different cameras by different colors and hatch
styles.

 

A button state at the moment of camera saving determines whether the filling or hatching of the
view area projections of the camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the active camera, this button changes view 
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and operates the visibility of filling (hatching) projections of all selected cameras simultaneously.

   Spatial resolution
 

Fill in different colors regions on the view area projections of the active camera, depending on
the spatial resolution within these regions.
Colors of the regions and the boundary values of the spatial resolution are determined by the
spatial resolution pattern assigned to the camera.
In the Spatial resolution box  you can edit the patterns and assign them to cameras.

 

Drop-down menu:

1.  Discre te  co lo rs  -  fill the regions in discrete colors in accordance with a spatial resolution
at the far bounds of the regions.
 

2.  Gradient - fill the view area projection in gradient color according to the spatial resolution at
each point on the projection.

 

In case of gradient color is chosen, the colors at the far region bounds equal to the colors of the
spatial resolution pattern, but between the bounds color changes smoothly, as well as real
spatial resolution.
Gradient reflects the spatial resolution more accurately and looks impressive, but discrete colors
are more intuitive and easy to use..

If the Gradient item is chosen, but in the
drop-down menu of the Fill projections
button the Hatching item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.

 

Calculation of gradient demands a lot of resources and increases redraw time.
 

3. Off. - don't display spatial resolution
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If in the submenu of Shadows  button or 
View area projection bounds  button (when
Shadows is Off) the 2 levels is chosen, then
lower section is not at the view area lower
bound but at the height of measuring spatial
resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower
bound ;

 

if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in previous versions ) .

In the active camera editing mode , the
regions of spatial resolution can be displayed
in the vertical projection, with the height  of
spatial resolution measurement (horizontal red
line).

In the Dome  mode the Spatial resolution is calculated without tak ing into account pan and tilt
angles of camera. It is assumed that the camera can pan and tilt freely, and spatial resolution is
calculated at the center of the field of view.
 

The  Spatial resolution button controls
displaying spatial resolution on 3D view area
and the Coverage  in the 3D World 
window .

 

A button state at the moment of camera saving determines whether the spatial resolution of the
camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the Active camera , this button changes view 

( ) and operates the visibility of spatial resolution of all selected cameras simultaneously.
 

See also: Spatial resolution box , Visualization of the camera control area projections and
spatial resolution within them .

   Shadow
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Display horizontal projection of the view area of
the active camera taking into account
shading from constructions  and 3D models

.

 

Shadows - a powerful yet easy-to-use tool of VideoCAD. Shadows are calculated for all
positions of cameras, shading objects can be located at any point of space. You should only
enable calculation of shadows with the help of this button.
 

Shading takes into account the camera installation height and all 3 coordinate of constructions and
3D models (including heights).
 
Drop-down menu:
 

1.  Within projection - display view area
projection taking into account shadows.
Shading is calculated according to a rule:
 

A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height
to the view area upper bound height , is
visible wholly.
 

By the same rule the horizontal projections
of view area are calculated. Changing the height
of the lower and upper bounds of view area
could change conditions of calculation of
shading. 
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2.  2 levels -simultaneously show 2 sections
of the view area by 2 horizontal planes, located
on the height of   lower  and upper
bounds of the view area. From the sections
subtract shadows from obstacles 

If in the submenu of the Fill projections
button Filling is chosen, the section of the
lower plane is displayed as filling, and the
section of the upper plane as hatching
(Camera 35).

 

If in the submenu of the Fill projections
button  Hatching is chosen, the section of
the lower plane is displayed as hatching, and
section of the upper plane as filling (Camera
36).

If in the submenu of the Spatial resolution
button Discrete colors or Gradient is chosen,
then lower section is not at the view area lower
bound but at the height of measuring spatial
resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
 

if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in VideoCAD7 and previous
versions).
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3.  Dome - display projection of the territory
controlled by the camera in 360 degrees,
without view area borders, but only taking into
account the shadowing.
 

When the Dome item is chosen, actually the
control area of a dome (PTZ) camera is
displayed.
 

The Dome mode is also useful for choosing the
best installation place for fixed cameras to
make required areas reachable for the cameras.
 

In the Dome mode all shaded areas from the
specified camera position become visible.
 

In the Dome mode the Spatial resolution  is
calculated without taking into account pan and
tilt angles of camera. It is assumed that the
camera can pan and tilt freely, and spatial
resolution is calculated at the center of the field
of view
. 

In the Graphics window calculation of shadows
in the Dome mode is performed like in the 
Within projection  mode, ie according to the
rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height
to the view area upper bound height , is
visible wholly.

In the 3D World  in the Dome mode the
territory controlled by the active  camera is
displayed as coverage  on the environment.
The coverage in the 3D World is displayed for
the active camera only.

 
4. Off - disable shadow calculation and displaying.

Difference between the Shadows and View area projection bounds  buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
  

The Shadow button works in conjunction with the Spatial resolution     and the Fill

projections      buttons. Depending on the state of these buttons, shadows can be
displayed in different ways: as filling, as shading, as a border lines, with mapping spatial resolution
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or not.
 

The calculation of shading - resource-intensive operation. During the shadow calculation on

the Shadow button red frame flashes .
Automatic shadow calculation is performed only for the active  camera. To recalculate shading
for a particular camera - activate this camera. To recalculate shading for all selected cameras,
click  Main Menu>View>Recalculate shadows .
To temporarily disable the automatic calculation of shading (keeping already calculated shadows
visible) clear the item Main menu>View>Calculate shadows for active camera .
 

The calculation of shading from 3D models  is disabled by default to save resources. To enable
the calculation of shading from the 3D models, check the Options box> Miscellaneous>
Shadow>Calculate shadows for 3D models .
Additionally, for each 3D model, which must be taken into account when calculating the shading:

double click  on the model to switch it to editing state ;
on the appeared Current construction parameter panel check Shadow  checkbox.

To force to calculate shadows from a type of 3D model you can mark  Shadows  checkbox on
the 3D Models  window while editing the type of the 3D model.
 

Whether or not a specific construction takes into account in the calculation of shading determines
by the Shadow  checkbox of the line type used for the construction.
.

You can ignore constructions of specified  layers  while calculating shadows, using the 
Shadows  row in the table of layers.

A button state at the moment of camera saving determines whether the shadows of the camera will
be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the Active camera , this button changes view 

 (  and operates the visibility of shadows of all selected cameras simultaneously.

When calculating 3D view areas  and
coverage of the active camera  in the 3D
World  window, shadows are calculated
independently from shadows in the Graphics
window. Calculation of shadows in the 3D
World is rougher, but much faster.

Accounting 3D models as obstacles in the 3D
World window does not depend on the state of
the Calculate shadows from 3D models
checkbox in the Options box.
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If Off is chosen in the Fill projections  and
Shadows, then filling view area faces  in the
 3D World  is not shown. 

 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Options box>Miscellaneous>Shadow

, Layers>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them

  3D view area
 

Show 3D transparent  view area faces  and
active camera coverage  area in the 3D
World window. 
 

See details: 3D World>View>View area

 Button state at the moment of camera saving determines whether the 3D view area of the given
camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the current layout, except the Active camera , this button changes

view  and operates the visibility of 3D view areas of all selected cameras simultaneously.
 

   Person detection area
 

Show/hide the Active camera  projections of person detection area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of the active
camera.
 

If the projections are present, a lilac frame round the button appears.
 

The projections are displayed in lilac color. Line type can be changed in the options box . 
 

A button state at the moment of camera saving determines whether the projections of person
detection area of this camera will be displayed when this camera is inactive. 
 

Clicking this button opens person detection area size  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. Person detection area displaying will remain and the
button will remain pressed.
  

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: Person detection area size box , Criteria editing box of person detection area , 
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Spatial resolution box

  Person identification area
 

Show/hide the Active camera  projections of person identification area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of the active
camera. 
 

If the projections are present, a orange frame round the button appears. The projections are
displayed in orange color.
 

Line type can be changed in the options box . 
 

A button state at the moment of camera saving determines whether the projections of person
identification area of this camera will be displayed when this camera is inactive.
 

Clicking this button opens person identification area sizes  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. Person identification area displaying will remain and the
button will remain pressed.
   

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: Person identification area size box , Criteria editing box of person identification area
,  Spatial resolution box

  License plate reading area
 

Show/hide the Active camera  projections of license plate reading area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of the active
camera. 
 

If the projections are present, a bright green frame round the button appears. The projections are
displayed in bright green color.
 

Line type can be changed in the options box . 
 

A button state at the moment of camera saving determines whether the projections of license plate
reading area of this camera will be displayed when this camera is inactive.
 

Clicking this button opens license plate reading area sizes  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. License plate reading area displaying will remain and
the button will remain pressed. 

   

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: License plate reading area size box , Criteria editing box of license plate reading area
, Spatial resolution box

  Test object
 

Show the test object of the Active camera  with the sizes and location according to
parameters in the test object box .  

Clicking this button also opens this box.
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Clicking this button once again close the test object box and hide test object on the layout. If it is
necessary to close only the box, and test object on the layout should be left, close the box by

clicking Close in upper right corner. Test object will remain and the button will remain pressed.
 

A test object can be displayed only in the graphical editing state  of active camera.
 

See more: Test object box 

  Layers
 

Show the Layers  panel. Cameras and constructions can be distributed by layers. On each
Layout  unlimited number of layers can be.  Control of layers is performed by the Layers panel.
 

See more: Layers panel

   Model of active camera
 

Using this combo box, you can choose a model for the Active camera .
The list consists of two parts: 
 

Under  =Used models =  header  there are camera models listed which are already used in the
project . All parameters of these models can be seen on Used models tab in the Table of camera
models .
 

Under =All models = header there are all camera models listed which are available in the
database of models. Parameters of these models can be seen and edited on All models tab in the
Table of camera models.
 

To assign a model, just choose its name in the list. 
 

As a result of model assignment to the active camera, model parameter values will be assigned to
parameters of the active camera. After that changing some parameters will be locked.
 

There is =Unassigned = string in the bottom of the list. Choose this string if it is necessary to
remove model assignment from the active camera. As a result of removing model assignment all
parameters of the active camera will be unlocked and can be changed.
 

You can change model of all selected cameras simultaneously. For this purpose:
Select  necessary cameras on the layout
Right click  on this combo box, then click  on the Assign to selected cameras pop up item.

 

See more: Table of camera models

  Table of camera models
 

Show Table of camera models. In this table it is possible to adjust parameters of camera models
and assign any model to the Active camera . The table can be exported to *.txt, *.csv, *.htm, *.
rtf, *.xls formats.
 

See more: Table of camera models

Lens focal length combo box
 

The box duplicates a corresponding box  in the Camera Geometry box to enhance the
convenience when using the graphics window. 
 

When moving the cursor to the box with a lens focal length the information on the lens view
angles appears.
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If a model  is assigned to the camera, and the model has fixed  focal length lens, then you
can not change the focal length.
 

If a model is assigned to the camera, and the model has a lens with limited  variable focal
length, then you can change focal length within the limits only. When approach to the limit values,
the box will become crimson.
 

You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned
model or the assigned model have not specified limits of the lens focal length.
 

If the active camera is panoramic  then the lens focal length box is colored by aqua-green.

 

 Changing the lens focal length, and therefore the calculated values of view angles of a camera with
enabled modeling lens distortion  will lead to detuning parameters of distortion and warping view
area form. To correct the mismatch you should set new values of the actual view angles , taking
into account the changed values of calculated view angles.
 

You can change lens focal length of all selected cameras simultaneously. For this purpose:
Select  necessary cameras on the layout
Right click on this combo box, then click on the Assign to selected cameras pop up item.

 

See more: Lens focal length

  Camera geometry
 

Clicking this button will open Camera Geometry box . This box includes geometric parameters of
the camera, lens and installation parameters of the camera.
 

See more: Camera geometry box

  Sensitivity and Resolution
 

Show the Sensitivity and Resolution  box in which there are parameters of sensitivity and
resolution of the Active camera .
 

Sensitivity parameters take part in modeling only if 3D Video  is opened and illumination
modeling  is switched on.
 

See more: Sensitivity and Resolution

  Spatial resolution
 

Show or hide the Spatial resolution box . In this box it is possible to create and edit patterns of
spatial resolution and field of view size visualization. In the box there are prepared spatial resolution
patterns according to the following criteria: Home Office Scientific Development Branch, Home
Office Guidelines for identification, P 78.36.008-99, Australian Standard AS4806: Closed Circuit
Television, European Standard EN 50132-7, ISO/IEC 19794 Biometric data interchange formats.
Also in the box there are examples of images are automatically displayed for each region of spatial
resolution.
 

See more. Spatial resolution box , Spatial resolution button .

  Depth of field
 

Show or hide the Depth of field calculation box.
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When the depth of field box is visible, next to
all cameras in the horizontal projection the
following lines are displayed:

sharpness area bounds ;
focus plane ;
plane at the hyperfocal distance .

These lines are calculated according to the 
depth of field parameters  of each camera at
the height of depth of field measurement .

 

If the focus plane or the plane at the
hyperfocal distance not intersect the
horizontal plane at the height of depth of field
measurement within the view area
projection, then the focus plane or the plane
at the hyperfocal distance are not displayed. 

 

If the near or the far bound of the sharpness area  not intersect the horizontal plane at the
height of depth of field measurement within the view area projection, then this bound is not
displayed.

 

The absence of near and far bounds of the sharpness area indicates that the sharpness area
completely covers projection of view area, thus the depth of field does not reduce the resolution of
the camera.

    

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .

 

See more: Depth of field calculation box ,  Control of Depth of Field in the horizontal projection
.

  3D Video
 

Show or hide the 3D Video window. The 3D Video displays the image from the Active camera .
 During the image generation in the 3D Video window on the 3D Video button red frame flashes

.
 

See more: 3D Video .

  3D World
 

Show or hide the 3D World window. In the 3D World the project layout with cameras and view
areas is shown in 3D.
 

See more: 3D World.

  Monitor window
 

Show or hide Monitor window. In the Monitor window images from any quantity of cameras are
displayed simultaneously. Monitor window allows modeling monitors of video surveillance system.
 

See more: Monitor window .

  Hide vertical projection
 

If this button is pressed, the horizontal projection is only present in the graphics area. 
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To display a vertical projection click this button again.

  Hide horizontal projection
 

If this button is pressed, the vertical projection is only present in the graphics area. To display
a horizontal projection click this button again.

 "Grid" control element group
 

The graphics area  includes 2 grids with the coinciding horizontal coordinates: a grid in the
vertical projection and a grid in the horizontal projection. The grid origin coincides with the
chosen origin of coordinates .

Grid selected step box
 

To change a grid step click the box and choose the required step from the pop-up list.
If the automatic step selection mode is active when changing the step value in the box this mode
is deactivated.
 

See also: "Grid" control element group

  ON/OFF the automatic grid step selection mode
 

Switch on/off the mode of automatic grid step selection according to a drawing scale.
 

See also: "Grid" control element group

  ON/OFF displaying grid
 

Switch on/off displaying grid. 
Choosing NO in the grid step selection box can also deactivate grid displaying.
 

See also: "Grid" control element group

"Edit" button group
 

Buttons of this group are used for the editing constructions , 3D objects , cables , texts
 and cameras. In this case the status bar  in the bottom of the Graphics window displays

hints. 
When editing an object the projections should be taken into account. Different projections are
different views, though connected ones. Moving objects correctly between projections has no
sense and is impossible to perform.
To start the editing select  the desired objects. 
Choosing the items from the pop-up menu that appears when click ing the graphics area  by the
right mouse button performs the commands of this group as well.

  Stop operation
 

Stop the current operation. Use also Esc.

162

245

188

188

188

193 259 208

201 275

189

162



Interface 189

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

  Erase
 

Erase the selected objects . To select objects use the button Select/Edit . 
If there are no selected objects this button is disabled. 
Use also Del.
 

You can not erase the Active camera .

  Select/Edit
 

 With this button chosen the first corner of
selection window appears when clicking any
empty place of graphics area  once. Clicking
it again completes the designation of selection
window. 
All the objects, which hit in the selection
window and reside on the projection
coinciding with one being clicked for the first
time, will be selected . However, the earlier
selected objects not hitting in the selection
window will revert to normal state . 

 

If Ctrl is pressed at click ing, the objects within the selection window are inverted, on the
contrary, state of those not hitting in the selection window remains the same. 
 

It is possible to select objects by one by clicking their image once, thus enabling the earlier
selected objects to revert to normal state. 
If Ctrl is pressed at click ing, the objects are inverted, and the state of the rest remains the same. 
  

You can make a 3D model  insensitive to mouse click  by Lock checkbox  in the 3D Models
window.
 

During construction 3D scenes  it is often necessary to place some constructions one over
another at a different height, made by means of different line types . 
To select one or more construction, located one over another, made by means of different
line types:

make the line type panel  visible, for example by double clicking any construction;
choose on the panel the line type of construction you want to select; 

select the construction by clicking.
 

Just repeat clicking at the same place without moving the cursor. Thus objects under the cursor
will be selected sequentially.
 

Layers  are very useful for multi-level constructions.
 

An object can be  inaccessible for selection if it belongs to a not enabled layer  

To move objects on the foreground or background use menu items: Bring to front , Send to back
.

 

Selected objects can be moved. To move the selected objects, bring the cursor to the selected
one, press the left mouse button and move the selected objects. After finishing the moving, release
left mouse button. 

To cancel selection click  this button again.
 

164 189

166

162

164

163

202 402

357

475

280

185

276

267

267



VideoCAD190

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

To select all objects on the current layout use Ctrl+A shortcut.
 

For switching to Select / Edit mode from any mode use also Esc button.
 

See also: Selected state
 

Editing state of objects

 

To translate an object into editing state  double-click its
image. After that pink grips appear on the object base points. 
When moving the cursor over this point its image changes. 

 

To edit an object click beside a base point with a grip and move the cursor. After clicking for the
second time, the changed object is set up.
If on one side of a construction a circle is displayed, the construction can be rotated around its
axis by gripping the circle by mouse.

To switch the circle  into the editing state you need to double-click on its center or on the
point on its radius that appears during the process of construction.
To switch  the arc  into the editing state you need to double-click on its center or on either of
its two ends.
 
When editing a rectangle  or a mask , then several points will move at a time, the rectangle
or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
 

When editing a Double line  or Wall , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved. 
 

When clicking the text  twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.
 

In the editing state, 3D models  are displayed with square
grips and pink circle.
You can rotate the 3D model by the mouse using the circle,
scale 3D model on X and Y axis using the square grips. You can
move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.

 

To switch illuminator  to editing state click on its center.
 

Thereupon, the Light intensity distribution curve (LIDC) becomes
visible. To edit the curve by moving grips on the layout press Ctrl.

 
It is possible to change object's parameters in editing state on the current construction
parameters panel  which automatically appears in the bottom of graphics window.
 

See also: Editing state

Activate cameras
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When double-clicking the camera lens the following actions are performed:
 

the Active camera  is saved. 
the camera being double-clicked will become active.

 

It is convenient to pan and tilt the active camera by moving the grip in the middle of the view area
upper bound. 
In a similar way by moving grips on the ends of the view area upper bound it is possible to
change lens focal length  of the camera. 
 
If a model  is assigned to the camera, the focal length changing is possible only in the limits
specified in model parameters .

Changing the lens focal length, and therefore the calculated values of view angles of a camera
with enabled modeling lens distortion  will lead to detuning parameters of distortion and
warping view area form. To correct the mismatch you should set new values of the actual view
angles , tak ing into account the changed values of calculated view angles.
 

See also: Active camera

See also: "Edit" button group

  Cut
 

Cut the selected objects  into the VideoCAD internal clipboard.
 

It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions , 3D objects , cameras, illuminators , texts  and cables.
 

When cutting the Active camera  it is copied.
 

See also: Cut with base point .

  Copy
 

Copy the selected objects  into the VideoCAD internal clipboard.
 

It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions , 3D objects , illuminators , texts  and cables.
   

See also: Copy with base point .

  Paste
 

Paste the objects from the VideoCAD internal clipboard. 
After clicking this button specify the base point of paste in the projection being clicked when
cutting or copying. 
 

It is possible to paste into different layouts , paste cables of one camera while another camera
is active (in this case the pasted cables belong to a camera which is active during paste), and to
paste any quantity of constructions , 3D objects , cameras, illuminators , texts  and
cables at a time.
 

It is available to copy and paste constructions, cables and texts between the projects. To this
effect make a copy in one project, then open another project or create a new one and paste what
you have copied.
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Be careful when copying and pasting cables. You can copy only cables of Active camera ,
and when pasting, these cables will belong to the camera which is active during pasting.
 

If a camera is being pasted a new camera with parameters of the pasted camera is created
automatically. This is an alternative way to create new cameras.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but pasted camera doesn't become active. Therefore the view area of the pasted
camera is displayed without shadows. To calculate shadows - activate  the camera after
pasting.
 

 Pasting is always performed to the active layer . At the moment of placing new camera  or
pasting  copied camera, its base height  is set to the  base height of the active layer .

  Move
 

Move the selected objects . 
After clicking this button the first click in a graphics area  designates the starting moving point,
the second click - the final one. 
 

When moving take into account the projection to which the objects are attached. A simultaneous
moving objects in different projections vertically is locked as being incorrect.
 

Selected  objects or cameras can be moved in Select / edit  mode. In order to move place
the cursor above the selected object, press left mouse button, move, after moving is finished
release the left mouse button.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but moved camera can be not active. If the camera is not active, the view area of the
moved camera is displayed with old shadows. To recalculate shadows - activate  the camera
after moving.

  Rotate
 

Rotate the selected objects . 
After  clicking this button the first click in a graphics area  designates the rotation center, the
second click specifies the initial rotating point, and the third click specifies the final rotating point. 
 

When rotating take into account the projection to which the objects are attached. The selected
objects, attached to the projection with a rotation center designated, can rotate only.
 

The scalable  fonts can rotate only. If a font is not scalable then its initial point rotates only,
the text remaining horizontal.
 

The Active camera  can be rotated in Select / edit  mode by moving the grip in the middle of
the view area upper bound.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but rotated camera can be not active. If the camera is not active, the view area of the
rotated camera is displayed with old shadows. To recalculate shadows - activate  the camera
after rotating.

  Scale
 

Change scale of selected  constructions relative to the center of scaling. 
 

After clicking on this button, the first click on the graphics area  specifies the center of scaling
. 
 

166

178 161 342

166

166

276 171

191 298 277

164

162

164 189

178 161 342

166

166

164

162

477

166 189

178 161 342

166

166

164

162



Interface 193

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Then moving the cursor up increases sizes of selected constructions, moving the cursor down
decreases sizes of selected constructions.
 

In the Status bar  the current scale factor is displayed.
 

When required sizes will be achieved,  click for the second time to complete scaling operation. To
cancel the scaling press ESC.
 

This tool does not scale 3D models . 3D models can be scaled in editing state  with the help
of the Current construction parameter panel .

  Mirror
 

Mirror the selected  constructions relative to the horizontal or vertical line passing through the
specified point. 
 

After clicking on this button, the first click on the graphics area  specifies the point through
which a mirror line must be passed. 
 

Then moving the cursor changes position of the mirror line.
 

When required position of the mirroring objects will be achieved, click for the second time to
complete mirroring operation. To cancel mirroring press ESC.

  Move to active layer
 

Move to active layer all selected  objects. 
 

See more: Layers

"Constructions" button group
 

Buttons of this group are used to perform measurements and constructions. The status bar 
in the bottom of the Graphics window and the Current construction parameter panel display the
results of measurements. The constructions can be used for 3D modeling the video surveillance
object, for specifying the required view areas, objects, obstacles, etc.
Each construction is attached to the projection containing its initial point. The constructions can
be moved, deleted, rotated, edited, copied, mirrored , scaled, changed draw order, hidden
using the buttons of Edit  group.
 

Constructions made in the horizontal projection are also displayed in the 3D Video   and 3D

World  . At this, the line corresponds to a vertical rectangle, the point - to a vertical segment,

the rectangle - to a parallelepiped, circle - to a cylinder, etc. 
Constructions are stretched throughout the height and become 3D objects. 
 

Minimal and maximal height of each object is determined by parameters of line type , by which
the construction is made.  The heights can be set separately for each object, during constructing
and editing by means of current construction parameters panel . Heights of constructions are
calculated relative to  base height  of a layer to which the construction belongs.
Color of constructions is determined only by line type , which is used at constructing.

Constructions can be distributed by Layers . By changing parameters of a layer you can
change some parameters of all constructions belong to the layer. At the moment of drawing,
construction is placed on the  active  layer.

To enhance speed and convenience of drawing, VideoCAD uses global and local snaps .
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The construction coordinates are displayed relatively to the chosen origin of coordinates . The
coordinates of constructions belonging to one camera only (focal plane , optical axis ,
field-of-view size , test object ,change view area upper bound ) are always displayed
relatively to the Active camera .
 

When choosing a button of this group a line type panel or a font type panel  appear, allowing
to change the line  or font  types.
When double-click ing the panels the options box  appears.
 

Above these panels the current construction parameters panel appears, by means of which it is
possible to create construction, by setting its parameters. 

  Point
 

When this button is pressed, clicking on the graphics area places a point.
The status bar  displays the coordinates of this point relatively to the origin of coordinates .
  

In the 3D Video  and 3D World  the vertical segment will be displayed in the points place. 
 

Default minimal and maximal heights of the segment are determined by the line type , which
constructs the point. The heights can be set separately for each point by means of the current
construction parameters panel , on which it is also possible to set coordinates of the point in
numeric values.
 

See also: "Constructions" button group

  Horizontal line
 

When this button is pressed, clicking on the graphics area  specifies a point through which a
horizontal line is passes. 
 

The status bar  displays the line height or its shift from the origin of coordinates  according

to the projection being clicked.
  

In the 3D Video  and 3D World  at the place of the horizontal line 2 horizontal lines will be
displayed. 
 

Default minimal and maximal heights of the lines are determined by the line type , which
constructs the horizontal line. The heights can be set separately for each horizontal line by means
of current construction parameters panel , on which it is also possible to set coordinates of the
horizontal line in numeric values.
 

See also: "Constructions" button group

  Vertical line
 

When this button is pressed, clicking on the graphics area  specifies a point through which a
vertical line is passes. 
 

The status bar  displays the distance from the origin of coordinates .
  

In the 3D Video  and 3D World  at the place of the vertical line 2 horizontal lines will be
displayed. 
 

Default minimal and maximal heights of the lines are determined by the line type , which
constructs the vertical line. The heights can be set separately for each vertical line by means of
the current construction parameters panel , on which it is also possible to set coordinates of the
vertical line in numeric values.
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See also: "Constructions" button group

  Line segment
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
line segment. Second clicking specifies the end point of the line segment.
 

The status bar  displays the segments length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point in it. 
 

In the 3D Video  and 3D World  a vertical
rectangle will be displayed at the segment
place. 
 

Default minimal and maximal heights of the
rectangle are determined by the line type ,
which constructs the line segment. The heights
can be set separately for each line segment by
means of current construction parameters panel

, on which it is also possible to set
coordinates of the line segment in numeric
values.
Color of the rectangle is determined only by line
type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
segment: coordinates of the first and second points, length, angle. 
 

A segment can be also used to measure distances on layouts without click ing for the second
time in this case.
 

Line segments can be used for modeling cables with subsequent cable length calculation. Use
separate line types to draw each cable type. For length calculation use the Length calculation of
line segments  tool.
 

See also: "Constructions" button group

  Polyline
 

This tool allows to draw line segments continuously. The end of each segment is the start of the
next one. To stop drawing lines, press ESC.
In other respects this tool equals to the Line segment  (see. above).
 

See also: "Constructions" button group"

  Angle
 

When this button is pressed, the first clicking on the graphics area  specifies the vertex of an
angle. Second and third clicking specify its arms.
 

The status bar  displays the angle value in degrees.
 

If the angle vertex and arms are constructed in different projections, when changing drawing
the angle is attached to the projection with its vertex. 
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In the 3D Video  and 3D World  2 vertical
rectangles will be displayed at the angle place. 
 

Default minimal and maximal heights of the
rectangles are determined by the line type ,
which constructs the Angle. The heights can be
set separately for each Angle by means of 
current construction parameters panel , on
which it is also possible to set coordinates of
the line segment in numeric values.
Color of the rectangles is determined only by 
line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
angle: coordinates of the first, second, third points, length, angle value in degree. 
 

The angle tool is also used to measure angles on layouts.
 

See also: "Constructions" button group

  Rectangle
 

When this button is pressed, the first clicking on the graphics area  specifies the first corner of
a rectangle. Second clicking completes the rectangle construction.
 

The status bar  displays the information on the rectangle sizes and location. 
 

In the 3D Video  and 3D World  a
parallelepiped will be displayed at the rectangle
place. 
 

Default minimal and maximal heights of the
parallelepiped are determined by the line type

, which constructs the rectangle. The
heights can be set separately for each
rectangle by means of current construction
parameters panel , on which it is also
possible to set coordinates of the rectangle in
numeric values.
Color of the parallelepiped is determined only
by line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
rectangle: coordinates of the first points, height, width. 
 

Rectangles are also used for creating rectangular horizontal planes in the 3D Video, for example
a ceiling or floor.
 

See also: "Constructions" button group

  Inclined rectangle
 

When this button is pressed, clicking on the graphics area  specifies  first corner of an inclined
rectangle.
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Inclined rectangle is similar to a rectangle
and differs from it that in 3D Video  and 3D
World  it is displayed in the form of inclined
rectangle. The minimal height of rectangle
corresponds to the lower side of this
rectangle, and the maximal height - to the
upper one.

In the Graphics window the upper side of
inclined rectangle is displayed by thick line. 
 

For modeling complex objects it is possible to edit  inclined rectangle by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
  

Inclined rectangle can be made transparent by 70 %. For this purpose it is necessary to mark the
Transparence checkbox on the Current construction parameter panel .

Inclined rectangle is very universal tool. Using the inclined rectangles it is possible to model any
3D objects. 
 

It can be useful to combine inclined rectangles
in pairs thus to get triangles with independent
vertexes in the 3D space. Meanwhile two
vertices of each inclined rectangle must
coincide. The rest two vertices of first inclined
rectangle must coincide with the other two
vertices of second inclined rectangle.

 

Using obtained triangles you can theoretically
build any 3D surfaces, although it can be not
simple in practice.
For example, all 3D models in VideoCAD
consist of triangular mesh only.

  

See also: "Constructions" button group

  Double line
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
double line. Second clicking specifies the end point of the double line.
 

The length and the width of the double line appear in the status bar .
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the distance between lines of the double line.
 

Two buttons allow switching the orientation of the second line relatively to the first one

.
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You can also switch the orientation quickly by pressing the Space bar.
 

In the 3D Video  and 3D World  2 vertical
rectangles will be displayed at the double line
place. 
 

Default minimal and maximal heights of the
rectangles are determined by the line type ,
which constructs the double line. The heights
can be set separately for each double line by
means of current construction parameters
panel , on which it is also possible to set
coordinates of the double line in numeric
values.
Color of the rectangles is determined only by 
line type , which is used at constructing.

 

On the current construction parameters panel it is possible to set and fix parameters of the
double line: coordinates of the first, second points, length, angle.
 

See also: "Constructions" button group

  Wall
 

The Wall tool is intended for drawing walls with specified thickness and height. In these walls you
can make apertures  of any shape,  for example for doors and windows..
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
Wall. Second clicking specifies the end point of the Wall.
 

The length and the width of the wall appear in the status bar .
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the wall.
 

Two buttons allow switching the orientation of the second wall side relatively to the first one

.
You can also switch the orientation quickly by pressing the Space bar.
  

In the 3D Video  and 3D World  a
parallelepiped will be displayed at the wall
place. 
Default minimal and maximal heights of the wall
are determined by the line type , which
constructs the wall. The heights can be set
separately for each wall by means of the current
construction parameters panel , on which it
is also possible to set coordinates of the wall in
numeric values.
Color of the parallelepiped is determined only
by line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
wall: coordinates of the first, second points, length, angle.
 

In walls it is possible to make apertures for doors and windows using the Aperture in Wall  tool. 
 

See also: "Constructions" button group
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  Aperture in Wall
 

The Aperture in Wall tool designed to easily
create apertures (openings) of various shapes
in the walls, built by the Wall  tool.

  

In order to an aperture will appear in the 3D
space, it must intersect the horizontal
projection of the wall.

 

The Aperture in Wall tool  is similar to the Inclined rectangle  tool. But the  Inclined rectangle
creates a flat rectangle in 3D space, but the Aperture in Wall placed inside the Wall, cuts an
aperture in the wall. This aperture equals to the projection of the same flat rectangle on the plane
of the wall.
The minimal height of aperture corresponds to the lower side of this rectangle, and the
maximal height - to the upper one.
 

In the Graphics window the upper side of aperture is displayed by thick line. 
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the aperture.
 

The Thickness of the wall affects only the shape of aperture projection in the Graphics window. In
the 3D Video the apertures always cut through a wall at its full thickness.
 

Two buttons allow switching the orientation of the second aperture side relatively to the first one

.
You can also switch the orientation quickly by pressing the Space bar.
 

For modeling complex apertures it is possible to edit  the Apertures by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
You can create complex apertures using several intersecting apertures.
 

See also: Wall , "Constructions" button group"
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  Circle
 

When this button is pressed, the first clicking on the graphics area  specifies the center of a
circle. Second clicking completes the circle construction.
The status bar  displays the information on the sizes and location of the circle.
 

To switch the circle into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
 

 In the 3D Video  and 3D World  a cylinder
will be displayed in the circle place. 
 

Default minimal and maximal heights of the
cylinder are determined by the line type ,
which constructs the circle. The heights can be
set separately for each circle by means of 
current construction parameters panel , on
which it is also possible to set coordinates of
the circle in numeric values.
Color of the cylinder is determined only by line
type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
circle: coordinates of the center and second point, radius, angle. 
 

See also: "Constructions" button group

  Arc
 

When this button is pressed, the first clicking on the graphics area  specifies the center of an
arc. Second and third clicking specify its ends..
To switch  the arc into the editing state you need to double-click on its center or on either of its
two ends. 

 

In the 3D Video  and 3D World  the arc
stretches, creating a cylindrical surface. 
 

Default minimal and maximal heights of the
cylindrical surface are determined by the line
type , which constructs the arc. The heights
can be set separately for each arc by means
of current construction parameters panel , on
which it is also possible to set coordinates of
the arc in numeric values.

Color of the arc is determined only by line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
arc: coordinates of the center, first and second points, radius, angle.  

 

See also: "Constructions" button group

  Stairs
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Stairs is similar to the Inclined rectangle
and differs from it that in the 3D Video and
3D World  windows it is shown in the form
of stairs 

On the current construction parameters
panel  the minimum height corresponds to the
pedestal of the stairs, maximum height
corresponds to the top of the stairs.

In the Graphics window the upper side of
stairs is displayed by thick line. 

The number of steps is calculated
automatically from the height of one step
equals to 15 cm.
 

See also: "Constructions" button group

  Focal plane
 

When this button is pressed, clicking on the graphics area   in the vertical projection specifies a
point through which a plane vertical projection passes. This plane is perpendicular to the main
optical axis of the active camera lens (parallel to the lens focal plane).
 

The status bar  displays the coordinates of the clicked point relatively to the active camera.
 

When changing camera location the position of the obtained plane changes correspondingly. 
 

In the 3D Video   and 3D World the Focal plane is not displayed.
 

 

Generally speak ing, the obtained plane is not a focal one, being only parallel to it.
 

See also: "Constructions" button group

  Optical axis
 

When this button is pressed, clicking on the graphics area  specifies a point through which an
optical axis of the active camera lens passes.
 

The status bar  displays the coordinates of the clicked point relatively to the active camera.

 
 

When changing a camera location the position of the obtained axis changes correspondingly. 
 

In the 3D Video   and 3D World the Optical axis is not displayed.
 

See also: "Constructions" button group

  Text
 

When this button is pressed, clicking on the graphics area  specifies the place for a text string.
At this point a pop-up frame with cursor will appear.
The necessary text is to be entered within a frame. To separate the lines use Enter. 
 

The font type panel  appears below in the graphics area allowing to change the font type . A
pop-up menu is available within a frame, appearing at clicking the right mouse button.
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The entered text is a text marker and can be quickly found using the Find text  tool. This is a
very convenient and quick means for navigation on big layouts.
 

See also: "Constructions" button group , Find text
 

  Mask
 

When this button is pressed, the first clicking on the graphics area  specifies  the first vertex of
rectangular mask. Second clicking completes the mask construction.
 

The status bar  displays the information on the mask sizes and location. 
 

Using masks allows to cover any image parts. Constructions  and texts  can be drawn over
masks.
  

To cover separate construction fragments you can also use line of white color.
 

In the 3D Video  and 3D World  masks are not shown.
 

See also: "Constructions" button group

  Filling
 

Filling is similar to a mask , but can be of any color, and also in the form of different hatch
type. Color of filling is defined by the color of line type, by which the filling is made, and type of
hatching or its absence - by style of this line type.
 

Fillings, as well as other objects, could be edited  by moving separate vertexes, and thus could
be stretched on various objects. 
 

In the 3D Video  and 3D World  fillings are not shown.
 

See also: "Constructions" button group

  3D model
 

The button opens submenu, in which there are 3D models which are present in the program
library. 
 

When any item in the submenu is chosen, clicking in the graphics area  specifies the place for
a 3D model. 
 

 3D models placement is possible in the
horizontal and vertical projections, however only
3D models placed in the horizontal projection
will be visible in the 3D Video  and 3D World

.

 

In the horizontal projection the 3D models are displayed in the top view, in the vertical projection
- in the side view, and in the 3D Video  and 3D World  models are as 3D objects.  
 

Horizontal and vertical  projections  for displaying in the Graphics window can be created in
the 3D Models  window.   
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3D models can be moved, rotated, copied, changed draw order  as other VideoCAD
objects. 
 

The default height of the 3D models above the ground is determined by the maximal height of
the line type  which was chosen when the 3D model was being placed. The height can be set
separately for each 3D model using the current construction parameters panel . 
 

To change 3D model height above the ground, select  the 3D model, then change line type
 or switch the 3D model to editing state by double clicking on it and change value in the 3D H

box on the Current construction parameters panel.
 

By default the 3D models are on the ground and constructed by the line type with the number,
specified on the Lines  tab of the Options box . This line type has the maximum height
equal to 0. 
Heights can also take on negative values, in this case 3D model plunges under ground. 
For example, to place a 3D model on a surface: construct the surface by the rectangle  tool
using line type with the required maximum height, place the 3D model on it, and then change 3D
model line type to the line type of the surface. 

In multilevel 3D projects heights are calculated relative to the base height of a layer  the which
the 3D model belongs. By changing the base height a layer you can move up or down all 3D
models and constructions on the layer
 

In the Editing state  using the Current construction parameters panel you can resize 3D
models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the  box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken. 3D model height above the ground is displayed and can be changed in 3D H box.  
 

In the editing state , 3D models are
displayed with square grips and pink circle.
You can rotate the 3D model by the mouse
using the circle, scale 3D model on X and Y
axis using the square grips. You can move the
3D model by pressing the left mouse button on
the 3D model, as well as in the selected state.
 

Moving 3D models

 

3D models can have velocity vectors. Model with specified nonzero speed will move with this
speed along a specified direction when modeling exposure time , Rolling Shutter ,
interlace distortions  and creation of animated images .
To set speed to 3D model you should enter a nonzero value in the Speed  box in the Current
construction parameter panel during the placement or editing 3D models.

If a 3D  model  has non zero speed, then

the velocity vector is displayed.
 

If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model pass
per second (crimson arrow).
If 3D model is in the normal state, the length

of the velocity vector equals to the
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distance which the 3D model passes for
the period between successive frames of
the Active camera  (black arrow).

 

* the length of the velocity vector of a 3D model in the normal state is inversely proportional

to the  frame rate  of the active camera. Thus we can see how many times the moving 3D

model gets into the frame of the active camera.

You can edit the velocity vector of 3D
model in editing state by moving its
terminus. 
 

 \

You can hide the velocity vectors of all 3D models using the Velocity vectors  menu item.

License plate of cars

Let's consider 3D models - cars with license plates. License plate type, the same for all

car models, is determined by the file number.bmp  file in the directory \Models\, and the

plate size - by the corresponding settings in the Options box on the 3D modeling  tab.

This opportunity allows using the same models in different countries with different license

plates. 

 

To make cars appear in the 3D Video with the license plate of your country:      
create a *.bmp  file with the image of you license plate; 

!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....

replace the file number.bmp by your file;
specify the sizes of your license plate in the Options box. 

3D models of terrain
 

You can use 3D model of terrain of video surveillance, for example: buildings, territory etc.
Cameras, constructions, other 3D models can be placed inside the 3D model-territory.
VideoCAD offers special tools  for working with 3D models-territories
 

See more:  3D Models window ,  3D World window , Work  with 3D model-territory .

 

Adding new 3D models, manage 3D models
 

You can add new 3D models to the library using Add 3D Model  menu item.
 

You can add, delete, duplicate 3D models, distribute 3D models by directories in menu, get
projections of 3D models for the Graphics window  using the  3D Models  window. 
 

Files of 3D models in *.vcm format can be exported from SketchUP and 3ds max using
plugins. Custom 3D models for VideoCAD can be created in SketchUP and 3ds max.
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 See more:  Importing 3D models from SketchUp and Autodeck 3ds Max  

 

See also: 3D Video , 3D World , 3D Models , Options box>Lines , Options box>3D
modeling .

  3D image
 

This tool is similar to Inclined rectangle . As well as the inclined rectangle it allows to place a
rectangle in three-dimensional space at any angle.
 

 But this rectangle can be "covered" by any
raster image in *.bmp , *.jpg, *.gif, *.tiff, *.png
formats. The image can be a photo or a figure. 
In  *.bmp and *.jpg files, pixels of the image
can be transparent if they have a color 
coincided with the color of the left bottom
pixel. Thus the image border can take any
form.
 

In *.png  files transparent pixels will be
displayed transparent.

In many cases raster images can replace 3D
models  which are difficult to make. They
can be used for modeling many objects from
banknotes and plates up to a complex
background. 

 

After choosing this button the Loading 3D image dialog box appears. After choosing a file in *.
bmp,*.jpg,*.jpeg,*.png,*.gif,*.tif  or *.tiff format place 3D image in the same way as Inclined
rectangle.
On the Current construction parameter panel  the minimal height corresponds to the bottom
bound of this rectangle and the maximal height - to the top bound.
 

In the Graphics window the top of 3D images is displayed by thick line.
 

Later 3D image can be edited  by moving its grips. It is possible to change 3D image sizes on

the Current construction parameter panel, delete and change the image file using buttons  and
. on the Current construction parameter panel.

 

To make transparent pixels with color coincided with color of left bottom pixel (or transparent
pixels of *.png file), check Transparence checkbox on the Current construction parameter
panel.
 

To get the transparence of *.bmp or *.jpg file, the image file has to be specially prepared by
means of any graphic editor, for example Paint. Pixels that should become transparent have to
be filled by color that coincides with the color of left bottom pixel.
 

See also: "Constructions" button group

  Rotakin
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Rotakin - an animated rotating test target for
visual estimation of spatial resolution and
motion distortions on the 3D images. 
 \

In the horizontal plane the Rotakin
automatically turns  towards the Active camera

.

In the vertical plane the Rotakin rotates with a
specified speed about an axis passing through
its center (in Professional version only).

Rotakin rotates when modeling exposure time , Rolling Shutter , interlace distortions  and
creation of animated images .
 

To place the Rotakin specify a place for the Rotakin by clicking.
On the current construction parameters panel it is possible to set minimal and maximal
heights of the Rotakin.  

In the  Options box   it is possible to change rotation speed of all Rotakin objects.
 

Rotating test target named Rotakin is used in field testing of video surveillance systems by the
techniques developed by the Home Office Scientific Development Branch 'Performance Testing
of CCTV Perimeter Surveillance Systems (Using the Rotakin Standard Test Target) ". The
Rotak in model meets the requirements of the document.
 

See also: "Constructions" button group

  Illuminator
 

The tool is designed to model illuminators with photometric accuracy.
 

As a result of clicking this button the Illuminator calculation box appears.
You can specify internal parameters of an illuminator in the box.
 

See more: Illuminator calculation .
 

You can open the Illuminator calculation box  by the  button on the Current construction
parameter panel  during placing or editing Illuminator.
 

On the Line type panel  it is possible to choose the line type , by which the Illuminator's icon
will be drawn. Later line type can be changed using Change line type  tool.

On the Current construction parameter panel it is necessary to specify Illuminator height
relative to the base height  of a layer to which the illuminator belongs and Inclination angle (for
projectors).
 

See more. Current construction parameter panel> Illuminator .
 

After assigning the parameters in the Illuminator calculation box and on the Current
construction parameter panel, specify an Illuminator place by the first clicking in horizontal
projection. Then specify a radiation axis direction by the second clicking (for projectors).
 

If graphic specifying angle of radiation and Light intensity distribution curve (LIDC) are not
required, click for the third time on any point in the graphics area. 
To specify angle of radiation and LIDC graphically after the second clicking clear Angle
checkbox on the Current construction parameter panel. After that by the third clicking specify
angle of radiation and light intensity concentration on an axis of radiation. 
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Light intensity distribution curve is displayed by orange
line.
Light intensity distribution curve represents relative light
intensity distribution. The curve does not depend on
absolute values.
     

It is possible to specify parameters after the Illuminator placement. To set parameters click Edit
button and set parameters on the Current construction parameter panel. To open Illuminator

calculation box click the  button.
In order to edit angle of radiation and concentration by moving pink grips, press and keep Ctrl
pressed.  
 
Created Illuminator will take part in 3D image modeling from some camera only if for this camera:

Illumination modeling is switched on ;
Illuminators are enabled ;
The Illuminator is switched on .

While modeling Illuminators VideoCAD considers only direct light. Reflected light can be
considered only approximately by specifying a part of light from this Illuminator diffused on the
scene. Shadows cannot be modeled in VideoCAD.
 

See also: Illuminator calculation , Current construction parameter panel .

  Field-of-view size at point
 

When this button is pressed, moving the cursor in the vertical projection of graphics area  a
field-of-view size value passing through the cursor point is indicated on the Status bar
 

The field-of-view size depends on height and distance, therefore measuring in the vertical
projection is allowed only.
 

The button is available in the graphical editing state  only.
 

If no other measurements made after the field-of-view size is marked at a point, with changing a
camera position, the values in the status bar change correspondingly, thus representing the
current field-of-view sizes at a point.
 

See also: "Constructions" button group

  Test object location
 

When this button is pressed, clicking on the graphics area  specifies the test object location.
The parameters of test object location in the test object dialog box  change correspondingly. 
 

The button is available in the graphical editing state  only.
 

 Test object can be seen in the 3D Video  in
the graphical editing state. 

 

See also: Test object box
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 Signal cable
 

When this button pressed, you can draw the signal cable of the Active camera  by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop
drawing cable, press ESC.
 

The status bar  displays the segment length and its projection to distance and height. 
 

Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the
segment is attached to the projection with its initial point. 
 

A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately. 
 

When copying  the cable segments between cameras and layouts  a process of cable
drawing is accelerated considerably even in complex CCTV systems.
 

When drawing a cable the menu item Cable laying  might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
 

The type and parameters of line designating the Signal cable can be changed in the options
box .
 

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Signal cable again.
A dialog box of the same name appears after that.
 

The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report , Table of cameras  and Cable report .
 

In multi-layer drawings, cables belong to the same layer  as a camera to which the cables
belong. 
 

It is possible to use Line segments  for cable modeling with subsequent cable length
calculation. Use separate line types  for drawing a cable of each type. For length calculation
use the Length calculation of line segments  tool and the Cable report .
 

See also: "Constructions" button group , View>Active camera cables , View>All camera
cables , Cable laying , Length calculation of line segments , Cable report .

  Power cable
 

When this button pressed, you can draw the power cable of the Active camera  by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop
drawing cable, press ESC.
 

The status bar  displays the segment length and its projection to distance and height. 
 

Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point. 
 

A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately. 
 

When copying  the cable segments between cameras and layouts  a process of cable
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drawing is accelerated considerably even in complex CCTV systems.
 

When drawing a cable the menu item Cable laying  might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc. 

 

The type and parameters of line designating the power cable can be changed in the options
box .
 

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Power cable again.
 

A dialog box of the same name appears after that enabling to choose a cross-section area of
power cable to fit the requirements of camera voltage supply. It is assumed that the conductor
material is copper and the conductor temperature is + 50° C
 

The results of the cables' calculation on each individual camera, each individual section area and
on the project as a whole are included into the text file obtained by Text report , Table of
cameras  and Cable report .
 

In multi-layer drawings, cables belong to the same layer  as a camera to which the cables
belong. 
  

It is possible to use Line segments  for cable modeling with subsequent cable length
calculation. Use separate line types  for drawing a cable of each type. For length calculation
use the Length calculation of line segments  tool, Cable report .
 

See also: "Constructions" button group , View>Active camera cables , View>All camera
cables , Cable laying , Length calculation of line segments , Cable report .

  Global snaps
 

This button is used to promptly switch global snaps  on/off. 
Snaps enhance the convenience in drawing. As a result of the snaps' functioning the cursor
"sticks" to the certain points, lines or directions.
 

Points - the cursor sticks to base object points.
Lines - the cursor sticks to objects lines.
Angular snap functions at construction of line segments, angles, cables, and at moving and
rotating as well. After that the subsequent construction points are leveled from the previous
points horizontally and vertically.
Extension - the cursor sticks to the virtual horizontal and vertical lines passing through base
objects points. 

The snap Extension is disabled for hidden  objects and in the Select/Edit  mode.
At grid - the cursor sticks to grid nodes.

 

In the pop-up menu you can choose permanent opened snap panel, with the help of which it is
convenient fast switch the snaps during drawings. 

 

In the Options box  you can change snap sensitivity.
 

 You can disable snaps for any layer  using parameter of layers - Snap .

"Active camera" control element group

  Change installation height
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When this button is pressed, clicking in a vertical projection specifies a new height of the
Active camera  installation. 
The value of camera installation height  in the Camera Geometry box  changes according to
the clicked point height.

  Change view area upper bound
 

When this button is pressed clicking in a vertical projection specifies a new height of the view
area upper bound  and new distance up to the view area upper bound . 
Clicking in the horizontal projection specifies a distance up to the view area upper bound
only. The values of correspondent parameters in the Camera Geometry box  change to clicked
point coordinates. 

 

You can change view area upper bound in the Select / Edit  mode, by moving the grip in the
middle of the view area upper bound.

  Change view area lower bound
 

When this button is pressed clicking in a vertical projection specifies a new height of the view
area lower bound. The values of view area lower bound height  in the Camera Geometry box

 change according to a clicked point height.

  Move active camera
 

When this button is pressed, clicking on the graphics area  specifies a new location of the
Active camera  relative to the view area upper bound, test object, constructions and other
cameras. All the parameters' values are recalculated. 

  Show active camera
 

Clicking this button make visible the active camera with it's view area in the graphics area . The
scale is chosen automatically. If the active camera is disposed in another layout , the correct
layout is activated. 
 

In this mode the scale changing and drawing dragging are not available.
It is convenient to use this tool at both projections  switched on, and also together with the Edit
active camera  tool. 
For switching off this mode, click  the same button once again.

  Edit active camera
 

Clicking this button switches the Active camera  into the graphical editing state .
 

A drawing in the graphics area  rotates so that the direction of the main optical axis of camera
lens becomes parallel to the display plane, and view area edges of the active camera are displayed
in lines of double thickness. The view area upper  and lower bounds  are displayed in
horizontal green lines. 
 

If the Spatial resolution  is displayed, the horizontal red line indicates the height of
measurement of the spatial resolution.
 

This state enables the detailed analysis of view area using the test object . In the vertical
projection calculation of the depth of field , the calculating the field-of-view sizes  at any
point of view area and displaying  Spatial resolution . Test object can be seen in the 3D Video

 in the graphical editing state. 
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In the graphical editing state of the active camera, selection and rotation of the active camera is
blocked to prevent displacement of the background, constructions and cameras relative to each
other on other layouts.
 

See more: Graphical editing state .

"Scale" button group

  Move drawing
 

When this button is pressed you can move a drawing within the graphics area  using the
mouse. 
To do that press and hold down the left mouse button at any spot of drawing and then move the
mouse holding the button down. To stop moving the drawing release the mouse button.
 

If your mouse is an Intellimouse or other Wheel mouse you can move the drawing at any time
by pressing and holding the middle button down. 
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
 

When the Show active camera  button is pressed, moving the drawing is not allowed and this
button is unavailable.  

     Zoom IN/Zoom OUT
 

Clicking these buttons increases or reduces a drawing scale correspondingly. 
 

Using the Intellimouse or other Wheel mouse you can change the drawing scale with the
simultaneous zooming in the drawing sections pointed by the cursor.
 

If Ctrl is not pressed at changing the scale, then the scale changes roughly which is
convenient at navigation. If Ctrl is pressed, the scale changes with the less step which is
convenient for the precise drawing positioning before printing, saving or exporting.
 

If input focus is on the graphics area, scale can be changed by + and -  buttons on the keyboard.
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
  

When the Show active camera  button is pressed, moving the drawing is not allowed and this
button is unavailable.  

 "Undo" button group

  UNDO
 

Undo the last operation. 
 

VideoCAD stores several last operations including Undo operation. When clicking this button
successively VideoCAD retraces to the last states and a state before the button Undo was
clicked for the first time.
The quantity of the stored operations can be adjusted in the Options box>Miscellaneous>UNDO
depth .
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  REDO
 

Redo the last operation undone by the UNDO  tool.211
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9.1.3 Main menu

See Main menu location . 

 

Menu items substantially duplicate the buttons of the tool bar ; however, there are certain
advanced tools. 
 

Keyboard shortcuts .  can be assigned to each menu item.

Project
 

New
Open
Save
Save as
Import from
VideoCAD3..6

Export to
VideoCAD3..6

Text report
PDF Report
Exit

Camera
 

New
Save to project

Camera list
Table of cameras

Numerate
cameras
Table of camera
models
Show active
camera
Edit active
camera
Change
installation
height
Change view
area upper
bound
Change view
area lower bound

View
 

View area edges

View area
projections
bounds
Fill projections

Spatial resolution

Shadow
Calculate
shadows for
active camera
Recalculate
Shadows
3D view area
Person detection
area
Person
identification
area
License plate
reading area
Titles
Camera names

Velocity vectors

Active camera
cables
All cameras'
cables
Cameras over
constructions
High resolution
on top
Camera
Geometry

Constructions
 

Point
Horizontal line

Vertical line
Focal plane
Optical axis
Line segment
Polyline
Angle
Rectangle
Inclined
rectangle
Double line
Wall
Aperture in Wall

Circle
Arc
Stairs
Text
Mask
Filling
3D image
Rotakin
Illuminator
Field-of-view size

 
Test object
location
Global snaps
Lock
constractions

3D Models
 

3D model
3D Models
window

Edit
 

Bring to front
Send to back
Hide
Align
Change Line
type
Move to active
layer
Combine to
block
Merge contour

Destroy
Switch ON
illuminators
Switch OFF
illuminators
Undo
Redo
Erase  
Erase all

Cables 
 

Signal cable
Power cable
Cable laying
Length
calculation of line
segments
Cable report

Criteria 
 

Person detection
area  
Person
identification
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Move active
camera
Move active
camera name

Drawing
 

Save as
Save as
background
Copy to
clipboard
Load background

Adjust
background
Move
background
Hide background

Import DXF/
DWG
background
Delete
background
Background only

Layouts
Layers
Printer setup
Print

      

Sensitivity ans
Resolution
Spatial resolution

3D Video
3D World
Depth of field
Test object
Monitor window

Hide vertical
projection
Hide horizontal
projection
Grid
Origin
Set origin
Black-and-white

Options

Scale
 

Zoom in
Zoom out
Move drawing
Show all
Find text

Add 3D model

Edit
 

Select all
Select/Edit
Cut
Copy
Cut with base
point
Copy with base
point
Paste
Move
Rotate
Scale
Mirror

area
License plate
reading area
Quality levels

Help
 

About VideoCAD

Help Contents
Language
Homepage
Order
User forum
Contact us
Change
registration code
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9.1.3.1 Menu items

See Main menu location . 

 

Menu items substantially duplicate the buttons of the tool bar ; however, there are certain
advanced tools. 
 

Keyboard shortcuts .  can be assigned to each menu item.

Project > New
 

Create new project. 
A project may contain unlimited number of cameras and up to 10 layouts . 
 

In the New project dialog box type the new project name. 
 

You can change the format of measurements in new project when necessary: Metric (meters,
millimetres) or Imperial (feet, inches). 

Project > Open
 

Open earlier saved project. 
Choose a project file. If the current project was not saved, VideoCAD offers to save it.

Project > Save
 

Save project to a file.
If a project is saved for the first time, the dialog box Save as appears enabling to change a project
filename and a saving directory when needed.

Project > Save as
 

Save project to a file under another name or in another directory. 
In the appearing dialog box choose a filename and a directory to save it.
 

The project includes all information on the program settings (line types, fonts, etc.).

Project > Import from VideoCAD3..6
 

Import of the previous project format *.vmp, supported by VideoCAD versions from 3 to 6.. In the
appearing dialog box choose a filename with  *.vmp extension.  

 

If after importing project seems incorrectly, - restart VideoCAD.

Project > Export to VideoCAD3..6
 

Export current project to the previous project format *.vmp, supported by VideoCAD versions from
3 to 6.. In the appearing dialog box choose a filename with  *.vmp extension.  
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*.vmp file can contain no more than 100 cameras and no more than 5000 constructions on each
layout. All that exceeds these limits, will be lost.  Also new tools which appeared in VideoCAD7
and VideoCAD8 will not be saved.

Project > Text report
 

Export the data on most of the specified and calculated parameters of cameras and cables
included into the current project to a text file. 
 

Enter a filename. A default filename coincides with the project name. 
 

When clicking OK, the text document obtained is automatically loaded into a text editor for
viewing and editing. 
 

You can copy and paste the text obtained into a project explanatory note.
 

All parameters of cameras in the project can be obtained in the form of adjustable table which can
be exported into various formats. You can get a report in PDF format . 
 

See also:  PDF report  , Table of cameras , Cable report

Project > PDF report
 

Export the data on most of the specified and calculated parameters of cameras and cables
included into the current project to a PDF file. 
  

Unlike the Text report , the PDF Report can include images from the cameras, fragments of
layouts with camera placed, a cover with logo. Report parameters and the structure of information in
the report is configurable.

After choosing this menu item, a dialog box for configuring the report parameters will appear. After the
setting, click OK in the dialog.
 

See more details about PDF report configuration: PDF Report

Generating a report in PDF format can take a lot of time, while generating the image in the Graphics
window may vary, the 3D Video  window can appear. Be patient, do not touch the mouse and
keyboard.
 

All parameters of cameras in the project can be obtained in the form of adjustable table which can be
exported into various formats. 
 

See also: PDF Report , Text report , Table of cameras , Cable report

Project > Exit
 

Exit the program.

Camera > New
 

Create new camera with default parameters. 
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 In the dialog box appeared you can change
camera number, name, type of the camera
which determines the kind of icon by which it
will be displayed. If necessary, you can enter
additional information on the created camera
(for example: purpose, a place and features of
installation). 

 

Later it is possible to change name, number, type of the camera and the additional information in
the Camera list  box.
Cameras can be numerated sequentially with the help of the Numerate cameras  tool.
Cameras are displayed by different icons only if the Display camera type  box in the Options box

 is marked.
 

On the Line type panel  it is possible to choose line type  by which the icon of the camera
and View area projection bounds  will be drawn. When displaying spatial resolution  is
disabled, projection will be filled  (hatched) by the color of assigned line type. Later it is possible
to change line type using Change line type  tool.
Hatch style  is determined by style of a line type , assigned to the camera (solid, dash, dot,
dash dot etc.).
 

After entering all necessary data click OK, to cancel the operation click Cancel.
 

If there is already a camera with chosen number in the current project, VideoCAD will ask to
specify, whether you would like to rewrite it.  
After camera creation specify by clicking a place for the new camera on the layout.
Just after camera creation the moving mode will be switched on. When placing will be completed,

click   Select/Edit  button or press ESC.
 

It is convenient to create new cameras with already set parameters by copying  and pasting
existing ones.

 

At the moment of placing new camera  or pasting  copied camera, its base height  is set to
the  base height of the active layer . 

Camera > Save to project
 

All the specified and calculated parameters of the active camera and layout are saved to the
current project. 
 

Saving is performed automatically at many operations.

Camera > Camera list
 

Clicking this button opens Camera list box, in which camera list of current project is displayed.
Active camera is highlighted by red frame. Any camera can be activated, removed, renamed,
found on layouts, it is possible to show 3D image from any camera. It is also possible to sort
cameras in the list. For carrying out any manipulations with the camera first select its name in the
list by single clicking.
 

See more: Camera list
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Camera > Table of cameras
 

Show interactive Table of parameters of all cameras in the project. The table can be exported to *.
txt, *.csv, *.htm, *.rtf, *.xls formats.
 

See more: Table of cameras

Camera > Numerate cameras
 

Open the Numerate cameras  tool. This tool allows renaming and serial numeration any quantity
of cameras simultaneously.
 

See more: Numerate cameras

Camera > Table of camera models
 

Show Table of camera models. In the table it is possible to set parameters to models and
assign any model to the active camera. The table can be exported to *.txt, *.csv, *.htm, *.rtf, *.xls
formats.
 

See more: Table of camera models

Camera > Show active camera
 

Clicking this button make visible the active camera with it's view area in the graphics area . The
scale is chosen automatically. If the Active camera  is disposed in another layout , the
correct layout is activated. 
 

In this mode the scale changing and drawing dragging are not available.
It is convenient to use this tool at both projections  switched on, and also together with the Edit
active camera  tool. 
For switching off this mode, click  the same button once again.

Camera > Edit active camera
 

Clicking this button switches the Active camera  into the graphical editing state .
 

A drawing in the graphics area  rotates so that the direction of the main optical axis of camera
lens becomes parallel to the display plane, and view area edges of the active camera are displayed
in lines of double thickness. The view area upper  and lower bounds  are displayed in
horizontal green lines. 

If the Spatial resolution  is displayed, the horizontal red line indicates the height of
measurement of the spatial resolution.
 

This state enables the detailed analysis of view area using the test object . In the vertical
projection calculation of the depth of field , the calculating the field-of-view sizes  at any
point of view area and displaying  Spatial resolution . Test object can be seen in the 3D Video

 in the graphical editing state. 
 

In the graphical editing state of the active camera, selection and rotation of the active camera is
blocked to prevent displacement of the background, constructions and cameras relative to each
other on other layouts.
 

See more: Graphical editing state .
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Camera > Change installation height
 

When this button is pressed clicking in a vertical projection specifies a new height of the
Active camera  installation. 
The values of camera installation height  in the Camera Geometry box  change according to a
clicked point height.

Camera > Change view area upper bound
 

When this button is pressed clicking in a vertical projection specifies a new height of the view
area upper bound  and new distance up to the view area upper bound . 
Clicking in a horizontal projection specifies a distance up to the view area upper bound. The
values of correspondent parameters in the Camera Geometry box  change to clicked point
coordinates.
 

You can change view area upper bound in  Select / Edit  mode, by moving the the grip in the
middle of the view area upper bound.

Camera > Change view area lower bound
 

When this button is pressed clicking in a vertical projection specifies a new height of the view
area lower bound. The values of view area lower bound height  in the Camera Geometry box

 change according to a clicked point height.

Camera > Move active camera
 

When this item chosen clicking in the graphics area  specifies a new position of the active
camera relative to the view area upper bound, test object, constructions and other cameras. All
the parameters' values are recalculated. 

Camera > Move active camera name
 

When this item chosen, clicking in the graphics area  specifies new location of the active
camera name relatively to its icon in the projection which you clicked.
 

If the Options box>Camera and Illuminator>Camera Icon>Scalable  is not checked, then  the
size of the camera icon is not scalable so the distance up to the name also cannot be scalable.
The distance  is saved in pixels.
If the Scalable is checked, then  the size of the camera icon is scalable so the distance up to the
name is scalable too. The distance is saved in meters(foot). 
 

Scalable and unscalable positions are stored separately, so switching the Scalable box will not
lead to losing of the saved positions of the camera name.

Drawing > Save as
 

The item opens a submenu in which a format of saving drawing file can be chosen.  You may
save the drawing in any of the following formats: *.dxf, *.dwg, *.wmf, *.emf, *.emf+, *.gif, *.tif, *.
png, *.pdf (raster and vector), *.plt (HPGL/2), *.cgm (Computer Graphic Metafile), *.swf (Adobe
Flash), *.bmp, *.jpg. 
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To the  *.png, *.pdf (raster), *.bmp, *.emf+ (vector) formats, a copy of the image in the Graphics
window is exported practically without artefacts. The default export is performed with the same
resolution as on the screen. You can increase the resolution of the drawing on the Export  tab in
the Options box. Therein you can also configure other export parameters.

Export to AutoCAD *.dxf, *.dwg is much more than a copy of the image in the Graphics window:
 

Cameras with view areas are exported as AutoCAD blocks, view area bounds are exported as
polylines. To attributes of the block the most important parameters of the camera are recorded:
Name, Model, Lens focal length, Height of installation, Base height, Heights of view area lower
and upper bounds, View angles, Number of pixels, Spatial resolution pattern, Quality level. 
Illuminators are exported as AutoCAD blocks. To attributes of the block the most important
parameters of the  illuminators are recorded: Lamp type, Number and power of lamps, Height of
installation. 
Distribution by layers , set in VideoCAD is saved. 
Hatching and filling of shadows  are saved.  
Styles and weights of lines  set in VideoCAD are saved.
Point of origin is saved. 
Grid is exported as AutoCAD block with attributes.
In the exported file the references to raster insertions are saved: background and 3D model
projections. Raster images in *.png format are exported along with DXF or DWG file into a
separate directory <exported file name>_img.
Gradient is changed to filling by separated colors. Transparence of filling is not saved. 
Objects in hidden  state are not exported to AutoCAD, thus to exclude some objects from
export - hide  them. 
Before export to AutoCAD activate any of visible cameras, adjust maximum distance  of
view area of cameras with infinite view areas.
When you export a drawing with the  background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers  or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing in AutoCAD format as a background;
2. Adding cameras and constructions on special layers.
3. Export the obtained drawing to AutoCAD format to work with it in AutoCAD.
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See more: Work  with background in AutoCAD format
More about export options to AutoCAD: Options box>Export>DXF,DWG,PLT,CGM,SWF,vPDF
 
*. wmf format is very outdated, it does not support images of 3D models, semitransparent (blend)
and gradient filling projections. *. emf format does not support gradient and blend filling. 
 

While saving to vector *.pdf, the transparency and rotation of 3D model projections are not
saved.
 

An alternative way to export to *.pdf is to print  to a virtual printer, which produces printing result
as a PDF file. In this method, the weight and color of lines , fonts  will match the values 
specified for printing.
 

While saving to *.gif, color distortions are possible, while saving to *.jpg compression artefacts can
be visible .
 

While saving to other formats, mentioned above and other distortions are possible.
 

Clicking a sub-item with extension name will open the Export  tab in the Options box . It is
possible on the tab to adjust export parameters: exporting drawing scale, camera icon and
illuminator icon sizes, size of nonscalable fonts, step of dash line and step of hatches.
 

After closing the Options box the dialog box Save drawing as appears enabling to choose a
filename and a saving directory. 
The file name coincides with the layout name by default. 
 

 You can save the drawing with a frame and tittle-block . To do this chose Print , chose frame
with a tittle-block  then save the drawing.
 
  If export module of VideoCAD can not export drawing with a complex background in AutoCAD
format, try the following:
1. Hide the background;
2. Export;
3. Combine the obtained dxf file with the original background in AutoCAD or any other program that
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can do it. 

Shift and rotation between background and drawing are possible when exporting drawing with a
background in AutoCAD format with the active User Coordinate System (UCS). The shift can be
corrected in AutoCAD. To prevent the shift do not use as a background files with the active User
Coordinate System. Use the files in the World Coordinate System (WCS). Before loading a file
with UCS as a background, open it in AutoCAD and use the PLAN command.
 

See also: Export of 3D view areas to DXF , Work  with background in AutoCAD format ,
Options box>Export , PDF Report

Drawing > Save as background
 

The menu item is intended for converting graphics files and VideoCAD constructions in the high
resolution *.emf file.
When converting, cameras images, titles and grid are excluded from the obtained file.    
 

Thus, the obtained file contains: 
 

the loaded background ;
VideoCAD constructions .

 

If necessary to hide constructions, use the item Background only . 

Drawing > Copy to clipboard
 

Copy drawing to Windows clipboard. 
 

Choosing this item opens a submenu allowing to choose the format in which the drawing will be
copied to the clipboard.
 

After that the drawing can be pasted into any document, e.g. into a project explanatory note.
A drawing is copied in a displayed size.

Drawing > Load background
 

This item opens a submenu allowing to choose a projection to load a background.
 

After choosing item a dialog box for choosing background file appears.  Graphic files of the
following formats can be used as a background:  *.bmp, *.jpg, AutoCAD *.dxf, *.dwg,  *.wmf, *.
emf, *.emf+, *.gif, *.tif, *.png,*.pdf. 
 

Choose the necessary file in the dialog box and click OK. 
 

The background will appear in the chosen projection along with the dialog box Adjust background
. Using its tools is necessary to bring an image scale on the background in correspondence

with the general VideoCAD scale.

Click the   Ruler button
Specify by clicking 2 points on the
background image, the distance between
which is known to you (e.g., the length of a
building, a wall, etc.). In the  Distance box
the measured distance at the current scale
will appear.
Enter the known distance into the  Real
distance box and click OK.
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The background will be automatically scaled
so that the distance specified by you will be
equal to the entered value of real distance.

 

If the loaded background is in PDF format, the Adjust background dialog includes fields for
selecting page in the PDF document and to set resolution of the PDF document. If the loaded
background is in DXF or DWG format, the dialog includes tools to select a layout and to control
visibility of layers of the background, as well as a checkbox to hide texts.
 

If the background is already loaded, and you load a background without removing  the previous
one, then the size, scale and location of a new background will remain the same as of a previous
one. In this case, the proportion between the sides of a new background might be distorted. 
If you remove an old background beforehand, then the new one will be automatically placed
according to the size of a file and the current scale on the screen.
 

The project includes background files themselves, therefore when moving the project file don't worry
about the background files moving.  

If VideoCAD can not read a file in AutoCAD format or reads it incorrectly, proceed as follows:
 

1. Open your file in AutoCAD, check the scale, check the presence of remote from the main
construction details, check for other abnormal details. If necessary, correct the detected errors.

2. Create a new blank file in AutoCAD
3. Copy from your file only those constructions that are necessary to accommodate the cameras.
4. Save the file as dxf version no later than 2015.
5. Load this file in VideoCAD as a background.

See also: Adjust background , Move background , Hide background ,Delete background
, Thin lines of raster background .

Drawing > Adjust background
 

This item opens a submenu allowing to choose a projection to adjust background.
 

After choosing item the dialog box Adjust Background appears. Using its tools is necessary to
bring an image scale on the background in correspondence with the general VideoCAD scale
.
 

Sequence of actions:

Click the   Ruler button
Specify by clicking 2 points on the
background image, the distance between
which is known to you (e.g., the length of a
building, a wall, etc.). In the  Distance box
the measured distance at the current scale
will appear.
Enter the known distance into the  Real
distance box and click OK.

 

The background will be automatically scaled
so that the distance specified by you will be
equal to the entered value of real distance.
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If the loaded background is in PDF format, the
Adjust background dialog includes fields for
selecting page in the PDF document and to
set resolution of the PDF document. 

 
 

If the loaded background is in DXF or DWG
format, the dialog includes tools to select a
layout and to control visibility of layers of the
background, as well as a checkbox to hide
texts.

To enable/disable layers: choose layers name
in the Layers list, then mark or clear the
Visible checkbox.
 

See also: Work  with background in AutoCAD
format , Import DXF/DWG background

 

Drawing > Move background
 

This item opens a submenu allowing to choose a projection to move background.
 

After choosing item clicking in the graphics area  specifies new location of the background
in the corresponding projection.

Drawing > Hide background
 

This item opens a submenu allowing to choose a projection to hide background.
 

The hidden background and all its parameters are stored in memory, but the background is not
displayed. It is convenient for increasing speed  on weak computer or in some other cases.

If export module of VideoCAD can not export drawing with a complex background in AutoCAD
format, try the following:
1. Hide the background;
2. Export;
3. Combine the obtained dxf file with the original background in AutoCAD or any other program that

can do it. 

Drawing > Import DXF/DWG background
 

Using this tool you can import 2D constructions from a background in AutoCAD formats to
VideoCAD 3D constructions  automatically. Use of this tool allows to reduce efforts of outlining
background to convert it to 3D constructions.  Specially prepared background file is not required, but
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if a background is pre-prepared in AutoCAD, then the efficiency of import will be higher.
 

Order of work:
 

1. Load  and adjust (scale)  the background,
show it on the screen.
 

2. Choose Main menu>Drawing>Import DXF/DWG
background
 

3. In the appeared box adjust the Filter of
constructions, in order to make visible only
constructions you want to import.  You can filter
constructions by layout, layer, line type, color, line
weight, name.
 

4. Make active a layer  of VideoCAD, to which
you want to import.
 

5. On the Toolbar  choose a type of VideoCAD
construction to which you want to import filtered
constructions from the background. You can
import to Line segment , Polyline , Inclined
rectangle , Double line , Wall , Aperture in
wall . 
 

While importing to the Aperture in wall , you can
cut gaps in existing walls. While importing to the 
Inclined rectangle  , you can make it
semitransparent.
 

6. On the Current construction parameter panel
set parameters of the chosen VideoCAD
construction (line type , Heights, Thickness of
walls etc.).
 

7. Click Import. The result will be the same, as if
you have outlined selected constructions
manually.

Imported constructions are usual VideoCAD constructions , you can edit them. 
You can repeat steps 3..7 many times, to import different constructions from the background to
different construction types of VideoCAD, on different heights, to different layers, by different colors
etc.
Not all types of background constructions can be imported. In VideoCAD8 you can import lines and
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polylines on the layout or in blocks.
 

See also: Work  with background in AutoCAD format

Drawing > Delete background
 

This item opens a submenu allowing to choose a projection to remove background.
 

Choosing item from the submenu removes background and all its parameters from the project.
 

If the background is already loaded, and you load  a background without removing the
previous one, then the size, scale and location of a new background will remain the same as of a
previous one. In this case, the proportion between the sides of a new background might be
distorted. 
If you remove an old background beforehand, then the new one will be automatically placed
according to the size of a file and the current scale on the screen.

Drawing > Background only
 

After choosing this item the background only will be displayed in the graphics area . 
 

VideoCAD turns to a handy program for graphic files viewing and printing.
For all the rest to be displayed choose this item again.

Drawing > Layouts
 

Choosing this item opens a box with the list of current project layouts. 
The project may contain up to 10 layouts. Originally one layout is created into project. 
 

See more. Layout box
 

To switch between layouts, create, delete, rename layouts in the Graphics window it is convenient
to use the Layouts tabs  in the lower left corner and the pop-up menu of these tabs.

Drawing > Layers
 

Show the Layers  panel. Cameras and constructions can be distributed by layers. On each Layout
 unlimited number of layers can be.  Control of layers is performed by the Layers panel.

 

See more: Layers panel

Drawing > Printer setup
 

Choosing this item opens a standard dialog box of current printer setup in Windows.

Drawing > Print
 

After choosing this item the borders of pages for printing and the Preview box appear in the
graphics area. 
 

631

222

162

513

274

276

513

276



Interface 227

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

In the box you can choose the number of pages horizontally
and vertically to print out current drawing. The obtained pages can
be glued together forming a drawing of a larger format.
 

Using the mouse, position and scale the drawing as needed.
If Ctrl is not pressed at changing the scale, then the scale changes
roughly which is convenient at navigation. If Ctrl is pressed, the
scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.
 

To exclude the certain areas of a drawing at printing, use the  Mask

 button that duplicates the same button  on the Tool bar.

To change settings of the current printer click the Printer

Setup button.

After the drawing preparation is completed click the button Print 
.

In case if any problem with printing try to choose printing options in
the Options box .

Frames and Tittle blocks

 

To get the standard drawing sheet with the frame and the Title-Block choose the required
frame in the Frame combo box. The frame should be created beforehand. 
 

Frames are a files of AutoCAD *.dxf format. They can be created or edited using the
AutoCAD or other program exporting to *.dxf.  VideoCAD can be used too. Frame files are
saved in the \Frames\ directory in the VideoCAD installation directory.    
You may use the prepared frames with the filled Title Blocks, or you may fill the Title Block
before printing. 

To fill the Title Block:

Click the Fill Title-Block  button. As a result the frame becomes fixed to other
constructions and at navigation is moved and scaled together with them. Current drawing
location and scale are memorized;
With the help of the mouse enlarge the Title-Block area and fill the fields with the text ;   
Click the button Title-Block again. The drawing and frame will return to the memorized
position.   

 

Store positions of drawing

 

In the lower part of the panel there is the Positions area. By means of tools in this area it is
possible to store the adjustments and positions of the drawing, and then quickly return to the
stored positions. This option is useful in case of repeated printing the same view after editing is
carried out.

After adjustment of the drawing's position and frame, before print, click the Add button and
enter any name of the position.
At printing the same view for returning to the stored position it is enough to select only the
position's name in the combo box. 
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To return to position in the combo box after displacement click Show button. 
To store new position under the name selected from the positions' list click Save button. 
To delete the selected position click Del button.

Printing on a virtual printer

 

An alternative way to export to PDF is printing on a virtual printer, which produces printing
result as a PDF file. In this method, the thickness and color of lines , fonts  will match
the values specified for printing.
 

However, not all virtual and hardware printers support printing transparent,  gradient fills,
hatches , transparent images . When printing on these printers , you can use an option
Printing>Use buffer  in the Options box .
When using a raster buffer, initial printing is carried out on the buffer, and then raster buffer is
sent to the printer.
 

Without using the buffer, an image is sent to the printer in vector form, as a set of drawing
commands and if the printer does not support all commands, errors are possible on the printed
image. 
 

However not all printers can work with the Use buffer mode in all cases. In case of issues
clear the Use buffer  checkbox. Try also to decrease printer DPI resolution, hide raster
background. Try another virtual printer.

View > View area edges
 

Show the Active camera view area edges, calculated according to parameters  in the Camera
Geometry box. 
 

Line type can be changed in the options box .
 
 

When View area projection bounds  is
disabled, but Shadows  is enabled, the View
area edges  is shown simplified in the form of
two rays if the angle of camera rotation around
its axis  is multiple of 90 degrees (Camera
2) or in the form of one ray if the angle of
camera rotation around its axis  is not
multiple of 90 degrees  (Camera 3).
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If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then for this camera the
line type of View area edges is taken from the
Options box>Lines>System line types>Bounds

. This line type is assigned to new cameras
by default (Camera 32 on the figure).
 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, the View area edges of this camera is
drawn by this line type assigned to the camera,
as well as the View area projection bounds
and camera icon.  (Camera 33...38).
 
Thus you can draw different cameras and their
view areas by different colors, thickness and
line style.

 

A button state at the moment of camera saving determines whether the view area edges of the
given camera will be displayed when this camera is inactive.
 

If selected cameras exist on the current layout, except the active camera, this button changes

view  and operates the visibility of View area edges of all selected cameras simultaneously. 

View > View area projection bounds
 

Show the bounds of the Active camera view area projections or sections of the view area on two
levels calculated according to parameters  in the Camera Geometry box.

 

Submenu of the button:
 
 

1.   Projection  - show View area projection
bounds of the active camera. 
 

Projection is calculated according to a
simple rule:

 

A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of
heights from the view area lower bound
height  to the view area upper bound
height , is visible wholly.
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2.  2 levels - simultaneously show 2

sections of the view area by 2 horizontal
planes, located on the height of the lower
and upper  bounds of the view area.
 

The upper section is shown by thick lines.
If in the submenu of the Fill projections
button Filling is chosen, the section of the
lower plane is displayed as filling, and the
section of the upper plane as hatching
(Camera 35).

 

If in the submenu of the Fill projections
button Hatching is chosen, the section of
the lower plane is displayed as hatching, and
section of the upper plane as filling (Camera
36).

 

When visualizing spatial resolution  with two
levels, the lower section is not at the view area
lower bound but at the height of measuring
spatial resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
 

if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in  VideoCAD7 and earlier
versions ) .

Difference between the View area projection bounds and Shadows  buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
 

3. Off. - don't show.
 

When View area projection bounds is disabled, but Shadows  is enabled, the View area
edges  is shown simplified in the form of two rays if the angle of camera rotation around its
axis is multiple of 90 degrees or in the form of one ray if the angle of camera rotation around its
axis  is not multiple of 90 degrees.
 

If the line type of camera  coincides with default line type for camera icons, specified in the
Options box , then for this camera the line type of View area projection bounds is taken from
the Options box>Lines>System line types>Bounds . This line type is assigned to new cameras
by default.
 
If another line type was assigned to the camera, the View area projection bounds of this
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camera is drawn by this line type assigned to the camera, as well as the View area edges  and
camera icon.
  

A button state at the moment of camera saving determines whether the bounds of the given
camera view area projections will be displayed when this camera is inactive.
 

If selected cameras exist on the current layout, except the active camera, this button changes

view  and operates the visibility of View area projection bounds of all selected cameras
simultaneously. 

View > Fill projections

Hatch or fill by blend color view area projections of active camera  ( if these projections exist)
calculated according to parameters in the Camera Geometry  box.
 

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then hatching (filling)
projections of this camera is performed by grey
color by default (Camera 30 on the figure).
 

If another line type was assigned to the
camera, then hatching (filling) projections of
this camera is performed by a color of this line
type assigned to the camera. (Camera 41,42).

If the Spatial resolution  is enabled, then
colors of hatching (filling) projections is 
determined by Spatial resolution parameters
(Camera 43).

 

Drop-down menu:
 

1.   Ha tching   - hatch projections.
 

2.  Fill ing  - fill projections by blend semitransparent color.
  

If the Hatching item is chosen, but in the drop-
down menu of the Spatial resolution  button
the Gradient item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.

Transparence of filling in the Graphics window
can be adjusted in the Options box .
Transparence of filling in the  3D World window
can be adjusted in the 3D World .
 

173

166

291

171

483

177

177

483

348



VideoCAD232

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

 If in the submenu of the View area projection
bounds  button, 2 levels is chosen then:

If in the submenu Filling is chosen, the
section of the lower plane is displayed as
filling, and the section of the upper plane as
hatching (Camera 35).

 

If in the submenu Hatching is chosen, the
section of the lower plane is displayed as
hatching, and section of the upper plane as
filling (Camera 36).

 

3. Off - don't hatch and fill view area projections.
 

If Off is chosen in the Fill projections and
Shadows , then filling view area faces  in
the  3D World  is not shown. 

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then for this camera Filling
is performed by Gray color and Hatching by 
DiagCross style. (Camera 32)
 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, then for this camera filling is
performed by a color determined by  color of
the line type and hatch style is determined by 
style of the line type (Camera 33...38).
 
Thus you can fill and hatch projections of
different cameras by different colors and hatch
styles.

 

A button state at the moment of camera saving determines whether the filling or hatching of the
view area projections of the camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the active camera, this button changes view 
and operates the visibility of filling (hatching) projections of all selected cameras simultaneously.

View > Spatial resolution
 

Fill in different colors regions on the view area projections of the active camera, depending on
the spatial resolution within these regions.
Colors of the regions and the boundary values of the spatial resolution are determined by the
spatial resolution pattern assigned to the camera.
In the Spatial resolution box  you can edit the patterns and assign them to cameras.
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Drop-down menu:

1.  Discre te  co lo rs  -  fill the regions in discrete colors in accordance with a spatial resolution
at the far bounds of the regions.
 

2.  Gradient - fill the view area projection in gradient color according to the spatial resolution at
each point on the projection.

 

In case of gradient color is chosen, the colors at the far region bounds equal to the colors of the
spatial resolution pattern, but between the bounds color changes smoothly, as well as real
spatial resolution.
Gradient reflects the spatial resolution more accurately and looks impressive, but discrete colors
are more intuitive and easy to use..

If the Gradient item is chosen, but in the drop-
down menu of the Fill projections  button
the Hatching item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.

 

Calculation of gradient demands a lot of resources and increases redraw time.
 

3. Off. - don't display spatial resolution
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If in the submenu of Shadows  button or 
View area projection bounds  button (when
Shadows is Off) the 2 levels is chosen, then
lower section is not at the view area lower
bound but at the height of measuring spatial
resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
 

if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper  bounds of
the view area ( as in previous versions ) .

In the active camera editing mode , the
regions of spatial resolution can be displayed
in the vertical projection, with the height  of
spatial resolution measurement (horizontal red
line).

In the Dome  mode the Spatial resolution is calculated without tak ing into account pan and tilt
angles of camera. It is assumed that the camera can pan and tilt freely, and spatial resolution is
calculated at the center of the field of view.
 

The  Spatial resolution button controls
displaying spatial resolution on 3D view area
and the Coverage  in the 3D World 
window .

 

A button state at the moment of camera saving determines whether the spatial resolution of the
camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the Active camera , this button changes view  

( ) and operates the visibility of spatial resolution of all selected cameras simultaneously.
 

See also: Spatial resolution box , Visualization of the camera control area projections and
spatial resolution within them .
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View > Shadow

Display horizontal projection of the view area of
the active camera taking into account shading
from constructions  and 3D models .

 

Shadows - a powerful yet easy-to-use tool of VideoCAD. Shadows are calculated for all
positions of cameras, shading objects can be located at any point of space. You should only enable
calculation of shadows with the help of this button.
 

Shading takes into account the camera installation height and all 3 coordinate of constructions and
3D models (including heights).
 
Drop-down menu:
 

1.  Within projection - display view area
projection taking into account shadows.
Shading is calculated according to a rule:
 

A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height
to the view area upper bound height , is
visible wholly.
 

By the same rule the horizontal projections
of view area are calculated. Changing the height
of the lower and upper bounds of view area
could change conditions of calculation of
shading. 
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2.  2 levels -simultaneously show 2 sections
of the view area by 2 horizontal planes, located
on the height of   lower  and upper  bounds
of the view area. From the sections subtract
shadows from obstacles 

If in the submenu of the Fill projections
button Filling is chosen, the section of the
lower plane is displayed as filling, and the
section of the upper plane as hatching
(Camera 35).

 

If in the submenu of the Fill projections
button  Hatching is chosen, the section of
the lower plane is displayed as hatching, and
section of the upper plane as filling (Camera
36).

If in the submenu of the Spatial resolution
button Discrete colors or Gradient is chosen,
then lower section is not at the view area lower
bound but at the height of measuring spatial
resolution , determined in the spatial
resolution pattern  assigned to the camera.
Spatial resolution is rendered on this level.

If the height  of measuring spatial resolution
is set to AUTO, then:

if the view area projection bounds  is set to
2 Levels, the height of measuring spatial
resolution is set at the view area lower bound

;
 

if the view area projection bounds is set
to Projection, the height of measuring spatial
resolution is set at the halfway between the
lower and upper  bounds of the view area
( as in VideoCAD7 and previous versions).
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3.  Dome - display projection of the territory
controlled by the camera in 360 degrees,
without view area borders, but only taking into
account the shadowing.
 

When the Dome item is chosen, actually the
control area of a dome (PTZ) camera is
displayed.
 

The Dome mode is also useful for choosing the
best installation place for fixed cameras to
make required areas reachable for the cameras.
 

In the Dome mode all shaded areas from the
specified camera position become visible.
 

In the Dome mode the Spatial resolution  is
calculated without taking into account pan and
tilt angles of camera. It is assumed that the
camera can pan and tilt freely, and spatial
resolution is calculated at the center of the field
of view
. 

In the Graphics window calculation of shadows
in the Dome mode is performed like in the 
Within projection  mode, ie according to the
rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height
to the view area upper bound height , is
visible wholly.

In the 3D World  in the Dome mode the
territory controlled by the active  camera is
displayed as coverage  on the environment.
The coverage in the 3D World is displayed for
the active camera only.

 
4. Off - disable shadow calculation and displaying.

Difference between the Shadows and View area projection bounds  buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
  

The Shadow button works in conjunction with the Spatial resolution     and the Fill

projections      buttons. Depending on the state of these buttons, shadows can be
displayed in different ways: as filling, as shading, as a border lines, with mapping spatial resolution
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or not.
 

The calculation of shading - resource-intensive operation. During the shadow calculation on the

Shadow button red frame flashes .
Automatic shadow calculation is performed only for the active  camera. To recalculate shading
for a particular camera - activate this camera. To recalculate shading for all selected cameras,
click  Main Menu>View>Recalculate shadows .
To temporarily disable the automatic calculation of shading (keeping already calculated shadows
visible) clear the item Main menu>View>Calculate shadows for active camera .
 

The calculation of shading from 3D models  is disabled by default to save resources. To enable
the calculation of shading from the 3D models, check the Options box> Miscellaneous>
Shadow>Calculate shadows for 3D models .
Additionally, for each 3D model, which must be taken into account when calculating the shading:

double click  on the model to switch it to editing state ;
on the appeared Current construction parameter panel check Shadow  checkbox.

To force to calculate shadows from a type of 3D model you can mark  Shadows  checkbox on
the 3D Models  window while editing the type of the 3D model.
 

Whether or not a specific construction takes into account in the calculation of shading determines
by the Shadow  checkbox of the line type used for the construction.
.

You can ignore constructions of specified  layers  while calculating shadows, using the  Shadows
 row in the table of layers.

A button state at the moment of camera saving determines whether the shadows of the camera will
be displayed when this camera is inactive. 
 

If selected cameras exist on the layout, except the Active camera , this button changes view  

(  and operates the visibility of shadows of all selected cameras simultaneously.

When calculating 3D view areas  and
coverage of the active camera  in the 3D
World  window, shadows are calculated
independently from shadows in the Graphics
window. Calculation of shadows in the 3D
World is rougher, but much faster.

Accounting 3D models as obstacles in the 3D
World window does not depend on the state of
the Calculate shadows from 3D models
checkbox in the Options box.
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If Off is chosen in the Fill projections  and
Shadows, then filling view area faces  in the
 3D World  is not shown. 

 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Options box>Miscellaneous>Shadow

, Layers>Shadow , Options box>Calculate shadows from 3D models , Current construction
parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing the best
place for PTZ (dome) camera , Visualization of the camera control area projections and spatial
resolution within them

View > Calculate shadows for active camera
 

Enable/ disable calculating shadows.
 

Automatic calculating shadows is performed for the active camera  only.  
To temporary disable automatic calculating shadows (with keeping already calculated shadows)
clear this menu item. 
  

This item controls shadow calculation in the Graphics window only, it doesn't affect  shadows  in
the 3D World .

 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections
and spatial resolution within them

View > Recalculate shadows
 

Recalculate shadows for all selected  cameras
 

Calculating shadows is a  resource-intensive operation. Automatic calculating shadows is
performed for the active camera  only.  To recalculate shadows for all selected  cameras,
click this item.

 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections
and spatial resolution within them

View > 3D view area
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Show 3D transparent  view area faces  and
active camera coverage  area in the 3D
World window. 
 

See details: 3D World>View>View area

 Button state at the moment of camera saving determines whether the 3D view area of the given
camera will be displayed when this camera is inactive. 
 

If selected cameras exist on the current layout, except the Active camera , this button changes

view  and operates the visibility of 3D view areas of all selected cameras simultaneously.
 

View > Person detection area
 

Show/Hide the active camera projections of person detection area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of the active
camera.
 

If the projections are present, a lilac frame round the button Person detection area appears. 
 

The projections are displayed in lilac color.
 

Line type can be changed in the options box .
 

A item state at the moment of camera saving determines whether the projections of person
detection area of this camera will be displayed when this camera is inactive.  

 

Clicking this item will open person detection area size  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. Person detection area displaying will remain and the
button will remain pressed.
  

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: Person detection area size box , Criteria editing box of person detection area , 
Spatial resolution box

View > Person identification area
 

Show/Hide the active camera projections of person identification area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of  the active
camera. 
 

If the projections are present, a orange frame round the button Person identification area
appears. 
 

The projections are displayed in orange color. 

 

Line type can be changed in the options box .
 

A item state at the moment of camera saving determines whether the projections of person
identification area of this camera will be displayed when this camera is inactive.
 

Clicking this item opens person identification area sizes  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
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necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. Person identification area displaying will remain and
the button will remain pressed.
  

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: Person identification area size box , Criteria editing box of person identification area
,  Spatial resolution box

View > License plate reading area
 

Show/Hide the active camera projections of license plate reading area, calculated according to
parameters  in the Camera Geometry box and the quality level criteria  of  the active
camera. 
 

If the projections are present, a bright green frame round the button License plate reading out
area appears. The projections are displayed in bright green color.
  

Line type can be changed in the options box .
 

A item state at the moment of camera saving determines whether the projections of license plate
reading area of this camera will be displayed when this camera is inactive.  

 

Clicking this item opens license plate reading area sizes  box.  
Clicking once again close the box and hide the area projection displaying on the layout. If it is
necessary to close only the box, and area displaying on the layout should be left, close the

box by clicking Close in upper right corner. License plate reading area displaying will remain and
the button will remain pressed.
  

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See also: License plate reading area size box , Criteria editing box of person identification area
,  Spatial resolution box

View > Titles
 

Show on the top left corner: names of project and layout and the grid step on the drawing.
When the active camera is in the graphical editing state , the name of the active camera quality
level  is shown in addition.  
 

Font type can be changed in the Options box .

View > Camera names
 

Switch on/off the displaying cameras' names near their icons in the Graphics window. In the 3D
World  window you can switch of cameras' names with the help of an appropriate checkbox.
. 
 

Font type can be changed in the Options box .

View > Velocity vectors
 

Switching on/off displaying velocity vectors of 3D models.
 

See more: 3D model speed .   
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View > Active camera cables
 

Show/Hide cables  of the active camera.

View > All cameras' cables
 

Show/Hide the cables  of all the cameras. 
 

Only cables of the active camera can be edited.

View > Cameras over constructions
 

When this item is checked, cameras icons and  view areas are displayed over constructions, i.e.
the constructions do not cover the cameras. This mode is convenient at operation with complex 3D
models of rooms.
When the item is not checked, the constructions are displayed over cameras (by default).

 

See also: High resolution on top .

View > High resolution on top
 

This Item controls overlay of view area projections of cameras with spatial resolution  visualization.
If it is not checked, the cameras with view areas are drawn in the order of their numbers in the Camera
list . Active camera  is drawn on top of all. In this case, cameras drawn above overlay previously
drawn cameras.
 

In the Camera list  you can change the order of cameras in the list, which means the draw order.
 

If this item is checked, then the order of drawing is more complicated:
Below all cameras without spatial resolution  visualization are drawn;
Then, regions of spatial resolution  with minimum resolution (remote regions) of all cameras are
drawn;
Then, all regions of spatial resolution of all cameras are drawn in ascending order of spatial
resolution;
Then, gradient  projections of view areas are drawn.
On top the rest details of cameras are drawn (icons, name, edges).

 

In this case, all cameras are visible, despite the imposition of projections of different cameras and
layout's areas controlled with high spatial resolution, are drawn on the top.

Usual drawing High resolution on top

If this item is checked while export to AutoCAD format , then cameras are exported not as whole
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block, but with dividing blocks of cameras on sub-blocks with regions of spatial resolutions. The
Blocks of spatial resolution regions are exported in the same order as the High resolution on top. 

See also: Cameras over constructions .

View > Camera geometry
 

Clicking this item will open Camera Geometry box . This box includes geometric parameters of
the camera, lens and installation parameters of the camera. 

See more: Camera geometry box

View > Sensitivity and Resolution
 

Show the Sensitivity and Resolution  box in which there are parameters of sensitivity and
resolution of the active camera.
 

Sensitivity parameters take part in modeling only if the 3D Video  is opened and illumination
modeling  is switched on.
 

See more: Sensitivity and Resolution

 View > Spatial resolution
 

Show or hide the Spatial resolution box . In this box it is possible to create and edit patterns of
spatial resolution and field of view size visualization. In the box there are prepared spatial resolution
patterns according to the following criteria: Home Office Scientific Development Branch, Home
Office Guidelines for identification, P 78.36.008-99, Australian Standard AS4806: Closed Circuit
Television, European Standard EN 50132-7, ISO/IEC 19794 Biometric data interchange formats..
Also in the box there are examples of images of group of people are automatically displayed for
each region of spatial resolution.
 

See more. Spatial resolution box , Spatial resolution button .

View > 3D Video
 

Show or hide the 3D Video window. The 3D Video displays the image from the active camera. 
 

See more: 3D Video

View > 3D World
 

Show or hide the 3D World window. In the 3D World the project layout with cameras and view
areas is shown in 3D.
 

See more: 3D World.

View > Depth of field
 

Show or hide the Depth of field calculation box.
 

242

289

289

329

357

372

329

316

316 177

357

342



VideoCAD244

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

When the depth of field box is visible, next to all
cameras in the horizontal projection the
following lines are displayed:

sharpness area bounds ;
focus plane ;
plane at the hyperfocal distance .

These lines are calculated according to the 
depth of field parameters  of each camera at
the height of depth of field measurement .
 

If the focus plane or the plane at the
hyperfocal distance not intersect the
horizontal plane at the height of depth of field
measurement within the view area
projection, then the focus plane or the plane
at the hyperfocal distance are not displayed. 
 

If the near or the far bound of the sharpness area  not intersect the horizontal plane at the
height of depth of field measurement within the view area projection, then this bound is not
displayed.
 

The absence of near and far bounds of the sharpness area indicates that the sharpness area
completely covers projection of view area, thus the depth of field does not reduce the resolution of
the camera.
 

This tool doesn't take into account camera rotation around its main optical axis , shadows
and lens distortion .
 

See more: Depth of field calculation box ,  Control of Depth of Field in the horizontal projection
.

View > Test object
 

Show the test object of the active camera with the sizes and location according to parameters
in the test object box .  

Clicking this button also opens this box.
Clicking this button once again close the test object box and hide test object on the layout. If it is
necessary to close only the box, and test object on the layout should be left, close the box by

clicking Close in upper right corner. Test object will remain and the button will remain pressed.
 

A test object can be displayed only in the graphical editing state  of active camera.
 

See more: Test object box 

View > Monitor window
 

Show or hide the Monitor window. In the Monitor window images from any quantity of cameras
are displayed simultaneously. Monitor window allows modeling monitors of video surveillance
system.
 

See more: Monitor window

View > Hide vertical projection
 

With this item chosen a horizontal projection is only present in the graphics area .
To display a vertical projection click this item again.
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View > Hide horizontal projection
 

With this item chosen a vertical projection is only present in the graphics area . 
To display a horizontal projection click this item again.

View > Grid
 

Choosing this item opens a submenu of grid displaying control. The submenu enables to set a
certain grid step up, switch a mode of automatic grid step selection on/off and switch the grid
displaying off.
 

See also: "Grid" control element group

View > Origin
 

This item opens the submenu of origin selection.
 

The graphics area  allows to use 2 coordinate systems:
 

Fixed coordinate system
Float coordinate system attached to the active camera

 

In case of the fixed coordinate system, the origin of coordinates does not vary when changing

the active camera. The origin is displayed as two icons  in horizontal and vertical projections. It
is possible to change a point of origin after choosing the menu item View > Set origin .
 

In case of the coordinate system attached to the active camera, the origin of coordinates
always coincides with the active camera location. It is convenient when studying its view area.
 

A grid  is fixed to the origin of coordinates, and the counting of the cursor current coordinates
in the status bar  starts from the origin.

View > Set Origin
 

After choosing this item clicking on the horizontal projection sets up a new origin  of the
Fixed coordinate system . 
 

In the vertical projection horizontally the Origin coincides with the one set in the horizontal
projection, and vertically it coincides with the ground.

View > Black-and-white
 

Switch black-and-white drawing mode on/off. 
 

This mode is useful when printing a drawing out on black-and-white printer.

View > Options
 

Choosing this item opens a dialog box of the program options .
 

See more: Options box

Scale > Zoom in
 

Clicking this item increases a drawing scale. 
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Using the Intellimouse you can change the drawing scale with the simultaneous zooming in the
image sections pointed by the cursor.
  

If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation. If Ctrl is pressed, the scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.

 

When the Show active camera  button is pressed, changing drawing scale is not allowed and
this item is unavailable. 
 

If input focus is on the graphics area, scale can be changed by + and -  buttons on the keyboard.
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
 

Choosing an item of the pop-up menu appearing when click ing the graphics area  with the right
mouse button performs the command as well.

Scale > Zoom out
 

Clicking this item reduces a drawing scale. 
Using the Intellimouse you can change the drawing scale with the simultaneous zooming in the
image sections pointed by the cursor.
  

If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation. If Ctrl is pressed, the scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.

 

When the Show active camera  button is pressed, changing drawing scale is not allowed and
this item is unavailable. 
 

If input focus is on the graphics area, scale can be changed by + and -  buttons on the keyboard.
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
 

Choosing an item of the pop-up menu appearing when click ing the graphics area  with the right
mouse button performs the command as well.

Scale > Move drawing
 

With this item chosen you can move a drawing within the graphics area  using the mouse. 
To do that press and hold down the left mouse button at any spot of drawing and then move the
mouse holding the button down. To stop moving the drawing release the mouse button.
 

If your mouse is an Intellimouse or other Wheel mouse you can move the drawing at any time
by pressing and holding the middle button down. 

 

When the Show active camera  button is pressed, moving drawing is not allowed and this button
is unavailable.
 

When Alt is pressed , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.

Scale > Show all
 

Show all cameras and other constructions on the current layout. At this the scale and view are
chosen automatically. The function is not operable in the editing active camera mode .
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Scale > Find text
 

After choosing this item the Find text box will appear. In the box any text can be entered. 
 

After clicking the button OK, all cameras and text markers  on the current layout, in which
designation the entered text is included, will become visible and selected . At this the scale
and view are chosen automatically.   
Even only one letter can be entered, and at this all cameras and text markers on the current 
layout, in which designation the entered letter is included will become visible.
 

It is convenient to mark the upper left and the lower right corner of the required areas with text
markers. After that as the result of searching the marked area will be displayed on the full screen.
      
 

When clicking the button Save the entered text string will be saved, and it will be enough later on
just to choose it from the list to find the corresponding objects.  
Text strings are saved in the project in separate lists for each layout, i.e. are saved between
computer rebooting and project moves.   
 

When clicking the button Delete the displayed text string will be deleted from the project. 
 

The function is not operable in the editing active camera mode .    

Constructions > Point
 

When this button is pressed, clicking on the graphics area places a point.
The status bar  displays the coordinates of this point relatively to the origin of coordinates .
 

In the 3D Video  and 3D World  the vertical segment will be displayed in the points place. 
 

Default minimal and maximal heights of the segment are determined by the line type , which
constructs the point. The heights can be set separately for each point by means of the current
construction parameters panel , on which it is also possible to set coordinates of the point in
numeric values.
 

See also: "Constructions" button group

Constructions > Horizontal line
 

When this button is pressed, clicking on the graphics area  specifies a point through which a
horizontal line is passes. 
 

The status bar  displays the line height or its shift from the origin of coordinates  according

to the projection being clicked.
 

In the 3D Video  and 3D World  at the place of the horizontal line 2 horizontal lines will be
displayed. 
 

Default minimal and maximal heights of the lines are determined by the line type , which
constructs the horizontal line. The heights can be set separately for each horizontal line by means
of current construction parameters panel , on which it is also possible to set coordinates of the
horizontal line in numeric values.
 

See also: "Constructions" button group

Constructions > Vertical line
 

When this button is pressed, clicking on the graphics area  specifies a point through which a
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vertical line is passes. 
 

The status bar  displays the distance from the origin of coordinates .
 

In the 3D Video  and 3D World  at the place of the vertical line 2 horizontal lines will be
displayed. 
 

Default minimal and maximal heights of the lines are determined by the line type , which
constructs the vertical line. The heights can be set separately for each vertical line by means of
the current construction parameters panel , on which it is also possible to set coordinates of the
vertical line in numeric values.
 

See also: "Constructions" button group

Constructions > Focal plane
 

When this button is pressed, clicking on the graphics area   in the vertical projection specifies a
point through which a plane vertical projection passes. This plane is perpendicular to the main
optical axis of the active camera lens (parallel to the lens focal plane).
 

The status bar  displays the coordinates of the clicked point relatively to the active camera.
 

When changing camera location the position of the obtained plane changes correspondingly. 
 

Generally speak ing, the obtained plane is not a focal one, being only parallel to it.
  

In the 3D Video   and 3D World  the Focal plane is not displayed.
 

See also: "Constructions" button group

Constructions > Optical axis
 

When this button is pressed, clicking on the graphics area  specifies a point through which an
optical axis of the active camera lens passes.
 

The status bar  displays the coordinates of the clicked point relatively to the active camera.

 
 

When changing a camera location the position of the obtained axis changes correspondingly. 
  

In the 3D Video   and 3D World  the Optical axis is not displayed.
 

See also: "Constructions" button group

Constructions > Line segment
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
line segment. Second clicking specifies the end point of the line segment.
 

The status bar  displays the segments length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point. 
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In the 3D Video  and 3D World  a vertical
rectangle will be displayed at the segment
place. 
 

Default minimal and maximal heights of the
rectangle are determined by the line type ,
which constructs the line segment. The heights
can be set separately for each line segment by
means of current construction parameters panel

, on which it is also possible to set
coordinates of the line segment in numeric
values.
Color of the rectangle is determined only by line
type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
segment: coordinates of the first and second points, length, angle. 
 

A segment can be also used to measure distances on layouts without click ing for the second time
in this case.
 

Line segments can be used for modeling cables with subsequent cable length calculation. Use
separate line types to draw each cable type. For length calculation use the Length calculation of
line segments  tool.
 

See also: "Constructions" button group

Constructions > Polyline
 

This tool allows to draw line segments continuously. The end of each segment is the start of the
next one. To stop drawing lines, press ESC.
In other respects this tool equals to the Line segment  (see. above).
 

See also: "Constructions" button group"

Constructions > Angle
 

When this button is pressed, the first clicking on the graphics area  specifies the vertex of an
angle. Second and third clicking specify its arms.
 

The status bar  displays the angle value in degrees.
 

If the angle vertex and arms are constructed in different projections, when changing drawing the
angle is attached to the projection with its vertex. 
  

In the 3D Video  and 3D World  2 vertical
rectangles will be displayed at the angle place. 
 

Default minimal and maximal heights of the
rectangles are determined by the line type ,
which constructs the Angle. The heights can be
set separately for each Angle by means of 
current construction parameters panel , on
which it is also possible to set coordinates of
the line segment in numeric values.
Color of the rectangles is determined only by 
line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
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angle: coordinates of the first, second, third points, length, angle value in degree. 
 

The angle tool is also used to measure angles on layouts.
 

See also: "Constructions" button group

Constructions > Rectangle
 

When this button is pressed, the first clicking on the graphics area  specifies the first corner of a
rectangle. Second clicking completes the rectangle construction.
 

The status bar  displays the information on the rectangle sizes and location. 
 

In the 3D Video  and 3D World  a
parallelepiped will be displayed at the rectangle
place. 
 

Default minimal and maximal heights of the
parallelepiped are determined by the line type

, which constructs the rectangle. The
heights can be set separately for each
rectangle by means of current construction
parameters panel , on which it is also
possible to set coordinates of the rectangle in
numeric values.
Color of the parallelepiped is determined only
by line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
rectangle: coordinates of the first points, height, width. 
 

Rectangles are also used for creating rectangular horizontal planes in the 3D Video, for example
a ceiling or floor.
 

See also: "Constructions" button group

Constructions > Inclined rectangle
 

When this button is pressed, clicking on the graphics area  specifies  first corner of an inclined
rectangle.
 

Inclined rectangle is similar to a rectangle
and differs from it that in 3D Video  and 3D
World  it is displayed in the form of inclined
rectangle. The minimal height of rectangle
corresponds to the lower side of this
rectangle, and the maximal height - to the
upper one.

In the Graphics window the upper side of
inclined rectangle is displayed by thick line. 
 

For modeling complex objects it is possible to edit  inclined rectangle by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
  

Inclined rectangle can be made transparent by 70 %. For this purpose it is necessary to mark the
Transparence checkbox on the Current construction parameter panel .
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Inclined rectangle is very universal tool. Using the inclined rectangles it is possible to model any
3D objects. 
 

It can be useful to combine inclined rectangles
in pairs thus to get triangles with independent
vertexes in the 3D space. Meanwhile two
vertices of each inclined rectangle must
coincide. The rest two vertices of first inclined
rectangle must coincide with the other two
vertices of second inclined rectangle.

 

Using obtained triangles you can theoretically
build any 3D surfaces, although it can be not
simple in practice.
For example, all 3D models in VideoCAD
consist of triangular mesh only.

  

See also: "Constructions" button group

Constructions > Double line
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
double line. Second clicking specifies the end point of the double line.
 

The length and the width of the double line appear in the status bar .
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the distance between lines of the double line.
 

Two buttons allow switching the orientation of the second line relatively to the first one

.
You can also switch the orientation quickly by pressing the Space bar.
 

In the 3D Video  and 3D World  2 vertical
rectangles will be displayed at the double line
place. 
 

Default minimal and maximal heights of the
rectangles are determined by the line type ,
which constructs the double line. The heights
can be set separately for each double line by
means of current construction parameters panel

, on which it is also possible to set
coordinates of the double line in numeric
values.
Color of the rectangles is determined only by 
line type , which is used at constructing.

 
 

On the current construction parameters panel it is possible to set and fix parameters of the
double line: coordinates of the first, second points, length, angle.
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See also: "Constructions" button group

Constructions > Wall
 

The Wall tool is intended for drawing walls with specified thickness and height. In these walls you
can make apertures  of any shape,  for example for doors and windows.
 

When this button is pressed, the first clicking on the graphics area  specifies the start point of a
Wall. Second clicking specifies the end point of the Wall.
 

The length and the width of the wall appear in the status bar .
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the wall.
 

Two buttons allow switching the orientation of the second wall side relatively to the first one

.
You can also switch the orientation quickly by pressing the Space bar.
  

In the 3D Video  and 3D World  a
parallelepiped will be displayed at the wall
place. 
Default minimal and maximal heights of the wall
are determined by the line type , which
constructs the wall. The heights can be set
separately for each wall by means of the current
construction parameters panel , on which it
is also possible to set coordinates of the wall in
numeric values.
Color of the parallelepiped is determined only
by line type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
wall: coordinates of the first, second points, length, angle.
 

In walls it is possible to make apertures for doors and windows using the Aperture in Wall  tool. 
 

See also: "Constructions" button group

Constructions > Aperture in Wall
  

The Aperture in Wall tool designed to easily
create apertures (openings) of various shapes in
the walls, built by the Wall  tool.
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In order to an aperture will appear in the 3D
space, it must intersect the horizontal
projection of the wall.

 

The Aperture in Wall tool  is similar to the Inclined rectangle  tool. But the  Inclined rectangle
creates a flat rectangle in 3D space, but the Aperture in Wall placed inside the Wall, cuts an
aperture in the wall. This aperture equals to the projection of the same flat rectangle on the plane
of the wall.
The minimal height of aperture corresponds to the lower side of this rectangle, and the
maximal height - to the upper one.
 

In the Graphics window the upper side of aperture is displayed by thick line. 
 

In line type panel  that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the aperture.
 

The Thickness of the wall affects only the shape of aperture projection in the Graphics window. In
the 3D Video the apertures always cut through a wall at its full thickness.
 

Two buttons allow switching the orientation of the second aperture side relatively to the first one

.
You can also switch the orientation quickly by pressing the Space bar.
 

For modeling complex apertures it is possible to edit  the Apertures by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
You can create complex apertures using several intersecting apertures.
 

See also: Wall , "Constructions" button group"

Constructions > Circle
 

When this button is pressed, the first clicking on the graphics area  specifies the center of a
circle. Second clicking completes the circle construction.
The status bar  displays the information on the sizes and location of the circle.
 

To switch the circle into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
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 In the 3D Video  and 3D World  a cylinder
will be displayed in the circle place. 
 

Default minimal and maximal heights of the
cylinder are determined by the line type ,
which constructs the circle. The heights can be
set separately for each circle by means of 
current construction parameters panel , on
which it is also possible to set coordinates of
the circle in numeric values.
Color of the cylinder is determined only by line
type , which is used at constructing.
 

On the current construction parameters panel it is possible to set and fix parameters of the
circle: coordinates of the center and second point, radius, angle. 
 

See also: "Constructions" button group

Constructions > Arc
 

When this button is pressed, the first clicking on the graphics area  specifies the center of an
arc. Second and third clicking specify its ends..
To switch  the arc into the editing state you need to double-click on its center or on either of its
two ends. 

In the 3D Video  and 3D World  the arc
stretches, creating a cylindrical surface. 
 

Default minimal and maximal heights of the
cylindrical surface are determined by the line
type , which constructs the arc. The heights
can be set separately for each arc by means of 
current construction parameters panel , on
which it is also possible to set coordinates of
the arc in numeric values.
Color of the arc is determined only by line type

, which is used at constructing.

On the current construction parameters panel it is possible to set and fix parameters of the
arc: coordinates of the center, first and second points, radius, angle.  

 

See also: "Constructions" button group

Constructions > Stairs
 

Stairs is similar to the Inclined rectangle
and differs from it that in the 3D Video and
3D World  windows it is shown in the form of
stairs 
 

On the current construction parameters
panel  the minimum height corresponds to the
pedestal of the stairs, maximum height
corresponds to the top of the stairs.
 

In the Graphics window the upper side of
stairs is displayed by thick line. 
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The number of steps is calculated
automatically from the height of one step
equals to 15 cm.
 

See also: "Constructions" button group
 

Constructions > Text   
 

When this button is pressed, clicking on the graphics area  specifies the place for a text string.
At this point a pop-up frame with cursor will appear.
The necessary text is to be entered within a frame. To separate the lines use Enter. 
 

The font type panel  appears below in the graphics area allowing to change the font type . A
pop-up menu is available within a frame, appearing at clicking the right mouse button.
  

The entered text is a text marker and can be quickly found using the Find text  tool. This is a
very convenient and quick means for navigation on big layouts.
  

In the 3D Video   and 3D World   Texts are not displayed.
 

See also: "Constructions" button group , Find text
 

Constructions > Mask
 

When this button is pressed, the first clicking on the graphics area  specifies  the first vertex of
rectangular mask. Second clicking completes the mask construction.
 

The status bar  displays the information on the mask sizes and location. 
 

Using masks allows to cover any image parts. Constructions  and texts  can be drawn over
masks.
  

To cover separate construction fragments you can also use line of white color.
In the 3D Video masks are not shown.
 

In the 3D Video   and 3D World  the Mask is not displayed.
  

See also: "Constructions" button group

Constructions > Filling
 

Filling is similar to a mask , but can be of any color, and also in the form of different hatch
type. Color of filling is defined by the color of line type, by which the filling is made, and type of
hatching or its absence - by style of this line type.
 

Fillings, as well as other objects, could be edited  by moving separate vertexes, and thus could
be stretched on various objects. 

In the 3D Video   and 3D World   fillings are not shown.
 

See also: "Constructions" button group

Constructions > 3D image

This tool is similar to Inclined rectangle . As well as the inclined rectangle it allows to place a
rectangle in three-dimensional space at any angle.
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 But this rectangle can be "covered" by any
raster image in *.bmp , *.jpg, *.gif, *.tiff, *.png
formats. The image can be a photo or a figure. 
In  *.bmp and *.jpg files, pixels of the image can
be transparent if they have a color coincided
with the color of the left bottom pixel. Thus
the image border can take any form.
 

In *.png  files transparent pixels will be
displayed transparent.

In many cases raster images can replace 3D
models  which are difficult to make. They can
be used for modeling many objects from
banknotes and plates up to a complex
background. 

 

After choosing this button the Loading 3D image dialog box appears. After choosing a file in *.
bmp,*.jpg,*.jpeg,*.png,*.gif,*.tif  or *.tiff format place 3D image in the same way as Inclined
rectangle.
On the Current construction parameter panel  the minimal height corresponds to the bottom
bound of this rectangle and the maximal height - to the top bound.
 

In the Graphics window the top of 3D images is displayed by thick line.
 

Later 3D image can be edited  by moving its grips. It is possible to change 3D image sizes on

the Current construction parameter panel, delete and change the image file using buttons  and
. on the Current construction parameter panel.

 

To make transparent pixels with color coincided with color of left bottom pixel (or transparent
pixels of *.png file), check Transparence checkbox on the Current construction parameter
panel.
 

To get the transparence of *.bmp or *.jpg file, the image file has to be specially prepared by means
of any graphic editor, for example Paint. Pixels that should become transparent have to be filled
by color that coincides with the color of left bottom pixel.
 

See also: "Constructions" button group

Constructions > Rotakin
 

Rotakin - an animated rotating test target for
visual estimation of spatial resolution and
motion distortions on the 3D images. 
 \

In the horizontal plane the Rotakin
automatically turns  towards the active camera.

In the vertical plane the Rotakin rotates with a
specified speed about an axis passing through
its center (in Professional version only).

Rotakin rotates when modeling exposure time , Rolling Shutter , interlace distortions  and
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creation of animated images .
 

To place the Rotakin specify a place for the Rotakin by clicking.
On the current construction parameters panel it is possible to set minimal and maximal
heights of the Rotakin.  

In the  Options box   it is possible to change rotation speed of all Rotakin objects.
 

Rotating test target named Rotakin is used in field testing of video surveillance systems by the
techniques developed by the Home Office Scientific Development Branch 'Performance Testing
of CCTV Perimeter Surveillance Systems (Using the Rotakin Standard Test Target) ". The
Rotak in model meets the requirements of the document.
 

See also: "Constructions" button group

Constructions > Illuminator
 

The tool is designed to model illuminators with photometric accuracy.
 

As a result of clicking this button the Illuminator calculation box appears.
You can specify internal parameters of an illuminator in the box.
 

See more: Illuminator calculation .
 

You can open the Illuminator calculation box  by the  button on the Current construction
parameter panel  during placing or editing Illuminator.
 

On the Line type panel  it is possible to choose the line type , by which the Illuminator's icon
will be drawn. Later line type can be changed using Change line type  tool.

On the Current construction parameter panel it is necessary to specify Illuminator height
relative to the base height  of a layer to which the illuminator belongs and Inclination angle (for
projectors).
 

See more. Current construction parameter panel> Illuminator .
 

After assigning the parameters in the Illuminator calculation box and on the Current
construction parameter panel, specify an Illuminator place by the first clicking in horizontal
projection. Then specify a radiation axis direction by the second clicking (for projectors).
 

If graphic specifying angle of radiation and Light intensity distribution curve (LIDC) are not
required, click for the third time on any point in the graphics area. 
To specify angle of radiation and LIDC graphically after the second clicking clear Angle box on
the Current construction parameter panel. After that by the third clicking specify angle of
radiation and light intensity concentration on an axis of radiation. 
 

Light intensity distribution curve is displayed by orange
line.
Light intensity distribution curve represents relative light
intensity distribution. The curve does not depend on
absolute values.

     

It is possible to specify parameters after the Illuminator placement. To set parameters click Edit
button and set parameters on the Current construction parameter panel. To open Illuminator

calculation box click the  button.
In order to edit angle of radiation and concentration by moving pink grips, press and keep Ctrl
pressed.  
 
Created Illuminator will take part in 3D image modeling from some camera only if for this camera:

Illumination modeling is switched on ;
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Illuminators are enabled ;
The Illuminator is switched on .

While modeling Illuminators VideoCAD considers only direct light. Reflected light can be
considered only approximately by specifying a part of light from this Illuminator diffused on the
scene. Shadows cannot be modeled in VideoCAD.
 

See also: Illuminator calculation , Current construction parameter panel .

Constructions > Field-of-view size
 

When this button is pressed, moving the cursor in the vertical projection of graphics area  a field-
of-view size value passing through the cursor point is indicated on the Status bar
 

The field-of-view size depends on height and distance, therefore measuring in the vertical
projection is allowed only.
 

The button is available in the graphical editing state  only.
 

If no other measurements made after the field-of-view size is marked at a point, with changing a
camera position, the values in the status bar change correspondingly, thus representing the
current field-of-view sizes at a point.
 

See also: "Constructions" button group

Constructions > Test object location
 

When this button is pressed, clicking on the graphics area  specifies the test object location.
The parameters of test object location in the test object dialog box  change correspondingly. 
 

The button is available in the graphical editing state  only.
 

Test object can be seen in the 3D Video  in the
graphical editing state. 

See also: Test object box

Constructions > Global snaps
 

Choosing this item opens a submenu enabling to switch global snaps on/off and display the snap
panel, with the help of which it is convenient switch the snaps fast when drawing.
 

Snaps enhance the convenience in drawing. As a result of the snaps' functioning the cursor
"sticks" to the certain points, lines or directions.
 

Points - the cursor sticks to base object points.
Lines - the cursor sticks to objects lines.
Angular snap functions at construction of line segments, angles, cables, and at moving and
rotating as well. After that the subsequent construction points are leveled from the previous
points horizontally and vertically.
Extension - the cursor sticks to the virtual horizontal and vertical lines passing through base
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objects points. 
The snap Extension is disabled for hidden  objects and in the Select/Edit  mode.

At grid - the cursor sticks to grid nodes.
 

In the Options box  you can change snap sensitivity.
 

Show panel - display the snap panel, with the help of which it is convenient switch the snaps
fast while drawing.

 

The pop-up menu appearing when clicking the graphics area  with the right button of the mouse
contains an item Local snap. The local snaps have the same function as the global ones though
working during one operation.

Constructions > Lock constructions
 

After modeling the environment the cameras' placement stage begins. At this stage displacement
of constructions is not required any more, and their casual selection can cause inconveniences. If
this item is marked, the selection of constructions is locked. To release the locking, click this item
once again.

3D models > 3D Model
 

The item opens submenu, in which there are 3D models which are present in the program library. 
 

When any item in the submenu is chosen, clicking in the graphics area  specifies the place for
a 3D model. 
 

 3D models placement is possible in the
horizontal and vertical projections, however only
3D models placed in the horizontal projection
will be visible in the 3D Video  and 3D World

.

 

In the horizontal projection the 3D models are displayed in the top view, in the vertical projection -
in the side view, and in the 3D Video  and 3D World  models are as 3D objects.  
 

Horizontal and vertical  projections  for displaying in the Graphics window can be created in
the 3D Models  window.   
 

3D models can be moved, rotated, copied, changed draw order  as other VideoCAD objects. 
 

The default height of the 3D models above the ground is determined by the maximal height of
the line type  which was chosen when the 3D model was being placed. The height can be set
separately for each 3D model using the current construction parameters panel . 
 

To change 3D model height above the ground, select  the 3D model, then change line type
or switch the 3D model to editing state by double clicking on it and change value in the 3D H box
on the Current construction parameters panel.
 

By default the 3D models are on the ground and constructed by the line type with the number,
specified on the Lines  tab of the Options box . This line type has the maximum height
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equal to 0. 
Heights can also take on negative values, in this case 3D model plunges under ground. 
For example, to place a 3D model on a surface: construct the surface by the rectangle  tool
using line type with the required maximum height, place the 3D model on it, and then change 3D
model line type to the line type of the surface. 

In multilevel 3D projects heights are calculated relative to the base height of a layer  the which
the 3D model belongs. By changing the base height a layer you can move up or down all 3D
models and constructions on the layer
 

In the Editing state  using the Current construction parameters panel you can resize 3D
models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the  box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken. 3D model height above the ground is displayed and can be changed in 3D H box.  
 

In the editing state , 3D models are displayed
with square grips and pink circle.
You can rotate the 3D model by the mouse
using the circle, scale 3D model on X and Y
axis using the square grips. You can move the
3D model by pressing the left mouse button on
the 3D model, as well as in the selected state.
 

Moving 3D models
 

3D models can have velocity vectors. Model with specified nonzero speed will move with this
speed along a specified direction when modeling exposure time , Rolling Shutter ,
interlace distortions  and creation of animated images .
To set speed to 3D model you should enter a nonzero value in the Speed  box in the Current
construction parameter panel during the placement or editing 3D models.

If a 3D  model  has non zero speed, then

the velocity vector is displayed.
 

If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model pass
per second (crimson arrow).
If 3D model is in the normal state, the

length of the velocity vector equals to the

distance which the 3D model passes for
the period between successive frames of
the Active camera  (black arrow).

 

* the length of the velocity vector of a 3D model in the normal state is inversely proportional

to the  frame rate  of the active camera. Thus we can see how many times the moving 3D

model gets into the frame of the active camera.
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You can edit the velocity vector of 3D
model in editing state by moving its
terminus. 
 

 \

You can hide the velocity vectors of all 3D models using the Velocity vectors  menu item.

License plate of cars

Let's consider 3D models - cars with license plates. License plate type, the same for all car

models, is determined by the file number.bmp  file in the directory \Models\, and the plate

size - by the corresponding settings in the Options box on the 3D modeling  tab. This

opportunity allows using the same models in different countries with different license plates. 

 

To make cars appear in the 3D Video with the license plate of your country:      
create a *.bmp  file with the image of you license plate; 

!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....

replace the file number.bmp by your file;
specify the sizes of your license plate in the Options box. 

3D models of terrain
 

You can use 3D model of terrain of video surveillance, for example: buildings, territory etc.
Cameras, constructions, other 3D models can be placed inside the 3D model-territory.
VideoCAD offers special tools  for working with 3D models-territories
 

See more:  3D Models window ,  3D World window , Work  with 3D model-territory .

 

Adding new 3D models, manage 3D models
 

You can add new 3D models to the library using Add 3D Model  menu item.
 

You can add, delete, duplicate 3D models, distribute 3D models by directories in menu, get
projections of 3D models for the Graphics window  using the  3D Models  window. 
 

Files of 3D models in *.vcm format can be exported from SketchUP and 3ds max using plugins.
Custom 3D models for VideoCAD can be created in SketchUP and 3ds max.
 

 See more: Importing 3D models from SketchUp and Autodeck 3ds Max  

 

See also: 3D Video ,  3D World , 3D Models , Options box>Lines , Options box>3D
modeling .

3D models > 3D Models window
 

Open the 3D Models window. This window is intended for working with 3D models , add, delete,
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duplicate, make projections etc.
 

See more: 3D Models window

3D models > Add 3D model
 

Add a 3D model to the program library. In the dialog box, select a file of 3D model *. vcm format
and click Open.
 

Files in *. vcm format can be obtained by exporting from SketchUP and 3ds max using plugins.
For details, see IImport of 3D models from SketchUp and Autodesk 3dsMax  
 

If VideoCAD library already has a 3D model with the same name or ID, you will be prompted to add
the model under a different name or ID.
Then you will see the  3D Models window , in which you can create the projection  of the 3D
model to display it in the Graphics window  and menus . To do this click the Save
projection button and close the 3D Models window. After this, icons of the 3D model will appear
in menus and the 3D model can be placed in the graphics area.
 

For other features of the 3D Models window, see 3D Models window
 

If your 3D model has textures, in the same directory where the *.vcm file is opened from, a folder
with textures must be. The folder should be named <model name> _textures. VideoCAD plugin
for SketchUP automatically creates the folder with the textures in the directory of saving exported
model.

Edit > Select All
 

Select all constructions, models, cameras, cables and illuminators on the current layout. 

Edit > Select/Edit
 

 With this button chosen the first corner of
selection window appears when clicking any
empty place of graphics area  once. Clicking
it again completes the designation of selection
window. 
All the objects, which hit in the selection
window and reside on the projection
coinciding with one being clicked for the first
time, will be selected . However, the earlier
selected objects not hitting in the selection
window will revert to normal state . 

 

If Ctrl is pressed at click ing, the objects within the selection window are inverted, on the contrary,
state of those not hitting in the selection window remains the same. 
 

It is possible to select objects by one by clicking their image once, thus enabling the earlier
selected objects to revert to normal state. 
If Ctrl is pressed at click ing, the objects are inverted, and the state of the rest remains the same. 
  

You can make a 3D model  insensitive to mouse click  by Lock checkbox  in the 3D Models
window.
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During construction 3D scenes  it is often necessary to place some constructions one over
another at a different height, made by means of different line types . 
To select one or more construction, located one over another, made by means of different
line types:

make the line type panel  visible, for example by double clicking any construction;
choose on the panel the line type of construction you want to select; 

select the construction by clicking.
 

Just repeat clicking at the same place without moving the cursor. Thus objects under the cursor will
be selected sequentially.
 

Layers  are very useful for multi-level constructions.

An object can be  inaccessible for selection if it belongs to a not enabled layer  

To move objects on the foreground or background use menu items: Bring to front , Send to back
.

 

Selected objects can be moved. To move the selected objects, bring the cursor to the selected
one, press the left mouse button and move the selected objects. After finishing the moving, release
left mouse button. 

To cancel selection click  this button again.
 

To select all objects on the current layout use Ctrl+A shortcut.
 

For switching to Select / Edit mode from any mode use also Esc button.
 

See also: Selected state
 

Editing state of objects

 

To translate an object into editing state  double-click its image.
After that pink grips appear on the object base points. 
When moving the cursor over this point its image changes. 

 

To edit an object click beside a base point with a grip and move the cursor. After clicking for the
second time, the changed object is set up.
If on one side of a construction a circle is displayed, the construction can be rotated around its
axis by catching the circle by mouse.

To switch the circle  into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
To switch  the arc  into the editing state you need to double-click on its center or on either of
its two ends.
 
When editing a rectangle  or a mask , then several points will move at a time, the rectangle
or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
 

When editing a Double line  or Wall , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved. 
 

When clicking the text  twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.
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In the editing state, 3D models  are displayed with square grips
and pink circle.
You can rotate the 3D model by the mouse using the circle, scale
3D model on X and Y axis using the square grips. You can move
the 3D model by pressing the left mouse button on the 3D model,
as well as in the selected state.

 

To switch illuminator  to editing state click on its center.
 

Thereupon, the Light intensity distribution curve (LIDC) becomes
visible. To edit the curve by moving grips on the layout press Ctrl.

 
It is possible to change object's parameters in editing state on the current construction
parameters panel  which automatically appears in the bottom of graphics window.
 

See also: Editing state

Activate cameras

 

When double-clicking the camera lens the following actions are performed:
 

the Active camera  is saved. 
the camera being double-clicked will become active.

 

It is convenient to pan and tilt the active camera by moving the grip in the middle of the view area
upper bound. 
In a similar way by moving grips on the ends of the view area upper bound it is possible to
change lens focal length  of the camera. 
 
If a model  is assigned to the camera, the focal length changing is possible only in the limits
specified in model parameters .

Changing the lens focal length, and therefore the calculated values of view angles of a camera
with enabled modeling lens distortion  will lead to detuning parameters of distortion and warping
view area form. To correct the mismatch you should set new values of the actual view angles ,
tak ing into account the changed values of calculated view angles.
 

See also: Active camera

See also: "Edit" button group

Edit > Cut
 

Cut the selected objects  into the VideoCAD internal clipboard.
 

It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions , 3D objects , cameras, illuminators , texts  and cables.
 

When cutting the Active camera  it is copied.
 

See also: Cut with base point .
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Edit > Copy
 

Copy the selected objects  into the VideoCAD internal clipboard.
 

It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions , 3D objects , illuminators , texts  and cables.
   

See also: Copy with base point .

Edit > Cut with base point
 

Cut the selected objects  into the VideoCAD internal clipboard relative to a base point. 
After clicking this button specify the base point of cutting. 
 

It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions , 3D objects , texts , cameras, illuminators  and cables as well.
 

When cutting the active camera it is copied.
 

See also: Cut .

Edit > Copy with base point
 

Copy the selected objects  into the VideoCAD internal clipboard relative to a base point. 
After clicking this button specify the base point of copying. 
 

It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions , 3D objects , texts , cameras, illuminators  and cables as well.
   

See also: Copy .

Edit > Paste
 

Paste the objects from the VideoCAD internal clipboard. 
After clicking this button specify the base point of paste in the projection being clicked when
cutting or copying. 
 

It is possible to paste into different layouts , paste cables of one camera while another camera
is active (in this case the pasted cables belong to a camera which is active during paste), and to
paste any quantity of constructions , 3D objects , cameras, illuminators , texts  and
cables at a time.
 

It is available to copy and paste constructions, cables and texts between the projects. To this
effect make a copy in one project, then open another project or create a new one and paste what
you have copied.
 

Be careful when copying and pasting cables. You can copy only cables of Active camera ,
and when pasting, these cables will belong to the camera which is active during pasting.
 

If a camera is being pasted a new camera with parameters of the pasted camera is created
automatically. This is an alternative way to create new cameras.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but pasted camera doesn't become active. Therefore the view area of the pasted
camera is displayed without shadows. To calculate shadows - activate  the camera after pasting.
 

 Pasting is always performed to the active layer . At the moment of placing new camera  or
pasting  copied camera, its base height  is set to the  base height of the active layer .
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Edit > Move
 

Move the selected objects . 
After clicking this button the first click in a graphics area  designates the starting moving point,
the second click - the final one. 
 

When moving take into account the projection to which the objects are attached. A simultaneous
moving objects in different projections vertically is locked as being incorrect.
 

Selected  objects or cameras can be moved in Select / edit  mode. In order to move place
the cursor above the selected object, press left mouse button, move, after moving is finished
release the left mouse button.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but moved camera can be not active. If the camera is not active, the view area of the
moved camera is displayed with old shadows. To recalculate shadows - activate  the camera
after moving.

Edit > Rotate
 

Rotate the selected objects . 
After  clicking this button the first click in a graphics area  designates the rotation center, the
second click specifies the initial rotating point, and the third click specifies the final rotating point. 
 

When rotating take into account the projection to which the objects are attached. The selected
objects, attached to the projection with a rotation center designated, can rotate only.
 

The scalable  fonts can rotate only. If a font is not scalable then its initial point rotates only,
the text remaining horizontal.
 

The active camera can be rotated in Select / edit  mode by moving the grip in the middle of the
view area upper bound.
 

 Shadows  in the Graphics window  and in the  3D World  are calculated for the active
camera , but rotated camera can be not active. If the camera is not active, the view area of the
rotated camera is displayed with old shadows. To recalculate shadows - activate  the camera
after rotating.

Edit > Scale
 

Change scale of selected  constructions relative to the center of scaling. 
 

After clicking on this button, the first click on the graphics area  specifies the center of scaling
. 
 

Then moving the cursor up increases sizes of selected constructions, moving the cursor down
decreases sizes of selected constructions.
 

In the Status bar  the current scale factor is displayed.
 

When required sizes will be achieved,  click for the second time to complete scaling operation. To
cancel the scaling press ESC.
 

This tool does not scale 3D models . 3D models can be scaled in editing state  with the help
of the Current construction parameter panel .

Edit > Mirror
 

Mirror the selected  constructions relative to the horizontal or vertical line passing through the
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specified point. 
 

After clicking on this button, the first click on the graphics area  specifies the point through
which a mirror line must be passed. 
 

Then moving the cursor changes position of the mirror line.
 

When required position of the mirroring objects will be achieved, click for the second time to
complete mirroring operation. To cancel mirroring press ESC.

Edit > Bring to Front
 

Move selected objects  on the foreground, then other objects will not shadow them. 
To move cameras over constructions use the Cameras over constructions  item.
 

Changing the objects' draw order can be required at operation with large 3D models  of rooms,
and also at operation with constructions placed one over another.

Edit > Send to Back
 

Move selected objects on the background, then selected objects will be covered by other objects. 
To move cameras over constructions use the Cameras over constructions  item.
 

Changing the objects' draw order can be required at operation with large 3D models  of rooms,
and also at operation with constructions placed one over another.

Edit > Hide
 

Hide the selected objects . 
 

With this item chosen the selected objects proceed into hidden state . In the hidden state the
objects in the Graphics window are displayed on the background in light grey color. The rest
characteristics are similar to those of normal state . 
 

In the 3D World  and 3D Video  windows the hidden objects are not displayed. Hidden
objects are not exported to AutoCAD formats , therefore to exclude some objects from export -
hide them.
 

The hidden state is used to conceal the temporarily interfering objects.
 

To return to normal state select  the hidden objects. 
 

The snap Extension  is disabled for hidden objects.
 

When working with a separate object it is convenient to select all the objects in layout  using
the shortcut Ctrl+A and hide them. After that select the objects needed.

 

See also: Layer - Hidden ;

Edit > Align
 

Align the selected objects . 
 

Because limited accuracy of computer calculations, sometimes after a rotation objects' form is
being distorted a little.
The effect of choosing this item is alignment of the form of selected objects.
 

Efficiency of alignment depends on a scale. Vast scale provides the minimum of efficiency, small
scale - the maximum. At high degree of efficiency small objects can be distorted.
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Edit > Change Line type
 

After choosing this item at the bottom of the graphics area  appears the line type panel .
In the line type panel you can choose line type  for the selected  constructions   and
cameras.
 

If during changing the line type of selected objects by the Change line type tool, to press and
hold Ctrl, then the selected objects will also change their minimum and maximum height according
to the chosen line type . If Ctrl is not pressed, the heights remains unchanged.
 

For changing line type with returning heights to values set in the new line type parameters , use
the Line type panel in editing state  of one construction.

Edit > Move to active layer
 

Move to active layer all selected  objects. 
 

See more: Layers

Edit > Combine to block
 

Combine to a block all selected  constructions. The block will behave as one object. Combining is
convenient at modeling complex objects and their subsequent moving, rotating and copying.
To destroy the block use the Destroy  tool.

Edit > Merge contour
 

Merge contours of selected  constructions. This tool works with walls  and rectangles .
Merging improves appearance of drawing of buildings. To destroy merged contours use the Destroy

 tool.
 

 

Line type  of the contour is determined by line type of the first construction of the contour. You
can create multiple contours of different constructions with different line types.

Edit > Destroy
 

Divide selected blocks  or contours  to separate objects. 

Edit > Switch ON illuminators
 

Switch ON  selected  illuminators .
 

For one camera no more than 7 illuminators could be switched on  simultaneously. Switched on
illuminators are saved in camera parameters, therefore it is possible to switch on and switch off
different illuminators for each camera. 
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Edit > Switch OFF illuminators
 

Switch OFF  selected  illuminators .

Edit > Undo
 

Undo the last operation. 
 

VideoCAD stores several last operations including Undo operation. When clicking this button
successively VideoCAD retraces to the last states and a state before the button Undo was clicked
for the first time.
The quantity of the stored operations can be adjusted in the Options box>Miscellaneous>UNDO
depth .

Edit > Redo
 

Redo the last operation undone by the UNDO  tool.

Edit > Erase
 

Erase the selected objects . 
 

If there are no selected objects this item is disabled. 
 

Use also Del.
 

You can not erase the active camera.

Edit > Erase all
 

Erase all constructions . 
 

If there are no constructions this item is disabled. 

Cables > Signal cable
 

When this button pressed, you can draw the signal cable of the active camera by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop drawing
cable, press ESC.
 

The status bar  displays the segment length and its projection to distance and height. 
 

Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the
segment is attached to the projection with its initial point. 
 

A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately. 
 

When copying  the cable segments between cameras and layouts  a process of cable
drawing is accelerated considerably even in complex CCTV systems.
 

When drawing a cable the menu item Cable laying  might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
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cable drawing along the walls, columns etc.
 

The type and parameters of line designating the Signal cable can be changed in the options
box .
 

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Signal cable again.
A dialog box of the same name appears after that.
You can open this box by choosing Calculate item near Signal cable item.
 

The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report , Table of cameras  and Cable report .
  

In multi-layer drawings, cables belong to the same layer  as a camera to which the cables
belong. 
 

It is possible to use Line segments  for cable modeling with subsequent cable length
calculation. Use separate line types  for drawing a cable of each type. For length calculation use
the Length calculation of line segments  tool and the Cable report .
 

See also: "Constructions" button group , View>Active camera cables , View>All camera
cables , Cable laying , Length calculation of line segments , Cable report .

Cables > Power cable
 

When this button pressed, you can draw the power cable of the active camera by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop drawing
cable, press ESC.
 

The status bar  displays the segment length and its projection to distance and height. 
 

Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point. 
 

A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately. 
 

When copying  the cable segments between cameras and layouts  a process of cable
drawing is accelerated considerably even in complex CCTV systems.
 

When drawing a cable the menu item Cable laying  might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc. 

 

The type and parameters of line designating the power cable can be changed in the options
box .
 

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Power cable again.
 

A dialog box of the same name appears after that enabling to choose a cross-section area of
power cable to fit the requirements of camera voltage supply. It is assumed that the conductor
material is copper and the conductor temperature is + 50° C
You can open this box by choosing Calculate item near Power cable item.
 

The results of the cables' calculation on each individual camera, each individual section area and
on the project as a whole are included into the text file obtained by Text report , Table of
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cameras  and Cable report .
 

In multi-layer drawings, cables belong to the same layer  as a camera to which the cables
belong. 
 

It is possible to use Line segments  for cable modeling with subsequent cable length
calculation. Use separate line types  for drawing a cable of each type. For length calculation
use the Length calculation of line segments  tool, Cable report .
 

See also: "Constructions" button group , View>Active camera cables , View>All camera
cables , Cable laying , Length calculation of line segments , Cable report .

Cables > Cable laying
 

With this item chosen a float panel of the same name appears enabling to choose a shift of
segment ends for a level parallel cable drawing along the walls, columns etc.
 

See also: View>Active camera cables , View>All camera cables

Cables > Length calculation of line segments
 

Clicking this item will open a box allowing calculate total length of any line segments . This
tool allows using line segments for modeling cables.
 

See more: Length calculation of line segments , See also: Cables

Cables > Cable report
 

Choosing this item opens a box with a text report of all line segments  and cables  made by
line types with marked Cable  box in the parameters of the line type.
These line types are considered as cable brands. These line types can be assigned to the
Signal cable  and the Power cable  of any camera.
 

You can simply draw cables as line segments on layouts using these line types. In this case, the
cables are considered as main cables which are not attached to any camera.

The Cable report includes the cables attached to cameras and the main cables as well. Cable
lengths is calculated for each brand (line type) separately.
 

See also: Length calculation of line segments , Calculation lenght of cables and getting the
Cable report , Signal cable length calculation box , Power cable electrical parameters and
length calculation box , Cables summary .

Criteria > Person detection area
 

Display a box with the person detection criteria. 
 

See more: Criteria editing box of person detection area

Criteria > Person identification area
 

Display a box with the person identification criteria. 
 

See more: Criteria editing box of person identification area
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Criteria > License plate reading area
 

Display a box with the license plate reading criteria. 
 

See more: Criteria editing box of license plate reading area

Criteria > Quality levels
 

Open a box to edit the quality levels.  This box allows to edit quality level criteria values and
assign a quality level to the active camera.
 

See more: Quality level box

Help > About VideoCAD
 

Open the About box with the general information of VideoCAD version and the Authors.

Help > Help contents
 

Open the contents of this Help file.

Help > Language
 

Choose the language.
 

All the text resources of the program are stored in *.lng files in the VideoCAD installation directory.
We are interested in translating the program to other languages. 
If you can do it, could you please contact us.support@cctvcad.com  

We offer big discounts for the translations.

How to add a new interface language

 

There is English.lng file in a directory of VideoCAD (or VideoCADdemo) installation. All text
elements of the interface are loaded from this file. 
For creation of new interface language it is necessary:
1. Copy English.lng (Russian.lng) file under a new name <YourLanguage>.lng
2. Accurately translate each line in the file. Don't change positions of the lines, don't delete or
create new lines! Each position corresponds to some interface element. Don't translate lines
which begin from '///' - they are labels. It is necessary to keep all blanks between lines.
3. Copy the obtained new file to the directory of VideoCAD(VideoCADdemo) installation and
start VideoCAD (or VideoCADdemo).
4. Choose Main menu> Help> Language><YourLanguage> 
5. Check up new interface. Correct the <YourLanguage>.lng file if necessary.
 

Don't hesitate to contact us in case of any troubles. 

Help > Home page
 

Visit CCTVCAD Software home page in the Internet.
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Help > Order
 

Visit CCTVCAD Software Order page in the Internet.

Help > User forum
 

Visit CCTVCAD Software User forum in the Internet.

Help > Contact us
 

Send us an email message. 

Help > Change registration code
 

Open the Enter key box to change the registration code.
 
Ability to change the registration code might be usefull for users with multiple licenses with USB
dongles. Each USB dongle corresponds its own registration code. Message  "The Dongle does not
fit the License." means that the USB dongle does not match registration code, which registered
the program. You need to change or a USB dongle, or enter the code corresponding to the dongle
connected.
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9.1.4 Layout tabs

See location of the Layouts tabs

There are Layouts tabs in the bottom-left corner of the Graphics area . Each tab corresponds to
the separate layout created in the project.
 

The layouts are separate sections of monitored object (building, room, territory and storey). A layout

contains the horizontal and vertical projections locating backgrounds, cameras, cables  and

constructions . Each camera can be displayed in one layout only, but camera cables may pass
through several layouts.
The project may contain up to 10 layouts. Originally one layout is created into project. 
 

To show any layout, click the tab with its name.
 

Using the pop-up menu, which appears by right clicking on the tab, you can create, delete, and
rename layouts or show the current layout completely.
The original layout and any layout with the cameras present in it can not be deleted. 
 

See also: Layouts box , Layers
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9.1.5 Status bar

 

See: location of the Status bar

Graphics window  status bar is situated in the bottom of the graphics window and consists of
two parts.
 

The left part is constantly displaying the current coordinate of the cursor relatively to the origin of
coordinates .
If the origin coinciding with the active camera is set up, then the coordinates have the following
values: 

.If the cursor is in the vertical projection, then it is the distance to the camera location and
its height above the ground. If the cursor is in the horizontal projection, then it is the
distance to the active camera location in horizontal and vertical. 
 

If there is no active camera in the layout displayed, then the values of coordinates have no sense.
 

The right part is displaying the measurement results and the hints. 
 

The construction coordinates are displayed relatively to the chosen origin of coordinates . The
coordinates of constructions belonging to one camera only (focal plane , optical axis ,
field-of-view size , test object ,change view area upper bound ) are always displayed
relatively to the active camera.
 

At moving the cursor nearer to the camera icon the name, model name and basic camera
parameters are displayed.
 

During graphical depth of field calculation , at moving the cursor over view area in vertical projection
in the right part of the Status bar, resolution at cursor point is displayed (in LPH). 
When moving the cursor over view area in horizontal projection, distance from the active camera and
resolution at the point of cursor are displayed.
The resolution in horizontal projection is measured at the height of measuring Depth of Field . 
 

During measuring field-of-view size  at a point, when moving the cursor over view area in vertical
projection, in the right part of the Status bar field-of-view size at cursor point is displayed.
 

During scaling , in the right part of the Status bar the current scale factor is displayed.
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9.1.6 Layers

Graphics window
Tool bar

  Layers
Cameras, constructions and 3D models can be distributed by layers. On each layout  unlimited
number of layers can be. The layers are managed using the Layers panel, which can be caused by
the Main menu>Drawing>Layers . item.
 

 

By default, a single layer - Layer 1 is created. To create a new layer , click the Add button
To delete a layer, select a row with the layer in the table and click Del.
 

If there is a construction or camera on the layer , the layer can not be deleted. Firstly you must
delete or move  to another layer the construction or camera from this layer.
The active  layer can not be deleted. Firstly you must make active another layer.
 

Cables  are in the same layer as a camera to which they belong .
 

You can move cameras and constructions from one layer to another using the Move to active layer
 menu item. 

Layers have the following parameters. You can edit them, by checking checkboxes and editing
values in the Table of layers.

Name
 

The layers are named automatically. To rename select the field and enter new name by keyboard.

Active
 

New cameras and constructions as well as pasted  ones are placed to the active layer.  Active
layer can not be deleted. Only one layer can be active, other options can be applied to several
layers simultaneously. Always one of layers is active. Active layer must be visible, enabled and
not hidden. 

Enabled
 

Cameras and constructions on an enabled layer can be selected  and then edited, copied or
deleted.

Visible
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Cameras and constructions on an visible layer are visible in the Graphics window .

Hidden
 

Cameras and constructions on visible but hidden layer are displayed in the Graphics window
by grey color on background, like objects in the hidden  state. In contrast to the hidden state,
at attempt to select the objects remain hidden. In addition, objects on hidden layers remain
visible in 3D Video  and 3D World  windows.

Snaps
 

On a layer with marked Snaps field the snaps  are enabled. By clearing this field, you can
disable snap for objects on this layer.

Shadows
 

Objects on a layer with shadows marked are considered as obstacles in calculation of shadows
, if they are obstacles according to their other setting. Using shadows field it is possible to

exclude certain layers from shading calculation. The option works on the Graphics window
and the  3D World . To enable shadows calculation other options must be enabled, see
shadows .
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows ,
Choosing the best place for PTZ (dome) camera , Visualization of the camera control area
projections and spatial resolution within them

3D visible
 

Objects on a 3D visible layer are visible in the 3D Video  and 3D World  windows.

Height
 

Base height of objects on the layer relative to the zero height. Heights of constructions on each
layers are calculated relative to the Base height. The Base height is taken into account in the 
3D Video  and 3D World  windows and in calculation of shadows . With the Base height,
layers are very convenient for multi-level projects.
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Heights of cameras and their view areas are not associated with the base height of layer, they
are calculated from the base height  of each camera. But when placing a new camera  or
pasting  copied camera, the cameras base height is set equal to the base height of the
active  layer. 

Color
 

In this field you can specify a color, by which constructions, cameras, cables, and text placed on
this layer will be displayed in the Graphics window. To call the color dialog click on the field.
If you set white color then constructions, cameras, cables, and text will be displayed by their
own colors.

See also: Work ing with layers and multilevel constructions , Work ing with 3D model-territory
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9.1.7 Pop-up panels

See location of the Pop-up panels

Pop-up panels appear automatically in the bottom of the Graphics window during creating or editing
constructions and texts.
 

Line type panel
Font type panel
Current construction parameter panel

161

280

281

282



VideoCAD280

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.1.7.1 Line type panel

The panel is designed for choosing line types  and displaying parameters of the current line type
.
The panel appears automatically in the bottom of the graphics area  when clicking the
construction buttons , when choosing the correspondent menu items or when editing
constructions.
 

The panel hides automatically in other modes. You can hide the panel by choosing the  Hide panel
item in the pop-up menu appearing when right clicking the panel.
 

The panel contains the following items:
 

Line type number box
Line type name box

 

Choosing values in these boxes changes the current line type.
 

As a result of changing line type of a construction using this tool, the minimum and maximum
heights  will be returned to values set in parameters  of the new line type.
For changing a line type without changing heights, use Change line type  tool.
 

 

When drawing a Double line  Wall  or Aperture in Wall , in the right part of line type panel
appear additional elements:

Box in which it is possible to choose or enter from the keyboard the width of the double line
(wall or aperture).

Two buttons     allow switching the orientation of the second line relatively to the first one.
You can also switch the orientation quick ly with the help of the Space bar.

Other items display parameters of the chosen line type. The parameters can be changed in the
options box  launched by double-clicking the line type panel or by choosing the item Edit line
type in the pop-up menu which appears when right clicking the panel. 

475

162

193 188

282 476

268

251 198 199

475



Interface 281

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.1.7.2 Font type panel

The panel is designed for choosing font types and displaying parameters of the current font type.
The panel appears automatically in the bottom of the graphics area  when clicking the button Text

, when choosing the correspondent menu items or when editing  text.
 

The panel hides automatically in other modes. You can hide the panel by choosing the item Hide
panel in the pop-up menu appearing when right clicking the panel.
 

The panel contains the following items:
 

Font type number box
Font type name box

 

Choosing values in these boxes changes the current font type.
 

Other items display parameters of the chosen font type. The parameters can be changed in the
options box  launched by double-clicking the font type panel or by choosing the Edit font type
item  in the pop-up menu which appears when right clicking the panel.
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9.1.7.3 Current construction parameter panel

The Panel is intended to set and edit parameters of constructions, 3D models and Illuminators.
The Panel appears automatically at the bottom of the  Graphics area   when drawing or editing
constructions. 
The set of the parameters for each kind of construction (point, line, rectangle, etc.) differs.

For example:
for a point it is coordinates of the point, and its heights in the 3D Video;
for a line segment it is coordinates of the segment's ends, length, angle and its heights in the 3D
Video; 
for a rectangle it is coordinates of corners, height, width and its heights in the 3D Video, etc.

Options of the panel in Construction and Editing  modes differ. 
 

In the Construction mode:
 

It is possible to draw constructions, having set the parameters sufficient for complete definition of
this construction. 
For example, for a line segment it is enough to set coordinates of the first and second point, or
coordinates of the first point, an angle and length.
 

It is possible to fix some parameters of construction, having marked check boxes nearby these

parameters . At moving the cursor, the construction will be drawn in such a
manner that the fixed parameter will remain constant.
 

For example, for a line segment it is possible to fix length or angle, for a rectangle - width or height,
etc.

After a construction has been drawn, in the right end of the panel Edit  button appears.
Clicking this button allows editing just created construction.

In the Editing mode:
 

It is possible to edit any parameters of construction from keyboard, thus the result of changing will
be visible at once.

In both modes it is possible to change the minimal and maximal heights of the construction in the
3D Video irrespective of parameters of line type , by which the construction is drawn.
 

In multi-level projects, the height are calculated relative to base height of a layer  to which the
construction belongs.

3D model, Illuminator, 3D image, Inclined rectangle, transparency

 

During placing or editing 3D models , special parameter set on the Current construction parameter
panel is displayed.
 

See details: 3D models .
 

During placing or editing Illuminators , special parameter set on the Current construction
parameter panel is displayed. 
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See details: Illuminator .
 

During drawing or editing 3D images  using the Current construction parameter panel it is
possible:

Load raster image by Load image  button;
Delete image by Delete image .button;
Mark Transparence box to make pixels transparent, which color coincides with the color of the
left-bottom pixel.

 

During Inclined rectangle  drawing or editing it is possible to make it transparent by 70 %. To do
this mark Transparence box.
 

Transparence of 3D images and transparence of Inclined rectangle have different purport.
Inclined rectangle becomes completely transparent by 70 %, what makes possible modeling glass.
 

On 3D image, if its raster image is not *.png, pixels become completely transparent, which color
coincides with color of the left- bottom pixel. Other pixels remain opaque. 
If its raster image is *.png, then transparent pixels of png file will be transparent in VideoCAD ( *.png
format supports transparency).
Thus, you can model objects of irregular shape using 3D images.

 

9.1.7.3.1  3D models

Current construction parameter panel
3D models

 

You can resize 3D models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the  box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken.
 

3D model height above the ground is displayed and can be changed in the 3D H box.
 

In multi-level projects, the height are calculated relative to base height of a layer  to which the 3D
model belongs.

If the Shadow box is checked and the Shadow calculation  is enabled and 3D models are taken
into account  in calculating shadows, then the editing 3D model will be considered as an
obstacle during calculating shadows.
 

Calculating shadows from complex 3D models  - very resource - intensive operation which can take a
lot of time. 
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them
 

The button  allows to open the 3D Models  window with edited 3D model loaded in it.

Speed of 3D model

 

In the Speed box you can specify speed of moving 3D model, in meters (foot) per second.
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Model with specified nonzero speed will move with this speed along a specified direction when
modeling exposure time , Rolling Shutter , interlace distortions  and creation of
animated images .
To set speed to 3D model you should enter a nonzero value in the Speed box during the
placement or editing 3D models.

If a 3D  model has non zero speed , then

the velocity vector is displayed.
 

If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model passes
per second (crimson arrow).
 

If 3D model is in the normal state, the length

of the velocity vector equals to the distance

which the 3D model passes for the period
between successive frames of the active
camera  (black arrow).
 

The length of the velocity vector of a 3D model in the normal state is inversely proportional

to the  frame rate  of the active camera. Thus we can see how many times the moving 3D

model gets into the frame of the active camera.

You can edit the velocity vector of 3D model
in editing state by moving its terminus. 
 

 

See also: Selecting frame rate on the basis of known target's positions and velocities .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of
moving objects"(*.pdf) 

9.1.7.3.2  Illuminator

Current construction parameter panel
Illuminator

 

During illuminator  creating and placing on the Current construction parameter panel it is
possible to set or change following illuminator parameters:
 

Coordinates of Illuminator in horizontal projection (C)
Height
Rotation angle/angle of radiation
Inclination angle in the vertical plane (Incl.)
Light flux (lumen)/Illumination(lux)
Flux/Illum. check box

 Illuminator calculation  
ON check box
Dispersion combo box
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Coordinates of Illuminator in horizontal projection (C)
 

Coordinates of Illuminator center.

Height
 

Height of Illuminator center above the ground.
 

In multi-level projects, the height are calculated relative to base height of a layer  to which the
illuminator belongs.

Rotation angle/angle of radiation
 

For specifying both angles one Ang box on the panel is used. During specifying illuminator's
direction, the rotation angle in horizontal plane appears in this box. During specifying light
intensity concentration or editing illuminator, angle of radiation in degrees appears in the same
box.
 

It is recommended to specify angle of radiation in the Illuminator calculation  box.

Inclination angle in the vertical plane (Incl.)
 

An angle between the axis of radiation and the horizontal.

Light flux (lumen)/Illumination(lux)
 

There are 2 types of illuminators in VideoCAD:
 

Real illuminators having a finite total light flux (lumen) and angle of radiation (degree).

Illumination on a scene, produced by real illuminator, diminishes inversely as the square of
distance from the illuminator (inverse-square law) and is simulated in VideoCAD. For models
of real illuminators total light flux of illuminator (lumen) is displayed in this box.

 

It is not recommended to set light flux in this box. Use Illuminator calculation  box to
calculate light flux from lamp and illuminator parameters.

 

Virtual illuminators, which are placed far enough from a scene in order to neglect

illumination diminishing with distance. Total light flux and distance up to virtual illuminator may
be unknown, but illumination (lux), created on a scene by the virtual illuminator should be
known. 
 

For virtual illuminators, illumination (lux) created on a scene by such illuminator is showed in
this box. Virtual illuminators can be used for modeling known illumination in some parts of the
scene.
 

Typical virtual illuminator - the Sun.
 

For infra-red (IR) illuminators the light flux and illumination cannot be measured in lumens
and luxes. Therefore, Radiant flux (watt) instead of a light flux (lumen) is showed in this box,
and irradiance (watt/square meter) is showed instead of illumination (lux).
 

See more: Infa-red illuminators .

Flux/Illum.  check box 
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Illuminator type can be specified in this box: Real  (the box is marked) or Virtual .

 Illuminator calculation
 

The button is intended to activate Illuminator calculation  box in which you can specify internal
parameters of real illuminators.  
 

The button is accessible only for real illuminators.
 

The only parameter in Illuminator calculation box, which is valuable for virtual illuminators - Lamp
type . To specify lamp type for virtual illuminator, switch  it to real temporarily, set lamp
type, and then make it to virtual again.
 

See more: Illuminator calculation .

ON check box
 

You can switch on and off the illuminator using this box.
 

For switching on or off several illuminators simultaneously, select  them, right click  on the
Graphics area, and choose in the pop-up menu Switch ON illuminators or Switch OFF
illuminators.
You can use items  with the same names in the Main menu.
 

For one camera no more than 7 illuminators could be switched on  simultaneously. Switched on
illuminators are saved in camera parameters, therefore it is possible to switch on and switch off
different illuminators for each camera. 

Dispersion combo box
 

During illumination modeling, VideoCAD takes into account only direct light from illuminators. The
light reflected from objects on a scene is ignored. However, setting value in this box, it is
possible to specify what part of the light from this illuminator re-reflects and is present on the
scene as diffused illumination.
 

At diffused light modeling, the distance from the illuminator up to the center of camera view area is
considered.

See also: Illuminator calculation , Lamp parameters , Luminaire parameters , Infa-red
illuminators , Illuminator , 3D Video>Image parameter panel>Scene . 
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9.1.8 Keyboard shortcuts

Keyboard shortcuts allow fast activation of various commands, by pressing shortcuts on the
keyboard. 
 

VideoCAD has:
 

Predefined shortcuts  which cannot be changed;
Customizable shortcuts  which can be adjusted according to users' preferences.

Predefined shortcuts
 

F1  Call Help information of interface element, box or window, which has the input focus.
 

Ctrl+A  Select all objects  in the current layout .
 

Ctrl+TAB Switch to the next layout in turn.
 

Ctrl+Space bar Save the active camera and activate the next camera in turn in the current layout.
If there is no active camera in the current layout, then a camera with the minimal number will be
activated.
 

ESC Stop the current operation, if an operation is executed. If no operation is executed, switching
to the Select/Edit  mode.
 

DEL Delete selected  objects.
 

Spacebar Pressing Spacebar when constructing a double line , wall , aperture in wall
enables to switch the orientation of the second line (side) relatively to the first  one quickly.
 

+ (plus on the digital keypad) Zoom in, if the input focus is on the Graphics area .

- (minus on the digital keypad) Zoom out if the input focus is on the Graphics area.
 

When Alt is pressed, it is possible to move drawing in the Graphics window using arrow keys and

change scale using + plus and -  minus keys irrespective of the input focus.
 

Ctrl  has several purposes:
 

Changes the selection logic  
Allows moving the horizontal projection vertically apart from the vertical one using the middle
mouse button or the button Move drawing . 
If Ctrl is not pressed, then the whole drawing moves, if Ctrl is pressed, the horizontal
projection moves only.
If Ctrl is pressed and held down when editing rectangle , mask , inclined rectangle ,
filling  or 3D image  by moving pink grips, then one point move only. If Ctrl is not pressed
when editing these objects, then several points will move at a time, the editing object remain
square.
If Ctrl is pressed when editing a double line , wall , aperture in wall  then only one line
will be moved. If Ctrl was not pressed when editing these objects, the whole double line (wall,
aperture) will be moved. 
If Ctrl is pressed during Illuminator  editing by moving pink grips, then angle of radiation and
light intensity distribution curve will be changed. If Ctrl is not pressed, then illuminator will be
rotated as a whole.
If Ctrl is not pressed at changing the common scale, then the scale changes roughly which is
convenient at navigation. If Ctrl is pressed, the scale changes with the less step which is
convenient for the precise drawing positioning before printing or saving. The effect of reducing
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zoom step presents in the Graphics window , in the 3D Models  and 3D World .
If during changing the line type of selected objects by the Change line type  tool, to press and
hold Ctrl, then the selected objects will also change their minimum and maximum height
according to the chosen line type . If Ctrl is not pressed, the heights remain unchanged.

Customizable shortcuts
 

Customizable shortcuts are seen in the Main menu  of the Graphics window during the
program operation. These shortcuts can be changed on the Keyboard  tab in the Options box.
Shortcuts can be assigned to any item of the Main menu of the Graphics window.
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9.2 Camera Geometry

Camera Geometry box includes geometric
parameters of active camera , lens and
installation parameters of the camera. 

 

In the Camera Geometry box, geometric parameters of the active camera view area in the
horizontal and vertical planes are displayed. 
 

The image in the Camera Geometry box represents two projections of view area, parted by the
horizontal black line corresponds to the ground in the vertical (upper) projection.
 

In multi-level projects, the ground is the base height of active camera .
 

The red lines mark the sizes, the green dash lines specify auxiliary constructions, the dark blue
lines designate the camera tilt angle, and the turquoise ones mark the space bounds of camera view
area.
 

The actual projection of view area as a result of calculations is filled by grey color.
 

The camera location and calculated parameters are displayed in the text boxes next to the camera
icon and the red dimension lines.  The parameters in the white boxes can be changed, by choosing
them from list or by typing. When any of the parameter is changed, the values of the rest parameters
are recalculated. 
 

You can change any parameters of all selected cameras simultaneously. For this purpose:
Select  necessary cameras on the layout
Right click  on the combo box, then click  on the Assign to selected cameras pop up item.

 

The parameters in the grey text boxes are results of calculation and can be changed only through
changing the parameters in the white boxes.
 

The linear parameters are entered and outputted in meters or feet according to the measurement
system  set in the project, if not specified otherwise on the image. The angular parameters are
inputted and outputted in degrees. 
 

When an incorrect value is entered the box turns red. When an incorrect value ratio is ensued from
the input, all boxes with the values of mutually incorrect ratio turn red. If calculation with incorrect
values is still possible and has sense, the program nevertheless performs it. In this case check the
results carefully. You can see the source of mistake in the graphics window .
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If the image of view area changes radically with new values, the image in the Camera Geometry
box changes correspondingly, thus the arrangement of parameter boxes are changed too. Watch
carefully the image changed, since with the image alteration the parameter boxes might interchange
their positions. 
 

The parameters in the Camera geometry box can not reflect the shape of view area rotated around
its main optical axis , it is impossible to reflect changing projections under the influence of lens
distortion . So the lens distortion and rotation around an axis within + -45 degrees does not affect
the parameters. The parameters of the Camera geometry  box continue to show values as if the
camera is not rotated.
When the rotation angle is more than 45 degrees, the parameters abruptly change their values to
ones corresponded to the camera rotated on 90 degrees. When the rotation angle is more than 135
degrees, the parameters will reflect the initial position of the camera.

See also: Parameters in the Camera Geometry box
External link : "The principles of CCTV design in VideoCAD. Part I. Camera view area"(*.pdf) . 

297

310

293

http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part1.pdf


Interface 291

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.2.1 Parameter list

 

Camera parameters
 

Image sensor size
Lens focal length
Aspect Ratio (of output
image)
Sensor and Lens

 

Camera installation
parameters

 

Height of installation
Camera tilt angle
Axial rotation angle
Base height

 

View area limitations
 

View area upper bound height

View area lower bound height

View area upper bound
distance
View area lower bound
distance
View area length
Width of view area upper
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bound
Width of view area lower
bound
Maximum distance of
drawing view area
Projection
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9.2.2 Parameters

Image sensor size
 

In the box, you can specify the size of the Image sensor or the size of Active area of the Image
sensor . 
 

See more: Image sensor and Active area of image sensor
 

  

The Image sensor size can be specified by any of the following ways:
 

Choosing a standard format (type) from the list
1/10",1/8",1/6",1/5",1/4.5",1/4",1/3.6",1/3.2",'1/3",'1/2.7",'1/2.5",1/2.3",1/2",1/1.8",1/1.7",1/1.6",2/
3",1/1.2",1",4/3",1.5"; 

 

This traditional way of setting Image sensor size can be unaccurate for modern cameras .
 

Entering a custom format in inches, in the form of  X/Y". For example: 1/7.31";
 

If you enter a format which does not exist in the list, the box turns yellow, and the Image sensor
size will be calculated by VideoCAD.
 

Entering diagonal size of the image sensor in millimeters, in the form of dX.Y. For example:
d6.0. 

 

See more: Specifying image sensor size through its diagonal and aspect ratio
 

Entering sensor side sizes in millimeters horizontally and vertically separated by hash, in the
form of  W#H.  For example: 4.8#3.6;

 

See more: Direct specifying image sensor side sizes

After format or length of diagonal, separated by space character, you can specify the aspect
ratio of the image sensor in the form of W:H. For example: 1/3" 16:9 or d6 16:9.  If the aspect
ratio of the image sensor is not specified, it is assumed equal to 4:3.
 

See more: Direct specifying active area size of the image sensor

Active area side sizes of the image sensor can be specified in millimeters horizontally and
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vertically separated by asterisk, in the form of W*H. For example: 4.8*3.6;
 

See more: Direct specifying active area side sizes of the image sensor
See also: Sensor and Lens>Image sensor , Specifying active area size of the image sensor/

When moving the cursor to the image sensor box the information on horizontal and vertical view
angles of lens appears.
 

 Changing the Image sensor size, and therefore the calculated values of view angles of camera
with enabled modeling lens distortion  will lead to detuning parameters of distortion and warping
view area form. To correct the mismatch you should set new values of the actual view angles ,
tak ing into account the changed values of calculated view angles.

Lens focal length
 

The values can be chosen from the list or typed by keyboard, e.g. when using the varifocal
lenses.
 

Choose a value given in the lens specification in this box.
It is assumed that the lens format equal to or larger than the camera Image sensor format is
used.  
The lens focal length influences all the calculated parameters. 
 

When moving the cursor to the lens focal length box the information on calculated view angles
appears.
 

If in lens' specification there are view angles which are different from the calculated ones, then
probably the lens has distortion. For precise modeling  such lens you should enable and adjust
simulating distortion . 
 
 

Focal length can be chosen from the list or typed into this box or duplicate boxes on the Tool bar
 of the Graphics window and on the 3D Video .

 

It is convenient to change lens focal length of active
camera on layout in the Select/Edit  mode, by
moving grips at the corners of view area projection. 

If a model  is assigned to the camera, and the model has fixed  focal length lens, then you
can not change the focal length.
 

If a model is assigned to the camera, and the model has a lens with limited  variable focal
length, then you can change focal length within the limits only. When approach to the limit values,
the box will become crimson.
 

You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned
model or the assigned model have not specified limits of the lens focal length.
 
If the active camera is panoramic  then the lens focal length box is colored by aqua-green.

 

 Changing the lens focal length and therefore the calculated values of view angles of camera with
enabled modeling lens distortion  will lead to detuning parameters of distortion and warping view
area form. To correct the mismatch you should set new values of the actual view angles , taking
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into account the changed values of calculated view angles.
 
You can change lens focal length of all selected cameras simultaneously. For this purpose:

Select  necessary cameras on the layout
Right click on this combo box, then click on the Assign to selected cameras pop up item.

 

See also: Sensor and Lens>Lens

Aspect ratio (of output image)
 

Aspect ratio of the output image of the camera: 4:3,16:9, 16:10 etc.
 

The Aspect ratio of the output image equals to the Aspect ratio of the active area of the
image sensor and may be different from the Aspect ratio of the image sensor.
 

The Aspect ratio of the image sensor can be specified in the Image sensor size  box.
 

See more: Specifying the Aspect ratio of output image
 

You can enter custom values from keyboard in the form of <width> :<height>, for example 11:4. 
 

By specifying formats 3:4 or 9:16, you can specify the so-called corridor format in which the
height of the frame is larger than its width.
 

For correct simulation resolution in the corridor format you must also swap the number of pixels
horizontally and vertically in the camera parameters  and image processing  settings.
 

 

Separated by space character after the Aspect ratio you can set the crop factor - the ratio of
cropping active area size of the image sensor when the active area does not touch the edges of
the image sensor. The Crop factor can be set as a vulgar fraction (separated by slash) or a real
number. For example 4:3 0.67 or 16:9 720/1080. If the Crop factor is not specified, it is taken to be
unity.
 

 

See more: Specifying the crop factor

If the camera has directly assigned active area sizes, then this box shows 'custom' and it
becomes unavailable. To make it available, set the size of image sensor by any way except of
direct specifying its active area size.
 

For correct calculation of person detection , identification  and license plate reading  areas
and spatial resolution , after changing the Aspect ratio it is necessary to check and adjust
vertical number of pixels  in the Sensitivity and Resolution box  and Image size  on the
Processing  tab on the Image parameter panel . 

 Changing the aspect ratio and therefore the calculated value of vertical view angle of camera with
enabled modeling lens distortion  will lead to detuning parameters of distortion and warping view
area form. To correct the mismatch you should set new values of the actual view angles , tak ing
into account the changed values of calculated view angles.
 

See also: Sensor and Lens>Image sensor's active area , Specifying active area size of the
image sensor

Sensor and Lens
 

Clicking this button will open Sensor and Lens box. In the box it is possible to specify any image
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sensor size , active area size , specify lens distortion  and adjust modeling active camera
as a panoramic camera .
 

See more: Sensor and Lens , Specifying active area size of the image sensor

Height of installation
 

Height of installation can be chosen from the list or typed. The height of installation influences
all calculated parameters.
 

In multi-level 3D projects, in 3D Video  and 3D World , as well as in calculation of shadows
, the height of installation,  heights of view area lower  and upper  bounds are calculated

relative to the Base height  

Height of installation can be negative.

Camera tilt angle
 

Camera tilt angle is a calculated parameter and can not be edited directly. The camera tilt angle
is an angle between the main optical axis of camera lens and a horizontal. 
 

Camera inclination is defined not by the tilt angle but by the three parameters:  
 

Height of installation ;
View area upper bound distance
View area upper bound height
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Axial rotation angle
 

In the box you can specify the camera rotation angle around its main optical axis, in degrees.
  

The parameters in the Camera geometry box
can not reflect the shape of view area rotated
around its main optical axis , it is impossible
to reflect changing projections under the
influence of lens distortion . So the lens
distortion and rotation around the axis within +
-45 degrees does not affect the parameters.
The parameters of the Camera geometry box
continue to show values as if the camera is not
rotated.
 

When the rotation angle is more than 45
degrees, the parameters abruptly change their
values to ones corresponded to the camera
rotated on 90 degrees. 
 

In this position the lateral faces of the view area
will become the upper and lower faces, and
upper and lower faces will become lateral ones.
 

When the rotation angle is more than 135
degrees, the parameters will reflect the initial
position of the camera.

 

If a camera is rotated by an angle more than 45 degrees, when calculating person detection  and
identification , license plate reading  areas,  the parameters: minimum vertical resolution
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(pixel/meter, pixel/ft), the minimum vertical size of face image ( pixels ), the minimum
vertical size of license plate ( pix) are calculated based on the number of pixels along the
horizontal, instead of the number of pixels along the vertical, as in this case the vertical side of the
field of view is located along the horizontal.
 

When calculating the spatial resolution , rotation of the camera around its axis by default does
not affect the position of the vertical and horizontal in the frame.  Horizontal and vertical positions
are tied to the camera and not to the scene. You can change this rule, using the Spatial resolution
and rotation  checkbox in the Options box .
 

In the Graphics window , 3D Video  and 3D world  windows rotation of camera is displayed
accurately. However, each passing through a multiple of 45 degrees angle, camera tilt angle  is
changed so as to keep the values of the View area upper bound height  and the View area upper
bound distance , taking into account the fact that a view area face appeared on top, becomes
the upper bound of the view area.
 

When you rotate the camera around its axis the view area projection changes its shape, sometimes
becomes infinite. To limit the distance of drawing view area, use the Maximum distance of drawing
view area . 
 

For a fuller picture of rotated view area projections it is recommended to set the Level 2 in pop up
menu of the View area projection bounds  and Shadow  buttons. 

See also: Using camera rotation around its own axis

Base height
 

The base height allows to change the height of installation  of the camera together with heights of
lower  and upper  bounds of its view area and the other heights. These heights are calculated
relative to the base height. Therefore, changing the base height does not affect the other
parameters in the the Camera geometry box.
 
Changing the base height can be represented as lifting or lowering the camera from floor to floor with
all the other parameters.
 

The base height affects the position of the camera along the vertical, relative to other cameras and
constructions in the 3D Video  and 3D World  windows, as well as in the calculation of
shadows  in the Graphics  window.
 

At the time of placing a new camera  or pasting  copied camera, its base height is
automatically set equals to the base height  of the active  layer .
 

Height of criteria of person detection  and person identification , license plate reading  are
considered relative to the base height of the camera, which the projections of identification,
detection, license plate reading  areas belong to.
 
The base height is calculated relative to the  Zero ground and can be negative .
 

See also: Work ing with layers and multi-level projects , Layers>Height

View area upper bound height
 

The height of view area upper bound can be chosen from the list or typed. In the horizontal
projection of the calculated view area the space above the upper bound height is not taken into
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consideration. 
 

Together with view area upper bound distance  it completely determines a camera tilt angle and
all calculated parameters through it.
 

 

The height of view area upper bound influences the projections of the person detection,
identification and the license plate reading areas only through changing the camera tilt angle. The
individual values of lower and upper bounds are customized in these projections' calculation criteria.
For instance, when identifying a person the default lower bound is 1.5 m and the upper one is 2.2
m.

 
In multi-level 3D projects, in 3D Video  and 3D World , as well as in calculation of shadows

, the height of installation,  heights of view area lower  and upper  bounds are calculated
relative to the Base height  

 

Height of view area upper bound can be negative.

Height of calculating Spatial resolution, Shadows and Depth of Field

 

Heights of the upper and lower bounds of view area are taken into account when
calculating shadows . If in the menu of the Shadow  tool Within projection is chosen,
then a point in the horizontal projection is considered as shaded if at least partially shaded the
vertical segment, formed by this point in the altitude range from the view area lower bound
height to the view area upper bound height.

 

If in the menu of the Shadow  tool 2 levels is chosen, then the 2 sections of the view area by
2 horizontal planes are simultaneously shown, located on the height of  lower  and upper
bounds of the view area. From the sections subtract shadows from obstacles 

If in the Height  box of the Depth of field box, AUTO is chosen, then calculation of depth of
field in the horizontal projection is carried out at the middle height between the heights of the
view area lower bound and the view area upper bound.

 

If in the Height  box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds  and Shadow  buttons the Within projection is chosen, then
calculation of spatial resolution in the horizontal projection is carried out at the middle height
between the heights of the view area lower bound and the view area upper bound.
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If in the Height  box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds  and Shadow  buttons the 2 levels is chosen, then calculation of
spatial resolution in the horizontal projection is carried out at the height of the view area
lower bound.

View area lower bound height
 

The height of view area lower bound can be chosen from the list or typed. In the horizontal
projection of the calculated view area the space below the lower bound height is not taken into
consideration. 

The height of view area lower bound influences the following calculated parameters:
View area lower bound distance  
View area lower bound width  

 

 
 

The height of view area lower bound doesn't influence the projections of the person detection,
identification and license plate reading areas. The individual values of lower and upper bounds are
customized in these projections calculation criteria. For instance, when identifying a person the
default lower bound is 1.5 m and the upper one is 2.2 m.
 

In multi-level 3D projects, in 3D Video  and 3D World , as well as in calculation of shadows
, the height of installation,  heights of view area lower  and upper  bounds are calculated

relative to the Base height  

 

Height of view area lower bound can be negative.

Height of calculating Spatial resolution, Shadows and Depth of Field

 

Heights of the upper and lower bounds of view area are taken into account when
calculating shadows . If in the menu of the Shadow  tool Within projection is chosen,
then a point in the horizontal projection is considered as shaded if at least partially shaded the
vertical segment, formed by this point in the altitude range from the view area lower bound
height to the view area upper bound height.

 

If in the menu of the Shadow  tool 2 levels is chosen, then the 2 sections of the view area by
2 horizontal planes are simultaneously shown, located on the height of  lower  and upper
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bounds of the view area. From the sections subtract shadows from obstacles 

If in the Height  box of the Depth of field box, AUTO is chosen, then calculation of depth
of field in the horizontal projection is carried out at the middle height between the heights of
the view area lower bound and the view area upper bound.

 

If in the Height  box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds  and Shadow  buttons the Within projection is chosen, then
calculation of spatial resolution in the horizontal projection is carried out at the middle height
between the heights of the view area lower bound and the view area upper bound.
 

If in the Height  box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds  and Shadow  buttons the 2 levels is chosen, then calculation of
spatial resolution in the horizontal projection is carried out at the height of the view area
lower bound.

View area upper bound distance
 

Together with the height of view area upper bound ,
the view area upper bound distance completely
determines the camera tilt angle and all the calculated
parameters via it.

 

When the camera is located above the view area upper bound , a view area upper bound
distance is the maximal distance of surveillance. The view area upper bound distance is
chosen from the list or typed. The view area is calculated up to this distance.
 

 

When the camera is located below the view area upper bound , the view area upper bound
distance can become the minimal distance of surveillance. 
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When a camera is located above the view area upper bound, a view area upper bound
distance is the maximal distance of surveillance. The view area upper bound distance is
chosen from the list or typed. The view areas are calculated up to this distance. Together with the 
height of view area upper bound , the view area upper bound distance completely determines
the camera tilt angle and all the calculated parameters through it.
 

The view area upper bound distance influences the projections of the person detection,
identification and the license plate reading areas only through changing the camera tilt angle.
The maximal distances of the person detection, identification and the license plate reading can
differ from the lower and upper bounds distance both to a smaller or larger extent.
 

When you rotate the camera around its axis, each pass through a multiple of 45 degrees angle, the
camera tilt angle  is changed so that a view area face appearing on top, becomes the view area
upper bound.
 

See also: Maximum distance of drawing view area

View area lower bound distance
 

 The view area lower bound distance is a calculated parameter and can not be edited. 
 

When the camera is located above the view area upper bound , the view area lower bound
distance is the minimal distance of surveillance (dead zone of surveillance). 
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When the camera is located below the view area upper bound , in some positions the view
area lower bound distance is the minimal distance of surveillance too.
 

 

In some positions the view area lower bound distance can be the maximal distance of
surveillance.
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The view area lower bound distance can be negative.
 

 

The view area lower bound distance doesn't influence the person detection, identification and
the license plate reading area projections. The minimal distances of the person detection,
identification and the license plate reading can differ from the lower and upper bounds' distance
both to a smaller or larger extent.

 

This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle  is multiple of 90 degrees;
Lens distortion   is not considered.

In other cases, the projection of view area has a more complicated form and displayed graphically
in the Graphics window.

View area projection length
 

The view area projection length is a calculated parameter and can not be edited. 
 

When there is an actual view area projection, the view area projection length displays the
absolute value of difference between the upper and the lower bound distances of view area
projection.

297

310



Interface 305

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

 

When there is no actual view area projection, the parameter doesn't have any sense and is not
displayed. The parameter displaying enhances the convenience in use when it is required to obtain
the length of view area projection.
 

This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle  is multiple of 90 degrees;
Lens distortion   is not considered.

In other cases, the projection of view area has a more complicated form and displayed graphically
in the Graphics window.
 

Width of view area projection upper bound
 

The width of view area projection upper bound is a calculated parameter and can not be
edited.
 

According to the "Projection " switcher state the width of view area projection upper bound
displays the camera view area width at the point of intersection between the camera view area
bound and the view area projection upper bound, or the view area projection edge width between
the lower bound and the upper one.
 

This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle  is multiple of 90 degrees;
Lens distortion   is not considered.

In other cases, the projection of view area has a more complicated form and displayed graphically
in the Graphics window.
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Width of view area projection lower bound
 

The width of view area projection lower bound is a calculated parameter and can not be
edited. 
 

According to the "Projection " switcher state the width of view area projection lower bound
displays the camera view area width at the intersection point between the camera view area bound
and the view area projection lower bound, or the view area projection edge width between the lower
bound and the upper one.
 

This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle  is multiple of 90 degrees;
Lens distortion   is not considered.

In other cases, the projection of view area has a more complicated form and displayed graphically
in the Graphics window.
 

Projection
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A "Projection" is a switcher determining a way of calculation:
 

The view area lower bound distance  and the view area lower bound width  when the view
area is narrowing upwards on the view area lower bound distance;
The view area upper bound distance  and the view area upper bound width  when the view
area is narrowing downwards on the view area upper bound distance;

 

When the switcher is checked, the view area bound distance and width are calculated according to
narrower level of the view area opposite bound. In this case all the points of the calculated view area
horizontal projection from the lower bound up to the upper one hit in the camera view area.
 

When the switcher is not checked, the distance up to the camera view area bound intersection with
the upper or lower bounds and the width of this bound are calculated.
 

When the view area is not narrowing towards the opposite bound, the switcher doesn't have any
sense and is not displayed.

Maximum distance of drawing view area
 

Value in this combo box limits the distance from the camera beyond which the view area is not
drawn in the Graphics window  and in the 3D World . 
 

This tool is particularly useful for simulating camera rotation  around its axis and lens distortion
.

 

If the value in this box is less than the maximum of the view area upper bound distance  and the 
view area lower bound distance , the box is colored in pink color.

 

 

External link : "The principles of CCTV design in VideoCAD. Part I. Camera view area"(*.pdf).
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9.3 Sensor and Lens

The Sensor and Lens box can be invoked by
clicking the Plus button in the Camera Geometry

 box.

In the box it is possible to specify any image
sensor size , active area size , specify lens
distortion  and adjust modeling active camera
as a panoramic camera .

 

Image sensor
 

See before: Image Sensor and Active area of image sensor

On the Image sensor panel you can set the size and aspect ratio of the image sensor or size of
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active area of the image sensor.
Size and Aspect ratio boxes duplicate the Image sensor size  box on the Camera geometry
window, but allow you to enter the size and aspect ratio in different boxes.
 

In the Size box you can specify the image sensor size by any of the following ways:
 

Choosing a standard format (type) from the list
1/10",1/8",1/6",1/5",1/4.5",1/4",1/3.6",1/3.2",'1/3",'1/2.7",'1/2.5",1/2.3",1/2",1/1.8",1/1.7",1/1.6",2/3"
,1/1.2",1",4/3",1.5"; 

 

This traditional way of setting the image sensor size can be unaccurate for modern cameras .
 

Entering a custom format in inches, in the form of  X/Y". For example: 1/7.31";
 

If you enter a format which does not exist in the list, the box turns yellow, and the Image sensor size
will be calculated by VideoCAD.
 

Entering diagonal size of the image sensor in millimeters, in the form of dX.Y. For example: d6.0. 
 

See more: Specifying image sensor size through its diagonal and aspect ratio
 

Entering sensor side sizes in millimeters horizontally and vertically separated by hash, in the form
of  W#H.  For example: 4.8#3.6;

 

See more: Direct specifying image sensor side sizes

In the Format box you can specify the active area side sizes of the image sensor in millimeters
horizontally and vertically separated by asterisk, in the form of W*H. For example: 4.8*3.6;
 

See more: Direct specifying active area side sizes of the image sensor
 
In the Aspect ratio box you can specify the aspect ratio of the image sensor in the form of W:H.
For example: 16:9 or 4:3. 

To save changes click Save.
To cancel changes click Cancel.

See also: Specifying active area size of the image sensor/

Image sensor's active area
 

See before: Image Sensor and Active area of image sensor

On the Image sensor's active area panel you can specify parameters of  active area of the image
sensor.
 

In the Aspect ratio box displays the aspect ratio of the active area of the image sensor. It is
identical with the Aspect ratio of the output image  of the camera.
 

See more: Specifying the Aspect ratio of output image

In  the Crop box you can set the crop factor - the ratio of cropping active area size of the image
sensor when the active area does not touch the edges of the image sensor.  In other cases Crop=1.
The Crop factor can be set as a vulgar fraction (separated by slash) or a real number. For example 
4:3 0.67 or 16:9 720/1080. If the crop factor is not specified, it is taken to be unity.
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See more: Specifying the crop factor

The Calculator icon  invokes the Image sensor calculator  box for convenient calculation of
image sensor's aspect ratio, active area aspect ratio and the crop factor.

The Horiz., Vert. and Diag. boxes display sizes of the active area of the Image sensor, which are
used in modeling the camera.
These sizes are calculated based on the size and aspect ratio of the image sensor, as well as the
aspect ratio of the output image.
 

In the boxes, you can directly type any sizes of the active area of the image sensor in millimeters.
In this case, the aspect ratio of the active area will be defined by the ratio of its sizes. The Aspect
ratio  box will show Custom.
By this method, you can specify an arbitrary aspect ratio of the image and camera angles. To set
arbitrary camera angles choose the sizes of the active area of the image sensor.
 

Below you can see the dynamic image showing the position and relative sizes of the active area on
the image sensor (aqua color) subject to the selected aspect ratios and crop factor.

Examples of images of image sensor of real cameras:
 

Aspect ratio of
Image sensor

4:3 16:9 4:3 16:9 16:10 16:10 16:9
(1920*1

080)

Aspect ratio of
Active area of
Image sensor

4:3 16:9 16:9 4:3 16:9 4:3 16:9
(1280*7

20)

Crop
1 1 1 1 1 1 720/10

80=0.6
7

Image

To save changes click Save.
To cancel changes click Cancel.
 

See also: Specifying active area size of the image sensor/

Lens

On the Lens panel you can see:
 

Lens focal length - the box duplicates the similar box  in the Camera geometry.
 

Calculated view angles are calculated from the sizes of active area of image sensor and the
lens focal length.
 

Via changing sensor sizes when the lens focal length  is fixed, you can set separately arbitrary
horizontal and vertical view angles.

To save changes click Save.
To cancel changes click Cancel.

Lens distortion
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See before: About Lens distortion .
 

 

 

As a rule, tak ing into account lens distortion is relevant for lenses with a focal length of less than
4mm. For long focus lenses, the distortion is usually can be neglected. In cases requiring precision,
compare the real view angles (from the camera manufacturer's specifications or obtained by
practical measuring ) with the calculated view angles displayed in this box. If the angles differ by
more than 1-2 degrees, the distortion of the camera lens may be noticeable. You can simulate
distortion and evaluate its impact on your task .  

To specify lens distortion:
 

1. Set or check the correct lens focal length ;
 

2. Set or check format  or real sensor sizes ;
 

3. On the Lens distortion panel mark a checkbox near to a box of known value of  real view angle
(horizontal, vertical or diagonal) and enter known angle to the box. Clear checkboxes of unknown
angles - VideoCAD will calculate them.
 

If real angles calculated by VideoCAD will differ from the real angles from camera specification, you
can correct them, by mark ing a checkbox near to appropriate box. You can also change lens focal
length  a little. It is not recommended to change sensor sizes to correct real angles.
If you set real angle values too differed from calculated angles or set other inconsistency, then the
boxed will colored in Red and (or) the view area will be corrupted.
 

4. Mark Simulate to model active camera taking into account lens distortion.
 

Simulation of distortion for all cameras can be turned on and off in the Options box > Miscellaneous
> Lens distortion > Simulate distortion . There, in the Options box, you can change the
discretization accuracy  of distortion simulation.
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Attention! Changing the lens focal length or the format / size of sensor at fixed real angles causes
view area corruption and requires changing the real angles. Therefore, it is advisable to enable
modeling distortion after a preliminary selection of proper lens to increase precision of modeling .
 
Under the influence of the lens distortion the view area becomes more complicated, it sometimes
becomes infinite . To limit the distance of view area drawing use the Maximum distance of drawing
view area .  

In the 3D Video  distortion is modeled with low resolution. You can obtain distorted image model
with real resolution by 2 ways: 

Check the Real frame size  menu item then save image from the 3D Video to a file. The file
will have full size, real resolution and distortion.
Use PiP . While distortion is modeled, the particular view of PIP has real resolution. In case
of corruption on the corners of image with strong distortion - decrease the size  of the
particular view. 

 

Changing the spatial resolution  under the influence of lens distortion is considered along radial
rays from the center of the frame to the edges, without distinguishing between horizontal and
vertical.
 

Simulation of distortion increases the demand for computer power.

To save changes click OK.
To cancel changes click Cancel or close the box.
 

See also:About lens distortion  Modeling lens distortion , Measuring real view angles of a
camera

Panoramic
 

The panel is designed to control simulation of cameras with a view area in the form of a hemisphere
(fisheye, panoramic, 360°/180° cameras).
To enable the simulation of the active camera as a panoramic camera,  check the Panoramic box.

In the Pan angle and Tilt angle combo boxes the angles of rotation of camera main optical axis in
horizontal and vertical planes are specified.
 

 

Thus, if the camera is mounted on a vertical wall, the Tilt angle should be zero, and Pan angle
determines angle of the wall. If the camera is mounted on a ceiling, the Tilt angle must be set to 90
degrees, and the Pan angle does not matter. If the camera is mounted on the floor, the Tilt angle
should be 90 degrees.

Pan, tilt and rotation of the camera around its own axis, made in the usual way does not affect the
position of the panoramic camera. By rotation the camera in the usual way, you can view images
from the panoramic camera in different directions in the 3D Video . In this case, the view area will
be limited at 180 degrees from the main optical axis of the lens. Beyond this limit the image is cut
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Image resolution of a panoramic camera is determined by the Number of pixels of sensor
Lens focal length  and Image size at image processing  have no affect on the image resolution
of a panoramic camera. 

You can change the Lens focal length, thereby changing the field of view size, but the image
resolution in the 3D Video will be always maintained equal to  the calculated resolution of the
panoramic camera.
If the calculated resolution is worse, the resolution of the 3D Video will be artificially reduced. If the
calculated resolution is better, then the PiP  mode will be launched in the 3D Video.
The Image line in the Titles  displays a virtual number of pixels for correct simulation of the
resolution.
Distortion of a panoramic camera images in the 3D Video is not modeled.
The simulated resolution is exact only at the center of the frame. Towards the edges of the frame
the actual resolution is worse than simulated. The smaller the view angle, the more accuracy of
simulating resolution on the edges of the frame.
For a more realistic model of the image, turn on modeling compression  and smoothing , or set
the actual resolution of the lens  (for accurate simulation the lens resolution you also need to
specify the correct size of the image sensor ).

In the Graphics window  the horizontal projection of the view area and  the distribution of spatial
resolution  are visualized. The projection is constructed in accordance with the Within projection

 rule.
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In the 3D World  the camera coverage area and distribution of spatial resolution  are visualized.

\

Pattern criterion  of spatial resolution for panoramic cameras must be based on spatial resolution
(Pixel per meter (Pixel per foot), Pixel for object), but not on field of view size. Criterion Field-
of-view height,  % of Field-of-view for object are not suitable to panoramic cameras, because of
panoramic cameras don't have a stable field of view.

To draw a camera using the special icons   or  in the Graphics window, you need to choose
thus icon during new camera creation  or later on the Camera list  panel. Selecting the icon
works regardless of the state of the Panoramic checkbox .
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To make a camera model  a panoramic camera it is necessary: 
 

Assign fisheye to the parameter Lens>Type  to model the camera as panoramic.
Assign panoramic to the parameter Type>Fixed, PTZ,Dome, Mini  to draw the camera using the

special icons   or  in the Graphics window.

The lens focal length boxes in the Graphics window and the Camera Geometry box for panoramic

cameras are colored by aqua-green.
In reports and in the exported dxf or dwg files for panoramic cameras instead of the lens focal length
value the 'fisheye' word is displayed. .

See also: Modeling panoramic cameras (Fisheye, 360°/180°)

419

438

431

626



VideoCAD316

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.4 Spatial resolution

Graphics window
Tool bar

  Spatial resolution

View area of cameras can be divided into
regions based on the following criteria:
 

vertical or horizontal spatial resolution (pixels/
meters, pixels/foot);

 

vertical or horizontal field of view size (meter,
foot);

 

vertical or horizontal number of pixels covered
by an object of  the specified height(width)
(meter, foot);

 

the part of the frame height(width) covered by
an object of the specified height(width)
(meter, foot).

 

These Criteria relates to the spatial resolution or the field of view size. For short, in the definitions,
it is mentioned the spatial resolution only (the Spatial resolution box, the Spatial resolution pattern,
the Spatial resolution criterion ...), except of special cases.
 

In the Graphics window, projection of different regions of view area can be filled  by different
color and (or) type of hatching.
  

Changing the spatial resolution under the influence of the lens distortion  is considered along
radial rays from the center of the frame to the edges, without distinguishing between horizontal
and vertical.
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Spatial resolution pattern 
 

- contains information about the regions and how they are filled and (or) hatched.
VideoCAD project can contain up to 30 spatial resolution patterns. Each pattern can include up to 10
regions. You can assign different patterns to different cameras.
 

Spatial resolution box 
 

- is designed for creating and editing the patterns of spatial resolution and field of view size
visualization. 
In the box there are prepared spatial resolution patterns according to the following criteria: 
 

Home Office Scientific Development Branch; 
Home Office Guidelines for identification; 
P 78.36.008-99;
Australian Standard AS4806: Closed Circuit Television;
European Standard EN 50132-7;
ISO/IEC 19794 Biometric data interchange formats. 

 

Individual patterns can be customized according to any other criteria related to the spatial resolution
or the field of view size.
 

Also in the box there are examples of images of group of people are automatically displayed for each
region of spatial resolution.
 

It is convenient to keep the Spatial resolution box opened during the analysis of spatial resolution in
the Graphics window. Comparing color of regions on the layout with color in table in the spatial
resolution box, on the images in the  Resolution  and Field of view  columns you can
immediately see the expected resolution and  field of view size at every point of view area of each
camera.

See further : Tools in the Spatial resolution box , Work  with the Spatial resolution box .
See also: Spatial resolution , Fill projection ,  Visualization of cameras' control area projections
and spatial resolution inside them .
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9.4.1 Tools

Pattern
Active camera

 Edit/Save
 Vert./Hor.
Pattern criterion
Height
Object height (width)
Draw Legend
Blend/Hatch
Assign  
To selected cameras
Vert.(Horiz.) number of pixel
Active camera
Table of regions
Resolution
Field of view
Type of hatching combo box
Colors of regions button
How to add your own images to the Table of
regions

Pattern
 

In this combo box the name of the chosen pattern of spatial resolution is shown.
You can choose any pattern from 30 patterns of spatial resolution. Parameters of the chosen
pattern are displayed and can be edited in the Spatial resolution box. 
The name of the pattern can be edited in this box, when the Edit  button is pressed.
 

As a result of right-click on the combo box a pop up menu will appear. Selecting the Default
patterns item, you can erase all changes in the patterns and return to the patterns set by default.
 

The box is inaccessible when the Active camera  box is checked.

Active camera
 

If the checkbox is checked, a pattern assigned to the active camera is automatically displayed in
the spatial resolution box. The Pattern  combo box will become inaccessible for editing.

Edit/Save
 

Edit the chosen pattern. Clicking on the Edit button makes parameters of the chosen pattern
accessible for editing. The button caption is changed to Save - stop editing and save the modified
pattern.
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Vert./Hor. switch
 

The switch allows to choose direction (horizontal or vertical) to which the pattern criterion
must be applied. 

If  Vert. is checked then the Pixel per meter is the number of pixel per meter along the
vertical, the Field-of-view height is the height of the Field-of-View, the Pixel for object is the
number of pixel covered by the object along the vertical, the % of Field-of-view for object is a
part (%) of the Field-of-View covered by the object along the vertical; 
If  Hor. is checked then  the Pixel per meter is the number of pixel per meter along the
horizontal, the Field-of-view width is the width of the Field-of-View, the Pixel for object is
the number of pixel covered by the object along the horizontal, the % of Field-of-view for
object is a part (%) of the Field-of-View covered by the object along the horizontal.   

 

The switch is accessible for editing in the Editing  mode.
 

When calculating the spatial resolution, rotation  of the camera around its axis by default
does not affect the position of the vertical and horizontal in the frame.  Horizontal and vertical
positions are tied to the camera and not to the scene. You can change this rule, using the Spatial
resolution and rotation  checkbox in the Options box .
  

Changing the spatial resolution under the influence of the lens distortion  is considered along
radial rays from the center of the frame to the edges, without distinguishing between horizontal
and vertical.

Pattern criterion
 

In the box you can choose a criterion according to which regions in the pattern will differ. 
 

You can choose one from 4 criteria:
Pixel per meter (Pixel per foot) - vertical (horizontal ) spatial resolution (pixels/meters,
pixels/foot);. 
Field-of-view height (width) - vertical (horizontal)  field of view size (meter, foot);
Pixel for object - vertical (horizontal)  number of pixels covered by an object of the height
(width) specified in the Object height(width)  box (meter, foot); .
% of Field-of-view for object - the part of the frame height (width ) covered by an object of
the height (width) specified in the Object height(width  box (meter, foot).

  

Direction of the criterion (vertical/height or horizontal/width) can be specified by the Vert.//Hor .
switch

 

Meters or feet as a unit of height are selected automatically depending on the format of
measurements  in the project. 
 

For the criteria Pixel per meter (Pixel per foot), Pixel for object  the spatial resolution
depends on the number of pixels along vertical or horizontal.
In calculation the minimal number of pixels from parameters of camera image sensor and
parameters of output image is used. 
Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
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Number of pixels of output image is specified on the Processing  tab of the Image
parameter panel .
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or
horizontal 768 pixels), what corresponds to analog camera.
 

Rotation  of the camera around its axis by default does not affect the position of the
vertical and horizontal in the frame.  Horizontal and vertical positions are tied to the camera
and not to the scene. You can change this rule, using the Spatial resolution and rotation
checkbox in the Options box .

 

Pattern criterion of spatial resolution for panoramic  cameras must be based on the spatial
resolution (Pixel per meter (Pixel per foot), Pixel for object), but not on the field of view size.
Criterion Field-of-view height,  % of Field-of-view for object are not suitable to panoramic
cameras, because of panoramic cameras have not a stable field of view.

The box is accessible for editing in the Editing  mode.

Height
 

Height of measuring the spatial resolution in the
horizontal projection (height of the horizontal red
line on the picture).
 

If the main optical axis of the camera is not
parallel to the horizon, the spatial resolution in the
horizontal projection depends on the height above
the ground.
 

If in the Height box AUTO is chosen and in
the View area projection bounds  and
Shadow  buttons the Within projection is
chosen, then calculation of spatial resolution in
the horizontal projection is carried out at the
middle height between the view area lower
bound height  and the view area upper
bound height .

 

If in the Height  box of the Spatial
resolution box, AUTO is chosen and in the
View area projection bounds  and Shadow

 buttons the 2 levels is chosen, then
calculation of spatial resolution in the horizontal
projection is carried out at the view area lower
bound height  

The box is accessible for editing in the Editing  mode.

Object height (width)
 

Height (width ) of the object for the criteria associated with an object: Pixel for object and % of
Field-of-view for object. 
 

The caption is changed according to the Vert./Hor.  switch.
 

The box is accessible for editing in the Editing  mode.
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 Draw Legend 
 

Draw legend of the current Spatial resolution pattern on the Graphics area. After choosing this
button specify place of the legend on the Graphics area of the Graphics window. 
You can select font type  on the font type panel  before placing or after double clicking near
to the left top corner of the legend.
By means of font type you can change size and color of the legend. You can also make the
legend scalable  or nonscalable. 
Legend is tied with his Spatial resolution pattern . If parameters of the pattern is changed then
the legend will be changed too. You can place several legends of different patterns on the same
layout.

Blend/Hatch
 

Show the regions in the Spatial resolution box hatched or filled by blend translucent colors.
 

This box affects displaying regions in the Spatial resolution box only. Hatch or fill regions in the
Graphics window can be determined separately for each camera using the Fill projections
button.

Assign
 

 

Assign chosen pattern to the Active camera. If the To selected cameras box is checked, then
the chosen pattern is assigned to all selected cameras. 

Vert.(Horiz.) number of pixels
 

 

Attention! The purpose of this combo box differs in Starter, Lite and Professional versions!
 

The caption is changed according to the Vert./Hor.  switch.
 

Vertical (horizontal) number of pixels for modeling images  on the far bounds of regions. Images
on the bounds of regions depend not only on the criterion value , but also on the number of
pixels.
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Thus, for criteria related to the number of pixels which covers a specified height (width) (
Pixel per meter, Pixel for object) value of the criterion determines the spatial resolution, ie
how detailed the scene is photographed. In this case, Vert.(Horiz.) number of pixels determines
the size of the field of view.
 

Conversely, for criteria related to the height (width) of the field of view (Field-of-view height
(width),% of Field-of-view for object) criterion value determines the size of the field of view. In
this case, Vert.(Horiz.) number of pixels determines the spatial resolution, ie how detailed the
scene is photographed.
 

In the Professional version this box affects only the images in the Resolution  and the
Field of view  columns in the Spatial resolution box. This box does not affect the regions
in the Graphics window.
For calculation of regions in the Graphics window the minimal number of pixels from
parameters of camera image sensor and parameters of output image is used. 
Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
Number of pixels of output image is specified on the Processing  tab of the Image
parameter panel .
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or
horizontal 768 pixels), what corresponds to analog camera.
 

Rotation  of the camera around its axis by default does not affect the position of the vertical
and horizontal in the frame.  Horizontal and vertical positions are tied to the camera and not to
the scene. You can change this rule, using the Spatial resolution and rotation  checkbox in
the Options box .

 

The box is accessible for editing if the Active camera  box is not checked.
 

Active camera
 

 

When this box is checked, the number of pixels of the Active camera is assigned to the Vert.
(Horiz.) number of pixel  box. The Vert.(Horiz.) number of pixel box becomes inaccessible for
editing.
 

For calculation the minimal number of pixels from parameters of camera image sensor and
parameters of output image is used. 
Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
Number of pixels of output image is specified on the Processing  tab of the Image parameter
panel .
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or horizontal
768 pixels), what corresponds to analog camera.
 

Rotation  of the camera around its axis by default does not affect the position of the vertical and
horizontal in the frame.  Horizontal and vertical positions are tied to the camera and not to the
scene. You can change this rule, using the Spatial resolution and rotation  checkbox in the
Options box ..

Table of regions
 

In rows of this table you can see and edit  parameters of regions of the chosen spatial
resolution pattern. 
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The bottom row of the table corresponds the nearest to the camera region. 
 

On the first column of the table, on the background rectangles filled by a color assigned to the
region, the Name of the region and the Criterion value  at the far bound of region are
displayed.

Resolution column

 

The Resolution column contains fragments of images with people at the far bounds of each
region. These are fragments of images, not whole images. Field of view of the
fragments is less than the real field of view, but the resolution of people corresponds the
real images exactly.
 

On the images in the Resolution column, you can see with which resolution people at the far
bound of each region will be visible.

Field of view column
 

The Field of view column contains whole reduced images of people with the field of
view at the far bounds of each region. Resolution of these images is less than resolution of
the real image, but the field of view corresponds the real images exactly.
 

On the images in the Field of view column, you can see which part of the field of view
people at the far bound of each region will cover.

Images in Resolution and Field of view columns are automatically generated according to the
criterion value of each region and the Vert.(Horiz.) number of pixel  value. 
The images visualize the boundary values of the criterion.
 

The height of "men in blue shirt" is 2 meters (about 6.5 feet).
 

Right click on any
image in the Table of
regions. Pop up
menu will appear.
With the help of this
menu you can change
image in the Table of
regions. 

 
 

In the Editing  mode the Names of regions and the Criterion values become accessible for
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editing. In addition the Type of hatching combo boxes  and Colors of regions

buttons  appear.

 

In the Type of hatching combo boxes  you can choose type of hatching for each
region. 
 

Hatching will be visible in the Spatial resolution box when the Blend/Hatch  box is not
checked. In the Graphics window, hatching of the chosen  type will be shown for cameras, which
have chosen Hatching in the menu of the Fill projections  button.
 

Color of region is the same for filling and for hatching.

 

How to add your own images to the Table of regions
 

Table of regions can display any images in *. jpg format, for example: photos of objects,
etc. Adding your own images you can see how your objects will look at the far bounds of
regions.

To add your own images to the Table of regions:
 

1. Take any *.jpg file, digital photo image etc.
 

Simulated spatial resolution can not exceed the spatial resolution of the object on the used
picture, so the spatial resolution of the object on the picture should be sufficient. The object
should take the greatest possible part of the picture and the picture resolution should be
sufficient.
 

2. Name your file by the following composite name: <anyname>,<W>,<H>,<CX>,<CY>.
jpg
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  Thus the name is a string composed of
the comma separated values:

<anyname> - any string without
spaces and special characters;
<W> - image width, in meters;
<H> -  image height, in meters;
<CX> - X coordinate of a spot on the
image, at which the camera should be
pointed (in meters);
<CY> -Y coordinate of a spot on the
image, at which the camera should be
pointed (in meters);

 

Origin of coordinates is on the top left
corner of the image.

 

Example of file name: 
sample1,2.67,2,1.335,0.177.jpg

 

3. Put your file in the VideoCAD installation directory,  /Resolution samples/ folder. 
You can place several files to this folder.
 

4. Launch VideoCAD. Open the Spatial resolution box. Right click on any image in the
Table of regions. Pop up menu will appear. With the help of this menu you can change
image in the Table of regions. 
If your file is missing in the menu, then you probably made a mistake in the filename. If the
file is displayed not correctly, you probably typed wrong values of sizes in the filename.

See further : Work  with the Spatial resolution box .326
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9.4.2 Work with the Spatial resolution box

Editing the Spatial resolution pattern
Assigning the pattern to cameras

Editing the Spatial resolution pattern

 

1. Clear the Active camera  box.
 

2. Choose a pattern for editing in the Pattern  combo box.

3. Click the Edit  button.  Caption on this button will be changed to Save. Parameters
of the chosen pattern will become accessible for editing.

 

4. If necessary, edit the Name of the pattern in the Pattern  box by the keyboard.
 

5. Choose direction  (horizontal or vertical) and criterion in the Pattern criterion  combo box.
 

 

6. Specify Height  at which the criterion values should be calculated. 
 

If in the Height box AUTO is chosen and in the View area projection bounds  and Shadow
buttons the Within projection is chosen, then calculation of spatial resolution in the horizontal
projection is carried out at the middle height between the view area lower bound height  and
the view area upper bound height .

 

If in the Height  box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds  and Shadow  buttons the 2 levels is chosen, then calculation of spatial
resolution in the horizontal projection is carried out at the view area lower bound height

 

7. In case of chosen criteria is related to an object (Pixel for object, % of Field-of-view for
object), choose the object height(width) in the Object height (width)  box. 
 

 

8. If the type of hatching is needed to show, clear the Blend/Hatch  box.
 

9. Specify values of the criterion  at far bound of each region in the Table of regions .

When editing the values of criteria, you must comply with the following

rules:

 

9.1 The bottom row of the table should correspond to the closest to the camera region, and
thus must have:

 

maximum spatial resolution (the maximum value of the criterion Pixel per meter);
any object must cover the maximum number of pixels (the maximum value of the criterion 
Pixel for object);
minimum size of the field of view (the minimum criterion Field-of-view height (width));
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any object must cover maximum part of the field of view (the maximum value of the criterion 
% of Field-of-view for object).

 

9.2 The values of the criteria should be edited consistently from region to region, starting from
the closest to camera region (bottom row). For example, if the criterion is Pixel per meter, then
in the bottom row should be the maximum spatial resolution, and in each subsequent row
criterion value must be less than the row below.

If this rule is violated then the boxes with wrong values would be red highlighted.
 

9.3 In the editing mode , the table unfolds and shows the maximum number of region in
the pattern (10). If you need a smaller number of regions, the "extra" regions must have equal
values of the criterion. "Unnecessary" regions should be placed one after another at the top of
the table.

10. You can edit the Name of each region in the Name box, choose a color that will be used for

displaying the region in the Graphics window by clicking on the Color button  , choose

hatch style in the Hatch style .  combo box.
 

Hatching will be visible in the Spatial resolution box when the Blend/Hatch  box is not
checked. 
In the Graphics window, hatching of the chosen type will be shown for cameras, which have
chosen Hatching in the menu of the Fill projections  button.
 

11. On the images in the Resolution  column, you can see with which resolution people at the
far bound of each region will be visible.
On the images in the Field of view  column, you can see which part of the field of view people
at the far bound of each region will cover.
 

Sample images are correct for the cameras with vertical number of pixels specified in the Vert.
(Horiz.) number of pixel  combo box .

12. When editing pattern will be finished, click the Edit/Save  button once again.

Assigning the pattern to cameras

 

To assign a pattern, displayed in the Spatial resolution box to a camera:
1. Activate  the camera.
 

2. Click on the Assign  button.
 

If the To selected cameras  box is checked, then the chosen pattern is assigned to all selected
cameras.
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See also: Spatial resolution , Fill projection ,  Visualization of cameras' control area projections
and spatial resolution inside them .
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9.5 Sensitivity and Resolution

Graphics window
Main menu

View
Sensitivity and Resolution

In the box sensitivity and resolution parameters
of the active camera present. 
Here you can choose camera type: color,
black-white or day/night.

 

If in the project it is required only to place cameras and choose lens focal lengths, and it is not
required to model illumination and image resolution, this box can be not used.

Sensitivity parameters
 

Sensitivity parameters are used in image modeling taking into account camera sensitivity and
scene illumination.

Sensitivity parameters are taken into account only when:
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3D Video  is visible;
Illumination modeling  is switched on.

 

Camera sensitivity is determined by set of parameters of camera and lens, therefore in the box
there are 2 big panels: 

 

Camera ;
Lens .

 

For image modeling considering scene illumination, parameters in white boxes should be set.
Parameters in grey boxes are results of calculation.
Some parameters correspond to adjustments on cases of cameras and lenses.
 

To allow lens contamination, dirt, camera degradation and parameter variation it is necessary to
set Maintenance factor of cameras  on the 3D modeling  tab of the Options box. 

 

See also: About camera sensitivity .

Resolution parameters
 

Resolution parameters are used in modeling resolution of image from the active camera in the 3D
Video . 

Number of pixels is also taken into account when calculating person detection , identification
and license plate reading  areas and spatial resolution .

Model of active camera
 

Model combo box duplicates similar combo box  on the Tool bar of the Graphics window. It
is convenient to assign all parameters in this box at once through assignment of camera model

 to the active camera in the Model combo box. 
After model assignment changing some parameters is locked according to model limits. To unlock

parameters it is necessary to choose =Unassigned = in the Model box.
 

 Near the box there is Table of camera models button for displaying detailed Table of camera
models . 

The button duplicates similar button  on the Tool bar of the Graphics window.
 

The Sensitivity and Resolution box can be used for comparison of images from various camera
models and lens according to known parameters.

By assigning different models to the active camera it is possible to compare images of the same
scene which can be obtained using different camera and lens models.

See more: Camera , Lens
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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9.5.1 Camera

Color
ExView
Number of pixels
Resolution (LPH)

Subpanels:
 

Minimum scene illumination
 

Min. illum. (lx)
AT:

Aperture
S/N (dB)
IRE
Exposure (ms)

On sensor

Signal/noise ratio
 

S/N max.
S/N current

Automatic gain control (AGC)
 

AGC
Current
Maximum
Set

Back light compensation (BLC)
 

BLC
BLC type

Gamma
 

Gamma
Degree of gamma correction

Internal Auto iris amplifier DC (DD)
 

Auto Iris DC -Level+
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Electronic shutter (ES, AES, AESC, shutter)
 

AESC
Exposure time limits  (shutter speed,
shutter LIM, SPD)
Current
- Level+

Color
 

In the box camera color can be chosen. 4 variants are available:
 

B/W - black-white camera;
 

color - color camera;
 

day/night - full day/night camera, which has infra-red filter that is mechanically removed in black-
white mode;
in black-white mode the day/night camera is sensitive to infrared light;
day/night camera at sufficient illumination behaves as a color camera with sensitivity approximately
in 5 times less than in black-white mode;
 

easy day/night - camera has infra-red filter which is not removed in black-white mode;
easy day/night camera have much less advantages in sensitivity from switching to black-white
mode, than full day/night cameras have;
in black-white mode easy day/night camera is non sensitive to infrared light;
At sufficient illumination easy day/night camera behaves as color camera with the sensitivity
approximately in 2 times less than in black-white mode.
 

At illumination reduction day/night and easy day/night cameras are switched into black-white
mode. At the same time their sensitivity increases up to the value set on Minimum scene
illumination  panel.
 

Color parameter influences 3D model  color as well as spectral sensitivity of cameras to
various light sourses . 
For example, color camera is non sensitive to IR illumitators , and black-white camera has
reduced sensitivity to light of discharge lamps in comparison with Incandescent lamp.

ExView
 

In the camera image sensor with increased relative IR sensitivity is used. 
Image sensor type is usually specified in camera specification. 
 

Image sensor type influences spectral efficiency factors  of different light sources that are used
in modeling. However this influence does not exceed 15-20 %. Do not mark this box if the type of
image sensor is unknown.
 

Though Sony ExView HAD ™ CCD has increased total sensitivity, this box does not influence
sensitivity to illumination produced by Halogen Incandescent lamps. Sensitivity to Halogen
Incandescent lamps is unequivocally specified in the Min. illum. (lx)  box.

Number of pixels
 

In the combo boxes you can choose horizontal and vertical numbers of effective pixels on the
image sensor. Analog cameras have, as a rule, 752x582 (high resolution) or 500x582 (standard
resolution) effective pixels.
Number of effective pixels of IP cameras can be different.

336

336

336

336

334

357

464

469

464

334



Interface 333

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

 

If N/A is chosen in the box, then number of pixels is not considered.
 

In the boxes exactly the number of image sensor's pixels is to be specified, without
considering analog-to-digital conversion or output image size. Analog-to-digital conversion or
output image size is set on the Processing  tab of the Image parameter panel. The final
image is modeled considering distortions connected with different number of pixels on image
sensor and in output image.
 

A button with a cross between combo boxes with horizontal and vertical numbers of pixels is
intended for fast calculation of vertical number of pixels from the specified horizontal number of
pixels and on the contrary. Calculation is carried out using the Aspect Ratio .

Criteria  of person detection , identification  and license plate reading , spatial
resolution  depend on the number of pixel. Therefore the number of pixels influences
person detection, identification and license plate reading areas, positions of spatial resolution
regions  and image examples  in the Spatial resolution box.
For criteria calculation minimal number of pixels from parameters of camera image sensor
and parameters of output image is used. 
Number of pixels of output image is specified on the Processing  tab of the Image parameter
panel .
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or horizontal
768 pixels), what corresponds to analog camera.

If a camera is rotated around its axis  by an angle more than 45 degrees, when calculating
person detection  and identification , license plate reading  areas,  the parameters:
minimum vertical resolution (pixel/meter, pixel/ft), the minimum vertical size of face
image ( pixels ), the minimum vertical size of license plate ( pix) are calculated based on
the number of pixels along the horizontal, instead of the number of pixels along the vertical, as
in this case the vertical side of the field of view is located along the horizontal.
 

When calculating the spatial resolution , rotation of the camera around its axis by default
does not affect the position of the vertical and horizontal in the frame.  Horizontal and vertical
positions are tied to the camera and not to the scene. You can change this rule, using the 
Spatial resolution and rotation  checkbox in the Options box .
 

The positions of the boundaries of spatial resolution  and the sample images  in the
Spatial resolution box are affected by the number of pixels in vertical or horizontal direction
depending on the position of the Vert. / Hor  switch in settings of a pattern of spatial
resolution, assigned to the camera.

Resolution (LPH)
 

In the box you can specify resolution of the active camera, in LPH - Lines per Picture Height. At
3D modeling resolution of image will be limited up to the value set in this box.
In the box on the left, a value of the lines per picture height (LPH) is entered, and in the box on the
right a drop of contrast in % according to the MTF at the entered number of lines is specified.
If the Horiz. only checkbox is checked then only horizontal resolution is modeled, which is typical
for analog cameras. If the Horiz. only checkbox is not checked, the camera resolution will
decrease horizontally and vertically in the same degree.
 

If N/A is chosen in the box, then resolution limitation is disabled.
 

Items sharp+1, sharp+2, sharp+3 on the contrary increase image sharpness. With the help of
these items it is possible to model effect of Aperture corrector.
 

Aperture corrector is automatically switched-off at insufficient illumination.
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You can also simulate the lens resolution . When the lens resolution simulation and camera
resolution simulation are both enabled, then their effects are summarized.
 

You can check resolution visually using the Test chart . 

Minimum scene illumination

Min. illum. (lx)
 

Minimum scene illumination (lux). The parameter is given in specification of any cameras.

However usage in calculations and models the minimum illumination values from
specification of some manufacturers can lead to errors.
 

In VideoCAD it is meant, that scene reflection factor is 0.75, light source - halogen incandescent
lamp (color temperature 3100 +-200K) according to Standard CEA 639 'Consumer Camcorder or
Video Camera Low Light Performance'. 
 
For day/night  and easy day/night cameras in this box it is necessary to enter the minimum
scene illumination in black-white mode.
 

For unambiguous description of sensitivity in VideoCAD, should be pointed also:
 

with what lens aperture  the minimum illumination is measured;
signal/noise  ratio of the image at the minimum illumination;
IRE  of video signal at the minimum illumination;
exposure time  at what the minimum illumination is measured.

 

To allow lens contamination, dirt, camera degradation and parameter variation it is necessary to
set maintenance factor of cameras on the 3D modeling  tab of the Options box.
 

For modeling increased contrast at constant signal/noise ratio use parameter Maximum AGC gain
.

 

Sometimes the boosted sensitivity is achieved due to noise decreasing as a result of digital image
processing. But in this case resolution essentially decreases too. 
For modeling resolution decreasing, use Sharpness  parameter.
 

See also: About camera sensitivity , Measuring camera sensitivity . 

AT:

Aperture
 

Lens aperture at which the minimum scene illumination is measured.
The parameter is given in camera specification. Typical value from F1.0 up to F2.0.

S/N (dB)
 

Signal/noise ratio of the image at the minimum illumination , unweighted value.  
 

According to CEA 639, limit value of signal/noise ratio at the minimum illumination determination is
17dB (7 times in voltage).

IRE
 

IRE of video signal at minimum illumination, at AGC switched on by default. 
In VideoCAD 100 IRE corresponds full peak-to-peak amplitude of video signal and accordingly to
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maximum brightness amplitude on the image. 50IRE corresponds half of maximum brightness
amplitude on the image, etc.   
 

The parameter is given in camera's specification. Typical value is from 30 to 50.
 

If Set  box is marked (the maximum AGC gain in set), AGC mode does not correspond default
AGC mode of camera. It means that IRE value at minimum illumination also will not correspond to
the value specified in the IRE box. Therefore this box will be grey. 
The more maximum AGC gain is, the larger is IRE. 
 

Exposure (ms)
 

Exposure time (milliseconds) at which the minimum illumination has been measured.
Parameter is sometimes given in camera specifications. For analog cameras typically value is
20ms(PAL) or 16.5ms (NTSC). For IP cameras and analog cameras with light accumulation the
exposure time may be up to 200ms or more.
VideoCAD offers a technique of measuring exposure time of cameras with an analog oscilloscope,
see: Measuring exposure time of IP camera
  

At modeling the exposure time assumed the truth of the Reciprocity principle, that is inversely
proportional of sensitivity to the exposure time.
 

See also: Modeling exposure .

On sensor
 

Calculated illumination on the image sensor of the camera, corresponding the minimum
illumination of scene  with reflection factor 0.75. 
 

This parameter is for information only.

Signal/noise ratio
 

S/N max.
 

Maximum signal/noise ratio of the camera (dB). 
In this box it is necessary to choose weighted value. Normally weighted value of maximum signal/
noise ratio is given in cameras' specification. 
 

At that it is not specially indicated in specification that just weighted value is given. 
 

Typical value for cameras with 1/3 " CCD image sensors is 50dB.
 

If only unweighted value is known, for obtaining the weighted value it is necessary to add 8dB to
unweighted one, according to http://cctv-information.co.uk 
 

Maximum signal/noise ratio determines dynamic range of camera.
For accurate modeling it is possible to measure  maximum scene illumination of the real
camera directly, then choose Maximum signal/noise ratio for obtaining equal maximum illumination
of the camera model in VideoCAD.

S/N current
 

Current signal/noise ratio of the modeling image (unweighted value). 
The parameter is calculated during modeling. 
 

In the project 2 values are stored: for day  time and night time.
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Electronic shutter (ES, AES, AESC, shutter)
 

AESC
 

Switching on/off electronic shutter. The electronic shutter controls exposure time depending on
illumination. 

Exposure time limits (shutter limits, shutter speed, shutter LIM, SPD)
 

Exposure time limits within which electronic shutter operates. 
 

The parameter is given in camera's specification. Modern PAL system cameras have exposure
limits 1/50s-1/100000s. For cameras of NTSC system the maximum exposure is 1/60s. For IP
cameras the maximum exposure time can be larger, up to several seconds.

Current
 

Current exposure time.  
If exposure is limited by electronic shutter  (electronic shutter operates), the box becomes aqua
color.
If current exposure time reaches minimum exposure time , the box becomes yellow together
with box, in which minimum exposure time is specified.
 

The parameter is calculated during modeling. In the project 2 values are stored: for day  time
and night time.
 

At modeling the exposure time assumed the truth of the Reciprocity principle, that is inversely
proportional of sensitivity to the exposure time.

- Level+
 

Adjuster of electronic shutter sensitivity to illumination change. Visually this adjuster changes
contrast of the image, which is obtained as a result of automatic electronic shutter's work. If the
contrast is too high, bright areas on the image are white level clipped.
 

The adjustment range of real cameras can be different.

Automatic gain control (AGC)
 

AGC
 

Switching AGC on/off. The AGC maintains constant video signal level at its insufficient level by
additional gain. At that together with the useful signal the noise is gained too.

Current
 

Current AGC gain (dB). 
 

The parameter is calculated during modeling. In the project 2 values are stored: for day  time and
night time.
 

If AGC additionally gains the signal, the box becomes aqua color.
 

If Maximum AGC gain  is set and gain value achieves the maximum , the box becomes
yellow, together with Maximum AGC gain box and IRE  box.
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Maximum
 

In this box it is possible to specify Maximum AGC gain (dB) for cameras with switchable AGC
gain: High AGC gain (High AGC, S-AGC, Super AGC) or LO AGC gain.
The box will be enabled and the set AGC limit will be considered in modeling, if the Set  box is
marked.  
Enter in the box maximum AGC gain if it is given in the camera's specification.  
 

Typical value is 26-42dB. 
 

If the camera does not have switchable AGC gain, the box must be disabled, and the maximum
AGC gain is calculated in the program.

Set
 

Switch ON the specified maximum AGC gain. If this box is marked, the maximum AGC gain set
in the Maximum  box is used in calculation. 
 

The check mark in this box means that a special AGC mode is switched on.
 

If this box is marked, the AGC mode is not corresponding to default camera's AGC mode. That
means that the IRE  value at minimum illumination also will not correspond to the value specified
in the IRE box. Therefore the IRE box becomes grey. 
The more maximum AGC gain is, the larger is IRE. 
 

The signal/noise  ratio depends only a little on the AGC gain.

Back light compensation (BLC)
 

BLC
 

Switching on/off back light compensation (BLC). If this function is switched on, measurement of
image brightness for the electronic shutter or Auto Iris (DC only) adjusting is made not by full
image, but only by central or central and lower parts of it.
This function allows to view objects at image centre which are on different brightness background.

BLC type
 

In the box you can choose:
 

Center - analyze
brightness on
image center;

Multizone - analyze
brightness on center
and bottom of the
image.

Gamma

Gamma
 

Switching on/off gamma correction. Gamma correction is used in the majority of cameras by
default. The correction of the linear response of a camera in order to compensate for the monitor
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phosphor screen non-linear response. Visually, at switched on gamma correction dark areas of an
image become visible better, but contrast of bright areas decreases.

Degree of gamma correction
 

The parameter is given in cameras' specification. Normally gamma correction degree equals 0.45.
The degree equal 1 is equivalent to absence of gamma correction.
 

It is supposed, that measurement of minimum illumination  is performed at the gamma
correction degree set in this box (even if the Gamma  box is not marked!).

Internal  Auto iris amplifier DC (DD)
 

Auto Iris DC -Level+
 

Adjuster of Auto Iris DC  gain. The slider corresponds to a similar adjuster on camera's case.
Visually this adjuster changes image contrast which is achieved as a result of auto iris adjustment.
If the contrast is too high, bright areas on the image are white level clipped.
 

Adjustment range of real cameras can be different.
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9.5.2 Lens

 
Iris type

Fixed Iris
Manual Iris
Auto Iris

DC
Video Drive

-Level+
ALC

 

Boxes:
 

Aperture limits  (F-number)
Curr. aperture  (F-number)
Min. illum.
 

Resol. (lp/mm)

Iris type

Fixed Iris
 

Fixed Iris. Aperture value is specified in the left box of Aperture limits . During modeling the
aperture does not vary.

Manual Iris
 

Manual iris. Aperture can be changed manually within specified limits, in the Curr. aperture
box. Aperture limits are specified in the Aperture limits  boxes.
During modeling the Aperture does not automatically vary.  

Auto Iris
 

Automatic iris. During modeling the aperture automatically varies depending on scene illumination.
Aperture change limits are specified in the Aperture limits  boxes.
Current value of the Aperture during modeling is displayed in the Curr. aperture  box.
If the automatic iris is chosen, AESC  (electronic shutter) in camera parameters is switch off,
adaptation to the illumination is performed only by changing aperture.
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Auto Iris can be of two types:

Auto Iris > DC
 

The iris control signal, which comes from camera to the lens, is a direct-current voltage. DC signal
is produced by camera depending on image sensor illumination. BLC  (back light compensation)
can work with DC iris lens. Image contrast can be adjusted by AutoIris DC -Level+  adjuster on
camera's case. 
 

Not all cameras have the circuit for controlling DC lens. 

Auto Iris > Video Drive
 

The iris control signal, which comes from camera to the lens, is a video signal. This video signal
will be transformed to iris control voltage by an internal circuit, which is in the lens.  BLC  can
not work with Video iris lens, as a rule. Image contrast can be adjusted by -Level + screw on lens
case.

On Video Drive lens there are screws:

Auto Iris > Video Drive > -Level+
 

Adjuster of iris sensitivity to video signal. Visually this adjuster changes image contrast which is
obtained as a result of auto iris adjustment. If the contrast is too high, bright areas on the image
are white level clipped.
 

Adjustment range of real cameras can be different.

Auto Iris > Video Drive > ALC
 

Sensitivity to peaks or to average level of video signal. 
If the slider is closer to Peak, the image contrast is adjusted by the brightest spots of the image
even if they occupy insignificant square. In this case bright areas are seen well, but dark areas can
be black level clipped and not be displayed.
 

If the slider is closer to Average, the image contrast is adjusted by an average level of image
brightness. At that the brightest areas on the image, which occupy small square, can be white
level clipped and not be displayed. 
Optimum position of this adjuster depends on scene features.
 

Adjustment range of real lenses can be different.

Boxes:

Aperture limits (F-number)
 

In the left box the maximum aperture value (F-number), which the lens can have (fully opened
aperture), is entered. 
In the right box the minimum aperture value (fully closed aperture) is entered.  
 

The more the F-number is, the less light passes through the lens.
 

These values are given in the lens specification. 
For Fixed Iris  lenses the fixed aperture (F-number) is entered in the left box.
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Curr. aperture (F-number)
 

Current aperture value. 
 

For Manual Iris  lenses in this box it is possible to change aperture value.
 

For Auto Iris  lenses in this box the aperture value calculated during modeling is displayed. 
 

In the project 2 values are stored: for day  time and night time.
 

This value can be automatically used at calculation and modeling of depth-of-field .
 

If the Auto Iris Control operates and closes the aperture, the box becomes aqua color.
 

If the Current aperture reaches limit value , the box becomes yellow together with box in which
the limit value is set.
 

If in the box an aperture value, exceeding maximum aperture value , is entered manually, the
box becomes red together with box in which the maximum aperture value is set.
 

Min. illum.
 

In the box the calculated value of minimum scene illumination at fully opened aperture is
displayed. 
 

This parameter is for information only.

Resol.(lp/mm)
 

Resolution of the lens in line pairs per millimeter (lp / mm).
Lp / mm - is the number of pairs of lines (black + white line) perpendicularly intersecting a segment
on the image sensor of length of 1 millimeter.
Note the difference with the unit of camera resolution, LPH. Resolution of cameras is measured in
the amount of black and white lines, but the lens resolution is measured in line pairs , that is, at the
same actual resolution, the lp / mm value is in 2 times less than LPH.
 

Effect of lens resolution on the final resolution of the camera depends on the ratio of lens resolution
in lp / mm to the number of pixels on the image sensor per 1mm (pixel density on the sensor) .
Thus, the smaller the size of the image sensor  is and the more pixels  on it - the higher lens
resolution must be in order that the lens does not spoil the resolution of the camera .
 

At the top box you can specify the number of line pairs per millimeter (lp / mm), and in the box
below ( % contrast ) you should enter contrast drop in % according to MTF (Modulation Transfer
Function) at the specified value of lp / mm.
 

In the 3D Video  window image resolution will be limited by values in these boxed. If N/A is
chosen, then the lens resolution limitation is disabled.
  

You can also simulate the camera resolution . When the lens resolution simulation and camera
resolution simulation are both enabled, then their effects are summarized.
 

You can check resolution visually using the Test chart . 
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9.6 3D World

Graphics window
Main menu

View
3D World

The 3D World window allows you to see the work project with cameras and view areas in three-
dimensional representation. For detailed examination of the object the 3D World has special 3D
tools  .
 

Placing and editing of objects is carried out in the horizontal projection  of the the Graphics
window . In the 3D World you can see the result of these actions.
 

You can change size of the 3D World by dragging its borders by mouse.
 

Camera height above the zero ground in the 3D World are the sum of the installation height of the
camera  and the base height  of the camera. Heights of constructions  and 3D models
are the sum of the  height of the objects above the ground  specified in the Graphics window and
the base height of the layout  to which the object belongs. These and other tools allow you to
work with complex multi-level projects, use three-dimensional models of multi-storey buildings.

Like the 3D Models  window, the 3D World consists of display area and panels with tools, divided
into tabs:
 

Navigation
View
Cutting

Below the tabs is a line with coordinates of a point in the 3D space over which the cursor is located .
Below there is the Save and Print  button, intended for export, save and print the contents of the
3D World window.

See also: 3D Video , 3D Models
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9.6.1 Navigation

On the Navigation tab there are tools for
navigation, using them you can view the
current layout  in 3D.

Using the 3D interface, you can consider in
detail the features of placing cameras, "visit"
in the premises of the 3D model-building,
"walk" on the floors, etc.

Functions of mouse buttons
 

On the left mouse button the Orbit   is assigned - moving  the mouse cursor with the left
button pressed rotates the 3D model in the space (or rotates the virtual viewer around the 3D
model);

 

Function of the left button can be changed .
You can lock  the rotation in vertical planes , leaving only the horizontal rotation , by check ing the 
Lock>Vert. orbit  checkbox .
 

On the middle mouse button the Move  is assigned - moving 3D model in the field of view
plane;

 

On the rotation of the mouse wheel the Zoom  tool is assigned - wheel rotation zooms in or
out the point in the 3D space, where the mouse cursor is. 

 

Pressed Ctrl reduces step of zooming;
Step and direction of zooming by turning the mouse wheel can be changed widely using 
Navigation>Scale factor  in the Options box .
 

On the right mouse button the Look around Look around   is assigned  - rotates the sight
direction standing the virtual viewer stationary.
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Layout size
 

Sizes of the whole layout on the screen in the format X:Y:Height. 

3D navigation buttons
 

By these buttons you can change function of the left mouse button. 

Orbit  - moving  the mouse cursor with the left button pressed rotates the 3D model in the
space (or rotates the virtual viewer around the 3D model). 
This is default function of the left mouse button.
You can lock  the rotation in vertical planes , leaving only the horizontal rotation , by check ing the 
Lock>Vert. orbit  checkbox 
 

Move  - moving 3D model in the field of view plane.
This is default function of the left middle mouse button. The middle mouse button works like in
the Graphics window .
 

Zoom  - moving the mouse cursor along vertical zooms in or out the point in the 3D space at
the center of the display area. By double clicking in the display area you can specify a new
center point. 
Wheel rotation zooms in or out the point in the 3D space, where the mouse cursor is. The Zoom
tool works like in the Graphics window.
 

Pressed Ctrl reduces step of zooming;
Step and direction of zooming by turning the mouse wheel can be changed widely using 
Navigation>Scale factor  in the Options box .
 

Look around  -  rotates the sight direction standing the virtual viewer stationary.
This is default function of the right mouse button.
 

Walk - controls movement of the virtual viewer in virtual horizontal plane. Pressing the left
mouse button fixes the starting point, moving the cursor from the starting point with left mouse
button pressed sets the direction and speed of movement.
 

Zoom frame . Pressing the left mouse button specifies the first point of the zoom frame,
moving the cursor with left mouse button pressed and releasing the left mouse button generates
the ZOOM frame. After releasing the mouse button the virtual viewer will approach to content of
the frame.
 

This tool works like the function of the right mouse button  in the Graphics window.

Fixed views buttons
 

Allow to quick look at the model from any of 6 sides: Front view, Left view, Right

view, Back view, Top view, Bottom view.

Lock panel
 

On the panel there are checkboxes, which can fix some of parameters that can be useful when
navigating in the 3D space.
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Height of viewer - fix the height above the ground of the virtual viewer;
Viewer tilt - fix tilt of the sight direction of the virtual viewer;

Vert. orbit - disable rotation in vertical planes by the Orbit   , leaving only the horizontal
rotation.

Step backward and Step forward buttons
 

Allows to move on the chain of previous views backward and forward.

Sight direction of the virtual viewer
 

Sight direction of the virtual viewer in vertical and horizontal planes and its view angle are
represented as a camera. The blue digits display the height of the virtual viewer above the ground.

View angle of virtual viewer slider
 

The slider allows to change view angles of the virtual viewer. Vertical angle value is displayed
on the caption of the window.
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9.6.2 View

On the View tab there are tools to controls
visibility of elements in the 3D space. 

Light
 

The Light slider allows you to change the light level on the layout, and a combo box located next
to - the direction of light. These tools allow you to highlight dark or light areas located at different
angles to the viewer.

3D view area
 

The 3D view area  checkbox allows to hide 3D view areas of all cameras at once. 
 

You can switch ON/OFF 3D view areas of separate cameras using the   3D View area
button on the Toolbar of Graphics window.

Four checkboxes located on the sides of the
rectangle are used to hide individual faces of
view areas, for a more detailed studying their
borders.
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Color of faces is determined by the same rules
as the color of view area filling  in the
Graphics window:

If the line type of camera  coincides with
default line type for camera icons, specified
in the Options box , then for this camera
faces are filled by Gray color. (Camera 32)

 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, then for this camera faces are filled
by a color determined by  color of the line
type (Camera 33,34).

 

If the Spatial resolution  is enabled, then
colors of filling faces is determined by
Spatial resolution parameters (Camera
35,36).

 If Off is chosen in the Fill projections  and
Shadows , then filling view area faces in the
3D World is not shown. 

Faces of 3D view areas are built taking into
account shadows from surrounding objects.
Automatic calculation of shadows can't be
disabled, but it is performed only for the active
camera . For other cameras shadows are
displayed from memory, in the form when this
camera was active. If surrounding objects of a
camera were changed, or a new camera was 
pasted , to update the shadows activate
this camera.
 

To recalculate 3D view areas of all cameras on
the current layout use the Recalc . button.
 

To make a construction  considered as an obstacle in the calculation of shadows of the 3D
view areas in the 3D World :
 

Line type of the construction must have the checkbox Shadow  marked ;
The construction must belong to a layer with the field Shadows  marked;

 
To make a 3D model  is considered as an obstacle in calculation of shadows of the view areas
in the 3D World :
 

Line type of the instance of the 3D model must must have the checkbox Shadow  marked;
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3D model must belong to a layer with the field Shadows  marked;
The instance of the 3D model , must have checkbox Shadow  on the Current construction
parameter panel  marked or the Shadow  checkbox on the View tab, 3D Models
window must be marked .

 

Calculation of shadows in the 3D World works independently on the calculation of shadows  in
the Graphics  window and in complicated environment it works more roughly but much faster.
 

Accounting for 3D models as obstacles in the 3D World does not depend on the state of the
checkbox Calculate shadows from 3D models  in the Options box. Using this checkbox it is
convenient to disable calculation of shadows from 3D models only in the Graphics window, where
this calculation requires a lot of resources, but leave the calculation of shadows from 3D models
in the 3D World.
 

3D models of view areas can be exported  to *.dxf file. The *.dxf files can be imported by many
3D design software, for example SketchUP .

Recalc.
 

Faces of 3D view areas are built taking into account shadows from surrounding objects.
Automatic calculation of shadows can't be disabled, but it is performed only for the active camera

. For other cameras shadows are displayed from memory, in the form when this camera was
active. 
 

Click this button launches procedure of recalculating 3D view areas of all cameras on the current
layout in the 3D World. During the procedure all cameras are activated  sequentially.

Transparence
 

Using the Transparence combo box you can change transparence of  3D view area faces  and
active camera coverage . 3D view area of the active camera has lower transparency (highlighted
by color strength).
 

See also: Transparence in the Graphics window .

Coverage
 

The  Coverage checkbox allows to switch ON/OFF displaying active camera coverage on
surrounding objects. The coverage is calculating and displaying for the active camera  only.

Color of the coverage is determined by the
same rules as the color of view area filling
in the Graphics window and color of 3D view
area faces :

If the line type of camera  coincides with
default line type for camera icons, specified
in the Options box , then for this camera
the coverage is filled by Gray color. (Camera
32)

 

Default line type for cameras is Line 21.
 

If another line type was assigned to the
camera, then for this camera the coverage is
filled by a color determined by  color of the
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line type (Camera 33).
 

If the Spatial resolution  is enabled, then
colors of filling coverage is determined by
Spatial resolution parameters (Camera
34,35).

Objects can be considered as obstacles or
not, according to the same rules as in
calculating shadows. 

To make a construction  considered as an
obstacle in the calculation of the coverage in
the 3D World :
 

Line type of the construction must have the
checkbox Shadow  marked ;
The construction must belong to a layer
with the field Shadows  marked;

 
To make a 3D model  is considered as an obstacle in calculation of the coverage in the 3D
World :
 

Line type of the instance of the 3D model must must have the checkbox Shadow  marked;
3D model must belong to a layer with the field Shadows  marked;
The instance of the 3D model , must have checkbox Shadow  on the Current construction
parameter panel  marked or the Shadow  checkbox on the View tab, 3D Models
window must be marked .

 

Accounting for 3D models as obstacles in the 3D World does not depend on the state of the
checkbox Calculate shadows from 3D models  in the Options box. 
 

Calculation of coverage in the 3D World works independently on the calculation of shadows  in
the Graphics  window and in complicated environment it works more roughly but much faster.

You can adjust transparence  of the coverage, resolution  of coverage calculation and adjust
deleting inner faces  formed in the view area by obstacles. 

If the Dome   mode is chosen for the
active camera then the coverage displays the
territory controlled by the camera in 360
degrees, without view area borders, but only
taking into account the shadowing.
 

When the Dome item is chosen, actually the
control area of an ideal dome (PTZ) camera
wish spherical 360-degree FOV is displayed.
 

The Dome mode is also useful for choosing
the best installation place for fixed cameras to
make required areas reachable for the
cameras.
 

In the Dome mode all shaded areas from the
specified camera position become visible.
 

In the Dome mode the Spatial resolution  is
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calculated without taking into account pan and
tilt angles of camera. It is assumed that the
camera can pan and tilt freely, and spatial
resolution is calculated at the center of the
field of view.
 

Coverage calculations in the Dome mode
requires a lot of computing resources. To
increase speed of image refresh, reduce the 
Resolution  of calculating the coverage.
 

 3D models of the coverage can be exported  to *.dxf file. The *.dxf files can be imported by
many 3D design software, for example SketchUP .

Resolution
 

In the box, you can select the resolution of the camera coverage  calculation. The higher the
resolution is, the more accurate the calculation, but the more time is needed to redraw image in
the 3D World.
 

Coverage calculations in the Dome  mode requires a lot of computing resources. To increase
speed of image refresh, reduce the Resolution of calculating the coverage.
 

When you export  the coverage to DXF file, it is recommended to set the minimum required
resolution to make DXF file of low size and its processing takes less time.

Inner faces
 

Shading from obstacles forms new internal faces (see Fig.) The inner faces in most cases spoil
the view of the camera coverage.
 

Coverage with inner faces Coverage without inner faces
 

By changing the parameter in the combo box, you can adjust the removal of inner faces with
minimum loss of coverage. The smaller the value in the box, the more fully the inner faces is
removed, but the more parts of real coverage can be removed together with them. The more the
parameter is, the less carefully the inner faces is removed. If you choose leave, then the inner
faces will not be deleted.

Cameras, Illuminators, Camera names, Grid, Background, Textura
 

These checkboxes allow to show/hide Cameras, Illuminators , Camera names, Grid,
Background in the 3D World.
 

Font of camera names can be changed in the Options box .
 

350

355

611

348

349

355

206

477



Interface 351

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

The Texture checkbox allows you to disable texture of 3D models  with textures. Disabling
texture increases the speed of redrawing complex 3D models and hides an excessive amount of
detail, allowing you to concentrate on the 3D model geometry.

Ground panel
 

On the panel you can switch ON/OF displaying ground surface. You can set color, height relative
to the zero ground. 
If the Active camera  checkbox is checked, then height of the ground is kept equal to the base
height  of the active camera.
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9.6.3 Cutting

The tab is intended to manage six clipping
planes. Using the cutting  you can left visible
only the desired area in arbitrarily complex 3D
model. Clipping is useful when designing CCTV
indoor a large building, using 3D model of the
building.
 

You can also hide individual objects (Hide
tool) and separate layers .
 

Cutting
 

Switch ON/OFF using cutting.

At layout size
 

If the checkbox is checked, then cutting plane positions are calculated automatically by limiting
objects on the layout. The Cutting on Height , Width cutting (X) and Depth cutting (Y) panels
become inaccessible.

 

To form stable work  area it is recommended to place limiting objects (for example - points ) on
the corners of the layout.

Cutting on Height panel
 

In the Top and Bottom combo boxes you can set heights of upper and lower cutting planes. The
heights are set relative to the zero ground.
 

The boxes are accessible when the At layout size  check box in not checked.
 

You can set the position of horizontal cutting plane directly on the 3D image. To do this, click  the

button with a knife   or . The mouse cursor changes to a knife. After that, specify the
position of the clipping plane by clicking directly on the 3D image.
Click  on any object, but not on the free space.
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To set the clipping plane on the limit of the layout (disable one of clipping planes), click the button

with a knife   or , and then click on the free space on the layout where clipped objects
were. 

Width cutting (X) and Depth cutting (Y) panels
 

Positions and directions of X and Y axis correspond to view of the layout in the Graphics

window and view in the 3D World after clicking on the Top view  button.  
 

In the Left and Right, Front and Back combo boxes you can set distances of the clipping planes
from the front left corner point on the layout.
 

The boxes are accessible when the At layout size  check box in not checked.
 

You can set the position of cutting plane directly on the 3D image. To do this, click  the button

with a knife ,   or , . The mouse cursor changes to a knife. After that, specify the
position of the clipping plane by clicking directly on the 3D image.
Click  on any object, but not on the free space.

To set the clipping plane on the limit of the layout (disable one of clipping planes), click the button

with a knife ,   or , , and then click on the free space on the layout where clipped
objects were. 
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9.6.4 Save and Print

Click on the button opens a menu. With the help of the menu you can save and print image on the
3D World, as well as export 3D view areas and coverage to DXF files. 

Multiply resolution
 

You can get images with resolution (size in pixels) larger than the size of the 3D World window
and even larger than the size of screen in Windows. The item opens a submenu where you can
select a multiplication factor of image resolution when saving and printing relative to image
resolution in the 3D World.

Save as
 

The item opens a submenu where you can select format of output file with image from the 3D
World. 
 

You can increase  size in pixel of the output file.

Copy to clipboard
 

Copy image from the 3D World to Windows clipboard.  After that the image can be pasted to
other program, for example MS Word. 
 

You can increase  size in pixel of the output file.

Export 3D view areas to dxf
 

Export displayed in the 3D World view areas  to AutoCAD DXF file. View areas are exported with
shadows, lens distortion ,  spatial resolution , in the same form as displayed.
View areas are exported as AutoCAD blocks. To attributes of the block the most important
parameters of the camera are recorded: Name, Model, Lens focal length, Height of installation,
Base height, Heights of view area lower and upper bounds, View angles, Number of pixels, Spatial
resolution pattern. 
Obtained DXF file can be imported into the most of general 3D design software, for example 
SketchUP .
 

This feature allows the convenient scheme of work  with combination of 3D BIM Software
(SketchUP) + VideoCAD.
1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with the
original layout in 3D.
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See also: Export coverage to dxf , Export 3D view areas to general 3D design software

Export coverage to dxf
 

Export displayed in the 3D World active camera coverage  with 3D view area to AutoCAD DXF
file. The coverage is exported with shadows, lens distortion ,  spatial resolution , in the same
form as displayed.
Obtained DXF file can be imported into the most of general 3D design software, for example 
SketchUP .
 

This feature allows the convenient scheme of work  with combination of 3D BIM Software
(SketchUP) + VideoCAD.
1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with the
original layout in 3D.
 

The Coverage is exported in the form of 3D polygon mesh. Mesh resolution, and hence the number
of polygons is determined by the Resolution  of calculating coverage. If the resolution is set to
Normal or High, it will produce a large number of polygons, the exported file will be huge and it
takes a lot of processing time.
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See also: Export 3D view areas to dxf , Export 3D view areas to general 3D design software

Printer setup
 

Open standard printer setup dialog.

Print
 

Print image from the 3D World on the current printer. 
 

You can increase  resolution of the printed file.
 

See also: Drawing>Print
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9.7 3D Video

Graphics window
Main menu

View
3D Video

 

The 3D Video window is designed for 3D modeling images from the active camera. 
 

3D Video can display: 
 

Ground surface. The ground color is set on the tab 3D modeling  in the Options Box. In
multi-level 3D projects the height of the ground equals to the base height  of active camera.

 

Grid. The presence, step and location of the grid are determined by the similar grid parameters
 in the graphics window.  

 

Background . The Background is not visible by default. You can make the background visible
on the View  tab of the Image parameter panel  or in the Main menu of 3D Video.

 

3D constructions; represent stretched throughout the height 2D constructions  in the graphics
window. 

 

3D models. These are prepared 3D models of people, cars and other objects. See more: 3D
model  

 

3D images. Usual raster images can be placed in the 3D space. See more: 3D image
 

Illuminators. Illuminators  Cameras are represented as 3D models .
 

Cameras. Cameras are represented as 3D models .  
  

Virtual post on which the active camera is installed. Allows to see the active camera installation
place projection on the ground. The post is nor displayed by default. You can make the post
visible in the View  tab of the Image parameter panel

 

Test object . Is visible in the graphical editing state  of the active camera as the
parallelepiped with numbers on sides. 

 

The fragment of the test chart EIA1956 for the visual estimation of the current horizontal and
vertical resolution. 

 

 Titles . At the left top corner the main image parameters are displayed.

Visibility of these objects can be switched on/off separately for each camera on the View  tab on
Image parameter panel . Visibility of some objects can be switched in the Main menu  of the
3D Video.

 

Location and editing these objects are carried out in the horizontal projection of the graphics
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area . In the 3D Video the result of these actions can be observed.  

3D Video allows to: 
 

model different situations of the person detection and identification and license plate
reading and any digital symbols in different sections of the view area, taking into account video
quality parameters ;

 

adjust person detection, identification and license plate reading criteria  according to
the personal demands;

 

disclose the view area distortions, arising from obstacles;
 

compare camera models, choose model with optimal parameters for the current task;
 

choose type, power and places of luminaries;
 

model resolution of megapixel cameras  which exceeds screen resolution;
 

save  obtained images in the static files or animated  *.gif files;
 

see at the design stage that, for what the video surveillance system is made - images from
video cameras.

 

In the 3D Video it is possible to model static and animated  images rather precisely
considering parameters of the scene (illumination, illuminators, visibility range), cameras
(sensitivity, resolution, color, exposure time, rolling shutter, interlace distortions, frame rate),
lenses (focal length, F-number, resolution, distortion) and DVR (resolution, compression,
brightness, contrast, sharpness). The parameters can be adjusted on the Image parameter panel

 and in the Sensitivity and Resolution  box.
 

By default illumination and resolution modeling is disabled, only view area is modeled.

 If image in the 3D Video is distorted, redrawing the image is too long or there are other artifacts,
see Errors in rendering 3D images .

See also: 3D Video main menu , Image parameter panel , 3D model , 3D image ,
Illuminator , Illuminator calculation , Sensitivity and Resolution , Errors in rendering 3D
images ,3D World , 3D Models
External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
. 
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9.7.1 Main menu

In the Main menu there are commands of image saving and printing and a part of image parameter
adjustments, which duplicate adjustments on the Image parameter panel  for faster access. All
image parameters are presented on the Image parameter panel. The panel can be called by right or
double clicking on the image in the 3D Video.
 

The menu is divided into groups according to the order of image processing from the camera:
Image - saving and printing current image in the 3D Video;
Scene - parameters of the scene;
Camera - parameters of the camera;
Processing - processing the obtained image, by the camera and other CCTV equipment;
View - visibility of auxiliary objects on the image model;
Speed - fast switching between redrawing speed and exactness of modeling 3D images.

Image
Real frame size
Save as *.bmp ( *.jpg, *.gif, *.tif, *.png)
Save as animated  *.gif
Copy to clipboard
Printer setup
Print

 

Scene
According to camera parameters
Day/Night
Lamp position
Model illumination
Illuminators
Meteorological visibility
Show panel

 

Camera
Model
Depth-of-field
Exposure
Show panel
Sensitivity and Resolution

Processing
According to camera parameters
One field
Brightness
Contrast
Compression
Show panel

 

View
According to camera parameters
Title
PTZH frame
Background
Ground surface
Test chart
Show panel

 

Speed
Disable image processing
Redraw 3D image only by clicking
 

Help

Image > Real frame size
 

If this item is checked , the frame from the 3D Video will be saved or printed with its real size in
pixels , regardless of the size of the 3D Video window .
 

The frame size is specified in the Sensitivity and Resolution  box and in the Image parameter
panel > Processing  tab.
 

This tool as well as the PiP  tool, allows modeling megapixel images .
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When modeling distortion  is enabled and the Real frame size is checked, the obtained images
will have real resolution of distortion ( distortion without this tool is modeled only at a lower
resolution ) . Another way to get the real resolution with lens distortion - see PiP .
 

Generation of frames with size more than the 3D Video window size or generation of frames with
distortion requires additional time and computer resources.
Depending on the capabilities of your video card and computer may be some problems with large
size images , especially when modeling large images with distortion  . If errors occur , try to
disable distortion or decrease the frame size 
 

The Real frame size .item doesn't affect to animated images .

Image > Save as *.bmp ( *.jpg, *.gif, *.tif, *.png)
 

Save the static image in the 3D Video in any format from the following:  *.bmp, *.jpg, *.gif, *.tif, *.png.
 
These items are inaccessible , when the image is animated, the Animate  box is checked and
Number of frames  is more than one.

 

See also: Real frame size .

Image > Save as animated *.gif
 

Save the animated image in the 3D Video in the animated *.gif format.
This item is inaccessible , when the image is not animated, the Animate  box is not checked or
Number of frames  equals one. 

 

The Real frame size .item doesn't affect to animated images.

Image > Copy to Clipboard
 

Copy the image to Windows clipboard. 
After that the image can be pasted into other program.

Image > Printer setup
 

Choosing this item opens a standard dialog box of current printer setup in Windows.

Image > Print
 

Print image in the 3D Video.
 

See also: Real frame size , Drawing>Print

 

Scene > According to camera parameters
 

Different cameras can be in various conditions and consequently for different cameras scene
parameters can be different. 
If this item is checked, scene parameters are set according to scene parameters of active camera. As
a result of activation of other camera, scene parameters will be changed according to scene
parameters of this camera. Manual changing scene parameters is disabled.
 
If this item is not checked, scene parameters could be specified manually. The set parameters will not
be changed during activation of different cameras.
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See also: Image parameter panel >Scene , Save

Scene > Day/night
 

During the day, scene of the same camera can be essentially changed. In daytime there is
predominance of the natural illumination, and at night artificial one. In daytime the sky is much brighter
than the ground, and at night it is darker (because of the predominance of artificial illumination).
Therefore for each camera 2 sets of scene parameters are specified: for day and night time. 
If this item is checked, scene parameters of day time is used, otherwise scene parameters of night
time is used.
 

The effect of this item is applied to all cameras at once. Actually it is a switch of time in the project.
The same switch is available in the Monitor window .
 

See also: Image parameter panel >Scene

Scene > Lamp position
 

The item opens a submenu, in which the Lamp position relative to the active camera can be chosen. 
 

Background light source produces background scene illumination. Except the background light source
on a scene it is possible to place illuminators .
 

See also: Image parameter panel >Scene

Scene > Model illuminantion
 

If this item is checked, during 3D image generation, scene illumination parameters , illuminators
and camera sensitivity  are considered. 
 

Image generation time can considerably increase.
 

If the item is not checked, illumination is not considered, only camera view area is modeled.
 

Illumination modeling can be switched on separately for each camera, for day time or night time.
 

See also: Image parameter panel >Scene

Scene > Illuminators
 

If this item is checked, during 3D image generation, switched on illuminators , placed on the scene,
are considered.
If the item is not checked, the illuminators are not considered.
 

The item is accessible only if illumination modeling  is switched on.
 

Illuminators can be switched on separately for each camera, for a day time or night time.
 

See also: Image parameter panel >Scene , Illuminator

Scene > Meteorological Visibility
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The item opens submenu, which can help to model
meteor, limiting visibility range (rain, snow, fog,
sandy storms, etc.).

Meteorological Visibility is the greatest distance at which it is just possible to see with the unaided
eye:

in the daytime, a prominent dark object against the sky at the horizon;
at night, a known, preferably unfocused, moderately intense light source. 

This parameter is reported in a weather forecast, and can be also visually determined.
 

Rough values of Meteorological Visibility for various weather conditions according to data of
meteorologists:
 

Rain, weak snowfall, smoke - 900-1000 m
Medium snowfall, weak fog - 500 m
Medium fog, strong snowfall - 100-500 m
Thick fog - less 100 m.

Pay attention to the following moments:
 

Meteorological Visibility does not coincide with the maximal person detection range. Meteorological
Visibility is calculated in respect of black big size object against background of fog or sky. Maximal
person detection range, limited by visibility, is 1.5-2 times less at the average depending on contrast
between background and person's clothes.
 

At surveillance in the night time and at illumination from the camera the maximal detection range is
considerably reduced due to light reflection from fog (rain or snow).
 

At modeling the threshold of eye contrast sensitivity 0.03 is accepted.
 

Quality of visibility range modeling has a great dependence from video card's opportunities and its
adjustments. Modern 3D-accelerator allows getting excellent quality of modeling. At the same time
without the accelerator, accurate modeling  fog is insufficient.
 

See also: Errors in rendering 3D images

Scene > Show panel
 

Show the Scene  tab on the Image parameter panel. On the tab all scene parameters are
presented. In the main menu there is only a part of the parameters.
 

See more: Image parameter panel >Scene

Camera > Model
 

Show the Table of camera models. In the table it is possible to set parameters to models and
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assign any model to the active camera. 
 

See more: Table of camera models

Camera > Depth-of-field
 

The Item opens submenu, which makes possible switch on unitary or permanent depth-of-field
modeling. Initial data (lens focal length, aperture and focus distance) are set in Depth-of-field box

. Clicking the Parameters item it is possible to display this box.  
 

More detail about Depth-of-field see General information about Depth of field in CCTV .
 

Modeling Depth-of-field takes much time (depending on complexity of scene, video card's and
computer's opportunities (from several seconds to one minute), therefore it is not recommended to
mark needlessly the item Model permanently, otherwise the program will work very slowly.
 

Quality of modeling considerably depends on video card's opportunities and its adjustments. If depth
of field modeling does not work  or works incorrectly, try to change adjustments of video card hardware
acceleration.
If in your video card there is no hardware support of this function, Depth of field should be modeled at
completely switched off hardware acceleration (the slider is moved to the left). However in this case
quality of other parameters of image is worsened.
 

See also: Errors in rendering 3D images

Camera > Exposure
 

The Item opens submenu, which makes possible switch on unitary or permanent exposure time
modeling. 
This item duplicates corresponding panel  on the Camera tab on the Image parameter panel.
 

Modeling Exposure time takes much time (depending on complexity of scene, video card's and
computer's opportunities (from several seconds to several minutes), therefore it is not recommended to
mark needlessly the item Model perm., otherwise the program will work very slowly.
 

Quality of modeling considerably depends on video card's opportunities and its adjustments. If
modeling exposure does not work  or works incorrectly, try to change adjustments of video card
hardware acceleration.
If in your video card there is no hardware support of this function, exposure should be modeled at
completely switched off hardware acceleration (the slider is moved to the left). However in this case
quality of other parameters of image is worsened.
 

See also: Errors in rendering 3D images

Camera > Show panel
 

Show the Camera  tab on the Image parameter panel. On the tab the active camera parameters
are presented. In the main menu there is only a part of the parameters.
 

See more: Image parameter panel >Camera

Camera > Sensitivity and Resolution
 

Show the Sensitivity and Resolution  box in which there are parameters of sensitivity and resolution
of the active camera.
 

Sensitivity parameters take part in modeling only if 3D Video  is opened and illumination modeling
 is switched on.
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See more. Sensitivity and Resolution

Processing > According to camera parameters
 

Images from different cameras can be processing by various means and consequently for different
cameras the processing parameters can be different. 
If this item is checked, processing parameters are set according to processing parameters of the
active camera. As a result of activation of other camera, processing parameters will be changed
according to processing parameters of this camera. Manual changing processing parameters will be
disabled.
 

If this item is not checked, processing parameters could be specified manually. The set parameters
will not be changed during activation of different cameras.
 

See also: Image parameter panel >Processing

Processing > One field
 

If this item is checked, the vertical resolution of the image sensor  is reduced in half.
Vertical resolution decreases, if video signal from a camera with interlace scan is captured by fields
(half frames), instead of full frames. For example, 768x288 pixels.

Processing > Brightness
 

The item opens a submenu, in which the image brightness can be chosen. 

Processing > Contrast
 

The item opens a submenu, in which the image contrast can be chosen. 

Processing > Compression
 

The item opens a submenu, in which the image compression level can be chosen. 
 

Compression levels may differ from the compression levels in the settings of different DVR or IP
cameras. To determine a correspondence use the visual image comparison. 
 

Obtained image compress by the JPEG algorithm for approximating the image in the 3D Video to the
real image from video cameras to exactly  estimation the possibilities of detection, identification and
reading 
 

Using in your DVR algorithms different from JPEG is not generally an obstacle for compression
modeling with the help of JPEG algorithm. Although other algorithm artifacts differ from JPEG artifacts,
the general amount of information correspondence that can be determined by the careful visual image
comparison is enough for modeling.      

Processing > Show panel
 

Show the Processing  tab on the Image parameter panel. On the tab the image processing
parameters are presented. In the main menu there is only a part of the parameters.
 

See more: Image parameter panel >Processing
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View > According to camera parameters
 

You can set visibility of additional elements separately for different cameras. 
If this item is checked, visibility of additional elements are set according to parameters of active
camera. As a result of activation of other camera, visibility of additional elements will be changed
according to parameters of this camera. Manual changing visibility of additional elements will be
disabled.
 

If this item is not checked, the visibility could be specified manually. The set visibility will not be
changed during activation of different cameras.
 

See also: Image parameter panel >View

View > Title
 

Place the following information in the left upper corner of the image: 
 

Name of the layout  on which the active camera is placed.
Active camera name.
Current image sizes in pixels.
Current image resolution in pixels (Image) and 3D Video size (Screen) separately, when the image
resolution differs from the 3D Video size; 

For panoramic  cameras the Image line displays a virtual number of pixels for correct simulation of
resolution of panoramic camera. The simulated resolution is exact only at the center of the frame.
Towards the edges of the frame the actual resolution is worse than simulated. The smaller the view
angle, the more accuracy of simulating resolution on the edges of the frame. 

Resolution in LPH (lines per pixture height, equals to TV-lines for analog cameras) in case of it can
be calculated. 
Brightness and Contast if these parameters are differed from default.
Image compression, if it is used.
The grid  step, if the grid is displayed. 
Calculated unweighted signal/noise ratio of the image, if illumination modeling  is switched on.
Calculated IRE of the image, if illumination modeling  is switched on.
Frame rate (fps), when image in the 3D Video is animated .
Exposure time (milliseconds) when exposure  is modeled.

View > PTZH frame
 

PTZH frame (Pan-Tilt-Zoom-Height) allows operating camera similarly to PTZ one and additionally
change camera's installation height. 
 
 

After clicking this item the camera's field of view
extends, and the objects being off view area, for
increasing the convenience of camera's
adjustment, become visible. Real field of view is
limited by orange frame.
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Above the frame the buttons, which changes view area upper bound distance   and view

area upper bound height  ., are located. Current distance and height values are digitally
shown under the buttons.

It is recommended to set view area upper bound height, which is equal to maximal height of
observed objects, and do not change it further. Further adjust camera's inclination by changing only
the view area upper bound distance.
 

On the right and to the left of the frame there are camera rotation buttons   . 
 

Under the frame there are buttons, which change the height of camera installation  . Current

value of height is digitally shown above the buttons. Near by them the  lens focal length  
combo box is located. Value in the box can be selected from the list or entered from the keyboard.
 

Using these tools it is possible to rotate the camera in both planes, change lens focal length and
height of installation. 
 

To change the position on one step click corresponding button. For continuous moving bring the
cursor to the button, then press it and do not release the left mouse button. For precise position
adjustment do the same, but with pressed Ctrl. 
 

In the PTZH frame mode you can pan and tilt the camera by moving the image like moving drawing in
the Graphics window. Press left mouse button, move cursor with the button pressed then release the
mouse button. Camera tilt angle is changed through changing view area upper bound distance. But
when Ctrl is pressed, the tilt angle is changed through changing view area upper bound height.
You can pan camera using arrow keys.
 

Frame PTZH disables image processing,  titles  and animation . 
  

Together with Monitor window  this tool offers a new method  of 3D CCTV design.
 

If a model  is assigned to the camera, and the model has fixed  focal length lens, then you can
not change the focal length.
 

If a model is assigned to the camera, and the model has a lens with limited  variable focal length,
then you can change focal length within the limits only. When approach to the limit values, the box will
become crimson.
 

You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned model
or the assigned model have not specified limits of the lens focal length.
 

 Changing the lens focal length and therefore the calculated values of view angles of camera with
enabled modeling lens distortion  will lead to detuning parameters of distortion and warping view
area form. To correct the mismatch you should set new values of the actual view angles , tak ing
into account the changed values of calculated view angles.

 

The PTZH frame simulates lens distortion  in simplified way. Only border of the field of view is
drawn without modeling optical distortion of the image.

 

View > Background
 

301

298

296

294

386 386

407 546

419 438

438

310

310

310



Interface 367

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Show or hide a background in the 3D image. 

In case of vector background you can adjust 
background resolution  in the 3D Video.

 

See more: Background , Background resolution
 

View > Ground surface
 

Show or hide ground surface. Ground color can be set on the 3D modeling  tab on the Options
box. 
 

In multi-level 3D projects the height of the ground surface equals to the base height  of the
active camera.

View > 3D view areas
 

Enable in the 3D Video visualization of view

areas of cameras with 3D view area  

enabled.  View areas are shown in the form of

pyramids.
  

If the line type of camera  coincides with
default line type for camera icons, specified in
the Options box , then sides of the view
area are filled by different colors by default
(Camera 7 on the figure).
 

If another line type was assigned to the
camera, then filling view area of this camera is
performed by a color (3D>Color) of this line
type assigned to the camera. (Camera 5,9).
 

If the Spatial resolution    is enabled,
then colors of filling projections is  determined
by Spatial resolution parameters (Camera 1,8).

 

View of  3D view area of the active camera can

be adjusted by buttons on the Toolbar  

View area edges ,    Fill projections

,    Spatial resolution .
 

Transparency of the 3D view areas can be
changed with transparency of view area
projections in the Graphics window, in the 
Transparency box in the Camera icon tab in
the Options box.
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The 3D view areas can be limited by the
maximum distance from the camera by using
the Camera geometry> Maximum distance of
drawing view area .
 
To display the 3D view areas in VideoCAD
Professional there is a special window - 3D
World , it offers much more powerful tools
for view area visualization.

View > Test chart
 Place at the right top corner the image fragment of the standard test chart EIA1956 for the visual
estimation of the current horizontal and vertical resolution. 
The Test chart shows resolution in  lines per picture height (LPH) regardless of the Aspect Ratio

.
 

Result of measuring resolution by this fragment of EIA1956 test chart equals to the modern  ISO
12223.  Use of EIA1956 is caused that it is more compact.
 

Maximum resolution what can be measured by the middle field without multiplication is 1600 LPH.
With the help of combo box under the Test chart  checkbox on the View tab of the Image
parameter panel, you can increase the size of the chart in 2 or 4 times or reduce the size in
2,4,8,16,32,64 times, and thus expand the range of measured resolution to 50-102400 LPH. 

 

You can simulate the image resolution using the tools Camera>Resolution (LPH) ,
Lens>Resol.(lp/mm) , Processing>Sharpness , Depth of Field .
 

You can get images with the number of pixels exceeds the screen size using the tools Real frame
size  and PiP . 
 

You can measure contrast drop using the TV - lines tool from the CCTVCAD Lab Toolkit
package.
 

See also: 3D Video window , , Real frame size

View > Show panel
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Show the View  tab on the Image parameter panel. On the tab you can show or hide all
additional elements on the 3D image. In the main menu there is only a part of the elements.
 

See more: Image parameter panel >View

Speed > Disable image processing
 

This item duplicates  the same box  on the 3D modeling tab on the Options box.
 

If this box is marked then the image processing will not be modeled.
Modeling gamma, noise, brightness, contrast, resolution, sharpness, compression, titles, animation,
exposure time and depth of field will be disabled.
 

Redraw speed will increase, errors with outdated video cards may be removed.

Speed > Redraw 3D image only by clicking
 

This item duplicates  the same box  on the 3D modeling tab on the Options box.  
 

Modeling complex 3D scenes, especially taking into account illumination, require high computer
performance. 
If the image in the 3D Video is redrawn too slowly and that hinder operation in the Graphics
window, mark this box. After that the image in the 3D Video will be redrawn automatically only at
activation of cameras. To force redrawing click on the image.
 

Help
 

Open the Help system topic with the information about 3D Video.
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9.7.2 Image parameter panel

3D Video
Image parameter panel

 

The panel can be called by right clicking or double clicking on the image in 3D wi 3D Video
ndow  or from the Main menu  of 3D Video.
On the panel it is possible to see and change 3D image parameters and thus to obtain accurate
model of a real image from a real camera.
 

The panel is divided into tabs according to the order of image processing from the camera:
Scene  - parameters of the scene;
Camera  - parameters of the camera;
Processing  - processing the obtained image, by the camera and other CCTV equipment;
View  - visibility of auxiliary objects on the image model.
PiP  (Picture in Picture) - modeling megapixel resolutions with the PiP technology.
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9.7.2.1 Scene

On the tab parameters of the scene in front of the active camera are presented. Scene parameters
include illumination and visibility range. For day and night time separate scene parameter sets are
specified.

Some elements on this panel are duplicated in the Main menu  of the 3D Video.

 According to camera parameters
Day and Night tabs
Background illumination panel

Lamp position
Model illumination

Background light source
Background illumination (lx)
Illuminators

Meteorological visibility
Save to camera

According to camera parameters
 

Different cameras can be in various conditions and consequently for different cameras scene
parameters can be different. 
 

If this box is checked, scene parameters are set according to scene parameters of active camera.
As a result of activation of other camera, scene parameters will be changed according to scene
parameters of this camera. Manual changing scene parameters is disabled.
 

If this box is not checked, scene parameters could be specified manually. The set parameters will
not be changed during activation of different cameras.
 

The box is duplicated  in the Main menu of the 3D Video. 

 

See also: Save, Save to selected cameras

Day and Night tabs
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During the day, scene of the same camera can be essentially changed. In daytime there is
predominance of the natural illumination, and at night artificial one. In daytime the sky is much
brighter than the ground, and at night it is darker (because of the predominance of artificial
illumination).
Therefore for each camera 2 sets of scene parameters are specified: for day and night time. 
If the Day tab is opened, scene parameters of day time is used. If the Night tab is opened, scene
parameters of night time is used.
 

The effect of this tabs is applied to all cameras at once. Actually it is a switch of time in the
project. The same switch is available in the Monitor window  and in the Main menu  of the 3D
Video.

Background illumination panel
 

On the panel there are parameters of the Background light source. Background light source
produces background illumination on the scene. 
 

For simple modeling illumination it is enough to specify parameters of the background light for
each camera. The Illumination produced by background light can be measure by the luxmeter
during the site pre-design investigation.
 

In addition to the background light on the scene you can place Illuminators .

Lamp position
 

The item opens a submenu, in which the Lamp position relative to the active camera can be
chosen. 
Background light source produces background illumination on the scene. 
In addition to the background light on the scene you can place Illuminators .

Model illumination
 

If this box is checked, during 3D image generation, scene illumination parameters , illuminators
 and camera sensitivity  are considered. 

 

Image generation time can considerably increase.
 

If the item is not checked, illumination is not considered, only camera view area is modeled.
 

Illumination modeling can be switched on separately for each camera, for day time or night time.
 

External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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Background light source
 

Using this combo box you can choose type of the Background light source.
 

The combo box is accessible only if illumination modeling  is switched on.
 

Camera sensor spectral sensitivity to different types of light sources essentially differs from human
eye (and luxmeter) spectral sensitivity. For example, luminescent and Incandescent lamps
produce equal scene illumination according to luxmeter reading. But the image from a black-white
camera directed on this scene will not be equal at scene illumination produced by different lamps.
The difference in the equivalent illumination can reach four or more times. Color cameras are
practically insensitive to IR illuminators, and black-white cameras have sensitivity depending on
maximum wavelength of the IR illuminators.
 

VideoCAD considers this difference through in advance determined and experimentally verified
spectral efficiency factors of different light sources for different types of cameras.
 

Choosing type of the light source, you automatically switch on an appropriate set of the spectral
efficiency factors.
 

See also: Illuminator calculation , Measuring spectral efficiency of light source .
 

Background illumination (lx)
 

In the box it is possible to choose from the list or enter from keyboard scene illumination, created
by background light.
Illumination is measured, according to the standard luxmeter reading, in luxes.
If background light source is an infra-red (IR) LED , the background illumination is measured in
Watts/square meter (watt/m2). The IR illumination cannot be measured by an luxmeter. More in
detail see Infra-red illuminators.
Background illumination does not decrease with distance, the scene is illuminated evenly. 
Light source type is selected in the Background light source  combo box, the light direction is
selected in the Lamp position  combo box.
 

The box is accessible and considered in 3D image modeling only if the illumination modeling  is
switched on.

Illuminators
 

If this box is checked, during 3D image generation, switched on illuminators , placed on the
scene, are considered.
If the box is not checked, the illuminators are not considered.
 

The box is accessible and considered in 3D image modeling only if the illumination modeling  is
switched on.

Meteorological  visibility
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Using this combo box you can model meteor,
limiting visibility range (rain, snow, fog, sandy
storms, etc.).

Meteorological Visibility is the greatest distance at which it is just possible to see with the
unaided eye:

in the daytime, a prominent dark object against the sky at the horizon;
at night, a known, preferably unfocused, moderately intense light source. 

This parameter is reported in a weather forecast, and can be also visually determined.
 

Rough values of Meteorological Visibility for various weather conditions according to data of
meteorologists:
 

Rain, weak snowfall, smoke - 900-1000 m
Medium snowfall, weak fog - 500 m
Medium fog, strong snowfall - 100-500 m
Thick fog - less 100 m.

Pay attention to the following moments:
 

Meteorological Visibility does not coincide with the maximal person detection range.
Meteorological Visibility is calculated in respect of black big size object against background of fog
or sky. Maximal person detection range, limited by visibility, is 1.5-2 times less at the average
depending on contrast between background and person's clothes.
 

At surveillance in the night time and at illumination from the camera the maximal detection range
is considerably reduced due to light reflection from fog (rain or snow).
 

At modeling the threshold of eye contrast sensitivity 0.03 is accepted.
 

Quality of visibility range modeling has a great dependence from video card's opportunities and its
adjustments. Modern 3D-accelerator allows getting excellent quality of modeling. At the same time
without the accelerator, accurate modeling fog is insufficient.
 

See also: Errors in rendering 3D images

Save to camera
 

Clicking Save button, the scene parameters, specified on the Scene tab, will be saved in
parameters of the active camera. 
Later on, if the According to camera parameters  box is marked, the saved scene parameters
will be loaded at each activation of this camera.
At modeling monitors  the scene parameters saved in cameras is always used.
 

If at clicking Save button the Save to selected cameras box is marked, scene parameter set on
the Scene tab will be saved in all selected cameras.
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9.7.2.2 Camera

This tab contains the tools for 3D modeling camera parameters associated with the modeling
movement (frame rate, interlacing, exposure time, rolling shutter) and the depth of field.
Tools on this tab can be applied simultaneously to one image, but in this case time of image
generation might increase in the tens or hundreds of times.
 

Camera sensitivity and resolution parameters, lens parameters are available in the Sensitivity and
resolution  box.  
 

See more: about modeling moving 3D models , Rotak in .
See more: about the depth of field .

According to camera parameters
 

Frame rate
Interlace
Exposure (ms)
Rolling shutter
Depth-of-field panel
 

Save to camera

According to camera parameters
 

Different cameras can have different parameters. 
 

If this box is checked, parameters on this tab are set according to parameters of the active
camera. As a result of activation of other camera, parameters will be changed according to
parameters of this camera. Manual changing parameters is disabled.
 

If this box is not checked, parameters on this tab could be specified manually. The set
parameters will not be changed during activation of different cameras.
 

See also: Save, Save to selected cameras

Frame rate
 

In this box you can specify the Frame rate of the Active camera in frames per second. 
The Frame rate is taken into account when modeling animated images  with moving 3D models
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 and Rotakin .
 

If a 3D  model has non zero speed , then

the velocity vector is displayed.
 

If 3D model is in the normal state, the length

of the velocity vector equals to the distance

which the 3D model passes for the period
between successive frames of the active
camera (black arrow).
 

If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model passes
per second (crimson arrow).
 

The length of the velocity vector of a 3D model in the normal state is inversely proportional to

the  frame rate of the active camera. Thus we can see how many times the moving 3D model

gets into the frame of the active camera.

If a model  is assigned to the active camera, and the model has set maximal frame rate ,
then value in this box can not exceed the maximal frame rate.
When approach to the maximal value, the box will become crimson.
You can change frame rate in wide range of cameras, which have not assigned model or the
assigned model have not specified maximal frame rate.
 

See also: Selecting frame rate on the basis of known target's positions and velocities . 
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Interlace
 

The panel is intended for modeling distortion of moving 3D models  and rotating Rotak in
object arising from interlacing of analog cameras (comb effect).

Due to the interlaced scanning, the full frame is
composed of two interlaced fields. The
exposition of the fields is performed
consistently at different times, but the full
frame is displayed on a digital monitor at once,
which causes a horizontal shift of lines of
moving objects.
Analog monitors have interlaced scan, and the
full frame is displayed on an analog monitor
field by field sequentially, therefore on analog
monitors the interlace effect is absent.

 

In the Time interval between fields box you can specify a period between two fields in the full
frame. 
 

In the PAL system this interval equals 20 millisecond (1/50 s), In the NTSC system this interval
equals 16.5 millisecond (1/60 s).

If the Model box is checked the the Interlace will be modeled. 
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Modeling Interlace increases image generation time in several times.
 

See also: Simulating distortions of moving objects arising from Exposure time, Interlace scan
and Rolling shutter , One field
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Exposure (ms)
 

The panel is intended for modeling blur of 
moving 3D models  and rotating Rotakin
object arising from the exposure time (Motion
blur).

The greater the exposure time and the greater
the velocity of an object on the screen, the
more the blur appear.

 

In the Exposure time box you can specify the exposure time of the active camera (shutter time,
shutter speed) in millisecond. 
 

Exposure time of standard analog cameras can not exceed the period between fields. (20ms
(1/50s) for PAL, 16.5ms (1/60s) for NTSC). Automatic electronic shutter reduces actual exposure
time in dependence of scene illumination, camera sensitivity and the aperture ratio of the lens. In
low light conditions exposure time is maximal.
Exposure time of IP cameras and analog cameras with light accumulation can be up to 200-
500ms and more. By increasing the exposure time  increasing the rated sensitivity of these
cameras is achieved, but this leads to blurring of moving objects, for that it does not always pay
attention.
 

If the Get from modeling box is checked, then the expected exposure time is calculated during
modeling sensitivity.
 

Different cameras can have different regularities of variation of exposure depending on the light,
so the possible error in calculating the expected time during modeling sensitivity. Before the
practical use of this feature, you must check it with the camera in use and make the necessary
corrections.
 

The Model button launch the modeling exposure time once. 
 

If the Model perm. box is checked, then the exposure time will be modeled permanently. 
 

VideoCAD offers a technique of measuring exposure time of cameras with an analog
oscilloscope, see: Measuring exposure time of IP camera

Modeling Exposure time takes much time (depending on complexity of scene, video card's and
computer's opportunities (from several seconds to several minutes), therefore it is not
recommended to mark needlessly the item Model perm., otherwise the program will work very
slowly.
 

Realism of modeling exposure can be adjusted by the Model Depth of Field and Shutter  slider
in the Options box.
Quality of modeling considerably depends on video card's opportunities and its adjustments. If
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modeling exposure does not work  or works incorrectly, try to change adjustments of video card
hardware acceleration.
If in your video card there is no hardware support of this function, exposure should be modeled at
completely switched off hardware acceleration (the slider is moved to the left). However in this
case quality of other parameters of image is worsened.
 

See also: Errors in rendering 3D images
 

See also: Simulating distortions of moving objects arising from Exposure time, Interlace scan
and Rolling shutter .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Rolling Shutter
 

The panel is intended for modeling distortion
of moving 3D models  and rotating Rotak in

 object arising from the rolling shutter
effect.  

As a result of Rolling Shutter work , exposure
of different rows of the image sensor begins
and ends sequentially at different times, which
causes a horizontal shift of moving objects.
This effect occurs with many IP cameras with
CMOS image sensor and usually doesn't occur
with cameras with CCD image sensor.

  

In the Row time box you can specify the time period (in microsecond) between the beginning
of exposure of adjacent rows. Unfortunately this parameter is not given in the cameras'
specification. To elucidate the value of the parameter you should contact the manufacturer or
measured this time in practice.

 

VideoCAD offers a technique of measuring row time of rolling shutter with an analog
oscilloscope, see: Measuring rolling shutter row time of IP camera
  

The Row time may vary slightly under different settings of the same camera.
   

The Up checkbox switches direction of scanning strings by the Rolling shutter. Top-down or
Down-top.
 

The Model button launch modeling Rolling Shutter once. 
  

If the Model perm. box is checked, then the Rolling Shutter will be modeled permanently. 
  

Modeling Rolling Shutter takes much time (depending on complexity of scene, video card's and
computer's opportunities (from several seconds to several minutes), therefore it is not
recommended to mark  needlessly the item Model perm., otherwise the program will work  very
slowly.
 

Realism of modeling can be adjusted by the Model Depth of Field and Shutter  slider in the
Options box.
Quality of modeling considerably depends on video card's opportunities and its adjustments. If
modeling Rolling Shutter does not work  or works incorrectly, try to change adjustments of video
card hardware acceleration.
If in your video card there is no hardware support of this function, Rolling Shutter should be
modeled at completely switched off hardware acceleration (the slider is moved to the left).
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However in this case quality of other parameters of image is worsened.
 

See also: Errors in rendering 3D images
See also: Simulating distortions of moving objects arising from Exposure time, Interlace scan
and Rolling shutter .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Depth of Field
 

On the panel you can invoke modeling depth-
of-field  and change depth-of-field
parameters.

Parameters
 

Show Depth-of-field  box. In this box it is possible to change lens parameters (lens focal
length, aperture and focus distance).
 

Auto Iris lens
 

If the box is checked, at depth of field calculation the aperture value , computed during 3D
modeling illumination, will be used. If the box is not checked, the aperture value, specified in the 
box Aperture  (F number) in the Depth-of-field  box, is used.

Model
 

Run depth-of-field  modeling once. Initial data (lens focal length, aperture and focus
distance) are set in Depth-of-field box . Clicking the item Parameters it is possible to display
this box.  
 

If the Model perm. box is checked, then the Depth of Field will be modeled permanently. 
 

Modeling Depth of Field takes much time (depending on complexity of scene, video card's and
computer's opportunities (from several seconds to several minutes), therefore it is not
recommended to mark  needlessly the item Model perm., otherwise the program will work  very
slowly.
 

Realism of modeling can be adjusted by the Model Depth of Field and Shutter  slider in the
Options box.
Quality of modeling considerably depends on video card's opportunities and its adjustments. If
modeling Depth of Field does not work  or works incorrectly, try to change adjustments of video
card hardware acceleration.
If in your video card there is no hardware support of this function, Depth of Field should be
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modeled at completely switched off hardware acceleration (the slider is moved to the left).
However in this case quality of other parameters of image is worsened.
 

See also: Errors in rendering 3D images

Save to camera
 

Clicking Save button, the parameters, specified on the Camera tab, will be saved in parameters
of the active camera. 
Later on, if the According to camera parameters  box is marked, the saved parameters will be
loaded at each activation of this camera.
At modeling monitors  the parameters saved in cameras is always used.
 

If at clicking Save button the Save to selected cameras box is marked, parameter set on the
Camera tab will be saved in all selected cameras.
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9.7.2.3 Processing

In CCTV systems the obtained image undergoes additional processing inside camera or other
equipment. On the tab it is possible to set image processing parameters.
 

Some elements on this panel are duplicated in the Main menu  of 3D Video.

According to camera parameters
 

Image size
One field
Brightness
Contrast
Compression
Sharpness
 

Save to camera

According to camera parameters
 

Images from different cameras can be processing by various means and consequently for different
cameras the processing parameters can be different. 
If this box is checked, processing parameters are set according to processing parameters of the
active camera. As a result activation of other camera, processing parameters will be changed
according to processing parameters of this camera. Manual changing processing parameters will
be disabled.
 

If this box is not checked, processing parameters could be specified manually. The set
parameters will not be changed during activation of different cameras.
 

The According to camera parameters checkbox on the Processing tab is marked
automatically when closing the Image parameter panel to avoid confusion with the resolution of
active and inactive cameras.
 

See also: Save to camera

Image size
 

Video signal received from an analog camera, comes to DVR or multiplexer input, where it is
processed by analog-to-digital convertor. 
Analog-to-digital conversion does not coincide with number of pixels of camera image sensor.
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As a result, the output image size, as a rule, does not coincide with number of pixels of the
image sensor. Because of such mismatch, there are distortions. 
 

In IP cameras the number of pixels on the output image also differs from number of pixels of the
image sensor.
In the combo boxes it is possible to set the horizontal and vertical number of pixels of output
image.
 

A button with a cross between combo boxes with horizontal and vertical numbers of pixels is
intended for fast calculation of vertical number of pixels from the specified horizontal number of
pixels and on the contrary. Calculation is carried out using the Aspect Ratio .
 

You can save frames with size in pixel exciting Windows screen size. See Real frame size . 
 

Criteria  of person detection , identification  and license plate reading , spatial
resolution  depend on vertical number of pixel. Therefore Vertical number of pixels
influences person detection, identification and license plate reading areas, positions of 
spatial resolution regions  and image examples  in the Spatial resolution box.
 

For criteria calculation minimal number of pixels from parameters of camera image sensor
and parameters of output image is used. 
Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
 

If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or
horizontal 768 pixels), what corresponds to analog camera.

If a camera is rotated around its axis  by an angle more than 45 degrees, when
calculating person detection  and identification , license plate reading  areas,  the
parameters: minimum vertical resolution (pixel/meter, pixel/ft), the minimum vertical
size of face image ( pixels ), the minimum vertical size of license plate ( pix) are
calculated based on the number of pixels along the horizontal, instead of the number of
pixels along the vertical, as in this case the vertical side of the field of view is located along
the horizontal.
 

When calculating the spatial resolution , rotation of the camera around its axis by default
does not affect the position of the vertical and horizontal in the frame.  Horizontal and vertical
positions are tied to the camera and not to the scene. You can change this rule, using the 
Spatial resolution and rotation  checkbox in the Options box .
 

The positions of the boundaries of spatial resolution  and the sample images  in the
Spatial resolution box are affected by the number of pixels in vertical or horizontal
direction depending on the position of the Vert. / Hor  switch in settings of a pattern of
spatial resolution, assigned to the camera.

 

If the According to camera parameters  box is marked on the View tab of the Image
parameters panel, Image size  the in the 3D Video becomes equal to the image size specified
in these boxes.

One field
 

If this box is checked, the vertical resolution of the image sensor  is reduced in half.
Vertical resolution decreases, if video signal from a camera with interlace scan is captured by
fields (half frames), instead of full frames. For example, 768x288 pixels.
 

For progressive scan cameras this box should not be marked. 
 

See also: Interlace
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Brightness
 

Using this slider the image brightness can be chosen.

Contrast
 

Using this slider the image contrast can be chosen.

Compression
 

Using this combo box an image compression level can be chosen. 
 

Compression levels may differ from the compression levels in the settings of different DVR or IP
cameras. To determine a correspondence use the visual image comparison. 
 

Obtained image compress by the JPEG algorithm for approximating the image in the 3D Video to
the real image from video cameras to exactly  estimation the possibilities of detection,
identification and reading 
 

Using in your DVR algorithms different from JPEG is not generally an obstacle for compression
modeling with the help of JPEG algorithm. Although other algorithm artifacts differ from JPEG
artifacts, the general amount of information correspondence that can be determined by the careful
visual image comparison is enough for modeling.      

Sharpness
 

Using the sliders it is possible to set additional sharpness or smoothing of the image. 
Move the sliders right to increase sharpness, move the sliders left to increase smoothing.
Additional sharping is applied to approximate the image in the 3D Video to real images from
cameras for evaluation of their possibilities. 
 

Principal causes of sharpness variation:
 

Sharpness increasing results from effect of aperture correctors in cameras and in other CCTV
equipment.
 

Horizontal smoothing appears as the result of losses of the videosignal high-frequency
component on long lines of communication or other components of the CCTV system. The
horizontal smoothing also will be necessarily present at the color videosignal capture by chips
without comb filters of chrominance (for example, Bt878) or black-and-white signal by the same
chips without disconnection of noth filters with the horizontal discretization more than 500
pixels. Horizontal smoothing is in the case of recording on VHS videorecorder.   
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Vertical smoothing appears when working some algorithms of deinterlacing (the process of
removing interlacing effects from the image). 

 

Total smoothing can appear as the result of lens adjustments errors (especially with Auto iris
lenses), optic pollution or as the result of working some algorithms of smoothing. Effect of
some digital processing systems in low light conditions can lead to smoothing. 

 

You can evaluate the resolution visually using the Test chart .

Save to camera
 

Clicking Save button, the processing parameters, specified on the Processing tab, will be saved
in parameters of the active camera. 
Later on, if the According to camera parameters  box is marked, the saved processing
parameters will be loaded at each activation of this camera.
At modeling monitors  the parameters saved in cameras is always used.
 

If at clicking Save button the Save to selected cameras box is marked, processing parameter
set on the Processing tab will be saved in all selected cameras.
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9.7.2.4 View

On the tab the image size in the 3D Video and visibility of additional elements on the 3D image are
specified.
 

Some elements on this panel are duplicated in the Main menu  of 3D Video.
 

See also: 3D Video

According to camera parameters
 

Size on the screen
Animation
Title
PTZH frame
Background
Test chart
Virt. post
3D view areas
Grid
Cameras
Illuminators
Ground surface
 

Save to camera

According to camera parameters
 

You can set visibility of additional elements separately for each camera. 
If this box is checked, visibility of additional elements are set according to parameters of active
camera. As a result of activation of other camera, visibility of additional elements will be changed
according to parameters of this camera. Manual changing visibility of additional elements will be
disabled.
 

If this box is not checked, the visibility could be specified manually. The set visibility will not be
changed during activation of different cameras.
 

The box is duplicated  in the Main menu of the 3D Video. 

 

See also: Save to camera

Size on the screen
 

In the box horizontal image size in the 3D Video is specified. Near this box,  the calculated
vertical image size and the Aspect Ratio  is shown.
 

If the According to camera parameters  box is marked, Size on the screen (pix) is taken
from camera parameters. But only if for this camera the Image size  on the Processing  tab
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is not specified. If the Image size is specified, the Size on the screen (pix) becomes equal to
the specified Image size.
 

The Image size in the 3D Video can not exceed screen resolution. How to model high resolution
images, see Real image size  and the PiP  tab. 
 

See also: According to camera parameters

Animation
 

When the Animation box is checked and the
value in the Number of frames combo box is
more than one, in the 3D Video  instead of a
static 3D image an animated image will be
generated.

Time of animated image generation increases in proportion to the number of frames.
 

The frame rate can be specified in the corresponding box  on the Camera tab.
 

On the animated image the 3D models  with non-zero speed will move, the Rotakin  will
rotate.
 

Animated images can be saved  in the animated gif files ,  and also can be displayed on the
Monitor  and saved  in html file.
 

To make visible movement on an animated image,  in the view area 3D models  with non-zero
speed and (or) object Rotakin  must present.
 

See also: Creating animated model of monitor .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Title
 

Place the following information in the left upper corner of the image: 
 

Name of the layout  on which the active camera is placed.
Active camera name.
Current image sizes in pixels.
Current image resolution in pixels (Image) and 3D Video size (Screen) separately, when the
image resolution differs from the 3D Video size; 

For panoramic  cameras the Image line displays a virtual number of pixels for correct simulation
of resolution of panoramic camera. 

Resolution in LPH (lines per pixture height, equals to TV-lines for analog cameras) in case of it
can be calculated. 
Brightness and Contast if these parameters are differed from default.
Image compression, if it is used.
The grid  step, if the grid is displayed. 
Calculated unweighted signal/noise ratio of the image, if illumination modeling  is switched
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on.
Calculated IRE of the image, if illumination modeling  is switched on.
Frame rate (fps), when image in the 3D Video is animated .
Exposure time (milliseconds) when exposure  is modeled.

PTZH frame
 

PTZH frame (Pan-Tilt-Zoom-Height) allows operating camera similarly to PTZ one and additionally
change camera's installation height. 
 

After clicking this item the camera's field of
view extends, and the objects being off view
area, for increasing the convenience of
camera's adjustment, become visible. Real
field of view is limited by orange frame.

 

Above the frame the buttons, which changes view area upper bound distance   and

view area upper bound height  ., are located. Current distance and height values are
digitally shown under the buttons.
 

It is recommended to set view area upper bound height, which is equal to maximal height of
observed objects, and do not change it further. Further adjust camera's inclination by changing
only the view area upper bound distance.
 

On the right and to the left of the frame there are camera rotation buttons   . 
 

Under the frame there are buttons, which change the height of camera installation  .
Current value of height is digitally shown above the buttons. Near by them the  lens focal length

  combo box is located. Value in the box can be selected from the list or entered
from the keyboard.
 

Using these tools it is possible to rotate the camera in both planes, change lens focal length
and height of installation. 
 

To change the position on one step click corresponding button. For continuous moving bring
the cursor to the button, then press it and do not release the left mouse button. For precise
position adjustment do the same, but with pressed Ctrl. 
  

In the PTZH frame mode you can pan and tilt the camera by moving the image like moving drawing
in the Graphics window. Press left mouse button, move cursor with the button pressed then
release the mouse button. Camera tilt angle is changed through changing view area upper
bound distance. But when Ctrl is pressed, the tilt angle is changed through changing view area
upper bound height.
You can also pan camera using the arrow keys.

 

Frame PTZH disables image processing,  titles  and animation . 

361

385

377

301

298

296

294

386 386



VideoCAD388

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

  

Together with Monitor window  this tool offers a new method  of 3D CCTV design.
 

If a model  is assigned to the camera, and the model has fixed  focal length lens, then you
can not change the focal length.
 

If a model is assigned to the camera, and the model has a lens with limited  variable focal
length, then you can change focal length within the limits only. When approach to the limit
values, the box will become crimson.
 

You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned
model or the assigned model have not specified limits of the lens focal length.

 

 Changing the lens focal length and therefore the calculated values of view angles of camera
with enabled modeling lens distortion  will lead to detuning parameters of distortion and
warping view area form. To correct the mismatch you should set new values of the actual view
angles , tak ing into account the changed values of calculated view angles.
 

The PTZH frame simulates lens distortion  in simplified way. Only border of the field of view
is drawn without modeling optical distortion of the image.

 

See also: CCTV design using Monitor window and PTZH frame

Background
 

Show or hide a background in the 3D image. 

In case of vector background you can adjust 
background resolution  in the 3D Video.

 

See more: Background , Background resolution

Test chart
 

Place at the right top corner the image fragment of the standard test chart EIA1956 for the visual
estimation of the current horizontal and vertical resolution. 
 

The Test chart shows resolution in  lines per picture height (LPH) regardless of the Aspect Ratio
.

 

Result of measuring resolution by this fragment of EIA1956 test chart equals to the modern  ISO
12223.  Use of EIA1956 is caused that it is more compact.
 

Maximum resolution what can be measured by the middle field without multiplication is 1600
LPH.
With the help of combo box under the Test chart  checkbox on the View tab of the Image
parameter panel, you can increase the size of the chart in 2 or 4 times or reduce the size in
2,4,8,16,32,64 times, and thus expand the range of measured resolution to 50-102400 LPH. 
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You can simulate the image resolution using the tools Camera>Resolution (LPH) ,
Lens>Resol.(lp/mm) , Processing>Sharpness , Depth of Field .
 

You can get images with the number of pixels exceeds the screen size using the tools Real
frame size  and PiP . 
 

You can measure contrast drop using the TV - lines tool from the CCTVCAD Lab Toolkit
package.
 

See also: 3D Video window , , Real frame size

Virtual post
 

Show or hide the virtual post on which the camera is
installed. The post allows to see projection of the
place, where the active camera is installed on the
ground.. The post is not visible by default.

Grid
 

Show/Hide the Grid .

Cameras
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Show/Hide 3D models of cameras.

Illuminators
 

Show/Hide 3D models of Illuminators .

Ground surface
 

Show/Hide 3D the ground surface. Ground color can be set on the 3D modeling  tab in Options
box. 
 

In multi-level 3D projects the height of the ground surface equals to the base height  of the
active camera.

Save to camera
 

Clicking Save button, the view parameters, specified on the View tab, will be saved in parameters
of the active camera. 
Later on, if the According to camera parameters  box is marked, the saved parameters will be
loaded at each activation of this camera.
At modeling monitors  the parameters saved in cameras is always used.
 

If at clicking Save button the Save to selected cameras box is marked,  parameter set on the
View tab will be saved in all selected cameras.
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9.7.2.5 PiP

This tab is designed for modeling images with 
megapixel resolution which exceeds 3D Video
size. 

PiP technology allows to model resolutions up to tens of megapixels, as well as save screen
working space and reduce generation time of megapixel 3D images.
 

In the 3D Video 2 pictures are displayed simultaneously . One of them is a general view - shows
the whole field of view, but with lower resolution. Another picture - a particular view - shows the
target region of the field of view, but with the original higher resolution.
 

The target region is outlined by a yellow frame.
 

You can quick ly choose the target region on the general view click ing by the middle mouse
button (or wheel). If there is no middle button, you can enable control by the left mouse button .
 

With the help of PiP,  the lens distortion can be modeled with real resolution of image.  Without PiP
the lens distortion  in the 3D Video is modeled with low resolution only. To get image with real
resolution while modeling distortion, turn PiP ON. When modeling distortion, the target region of PIP
will have real resolution. In case of warping at the image corners while modeling significant distortion,
reduce the size  of the target region .
 

Another way of modeling megapixel images and distortion with real resolution - use the Real frame
size  item.
 

See also: Modeling megapixel images .
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According to camera parameters
 

Off
On
Auto
Picture in picture

Resolution/Field of view
Position
Size (%)

Target region
Left click
Size (%)
Maximum

Digital  ZOOM
 

Save to camera

According to camera parameters
 

Scenes of different cameras can demand different positions of the target region and different
positions of the little picture in the big picture. Therefore the PiP parameters can be specified for
each camera separately. 
If this box is checked, PiP parameters on this tab are set according to PIP parameters of the
active camera. As a result activation of other camera, PIP parameters will be changed according
to PIP parameters of this camera. Manual changing PiP parameters will be disabled.
 

If this box is not checked, PiP parameters could be specified manually. The set parameters will
not be changed during activation of different cameras.
 

See also: Save to camera

Off
 

Turn OFF the PiP mode unconditionally.

On
 

Turn ON the PiP mode unconditionally.

Auto
 

If this switch is chosen, the PiP mode will be turned ON automatically when resolution of image
in the 3D Video exceeds size of the 3D Video in any dimension (in width or in height).

Picture in picture
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Resolution/Field of view
 

If this box is checked, then particular view  is displayed in the little picture outlined by a
green frame, which located inside the big picture. The big picture displays the general view .
If this box is not checked,  in the little picture the general view is displayed, but in the big
picture the particular view is displayed.

Position
 

In this combo box you can choose position of the little picture inside the big picture on
unimportant area of image. 6 positions are possible.

Size (%)
 

In this combo box you can choose size of the little picture as a % part of the big picture.

Target region

Left click
 

You can quickly choose the target region on the general view  clicking by the middle mouse
button (or wheel) by default. If there is no middle button, you can enable control by the left
mouse button, checking this box.

Size (%)
 

If the Maximum  box is not checked, then the Size (%) box displays the current size of the
target region in % of the whole field of view. The Size is calculated automatically.
 

If the Maximum box is checked, then in the Size (%) box you can set the maximum size of
the target region in % of the whole field of view.
In case, for exact imaging resolution, it would be required larger target region, then the size of the
target region will still not exceed the value in the Size (%) box, but the resolution of a particular
view will be reduced.
 

This mode can be useful for comparing resolution of cameras without changing the size of the
target region. 

Maximum
 

See Size (%)  above. In the most cases the Maximum box should not be checked.

Digital  ZOOM
 

In this box you can choose additional digital ZOOM of the particular view  without increasing
real resolution. This tool gives the the same effect as Digital ZOOM in cameras.

Save to camera
 

Clicking Save button, the view parameters, specified on the PiP tab, will be saved in parameters
of the active camera. 
Later on, if the According to camera parameters  box is marked, the saved parameters will be
loaded at each activation of this camera.
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At modeling monitors  the parameters saved in cameras is always used.
 

If at clicking Save button the Save to selected cameras box is marked, parameter set on the
PiP tab will be saved to all selected cameras.

 

See also: Modeling megapixel images .
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9.8 Errors in rendering 3D images

The quality of 3D images in the 3D Video ,  3D World  and 3D Models  windows and the
speed of its refreshing depends much on your graphics card capabilities. To get maximum realism
set the maximum quality of Open GL images.  
 

On some outdated graphic cards visible pixelization, errors and the lack of image are possible. This
is not a program fault. Some new graphic cards need an additional setting to get the maximum
realistic quality.     
The speed of image updating also depends on the quantity of the displayed 3D models.  
 

If errors are visible on the image in the 3D Video/3D World or the computer buzzes at the 3D Video
/3D World displaying, first of all update the graphics card driver to the latest version accessible on
the manufacturer website. The drivers which are used in Windows by default as a rule do not support
hardware acceleration.

Then try to change Hardware acceleration in the Display Properties box.

Then try to reduce Model space on the 3D modeling  tab in the Options box. Try to disable
image processing .

If failures or distortions remain, - a more high-end graphics card is necessary for 3D modeling.
For the best quality it is necessary to use a graphics card with OpenGL hardware support.

 

Redraw speed of the image depends also on number and complexity of displayed 3D
models and the size of opened 3D Video. 
 

The speed is considerably decreased when modeling illumination , depth of field   exposure ,

rolling shutter , animation , distortion , gradient . The speed is decreased in a less degree

when modeling interlace , using PiP .
Compression  modeling and other additional image processing reduces speed to some extend.

It is recommended to enable resource-intensive operations only when needed and disable them
during normal operation.
You can quickly enable and disable all image processing with the help of the 3D Video>Main
menu>Speed>Disable image processing . 
Using the 3D Video>Main menu>Speed>Redraw 3D image only by clicking  you can avoid
unnecessary redrawing the 3D view.
 

If the image is redrawn too slowly and that hinder operation in the Graphics window, try to adjust
VideoCAD for the most comfortable working on your equipment and your projects:
 

Mark the  Redraw 3D image only by clicking  box on the 3D modeling  tab in the Options box
. After that the image in 3D Video will be redrawn automatically only at activation of cameras. To

force redrawing click on the image.
 

Try to disable image processing . After that the image processing will not be modeled, but redraw
speed will increase.
 

You can increase redraw speed or modeling accuracy using Speed <> Accuracy  slider on the 3D
modeling  tab in the Options box . 
 

If with the 3D Video opened, errors occur, try to switch redrawing in the 3D Video to the common
thread by clearing the checkbox Draw 3D Video in separated thread . This would worsen the ease
of program operation, but may increase stability.
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See also: Options box>3D modeling>Redrawing 3D Video . Program speed and system
requirements

481

650



Interface 397

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.9 3D Models

Graphics window
Main menu

View
3D Models

The 3D Models window is intended to manage 3D models  in the program library.

The 3D Models window can be opened in several ways:
 

Via the Main menu > 3D models> 3D Models window ;

By clicking the button  on the Current construction parameter panel  during placement or
editing 3D models. In the 3D Models window the placed or edited 3D model will be loaded.
Adding a new model via Main menu >3D Models> Add 3D model . The 3D Models window will
appeared automatically after opening a 3D model file, the new 3D model will be loaded into the 3D
Models window.

Like the 3D World , tThe 3D Models window consists of display area and panels with tools. 
On the top of panels there is a button of choosing 3D models. Clicking on the button opens a menu
where you can select a 3D model from 3D model available in the library of 3D models. Below there
are 3 tabs:
 

Model
View
Navi (navigation)

For general 3D models of variety of objects, people , vehicles etc. tools on the Model  tab are
enough. The other tabs are intended to work with 3D models-territories.   For example 3D model of
the building , terrain, etc. You can place inside these 3D models: cameras, constructions and other
3D models. 
 

In VideoCAD Lite there is only one tab - Model . In VideoCAD Professional there are more tabs
View and Navigation.
Changes in the 3D Models window will be applied to all instances of the 3D model already placed in
the project. If you need several variants of the same 3D model with different properties, create a copy

 of the 3D model.
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You can resize the 3D Models window by dragging its borders by mouse. Via resizing the window,
you can change resolution of the 3D model's projection for  displaying in the Graphics window

.
The 3D model's projection is updated at the moment of clicking the Save projection  button.

See also: 3D Video , 3D World
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9.9.1 Model

On the Model tab you can:
 

Load new 3D models from *.vcm files.
 

3D model files in *.vcm format can be
obtained from SketchUP or 3ds max with the
help of special plugins. See more: Import of
3D models from SketchUp and Autodesk
3dsMax .
 

Delete 3D models from the library;
Build projections of 3D models to display in
the Graphics window  and in menus ;
Save 3D models to *.vcm files;
Duplicate 3D models;
Distribute 3D models by hierarchy
directories  for convenient access from
menus.

Projection panel
 

The panel is intended to create projections of the 3D model to display in the Graphics window
 and the menu . Without the created projections, in the menus and Graphics window

instead of the 3D models  gray rectangles will be displayed.
These projections can be repeatedly re-created for new or already placed 3D models.

The order of creation projection:
 

1. By the Horiz. <> Vert. switch, choose which projection should be created. Firstly you should
create the horizontal projection. The vertical projection is  used rarely only to display 3D
model in Vertical projection of the Graphics area .
 

2. Then adjust resolution of the projection visually, via changing window size by mouse.
   

For 3D-models of objects in order to improve performance you should  chose minimally sufficient
resolution.
3D-models-territories require high resolution, for its increase special tools on the View  tab are
offered.
 

3. After adjusting resolution, click the Save projection button. As a result in menus and in the
Graphics area  the 3D model will be displayed in the form of created projection.

Model panel
 

Load - Add new 3D model to the program library. In the appeared dialog choose a file in *.vcm
format and click Open. 
 

3D model files in *.vcm format can be obtained from SketchUP or 3ds max with the help of
special plugins. See more: Import of 3D models from SketchUp and Autodesk 3dsMax .
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If VideoCAD library already has a 3D model with the same name or ID, you will be prompted to
add the model under a different name or ID.
Then you will see the  3D Models window , in which you can create the projection  of the 3D
model to display it in the Graphics window  and menus . To do this click the Save
projection button and close the 3D Models window. After this, icons of the 3D model will appear
in menus and the 3D model can be placed in the graphics area.
 

If your 3D model has textures, in the same directory where the *.vcm file is opened from, a folder
with textures must be. The folder should be named <model name> _textures. VideoCAD plugin
for SketchUP automatically creates the folder with the textures in the directory of saving exported
model.

Save - save to *.vcm file the current 3D model. If your 3D model has textures, in the directory of
saving *.vcm file, a folder with textures named <model name> _textures will be created.

Dupl - make a copy of the current 3D model. Copies can be useful, for example, while working
with multi-storey buildings. You can create multiple copies of the 3D model of the building for
each floor. For each copy make a projection at different levels  and put them on different layers

.

Delete - delete the current 3D model from the library. When you delete placed 3D model, all
instances of this 3D model will be also deleted from the project.

Directories panel
 

The panel is intended for distribution 3D models by hierarchy directories for convenient access
from menus.

List of directories - The list with full paths starting from the root directory. In the list you can
choose a directory for deleting or to put in it the current 3D model. 

Add - Add new directory. The name of the directory should be entered with all directories of higher
levels. For example:
"cars" - new directory cars in the root directory of menus. 
"cars\trucks" - new directory trucks in directory cars. If the cars directory does not exist, it will be
created. 
 

Empty directories are not visible in menus, only directories with 3D models are visible in menus.

Delete  - Delete the directory, chosen in the List of directories. Only empty directory can be
deleted.

Insert model - Put the current 3D model to the directory, displayed in the List of directories.
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9.9.2 View

On the View tab, you can change view and
resolution of projection of 3D model for
displaying in the Graphics area  of the
Graphics window. Changes may be necessary
when working with 3D models- territories.

To change the projection make the necessary
settings on this tab and click Save projection

. Projection can be changed many times,
the changes will affect on all already placed
instances of the 3D model. If you need multiple
instances with different properties, create a 
copy  of the 3D model.

Faces and Edges
 

Checkboxes Faces and Edges allows to switch view of the 3D model in the form of faces or
edges (lines). If both checkboxes are not checked the 3D model is displayed as points.

Light
 

The Light slider allows you to change the light level on the layout, and a combo box located next
to - the direction of light. These tools allow you to highlight dark or light areas located at different
angles to the viewer.

Incline
 

The Incline slider allows to incline projection of the 3D model a little to make vertical details ( for
example: walls) more discernible on horizontal projection.

Height cutting
 

The Height cutting comboboxes  allow to cut in the 3D model a horizontal layer limited from top
and bottom,  draw it as a projection to display in the Graphics window .   The tool is useful to
highlight the storeys in the form of projections of the 3D model while working with multi-storey
buildings.

Multiply resolution
 

The Multiply resolution combo box allows to increase resolution of the projection of the 3D
model in several times, relative to the size of the 3D Models window. Increasing the resolution
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may be necessary when working with 3D models-territories.

PiP (picture in picture)
 

The PiP checkbox allows to further increase the resolution of a separate area on the projection.
 

To select the area:
1. Check this checkbox;
2. Specify by black frame the area on the projection ( left mouse button click in the corner of the
area, move the mouse while holding the button and release the button at the other corner );
3. Click Save projection .
 

After that, the area on the projection of the 3D model will be displayed with higher resolution in the
Graphics area. The smaller the fraction of the total size of the projection the area occupies, the
more the relative increase of the resolution.
 

The PiP checkbox is inaccessible while the Enable navigation  on the Navigation  tab is
checked.

Shadows
 

The Shadows checkbox allows to consider the 3D model as an obstacles in the calculation of
shadows  in the 3D World  and in the Graphics window  regardless of the state of
checkboxes Calculate shadows from 3D models  in the Options box and Shadow  on the
Current construction parameter panel.
A 3D model with the Shadows option checked behaves like a construction  that is an obstacle
if its line type has checked Shadow  option and it belongs to a layer with the Shadows
option checked.
 

This checkbox should not have a mark for conventional 3D models - not a territory. Do
not mark it unnecessarily.
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows ,
Choosing the best place for PTZ (dome) camera , Visualization of the camera control area
projections and spatial resolution within them

Lock
 

The Lock checkbox makes instances of the 3D model insensitive to selection  by mouse click.
This option is required to work with projections of 3D models- territories in the Graphics window.

  

Opportunity of selection by the selection window remains.
 

To make 3D models will not cover cameras, check the Main Menu in the Graphics window 
View>Camera over constructions .

Thin lines
 

Mark of this checkbox increases the thickness of the thin dark lines on a light background to one
pixel when displaying projection of the 3D model in the Graphics window. In most cases it
improves legibility of the projection when it is scaled.
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Textures
 

The Textures checkbox allows you to hide textures of 3D models with textures. Hiding textures
increases the speed of redrawing complex 3D models and hides an excessive amount of detail,
allowing you to concentrate on the geometry of 3D models.
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9.9.3 Navigation

On the Navi tab, you can examine in detail the
3D model using the tools of navigation in 3D
space. This can be useful when working with
3D models-territories.

Navigation interface is a simplified version of the
interface of the 3D World .

Enable navigation

If the checkbox is not checked,  the selected projection  of 3D model is displayed, ready to
save. If the checkbox is checked, the 3D navigation interface is active.
Using the 3D interface, you can examine in detail features of the 3D model, "visit" in the premises
of the 3D model-building, "walk" on the floors etc.

Functions of mouse buttons

On the left mouse button the Orbit   is assigned - moving  the mouse cursor with the left
button pressed rotates the 3D model in the space (or rotates the virtual viewer around the 3D
model);

 

Function of the left button can be changed .
 

On the middle mouse button the Move  is assigned - moving 3D model in the field of view
plane;

 

On the rotation of the mouse wheel the Zoom  tool is assigned - wheel rotation zooms in or
out the point in the 3D space, where the mouse cursor is. 

 

Pressed Ctrl reduces step of zooming;
Step and direction of zooming by turning the mouse wheel can be changed widely using 
Navigation>Scale factor  in the Options box .
 

On the right mouse button the Look around Look around   is assigned  - rotates the sight
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direction standing the virtual viewer stationary.

3D navigation buttons
 

By these buttons you can change function of the left mouse button. 

Orbit  - moving  the mouse cursor with the left button pressed rotates the 3D model in the
space (or rotates the virtual viewer around the 3D model). 
This is default function of the left mouse button.
 

Move  - moving 3D model in the field of view plane.
This is default function of the left middle mouse button. The middle mouse button works like in
the Graphics window .
 

Zoom  - moving the mouse cursor along vertical zooms in or out the point in the 3D space at
the center of the display area. By double clicking in the display area you can specify a new
center point. 
Wheel rotation zooms in or out the point in the 3D space, where the mouse cursor is. The Zoom
tool works like in the Graphics window.
 

Pressed Ctrl reduces step of zooming;
Step and direction of zooming by turning the mouse wheel can be changed widely using 
Navigation>Scale factor  in the Options box .
 

Look around  -  rotates the sight direction standing the virtual viewer stationary.
This is default function of the right mouse button.
 

Walk - controls movement of the virtual viewer in virtual horizontal plane. Pressing the left
mouse button fixes the starting point, moving the cursor from the starting point with left mouse
button pressed sets the direction and speed of movement.
 

Zoom frame . Pressing the left mouse button specifies the first point of the zoom frame,
moving the cursor with left mouse button pressed and releasing the left mouse button generates
the ZOOM frame. After releasing the mouse button the virtual viewer will approach to content of
the frame.
 

This tool works like the function of the right mouse button  in the Graphics window.

Fixed views buttons
 

Allow to quick look at the model from any of 6 sides: Front view, Left view, Right

view, Back view, Top view, Bottom view.

Step backward and Step forward buttons
 

Allows to move on the chain of previous views backward and forward.

Sight direction of the virtual viewer
 

Sight direction of the virtual viewer in vertical and horizontal planes and its view angle are
represented as a camera.
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Parameters of the model
 

On the bottom of the tab important parameters of the 3D model are displayed:
 

Size: - Sizes of the 3D model in the format X:Y:Height.  
Sizes of instances of the 3D model along each coordinate axis can be set independently on the 
Current construction parameter panel .
 

ID of the 3D Model. VideoCAD recognizes 3D models not by names, but by integer IDs. All 3D
Models in the library must have different IDs. 
 

Number of vertices (Vert) and faces (Faces) in the 3D model. The more vertices and faces are,
the more complicated the 3D model, the more computational power is required for calculating 
shadows  from this 3D model in the Graphics window. For 3D models-territories with shadow
calculation it is recommended to use 3D models with little number of vertices to increase drawing
speed.
 

Shadow calculation in the 3D World  less dependent on the complexity of 3D models, than the
calculation in the Graphics window.
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9.10 Monitor window

Graphics window
Main menu

View
Monitor window

 

Monitor window is intended to model monitors of video surveillance system. However the field of
application of this tool is much wider. 
 

Together with 3D Video  the Monitor window allows to project video surveillance system, working
directly with images.  Thus all necessary changes on the drawing are carried out automatically.
 

Monitor window logically finishes the information transfer process in video surveillance system "from
a real object to an operator" and thus, allows to model the video surveillance system as a hole.
 

In Monitor window there can be up to 10 monitors. On each monitor up to 100 images from cameras
could be displayed simultaneously or with the dividing into screens.

 

Monitor window  can display static and animated  images. Animated images in different cells can
have different frame rate . 

Using Monitor window in order to achieve the best result it is possible to compare various variants of
cameras' placement.
 

Monitor window is useful at designing an operator's workplace. It is possible to estimate the detail of
images from cameras in split screen, an option to display images from different cameras in various
sizes, choose optimal quantity and sizes of monitors as well as optimal distance of watching these
monitors, taking into account features of projected video surveillance system.
  

Together with PTZH frame  this tool offers a new method  of 3D CCTV design.

See also: Work  with Monitors , Monitor window Tool bar , Monitor window Main menu ,
Monitor window Pop-up menu .
External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
. 
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9.10.1 Tool bar

 Monitor list  
 

 Update  
 

 Day/Night  
 

 Animation  
 

 Previous screen , Next screen  
 

 Previous cell , Next cell  
 

 Edit  
 

 Monitor dimension  
 

 Monitor diagonal  
 

 Screen Acpect Ratio  
 

 Stretch another aspect ratio images  
 

 Analog monitor  
 

 Monitor resolution  

 Monitor list
 

In the combo box there is a name of displayed monitor. It is possible to choose other monitor. In
VideoCAD there are 10 monitors, in which the set of cameras and the parameters are adjusted
independently. 
To rename the displayed monitor use item Main menu Monitor>Rename .

 Update
 

Update all images on the displayed monitor. 
 

Monitor window itself does not generate 3D images, but uses the ready images which are created
in 3D Video  and are stored in the memory that allows to work  simultaneously with a big
quantity of 3D images without decreasing program's speed.
 

As a result of clicking this button, for some time 3D Video will appear, in which the images from
all cameras will be modeled according to saved parameters of the cameras. 

 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.
 

To update the image in one cell click  it by the right mouse button and choose in the pop-up
menu Update .
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 Day/Night
 

Switch Day/Night  time in the project and update all images on the displayed monitor. 

As a result of clicking this button, the Day/Night  time on the Scene  tab on the  Camera
parameters panel  will be switched, then for some time 3D Video will appear, in which the
images from all cameras will be modeled according to saved parameters of the cameras. 
 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.

 Animation
 

Turn On/Off animation on the monitor.. 
When the Animation is turned On, animated images will be generated and loaded on the Monitor. 
 

The 3D Video  will appear when necessary, in which animated images from cameras with
enabled animation  will be generated.
 

In order to make image from a camera animated:
Image parameter panel>View>Animation  box must be checked; 
Number of frames  must be more than one;
these settings must be saved in camera parameters .

 

To make visible movement on an animated image,  in the view area 3D models  with non-zero
speed and (or) object Rotakin  must present.
 

See also: Creating animated model of monitor .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

  Previous  screen,  Next screen
 

Each monitor consists of 100 cells, but it is also possible to display a smaller quantity of cells
simultaneously. The quantity of simultaneously displayed cells is chosen in the Monitor
dimension  combo box.
 

Clicking the buttons Previous screen and Next screen shift the displayed cells on the quantity
of simultaneously displayed cells.
 

For example, if the monitor's dimension is 2x2, 4 cells are simultaneously displayed. If cells
5,6,7,8 are displayed, as a result of click ing the Previous screen button - cells 1,2,3,4 will be
displayed, and by click ing the Next screen button - cells 9,10,11,12 will be displayed. 
 

Thus, each monitor can have several screens.

  Previous cell,  Next cell
 

Each monitor consists of 100 cells, but it is also possible to display a smaller quantity of cells
simultaneously. The quantity of simultaneously displayed cells is chosen in the Monitor
dimension  combo box.
  

Clicking the buttons Previous cell and Next cell shift displayed cells on one cell. 
 

For example, if monitor's dimension is 2x2, 4 cells are simultaneously displayed. If cells 5,6,7,8
are displayed, as a result of click ing the Previous cell button - cells 4,5,6,7 will be displayed,
and by click ing the Next cell button - cells 6,7,8,9 will be displayed.
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 Edit
 

If this button is pressed, the monitor editing tools become available: 
 

Monitor dimension
Monitor diagonal
Screen Acpect Ratio
Stretch another aspect ratio images  
Analog monitor
Monitor resolution
Monitor>Clear
Monitor>Rename
Clear cell
Opportunity of cameras connection to the monitor
Opportunity of moving and copying cells
 

If this button is not pressed, monitor's editing is locked for protection against accidental change of
the monitor.

 Monitor dimension
 

In the combo box it is possible to choose quantity of simultaneously displayed cells on the
current monitor. 
2x2 corresponds to 4 cells, 3x3 - to 9 cells, etc. 
 

One image can occupy 1, 4, 9 or 16 side-by-side located cells. 
 

Changing value in the box is possible only in Edit mode  of the monitor.

 Monitor  diagonal
 

In the combo box it is possible to choose physical size of the screen of the current monitor.
The size is set by diagonal, in inches. Value N/A corresponds to the size which is not set. If the
physical size is set, possibility to change the sizes of Monitor window by the mouse is locked.
 

To get precise sizes of the Monitor window you can adjust Monitor size factor  in the Options
box. 
 

To change value in the box is possible only in Edit mode  of the monitor.

 Screen aspect ratio
 

You can choose in the combo box screen aspect ratio. 4/3 - standard monitor, 16/9 - wide-screen
monitor.

 Stretch another aspect ratio images
 

If the button is pressed then images from cameras with differing aspect ratio will be stretched. 

 Analog monitor
 

This tool allows to model analog monitors, the resolution of which is below the computers' one. If
this button is pressed, the resolution of the monitor is limited to value 768x576 pixels.
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To change button's state is possible only in Edit mode  of the monitor.

 Monitor resolution
 

In this box you can set resolution of the monitor. Resolution in the Monitor window will be limited
by value in this box. 

 

Changing value in the box is possible only in Edit mode  of the monitor.
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9.10.2 Main menu

Image
Save as *.bmp
Save as *.jpg ,*.gif,
*.tif, *.png
Export to *.html
Printer setup
Print

Monitor
Update
Edit
Clear
Rename

View
Day/Night

Animation
Full screen

Help

Image > Save as *.bmp
 

Save the image in the Monitor window in *.bmp format. The image is saved exactly as on the
screen, but the obtained file will be big. 

Image > Save as *.jpg, gif, *.tif, *.png
 

Save the image in the Monitor window in *.jpg, *.gif, *.tif, *.png formats. The image is saved
compressed, at that a small loss of quality appears, but the file size turns to be small.   

Image > Export to *.html
 

Export the image in the monitor window to *. html file. This file can be viewed in any Internet
browser.
 

The main html file and separate image files are generated. Images are saved with resolutions
according to parameters of each camera. The images are stretched by a browser when viewing.
All files are saved in one directory.

 

Image files can be static (*.png), and animated  (animated *.gif).
 

See also: PDF Report

Image > Printer setup
 

Choosing this item opens a standard dialog box of current printer setup in Windows.

Image > Print
 

Print the image in the Monitor window.

Monitor > Update
 

Update all images on the displayed monitor. 
 

Monitor window itself does not generate 3D images, but uses the ready images which are created
in 3D Video  and are stored in the memory that allows to work  simultaneously with a big
quantity of 3D images without decreasing program's speed.
 

As a result of clicking this button, for some time 3D Video will appear, in which the images from
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all cameras will be modeled according to saved parameters of the cameras. 
 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.
 

To update the image in one cell click  it by the right mouse button and choose in the pop-up
menu Update .

Monitor > Edit
 

If this item is checked, the monitor editing tools become available: 
 

Monitor dimension
Monitor diagonal
Screen Aspect Ratio
Stretch another aspect ratio images  
Analog monitor
Monitor resolution
Monitor>Clear
Monitor>Rename
Clear cell
Opportunity of cameras connection to the monitor
Opportunity of moving and copying cells
 

If this item is not checked, monitor's editing is locked for protection against accidental change of
the monitor.

Monitor > Clear
 

Clear all cells of the displayed monitor, delete images and disconnect cameras. 
 

Item is accessible only in Edit mode  of the monitor

Monitor > Rename
 

Rename the displayed monitor. As a result of clicking this item a dialog box will appear, in which
it is possible to enter the new name of the monitor. 
 

Item is accessible only in Edit mode  of the monitor

View > Day/Night
 

Switch Day/Night  time in the project and update all images on the displayed monitor. 

As a result of clicking this item, the Day/Night  time on the Scene  tab on the  Camera
parameters panel  will be switched, then for some time 3D Video will appear, in which the
images from all cameras will be modeled according to saved parameters of the cameras. 
 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.

View > Animation
 

Turn On/Off animation on the monitor.. 
When the Animation is turned On, animated images will be generated and loaded on the Monitor. 
 

The 3D Video  will appear when necessary, in which animated images from cameras with
enabled animation  will be generated.
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In order to make image from a camera animated:
Image parameter panel>View>Animation  box must be checked; 
Number of frames  must be more than one;
these settings must be saved in camera parameters .

 

To make visible movement on an animated image,  in the view area 3D models  with non-zero
speed and (or) object Rotakin  must present.
 

See also: Creating animated model of monitor .

View > Full screen
 

Show the image from the displayed monitor at full screen. 
In this mode it is possible to switch monitors sequentially using the keys Page Up and Page
Down, to shift cells by cursor moving keys Arrow left and Arrow right, to change monitor's
dimensions by cursor moving keys Arrow up and Arrow down.
 

To return to the monitor's showing in the window press any other key. 

Help
 

Show Help section with description of Monitor window.
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9.10.3 Pop-up menu

The Pop-up menu appears as a result of click ing the right mouse button on any cell in Monitor w
indow. Operations in the pop-up menu are carried out above the camera, the image from which is
present at the cell. Therefore, in case of an empty cell items of the menu are inaccessible.
Exception is the Clear cell  item, which action concerns to the cell. Click ing this item deletes the
image from the cell. 

Show in 3D Video
Update
Activate
Find on layouts
Clear cell

Show in 3D Video
 

Show the image in this cell in 3D Video . The same result will be obtained, by double click the
cell.
 

It is convenient in 3D Video check the item of Main menu>View> PTZH frame  and visually
adjust cameras' positions. It is also possible to model parameters of the image and conditions of
surveillance. Thus, it is possible to project video surveillance system, working only with images.
All necessary changes on the layout will be automatically carried out. 
After changing the camera's parameters click the Update  item.

Update
 

Update the image from the camera connected to this cell. 
 

Monitor window  does not generate 3D images itself, and uses ready images which are created in 
3D Video  and are stored in the memory that allows to work  simultaneously with a big quantity
of 3D images without program's speed decreasing.
 

As a result of clicking this item, for some time 3D Video will appear. In this window the image
from the camera will be modeled. The image will be modeled according to saved parameters of
the cameras. 
 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.
 

To update the images on the monitor use the Update  button on the Tool bar.

Activate
 

Activate  the camera, connected to this cell. 

Find on layouts
 

Find on layouts and select the camera, connected to this cell. 

Clear cell
 

Delete the image from this cell and disconnect the camera from it. 
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Item is accessible only in Edit mode  of the monitor410



Interface 417

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.10.4 Work with Monitors

Opening Monitor window 
Preliminary monitor's adjustment
Connecting cameras
Placement of images
Updating images
Creation of animated monitor
Work with monitor

Opening Monitor window
 

For opening the Monitor window click the Monitor window   button on Graphics window
tool bar. At first opening in Monitor window the first monitor with the name Monitor 1 and
parameters by default will be shown.
 

If the monitor is already adjusted and cameras are connected to it, at first opening Monitor
window after starting the program for some time 3D Video  will appear, in which images from
these cameras will be modeled.
 

Generation of 3D images can take a lot of time. To interrupt generation press ESC.

Preliminary monitor's adjustment
 

For monitor's adjustment, first of all switch on edit mode by clicking the Edit   button. 
 

For renaming the monitor click the item in the Main menu of Monitor window Monitor >
Rename .
 

Select quantity of cameras, which will be displayed the Monitor dimension  combo box.
 

If necessary, select physical size of monitor's screen in the Monitor diagonal  combo box. 
Having set the size it will be impossible to change the size of Monitor Window by the mouse.
 

If it is an analog monitor, click the Analog monitor   button. The button should look
pressed.
 

In the Monitor resolution  box you can specify the resolution of monitor.

Connecting cameras
 

Connection of cameras is available only in Edit mode (Edit   button is pressed).
 

Select  necessary cameras on the layout in Graphics window, and then click a cell on the
monitor, beginning from which these cameras should be displayed on the monitor.
 

For some time 3D Video  will appear, in which images from these cameras will be modeled.
After that the images will appear in cells of the monitor, beginning from a cell selected by click. 
 

Thus it is possible to connect any quantity of the selected cameras simultaneously.
 

If at the moment of click ing on the monitor Ctrl is pressed, new cameras will fill only free cells on
the monitor. Cells already filled will not change.
 

The image from each camera is modeled according to saved parameters of the camera. 
 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
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resolution  box.

Placement of images
 

Images can be changed in positions, copied, deleted, merged in 4,9,16 side-by-side located cells
to get big images from some cameras
 

For placement of images the Edit  mode should be switched on.
 

To interchange images' positions in two cells, first click the first cell, then the second one.
 

For copying the image from one cell in another, first click the cell, from which it is necessary to
copy the image, and then on the cell, where it is necessary to copy the image. At the same time 
Ctrl should be pressed.
 

To delete the image from the cell, click it by the right mouse button and choose in pop-up
menu Clear cell . 
 

To delete all images from the monitor choose item in the Main menu>Monitor>Clear .
 

To increase images' size by merging the cells, place the images from one camera in 4, 9 or 16
side-by-side located cells. These cells are merged automatically.

Updating images
 

Monitor window does not generate 3D images itself, and uses the ready images which are created
in 3D Video  and which are stored in the memory. That allows to work  simultaneously with a
big quantity of 3D images without decreasing the program's speed.
 

That is why after changing the parameters of a camera it is necessary to update camera's image
on the screen. To update the image in a cell click it by the right mouse button and choose in the
pop-up menu Update . Then 3D Video will appear, in which the image will be modeled
according to saved parameters of the camera. 

 

Camera parameters can be saved on the Camera parameters panel  and in the Sensitivity and
resolution  box.
 

To update all images click the Update   button on the Tool bar.

Creation of animated monitor
 

Monitors can display animated  images. Monitor with animated images can be exported to *.
html file. 
 

See: Animation , Export to html , Creating animated model of monitor .
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Work with monitor
 

In order not to change monitor's adjustment by accident, switch off Edit mode by clicking the

Edit   button. The button should look not pressed. 
 

Application of monitors at designing can be various. For acquaintance with all options of the work
with monitors, see: Tool bar , Menu bar  and Pop-up menu .
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9.11 Table of camera models

Graphics window
Tool bar

Table of camera models

The table displays parameters of camera models. Rows in the table correspond to models and
columns in the table correspond to model parameters.
 

To get help for any parameter, select a cell and press F1 or use the Help of parameter (F1)
item in the pop-up menu.
 

Models can be assigned  to cameras in the project. As a result of model assignment to a
camera, model parameters  would be assigned to the camera. 
 

In the table there is a variety of parameters , which is sufficient for description almost all security
cameras existing at the moment of VideoCAD creation. Some parameters are used in camera
modeling in VideoCAD, the rest of parameters exist only for comparison and for information.
Parameters values can be taken from camera specifications.
 

Many cameras have different parameters in different modes, for example, at different resolutions,
different combinations of settings. If you need to simulate different modes of these cameras, you
should create several models for single camera.
 

At adding  new model it is not necessary to specify all parameters, it is possible to set only
important for a current task parameters. Unused columns in the table can be hidden . It is
possible to create variety of table views  with different sets of columns and switch between them.
 

Search , filtering , sorting  of camera models by parameters are possible. These functions
make the table suitable for optimal choice of camera models for specific tasks.
 

It is possible to print  or export  the table or its separate fragments into formats *.txt, *.csv, *.
htm, *.rtf, *.xls.
 

It is possible to paste  fragments from Excel and copy  fragments to Excel using standard
copying and pasting. 
At that the copying cell number and types of data in the copying cells should coincide.
 

In the table the sums of some parameters are automatically calculated and displayed in the
bottom row.

The table of camera models has 2 tabs:

All models
 

On the tab all camera models, which are available in the database of models, are presented. It is
possible to add  new models, edit  and delete  existing ones, as well as to assign
models to cameras in the project. 
 

The assigned model will be copied to the Used models tab automatically. 
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The database file of models on this tab is located in the VideoCAD installation directory and is not
included in the project. It is possible to save  the database of models to file and load  from file.
 

Sensitivity parameters of camera models, which are being in the table by default, are tested  in
laboratory of CCTVCAD Software. These models can be used in illumination modeling.

Used models
 

On the tab there are camera models, which have been already assigned to cameras in the project.
 

It is possible to edit  models and assign  models to cameras in the project. Adding and
deleting models from this tab is carried out automatically.
 

The assigned model from the All models tab is automatically copied to the Used models tab. If
the model is not used in the project any more, it is deleted from this tab.
 

The database of models on the Used models tab is a part of the project. As a result of opening the
project on other computer on the tab there will be the same models. You can copy  model from
this tab to the All models tab.

 

See more: Table Interface , Tool bar , Pop-up menu , Parameters of camera model .
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9.11.1 Interface

Interface of the Table of camera models includes:
 

Table Interface ;
Tool bar ;
Pop-up menu .
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9.11.1.1 Table Interface

Selecting model (row)
Selecting column
Selecting fragment
Selecting and editing cell

Changing column width
Changing row height
Moving columns
Visibility of columns
Table views

Sorting by column data
Filtering by parameter value

Searching by parameter value

Selecting model (row)
 

To select model (row) bring the cursor to the left end of the row. The cursor should become a

right arrow . Then click on this place. The selected row will be highlighted and marked by

the sign .
To select adjacent models use up arrow and down arrow keys.
By pressing the down arrow key on the bottom row, new model will be created.

Selecting column
 

To select a column bring the cursor to the border between header and data of the column. The

cursor should become down arrow . Click on this border.
To select several columns hold Ctrl. To select range of columns hold Shift or move the cursor,
holding the left mouse button.

Selecting fragment
 

Bring the cursor to a corner cell of a fragment, press the left mouse button and then move the
cursor, holding the left mouse button pressed. After selecting the fragment release the left mouse
button.

Selecting and editing cell
 

To select a cell, click on it. To edit, click on the selected cell once again. In most cells it is
possible to choose parameter value from the list.
It is possible to move around the cells using keys with arrows. For editing press Enter.
 

Some cells admit choice from the list of values only.

Changing column width
 

Bring the cursor to border of a column on the header. The cursor will become a double arrow

. Press the left mouse button and move the cursor. After getting the necessary width release
the mouse button.

Changing row height
 

Bring the cursor to border of a row on the left edge of the table. The cursor will become a double

arrow . Press the left mouse button and move the cursor. After getting the necessary height
release the mouse button.
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You can change height only for all rows simultaneously.

Moving columns
 

To move a column, place the cursor on the column header. Press the left mouse button and move
the cursor. After moving column, release mouse button.

Visibility of columns
 

You can adjust visibility of columns, save and restore table structures as Views. 

To show/hide any particular column:
 

Click on the black triangle on the top-left corner of the table;
In the appeared menu choose Visible columns;
In the appeared list of all columns check or clear name of necessary columns.

 

See also:  Table tool bar>Views .

Table Views
 

You can adjust visibility of columns, save and restore table structures as Views. 
 

See also:  Table tool bar>Views .

Sorting by column data
 

To sort by the parameter value in the column, just click on the column header. Reclick changes
sort order to the reverse one.
 

To disable sorting, sort by the Number column.

Filtering by parameter value
 

Click on the arrow in the combo box at the column top (between parameters values and header) 

 and choose parameter value from the list.
 

In this combo box you can specify following filters:
 

Order by descending;
Order by ascending;
Clear filter;
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Custom; - Combined custom filter with several conditions.
All - all rows;
Not empty - only not empty;
Empty - only empty.
Boxes with possible field value. Just select needed values.

Searching by parameter value
 

Select any cell in a column (just select by one click, the cell should not be in edit mode). Type
fast a parameter value on the keyboard. During typing search of row (of model) will be carried out

with the typing parameter value in this column .

See also: Table of camera models , Tool bar , Pop-up menu , Parameters of camera
models .
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9.11.1.2 Tool bar
 

Tool bars on All models  tab and Used models  tab differ a little. Differences are given below, in
tool descriptions.

Camera model
Assign
New
Edit
Delete
Copy to All models

Data
Save
Load
Export
Print

Views
Compress/Expand
Hide columns
Show all
Save view
Table view list
Delete view

Camera model
 

Assign
 

Assign model selected in the table to the active  camera. 
As a result of assignment, model parameters  will be assigned to parameters of the active
camera. Changing of some parameters of the active camera will be disabled or restricted
according to model limits.
If model from the All models  tab is assigned it will be copied to the Used models  tab.
 

To assign one model to all selected cameras, use pop up menu of the Model of active camera
 combo box on the Tool bar  of the Graphics window.

New
 

The button is present on the All models  tab only.
 

Create a new camera model. After clicking this button the form of new model parameters  will
appear.
 

The red highlighted parameters are used in camera modeling. The rest parameters exist only
for information and comparison of different models. The majority of parameters can be chosen
from lists. 
 

It is possible to specify parameters not only in the special form, but also directly in the table of
models.   For specifying parameter, click  the cell of table twice with an interval not less half of
second. To turn the selected cell to edit state press Enter.
It is convenient to move the focus on the cells using the arrow keys. If you press the "down
arrow" on the bottom line, a new line will be created.
 

It is possible to copy fragments into the table from Excel table. At that the number of cells and
data types should coincide.
 

See also. Parameters of camera model

Edit
 

Edit parameters of camera model. After clicking this button, the form of editing model parameters
 appears.
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The red highlighted parameters are used in camera modeling. The rest parameters exist only
for information and comparison of different models. The majority of parameters can be chosen
from lists. 
 

It is possible to specify parameters not only in the special form, but also directly in the table of
models.  For specifying parameter, click  the cell of table twice with an interval not less half of
second. To turn the selected cell to edit state press Enter.
It is convenient to move the focus on the cells using the arrow keys. If you press the "down
arrow" on the bottom line, a new line will be created.

 

It is possible to copy fragments into the table from Excel table, it is possible to copy cells within
the table of models. At that the number of cells and data types should coincide. 

 

See also. Parameters of camera model

Delete
 

Delete model selected in the table. As a result of deleting model from the Used models  tab,
model assignment will be removed from cameras, to which the deleted model had been assigned.
 

Copy to All models
 

The button is present on the Used models  tab only.
 

Copy selected model from the Used models  tab to the All models  tab.

Data

Save
 

The button is present on the All models  tab only.
 

Save model database to file.

Load
 

The button is present on the All models  tab only.
 

Load model database from file.

Export
 

Export table of camera models to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File
format can be chosen in Save as dialog box appeared.
 

You can export selected fragments using pop-up menu .

Print
 

Print full table of camera models or a selected fragment of the table. Print dialog box will open in
which it is possible to adjust printing options.

Views
 

View - is a set, width and order of visible columns. 
In the table there are more than hundred parameters  by which it is possible to describe the
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majority of security cameras existing at the moment of VideoCAD release. In real projects there
is no necessity to use all parameters. At various times different parameters sets are necessary.
You can hide  unnecessary columns, place  the rest columns in required order and save
obtained view. After that at any moment you can restore  the saved view (i.e. set and order of
visible columns). 

Compress/Expand
 

Compress columns so that the table is placed completely on the screen or restoring normal width
of columns.

Hide columns
 

Hide selected  columns. 

Show all
 

Show all columns including hidden  ones.

Save view
 

Save current table view . Dialog box will open, in which it is necessary to enter view name. The
name will appear in the Table view list .

Table view list
 

In the list there are all earlier saved views  of the table. To load a view, just choose its name in
the list.

Delete view
 

Delete the view , the name of which is displayed in the Table view list .

See also: Table of camera models , Table interface , Pop-up menu , Parameters of camera
model .
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9.11.1.3 Pop-up menu

Pop-up menu appeares at right-clicking on the Table of camera models.

Hide selected columns
Freeze columns up to selected one
Show all columns
 

Cut selection
Copy selection
Paste
Delete selection
Print
Export selection
 

Select all
 

Open Internet link
Help of parameter (F1)
 

Update cameras of the selected model
Update cameras of all models

Hide selected columns
 

Hide selected  columns.

Freeze columns up to selected one
 

Freeze columns, beginning from the left column up to selected  one. Frozen columns will not
be moved at horizontal scrolling of the table.

Show all columns
 

Show all columns including hidden  ones.

 

Cut selection
 

Cut contents of selected  cells to the clipboard.
The cut contents can be pasted  to other cells of the table or to Excel table.

Copy selection
 

Copy contents of selected  cells to the clipboard.
The copied contents can be pasted  to other cells of the table or to Excel table.

Paste
 

Paste clipboard contents to the selected  cells.
 

The content can be copied  from other sells or from Excel table. The copying cell number and
types of data in the copying cells should coincide.

428

428

428

428

428

428

429

429

429

429

429

429

429

429

422

422

427

422

428

422

428

422

428



Interface 429

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Delete selection
 

Clear selected  cells.

Print
 

Print selected  fragment of the table. 
Print dialog box will open in which it is possible to adjust printing options.

Export selection
 

Export selected  fragment to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File
format can be chosen in Save as dialog box appeared.

 

Select all
 

Select all cells.

 

Open Internet link
 

Internet link is a camera model parameter  too. To each model an Internet link to more detailed
information can be assigned.

Help of parameter (F1)
 

Open help system topic with description of the parameter in the selected cell. 
 

Effect of the item is similar to F1 pressing.

 

Update cameras of the selected model
 

At changing model parameters in the table, the parameters of cameras of this model, do not
change automatically. 
 

Choose this item to bring parameters of all cameras of the selected model in correspondence
with the parameters of this model.
 

The item is present only in the pop-up menu of Used models  tab.

Update cameras of all models
 

At changing model parameters in the table, the parameters of cameras of this model, do not
change automatically. 
 

Choose this item to bring parameters of all cameras in correspondence with the parameters of
all models.
 

The item is present only in the pop-up menu of Used models  tab.

See also: Table of camera models , Table interface , Tool bar , Parameters of camera
models .
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9.11.2 Parameters of camera model

The bold parameters are used in camera modeling. The rest parameters exist only for information
and comparison of different models. 
 

Name
Producer
Key feature
Type

TV system
Fixed, PTZ, Dome, Mini
Output
Color

Image sensor
Model
Size
Number of pixels
Scan
Aspect ratio
Rolling shutter

Row time
(microsecond)
Scan direction

Resolution
LPH  (lines per picture
height)
Contrast %
Horizontal only

Max. frame rate (fps)
Signal/noise (max, dB,
weighted)
Sensitivity

Min. scene illumination
(lx)
AT:

Exposure (ms)
Aperture (F)
Signal/noise (dB)
IRE

AESC
Processing

AGC (dB, Max)
Gamma
DSP
AWB
Compression
Other

Connectors
Switches and adjusments

ES
AGC
Gamma
Auto Iris DC
BLC
Other 1..3

Remote control
Lens

Model
Format
Mount
Type
IR correction
Focal length

Control
Min. (mm), Max. (mm)

Angles of view (deg.)
Iris

Control
Min. (F), Max. (F)

Focus
M.O.D.
Autofocus

Resolution
lp/mm  (line pairs
per mm)
Contrast %

Distortion
ON
Real angles

Additional features
Synchro
BLC
IR LED
Microphone
VMD
Flip
Other 1..3

Power supply
Voltage
Consumption

Power (watt)
Current (A)

Type of current
Case

Protection
Environment

Temperature (C)
Max. humidity (%)

Form
Sizes
Weight
Color

Compatible equipment 1..3

Compatible software 1..3
Provider
Cost
Add. cost 1..3
Total cost
Add. information
Internet link

See also: Table of camera models .
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9.11.2.1 Parameter description

 
The red highlighted parameters are used in camera modeling. The rest parameters exist only for
information and comparison of different models. The majority of parameters can be chosen from
lists. 

Number
 

Unique model number in the base of models. At the moment of new model creation the number is
generated automatically.

Name
 

Model name. 

Producer
 

Producer of the model.

Key feature
 

Key feature of the model.

Type

TV system
 

Television system (CCIR/PAL, EIA/NTSC). Not used for digital (IP) cameras (N/A).
 

If EIA/NTSC is chosen, then maximal exposure time  sets to 1/60s, or else 1/50s.

Fixed, PTZ, Dome, Mini
 

Standard camera, PTZ camera, dome camera, mini-camera, auto-dome camera.
 

If the Display camera type box (on the Camera and Illuminator Camera icon tab in the Options
box ) is checked:

If PTZ or auto-dome camera is chosen, icons of cameras of this model in the Graphics

window will correspond to PTZ camera .
If mini-camera (mini or mini-dome) is chosen, icons of cameras of this model in the

Graphics window will correspond to mini-camera .
If panoramic is chosen, icons of cameras of this model in the Graphics window will

correspond to panoramic camera  or .
 

The icon type is influenced by Protection  parameter as well.

Output
 

Output type of camera.

Color
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B/W (black&white), color, day/night (removeble IR filter) easy day/night (permanent IR filter). 
At illumination reduction day/night and easy day/night cameras are switched into black-white
mode. 
 

Color parameter influences 3D model  color as well as spectral sensitivity of cameras to
various light sourses . 
 

See more: Color
 

Image sensor

Model
 

Image sensor model. If ExView HAD ™ CCD is chosen, in calculation of illumination from
different light sources special factors  will be used, considering increased relative IR spectral
sensitivity of such image sensor.
 

See also: ExView

Size
 

The Size parameter determines size of the image sensor or size of active area of the image
sensor. 
 

See more: Image Sensor and Active area of image sensor
 

The Image sensor size can be specified by any of the following ways:
 

By format (type) in inches. For example 1/3";
 

By diagonal size of the image sensor in millimeters, in the form of dX.Y. For example: d6.0. 
 

By sensor sizes in millimeters horizontally and vertically via hash, in the form of  W#H.  For
example: 4.8#3.6;

After format or length of diagonal, separated by space, you can specify the aspect ratio of
the image sensor in the form of W:H. For example: 1/3" 16:9 or d6 16:9.  If the aspect ratio of
the image sensor is not specified, it is assumed equal to 4:3.

Active area size of the image sensor can be specified in millimeters horizontally and vertically
via asterisk, in the form of W*H. For example: 4.8*3.6;
 

See also: Image sensor size , Specifying active area size of the image sensor

Number of pixels
 

Horizontal and vertical numbers of effective pixels of the image sensor.
Number of pixels is used in modeling image resolution and in calculation of person detection,
identification and license plate reading areas.
Number of pixels of output image are set separately  and can differ from the numbers of
effective pixels of the image sensor.
 

See also: Number of pixels

Scan
 

Interlaced or progressive. Analog cameras always have interlaced scan. Digital cameras can have
progressive scan.    
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Progressive scan is preferable.
 

Modeling interlace distortion can be enabled separately in camera parameters. This parameter of
camera model does not affect the simulation of interlace scan .
 

See also: One field , Interlace

Aspect ratio
 

Aspect Ratio of the output image (horizontal side size of the output image to the vertical side
size): 4:3,  16:9 etc. 
The Aspect ratio of the output image may be different from the Aspect ratio of the image
sensor (can be specified in the Size  field).
 

See more: Specifying the Aspect ratio on output image
 

You can enter custom values from keyboard in the form of <width> :<height>, for example 11:4. 
 

By specifying formats 3:4 or 9:16, you can set the so-called corridor format in which the height
of the frame is larger than its width.
 

For correct simulation resolution in the corridor format you must also swap the number of pixels
horizontally and vertically in the camera parameters  and image processing  settings.

Via space character after the Aspect ratio you can set the crop factor - the ratio of cropping
active area size of the image sensor when the active area does not touch the edges of the image
sensor. Crop factor can be set as a vulgar fraction (separated by slash) or a real number. For
example 4:3 0.67 or 16:9 720/1080. If the crop factor is not specified, it is taken to be unity.
 

 

See also: Specifying  the crop factor , Aspect ratio , Specifying active area size of the
image sensor

Rolling shutter

Row time (microsecond)
 

This parameter is used for modeling distortion of moving 3D models  and rotating Rotak in
 object arising from the Rolling Shutter effect.  

 

As a result of Rolling Shutter work , exposure of different rows of the image sensor begins and
ends sequentially at different times, which causes a horizontal shift of moving objects.
This effect occurs with many IP cameras with CMOS image sensor and doesn't occur with
cameras with CCD image sensor.
 

Row time (microsecond) is the time period (in microsecond) between the beginning of
exposure of adjacent rows. Unfortunately this parameter is not given in the cameras'
specification. To elucidate the value of the parameter you should contact the manufacturer or
measured this time in practice.
 

See also: Rolling Shutter

Scan direction
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This switch deternines direction of scanning strings by the Rolling shutter. Top-down or Down-
top.
 

 See also: Rolling Shutter

Resolution

LPH
 

 Resolution of the camera, in LPH. At 3D modeling image resolution will be limited up to the value
set in this field.
 

If N/A is chosen in the field, then resolution limitation is disabled.
 

Items sharp+1, sharp+2, sharp+3 on the contrary increase image sharpness. With the help of
these items it is possible to model effect of Aperture corrector.
 

Aperture corrector is automatically switched-off at insufficient illumination.
 

See also: Resolution

Contrast %
 

In the Contrast % you can specify a drop of contrast in % according to the MTF at the specified
number of lines LPH .

Horiz. only
 

If Yes is set then only horizontal resolution is modeled, which is typical for analog cameras. If NO
is set, the camera resolution will decrease horizontally and vertically in the same degree.

Maximal frame rate (fps)
 

Many of megapixel cameras have limits of frame rate, which depends on image number of pixels.
The maximal frame rate of analog cameras is 25 fps (PAL) and 30 fps (NTSC).
 

For cameras of this model you can't set frame rate  more than the Maximal frame rate.
 

See also: Frame rate

Signal/noise (Max, dB, weighted)
 

Maximum signal/noise ratio. Unweighted value.
 

See more: S/N max.

Sensitivity

Min. scene illumination (lux)
 

In VideoCAD it is meant, that scene reflection factor is 0.75, light source - halogen incandescent
lamp (color temperature 3100 +-200K) according to Standard CEA 639 'Consumer Camcorder or
Video Camera Low Light Performance'. 
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For day/night  and easy day/night cameras in this box it is necessary to enter the minimum
scene illumination in black-white mode.
 

For unambiguous description of sensitivity in VideoCAD, should be pointed also:
 

with what lens aperture  the minimum illumination is measured;
signal/noise  ratio of the image at the minimum illumination;
IRE  of video signal at the minimum illumination.
exposure time at what the minimum illumination is measured.

 

In VideoCAD the minimum illumination is specified at maximum exposure time .
 

See more: Min. illum. (lx)

AT:

Exposure (ms)
 

Exposure time (milliseconds) at which the minimum illumination has been measured.
Parameter is sometimes given in camera specifications. For analog cameras typically value is
20ms (PAL) or 16.5ms (NTSC). For IP cameras and analog cameras with light accumulation the
exposure time may be up to 200ms or more.
  

At modeling the exposure time assumed the truth of the Reciprocity principle, that is inversely
proportional of sensitivity to the exposure time.

 

See also: at exposure (ms) , modeling exposure .

Aperture (F)
 

Lens aperture at which the minimum scene illumination is measured.
The parameter is given in camera specification. Typical value from F1.0 up to F2.0.
 

Signal/noise (dB,unweighted)
 

Signal/noise ratio of the image at the minimum illumination , unweighted value.  
 

According to CEA 639, limit value of signal/noise ratio at the minimum illumination determination
is 17dB (7 times in voltage). 

IRE
 

IRE of video signal at minimum illumination, at AGC switched on by default. 
 

In VideoCAD 100 IRE corresponds full peak-to-peak amplitude of video signal and accordingly to
maximum brightness amplitude on the image. 50IRE corresponds half of maximum brightness
amplitude on the image, etc.   
 

The parameter is given in camera's specification. Typical value is from 30 to 50. 

AESC  (ES, AES, shutter)
 

Exposure time limits within which electronic shutter operates. 
 

The parameter is given in camera's specification. Modern PAL system cameras have exposure
limits 1/50s-1/100000s. For cameras of NTSC system the maximum exposure is 1/60s. For IP
cameras the maximum exposure time can be larger, up to several seconds.
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See more: AESC

Processing

AGC (dB, Max.)
 

In this cell it is possible to specify Maximum AGC gain (dB) for cameras with switchable AGC
gain: High AGC gain (High AGC, S-AGC, Super AGC) or LO AGC gain.
The box will be enabled and the set AGC limit will be considered in modeling, if the Set  box is
marked.  
Enter in the cell maximum AGC gain if it is given in the camera's specification.  
 

Typical value is 26-42dB. 
 

If the camera does not have switchable AGC gain, the maximum AGC gain is calculated by the
program.
 

See also: AGC

Gamma
 

The parameter is given in cameras' specification. Normally gamma correction degree equals 0.45.
The degree equal 1 is equivalent to absence of gamma correction.
 

See more: Gamma

DSP
 

Digital image processing inside of camera. 

AWB
 

Automatic white balance. 

Compression
 

Type of compression.
 

Modeling compression can be enabled separately in camera parameters. This parameter of
camera model does not affect the simulation of compression.
 

See also: Compression

Other
 

Any other features of image processing inside of camera.

Connectors (sockets, input-output, I/O)
 

Presence or absence of various purpose connectors on camera case.

Switches and adjusments

AESC  (shutter control)
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Possibility of switching OFF/ON of electronic shutter and specifying its limits.
The parameter determines accessibility of shutter parameters  changing in the Sensitivity and
Resolution  box for a camera of this model.

AGC
 

Possibility of switching OFF/ON of AGC and specifying its limits.
The parameter determines accessibility of AGC parameters  changing in the Sensitivity and
Resolution  box for a camera of this model.
 

Low/high value corresponds to availability of AGC gain switch. AGC gain value in this case is
specified by AGC parameter AGC (dB, max) .

Gamma
 

Possibility of switching OFF/ON of Gamma correction and specifying its degree.
The parameter determines accessibility of Gamma parameters  changing in the Sensitivity and
Resolution  box for a camera of this model.

Auto Iris DC (Direct)
 

Possibility of switching OFF/ON of Auto iris DC and specifying its level.
The parameter determines accessibility of Auto iris DC  changing in the Sensitivity and
Resolution  box for a camera of this model.

BLC 
 

Possibility of switching OFF/ON of Back light compensation and specifying its type.
The parameter determines accessibility of BLC parameters  changing in the Sensitivity and
Resolution  box for a camera of this model.

Other 1..3
 

Any other switches and adjusments.

Remote control
 

Presence and type of remote control feature.

Lens

Model
 

Name of lens model. 

Format
 

Lens format must be no less than camera sensor format . 

Mount
 

Lens mount type.

336

331

336

331

436

337

331

338

331

337

331

432



VideoCAD438

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Type
 

Lens type. If fisheye is chosen then the camera is a panoramic camera (180, 360 deg).
 

See more: Panoramic

IR correction
 

Lens infra-red correction. IR corrected lenses don't shift focus between normal scene illumination
and IR illumination.

 
 Focal length

Control
 

Focal length control type. For fixed focal length, changing focal length  is locked for camera of
this model.

Min. (mm), Max. (mm)
 

Minimal focal length - camera view angles are maximal. 
Maximal focal length - camera view angles are minimal. 
For a camera of this model, changing lens focal length  is possible only within the limits
from minimal to maximal. 
 

For a lens with the fixed focal length minimal and maximal focal length are equal.
 

See also: Lens focal length

Angles of view (deg.)
 

Calculated angles of view of the lens. Angles of view are determined by VideoCAD, from camera
sensor format   and lens focal length .
 

Real angles of view can differ from the calculated ones becouse of Lens distortion

Iris

Control
 

Iris control type. For fixed iris, changing aperture  is locked for camera of this model.
 

See also: Iris type

Max. (F), Min. (F)
 

Maximum aperture = the quantity of light passing through the lens is maximal = minimal F
number.
Minimum aperture = the quantity of light passing through the lens is minimal = maximal F
number. 
 

The more the number is, the less light passes through a lens.
 

For a camera of this model aperture changing  is possible only within the limits from minimum
to maximum.
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See also: Aperture limits

Focus

M.O.D.
 

Minimum distance on which the lens can be focused.

Autofocus
 

Automatic focusing. This function can be found in cameras with built-in lens.

Resolution

lp/mm
 

Resolution of the lens in line pairs per millimeter (lp / mm).
Lp / mm - is the number of pairs of lines (black + white line) perpendicularly intersecting a segment
on the image sensor of length of 1 millimeter.
Note the difference with the unit of camera resolution, LPH. Resolution of cameras is measured in
the amount of black and white lines, but the lens resolution is measured in line pairs , that is, at the
same actual resolution, the lp / mm value is in 2 times less than LPH.
 

Effect of lens resolution on the final resolution of the camera depends on the ratio of lens resolution
in lp / mm to the number of pixels on the image sensor per 1mm (pixel density on the sensor) .
Thus, the smaller the size of the image sensor  is and the more pixels  on it - the higher lens
resolution must be in order that the lens does not spoil the resolution of the camera .
 

In the 3D Video  window image resolution will be limited by values in these boxed. If N/A is
chosen, then the lens resolution limitation is disabled.
  

You can also simulate the camera resolution . When the lens resolution simulation and camera
resolution simulation are both enabled, then their effects are summarized.
 

You can check resolution visually using the Test chart . 

Contrast %
 

 In the field you should enter contrast drop in % according to MTF (Modulation Transfer Function)
at the specified value of lp/mm .

Distortion

ON
 

Turn ON/OFF simulating lens distortion.
 

See also: Real angles

Real angles
 

Lens distortion is defined by the values of the calculated and real view angles ( horizontal, vertical ,
diagonal ) . The calculated angles  are obtained by calculating from the focal length  and the
image sensor size  (format). The real angles are usually given in the specifications of cameras and
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lenses. If the real angle is unknown, you can get them by practical measuring .
To specify distortion it is enough to set one of three real angles: horizontal, vertical or diagonal.
Preferable to set the horizontal angle. VideoCAD will calculate missing angles. For maximum
accuracy, you can specify 2 or all 3 of the real angles .
 

If the column Set  Calc is present, then this angle is not set, it will be calculated by the program, if
there is Set, the corresponding real angle must be specified.

Attention! Changing the lens  focal length  or the format / size of sensor  at fixed real angles
causes view area corruption and requires changing the real angles. 
 

See more: Lens distortion

Additional features

Synchro
 

Synchronization type: internal, linelock, genlock. Linelock and genlock are used in analog
systems for preventing vertical jitter at multiplexing and for increasing speed of video capturing
from several cameras.

BLC
 

Back light compensation control. The parameter determines accessibility of BLC control  in
the Sensitivity and Resolution  box for a camera of this model.
 

See also: BLC

IR LED
 

Presence of build-in infra-red LED illuminators.

Microphone
 

Presence of a build-in microphone.

VMD
 

Presence of a build-in Video Motion Detector.

Flip
 

Automatic flip of an image is performed in such a manner that the top of the image always
corresponds to the top of view area. Function could be found in AutoDome cameras.  

Other 1..3
 

Any additional options.

Power supply

Voltage
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Supply voltage of camera.

Consumption

Power (watt)
 

 Power consumption of camera.

Current (A)
 

The consumption current of the camera. The current is calculated by VideoCAD from power
consumption and voltage.
 

On the Used models  tab the total current and power consumption of all cameras of this model
is displayed additionally.

Current type
 

Direct current, Alternating current or Power over Ethernet (PoE).

Case

Protection
 

Case protection.
 

If protected housing (waterproof, outdoor or vandalproof) is selected and the Display camera
type box is marked (on the Camera and illuminator  tab in the Options box ), then the icon
of the camera of this model in the Graphics window will correspond to the camera in housing 

.

Environment

Temperature (C)
 

Environment temperature range.

Max. humidity (%)
 

Maximum humidity.

Form
 

Form of the case.

Size
 

Model sizes.

Weight
 

Model weight.
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Color
 

Model color.

Compatible equipment 1..3
 

CCTV equipment, which is compatible with the model.

Compatible software 1..3
 

Software, which is compatible with the model.
 

Provider
 

Provider of the camera model.

Cost
 

Model cost.

Add. cost 1..3
 

Additional costs connected to using the model.

Total cost
 

The model price including additional costs. Value is calculated by VideoCAD by summing the 
Cost  and additional costs .
 

On the Used models  tab the total cost of all cameras of this model is displayed.

Add. information
 

Any additional information about this camera model.

Internet link
 

Internet link to an information about this camera model.
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9.12 Table of cameras

Graphics window
Tool bar

Table of cameras

The table of cameras can be used to control and edit camera parameters in the project, and
for obtaining different reports as well.
 

In the table there are all input camera parameters  used in the program for calculation and all
output parameters - calculation results.
Rows in the table correspond to cameras and columns in the table correspond to parameters.
 

To get help for any parameter, select a cell and press F1 or use the Help of parameter (F1)
item in the pop-up menu.

 

For different projects, different sets of parameters can be required.
Unused columns in the table can be hidden . It is possible to create variety of table views  with
different sets of columns and switch between them.
 

Search  filtering , sorting  of cameras by parameters are possible
 

It is possible to print  or export  the table or its separate fragments into formats *.txt, *.csv, *.
htm, *.rtf, *.xls.
 

It is possible to copy  fragments  to Excel using standard copying and pasting. 
 

In the table the sums of some parameters are automatically calculated. The sums are displayed in
the bottom row.

The Table of cameras is interactive. As a result of double clicking  on any cell, camera
corresponding the row is activated and a box or several boxes are opened.  In the boxes it is possible
to control or change the parameter located in the cell. This function makes the table suitable for
control and editing camera parameters.

See also: Table Interface , Tool bar , Pop-up menu , Camera parameters .
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9.12.1 Interface

Interface of the Table of cameras includes:
 

Table Interface ;
Tool bar ;
Pop-up menu .
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9.12.1.1 Table Interface

Selecting camera (row)
Selecting column
Selecting fragment
Selecting and editing cell

Changing column width
Changing row height
Moving columns
Visibility of columns
Table views

Sorting by column data
Filtering by parameter value

Searching by parameter value

Selecting camera (row)
 

To select camera (row) bring the cursor to the left end of the row. The cursor should become a

right arrow . Then click on this place. The selected row will be highlighted and marked by

the sign .
To select adjacent cameras use up arrow and down arrow keys.

Selecting column
 

To select a column bring the cursor to the border between header and data of the column. The

cursor should become down arrow . Click on this border.
To select several columns hold Ctrl. To select range of columns hold Shift or move the cursor,
holding the left mouse button.

Selecting fragment
 

Bring the cursor to a corner cell of a fragment, press the left mouse button and then move the
cursor, holding the left mouse button pressed. After selecting the fragment release the left mouse
button.

Selecting and editing cell
 

To select a cell, click on it. To edit, double-click on it. 
It is possible to move around the cells using keys with arrows. 

As a result of double clicking on cell:
 

camera corresponding the row will be activated;
box or several boxes will be opened.  In the boxes it is possible to control or change the
parameter located in the cell.

 

If it is an input parameter for calculation, it can be changed directly in the appeared box. If the
parameter is a result of calculation, it is possible to change input parameters influencing this
result.
If it is an information parameter of camera model, the Table of camera model  appears.
 

You can not edit parameters directly in the Table of cameras.
 

After editing parameter it is necessary to refresh  parameters of this camera in the Table of
cameras using pop-up menu . 

Changing column width
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Bring the cursor to border of a column on the header. The cursor will become a double arrow

. Press the left mouse button and move the cursor. After getting the necessary width release
the mouse button.

Changing row height
 

Bring the cursor to border of a row on the left edge of the table. The cursor will become a double

arrow . Press the left mouse button and move the cursor. After getting the necessary height
release the mouse button.
 

You can change height only for all rows simultaneously.

Moving columns
 

To move a column, place the cursor on the column header. Press the left mouse button and move
the cursor. After moving column, release mouse button.

Visibility of columns
 

You can adjust visibility of columns, save and restore table structures as Views. 

To show/hide any particular column:

Click on the black triangle on the top-left corner of the table;
In the appeared menu choose Visible columns;
In the appeared list of all columns check or clear name of necessary columns.

 

See also:  Table tool bar>Views .

Table Views
 

You can adjust visibility of columns, save and restore table structures as Views. 
 

See also:  Table tool bar>Views .

Sorting by column data
 

To sort by the parameter value in the column, just click on the column header. Reclick changes
sort order to the reverse one.
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To disable sorting, sort by the Number column.

Filtering by parameter value
 

Click on the arrow in the combo box at the column top (between parameters values and header) 

 and choose parameter value from the list.
 

In this combo box you can specify following filters:
 

Order by descending;
Order by ascending;
Clear filter;
Custom; - Combined custom filter with several conditions.
All - all rows;
Not empty - only not empty;
Empty - only empty.
Boxes with possible field value. Just select needed values.

  

Searching by parameter value
 

Select any cell in a column (just select by one click, the cell should not be in edit mode). Type
fast a parameter value on the keyboard. During typing search of row (of model) will be carried out

with the typing parameter value in this column .

See also: Table of cameras , Tool bar , Pop-up menu , Camera parameters .443 448 450 452
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9.12.1.2 Tool bar

Close
 

Data
Refresh
Export
Print

Views
Compress/Expand
Hide columns
Show all columns
Save table view
Table view list
Delete table view

Close
 

Close the Table of cameras.

Data
 

Refresh
 

As a result of choosing this item, data in the selected row will be refreshed. 
 

Data are not refreshed automatically in program operation. Refreshing all data could take some
time. To refresh only one camera parameters select any cell on the row of the camera, right-click
on the cell then choose Update camera parameters  in the pop-up menu.  

Export
 

Export table of cameras to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File format
can be chosen in Save as dialog box appeared.
 

You can export selected fragments using pop-up menu . .
 

See also: PDF Report

Print
 

Print full table of cameras or a selected fragment of the table. Print dialog box will open in which it
is possible to adjust printing options.

Views
 

View - is a set, width and order of visible columns. 
In the table there are more than hundred parameters  by which it is possible to describe the
majority of security cameras existing at the moment of VideoCAD release. In real projects there is
no necessity to use all parameters. At various times different parameters sets are necessary. You
can hide  unnecessary columns, place the rest columns in required order and save  obtained
view. After that at any moment you can restore  the saved view (i.e. set and order of visible
columns). 

Compress/Expand
 

Compress columns so that the table is placed completely on the screen or restoring normal width
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of columns.

Hide columns
 

Hide selected  columns. 

Show all columns
 

Show all columns including hidden  ones.

Save table view
 

Save current table view . Dialog box will open, in which it is necessary to enter view name. The
name will appear in the Table view list .

Table view list
 

In the list there are all earlier saved views  of the table. To load a view, just choose its name in
the list.

Delete table view
 

Delete the view , the name of which is displayed in the Table view list .

See also: Table of cameras , Table interface , Pop-up menu , Camera parameters .
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9.12.1.3 Pop-up menu

The pop-up menu appears as a  result of right-clicking on the Table of cameras. 

Hide selected columns
Freeze columns up to selected one
Show all columns
 

Copy selection
Print
Export selection
 

Select all

Change parameter
Update camera parameters
 

Open Internet link
Help of parameter (F1)

Hide selected columns
 

Hide selected  columns.

Freeze columns up to selected one
 

Freeze columns, beginning from the left column up to selected  one. Frozen columns will not
be moved at horizontal scrolling of the table.

Show all columns
 

Show all columns including hidden  ones.

Copy selection
 

Copy contents of selected cells  cells to the clipboard.
The copied contents can be pasted to other cells of the table or to Excel table.

Print
 

Print selected fragment  of the table. 
Print dialog box will open in which it is possible to adjust printing options.

Export selection
 

Export selected fragment  to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File
format can be chosen in Save as dialog box appeared.

Select all
 

Select all cells.

Change parameter
 

The item is accessible, if the cursor is above selected cell. Effect of the item is the same as
double clicking on the cell.
 

After choosing this item, camera corresponding the row will be activated and a box or several
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boxes will be opened.  In the boxes it is possible to control or change the parameter located in
the cell.
 

If it is an input parameter for calculation, it can be changed directly in the appeared box. If the
parameter is a result of calculation, it is possible to change input parameters influencing this
result.
If it is an information parameter of camera model, the Table of camera models  appears.
 

It is impossible to edit parameters directly in the Table of cameras.
 

After editing parameter it is necessary to update  parameters of this camera in the Table of
cameras.

Update camera parameters
 

As a result of choosing this item, data in the selected row will be refreshed. 
 

Data are not refreshed automatically in program operation. 
 

To refresh all data use the Refresh  button.
 

Refreshing all data could take some time.

Open Internet link
 

Internet link is a camera model parameter  too. To each model an Internet link to more detailed
information can be assigned.

Help of parameter (F1)
 

Open help system topic with description of the parameter in the selected cell. 
 

Effect of the item is similar to F1 pressing.

See also: Table of cameras , Table interface , Tool bar , Camera parameters .
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9.12.2 Camera parameters

The Table of cameras only displays camera parameters. Changing parameters is possible in other
boxes of the program. Boxes for editing parameters can be called by double clicking  on a cell in
the Table of cameras.
Detailed descriptions of each parameter are in Help topics of corresponding boxes.

Camera parameters include:

1. Basic parameters of camera:
 

Number ;
 

Unique number which is assigned to camera at its creation . It can be changed in the Camera
list  box.
 

Name ;
 

It is assigned at creation . Later it can be changed in the Camera list  box or using the
Camera numeration  tool or by double clicking on the cell in the Table of cameras.
 

Layout ;
 

Layout , on which the camera is placed.
 

Layer ;
 

Layer  to which the camera belongs.
 

Description ;
 

Any additional information about the camera. The information can be entered at camera creation
 and can be changed in the Camera list  box.

 

2. Parameters of camera model ;
 

Among input parameters of model in the Table of cameras there are calculation results
obtained during image modeling:

Current signal/noise ratio (dB, unweighted) ;
Current Electronic shutter exposure (1/s) ;
Current AGC gain (dB) ;
Current lens focal length (mm) ;
Current angles of view ;
Current aperture .

 

3. Camera installation parameters (Geometric parameters) ;
 

4. Criteria of person detection, identification and license plate reading ;
 

The criteria are combined into Quality levels .
  

5. Depth of Field and Spatial resolution:
 

Name of Spatial resolution pattern ;
Depth-of-field parameters ;

 

6. Parameters of 3D modeling:
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Scene parameters ;
Camera parameters ;
Parameters of Image processing ;

 

7. Cable parameters:
 

Signal cable length ;
Power cable parameters .

See also: Table of cameras , Table interface , Tool bar , Pop-up menu .
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9.13 Depth of field

Graphics window
Main menu

View
Depth of field

 

When using long-focus lenses the depth of field calculation may be necessary. 
For example, in the case when one camera is used for the person identification at a short distance
and for the person detection at a long distance. At that the sufficient resolution is required in both
cases.   

 With the help of VideoCAD you can:
 

Calculate the view area bounds, in which the resolution is not less than the predetermined value (
sharpness area).
Find the optimal focus distance of the camera lens to get the required sharpness area bounds. 
Find the resolution in any point in view area with other parameters specified.   
Simulate  Depth-of-Field distortion in the 3D Video .

The depth-of-field is influence by: 
 

Lens focal length. The less focal length  is the more is the depth of field. It makes sense to
calculate practically the depth-of-field in CCTV beginning from the focal length 8-12 mm when
resolution is less than 500-800 Lines per picture height (LPH). With less focal lengths the depth-of-
field is sufficient at the correct lens focusing.  

 

As a rule with Megapixel cameras we need high optical resolution of lens.Therefore with megapixel
cameras the Depth of field distortion can arise with the lesser focal length. 
 

Aperture. The more the aperture number is the more is the depth-of-field. This dependence is
clearly seen when using autoiris lenses. In the dark the diaphragm opens and the depth-of-field
decreases.     
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Boundary resolution. I.e. minimum acceptable resolution in the sharpness area. At that we
should remember that we won't get better resolution, than other video system components
can give. The boundary resolution should not exceed the real resolution of the in-focus image. 

 

Focus distance. I.e. minimum distance from the lens to the plane that is perpendicular to the
main optical axes, on which the lens is focused. 
 

In most cases it is impossible to focus practically the lens on the predetermined distance,
because the image sensor and monitor resolutions limit the possibility of viewing  the maximal
resolution at the focus point. Practically we are more interested in the sharpness area bounds. But
operating with the focus distance we can calculate these bounds, and then achieve by the
practical lens adjusting .      

Hyperfocal distance
 

An important notion is the hyperfocal distance - the closest point of focus at a given aperture, at
which infinity falls within the Depth of field.
When the lens is focused on the hyperfocal distance, the sharpness area extends from half the
hyperfocal distance to infinity. In this case the sharpness area will have maximum extension. 
 

The hyperfocal distance depends on:
 

lens focal length;
aperture;
boundary resolution.  

 

In many cases the optimal focus distance is the hyperfocal distance.  But there are exceptions when
sharpness at a long distance is not required, but shrpness at a distance less than the half of the
hyperfocal distance.    But there are exceptions, when it is not required the sharpness at a long
distance, but the sharpness at a less distance than the half of the hyperfocal distance. In this case
it is necessary to focus the  lense at the distance less than hyperfocal. At that we lose sharpnes at
longer distances and get sharpness at shorter distances.    

All these calculations can be performed with the help of the Depth of field calculation box. 
Calculations for the active camera in the numerical form is possible in any state. 

 

When the depth of field box is visible, next to all
cameras in the horizontal projection the
following lines are displayed:

sharpness area bounds ;
focus plane ;
plane at the hyperfocal distance .

These lines are calculated according to the 
depth of field parameters  of each camera at
the height of depth of field measurement .
 

If the focus plane or the plane at the
hyperfocal distance not intersect the
horizontal plane at the height of depth of field
measurement within the view area
projection, then the focus plane or the plane
at the hyperfocal distance are not displayed. 

 

If the near or the far bound of the sharpness area  not intersect the horizontal plane at the height
of depth of field measurement within the view area projection, then this bound is not displayed.
 

The absence of near and far bounds of the sharpness area indicates that the sharpness area
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completely covers projection of view area, thus the depth of field does not reduce the resolution of
the camera.
 

Depth of Field calculation doesn't take into account Lens distortion .
 

3D modeling  depth-of-field and modeling depth-of-field depending on scene illumination for auto
iris  lenses are possible.
 

See also: Parameters in Depth of field box , Example of Depth-of-field calculation , 3D Video
main menu>Depth-of-field , Check ing Depth of Field in horizontal projection
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9.13.1 Parameters in Depth of field box

Aperture
Auto Iris lens
Boundary resolution 
Height
Hyperfocal distance 
Insert in report
Focus distance
The button "Specify the focus plane"
Sharpness area bounds 
Resolution at distance
Default
Selected cameras

 

Aperture (f-number)
 

The number, characterizing the amount of light, coming through the lens. Set in this combo-
box a value, given in the lens specification. If the auto-iris lens is used and the calculation for
minimum lighting is required, set the minimum f-number, given in the lens specification. The
minimum number characterizes opened diaphragm, at that the depth of field is minimum. If it is
necessary to determine the minimum aperture to get the specified depth of the field, then in this
box select the number necessary to get the required depth of field.

Auto Iris lens
 

If the box is checked, at depth of field calculation the aperture value , computed during 3D
modeling illumination, will be used. If the box is not checked, the aperture value, specified in the 
box Aperture  (F number), is used.

Boundary resolution
 

The minimum acceptable resolution in the sharpness area in lines per picture height (LPH).
At that we should remember that we won't get better resolution than other video system
components can give. The boundary resolution should not exceed the real resolution with the
in-focus image. The resolution on the calculated bound of the sharpness area will be equal to the
specified boundary resolution, and inside the sharpness area the resolution will be higher.
Changing the value in this box we can get the sharpness areas for different resolutions.  
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Height
 

Height of measuring Depth of Field in the horizontal projection.
If the main optical axis of the camera is not parallel to the horizon, the Depth of Field in the
horizontal projection depends on the height above the ground.
 

In multi-level 3D projects the height of the ground surface equals to the base height  of the
active camera.
 

The AUTO indicates that the height is equal to the middle height between the view area lower
bound height  and the  view area upper bound height .

Hyperfocal distance
 

It is calculated basing on the lens focal length  of the active camera, aperture and
boundary resolution. If the lens is focused on the hyperfocal distance, then the sharpness area
stretches from the half of this distance to the infinity. In this case the sharpness area will have the
maximum extension.  

Insert in report
 

If the box is checked, the calculation results of the active camera depth of field will be included in
the text file, getting when Text report . 

Focus distance
 

Minimum distance from the lens to the plane, perpendicular to the main optical axes, on which
the lens is focused. Sharpness area bounds depend on the focus distance. 

 The button "Specify the focus plane
 

With the Depth of Field box opened, in the horizontal projection, but in the graphical editing
state  of the active camera in the vertical projection too can be seen:

 

sharpness area (heavy blue line);
plane at the hyperfocal distance (heavy turquoise line);
plane at the focus distance (thin turquoise line). 

Line types can be changed in the Options box . 
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After clicking this button: 
A click on the view area set up a new focal plane location. At that all other parameters are
recalculated. 
When moving the cursor over the view area of the active camera on the Status bar  at the
bottom of the graphics window the current distance from the lens and the resolution in the
cursor point are displayed. 

 

In the horizontal projection calculations are performed at the height of measuring Depth of Field
.

Sharpness area bounds
 

Near and far sharpness area bounds. The far bound can amount to infinity. 

Resolution at distance
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If in the Distance box to specify the distance from the lens, then in the Resolution box the
resolution at this distance can be seen. 
At that it is necessary to remember that we won't get better resolution than other video system
components can give.      

Default
 

Clicking this button assigns default depth of field parameters to the active camera:
Boundary resolution  = 0.7* Phor/Aspect ratio;
where: 

0.7 - Kell factor;
Phor - horizontal number of pixels (minimum value from number of pixel of the image sensor

 and the number of pixel specified on the Processing  tab); 
Aspect ratio - a ratio of Horizontal frame size to vertical one;

Focus distance  = hyperfocal distance ;
Height =AUTO; 

Selected cameras
 

If this box is checked, clicking on the Default  button assigns default depth of field parameters
to all  selected  cameras at once. 

See also: General information on the depth of field in CCTV , Example of Depth-of-field
calculation , 3D Video main menu>Depth-of-field , Check ing Depth of Field in horizontal
projection.
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9.14 Illuminator calculation

Graphics window
Current construction parameter panel

Illuminator calculation

The box is intended for specifying internal lighting and photometric parameters of illuminator  for
modeling the illuminator in VideoCAD.
The box appears during illuminator creation and can be called at illuminator editing by the Illuminator

calculation  button  on the Current construction parameter panel .
 

The Illuminator calculation button  is displayed on the Current construction parameter panel only
during creation or editing of illuminator.
 

Illuminator parameters are divided into:
 

Lamp parameters ;
Luminaire parameters . 

 

Begin entering parameters from parameters of lamp (strictly from Lamp type at the up-left corner).
During entering lamp parameters, the derivative parameters will be calculated automatically. After
entering all parameters, it is possible to correct derivative parameters if necessary.
 

After entering parameters click OK.
 

The created illuminator model with specified parameters will be the calculation result. 
 

For information in the box the following values are displayed:
 

Axial light intensity ;
Illumination  produced by the illuminator at specified distance  an axis of radiation.

 

Using a luxmeter you can check illumination value on specified distance from the real illuminator,
then choose parameters to achieve full identity of the model and the real illuminator.
 

You can change location of created illuminator model in horizontal projection by moving  and
rotating  similarly to other constructions . Illuminators can be copied .
You can specify installation height , vertical inclination angle , dispersion , switch
illuminator ON/ OFF on the Current construction parameter panel . 

Created Illuminator will take part in 3D image modeling from some camera only if for this camera:
Illumination modeling is switched on ;
Illuminators are enabled ;
The Illuminator is switched on .
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While modeling Illuminators VideoCAD considers only direct light. Reflected light can be considered
only approximately by specifying a part of light  from this Illuminator diffused on the scene.
Shadows cannot be modeled in VideoCAD6.

See also: Lamp parameters , Luminaire parameters , IR illuminators , Illuminator , Current
construction parameter panel>Illuminator , 3D Video>Image parameters panel>Scene .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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9.14.1 Lamp parameters
 

Lamp parameters are located on the Lamp
panel, on the left half of the Illuminator
calculation  box.

   

In case of modeling infra-red illuminator, see IR illuminators .

Lamp type
Light efficiency (lm/watt)
Spectral efficiency of radiation
Edit

Lamp power (watt)
Light flux emitted by lamp (lm)

Lamp  type
 

In the box is necessary to choose lamp type. 
 

Lamp type determines:
Light efficiency ;
Spectral efficiency .

 

After choosing IR LED in the Lamp type box, units of measure in some boxes will be changed. 
See more: IR illuminators .

Light efficiency (lm/watt)
 

Light efficiency determines what part of lamp power is converted to visible light. In other words, it
is efficiency of the lamp as a source of visible light. Light efficiency is measured in lumens/watts
and is given in lamp specifications. 
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Average value of light efficiency of chosen lamp type  is displayed in the box.
 

VideoCAD offers average values of light efficiency for different lamp types. Light efficiency of real
lamps can be different. For precise modeling, see lamp specification.
 

For different lamp types the light efficiency is from 8-15 (incandescent lamps) up to 140-180
(sodium lamps) and more lumen/watt.
 

Very often in lamp specifications Power (watt) and Full light flux (lumen) are given instead of the
Light efficiency. In this case enter the full light flux value from lamp specification to the Light
flux emitted by lamp  box.
 

Spectral efficiency of radiation
 

Sensitivity of different types of image sensor to radiation of different wavelengths (spectral
sensitivity) essentially differs from human eye spectral sensitivity (and luxmeter sensitivity
coinciding with it). 
Radiation spectrums of different lamp types can be different.
 

VideoCAD considers this difference through in advance calculated and experimentally verified
spectral efficiency factors of different light sources for different types of cameras.
 

During illumination modeling VideoCAD calculates efficiency of each illuminator depending on 
image sensor type  of the active camera.
 

During designing it is not necessary to change these factors. 
 

See more: What is spectral efficiency . 

Edit
 

Edit Light efficiency  and Spectral efficiency  of chosen lamp type . 
 

In VideoCAD the calculated and experimentally verified  factors are given. In most cases there
is no necessity to change them. 
 

The same values of spectral efficiency factors are used in modeling background light  in the 3D
Video .

Lamp power (watt)
 

In the box the power consumption of lamp (watt) is specified.

Light flux emitted by lamp (lm)
  

After specifying the power consumption, the full light flux emitted by the lamp (lumen) will be
displayed in the box. The full light flux is calculated from the power consumption and average light
efficiency  of chosen lamp type .
 

It is recommended to enter in this box value from specification for more precise modeling.

See also: Illuminator calculation , Luminaire parameters , IR illuminators , Illuminator ,
Current construction parameter panel>Illuminator , 3D Video>Image parameters panel>Scene .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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9.14.2 Luminaire parameters
 

  

Luminaire parameters are located on the 
Luminaire panel, on the right half of the
Illuminator calculation  box.
 

 

To allow for lamp aging, supply voltage deviation, as well as luminaire dirt depreciation in operation it
is necessary to set Maintenance factor of illuminators on the 3D modeling  tab of the Options
box  according to CIE 97.  
 

In case of modeling infra-red illuminator, see IR illuminators .

Lamp quantity
Efficiency factor
Light flux emitted by Illuminator (lm)
 

Omnidirectional light source
Light intensity (cd)

 

Projector
Angle of radiation (deg.)
Concentration
Axial light intensity (cd)

 

Illumination at distance
Distance (m. or ft.)
Illumination (lux)

Lamp quantity
 

Number of lamps in the Luminaire.
 

Lamp parameters are set on the Lamp  panel.
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Efficiency factor
 

Efficiency of the luminaire. 
 

A part of the luminous flux emitted by lamps is consumed inside the luminaire or is emitted
outside the angle of radiation .
 

Efficiency factor of the luminaire is a ratio of the light flux emitted within the limits of
radiation angle to the total light flux  of all lamps.

Typical values of efficiency factor for new luminaires:
 

For luminaires with angle of radiation of more than 100 degrees - 0.6-0.9;
For luminaires with angle of radiation of 50-100 degrees - 0.5;
For luminaires with angle of radiation of 20-50 degrees - 0.4;
For luminaires with smaller angle of radiation, the efficiency factor can reach up to 0.2.

 

For IR illuminators  the recommended efficiency factor is 0.3-0.5. 
 

In IR illuminators a part of consumed power is lost in internal circuits and filter. 
 

In operation the luminaire efficiency factor is reduced depending on environment contamination. 
 

It is possible to allow for environment contamination through the maintenance factor  of
illuminators.
 

The efficiency factor is sometimes given in the luminaire specification, but the light intensity
curves  with the lamp with full light flux of 1000 lumen are given more often. In this case,
it is necessary to select efficiency factor in this box to obtain light intensity value, recalculated
according to light flux of the lamp in the luminaire. 
 

For example: The total light flux of all lamps is F=3000 lumen. In this case an axial light

intensity value obtained from the light intensity curves (with the lamp of 1000 lumen) has to be
multiplied by 3.

Light flux emitted by Illuminator (lm)
 

The light flux of the illuminator within the limits of angle of radiation . The light flux of the
illuminator equals to the total light flux of all lamps, multiplied by efficiency factor  of the
luminaire.

Omnidirectional light source
 

The illuminator emits light in all directions with equal light intensity. 
For example, a lamp without reflector. 
 

An omnidirectional illuminator has one parameter - light intensity (candela).

Light intensity (cd)
 

Light intensity of the omnidirectional illuminator, equal in every direction. It is the most important
parameter of the illuminator. 

Projector
 

An illuminator with limited angle of radiation. The majority of real luminaires have limited angle of
radiation.
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Angle of radiation (deg.)
 

The full angle of radiation at the top of the light cone. The light flux of the illuminator is emitted
within the limits of this angle. 
The angle of radiation influences illumination area and light intensity  of the illuminator. Having
identical lamps, the luminaire with a smaller angle of radiation will have higher light intensity
and, therefore, produces higher illumination.

Concentration
 

The ratio of light intensity on the borders of the radiation cone to light intensity on the axis of the
radiation cone. 
Real luminaires have irregular light distribution within the limits of the radiation cone. As a rule,
light intensity is maximal in the center of the cone. 
 

In luminaire specification the light intensity curves with the lamp with full light flux of 1000
lumen are given. During construction or editing of the illuminator  in the Graphics window, the
light intensity curves of the luminaire model are displayed. 
By moving grips in the Graphics window (Ctrl is pressed) or by changing concentration it is
possible to reach closer light intensity distribution. High precision is not required; a rough
correspondence of the light intensity curves is enough. The axial light intensity  should be
selected more precisely. 
 

When changing concentration, the full light flux  of the illuminator is not changed. If light
intensity increases on the radiation axis, it weakens on the borders of the radiation cone and vice
versa.
 

Using one illuminator model in VideoCAD it is possible to model only a point light source with
round symmetrical light intensity distribution. Luminaires with non-round symmetrical light
intensity distribution can be modeled by one illuminator only roughly. For accurate modeling
several illuminators should be used.  Recount their light fluxes, reaching the light intensity value
similar to light intensity value of the real luminaire.

Axial light intensity (cd)
 

Light intensity on axis of radiation. 
It is the most important parameter of the luminaire. All the previous parameters are used for
estimation of the light intensity. 
 

If there are the light intensity curves with the lamp with full light flux of 1000 lumen in the
luminaire specification, light intensity should be recalculated in proportion to the total light flux of
the real lamps  in the luminaire. 
 

For example: the total light flux of lamps is 3000 lumen. In this case the axial light intensity value
obtained from light intensity curve (with lamp of 1000 lumen) has to be multiplied by 3.
 

Then by selecting the efficiency factor , it is necessary to reach an equal value of the axial
light intensity.
 

If there are no light intensity curves in the specification, but there is an axial light intensity value,
it is necessary to select an efficiency factor value for obtaining the equal axial light intensity.
 

If in the specification there are no such parameters, or the specification is absent, only estimation
is possible. Specify  0.5 as the efficiency factor value and concentration  =0.5. In practice,
the estimation is usually enough.
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Illumination at distance
 

On the panel you can calculate illumination produced by the illuminator on the specified distance.
For projector illumination is calculated on axis of radiation.
 

Values on this panel are given only for information and do not influence parameters of the
illuminator model. 
 

Illumination is calculated on the plane perpendicular to axis of radiation. 
 

By means of luxmeter you can verify illumination value on the specified distance from the real
luminaire and by selecting parameters reach complete identity of the model and the real
luminaire.

Distance (m. or ft.)
 

Distance from the luminaire on which illumination is calculated. The distance is measured in
meters or foots depending on measuring formats  in the project.

Illumination (lux)
 

The calculated illumination. As in CCTV the sensitivity of cameras is measured only in lux,
illumination is displayed in luxes irrespective of the measuring format in the project.
 

1 foot-candela equals 10.76 lux.

See also: Illuminator calculation , Lamp parameters , IR illuminators , Illuminator , Current
construction parameter panel>Illuminator , 3D Video>Image parameters panel>Scene .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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9.14.3 IR illuminators

IR LEDs radiate out of visible light range,
therefore their characteristics cannot be
measured in photometric units (lumens,
candelas and luxes). Characteristics of IR
LEDs are measured in power units (watts,
watts/steradian, watts/m2).
 

  

In the same time black-white cameras are sensitive in the infra-red range, but their sensitivity is
measured in photometric units (lux). Therefore, it is necessary to convert power values to the
photometric ones.

After selecting IR LED in the Lamp type  box, measurement units are changed in the boxes:
 

Light efficiency (lm/watt)>LED efficiency factor (watt/watt)
Spectral efficiency of radiation (lumen / lumen) >Spectral efficiency of IR radiation (lumen / watt)
Light flux emitted by lamp (lm)>Radiant power (watt)
Light flux emitted by Illuminator (lm)>Radiant power (watt)
Axial light intensity (cd)>Axial radiant intensity (watt/Sr)
Illumination (lux)>Irradiance (watt/m2)

Light efficiency (lumen/watt)>LED efficiency factor (watt/watt)
 

Instead of light flux (lumen), for measuring IR radiation power watts are used.
Therefore, measurement unit in this box is the efficiency factor of LED, i.e. the ratio of radiant
power in the specified IR range to consumed electric power.
 

Efficiency factor of modern IR LEDs is 0.06..0.35. To obtain efficiency factor it is necessary to
divide the full radiant power by the consumed electric power. 
 

These parameters are given in characteristics of LEDs. If the LED type, efficiency factor or
radiant power are unknown, it is recommended to enter in this box efficiency=0.1.

Spectral efficiency of radiation (lumen / lumen) >Spectral efficiency of IR

radiation (lumen / watt)
 

Black-white sensor sensitivity to IR radiation of different wavelength essentially differs. Between
image sensors of different types, there is also a difference in spectral sensitivity.
Color cameras are practically insensitive to infra-red illuminators.
 

VideoCAD considers this difference through in advance calculated and experimentally verified
spectral efficiency factors of IR illuminators of different wavelengths.
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The spectral efficiency factor for IR radiation (lumen/watt) of the specified wavelength
and specified type of image sensor is equal to the light flux (lumen) of a halogen
incandescent lamp with color temperature Tc=3100K having equal efficiency with IR
radiation of the specified wavelength having power of 1 watt for the specified type of
image sensor
 

Through the spectral efficiency factor the power of IR radiation is converted to photometric
equivalent. This is necessary, as camera sensitivity is measured in photometric units (lux). 
 

Cameras' sensitivity in VideoCAD is given to the light from halogen incandescent lamp,
according to standard CEA 639 ' Consumer Camcorder or Video Camera Low Light Performance
'. 
 

Spectral efficiency factors are given for five basic types of image sensors:
 

Standard black-white CCD and CMOS sensors;
 

Sony ExView HAD™  CCD sensors, having increased relative spectral sensitivity to infra-
red radiation;

 

Standard color sensors of day/night cameras with color filters (without IR filter). 
 

Color filters weaken sensitivity in visible light range more strongly, than in infra-red range. As a
result, image sensors of day/night cameras have lower sensitivity in visible light range, or, that is
the same, the increased relative sensitivity in infra-red range.
 

Sony ExView HAD ™ sensors of day/night cameras with color filters (without IR filter). 
 

Effects from decreasing sensitivity in visible light range by color filters and from increasing
sensitivity in infra-red range due to Sony ExView HAD ™ technology are added. Such image
sensors have the highest relative sensitivity in infra-red range. 
 

Standard color sensors with color filters and IR filter. Color cameras are practically insensitive
in infra-red range.

 

During modeling images, VideoCAD automatically calculates efficiency of each illuminator
depending on image sensor type  of the active camera.
 

Reflecting ability of different objects differs in light of incandescent lamps and in IR light. Spectral
efficiency factors are obtained from tests with white paper and a human body.
 

Example 1: Scene is illuminated by halogen incandescent lamp with color temperature
Tc=3100K, the luxmeter shows illumination of 0.1 lux.
To reach exactly the same image from the camera at illumination from IR illuminator with the
spectral efficiency factor of 50 lumen/watt, IR illumination should be 0.1/50=0.02 watt/m2. 
 

As color cameras are insensitive to IR radiation, for them the spectral efficiency factor of IR
radiation is equal to zero. 
 

During design it is not necessary to change these factors. 

Light flux emitted by lamp (lumen)>Radiant power (watt)
 

Instead of light flux (lumen) for measuring IR power watts are used. 
After specifying the consumed power , in the box the total radiant power of IR LED (watt) is
displayed. Total radiant power of IR LED is calculated from consumed power and efficiency
factor  of the IR LED. 
 

You can enter in this box the value from LED specification for more accurate modeling.
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Light flux emitted by Illuminator (lumen)>Radiant power (watt)
 

It is projector radiant power within the limits of the radiation angle . The projector
radiant power is equal to the sum of radiant powers of all LEDs  (if they are several), multiplied by 
efficiency factor  of the illuminator.

Axial light intensity (candel)>Axial radiant intensity (watt/steradian)
 

Instead of light intensity (candelas) for measuring IR radiant intensity the watt/steradian is
used.
It is an axial IR radiant power.
It is the most important parameter of the illuminator. All previous parameters are used
for estimation of the radiant intensity. 
 

If in specification of IR illuminator the radiant intensity curves are given, it is necessary to reach
by selection of Radiant power  (watt) equal value of an axial radiant intensity.
 

If in specification there are no radiant intensity curves, but there is a value of the axial radiant
intensity, it is necessary to select value of the Radiant power to obtain equal axial radiant
intensity.
 

If in the specification there are no such parameters, or the specification is absent, only estimation
is possible. 
 

Specify:
Efficiency factor =0.3 for the narrow angle luminaire (radiation angle  of 20-50 degrees);
Efficiency factor =0.5 for the wide-angle luminaire (radiation angle of 60-120 degrees).
Concentration  =0.5. 
 

In practice the estimation is enough.

Illumination (lux)>Irradiance (watt/m2)
 

Instead of Illumination (lux), the Irradiance (watt/m2) is used.

See also: Illuminator calculation , Lamp parameters , Luminaire parameters , Illuminator ,
Current construction parameter panel>Illuminator , 3D Video>Image parameters panel>Scene .
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9.14.4 What is the spectral efficiency
 

Sensitivity of different types of image sensor to radiation of different wavelengths (spectral sensitivity)
essentially differs from human eye spectral sensitivity (and luxmeter sensitivity coinciding with it). 
Radiation spectrums of different lamp types can be different.
 

For example, luminescent and Incandescent lamps produce equal scene illumination according to
luxmeter reading. But the image from a black-white camera directed on this scene will not be equal
at scene illumination produced by different lamps. The difference in the equivalent illumination can
reach four or more times. Color cameras are practically insensitive to IR illuminators, and black-
white cameras have sensitivity depending on maximum wavelength of the IR illuminators.
  

VideoCAD considers this difference through in advance calculated and experimentally verified
spectral efficiency factors of different light sources for different types of cameras.
 

Spectral efficiency factor for specified lamp and camera types is equal to light flux

(lumen) produced by halogen incandescent lamp with color temperature Tc=3100K. At

that, this light flux is equivalent for the specified camera type to one lumen of the light

flux from the specified lamp type. 

 

In other words:
 

Spectral efficiency factor for specified lamp and camera types shows for how much

efficiency of light produced by this lamp for this camera higher or lower than efficiency of

light produced by halogen incandescent lamp with color temperature Tc=3100K, in case

when both lamps create equal illumination according to luxmeter reading. 

 

Cameras' sensitivity in VideoCAD is given to the light from halogen incandescent lamp, according
to standard CEA 639 ' Consumer Camcorder or Video Camera Low Light Performance '. 
Spectral efficiency factors are given for five basic types of image sensors:
 

Standard black-white CCD and CMOS sensors;
 

Sony ExView HAD™  CCD sensors, having increased relative spectral sensitivity to infra-red
radiation;

 

Standard color sensors of day/night cameras with color filters (without IR filter). 
 

Color filters weaken sensitivity in visible light range more strongly, than in infra-red range. As a
result, image sensors of day/night cameras have lower sensitivity in visible light range, or, that is the
same, the increased relative sensitivity in infra-red range.
 

Sony ExView HAD ™ sensors of day/night cameras with color filters (without IR filter). 
 

Effects from decreasing sensitivity in visible light range by color filters and from increasing
sensitivity in infra-red range due to Sony ExView HAD ™ technology are added. Such image sensors
have the highest relative sensitivity in infra-red range. 
 

Standard color image sensors with color filters and permanent IR filter. 
 

Spectral sensitivity of color sensors with permanent IR filter is similar to human eye spectral
sensitivity and a luxmeter spectral sensitivity, therefore the Spectral efficiency factor is closed to
one.
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During modeling images, VideoCAD automatically calculates efficiency of each illuminator depending
on image sensor type  of the active camera.
 

For color cameras  and visible light sources the Spectral efficiency factors are closed to one
(0.8..1.2), but for black-white cameras the factors can be from 0.25 to 1.2. 
For special light sources the Spectral efficiency factors can be in wide range. 

Example 1: Black/white camera sensitivity , given in specification, is equal to 0.1 lux at scene
illumination produced by halogen incandescent lamp. 
Sensitivity of the same camera to the mercury lamp light with spectral efficiency factor 0.45 will be
equal to 0.1*0.45=0.22 lux. 
 

Example 2: The scene is illuminated by standard incandescent lamp with spectral efficiency factor
1.15, the luxmeter shows scene illumination 0.1 lux.
If obtain the same image from camera at illumination produced by sodium lamp with spectral
efficiency factor 0.35, the luxmeter will show 0.1*1.1/0.35=0.31 lux. 
 

Example 3: Efficiency of any lamp for a human eye is equal to the light efficiency . Relative
efficiency of any lamp for CCTV is equal to the product of light efficiency multiplied by spectral
efficiency. Spectral efficiency of halogen incandescent lamp (Tc=3100C) is considered to be one.
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9.15 Options

Graphics window
Main menu

View
Options
 

The box is intended for adjusting various parameters of the program.
 

The box can be opened by choosing the item View > Options  in the Main menu of the Graphics
window  or by double-clicking on the Line type panel  or the Font type panel .

The box consists of the following tabs:
 

Lines
Fonts
Keyboard
Camera and Illuminator
3D modeling
Export
Miscellaneous
Tool bar

 

All the parameter changes in the tabs become valid immediately and you can see their result.
 

To save the introduced changes click OK. 
To cancel the changes click Cancel.
To assign default values to all parameters on the opened tab click Default.
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9.15.1 Lines

Graphics window
Main menu

View
Options

Lines

  

Left side of the tab
 

In the left side of the tab you can see and change parameters of any VideoCAD line type.
 

Up to 2000 types of lines can be used in VideoCAD project.
 

Parameters in the left side of the tab :
 

Number - the number of the displayed line type. Each line type has unique number from 1 to

2000.
 

Name - the name of the line type. The name can be changed.
 

Style - the name of line style. It can be chosen from the list (Solid, Dash, Short Dash, DashDot,

DashDotDot, etc). 
 

Shadow - If the box is checked then all constructions made by this line type are considered as

obstacles at calculating shadows .
 

In addition, to make a construction be considered as obstacle in calculation of shadows, it must
belong to a layer with the shadows  option marked
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them
 

Cable -  If the box is checked then line segments  made by this line type are considered as

cables. Their lengths are included in the cable report , their names present in the Cable brand
lists in the Signal cable  and Power cable  length calculation boxes. 

 

Screen width  - line width on the screen (pix).
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Print width - line width when printing (mm,inch).
 

Screen color - line color on the screen.
 

Print color - line color when printing.

Parameters, relating to the 3D tools:
 

Maximum height - maximum height above the ground of 3D objects , made by the line of this

type. Also the height above the ground of 3D models . 

Minimum height - minimum height above the ground of 3D objects, made by the line of this

type. 
 

Heights can also take on negative values, and at that 3D model plunges under ground. 
 

In multi-level 3D projects the ground height equals to the base height of a layer  to which the
construction belongs.
 

It is possible to change the heights on the Current construction parameters panel irrespective of
line type.
 

Color - the color of 3D objects, made by the line of this type.  

Reflection - reflection factor of the selected color in illumination modeling.
 

The reflection factor is calculated automatically and is given for information.
  

Right side of the tab
 

In the right side of the tab you can see and change the numbers of line types for displaying the
system objects:
 

View area edges.
View area projection bounds.
Horizontal bounds.
Signal cable.
Power cable.
Grid.
Person detection area projections.
Person identification area projections.
License plate reading area projections.
Ground indication.
Height indication.
Sharpness area.
Focus plane.
Plane at the hyperfocal distance.
Default line type for 3D models.

Don't use the system lines for constructions and change their parameters without necessary.
Sometimes it leads to confusion.
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9.15.2 Fonts

Graphics window
Main menu

View
Options

Fonts

Left side of the tab
 

In the tab left part you can see and change parameters of any VideoCAD font type.
 

Up to 100 types of fonts can be used in VideoCAD project.
 

Parameters in the tab left part:
 

Number - the number of the displayed font type. Each font type has unique number from 1 to 30.
 

Name - the name of the font type. The name can be changed.
 

Style in Windows - the name of font typeface. It can be chosen from the list. 
 

It is necessary to remember that not all the font typefaces are scaled correctly. To use
VideoCAD it is recommended to use only scalable typefaces (True Type or Open Type). Using
bit-mapped fonts (e.g.,MS Sans Serif) is not recommended.

 

Height - The font height in inches (in the actual drawing sizes). 1 inch = 2.54cm.

If the Scalable box is not checked, then the height has only relative sense.
 

Style - Bold, Italic, Underline, Strike out
 

Screen color - font color on the screen
 

Print Color - font color at printing.
 

Scalable - 
 

If the box is checked, then the font size will change together with changing the drawing scale.
The text typed in such font can be rotated to any angle. The box should be checked for the
majority of fonts.
If the box is not checked, the font size will not change at changing the drawing scale, and at
rotating text typed in such font it will be always horizontal. Such fonts are used for the camera
names and titles. They prove to be convenient for creating labels to be read at any scale.

  

Right side of the tab



VideoCAD478

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

 

In the tab right part you can see and change numbers of system fonts:
 

Font of the titles displaying;
Font of the titles displaying in 3D Video ;
Font of the camera name displaying in the Graphics window .
Font of the camera name displaying in the  3D World ..

It is not recommended to use the system fonts and change their parameters without necessary.
Sometimes it leads to confusion.
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9.15.3 Keyboard

Graphics window
Main menu

View
Options

Keyboard

 

On the tab you can assign Shortcuts keys (keyboard shortcuts) for the items of the Main menu
of the Graphics window.
 

Keyboard shortcuts allow fast activation of various commands from the Main menu, by pressing
shortcuts on the keyboard. 

The order of shortcuts assignment to item of the Main menu:
 

In the Menu box choose section of the Main menu .
 

In the Commands box the list of items of the chosen section will appear. Already assigned
shortcuts are indicated in brackets after the names of menu item. 
 

By the Show all button it is possible to call the full list of all menu items with assigned shortcuts.
This list can be saved to text file. 
 

In the Commands box select the name of the menu item.
 

If the menu item has already assigned shortcut, the shortcuts will be displayed in the box on the 

Current keys panel. 

To remove assigned shortcuts click  Remove.
 

To assign new shortcuts:
 

Set input focus on the Press new shortcut key box on the New shortcut key panel.
 

Press shortcut key on the keyboard.
 

The pressed shortcuts will appear in the Press new shortcuts box.
 

If pressed shortcuts has been already assigned to other menu item, the name of this item will be

displayed in the Currently assigned to box. 
 

To assign typed shortcuts click Assign.
 

Shortcut assignment will be removed from the item displayed in the Currently assigned to box
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9.15.4 3D modeling

Graphics window
Main menu

View
Options

3D modeling

3D panel
 

Plate height 
- vertical size of the license plate in the 3D Video  and 3D World . 

Plate width 

- horizontal size of the license plate in the 3D Video and 3D World. 
 

Specify in these boxes the sizes of license plate, accepted in you country.   
Also create *.bmp file with the image of you license plate, name it Number.bmp and replace with it
the file of the same name in the folder \Models\ in the VideoCAD installation directory. 
!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....
After that 3D models  - cars will be displayed with your license plate.  

Ground color 

- ground color in the 3D Video. In the 3D World the ground color is specified separately .   

Licence plate and test chart antialiasing 

If these boxes are checked- the license plates and test chart are displayed more realistic in the 3D
Video, but at that it takes more time for repainting the 3D Video and there can be errors on some
outdated graphic card. 
 

Space limits 
 

At the  use of some outdated graphic card the occurrence of distortions on the image in the 3D
Video is possible. For reduction of the distortions it is recommended to reduce Model space. 
 

The increase of the near space limit has the much greater influence on distortions, than reduction of
the far space limit.
The objects which are closer to the camera, than near space limit or farther than far space limit
will not be displayed, but the distortions of the objects which are between space limits will be
reduced or removed completely.
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Background res.
 

In this box you can set resolution of vector background in the 3D Video  and 3D World .

Illumination modeling panel
 

Parameters on this panel are considered in 3D image modeling only if the illumination modeling  is
switched on.
 

Using Speed <> Accuracy slider you can choose a compromise solution between accuracy of

modeling light bounds and performance of illumination modeling.

Maintenance factor of illuminators  

- allows for supply voltage and lamp parameters variation, lamp aging, luminaire dirt depreciation.
 

Suggested Maintenance factors, according to CIE 97: 
 

0.8 - very clean environment, maintenance cycle 1 year;
0.67 - clean environment, maintenance cycle 3 years;
0.57 - normal environment pollution load, maintenance cycle 3 years;
0.5 - dirty environment, maintenance cycle 3 years;
 

If the supply voltage is not stable or below normal then it is necessary to decrease the Maintenance
factor proportionally to possible voltage slump.

Maintenance factor of cameras 

- allows for lens contamination, dirt, camera degradation and parameter variation in the lifetime. 
 

Suggested Maintenance factors: 
 

0.7 - very clean environment, maintenance cycle 1 year;
0.6 - clean environment, maintenance cycle 3 years;
0.5 - normal environment pollution load, maintenance cycle 3 years;
0.4 - dirty environment, maintenance cycle 3 years;
 

Redrawing 3D Video
 

On this panel you can optimize the speed of redrawing 3D Video  according to computer's
performance, current design features and designer's habits.

Draw 3D Video in separate thread
 

Use separate program thread for redrawing image in the 3D Video. When the checkbox is checked,
redrawing the 3D Video doesn't  retard work of other windows but is carrying out with delay. 
 

This checkbox is checked by default.  If errors occur while redrawing the 3D Video, try to clear this
checkbox.
 

With the help of the Priority combo box, you can control the priority of redrawing 3D Video in

separate thread. The higher the priority is, the faster the image  in the 3D Video is redrawn, but the
more hinders operation in the Graphics window.

In the the Mode combo box you can switch the method of redrawing image in the 3D Video.

Normal - drawing image in the usual way, in one stage;
2 stage - drawing in 2 stages. on the first stage "raw" image is rapidly shown, and then a resource-
intensive image processing is carried out;
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2 stage+2 priority - like a 2 stage, but the first stage is faster with higher priority.

Redraw 3D image only by clicking
 

Modeling complex 3D scenes, especially taking into account illumination, require high computer
performance. 
If the image in the 3D Video is redrawn too slowly and that hinder operation in the Graphics window,
mark this box. After that the image in the 3D Video  will be redrawn automatically only at
activation of cameras. To force redrawing click on the image.
 

The box is duplicated in the Main menu  of the 3D Video.
 

Disable image processing
 

If this box is marked then the image processing will not be modeled.
Modeling gamma, noise, brightness, contrast, resolution, sharpness, compression will be disabled.
 

Redraw speed will increase, errors with outdated video cards may be removed.
 

The box is duplicated in the Main menu  of the 3D Video.

 

Modeling Depth of Field and Shutter
 

Using Speed <> Accuracy slider you can choose a compromise solution between realism and

performance of modeling depth of field , exposure time  and rolling shutter . 
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

Rotakin speed (rpm)
 

In the box you can specify number of revolutions of the Rotak in  object in revolutions per minute.

357

369

369

379 377 378

205

http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf


Interface 483

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.15.5 Camera and Illuminator

Graphics window
Main menu

View
Options

Camera and illuminator

On this tab can be changed: 
 

Size and line type for icons of camera and illuminator  
 

The icon size is specified separately when displaying on the screen and when printing. 
 

You can set any line type  for a camera or illuminator during creating the camera  or placing
the illuminator .
The camera or illuminator will be drawn by default line type, if another line type has not been
specified during creation and placing.
Later on, you can change line type using Change line type  tool.

Show camera type
 

If the box is marked, then cameras of different types  will be represented by different icons: 

, , ..
In this case, camera tilt is not represented by the icons.
 

If the box is not marked, then all cameras will be represented by identical icons, which represent the
camera tilt.

Scalable
 

If Scalable box is checked, then cameras' (illuminators') icons are scaled with the other
constructions. Size of icons is specified in meters (feet) in the Size box below. 
If Scalable box is not checked, then cameras' (illuminators') icons are not scaled.  Size of icons is
specified separately: on the screen in pixel - in the Size (pix) box,  for printing in millimeters, - in
the Size (mm) box.

Size
 

Size of scalable icons in meter (foot), when the Scalable box is checked.
 

Transparence of projections
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This combo box allows to adjust transparence of filling view area projections  in the Graphics
window.
 

See also: Transparence in the 3D World

See also: Move active camera name
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9.15.6 Export

Graphics window
Main menu

View
Options

Export

On the tab you can adjust parameters of drawing export .
 

The tab is divided to 2 sub-tabs: 
 

Parameters on the DXF,DWG,PLT,CGM,SWF,vPDF  sub-tab are related to the export to
AutoCAD DXF,DWG,PLT,CGM,SWF, vector PDF formats.
Parameters on the BMP,WMF,EMF,GIF,TIFF,PNG,JPG,rPDF,PDF  sub-tab are related to the
export to raster BMP,GIF,TIF,PNG,JPG, PDF formats and windows metafile vector formats  (WMF,
EMF). The tab includes the Raster PDF  panel.

 

If the Show this box before export is marked, the Export tab will be shown before each export.
 

See also Drawing>Save as

DXF,DWG,PLT,CGM,SWF,vPDF
 

Common scale (unit/m, unit/ft.) 
 

Common scale of exporting drawing. The scale can be set in AutoCAD unit per meter (or foot)
on the VideoCAD layout. 
 

When the background in AutoCAD DXF or DWG format is used and Add to DXF/DWG
background  checkbox is checked, then the Common scale is determined by the background file
and can't be changed.

Resolution (m. or ft.)
 

Resolution is the accuracy of export. Objects having sizes smaller than the set resolution could
be exported with errors. In most cases the resolution of 0.005m (0.5 cm) is optimal. For big size
drawings (kilometers) the export with such resolution can lead to errors. In this case, it is needed
to increase resolution and repeat export. 
 

The Resolution influences on all constructions only during Simplified export . When the
Simplified export is not checked, the precision doesn't depend on the Resolution and always
maximal.
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Sizes (unit)
 

As the export is usually executed with resolution, different form the screen resolution, it is
necessary to adjust the size of nonscalable objects. In case of nonscalable objects become too
small or too big in the exporting file. 

Sizes (unit)
Camera icon, Illuminator icon (unit)

 

In the boxes you can specify sizes of camera and illuminator nonscalable icons in AutoCAD

units.
 

See also: Scale . 

Sizes (unit)
Nonscalable fonts, Hatch and dash lines

 

In the boxes you can specify scale factors for Nonscalable fonts (unit/point), Hatch and dash
lines. The factor for Hatch and dash lines also applied for arrows.

Sizes (unit)
Line weight unit/pixel

 

In the box the scale factor of line weights is specified in units of line weight in AutoCAD divided
by pixel of line weight on the screen.
 

This option is not used when the Simplified export  is checked.

Insert rastrer images
 

Insert in the obtained vector file the raster inserts (raster background, projections  of 3D
models). If you are exporting to DXF or DWG format, then add links to external raster files and
copy the raster files themselves to a separate sub-directory named <export file name> _img in
the directory of export.
 

This option is not used when the Simplified export  is checked.

Add to DXF/DWG background
 

If  background in DXF or DWG format is used and this checkbox is checked, the exported file will
be a copy of the background with cameras and constructions added on separate layers .
 

If  background in DXF or DWG format is used and this checkbox is not checked, then a new file
with cameras and constructions will be created. This file will include a link (XREF) to the
background file in DWG format. The background in DWG format will be saved in the subdirectory 
<export file name> _img in the directory of export.
 

This option works only when the background in AutoCAD DXF or DWG format is used and when
exporting to AutoCAD DXF or DWG format.

 

This option doesn't work  when the Simplified export  is checked.
 

If the Add to DXF/DWG background checkbox is checked, then the Common scale  is
determined by the background file and can't be changed.
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Simplified export
 

Simplified export gives the worst result and it is left only as a legacy tool.
All cameras and constructions splits into separate lines, parts of cameras are not combined into
blocks, the structure of the background is broken. Filling of the view areas is not saved, it can be
saved as hatching. When the shadows  is enabled, view areas with shadows are not saved. 
 

Simplified export is possible to DXF format only. Resolution is limited by the value in the 
Resolution  combo box.
 

While simplified export layers  of VideoCAD is not saved, but export file will be multi-layers. In
obtained  *.dxf file there will be the following layers:

Background;
Constructions;
Cameras;
Additional (grid, titles, horizontal);
Frame for printing (if it is enabled).

  

Raster objects (projections of 3D models ) are saved in the form of rectangles. 
 

During the simplified export the following options don't work :
Line weight unit/pixel ;
Insert rastrer images ;
Add to DXF/DWG background .

Vector PDF
 

On the panel you can adjust options for export to vector PDF:
 

Page Width and Height in centimeters or inches 
To change page orientation, invert Width and Height.

Page margins,  in centimeters or inches;
Title, Author, Subject, Keywords.

 

On the Line weight tab you can enable exporting weights of lines, adjust the scale of the line
weight and specify weight for zero-weight lines.
 

Parameters on the left side of the DXF,DWG,PLT,CGM,SWF,vPDF  sub-tab also  have an
influence on vector PDF. 

BMP,WMF,EMF,GIF,TIF,PNG,JPG,PDF
 

 

Scale factor
 

Unlike DXF,DWG,PLT,CGM,SWF,vPDF , the scale is not related to drawing size (in meter or
foot), it is related to screen size only.
 

Common scale
 

Common scale of exporting drawing relatively layout size on the screen. 

Camera icon, Illuminator icon, Nonscaleable fonts and hatches.
 

In the boxes you can specify scale factors of nonscalable Camera icon, Illuminator icon,
Nonscaleable fonts.
 

See also: Scale .

Raster PDF
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On the panel there are tools for export to raster PDF.
 

Page Width and Height in centimeters or inches 
To change page orientation, invert Width and Height.

Page margins,  in centimeters or inches;
Title, Author, Subject, Keywords.

 

Parameters on the left side of the BMP,WMF,EMF,GIF,TIF,PNG,JPG,PDF  sub-tab also
have an influence on raster PDF. 
 

An alternative way to export to *.pdf is to print  to a virtual printer, which produces printing result
as a PDF file. In this method, the weight and color of lines , fonts  will match the values 
specified for printing.
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9.15.7 Tool bar

Graphics window
Main menu

View
Options

Tool bar

On this tab you can control visibility of buttons on the Tool bar  of the Graphics window. 
In the left window there are Invisible buttons, in the right window there are Visible buttons.

With the help of buttons  and  you can move buttons between these two windows making
them visible or invisible.

To move a button to other window:
select it by clicking;

click on the appropriate button  Make the button visible or  Make the button
invisible.

If after changing buttons' visibility the Tool bar looks incorrectly, - restart VideoCAD.
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9.15.8 Miscellaneous

Graphics window
Main menu

View
Options

Miscellaneous

Scaling factor when turning the mouse wheel
 

At a large factor the navigation becomes quicker, but less precise. Also use the key Ctrl .   Sign
of this factor determines the reaction for direction of rotation the mouse wheel. The factor has an
influence on scaling in the Graphics window , 3D World  and 3D Models .
 

Exclude blinking
 

If the box is checked, then the redrawing is carried out in the computer memory and displayed on the
screen only at the end. At that there is no image blinking, but the redrawing speed lowers slightly.  
If the box is not checked, the redrawing is carried out directly on the screen. 

Snap sensitivity
 

You can adjust a distance on which the cursor will be snapped to points, lines and grid as a result of 
snap  effect.
Lesser sensitivity allows to control mouse more precisely.
Higher sensitivity allows to use some imprecise pointer devices or work with high resolution
monitors. 

Calculate shadow for active camera
 

Enable/ disable calculating shadows .
 

Automatic calculating  is performed for the active camera  only.  
To disable automatic calculating shadows (with keeping already calculated shadows) clear this box. 
 

This box is duplicated in the Main menu  of the Graphics window.
 

This checkbox has an influence on calculation of shadows in the Graphics window only, it hasn't
influence on the 3D World .
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
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the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them

Calculate shadow from 3D models
 

The calculation of shading from complex  3D models  in the Graphics window - resource-intensive
operation. 
 

The calculation is disabled by default to save resources. To enable the calculation of shading from
3D models, mark the Calculate shadows for 3D models box.
Additionally, for each 3D model, which must be taken into account when calculating the shading:

double click  on the model to switch it to editing state ;
on the appeared Current construction parameter panel check Shadow  checkbox.

 

In addition,
line type of the instance of 3D model must have Shadow  checked;
the 3D must belong to a layer with Shadows  field checked;

  

This checkbox has an influence on calculation of shadows in the Graphics window  only, it hasn't
influence on the 3D World . Calculation of shadows from 3D models in the 3D World requires
much less computer power. It is convenient to use this checkbox to disable shadow calculation from
3D models in the Graphics window only, where this calculation requires a lot of resources, but leave
the calculation of shadows from 3D models in the 3D World.
 

3D models with marked the Shadows  checkbox in the 3D models window are considered as
obstacles in the calculation of shading regardless of state of this checkbox Calculate shadow from
3D models.
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them

Calculate shadow for active camera once
 

As a result of clicking this button, shadows for active camera will be calculated once, then the 
Calculate shadow for active camera box will be cleared and shadows will not be calculated
anymore.  Shadows have been calculated will be saved in project.

Project auto saving
 

With this panel, you can adjust auto saving VideoCAD's working projects to chain of files in intervals
specified in the Interval (min). The number of files is specified in the Depth box . The more files in
the chain are and the larger the file size of the project, the more hard disk space will require. After full
filling the chain, saving each new file will remove the oldest. You can specify autosave directory by
clicking on the Dir button.
 

Files in the chain are the usual project files of VideoCAD. The newest file called vcadproject_1.vc7,
previous vcadproject_2.vc7 etc.
Auto saving works while work ing with the program. When no work , saving stops.

Printing
 

On the panel you can enable printing via buffer that allows to print without error on printers which do
not support GDI+ drawing commands of transparent fills, gradient and transparent projection of 3D
models. Via the buffer you can print without errors on most virtual printers, such as printing to PDF. 
 

583

580

202

164

283

475

277

161

342

402

178 239

239 475 277

490 491

283 402

583

580



VideoCAD492

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

When using the buffer printing on the raster buffer is performed firstly, and then the raster buffer is
passed to the printer.
Without the use of the buffer the image is passed to the printer in vector form, as printing
commands. If the printer does not support all commands, the distortions of the printed image are
possible.
 

However not all printers can work with the Use buffer mode in all cases. In case of issues clear the
Use buffer checkbox. Try also to decrease printer DPI resolution, hide raster background.
 

 When using the print buffer or if the printer does not scale hatching, to print hatching properly
check the option Scale hatching. If the printer scales hatching on their own and the buffer is not
used, clear the Scale hatching, otherwise the hatching will be printed too rare.

Thin lines of raster background
 

Mark of this checkbox increases the thickness of the thin dark lines on a light background to one
pixel when displaying raster background in the Graphics window. In most cases it improves
readability of the background when it is scaled.
 

This mode decreases speed of redrawing background. 

UNDO depth
 

VideoCAD keeps several  previous states for the possibility to undo operations using the Undo
function.
The number of keeping states can be adjusted in this box. The more states are kept and the more
the project size, the more RAM is needed.

Monitor size factor
 

Correction factor to bring the physical size of the Monitor window  on the computer screen to the
value specified in the Monitor diagonal  box on the Tool bar of the Monitor window.
 
To set the factor:

open the Monitor window;
specify in the Monitor diagonal  box on the Tool bar of the Monitor window approximately a
half of the physical diagonal of your computer screen. The Monitor window must be visible on the
screen as a whole;
measure by a ruler the physical diagonal of the Monitor window on the computer screen;
calculate the needed Monitor size factor = (value in the Monitor diagonal box) / (Physical
diagonal of the Monitor window).

 

The Monitor diagonal is measured in inches. 1 inch = 25.4 mm.
 

For various physical monitors and screen settings in Windows may require different Monitor size
factors.

Simulate distortion
 

This checkbox can globally enable and disable simulation of lens distortion of cameras with lens
distortion enabled.  
 

See also: Lens distortion ,

Sampling
  

Modeling the lens distortion in VideoCAD is performed with limited sampling, which can be changed
in this box. Than more the value in the box is, the more segments will be used in calculation of

211

407

410

410

310



Interface 493

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

distortion, the more precision, less artifacts, but the longer it takes for redrawing images with
distortion.
 

See also: Lens distortion ,

Spatial resolution and rotation
 

If this checkbox is not checked, then rotation of the camera around its axis  does not affect the
position of the vertical and horizontal in the frame when calculating the spatial resolution .
Horizontal and vertical directions are tied to the camera and not to the scene.

 

If this checkbox is checked, then each time you rotate the camera around its axis by an angle
greater than 45 degrees, vertical number of pixels will be considered as horizontal and horizontal
number of pixels - vertical. Further, at every rotation by an angle more than 135 degrees, vertical
number of pixels will be considered vertical and horizontal number of pixels - horizontal. Thus the
vertical and horizontal in the spatial resolution calculation will be tied to the scene, not to the
camera. 
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9.16 Utilities

Utilities for measuring camera and image parameters:
Image analyzer;
Live video analyzer;
Lamp spectrum analyzer;

- were separated out from VideoCAD in the separate product - CCTVCAD Lab Toolkit. 

Please visit our website for details: http://www.cctvcad.com

http://www.cctvcad.com
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9.17 Person detection area size box

Graphics window
Tool bar

  Person detection area

 

The box displays an approximate view and sizes of person detection area projection. 
 

The projection is calculated according to person detection criteria attached to a quality level
assigned to camera. The criteria can be edited in a criteria-editing box  of person detection area.
 

The person detection area projection unlike the other areas' projections is calculated on a
condition of person getting in the area at any height within the specified range. For instance, the
presence of a person's leg or head in the area is enough to detect the person.
 

If there are no numerical values in the box, then the person detection area projection is missing.
The missing projection of detection area implies the failure of capacity to detect at all points of view
area, e.g. a camera is looking upwards from the height greater than the upper bound of detection
area.
 

This tool doesn't take into account rotation of camera around its axis , shadows  and lens
distortion .

 

See also: Recommendations on the program use , Criteria editing box of person detection area
, Spatial resolution . 
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.18 Person identification area size box

Graphics window
Tool bar

  Person identification area

 

The box displays an approximate view and sizes of person identification area projection. 
 

The projection is calculated according to person identification criteria attached to a quality level
 assigned to camera. The criteria can be edited in a criteria-editing box of person identification

area .
 

The person identification area projection is calculated on a condition of person face getting in the
area at all the heights within the specified range. The identification condition becomes a presence of
a  face of person of any height.
 

If there are no numerical values in the box, then the person identification area projection is
missing.
The missing projection of identification area doesn't imply the failure of capacity to identify at all
points of view area. To create an identification area projection all these criteria are to be observed
in the whole range of heights specified in these criteria, i.e. for a person of any height
 

This tool doesn't take into account rotation of camera around its axis , shadows  and lens
distortion .

 

See also: Recommendations on the program use , criteria editing box of person identification area
, Spatial resolution . 

External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.19 License plate reading area size box

Graphics window
Tool bar

  License plate reading area 

 

The box displays an approximate view and sizes of license plate area projection. 
 

The projection is calculated according to license plate reading criteria attached to a quality level
 assigned to camera. The criteria can be edited in a criteria-editing box of license plate reading

area .
 

The license plate reading projection is calculated on a condition of license plate hitting in the
area at all the heights from the customized range. The reading condition becomes a presence of
license plates of either lorries (high vehicles) or passenger cars (low vehicles). 
 

If there are no numerical values in the box, the license plate reading area projection is missing
consequently.
The missing projection of reading area doesn't imply the failure of capacity to read-out plates at
all points of view area. To create a reading area projection all the criteria are to be observed in the
whole range of heights specified in the criteria, i.e. for the vehicles of any size.
 

This tool doesn't take into account rotation of camera around its axis , shadows  and lens
distortion . 

 

See also: Recommendations on the program use , criteria editing box of license plate reading
area , Spatial resolution . 
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.20 Criteria editing box of person detection area

Graphics window
Main menu

Criteria
Person detection area

 

These criteria are the following:
 

Minimal height of detection;
Maximal height of detection;
Minimal vertical resolution (pixel/m, pixel/ft).

 

The criterion Minimal vertical resolution (pixel/m, pixel/ft) depends on vertical number of
pixels. Vertical number of pixels influences person detection, identification and license plate
reading areas.
For criteria calculation minimal number of pixels from parameters of camera image sensor and
parameters of output image is used. 
Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
Number of pixels of output image is specified on the Processing  tab of the Image parameter
panel .
 

If a camera is rotated by an angle more than 45 degrees, when calculating person detection
and identification , license plate reading  areas,  the parameters: minimum vertical
resolution (pixel/meter, pixel/ft), the minimum vertical size of face image ( pixels ), the
minimum vertical size of license plate ( pix) are calculated based on the number of pixels
along the horizontal, instead of the number of pixels along the vertical, as in this case the
vertical side of the field of view is located along the horizontal.
In other respects the person detection area doesn't take into account rotation of camera around
its axis , shadows  and lens distortion .

 

If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (768 on
horizontal), what corresponds to analog camera.

 

In multi-level 3D projects the heights in the criteria are calculated relative the Base height  of the
camera, for which the person detection, identification, license plate reading areas are calculated.
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The person detection area projection unlike the other areas' projections is calculated on a condition
of person hitting in the area at any height from the customized range. For instance, the presence of a
leg or a head of person in the area is enough to detect a person.
 

The box upper part contains a quality level combo box enabling to choose any quality level. The
box immediately displays the criteria values relevant to the chosen level of quality. The criteria
values can be edited, by typing the new values.
 

If the quality level being edited coincides with the quality level of the active camera, all the
criteria alterations are immediately taken into account when calculating the person detection area. 
 

When moving the cursor to a box with the chosen quality level, the additional information on
this quality level appears.
 

To save the introduced changes click OK. 
To cancel the introduced changes click Cancel.
  

You can set your own criteria  using the 3D Video  as a control monitor and moving 3D models
 in the camera view area.

 

You can change the criteria values of several quality levels outright. Clicking OK saves all the
introduced changes.
 

See also: Recommendations on the program use , Example 6 Determining person identification
criteria by the real image  , Spatial resolution box.
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.21 Criteria editing box of person identification area

Graphics window
Main menu

Criteria
Person identification area 

 

These criteria are the following:
 

Minimal height of identification;
Maximal height of identification;
Minimal vertical size of face image (pixel);
Maximal angle between a direction on the camera and horizontal.

 

A face height is taken as equal to 0,2m (0,66 ft).  

  

In multi-level 3D projects the heights in the criteria are calculated relative the Base height  of the
camera, for which the person detection, identification, license plate reading areas are calculated.
 

The criterion Minimal vertical size of face image (pixel) depends on vertical number of
pixels. Vertical number of pixels influences person detection, identification and license plate
reading areas.
For criteria calculation minimal number of pixels from parameters of camera image sensor and
parameters of output image is used. 
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Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
Number of pixels of output image is specified on the Processing  tab of the Image parameter
panel .
  

If a camera is rotated by an angle more than 45 degrees, when calculating person detection
and identification , license plate reading  areas,  the parameters: minimum vertical
resolution (pixel/meter, pixel/ft), the minimum vertical size of face image ( pixels ), the
minimum vertical size of license plate ( pix) are calculated based on the number of pixels
along the horizontal, instead of the number of pixels along the vertical, as in this case the
vertical side of the field of view is located along the horizontal.
In other respects the person identification area doesn't take into account rotation of camera
around its axis , shadows  and lens distortion .

 

If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (768 on
horizontal), what corresponds to analog camera.
 

The criterion Maximal angle between a direction on the camera and horizontal is introduced
due to the reduction of identification capacity, if a camera is viewing a person downwards, despite the
adequate sizes of person face on a display.

 

The person identification area projection is calculated on a condition of person face hitting in the
area at all the heights from the customized range. The identification condition becomes a presence of
a face of person of any height.
 

The box upper part contains a quality level combo box enabling to choose any quality level. The
box immediately displays the criteria values relevant to the chosen level of quality. The criteria
values can be edited, by typing the new values. 
 

If the quality level being edited coincides with the quality level of the active camera, all the
criteria alterations are immediately taken into account when calculating the person identification
area projection. 
 

When moving the cursor to a box with the chosen quality level, the additional information on this
quality level appears.
 

To save the introduced changes click OK. 
To cancel the introduced changes click Cancel.
  

You can set your own criteria  using the 3D Video  as a control monitor and moving 3D models
 in the camera view area.
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You can change the criteria values of several quality levels outright. Clicking OK saves all the
introduced changes.
 

See also: Recommendations on the program use , Example 6 Determining person identification
criteria by the real image  , Spatial resolution box.
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.22 Criteria editing box of license plate reading area

Graphics window
Main menu

Criteria
License plate reading area 

 

These criteria are the following:
 

Minimal height of license plate reading;
Maximal height of license plate reading;
Minimal vertical size of license plate image (pixel).

 

A license plate height is taken as equal to 0,1m (0,33 ft).  

 

In multi-level 3D projects the heights in the criteria are calculated relative the Base height  of the
camera, for which the person detection, identification, license plate reading areas are calculated.
 

The criterion Minimal vertical size of license plate image (pixel) depends on vertical
number of pixels. Vertical number of pixels influences person detection, identification and
license plate reading areas.
For criteria calculation minimal number of pixels from parameters of camera image sensor and
parameters of output image is used. 
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Number of pixels of image sensor is specified on the Sensitivity and Resolution  box.
Number of pixels of output image is specified on the Processing  tab of the Image parameter
panel .
  

If a camera is rotated by an angle more than 45 degrees, when calculating person detection
and identification , license plate reading  areas,  the parameters: minimum vertical
resolution (pixel/meter, pixel/ft), the minimum vertical size of face image ( pixels ), the
minimum vertical size of license plate ( pix) are calculated based on the number of pixels
along the horizontal, instead of the number of pixels along the vertical, as in this case the
vertical side of the field of view is located along the horizontal.
In other respects the license plate reading area doesn't take into account rotation of camera
around its axis , shadows  and lens distortion .

 

If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (768 on
horizontal), what corresponds to analog camera.

 

Since the license plate is a flat object, the angle included between an optical axis of camera lens
passing through a license plate and a horizontal has a smaller value comparing to a license plate
reading procedure. It is to be kept in mind though that with the angle large values the sensitivity to a
vertical skew of license plate ascends.
 

The license plate reading projection is calculated on a condition of license plate hitting in the area at
all the heights from the customized range. For instance, to read the license plates of the passenger
cars out only, the maximal height parameter is to be changed. In this case the calculated license
plate area extends.
 

The box upper part contains a quality level combo box enabling to choose any quality level. The
criteria values relevant to the chosen level of quality are immediately displayed in the box. The
criteria values can be edited, by typing the new values. If the edited quality level coincides with
the quality level of the active camera, all the criteria alterations are immediately taken into
account when calculating the license plate reading area. 
 

To save the introduced changes click OK. 
To cancel the introduced changes click Cancel.
  

You can set your own criteria  using the 3D Video  as a control monitor and moving 3D models
 in the camera view area. 

You can change the criteria values of several quality levels outright. Clicking OK saves all the
introduced changes.
 

See also: Recommendations on the program use , Example 6 Determining person identification
criteria by the real image  , Spatial resolution box .
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.23 Quality level box

Graphics window
Main menu

Criteria
Quality levels

Quality level is a set of criteria according to which VideoCAD calculates person detection ,
identification  and license plate reading  areas. 
The criteria values for each quality level can be adjusted using the Quality level box.
Calculated projections are displayed in the Graphics window  and in the size boxes of person
detection  and identification  , license plate reading .
 

The Quality levels can be assigned to cameras in the Quality level box. As a result of the quality
level assignment to a camera, the person detection, identification and license plate reading areas of
the camera will be calculated according to criteria which are included in the assigned Quality level.
 

To change the name click the left mouse button on the selected quality level in the table.  
 

Editing the additional information is available in the description box. 
 

The additional information appears when moving the cursor to a quality level box in the boxes of
editing the criteria of person detection , identification  and license plate reading .                
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Using the pop-up menu of the table you can rename a quality level.
 

In the right part of the box on the separate panels there are values of criteria of the person detection,
identification and license plate reading, which are included in the Quality level selected in the table .
 

To edit the criteria, click the Edit button on the corresponding panel. Criteria editing box will
appear.
 

More in detail about criteria see:
Criteria editing box of person detection area 
Criteria editing box of person identification area 
Criteria editing box of license plate reading area
 

To save the introduced changes and assign the selected quality level to the active camera click 
OK. 
To cancel the introduced changes click Cancel. 

 
See also: Recommendations on the program use , Example 6 Determining person identification
criteria by the real image , 3D Video general information  , Spatial resolution box..
External link : "The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf) . 
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9.24 Test object box

Graphics window
Tool bar

  Test object

 

The box displays a test object and its image on the display conventionally.
 

Test object is a vertical parallelepiped situated perpendicular to the ground projection of camera
lens main optical axis. 
 

You can change the horizontal and vertical sizes of parallelepiped, its depth, its height above
the ground, shift from the lens main optical axis projection and the distance between
camera location and test object as well. 
 

In multi-level 3D projects the height of the test object is calculated relative the Base height  of the
camera, for which the test object belongs.

In the display box you can see an approximate image of the closest to the camera parallelepiped
surface  and the information on which part of screen is occupied with this surface top, bottom and
height.
 

You can choose a parameter taken as a full screen and correspondingly obtain the information on
this surface  sizes in percentage, pixels and millimetres (inches in case of Imperial format). 
Using the test object you can obtain the better part of geometrical and resolution parameters on
different sections of view area.
   

In the 3D Video  in the graphical editing state
 of the active camera you can see the actual

image of test object as a parallelepiped with
numbers on sides. Changing the location of the
test object and its sizes you can estimates of
the symbol readability on the sides in different
sections of view area. 

 

Using the button Test object location  or the corresponding item of the graphics window menu
you can also change a test object location.
The same window allows observing an actual image of test object in horizontal and vertical
projections. 
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Working with a test object in the graphics window  and in the 3D Video is available only within a
graphical edit state  of active camera. 
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9.25 Camera list

Graphics window
Tool bar

  Camera list

In the Camera list box list of cameras in the project is displayed. Active camera is highlighted by
red frame. Any camera can be activated, removed, renamed, found on layouts,  it is possible to
show 3D image from this camera. It is also possible to sort cameras in the list. 

 

In the Camera list box only basic camera parameters are given. To obtain the list of all camera
parameters in the project, the Table of cameras  multifunctional window is used. It can be called

by the Table of cameras  button or by the same button on the Tool bar of the Graphics
window. 
 

To perform any manipulations with the camera first select its name in the list by clicking.
 

For the chosen camera, it is possible to change Additional information and Camera type, which
determines camera icon type. 
 

Cameras are displayed by different icons, only if the Display camera type  box in the Options box
 is marked. 

 

To activate camera without closing the box, double click the row with camera name in the table. 
 

It is convenient to activate any camera by double click ing on its lens on the layout or by camera's
selection in the Active camera  list on the Tool bar of the Graphics window. It is possible to
activate cameras from the Monitor window . 

To find a camera on layouts select it in the table by clicking it once and then click Find on layouts.
To show 3D image from a camera select it in the table by clicking it once and then click Show 3D.
 

Choosing the items of pop-up menu, which appears when clicking the camera selected in the table
with the right mouse button, can perform the same actions. 
 

Using the pop-up menu it is also possible to rename the camera and select camera model .
 

Choosing the item Copy to clipboard you can copy whole camera list to Windows' clipboard.  After
copying you can paste the camera list to MS Word, MS Excel or other software.
 

You can rename the camera from the Table of cameras  and rename any number of cameras
simultaneously using the Numerate cameras  dialog box. 
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To sort the cameras in the list click the Sort cameras  buttons. Then will appear the buttons, by
using which it is possible to move the cameras selected in the list upwards on one position,
downwards, to the beginning or to the end of the list.
 

It is not recommended to change the order of cameras without necessity.
 

To activate a camera and save the introduced changes click OK. 
To cancel the introduced changes and camera activation click Cancel.
To switch promptly between cameras in the graphics window use the shortcut Ctrl+Spacebar.

 

See also: Table of cameras , Active camera combo box443 172
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9.26 Numerate cameras

Graphics window
Main menu

Camera
Numerate
cameras

This tool allows renaming and serial numeration any quantity of cameras simultaneously.
 

Order of work:
 

1. Adjust Numeration pattern .
2. Adjust Numeration order .
3. Adjust additional Setting .
4. Click Numerate .

Numeration pattern
 

Numeration pattern can be adjusted by combo boxes and check boxes placed above the combo
boxes. 
In order that position of a combo box presents in the pattern, the box above this combo box should
be marked. 
It is possible to select variants of using the positions.

In the Example of numeration box the camera name example according to the specified

pattern is displayed. 

Numeration order
 

Camera numeration order on layouts is adjusted on the panel.
 

Common number - numerate in camera number increasing order all over the project. Camera

numbers are displayed in the Camera list  box and the Table of cameras  window in the
Number column.
 

Numerate on layouts - numerate in camera number increasing order separately on each layout

. 
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From top to down  - numerate cameras from top to down according to their position on layouts.
 

From left to right  - numerate cameras from left to right according to their position on layouts.
 

Step - numeration step on layouts when numerating from top to down and from left to right (meters

or foots).

Setting
 

Selected only - if the box is marked, numerate only selected  cameras, otherwise all

cameras.
 

On all layouts - if the box is marked, numerate cameras on all layouts in the project, otherwise

only on the current layout.
 

Start numeration on each layout - on each layout the numeration will be started over again.

At that on different layouts in the project, cameras with identical names could be found.
 

Starting index - index, from which to start numeration.

Numerate
 

- start numeration.
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9.27 Layouts

Graphics window
Main menu

Drawing
Layouts

 

In this box a list of project layouts is displayed. 
 

The project may contain up to 10 layouts. Originally one layout is created into project. 
You can create, delete or rename any project layout. To delete the original layout and any layout
with the cameras present in it is not allowed.
 

The layouts are separate sections of monitored object (building, room, territory and storey). A layout

contains the horizontal and vertical projections locating backgrounds, cameras, illuminators ,

cables  and constructions . Each camera can be displayed in one layout only, though the
camera cables may pass through several layouts.
 

To choose a layout for displaying it in the graphics window  and saving the introduced changes
select it in the table by clicking it once and then click OK. 
To delete a layout select it in the table by clicking it once and then click Delete. 
To create new layout click Add. 
To rename a layout double-click a line with its name in the table. 
To cancel the introduced changes and layout loading click Cancel.

 

It is convenience to switch the layouts, create, delete, rename the layouts using the Layout  tabs
in the left bottom corner of the Graphics window and the pop-up menu of the tabs.

 

To switch promptly between layouts in the graphics window use the shortcut Ctrl+TAB. 

See also: Layers .

206

269 193

161

274

276



VideoCAD514

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

9.28 Signal cable length calculation box

Graphics window
Main menu

Cables
Signal cable

VideoCAD summarises the lengths of all the segments, considers the reserves and calculates the
total length of cable. 
 

To change the default parameters and obtain the calculation results double-click on any cable
segment or click Signal cable  again.
A dialog box of the same name appears after that.

Cable brand 
 

In this box you can assign a brand to the signal cable of the active camera. Cable brands are
Names of  line types , which are considered as cables (the Cable box in the line type parameters

 is checked).. Thus we assign simultaneously cable brand and correspondent line type by which
the cable will be drawn on layouts.
 

We can obtain Cable report  which contains cable lengths of each brand separately.
 

The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report  and in the Table of cameras .

See also: Power cable electrical parameters and length calculation box , View>Active camera
cables , View>All cameras' cables , Length calculation of line segments , Cable report .
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9.29 Power cable electrical parameters and length calculation box

Graphics window
Main menu

Cables
Power cable

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates the
total length of cable. 
 

To change the default parameters and obtain the calculation results double-click on any cable
segment or click Power cable  again.
A dialog box of the same name appears after that enabling to choose a section area of power
cable to fit the requirements of camera voltage supply. 
 

It is assumed that the conductor material is copper and the conductor temperature is + 50° C
 

Cable brand 
 

In this box you can assign a brand to the power cable of the active camera. Cable brands are
Names of  line types , which are considered as cables (the Cable box in the line type parameters

 is checked).. Thus we assign simultaneously cable brand and correspondent line type by which
the cable will be drawn on layouts.
 

We can obtain Cable report  which contains cable lengths of each brand separately.

The results of the cables' calculation on each individual camera, each individual section area and on
the project as a whole are included into the text file obtained by Text report  and in the Table of
cameras .

See also: Signal cable length calculation box , View>Active camera cables , View>All
cameras' cables , Length calculation of line segments , Cable report .
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9.30 Length calculation of line segments

Graphics window
Main menu

Cables
Length calculation of line segments

With this tool it is possible to calculate total length of line segments  of the chosen line type .
Thus, it is possible to use certain line types as cables. 
 

Only line segment  lengths are summarized. Lengths of other type constructions  are not
summarized. 

Line type
 

In the combo box you can select line type . Line segments made by the line type will be
summarized.

Cables only
 

When this box is checked, in the Line type combo box only line types which are considered as
cables are shown (the Cable box in the line type parameters  is checked).

Selected only
 

Summarize selected  segments only.

After selecting line type, in the On the current layout and On all layouts boxes calculation
results will appear.

Additional buttons:
 

Refresh - Recalculate.
 

Close - Close the box.
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Help - open this Help topic.

See also: Cables ,Signal cable length calculation box , Power cable electrical parameters and
length calculation box , Cable report .
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9.31 PDF Report

Graphics window
Main menu

Project
PDF Report

The dialog box is used to configure the report in PDF format.
The box consists of the following tabs:

Document
Cover
Cameras
Other

 

To get a report you should adjust the settings on each tab, then click OK.
 

Document

 

On the tab the common parameters of a PDF document are specified.

Page Width and Height in centimeters or inches 
To change page orientation, invert Width and Height.
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Page Margins,  in centimeters or inches;
Title, Author, Subject, Keywords.

In the Font (codepage) combobox a font for the document can be specified. The font must be
TrueType. This can either be the name of the font as shown in the Windows\Fonts folder (for
example "Times New Roman") or it can be the font family name with an optional style specifier in
square brackets (for example "Times New Roman [BoldItalic]").
Possible optional specifiers are: [Bold], [Italic] or [BoldItalic].
A codepage can also be specified (for example "Arial [Bold] {1250}") which allows other encodings
to be used. 

If the report is in characters other than the Latin alphabet is not displayed correctly -
select your codepage.
 
Possible code pages are:
{0} Direct mapping
{437} OEM_CHARSET
{850} OEM_CHARSET
{852} OEM_CHARSET
{874} THAI_CHARSET
{1250} EASTEUROPE_CHARSET
{1251} RUSSIAN_CHARSET
{1252} ANSI_CHARSET
{1253} GREEK_CHARSET
{1254} TURKISH_CHARSET
{1255} HEBREW_CHARSET
{1256} ARABIC_CHARSET
{1257} BALTIC_CHARSET
{1258} VIETNAMESE_CHARSET
{1361} JOHAB_CHARSET

Below, you can set the Font height in % of the height of the sheet and Line spacing.

If the Page Numbers checkbox is checked, at the bottom of report pages the page
numbers will be printed.

The Headlines checkbox enables drawing horizontal lines on top and on bottom of each
page.
Below you can specify Header and Footer.

Cover

 

On the tab parameters of the cover sheet can be specified.

If the Cover checkbox is marked, the cover is included in the report.
If the Frame checkbox is marked, the frame is drawn on the cover.

If the Logo checkbox is marked, then any image can be drawn on the cover.
X (%), Y (%) - the position of the image on the sheet in % of the sizes of the sheet.
W (%), H (%) - the size of the image on the sheet, in % of the sizes of the sheet.
In the Path box the path to the image file can be entered. To select a file click on the

button .  Possible file formats: bmp, jpeg, gif, tif, png, wmf, emf.

Below there are 4 identical panels where you can specify blocks of text.
Checkboxes Text 1..Text 4 include corresponded blocks of text on the cover.
X (%), Y (%) - the position of the text on the sheet in % of the sheet size.
Height (%) - the height of the text on the sheet in % of the size of the sheet.
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By clicking  button, you can select color of the text block. 
In the Alignment combobox you can select text alignment.

The text itself can be entered in the box at the bottom of each panel.

Cameras

 

The tab is intended for adjusting information about the cameras that you want to include in the
report.

If the Layouts checkbox checked, the report will include the names of layouts.
If the Drawing checkbox is marked, the report will include drawings of the layouts.
X (%), Height (%) - the position and height of the drawings on the sheet, in % of the size of the
sheet.

If the Cameras checkbox is marked, the report will include parameters of cameras.
 

If the Images checkbox  is marked, the report will include images from the cameras.
X (%), Height (%) - the position and height of the images from the cameras on the sheet, in % of
the size of the sheet.
If the Titles checkbox is marked , the images from the cameras will include titles .
If the Real size checkbox is marked, then the images from the cameras will be generated in real-
size in pixels.
If the Day and Night checkbox is marked, the report will include 2 images for each camera: for day
and night time.
 

Clicking on the  button starts updating the stored images.
Generation of images from the cameras can be time consuming.

If the Placement checkbox is marked, then the report will include fragments of layouts
with positions of the cameras.
X (%), Height (%) - the position and height of the fragments of the layouts on the
sheet, in % of the size of the sheet.
 

If cam eras  occupy too sm all fragm ents  of plans , reduce the Maxim um  dis tance of draw ing view
area  in  the cam era param eters . 

Below there are checkboxes, by which you can select the camera parameters that should
be included in the report.

Other

 

On the tab additional information in the report can be adjusted.
 

Cameras summary - the number of cameras, the number of used models of cameras , lens
focal lengths, the camera resolutions in pixels, the total cost of the cameras (if the cost  is
assigned to the used camera models).
 

Cables summary - the sum of the lengths of the cables.
All line segments  and cables  made by line types with marked Cable  box in the
parameters of the line type will be calculated.
These line types are considered as cable brands. These line types can be assigned to the Signal
cable  and the Power cable  of any camera.
You can simply draw cables as line segments on layouts using these line types. In this case, the
cables are considered as main cables which are not attached to any camera.
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The report includes the cables attached to cameras and the main cables as well. Cable lengths
are calculated for each brand (line type) separately.
 

See also Cable report
 

Spatial resolution patterns - information about Spatial resolution patterns  used in the project.
 

Date - the date and time of generating the report.
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9.32 Image sensor calculator

Camera Geometry
Sensor and Lens

Calculator 

The Calculator is intended for convenient calculation :
Aspect Ratio of Image sensor;
Aspect Ratio of active area of Image sensor (=Aspect ratio of the output image);
Crop-factor.

About use of the calculator, see: Specifying active area size of the image sensor/

The calculator can be invoked by the Image sensor calculator  button in the Sensor and Lens
 box.

The calculator consists from the three lines:

Image sensor

 

As a result of click on the left button  numbers of pixels of image sensor horizontally

and vertically are copied  from the Sensitivity and resolution  window to the Hor. and
Vert. boxes. If the numbers are not specified, the left button is not available. 
To the  Hor. and Vert. boxes you can type any values.
 

In the Aspect ratio box the calculated ratio of horizontal to vertical numbers of pixels of the Image
sensor will be displayed.
 

Attention! To calculate the Aspect ratio of Image sensor you must divide maximum number of
horizontal pixels to the maximum number of vertical pixels in all possible modes of the
camera. In general, the maximum number of pixels may be different from those specified in the
Sensitivity and Resolution window.. 
 

For example, a camera has the following resolution modes
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90 
1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
 

The maximum horizontal number of pixels - 1920, The maximum vertical number of pixels - 1200.
Probable Aspect ratio of the image sensor 1920/1200=1,6=16:10

Clicking the right button  the calculated aspect ratio of image sensor will be copied to the
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Aspect ratio  box in the Sensor and Lens box.

Image sensor's active area

 

As a result of click on the left button  numbers of pixels of output image
horizontally and vertically are copied  from the Processing tab of the Image parameter
panel  to the Hor. and Vert. boxes. If the numbers are not specified, the left button is
not available. 
To the  Hor. and Vert. boxes you can type any values.

In the Aspect ratio box the calculated ratio of horizontal to vertical numbers of pixels of the output
image will be displayed.

Clicking the right button  the calculated aspect ratio of the output image will be copied to
the Aspect ratio  box in the Camera Geometry  box. 

Crop

 

The Crop factor value is calculated from the Aspect ratio of the Image sensor and Aspect ratio
of the output image.

Attention! The calculated value of Crop has sense only if the active area on the image sensor
does not touch the edges of the image sensor. Otherwise Crop = 1 and the result of
calculation does not matter.

 

See more: Specifying the crop factor

To be able to calculate Crop it is necessary that numbers of pixels of image sensor  are greater
than or equal to the numbers in pixels of the active area. Otherwise, the Crop box displays Error.

Clicking the right button  the calculated Crop factor will be copied to the Crop  box of
the Sensor and Lens box.
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10 Examples of work with VideoCAD

Example 1  Choice of camera installation height and parameters
 

Example 2  Choice of cameras' quantity and location 
 

Example 3  Choice of cameras' quantity and location on the original layout
 

Example 4  Calculation of camera view area parameters
 

Example 5  Calculation of cameras' parameters and choice of their relative locations
 

Example 6  Determining person identification criteria by a real image
 

Example 7  CCTV design using Monitor window and PTZH frame
 

Example 8  CCTV project
 

Example 9  Choice of camera model according to known scene illumination
 

Example 10  Measuring camera sensitivity
 

Example 11  Measuring low illumination
 

Example 12  Measuring resolution of camera (lens)
 

Example 13  Measuring maximum scene illumination for a camera
 

Example 14  Examples of luminaire calculation
 

Example 15  Choice of luminaire power and location
 

Example 16  Determining spectral efficiency of light source
 

Example 17  Measuring projector parameters
 

Example 18  Measuring parameters of IR illuminator
 

Example 19  Modeling megapixel images
 

Example 20  Selecting frame rate on the basis of known target's positions and velocities
 

Example 21  Creating animated model of monitor
 

Example 22  Visualization of cameras' control area projections and spatial resolution inside them
 

Example 23  Choosing install location for PTZ camera
 

Example 24  Simulating distortions of moving objects arising from Exposure time, Interlace scan and
Rolling shutter
 

Example 25  Calculating lengths of cables and getting Cable report
 

Example 26  Checking Depth of Field in horizontal projection
 

Example 27  Measuring exposure time of IP camera
 

Example 28  Measuring rolling shutter row time of IP camera
 

Example 29  Import of 3D models from SketchUp and Autodesk 3dsMax
 

Example 30  Work with layers and multi-level projects
 

Example 31  Work with 3D models-territories
 

Example 32  Export 3D view areas to general 3D design software
 

Example 33  Using camera rotation around its own axis
 

Example 34  Modeling lens distortion
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Example 35  Measuring real view angles
 

Example 36  Modeling panoramic cameras (Fisheye, 360°/180°)
 

Example 37  Work with background in AutoCAD formats
 

Example 38  Specifying active area size of the image sensor
 

Example 39  Teaching materials
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10.1 Example 1  Choice of camera installation height and
parameters

Problem
 

We have a number of objects spread in a space. 
The objects have certain locations and sizes. 
It is required to determine the height of installation and lens focal length of the camera to
display all the objects properly.

Solution
 

1. Place the objects in horizontal and vertical projections according to their actual sizes and
location using the tools on the Tool bar . High-usage tools are:

  Line segment

  Polyline

  Rectangle

  Inclined rectangle

  Wall

  Aperture in Wall

  Circle

  3D model

  3D image
 

It is necessary for 3D modelling to place objects only in the horizontal projection, color of the
objects preset in the line type , by means of which the object is drawn. Heights of the objects
can be specified on the  Current construction parameter panel  during drawing constructions. 

As the objects prepared 3D models   can be used (people, cars). Choose necessary 3D model
from the Tool bar then specify by click ing the place of the model on layout.
 

2. Open 3D Video  . Control image in the 3D Video during next operations.
 

3. Switch to  Select/Edit   mode by successive pressing ESC key.
 

4. To move the camera:
 

Select the camera by clicking on its lens;
Move the cursor to the lens, then press the left
mouse button;
Keeping mouse button pressed, move the selected
camera to a new place;
Release the left mouse button.

5. For tilting and panning the Active camera  on the layout in Select /edit  mode:
 

Move the cursor to the pink grip in the middle of the
view area bound. Thereupon, the point will be
outlined by red square;
Click on it by mouse;
Move the cursor;
To stop tilting or panning click once again on a point
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where the middle of the view area bound is to be
located.

 

Current focal length value is displayed in the Lens
focal length  combo box on the Tool bar .

 
6. To change lens focal length  of the active camera on the layout in Select /edit  mode:
 

Move the cursor to any orange grip on the ends of
view area bound. Thereupon, the point will be
outlined by red square;
Click on it by mouse;
Move the cursor;
To stop changing focal length click Once again on a
point where the end of view area bound is to be
located.

 
 
7. You can change Camera installation height by
choosing value from the combo box  in the Camera

Geometry  box .
 
You can also specify the height by click ing in vertical
projection after choosing the   Change installation

height   tool.

 
8. According to the image in the 3D Video and view area projections on the layout choose the
optimal camera position and its lens focal length . 

You can see your project in 3D form in the  3D World .

External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf) . 
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10.2 Example 2  Choice of cameras' quantity and location

Problem 
 

It is required to monitor a room of arbitrary form and sizes.
Person detection is required at all the space of a room. 
Person identification is requires beside an entrance door, a safe and a manager's table. 
The manager's workplace itself must not hit in the view area.
Cameras might be installed anywhere, though not lower than 2.5 m.
It is required to choose the camera quantity, lenses, locations and cables.

 

Solution
 

1. Create project   and Camera  .
 

2. Using the tools of Constructions group  create an actual plan of a room. 
All the details are not to be kept, our task  is to observe the sizes carefully.
 

It is possible to load as a background  prepared drawing in any of the following formats:
*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format  (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.jpg - the compressed image (e.g., a digital picture of the plan);
*.wmf, *.emf - Windows Metafile (export to *.wmf is supported by the majority of the Windows
graphics applications)
 

It is necessary for 3D modelling to place objects only in the horizontal projection. Color of the
objects is specified in the line type , by means of which the object is drawn.  
Heights of the objects can be specified on the  Current construction parameter panel  during
drawing constructions. 
For example to model a grey wall it is necessary to use lines with the minimum height 0 m and
maximum - 3 m (the height of the wall); to model a door draw a rectangle using a line with the
heights 0-2 m; to model a table surface draw a rectangle in the height range 0,73-0,75 m etc. 
Windows and door apertures can be cut through walls made by the Wall  tool with the help of the
Aperture in Wall  tool. Or model walls by several constructions: under aperture, on each side of
aperture, above aperture.

It is possible to put 3D models  of people in some places. 
 

3. Create the essential quantity of cameras, using the copying   and paste  . 
 

4. Enable showing person detection  and identification  areas of created cameras. 
 

5. By changing camera disposition in the graphics window and lenses' focal lengths  we obtain
the best location, when person detection and identification areas cover necessary areas on the
layout.
See. Example 1 .
 

6. In the 3D Video  we can see 3D models of camera images.
 

7. Choose Filling  in the drop-down menu of the Fill projection  button on the Tool bar.  
 

View area projection will be filled by blend color.
 

The color of filling is determined by the line type  of the camera.
 

8. Choose Discrete color  in the drop-down menu of the    Spatial resolution  button on
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the Tool bar.  
 

View area projection will be divided into the regions. The regions will be colored according to values
of the criterion  within the regions. 

 

9. Open the Spatial resolution   box.
 

In the Pattern criterion  combo box you can see which criterion is chosen in the pattern assigned
to the active camera.
 

 

In calculation of spatial resolution, the Vert.(Horiz.) number of pixel  is taken into account.
 

In the Table of regions  you can see what color corresponds to each range of the criterion value.
On the images in the Resolution  column, you can see with which resolution people at the far
bound of each region will be visible.
On the images in the Field of view  column, you can see which part of the field of view people at
the far bound of each region will cover.
 

 

10. Create additional layouts if needed (e.g. several storeys).

You can see your project in 3D form in the  3D World .

External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf), The
principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf). 
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10.3 Example 3  Choice of cameras' quantity and location on the
original layout

Problem
 

There is a location plan of site in any of the following formats:
 

*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format  (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.jpg, *.gif, *.tif, *.png - the compressed image (e.g., a digital picture of the plan);
*.pdf - cross-platform format of electronic documents developed by Adobe Systems;
*.wmf, *.emf, *.emf+ - Windows Metafile (export to *.wmf is supported by the majority of the
Windows  graphics applications)
 

The length of a building frontal wall - 80m. (Or any other size) is known.
It is required to create a project of site surveillance system.

Solution
 

1. Choose menu item Drawing > Load background > Horizontal projection . 
 

2. In the appeared dialog box choose a layout file and click Open.
 

3. In the appeared dialog box Adjust Background  click Ruler.
 

4. Click the beginning of the frontal wall in the loaded layout.
 

5. Then click on the end of the frontal wall.
 

6. After that enter the known length of the frontal wall - 80m in the Real distance box.
 

7. Then click OK in the Adjust background dialog box .
 

If the loaded background is in PDF format, the Adjust background dialog includes fields for
selecting page in the PDF document and to set resolution of the PDF document. If the loaded
background is in DXF or DWG format, the dialog includes tools to select a layout and to control
visibility of layers of the background, as well as a checkbox to hide texts.

 

8. To obtain 3D model of the site , draw out lines on the background by Constructions  in
VideoCAD.
 

If the loaded background is in AutoCAD DXF or DWG format, you can import lines and polylines
from the background to VideoCAD constructions automatically using the tool Import DXF/DWG
background .

 

9. Further place cameras and cables on the original layout as well as in previous Examples .

See more: Work  with background in AutoCAD formats
External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
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10.4 Example 4  Calculation of camera view area parameters

  

Problem 
 

It is required to calculate a horizontal projection of view area in a height range of 0.5-2 m and
projections of person detection and identification areas to a camera with 1/4" image sensor and
lens of 12-mm focal length. 
 

The camera is installed at 3,5-m height above the ground. View area far bound is to be 10 m away
from the camera location. 
 

The camera is designed to detect a person. It is required to determine identification capacity. 
 

The lighting is adequate, camera resolution is high, and a digital system of high resolution is used for
displaying and recording. Compression level is minimal.

The solution by calculating
 

1. If the project is not created, click Main menu>Project>New  . Then type a project name and
choose Metric.

 

In the Camera Geometry box  set:
 

Camera parameters:
 

Image sensor format  - 1/4";
Lens focal length  - 12 mm;
Quality level  - Quality 1 (the best);

 

Installation parameters:
 

Installation height  - 3,5 m.
 

Required view area limitations:
 

View area upper bound distance  - 10 m;
View area lower bound  - 0,5 m;
View area upper bound  - 2 m.

2. After the last parameter in the Camera Geometry box  is entered, an approximate image of view
area and the exact sizes of view area horizontal projection are displayed:
 

View area horizontal projection lower bound  (the near one, in this case) distance - 7,69 m;
View area lower bound width  - 2,46 m.
View area upper bound  (the far one, in this case) width - 3,01m.

 

Now we see color frames on the buttons  on the Tool bar : Person detection area , Person

identification area   and License plate reading area , designating the presence of the
areas.

Presence and sizes of the areas depend on set criteria of  person detection , person
identification  and license plate reading .

3. When clicking Person detection area  the sizes of a person detection area projection are
displayed:
 

Near bound distance - 5,12 m;
Near bound width - 1,63m;
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Far bound distance  - 21,3 m;
Far bound width - 6,41m.

 

The information on person identification and license plate reading areas' projections is obtained by
analogy.
 

4. If the information obtained is not satisfactory, for instance:
The view area lower bound distance is too large (7,69 m), though possessing person detection
area margins, we easily change lens focal length to 8 mm.
In this case, the bound of person detection area remains within the required limits, and the near
bound distance reduces to 5,73 m. When using a 12 mm lens we lower a camera up to 2.5 m,
then the view area near bound distance becomes 7,14 m. 
 

5. Thus selecting parameters, we can choose the most suitable ones to provide the required view
area.

To view the projections' image of view areas obtained, click the buttons Person detection area  ,

Person identification area  , License plate reading area   on the Tool bar  of the
Graphics window, after which the calculated projections are displayed. 
 

To save the drawing obtained to a file, click Save drawing as  menu item.
 

To copy the drawing into the Windows clipboard, click Copy to clipboard  menu item after which
the drawing can be pasted into a graphic editor, e.g. Paint. 
  

To print the drawing choose the menu item Drawing>Print . 

To save the project, click Project> Save as   and save the project to a file.
 

If the project information is to be exported into a text file, e.g., to execute an explanatory note
promptly or print it out for the installers, we click menu item Project > Text report  and thus save
the text file.
 

To obtain all camera parameters as a table, click   Table of cameras  button on the Tool bar.

You can see your project in 3D form in the  3D World .

External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf) ,  "The
principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification area,
license plate reading area. Spatial resolution."(*.pdf)
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10.5 Example 5  Calculation of cameras' parameters and choice of
their relative locations

Problem 
 

It is required to monitor a wall of building at a level of ground floor windows. 
 

Wall length - 60 m. 
Height of windowsills - 1 m. 
Height of windows - 2 m. 

 

The minimal height to install cameras under the requirements of vandalism guard - 3.5 m.  
 

Person detection by the digital video motion detector for the wall space is required. The video
motion detector can detect an object with no less than 5x5 pixel size. 

 

An entrance is situated within a 20-m distance from the wall edge. It is required to identify all
people coming in and out of the building.

 

A busy highway is situated within a 10-m distance from the wall. It is required to minimise the
highway hitting in the camera view areas.

 

The lighting is adequate and at night luminaires are used.
 

The high-resolution cameras are used, with 1/3" image sensor, 752x582 effective pixels.
 

A digital system of the high resolution with the full frame input is used for displaying and recording.
Output image size is 768x576 pixels.

 

The compression level is minimal. 
 

The image is color. 
 

Real horizontal resolution is 350 LPH    

Solution

The example describes the calculation method for better understanding. It is much easier to
solve the problem by graphics methods, as described in previous examples . 

First we will calculate 2 variants of camera placing and will compare both the variants, 
Then we will check depth-of-field , then we will obtain 3D images  from the cameras. 
 

Calculation of variants of cameras placing

 

In this case the best solution might be the disposition of two cameras looking towards each other
on a building wall. 

 

The best height is a minimal possible height, i.e. 3.5 m. It is required to choose the cameras'
lenses and location. 

1. If not to consider a door the problem comes to choosing a lens for a camera installed at 3.5-m
height. Its view area projection length  (i.e. a distance between a near bound and a far one) in a
height range of 1-2 m is to be equal to a half of wall length (i.e. 30 m). A view area width is to be
minimally possible to enhance the object resolution for the wall space and reduce the highway
hitting the view area.  
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1.1 If a project is not created, click Main menu>Project>New  , and type a project name.
 

1.2 At creation of new project one camera are created automatically.  
 

1.3 Then customize a criterion of person detection by the video motion detector (if it is not
customized earlier).
 

1.3.1 Choose the Main menu>Criteria>Person detection area . 
 

Minimum size of detected object is 5x5 pixels. If a human figure occupies 5 horizontal pixels, it
will occupy no more than 45 vertical pixels. To detect 1.5 m tall person, the minimum vertical
resolution should make 45/1.5=30 pixels per meter. Enter this value to the Minimum vertical
resolution (pixel/meter) box. Click OK to save changes.
 

1.3.2 Enter Number of pixels of the image sensor. Click Sensitivity and resolution  . In the
Sensitivity and resolution box, in the Number of pixels  boxes select 752 x 582. Close the box
and confirm the changes. 
 

1.3.3 Enter Image size. Open 3D Video   , right click on it. On the appeared Image
parameter panel  select the Processing  tab. 
On this tab in the Image size  combo boxes select horizontal and vertical sizes: 768x576. Click
Save  to save change of the image size of this camera and close the box. 
 

1.4 Then we choose lenses. Since the view area width is to be minimal, we start with the
maximal focal length.
 

1.4.1 In the Camera Geometry box   set up:
 

Camera parameters:
 

Image sensor format  - 1/3";
Lens focal length  - 36 mm (for a start);
Quality level   - Quality 1 (don't change). 

 

Installation parameters:
 

Installation height  - 3.5 m.
 

Required view area limitations:
 

View area lower bound  - 1 m;
View area upper bound  - 2 m;
View area upper bound distance  is selected so that the view area length  constitutes 30 m.
The obtained value - 50 m.

2.1 Then we construct a situation model using buttons of Constructions group .

Click Rectangle   and construct a rectangle of 60-m length in horizontal  projection. 
To obtain the required accuracy we switch a grid step  - 10 m on and by clicking the right mouse
button choose a Local snap > To grid. 
 

Using another rectangle mark a door at 20-m distance from the edge of rectangle. 
 

Using  horizontal line mark a highway boundary at 10-m distance from the rectangle in the
horizontal projection.
 

2.2 Then switch displaying person identification area on by clicking Person identification area

. The area obtained will be displayed in orange frames.
 

2.3 Then click Select/Edit   and select the camera. Then click Move  , and on camera
lens. Then select a place for camera location on the wall visually so that the door hits in the
person identification area.
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2.4 Now we see that the calculated view area doesn't get slightly to the end of wall. Click

Change view area upper bound   and then the far edge of building's wall. We see that the
person identification area has shifted slightly. In such a way, the first camera is placed.
 

2.5 Then click Select/Edit  and select the only camera we have, by clicking its lens or capturing
it with a selection window. If at clicking the other objects were selected too, deselect them, by
clicking them while holding Ctrl down.
 

2.6 Click Copy   and specify a base point for the copying, i.e. a camera lens in the
horizontal projection.
 

2.7 Then click Paste   and locate a camera phantom on the opposite wall end in the
horizontal projection. Click a point of a second camera location. After that the New camera
dialog box appears, enabling to change the offered values or to agree with them, by clicking OK.

The new camera is created. Since the second paste is not required, click Stop operation  .
 

2.8 Then select  the created camera, deselecting other objects simultaneously. Click Rotate

 , and specify rotation centre, i.e. a camera lens in the horizontal projection. After that
specify the initial and final points of rotation and rotate the camera to 180°. 
 

2.9 To remove a hatch of view areas, select cameras then click Actual projections   and hide
it. 
 

2.10 At the end, activate the created camera.
 

2.11 Now we see in the horizontal projection the calculated view areas of the cameras
intersecting while the calculated view area of the second camera doesn't get to the end of a wall. It
means that the cameras are used inefficiently. 
 

2.12 Click Change view area upper bound   and then click the windows' boundaries on the left
end of the wall. Thus, the view area bound is set up. 

Then click Move active camera   and select a place for the second camera location so that
the intersection of the cameras' view area was insignificant (margins). 
 

It is seen simultaneously that if the second camera is moved, then the person identifications area
of the second video camera also covers the door, i.e. the identification  of the coming in and out is
realized by both cameras on both sides. Undoubtedly it increases the identification probability, but
in the view areas in the door zone there appears a gap that can not be viewed.  
 

We slightly rotate the cameras from the wall in the horizontal projection.
 

2.13 The person detection areas of both cameras are displayed so that we see that the person
detection is provided along the full length of wall.
 

2.14 Now we read-out the obtained results by measuring the distances using the line segments

.
 

the first camera is to be located within a 1.3 m. distance from the left end of the wall.
the second camera is to be locate within a 13 m. distance from the right end of the wall.

 
There's no doubt the decision is true, still the lenses with a 36-mm focal length are expensive
and hard to get.

3. Now we make calculation for the available lens with a 16-mm focal length and compare it to the
results obtained.
 

3.1 For comparison we make another drawing on another layout. To do that right click on the
Layouts  tabs then choose in the pop-up menu Add Layout. The new layout is created.
 

210

191

191

171

188

189 192

175

210

210

274



Examples of work with VideoCAD 539

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

3.2 By pressing Ctrl+A all objects on the first layout are selected . Then click Copy   and
specify a base point on the first camera lens.
 

3.3 Switch to the new layout using the shortcut Ctrl+TAB.
 

After that click Paste   and specify a base point on lens of the same camera. 
Two dialog boxes of the creation of new cameras appear. Click OK. Since the second paste is not

required, we click Stop operation  . Thus, we have a copy of the first layout. 
 

3.4 Load the third camera from the new layout by double clicking on its lens.
 

3.5 Using the  Lens focal length  box change focal length of the active camera lens to 16 mm.
Activate another camera and change its focal length, too. 
 

3.6 Now we see that the person identification area is insignificant, though present. Select and
move the third camera, superposing the person identification area and a door. Activate the third

camera (if the fourth one is active) and click Change view area upper bound . Specify the
upper bound of view area by clicking the boundaries of windows on the left end of wall. 
Then activate the fourth camera. 

 

3.7 Now we see in the horizontal projection the calculated view areas of the cameras intersecting. It

means that the cameras are used inefficiently. Click Change view area upper bound  and
click the boundary of windows on the left end of a wall. 
The view area bound is set up. 

Then click Move active camera  and select a place for the fourth camera location so that the
intersection of the cameras' view area was insignificant (margins). 
Then slightly rotate the cameras from the wall in the horizontal projection. 
 

3.8 When displaying the person identification area of the fourth camera we see that due to its
shorter length of view area the person identification area has larger sizes. Hence it' s correct to
use the fourth camera for the identification. 

Relocate it when clicking Move active camera , and superpose the person identification
area with the door. 
 

3.9 Activate the third camera again. Then click Move active camera  and select a place for the
fourth camera location so that the intersection of the cameras' view area was insignificant
(margins). 
Slightly rotate the cameras from the wall in the horizontal projection 
 

3.10 The person detection areas of both cameras are displayed so that we see that the person
detection is provided along the full length of a wall.
 

3.11 Now we read-out the obtained results by measuring the distances using the segments .
 

the third camera is to be located within a 7.6 m. distance from the left end of the wall.
the fourth camera is to be located within a 31 m. distance from the right end of the wall.

4. By switching between the layouts using Ctrl+TAB we compare both variants and see, that the
one with 36-mm lenses is more preferable in most of the cases, as it provides the larger length of
person identification area.

Graphical calculation of depth of field

 

5. As the long-focus  lenses are used, it makes sense to check the depth of field  for the first
camera with the  36 mm lens which is used for the person identification and the detecting along
the wall at the same time.  Activate this camera.
 

5.1 The calculation of the depth of field requires one more parameter - aperture. As the cameras
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are external, then a wide aperture is necessary for the conservation of sensitivity. Let's preset the
aperture 2.0 typical of mini lenses.
 

5.2 Open the Depth of field calculation box  by clicking the Depth of field  button .
 

5.3 Specify the aperture equal to 2 in the Aperture  box. 
 

5.4 Specify the boundary resolution  350 LPH . This is a real resolution of the color picture

according to camera parameters.   
5.5 When the Depth of field calculation box  is opened, the sharpness area limits  and the
plane at the hyperfocal distance  are seen in the graphics area. We see that while focusing at
the hyperfocal distance and further the door doesn't get into the sharpness area   

5.6 Click the  Specify the focus plane  button  in the Depth of field calculation box.
 

5.7 By clicking the view area make the sharpness area cover the door and touch the end of the
wall.  
 

5.8 As we succeeded, then the depth of field is sufficient. For the necessary depth of field the
camera should be focused at the distance 26 m.  

Getting 3D image models from video cameras

 

6.1 Build the wall with windows and door and the highway with the help of the tools:  Wall

,   Aperture in Wall   and Rectangle   in the horizontal projection.
First build the Wall. 

Choose Wall  .
On the Current construction parameter panel  enter:
3D H min (minimum height of 3D construction) = 0;
3D H max (maximum height of 3D construction) = 3;

 

Build the wall (0-3m) by specifying its ends. 
 

Then make window apertures in the Wall.

Choose  Aperture in Wall  .
On the Current construction parameter panel  enter:
3D H min (minimum height of 3D construction) = 1;
3D H max (maximum height of 3D construction) = 3;
Specify by clicking ends of each aperture within the projection of the Wall.

  

Build the highway (0-0.1m) using the Rectangle  tool  within the heights 0-0.1m. 
 

6.2 Using 3D object    tool, place people next to the door and along the edges of the wall and

cars on the highway.    

 

6.3 Open 3D Video by clicking the 3D Video   button. 
 

6.4 Activate all the cameras of the project by turns, see real pictures from them.
 

6.5 Save obtained pictures with the help of the item in the menu in 3D Video Image>Save as *.

bmp  or Image>Save as *.jpg .    

In such a way, using VideoCAD we have solved a problem in the best way, using two cameras only. 
Since for the solution of the similar problems 3 cameras are used as a rule (with an
individual camera at the entrance), we have saved no less than $200.
 

To save the project, we click  Main menu>Project>Save as  and thus save the project to file.
To print the drawing choose the menu item Drawing>Print
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If the project information is to be exported to a text file, e.g., to execute an explanatory note
promptly or print it out for the installers, we click  Project > Text report  and thus save the text
file.

You can see your project in 3D form in the  3D World .

External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf) ,  "The
principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification area,
license plate reading area. Spatial resolution."(*.pdf), The principles of CCTV design in VideoCAD.
Part 3. 3D modeling in VideoCAD"(*.pdf) 
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10.6 Example 6  Determining person identification criteria by a real
image

Sizes of the person detection, identification , license plate reading areas, calculated by VideoCAD,
depend on the numerical values of the criteria of person detection ,  identification  and license
plate reading  and Image size (pixels).    

 

The criteria are specified by the designer, based on the image quality of the video system being
used and aspects of the problem. 
 

Image quality in VideoCAD is modeled by the following parameters:
 

Camera parameters (Sensitivity and resolution  box):
color ;
Horizontal and Vertical number of effective pixels of image sensor ;
horizontal resolution ;

 

Image processing parameters  ( Processing  tab on the Image parameter panel ):
Horizontal and Vertical size of output image ;
full frame  or one field;
brightness ;
contrast ;
sharpness ;
compression .

Knowing the video system parameters and having one or several exemplary images with people
and cars from this video system, it is possible to fit the quality parameters and criteria for modeling
person detection, person identification, license plate reading areas produced by this video system.   
 

The best image is that, on which many people are captured at different distances, at the same time
some of the people can be considered identified. 
 
It is necessary to remember that: 
 

the result of identification, detection and reading depends on many factors; it is impossible to
model all of them, and even if it were possible, then the labour-intensiveness and the probability of
error of such modeling would be very high;
by video system is implied a video camera with the lens, video signal  transmission channel,
recorder and display device. Each component can cause specific distortion;
from one and the same video system images of different quality can be obtained depending on its
settings and scene features;
detection and identification depend on personal qualities of the operator, on the degree of
acquaintance with the identifiable person;
video system resolution, measured with the help of the test chart is not a sufficient parameter for
getting detection and identification criteria.  

 
In spite of all these complexities it is quite possible to get correct criteria for VideoCAD with
the enough accuracy for practice.      

Problem

 
There are some images from video system with the images of people. It is planed to build a large-
scale CCTV system on the basis of this video system.    
For this it is necessary to determine the person identification criteria according to the designer
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requirements.
 

Video system parameters:
high resolution cameras with 752x582 image sensor are used;
camera is black-and-white;
video signal is captured with 768x288 resolution (by interlaced fields);
in the video system simple notch (not comb) filters are used for the separation of the luminance
and chrominance, which don't become disconnected when the black-and-white signal is
incoming;
middle level compression is used (by the DVR settings ).

Problem solution consists of two stages:
 

Determining the quality parameters of the image model
 

1. Determine the quality parameters of the active camera basing on the video system
parameters.  
 

1.1 Open the Sensitivity and resolution   box.
 

1.2 Enter to the Number of pixels  combo boxes 752x582. 
In the Resolution  box choose the maximum possible resolution in case of using notch (not
comb) filters - 350 TV-lines.

Close the Sensitivity and resolution   box and confirm changes.
 

Open 3D Video  . Open Image parameter panel  by right-clicking on the 3D Video. On the
Image parameter panel choose Processing  tab.
 

1.3 Enter on the Processing tab:
 

Horizontal size - 768 pix;
Vertical size - 576 pix;
One field - mark;
Color - clear;
Brightness - 5 (to begin with);
Contrast - 5 (to begin with); 
Sharpness - move to middle positions;
Compression - 3 (to begin with). 

 

Horizontal resolution is already specified as Camera resolution .
 

1.4 Click Save for saving the parameters.
Choose View  tab and mark According to camera parameters  box. As a result the 3D image
size will be 768x576 pixels.
 

2. Open the Camera Geometry box  by clicking the Camera Geometry   button.
Determine approximately the same height, inclination, lens focal length, as of the camera, from
which the exemplary image is taken.
 
 

3. Open the exemplary image using any graphical viewer (without scaling!) and place next to the
3D Video.
 

It is possible just to load the image as the background  and to fix its size equal to 3D
Video.

4. Place 3D model  - a person on the horizontal projection of the graphics area within the
bounds of view area projection. Person's figure appears in 3D Video. 
By moving the 3D model in the graphics area try to make person's face take about the same
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location and size as on the exemplary image. 
 

5. Compare face legibility on the exemplary image and in the 3D Video. If necessary correct the
quality parameters (see above) achieving person's face equal legibility. 
 

Place several 3D models at different points of camera view area. 
It is desirable to repeat p. 3… 5 with several exemplary images.

When all adjustments have been made, click Save on the Processing  tab to save the
parameters. 

As a result of the given source data the following quality parameters are:
 

Brightness - 4;
Contrast - 7;
Compression - 2;
Horizontal sharpness - minus 1;
Vertical sharpness - minus 1;

The fragments of the real image and the image model (additional processing has not been done):

   

Determining the person identification criteria on the image model
 

6. Open the Camera Geometry box and specify the following parameters: 
 

installation height = 0.2 m above the maximum height of identification (2.2 m); 
height of view area upper bound =0.1 m above the maximum height of identification (2.1 m); 
lens focal length=4,5 mm;
image sensor format =1/3". 

 

These parameters are optimal for the person identification area size not to be limited by the view
area bounds. Look at the vertical projection. If there is a limit, change the parameters.

7. Place several  3D models - people of the minimum height (1,5 m) within the bounds of the
camera view area.  
 

The angle between a direction on the camera and horizontal  is maximum exactly to the
figure of the minimum height.   
 

8. Show the Person identification area  by clicking the  Person identification area 
button. 

9. Open the Criteria editing box of person identification area , by choosing the menu-item
Criteria>Person identification .
 
10. By examining the image in the 3D Video and the bounds of the calculated identification area in
the graphics window, determine the near and far identification bounds according to your
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demands, by correcting the parameters: 
 

Maximal angle between a direction on the camera and horizontal (the near bound);
Minimal vertical size of face image (pixel) (the far bound).  

 

Minimum and maximum heights of identification depend on the possible range of the human height
and the roughness of the area. These parameters don't depend on the image quality that's why they
are not recommended to be changed.    

As a result of modeling according to our views on identification the following criteria are: 
 

Maximal angle between a direction on the camera and horizontal is 35 degree; 
Minimal vertical size of face image (pixel) is 30 pixels. 

Image fragments at the near and the far identification bounds:

      

Determination of the criteria of person detection  and the license plate reading  is carrying out
in a similar manner.  

External link : The principles of CCTV design in VideoCAD. Part 2. Person detection area, person
identification area, license plate reading area. Spatial resolution."(*.pdf)
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10.7 Example 7  CCTV design using Monitor window and PTZH
frame

The Monitor window  and the new tool in the 3D Video  - PTZH frame  allow to project video
surveillance system by a new method, working directly with images from video cameras. This
method can be very convenient.

Order of work: 

1. Create  the project, load background , by means of constructions  create 3D model of
environment and place 3D models  of people and cars at control points.
 

2. Preliminary place cameras in the Graphics window. 
 

3. Choose camera models  if necessary.
 

4. Open  the Monitor window,
choose Dimension  of monitor. This
dimension must be a little bit greater
than quantity of cameras. Connect
all cameras to this monitor. On the
monitor images from preliminary
placed cameras will be visible.

 

5. Analyze images. If an image is not optimum, do the following:
 

Double click the image. 3D Video will appear. 
In the Main menu of 3D Video choose item View> PTZH frame . 

 

Using the frame, adjust position and
parameters of the camera to get optimum
image. At the same time, changes in the 
Graphics window are performed
automatically.

 

Thus adjust all cameras. If necessary move  cameras in the Graphics window, create
additional cameras and delete the cameras, which have become unnecessary. 
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If one monitor is not enough to control video surveillance system, connect cameras to other
monitors  in the Monitor window.

6. As a result we receive ready project: 
 

Drawing of cameras' placement in the Graphics window;
Images of video surveillance system on monitors;
Description  of all cameras for an explanatory note;
A table  with all camera parameters.

External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
. 
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10.8 Example 8  CCTV project

In the  Examples directory you can find an example of a video surveillance system project of an
administration building that was designed in VideoCAD.
 

In this project locations and parameters  of cameras were chosen. Models  are assigned
to the cameras.
 

When locating the cameras, its person detection areas, person identification areas,  license plate
reading areas were considered depending on cameras' purpose.
 

In the project a prepared background  is used in the *.dxf format, walls and objects in the
cameras view areas are outlined by VideoCAD constructions. There are 3D models  and 3D
images  in the project.

There are Illuminators , which switch ON in the nightime.

You can look into each camera having activate it and opening 3D Video  .   
 

It is convenient to load camera by double click ing on its lens or by choosing in the Active camera
 combo box.

 

You can display all cameras on the Monitor, by clicking the Monitor window   button. You can

switch between daytime and nighttime, by clicking Day/Night   button on the Monitor window
Tool bar.

In the the demo-version you can not edit the cameras. When activation of any camera its lens
focal length  will become 4 mm, image sensor format  - 1/3", lens aperture  - F1.2 and
light sensitivity  - 1 lux.
In the full version you can edit the project and choose more suitable location and parameters of
cameras.

You can see your project in 3D form in the  3D World .

External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
. 
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10.9 Example 9  Choice of camera model according to known scene
illumination

See before: About camera sensitivity

Problem
 

There is a black/white mini camera with known sensitivity parameters: Minimum scene
illumination 0.04 lx with lens F1.2 at signal/noise ratio=10dB, IRE30. 
 

Mini lens F2.0 is mounted on the camera. 
 

At night the scene is poorly illuminated by the illuminator with a mercury high pressure lamp,
placed far from the scene. Illumination measured by the luxmeter is 0.1 lx.
 

It is required to obtain and evaluate image model from the camera.  

Solution
 

1. Create camera by clicking the Create camera   button and place it on layout.
 

2. Modeling the scene. 
 

2.1 Open the 3D Video  .

2.1.1 Click the 3D model    button and place some different 3D models in front of the camera.
 

3. Modeling scene illumination.
 

3.1 By right clicking or double clicking on the 3D Video open the Image parameter panel , open
the Scene  tab. On the Scene tab switch to the Night  tab. 
 

On the Night tab:
 

3.1.1 Mark the Model illumination  box. 
3.1.2 Select in the combo box Background light source  = Mercury high pressure.
3.1.3 Select in the combo box Background illumination (lx)  =0.1.
 

4. Modeling camera sensitivity. 
 

4.1 Open the Sensitivity and resolution  . box. In the box select sensitivity parameters on the
Camera  panel:
4.1.1  Color  = black/white.
4.1.2  Minimum scene illumination (lx)  =0.04.
4.1.3  At aperture  =F1.2.
4.1.4  S/N (dB) =10.
4.1.5  IRE  = 30.
4.1.6  exposure (ms)  = 20.
4.1.7  Mark the AESC  (electronic shutter), AGC  (automatic gain control) and Gamma

(gamma correction) boxes.
 

4.2 On the Lens  panel choose:
4.2.1 Fixed iris .
4.2.2 Aperture limits  = F2.0.
 

5. In the 3D Video we see image model and calculated values: signal amplitude 20 IRE and signal/
noise ratio (S/N)=2.31dB.
 

Visually the image is unsatisfactory. 3D models are lost in noise. 
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6. Select more sensitive standard design camera with a higher aperture lens: minimum scene
illumination 0.04 lx with lens F1.2 at signal/noise ratio=17dB, 50 IRE. The lens F1.2 is mounted on
the camera. 

6.1 Specify its parameters in the Sensitivity and resolution   box and see the image model.
Visually image quality at the night time is quite acceptable. Calculated parameters: S/N=17dB, 51
IRE. 

It is possible to specify resolution  parameters, check possibility of 3D model detection and
identification at known distances. 

It is recommended to perform the test with 3D model   of a black  man.
It is recommended to set the maintenance factors .
 

External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.10 Example 10  Measuring camera sensitivity

See before:About camera sensitivity .

Problem
 

There is a camera. It is necessary to measure its sensitivity.

The matter of measurement of sensitivity is a measurement of scene illumination with which the
camera image have Signal/Noise ratio = 17dB. To measure illumination a Luxmeter is used, to
measure Signal/Noise ratio the Image analyzer or the Video analyzer from the CCTVCAD Lab
Toolkit package can be used.
The Video analyzer reads out the Signal/noise ratio directly from the screen.
The Image analyzer uses the stored frames in *.bmp or *.jpg formats.
In most cases the Video analyzer is more convenient for measuring signal/noise ratio.

Equipment:

To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).

 

Luxmeter (a device for measuring illumination).
Almost any kind of such a device with
standard CIE spectral response will suit.

 

If the lower limit of illumination measured by the
luxmeter is more than assumed camera
sensitivity, see Measuring low illumination .
 

Any PC-based video capture system, TV-tuner
with video input, etc. The System should allow
to display live video on the computer screen
and save images without compression or with
little compression.

 

For measuring IP cameras' sensitivity it is
enough to  have possibility to display images on
the screen and save images. 
 

IP cameras sensitivity can worsen considerably
depending on compression level.
 

Image analyzer utility. It is a part of
CCTVCAD Lab Toolkit .

 

Compact tungsten halogen lamp 12V, 10W.
 

Stabilized power supply unit for the lamp. 12V
DC, without considerable ripples of output
voltage.

 

Lens with F1.2 aperture, parameters of which 
are reliable, focal length is 4-8mm. 

 

If the camera allows to mount only mini-lenses
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(M12), the mini-lens with a known aperture (F2.0)
is needed.
 

A test chart with grey scale, for example
EIA1956.

 

Stand. It is recommended for convenience and
accuracy. 

 

Measuring sensitivity should be carried out in a
dark  room.
 

Order of work
 

1. Switch off all additional options of image processing. Only AESC and AGC should be switched on.
Switch maximal gain of AGC if it is possible.
 

For IP cameras, set the compression type - M-JPEG, the image quality - the best. While measuring
the sensitivity of IP cameras you must know which exposure time is used by the testing camera,
otherwise the measurement becomes meaningless. 
See Measuring exposure time of IP camera .
 

Sensitivity of IP cameras can depend on the number of pixels in image. The higher the number of
pixels is, the smaller pixel size - the worse the sensitivity.
Correctly measuring sensitivity of modern IP cameras is not an easy task . When light is decreased,
IP camera automatically turns on the noise reduction, merges neighboring pixels, reduces frame
rate, multiplies exposure time, disables color. The black  level rises and the noise is lost in black
together with dark  image details. Meanwhile turning off this automation is impossible in many cases.
 

2. Mount lens F1.2, on the camera, mount the camera on stand, direct it towards the test chart,
connect to computer, display image on the screen.
 

If the camera allows mounting only mini-lenses (M12), mount a mini-lens with known aperture (F2.0).
 

3. Direct on the test chart, in the camera field-of-view place the luxmeter sensor.
 

4. Defocus.the image slightly to blur possible unevenness on the chart. 
 

5. Switch on tungsten halogen lamp. Switch off common light. 
 

6. Changing the distance from the lamp to the test chart, get an image with visible noises on the
screen. 
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the test chart. 
Be sure, that the luxmeter sensor window and the grey scale of the test chart have visually equal
illumination.
 

7. Save the image and record illumination according to the luxmeter reading.
 

If luxmeter sensitivity is not enough, see Measuring low illumination .
 

8. Repeat p.6.. 7 for different illumination.
 

9. Measure signal/noise ratio for saved images by means of the Image analyzer . As a white
area use the white area of paper near to the luxmeter sensor window. As a dark area use one of
rectangle of the grey scale.
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About choice of the dark  area in details:
The dark  area must meet two requirements:
1. Noise at the area should be not be greatly
restricted by the black  level.
2. It should be exactly the darkest area.

With standard analog cameras it is usually
enough to choose the black  darkest square on
the gray scale. Automation analog camera works
in such a way that the black  level is kept when
changing the light, not cutting off the signal and
noise.
Complicated analog cameras with digital
processing, IP cameras can behave
unpredictably. Sometimes while changing light
levels some of squares in the gray scale goes
for the black  level or rise above the black  level,
black  level "floats." In this case we have to
choose to measure different areas, mak ing sure
that the dark  area is really darkest and the noise
is not cut by the black  level. 
 
 

10. Find image with signal/noise ratio equal 17dB. Record Maximum level of brightness and
illumination at which this image is obtained.
 

11. Value of illumination at which the image is obtained is the Minimum scene illumination  for
the tested camera at signal/noise ratio  equal 17dB and lens F1.2 (F2.0 for a camera with mini-
lens).
The Maximum level of brightness is the IRE at the minimum illumination . 
 

You can insert these values into the Table of camera models  or in the Sensitivity and Resolution
 box. After that it is possible to perform precise modeling of the tested camera model.

3

With complicated analog cameras and IP cameras may be a situation when we can not  get the
signal to noise ratio equal to 17dB because of constantly working noise reduction schemes. If the
noise reduction can not be disabled, then we can not use the Signal/Noise ratio as a boundary
criterion of sensitivity. In this case we have to choose another boundary criteria, for example the
image resolution. Precise modeling of the sensitivity of these cameras is not possible, but an
approximate simulation of images details may be sufficient for practice. 

See also: About camera sensitivity , Measuring low illumination , Sensitivity and
Resolution>Camera , Table of camera models .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.11 Example 11  Measuring low illumination

Not expensive luxmeters which are presented on the market have the lower-range value about
0.1..0.5 lux, but minimum scene illumination for modern cameras reaches 0.04 lux. Therefore when 
measuring sensitivity  of such cameras it is necessary to attenuate sensitivity in known number of
times (it is convenient to attenuate in 50-200 times).
 

It is possible to attenuate sensitivity in the following ways:
  

By limiting exposure time of electronic shutter ; 
By calibrated manual iris lens ;
By calibrated attenuation filter . 

Setting limit of electronic shutter
 

If camera allows setting exposure fixed value of the electronic shutter (ES, AES, AESC, ESC) on
1/1000-1/10000s, this way will be the easiest way of sensitivity attenuation.
For example, when setting exposure time on 1/10000s, the CCIR/PAL camera sensitivity is
attenuated in 10000/50=200 times. Thus, the sensitivity of 0.05 lx will correspond to scene
illumination of 0.05x200=10lx.
 

For EIA/NTSC cameras the attenuation will make 10000/60=167 times.
 

Although the Reciprocity principle is generally correct in digital photography, some cameras can
have a difference between the shutter time from the settings and the actual exposure time.
Additionally the Reciprocity failure can take place in some situation. Therefore, this method may
be inaccurate.
 

We recommend to check real exposure time of your camera .

Calibrated manual iris lens
  

 

Sensitivity measuring is made with the lens with narrowed aperture. 
Camera sensitivity with such lens should be attenuated in known number of times. It is possible
to use standard lens with manual iris after calibration as the lens with narrowed aperture. 
 

Equipment:
 

For calibrating lens in addition to the equipment  listed above the following is necessary:
 

Lens with manually adjustable iris. Focal length must be the same as in lens with aperture
F1.2.

551

554

554

555

593

551



Examples of work with VideoCAD 555

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Camera with attenuated  sensitivity or color camera with sensitivity 1..3lx preferably with the
possibility to switch off AGC.
The Video Analyzer  utility is included in CCTVCAD Lab Toolkit .
Projector with halogen incandescent lamp 500-1000watt, 220V. 
Sticky tape

Order of calibration
 

1. Switch off all image processing and AGC in the camera.
 

AGC switching off increases calibration accuracy and allows work ing with illumination of 5..10lx,
even if the camera has sensitivity of 0.2..1lx.
 

2. Mount lens F1.2, on the camera, mount the camera on stand, direct it towards sheet of paper,
connect to computer, display image on the screen.
 

3. In the camera field-of-view place the luxmeter sensor.
 

4. Close to the sensor window directly on the sensor, fix a small piece of even white paper.
 

5. Run Video Analyzer . Mark Cycle box, click Start. After that move fast the mouse cursor to
the small piece of even white paper on the screen, close to the sensor window. 
 

6. Switch on tungsten halogen lamp. Switch off common light. 
 

7. By changing distance from the lamp to the sheet of paper, obtain that the Average brightness
measured by the Video analyzer would be equal to 0.22-0.25 after finishing measuring cycle by
100 frames.
 

The objects on the image should be recognized. 

 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

8. Write down luxmeter reading and the Average brightness value according to the Video analyzer
reading.
 

9. Substitute the lens F1.2 to the lens with manual iris.
 

10. Using the projector with halogen lamp set illumination exactly 100 times more than the
illumination registered in step 8. Fix the projector.
 

11. By adjusting lens iris obtain the Average brightness value from the same point on the image
according to the Video analyzer reading, equal to the value written down in step 8.
 

12. Fix the iris adjustment ring by the sticky tape.
 

13. Verify the Average brightness value.
 

14. Remove and mount again the lens. Make sure that the Average brightness value is changed
only insignificantly.
 

The calibrated lens, with which the camera sensitivity is attenuated in 100 times, is obtained. 
With this lens the sensitivity of 0.05lx will correspond to the scene illumination 0.05x100=5lx. 
 

It is recommended to verify lens calibration after measuring sensitivity of each camera.

Using attenuation filters
 

It is possible to measure sensitivity of camera with mini-lens (M12) using attenuation filters. Such
cameras, as a rule, do not have possibility to fix electronic shutter exposure value . It is difficult
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to find mini-lens with manual iris .
  

 

Spectral transmission characteristic of standard neutral density optical filters is not standardized
in sensitivity range of CCD sensors. It is standardized only in eye sensitivity range. Therefore it
is possible to use filter only after measuring its transmission of the light produced by
halogen lamp for the same CCD sensor as in the tested camera. 
When using filters for sensitivity measurement without preliminary transmission measurement, 
significant errors in measurement results are possible.  
Transmission coefficient value of filters for black/white and color cameras can differ. It is necessary
to make calibration separately for black/white and color cameras.
 

As standard filters of neutral density have unknown transmission coefficients in the sensitivity
range of CCD sensors and need their measurement, with the same result it is possible to use self-
made filters, made from floppy disk, with unknown transmission coefficient also.
 

Measuring filter transmission coefficient
 

Equipment:
 

For measuring in addition to the equipment  listed above the following is necessary:
 

Camera with attenuated  sensitivity or color camera with sensitivity 1..3lx preferably with the
possibility to switch off AGC.
The Video Analyzer  utility is included in CCTVCAD Lab Toolkit .
Projector with halogen incandescent lamp 500-1000watt, 220V. 

 

Order of measurement
 

1. Switch off all image processing and AGC in the camera.
 

AGC switching off increases calibration accuracy and allows work ing with illumination of 5..10lx,
even if the camera has sensitivity of 0.2..1lx.
 

2. Mount lens F1.2, on the camera, mount the camera on stand, direct it towards sheet of paper,
connect to computer, display image on the screen.
 

3. In the camera field-of-view place the luxmeter sensor.
 

4. Close to the sensor window directly on the sensor, fix a small piece of even white paper.
 

5. Run Video analyzer. Mark Cycle box, click Start. After that move fast the mouse cursor to the
small piece of even white paper on the screen, close to the sensor window. 
 

6. Switch on tungsten halogen lamp. Switch off common light. 
 

7. By changing distance from the lamp to the sheet of paper, obtain that the Average brightness
measured by the Video analyzer would be equal to 0.22-0.25 after finishing measuring cycle by
100 frames.
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The objects on the image should be recognized. 
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

8. Write down luxmeter reading and the Average brightness value according to the Video
analyzer reading.
 

9. Mount measuring filter on the lens.
 

When using filters from a floppy disk  it is convenient to use lens cover with cut out hole as a
mount.
 

10. Switch on the projector with halogen lamp 500-1000 watt, 220V. 
 

11. By changing the distance from the projector to the sheet of paper, obtain equal with step 8
value of Average brightness after finishing measuring cycle by 100 frames. 
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
 

12. Write down the luxmeter reading.
 

13. Filter transmission coefficient = illumination without filter/illumination with filter.
 

Calibrated filter is obtained with which the camera sensitivity is attenuated in a known
transmission coefficient. For example, if the filter transmission coefficient is 0.0125, the camera
sensitivity of 0.05lx with the filter will correspond to the scene illumination 0.05/0.0125=4lx.

See also: About camera sensitivity , Measuring camera sensitivity , Sensitivity and
Resolution>Camera .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.12 Example 12  Measuring resolution of camera (lens)

Problem 
 

There is an image of the test chart EIA 1956, made by equipment under test (camera+lens+DVR). It
is necessary to determine equipment resolution in LPH at contrast loss of 10%.
 

The test chart EIA1956 in full resolution allows
to measure resolution up to 1600 LPH. To
measure higher resolution you can also use the
test chart EIA1956, but it should not occupy the
entire frame, but a part of the frame. For
example, if the table will occupy by the area of a
quarter of the frame (half the vertical and half of
horizontal sizes), the range of measured values
of resolution will be doubled.
 

By mak ing measurements with the same
camera, but with different lenses, we can
compare resolution of the lenses. Lens
resolution is very important for megapixel
cameras.
 

We can measure resolution with a given drop
of contrast as well as drop the contrast at a
given resolution.

 

To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).

Solution

1. Open the Image analyzer  from CCTVCAD Lab Toolkit.
 

2. Click Load in the upper left corner of Image analyzer and select image file. 
 

3. For conveniences it is recommended to increase image size in 2 times. To do this open the
Processing tab, enter two times larger sizes on the Image size panel and click Apply.
 

4. Open the TV lines tab.
 

5. Click vertical wedge area of the test chart with lines corresponding to the minimal resolution (100-
200 LPH). Record  peak-to-peak amplitude of signal in the area of minimal resolution. 
 

The peak-to-peak amplitude of signal can be seen on the oscillogram under the image.

6. Move the cursor with pressed mouse button to the side where the wedge becomes narrow up to the
moment when the peak-to-peak amplitude of signal from the wedge makes 10% from the signal
amplitude at minimal resolution.
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7.  Determine resolution according to the place of analyzing line on the test chart.
 

In case when resolution is close to the maximal possible one at specified image size and camera
aperture corrector works, determining the point of the contrast loss of 10% could be difficult. Image
pixel beating and chart lines beating as well as image digitization hinder from it. This problem refers
equally to all ways of resolution measurement.

Using CCTVCAD Lab Toolkit we can measure resolution of separate colors.
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10.13 Example 13  Measuring maximum scene illumination for a
camera

Problem
 

There is a camera. It is required to measure maximum scene illumination, at which this camera
produces image without brightness limitation.

Equipment:
 
 

Luxmeter (a device for measuring illumination).
Almost any kind of such a device with
standard CIE spectral response will suit.
Monitor.
Projector with tungsten halogen lamp 220V,
1000W or more.

 

Such projector can create illumination up to
150000lx, what exceeds illumination in bright
sunny day on mid-latitudes (100000-120000lx).
 

Work carefully with the projector. There is
danger of overheating and inflammation of
fire hazardous materials next to the projector.
 

Lens with F1.2 aperture, parameters of which 
are reliable, focal length is 4-8mm. 

 

If the camera allows to mount only mini-lenses
(M12), the mini-lens with a known aperture (F2.0)
is needed.
 

A sheet of crumpled white paper.
 

Stand. It is recommended for convenience and
accuracy. 

Order of work
 

1. Switch off all additional options of image processing. Only AESC and AGC should be switched
on. 
 

2. Mount lens F1.2, on the camera, mount the camera on stand, direct it towards sheet of paper,
connect to computer, display image on the screen.
 

If the camera allows mounting only mini-lenses (M12), mount a mini-lens with known aperture (F2.0).
 

3. Reduce contrast of the monitor to 50-70% of maximum. 
 

4. Close to the sensor window directly on the sensor, fix a small piece of crumpled white paper.
 

5. Switch ON the projector. 
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6. By changing the distance from the projector to the luxmeter sensor, obtain the image on the
screen with a little bleeding whites on the bends of the rumpled sheet of paper.  
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

7. Record the maximum illumination according to the luxmeter reading.

Maximum illumination for black /white cameras with 1/3" CCD image sensor with exposure range of
the electronic shutter up to 1/100000s and lens with the aperture F1.2 make approximately
20000..30000lx. It allows using these cameras indoor with any lenses or outdoor with auto iris lenses
or lenses with maximal aperture no more than F2.5. 
Maximum illumination for high-quality color cameras or day/night cameras exceeds 100000lx. For
mini-cameras with image sensor format of 1/4" the maximum illumination can be considerably lower. 
 

As in cameras' specification there is no the Maximum illumination parameter, in VideoCAD the
maximum illumination is not specified separately and is calculated inside the program. For accurate
modeling maximum illumination, first specify all other camera parameters and then choose the 
Maximum signal/noise ratio  for obtaining a little bleeding whites at the measured maximum
illumination. 
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10.14 Example 14  Examples of luminaire calculation

See before: Illuminator calculation

Problem
 

There is a illuminator. It is necessary to create its model in VideoCAD.

Solution

To create new illuminator click the Illuminator   button on the Tool bar .
 

To edit existing illuminator double click on its icon on the layout. 
 

To edit just created illuminator click the Edit  button on the Current construction parameter
panel . 

To open the Illuminator calculation  box click the Illuminator calculation button  on the Current
construction parameter panel .

The calculation may be approximate or more precise, depending on that parameters are known.
 

Example 14.1. Approximate calculation of visible light luminaire
Example 14.2. More precise calculation of visible light luminaire
Example 14.3. Approximate calculation of IR illuminator
Example 14.4. More precise calculation of IR illuminator

Example 14.1. Approximate calculation of visible light luminaire
 

It is known: 
 

Lamp type, power consumption of one lamp and number of the lamps;
Angle of radiation (degree).

Order of calculation:
 

1. Choose lamp type in the Lamp type  combo box.
 

2. Enter power consumption of one lamp in the Lamp power (watt)  combo box.
 

3. Choose number of lamps in the luminaire in the Lamp quantity  combo box.
 

4. Choose Efficiency factor=0.6 in the Efficiency factor  combo box.
 

For projectors with angle of radiation less than 50 degrees select efficiency factor=0.3.
 

If efficiency factor is known from specification, this known factor should be entered. 
 

If a lamp without reflector is being modeled, 0.8 should be entered in the efficiency factor box
and the Omnidirectional light source  panel should be selected. After that jump to the step 7. 
 

5. Enter Angle of radiation .
 

6. Enter 0.5 to the Concentration  combo box. 
 

At concentration=0.5 light intensity on the edges of the light cone makes a half of axial light
intensity.
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7. Click OK.

Example 14.2. More precise calculation of visible light luminaire
 

It is known: 
 

Lamp type, total light flux of one lamp and number of the lamps;
Light intensity curve with lamp with full light flux of 1000 lumen.

 

You can find the Total light flux of lamp in the lamp specification. You can find the the Light
intensity curves with lamp with full light flux of 1000 lumen in the luminaire specification.

Order of calculation:
 

1. Choose Lamp type in the Lamp type  combo box.
 

2. Enter Full light flux of one lamp to the Light flux emitted by lamp (lm)  combo box.
 

3. Choose number of lamps in the luminaire in the Lamp quantity  combo box.
 

4. Using the Light intensity curve with lamp with full light flux of 1000 lumen determine the
angle of radiation (degree) and the axial light intensity (candle).
 

5. Enter Angle of radiation to the Angle of radiation  combo box.
 

6. By choosing concentration value in the Concentration  box or by moving grips when editing
illuminator (holding Ctrl), try to obtain light intensity curve, close to light intensity curve from the
specification.
 

Light intensity distribution curve is displayed by orange line during drawing or editing illuminator.
Light intensity distribution curve represents relative light intensity distribution. The curve does not
depend on absolute values.
 

7.  Recalculate the axial light intensity of the luminaire in proportion to the total light flux of the
lamps .
 

For example: The total light flux of all lamps is F=3000 lumen. In this case an axial light intensity

value obtained from the light intensity curves (with the lamp of 1000 lumen) has to be multiplied by
3.
 

8. By choosing Efficiency factor in the Efficiency factor  combo box, obtain the axial light
intensity in the Axial light intensity (cd)  box which is equal to the axial light intensity
calculated in step 7.
 

9. Click OK.

Example 14.3. Approximate calculation of IR illuminator
 

It is known: 
 

Consumed electrical power and wavelength of radiation maximum;
Angle of radiation.

Order of calculation:
 

1. Choose LED of known wavelength in the Lamp type  combo box.
 

2. Choose consumed electrical power of the IR illuminator in the Lamp power (watt)  combo
box.
 

Consumed power of the illuminator is equal to the product of supply voltage (volt) multiplied by
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consumed current (ampere). These parameters are given in the illuminator's specification.
 

3. Choose '1' in the LED quantity  combo box.
 

4. Choose in the Efficiency factor  combo box:
 

Efficiency factor=0.3 for narrow angle illuminator (angle of radiation is 20-50 degrees);
Efficiency factor=0.5 for wide angle illuminator (angle of radiation is 60-120 degrees).
 

For hot climate select efficiency factor=0.2-0.3.
 

5. Enter Angle of radiation to the Angle of radiation  combo box..
 

6. Enter 0.5 to the Concentration  combo box.
 

At concentration=0.5 light intensity on the edges of the light cone makes a half of axial light
intensity.
 

7. Click OK.

Example 14.4. More precise calculation of IR illuminator
 

It is known: 
 

Wavelength and number of LEDs in the illuminator;
Axial radiant intensity (watt/steradian) of one LED and angle of radiation of one LED (degree);
Radiant intensity curve in dependence of angle for one LED (not obligatory).

 

Wavelength, axial radiant intensity and radiant intensity curves could be found in the LED
specification. For this it is necessary to know LED model.
Radiant intensity in operating mode is changed in direct proportion to current through the LED.

Order of calculation:
 

1. Choose LED of known wavelength in the Lamp type  combo box.
 

2. Choose number of LEDs in the illuminator in the LED quantity  combo box.
 

3. Enter Angle of radiation to the Angle of radiation  combo box.
 

4. By choosing concentration in the Concentration  box or by moving grips when editing
illuminator (holding Ctrl), try to obtain the radiant intensity curve, close to radiant intensity curve
of one LED.
 

Light intensity distribution curve is displayed by orange line during drawing or editing illuminator.
The Light intensity distribution curve represents relative light intensity distribution. The curve does
not depend on absolute values.
In case of the Light intensity distribution curve is not available, - enter 0.5 to the Concentration

 combo box.
 

5. Choose 0.9 in the Efficiency factor  combo box (temporarily).
 

6. By choosing radiant power in the Radiant power (watt) , obtain the axial radiant intensity in
the Axial radiant intensity (watt/Sr)  box which is equal to the product of axial radiant
intensity of one LED multiplied by the number of LEDs in the illuminator.
 

7. Choose 0.5 in the Efficiency factor  combo box for considering power lost in internal circuits. 
 

For hot climate and for illuminators which are get hot select efficiency factor=0.3.
 

8. Click OK.
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The created illuminator model with specified parameters will be the calculation result. 
 

For information in the box the following values are displayed:
 

Axial light intensity ;
Illumination  produced by the illuminator at specified distance  an axis of radiation.

 

Using a luxmeter you can check illumination value on specified distance from the real illuminator,
then choose parameters to achieve full identity of the model and the real illuminator.
 

You can change location of created illuminator model in horizontal projection by moving  and
rotating  similarly to other constructions .
You can specify installation height , vertical inclination angle , dispersion , switch
illuminator ON/ OFF on the Current construction parameter panel . Illuminators can be copied .
 

To allow for lamp aging, supply voltage deviation, as well as luminaire dirt depreciation in operation it
is necessary to set Maintenance factor of illuminators on the 3D modeling  tab of the Options
box  according to CIE 97.  

See also: Illuminator calculation , Lamp parameters , Luminaire parameters , IR illuminators
, Illuminator , Current construction parameter panel>Illuminator , 3D Video>Image

parameter panel>Scene , Measuring parameters of IR illuminator .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.15 Example 15  Choice of luminaire power and location

See before: Illuminator calculation , Examples of illuminator calculations .

Problem
 

As a result of camera model selection  according to the known scene illumination it is determined
that the illumination is insufficient for obtaining image with required quality. Additional illumination is
necessary.
 

Solution
 

1. Create illuminator by clicking the Illuminator  button.
 

2. In the Illuminator calculation  box specify illuminator parameters  according to the
parameters of available illuminator model.
 

See. Examples of luminaire calculation .
 

3. Place the illuminator on the scene. On the Current construction parameter panel  specify height
of illuminator installation and inclination angle.
 

4. Switch on the illumination modeling  and illuminators  on the Scene tab of the Image
parameter panel. Then control image from the camera in the 3D Video .
 

For accurate image modeling the camera parameters  should be specified.
 

5. If necessary create, adjust and place additional illuminators. 

 

For one camera no more than 7 illuminators could be switched on  simultaneously. Switched on
illuminators are saved in camera parameters, therefore it is possible to switch on and switch off
different illuminators for each camera. 
You can switch on/off all selected  illuminators simultaneously using the Main menu or the menu
appeared by right click ing. If there are selected illuminators, in the menu the following items appear: 
Switch on illuminators  and Switch off illuminators .
 

It is recommended to carry out verification with  3D model   of a black  man.
 

It is recommended to set maintenance factor . 

External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.16 Example 16  Determining spectral efficiency of light source

See before: What is spectral efficiency .

Problem
 

There is a lamp and a camera. It is necessary to measure spectral efficiency of this lamp for this
camera in relation to the halogen incandescent lamp. 

Equipment:
 

To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).

 

Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
Any PC-based video capture system, TV-tuner with video input, etc. The System should allow to
display live video on the computer screen.
Video Analyzer  utility. It is a part of CCTVCAD Lab Toolkit .
Tungsten halogen lamp of approximately the same power consumption, as testing lamp.
Manual iris lens, focal length 4-8mm. 
 Stand. It is recommended for convenience and accuracy. 

 

Measuring should be performed in a dark  room.

Order of work
 

1. Switch off all image processing options and AGC in the camera.
AGC switching off increases accuracy and allows working with illumination of 5..10lx, even if the
camera has sensitivity of 0.2..1lx.
 

2. Mount the manual iris lens on the camera, mount the camera on stand, direct it towards sheet of
paper, connect to computer, display image on the screen.
 

3. On the sheet of paper, in the camera field-of-view place the luxmeter sensor.
 

4. Close to the sensor window directly on the sensor, fix a small piece of even white paper.
 

5. Run Video Analyzer . Mark Cycle box, click Start. After that move fast the mouse cursor to the
small piece of even white paper on the screen, close to the sensor window. 
 

6. Switch off common light. Switch on the testing lamp and fix it at a middle distance from luxmeter
sensor.
 

There should be a possibility to approach and move away the lamp.
 

Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

7. By adjusting aperture, obtain that the Average brightness measured by the Video analyzer
would be equal to 0.22-0.25 after finishing measuring cycle by 100 frames. 
 

The objects on the image should be recognized. 

 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
 

8. Write down luxmeter reading and the Average brightness value according to the Video analyzer
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reading.
 

9. Switch off the testing lamp. Switch on the halogen lamp.
 

10. By changing the distance from the lamp to the sheet of paper, obtain equal with step 8 value of
Average brightness after finishing measuring cycle by 100 frames. 
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

11. Write down the luxmeter reading.
 

12. Spectral efficiency factor of the tested lamp=illumination from tungsten halogen lamp
(step11)/illumination from the tested lamp (step 8).

You can insert the obtained factor in the Illuminator calculation  box.
 

See also: What is spectral efficiency .
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10.17 Example 17  Measuring projector parameters

See before: Illuminator calculation .

Problem
 

There is a visible light projector with close to round symmetrical light intensity distribution. It is
necessary to create the model of this projector in VideoCAD.

Equipment:
 

Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
Measure by the luxmeter and write down the projector illumination on an axis of radiation at
the distance not less than in 20 times more than the geometrical size of the radiant window.

Order of work
 

1. Install the projector, supply it by nominal voltage. 

 

2. Measure by the luxmeter and write down the projector illumination on an axis of radiation at
the distance not less than in 20 times more than the geometrical size of the radiant window.
 

If the environment reflects the projector's light significantly, using small nontransparent object create
shadow on the luxmeter sensor from the projector. Measure illumination created by the light reflected
from the environment, and then deduct this illumination from the illumination on projector axis of
radiation.
 

3. Open Illuminator calculation  box . Enter:
 

Lamp type  - type of lamp in the projector;
Lamp power  - consumed electric power of the lamp;
Lamp quantity  - number of lamps in the projector;
Projector  - mark;
Angle of radiation  - radiation angle of the projector (0.5 light intencity);
Concentration  - 0.5;

 

If there is a specification with the light intensity curves, by choosing Concentration try to obtain
close light intensity distribution.
 

Distance  - the distance on which the illumination has been measured in step 2.
 

4. Choose the value in the efficiency factor  box for obtaining value in the Illumination  box,
which is equal to the one measured in the step 2.
 

5. In this way we have obtained the model of the projector we have. Using obtained model we
can get image models from different cameras at illumination produced by this projector with sufficient
accuracy for the practice.
 

See also: Measuring camera sensitivity ,  IR illuminators .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.18 Example 18  Measuring parameters of IR illuminator

See before: IR illuminators .

Problem
 

There is an IR illuminator. It is necessary to measure efficiency of this illuminator for a black/white
camera in relation to the halogen incandescent lamp and create model of this illuminator in
VideoCAD.

Equipment:
 

To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).

 

Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
Any PC-based video capture system, TV-tuner with video input, etc. The System should allow to
display live video on the computer screen.
Video analyzer utility. It is a part of CCTVCAD Lab Toolkit .
Compact tungsten halogen lamp 12V, 10W.
Stabilized power supply unit for the lamp. 12V DC, without considerable ripples of output voltage.
Manual Iris Lens, focal length is 4-8mm. 
Stand. It is recommended for convenience and accuracy. 
Measuring should be carried out in a dark room.

Order of work
 

1. Switch off all image processing options and AGC in the camera.
AGC switching off increases accuracy and allows working with illumination of 5..10lx, even if the
camera has sensitivity of 0.2..1lx.
 

2. Mount the manual iris lens on the camera, mount the camera on stand, direct it towards sheet of
paper, connect to computer, display image on the screen.
 

3. On the sheet of paper, in the camera field-of-view place the luxmeter sensor.
 

4. Close to the sensor window directly on the sensor, fix a small piece of even white paper.
 

5. Fix the testing IR illuminator at the distance of 1-2 meter from the luxmeter sensor (not closer than
20-times size of the illuminator radiant window), direct illuminator axis of radiation on the sheet of
paper on the sensor perpendicularly to the sheet of paper.
 

6. Run the Video analyzer. Mark Cycle box, click Start. After that move fast the mouse cursor to
the small piece of even white paper on the screen, close to the sensor window. 
 

7. Switch of common light. supply the illuminator by nominal voltage. If a LED IR illuminator is being
tested, warm up the illuminator not less than 1 hour. 
 

During warming up the power of the LED IR illuminator decreases by 15-20% and more in
dependence of heatsink  construction. 

8. By adjusting aperture, obtain that the Average brightness measured by the Video analyzer
would be equal to 0.22-0.25 after finishing measuring cycle by 100 frames. 
 

The objects on the image should be recognized. 
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9. Switch OF the IR illuminator. Switch ON the tungsten halogen lamp.
 

10. By changing the distance from the lamp to the sheet of paper, obtain equal with step 8 value of
Average brightness after finishing measuring cycle by 100 frames. 
 

You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper. 
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
 

11. Record the luxmeter reading. 
 

The luxmeter shows illumination Eeq., which is equivalent to IR illumination (irradiance) created by
the IR illuminator for this camera.
 

12. Calculate the irradiance Eir (watt/m2), created by the illuminator according to the formula:
 

Eir=Eeq/Kse;
where:
Eeq - equivalent illumination, measured in step 11;
Kse - relative spectral efficiency factor  of IR radiation (lumen/watt) for white paper and black/
white CCD sensor. 

 

The Kse values for illuminators with different wavelengths of radiation maximum and for different
image sensors you can see in the Illuminator calculation  box.
The Kse values are obtained by practical measurements in the laboratory of CCTVCAD Software
http://cctvcad.com with IR illuminators calibrated in radiometric laboratory of Micrel.Ltd http://micrel.
spb.ru. 

The Kse values are correct for white paper. Closer Kse values are obtained for a human body. For
green grass Kse have 2.2 times more values..
 

Green grass reflects IR radiation better than the visible light. Paper and human body reflect IR
radiation worse than the visible light. 
 

Theoretical calculation gives average result. The theoretical result did not take into account
difference in reflection power in visible and IR lights. 
 

During designing, it is necessary to use Kse value for paper and human body.
 

Switching the Kse values for day/night cameras in VideoCAD is performed automatically in
dependence on camera type . 

13. Open the Illuminator calculation  box . Enter:
 

Lamp type  - IR LED of known wavelength;
Lamp power  - consumed electric power of the IR illuminator;
LED quantity  - 1;
Projector  - mark;
Angle of radiation  - radiation angle of the IR illuminator (0.5 radiation intencity);
Concentration  - 0.5;

 

If there is a specification with the light intensity curves, by choosing Concentration try to obtain
close rediant intensity distribution. 
 

Distance  - the distance between the IR illuminator and the small piece of even white paper on
the sensor window (meter).

 

14. Choose value in the Efficiency factor  box to obtain in the Irradiance (watt/m2)  box the
value, which is equal to Eir calculated in step 12
 

The Efficiency factor values obtained by measuring some real IR illuminators:
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Efficiency factor=0.3 for narrow angle illuminator (angle of radiation is 20-50 degrees);
Efficiency factor=0.5 for wide angle illuminator (angle of radiation is 60-120 degrees).
 

Total efficiency factor of the IR illuminator is a product of efficiency factor of IR LED
(0..5..0.15) multiplied by the chosen efficiency factor of the illuminator.
 

15. Thus, we have obtained the model of available LED IR illuminator. Using obtained model we can
get image models from different cameras at illumination produced by this illuminator with sufficient
accuracy for practice.
 

See also: Measuring camera sensitivity ,  IR illuminators .
External link : "The principles of CCTV design in VideoCAD. Part 4. Illumination and camera
sensitivity in CCTV"(*.pdf) . 
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10.19 Example 19  Modeling megapixel images

Problem
 

Because of the Open GL limitation, we can not create three-dimensional image with number of
pixels more than the screen number of pixels in Windows. However, modern megapixel cameras
already have a much higher number of pixels.
Even when the camera number of pixels is less than the screen number of pixels, it is inconvenient
to work with images that occupy a large area on the screen and require a lot of time for regeneration.
 

In most cases, we need only to see how an object on the scene will look on image from a camera
with the specified number of pixels.
VideoCAD offers 2 ways of solving this problem:
 

with the help of PiP technology  (Picture in Picture);
with the help of pixel multiplication.

Order of work with PIP
 

 1. Construct 3D model of the scene, place 3D models. See Example  and Example .  

2. Create  camera and place it in the appropriate position.

3. Open the Sensitivity and resolution    box and set horizontal and vertical numders of pixels
, for example: 2048x1536. Close the box and save changes.

4. Open the 3D Video  . Stretch the 3D Video if necessary. 

If the PiP  mode is enabled (by default) in the
3D Video a yellow rectangle will be displayed.
And in the corner of the 3D Video, inside a green
rectangle, a image fragment from the yellow
rectangle will be displayed.
Pay attention that the entire frame is shown with
a resolution lower than specified  2048x1536 and
only the fragment from the yellow rectangle is
shown with the actual resolution  2048x1536.

 

Place the yellow rectangle on the image area which should be seen with the real resolution, by
clicking the middle mouse button (wheel). 
 

The PiP mode offers flexible setting. You can specify which image will appear in the whole frame, but
which in the small picture, you can adjust the position and size of the small picture, you can
additionally magnify the fragment in the small picture.

5. To change PiP setting:
By right click on the 3D Video open the Image parameter panel . 
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Chose PiP  tab. Clear the According to camera parameters  box if it is checked. 
 

See PiP  for details.

Order of work with pixel multiplication
 

 1. Construct 3D model of the scene, place 3D models. See Example  and Example .  

2. Create  camera and place it in the appropriate position.

3. Open the Sensitivity and resolution    box and set horizontal and vertical numders of pixels
, for example: 2048x1536. Close the box and save changes.

4. Open the 3D Video  . Stretch the 3D Video if necessary. 

5. In the main menu of the 3D Video mark Image>Real frame size .

6. In the main menu of the 3D Video choose  Image>Save as  and save the image to file in any
format. Obtained file will have number of pixels and resolution equal to set number of pixels in the 
Sensitivity and resolution box, even if the number of pixels of Windows screen is less.
 

The pixel multiplication doesn't work  with animated images .

375 375

391

529 531

171

186

332

357

359

360

360



Examples of work with VideoCAD 575

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

10.20 Example 20  Selecting frame rate on the basis of known target's
positions and velocities

The frame rate greatly affects the required bandwidth of communication channels, the capacity of
the archives, computing power, and hence the total cost of video surveillance systems.
At the same time, choosing optimal frame rate - not an easy task  and criteria for selection are not
always unambiguous. When the frame rate is too low, omission of important events are possible, too
high frame rate leads to an unjustified rise in price of video surveillance systems.
 

VideoCAD offers a tool for choosing frame rates based on the desired frequency of getting in the
frame objects with the known positions and velocity. Additionally, you can create animated
images with the specified frame rate.

Problem
 

Place of camera installation, the probable locations and velocity of moving objects are known. We
should choose an optimal frame rate to ensure that any moving object gets into the frame at least
twice.

Order of work
 

 1. Construct 3D model of the scene, place the camera. See Example  and Example .  

 

You can use the Shadow  tool to take into account camera control area with shadows from
obstacles.
 

2. Place the 3D models  at the expected locations of moving objects. 
 

3. Specify velocity vectors  for the 3D models according to expected speeds and directions of
moving objects. 
 

double click on the model to switch it to editing state ;
on the appeared Current construction parameter panel type a nonzero velocity value (in meter
(foot) per second) into the Speed  box.

 

You can edit the velocity vector of 3D model
in editing state by moving its terminus. 

Bring the cursor to the terminus of the velocity
vector, click the left mouse button and drag the
terminus. At the same time the speed value
and direction of movement is being edited
simultaneously. Click for the second time to
specify new velocity and finish editing. 

 \

4. Remove selections from the 3D models if there are selected ones.
 

5. Open the 3D Video . By right clicking open the Image parameters panel . Chose Camera
tab.
 

6. Try to change Frame rate  value, watching the velocity vectors of 3D models in the Graphics
window. 
 

If 3D model is in the normal state, the length of the velocity vector equals to the distance which

the 3D model passes for the period between successive frames of the active camera.
 

7. Select the Frame rate in order that all velocity vectors fit in the view area (control area)
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projection at least twice.
 

8. Choose the View  tab on the Image parameters panel. Check Animation  box. Set the
Number of frames =3 or more.
In several seconds animated image with specified frame rate will appear in the 3D Video. In the
image there will be 3D models with specified  velocity.

External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 
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10.21 Example 21  Creating animated model of monitor

This example shows how to create an animated model of monitor as *.html file. This model may
contain up to 100 animated images from different cameras. Each image has its own settings (frame
rate, resolution, etc.). Obtained html file can be viewed by any Internet browser, edited with any text
editor, etc.
 

See an example of animated monitor (file size about 4 Mb).

Order of work

1. Construct 3D model of the scene, place and adjust cameras 

 

Place the 3D models  at the expected locations of moving objects. See Example  and
Example .  

 

2. Specify velocity vectors for the moving 3D models according to expected

speeds and directions of moving objects

 

double click on the 3D model to switch it to editing state ;
on the appeared Current construction parameter panel type a nonzero velocity value (in
meter(foot) per second) into the Speed  box.

 

You can edit the velocity vector  of 3D model
in editing state by moving its terminus. 

 

Bring the cursor to the terminus of the velocity
vector, click  the left mouse button and drag the
terminus. At the same time the speed value
and direction of movement is being edited
simultaneously. Click  for the second time to
specify new velocity and finish editing.

 

If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model passes
per second (crimson arrow).
If 3D model is in the normal state, the length

of the velocity vector equals to the distance

which the 3D model passes for the period
between successive frames of the active
camera  (black arrow).

 

3. Adjust animation of the cameras which should have animated images

 

3.1 Activate  one of those cameras, which should have animated images.

3.2 Open the 3D Video by clicking on the 3D Video    button on the Tool bar  of the
Graphics window. Right click on the 3D Video to open the Image parameter panel .
3.3 Choose the Camera  tab. Uncheck the According to the camera parameters  box if it is
checked. Adjust the Frame rate .
3.4 Select  all cameras, which should have animated images. Check the To selected cameras
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 box. Click on the Save  button.
3.5 Switch to the View  tab. Check the Animation  box. Set the Number of frames = 3 or
more.
3.6 Select all cameras, which should have animated images. Check the Save to selected
cameras box. Click on the Save button.
 
 

After several seconds in the 3D Video the
animated image will be shown. The image with
the specified frame rate will contain moving
with the specified velocities 3D models.

 

We have set the same number of frames in the animated images and the frame rate  for all
selected cameras simultaneously. You can set individual values for each camera, not check ing
the To selected cameras box before click ing the Save button and repeat adjusting for each
camera separately.
 

To save animated image on this step,  see: Save as animated *.gif . 

4. Connect the cameras to the Monitor

 

4.1 Open the Monitor window  by clicking on the Monitor window    button on the Tool bar
 of the Graphics window.

4.2 Click on the Edit   button on the Tool bar  of the opened Monitor window.
4.3 Select  on the layout cameras which should be displayed on the Monitor.  
 

You can select cameras with static and animated images mixed.
 

4.4 Then click on a cell of the Monitor starting from which these cameras should  be displayed
on the Monitor.

 

After some time the 3D Video will appear, in which static images from these cameras will be
simulated. Then these images will appear in the cells of the Monitor, starting from the clicked cell. 

 

See more details of work  with Monitor: Work  with Monitors .

5. Switch Monitor window to the animation mode

Click the Animation   button on the Tool bar of the Monitor window.
 

The 3D Video will appear again, but this time it will generate animated images for your monitor.
 

Generation of animated images takes much longer, it is a complex multi-threaded resource-
intensive operation. Be patient, do not touch the mouse and keyboard, do not interfere the
program, otherwise an errors are possible.

6. Save the animated Monitor to HTML file 
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For this click on the monitor window Main menu> Image> Export to *.html. 
 

It is recommended to save the *.html file to a separate directory. The resulting "file" includes the
actual HTML file with links to images and the image files in animated GIF and PNG formats. The
images are stored with the resolution and other parameters of the corresponding cameras.
 

See an example of animated monitor (file size about 4 Mb).

See also: PDF Report
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 
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10.22 Example 22  Visualization of cameras' control area projections
and spatial resolution inside them

Read before:  Shadow ,     Spatial resolution  , Spatial resolution box   

Problem
 

We have a three-dimensional model of a complex environment.
We need to determine the areas controlled by cameras taking into account shadows arising from
obstacles of the environment (camera control areas). Within the control areas, the spatial
resolution of cameras must be visualized.
 
We should be able to estimate directly on the 2D site plan how people will look into the camera
image at each point of the camera control area.

Order of work

1. Construct three-dimensional model of the environment using the tools of 3D modeling .
 

The constructions must be drawn by line types  with marked Shadow  box.
 

You can import the environment or its fragments in the form of one or several 3D models
imported from other graphics formats using Autodesk 3ds Max or SketchUp . 

 

If the environment contains 3D models,  shadows from which must be taken into account, you must:
enable calculation of shadows from 3D models  in the Options box;
individually switch these 3D models into the editing state by double-click ing, then mark   the 
Shadow  box on the Current construction parameter panel . 

2. Place a camera. Activate it.

3. Choose Filling  in the drop-down menu of the Fill projection  button on the Tool bar.  
 

View area projection will be filled by blend color.
 

The color of filling is determined by the line type  of the camera.

4. Choose Discrete color in the drop-down menu of the    Spatial resolution  button on the
Tool bar.  
 

View area projection will be divided into the regions. The regions will be colored according to values
of the criterion  within the regions. 

5. Open the Spatial resolution   box.
 

In the Pattern criterion  combo box you can see which criterion is chosen in the pattern assigned
to the active camera.
 

 

In calculation of spatial resolution, the Vert.(Horiz.) number of pixel  is taken into account.
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In the Table of regions  you can see what color corresponds to each range of the criterion value.
On the images in the Resolution  column, you can see with which resolution people at the far
bound of each region will be visible.
On the images in the Field of view  column, you can see which part of the field of view people at
the far bound of each region will cover.
 

 
  

Sample images are correct for the cameras with vertical resolution specified in the Vert.(Horiz.)
number of pixel  combo box.

 

See details: Spatial resolution box .
 

Don't close the Spatial resolution box.

6. Choose Within projection  in the drop-down menu of the Shadow    button on the Tool
bar.  
  

After a while VideoCAD calculates the control
area projection, taking into account shadowing
from obstacles in environment. 

7. Keep the Spatial resolution box opened.  
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It is convenient to keep the Spatial resolution
box opened during the analysis of spatial
resolution in the Graphics window. Comparing
color of regions on the layout with colors in the 
Table of regions  in the Spatial resolution
box, on the images in the  Resolution  and
Field of view  columns you can immediately
see the expected resolution and  field of view
size at every point of view area of each camera.

 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing the
best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them
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10.23 Example 23  Choosing install location for PTZ camera

Problem
 

We have a three-dimensional model of a complex environment. We should choose the best install
location for PTZ (dome) camera so that the areas you want to monitor, should be not shaded by
objects of the environment.

Order of work
 

1. Construct three-dimensional model of the environment using the tools of 3D modeling .
 

The constructions must be drawn by line types  with marked Shadow  box.
 

You can import the environment or its fragments in the form of one or several 3D models
imported from other graphics formats using Autodesk 3ds Max or SketchUp. 
See: Importing 3D models from SketchUp and Autodesk 3ds Max

 

If the environment contains 3D models,  shadows from which must be taken into account, you must:
enable calculation of shadows from 3D models  in the Options box;
individually switch these 3D models into the editing state by double-click ing, then mark  the 
Shadow  box on the Current construction parameter panel . 

2. Place the PTZ camera preliminary. Activate it.

3. Choose Dome  in the drop-down menu of the Shadow    button on the Tool bar.
  

After a while VideoCAD calculates the control
area projection, taking into account shadowing
from all obstacles in environment. 

In the Dome mode all shaded areas from the
specified camera position become visible.

The Dome mode is also useful for choosing the
best installation place for fixed cameras to
make required areas reachable for the cameras.
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In the 3D World  in the Dome mode the
territory controlled by the active  camera is
displayed as coverage  on the environment.
The coverage in the 3D World is displayed for
the active camera only.
 

Coverage calculations in the Dome mode
requires a lot of computing resources. To
increase speed of image refresh, reduce the 
Resolution  of calculating the coverage.

4. By moving the camera between the possible installation locations, choose the best location in
terms of control required areas.
 

You can add several cameras and instead of moving, to hide  and show different cameras.
 

See also:Shadows ,Main menu>View>Calculate shadows for active camera , Main
Menu>View>Recalculate shadows ,Line type>Shadow , Layers>Shadow , Options
box>Miscellaneous>Shadow , Options box>Calculate shadows from 3D models , Current
construction parameter panel>3D model>Shadows , 3D Models window>Shadows , Choosing
the best place for PTZ (dome) camera , Visualization of the camera control area projections and
spatial resolution within them

342

166

348

350

267

178 239

239 475 277

490 491

283 402

583

580



Examples of work with VideoCAD 585

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

10.24 Example 24  Simulating distortions of moving objects arising
from Exposure time, Interlace scan and Rolling shutter

Problem
 

There are three cameras:
Three-megapixel (3MP) (2048x1536) IP camera with CMOS sensor and Rolling shutter;
1.3 megapixel (1280x960) IP camera with CCD sensor and Global shutter;
0.4MP (768x576) analog camera with interlace scan.

We know camera exposure time at the scene light conditions.
3MP IP Camera - 100ms;
1.2MP IP camera - 50ms;
analog camera - 20ms (PAL).

3MP camera employs Rolling shutter, the period between start reading successive rows ( Row time)
 = 50 microseconds.

All cameras have the same sensor size 1 / 3 "and a lens with a focal length = 4mm.
We know camera position, location and speed of moving objects on the scene.

We need to get the model images of moving objects from each camera at the same position and
compare them.

See also: Measuring exposure time of IP camera , Measuring rolling shutter row time of IP camera

Order of work

1. Construct 3D model of the scene, place and adjust cameras 

 

Place the 3D models  at the expected locations of moving objects. See Example  and
Example .  

 

2. Specify velocity vectors for the moving 3D models according to expected

speeds and directions of moving objects

 

double click on the 3D model to switch it to editing state ;
on the appeared Current construction parameter panel type a nonzero velocity value (in
meter(foot) per second) into the Speed  box.

 

You can edit the velocity vector  of 3D model
in editing state by moving its terminus. 

 

Bring the cursor to the terminus of the velocity
vector, click  the left mouse button and drag the
terminus. At the same time the speed value
and direction of movement is being edited
simultaneously. Click  for the second time to
specify new velocity and finish editing.
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If 3D model is selected then length of the

velocity vector equals to the distance in

meters (feet) which the 3D model passes
per second (crimson arrow).
If 3D model is in the normal state, the length

of the velocity vector equals to the distance

which the 3D model passes for the period
between successive frames of the active
camera (black arrow).

 

3. Modeling image from three-megapixel (3MP) IP camera

 

3.1 Create  and place a camera at the appropriate position. 

3.2 Open the  Camera Geometry    box and specify: image sensor format  - 1/3", lens focal
lehgth  - 4mm, aspect ratio  - 4:3. Then close the box.

3.3 Open the Sensitivity and resolution   box and specify numbers of pixels  horizontal -
2048 , vertical - 1536. Close the box and save changes.

3.4 Open the 3D Video  . Stretch the 3D Video for better resolution if needed. 
 

If the PiP  mode is enabled (by default) in the 3D Video a yellow rectangle will be displayed.
And in the corner of the 3D Video, inside a green rectangle, a image fragment from the yellow
rectangle will be displayed.
Pay attention that the entire frame is shown with a resolution lower than specified  2048x1536 and
only the fragment from the yellow rectangle is shown with the actual resolution  2048x1536.

 

Place the yellow rectangle on the moving 3D model, by clicking the middle mouse button (wheel). 
 

For detail about PiP, see: PiP .
 

3.5 By right clicking on the 3D Video, open the Image parameter panel . 
3.6 Choose the Camera  tab. Uncheck the According to the camera parameters  box if it is
checked. 
Choose '100' in the Exposure (ms)  combo box. Check  Model perm. on the Exposure (ms)
panel.
Choose '50' in the Rolling shutter  combo box. Check  Model perm. on the Rolling shutter
panel.
 

During the image generation in the 3D Video on the   3D Video  button red frame flashes ..
 Simultaneous modeling exposure and rolling shutter can take several minutes. After a while you
will see the image model. 
 

You can adjust realism  of modeling exposure and rolling shutter on the 3D tab of the Options
box . The more realistic simulation is, the more time required to generate the images in the 3D
Video.
 

3.7 Save the image in the 3D Video: 3D Video>Main menu>Save as *.png

4. Modeling image from 1.3MP IP camera

 

4.1 Open the Sensitivity and resolution   box and specify numbers of pixels  horizontal -
1280 , vertical - 960. Close the box and save changes..

4.2 Open the 3D Video   . Place the yellow rectangle on the moving 3D model, by clicking the
middle mouse button (wheel). 
4.3 By right clicking on the 3D Video, open the Image parameter panel . 
4.4  Choose the Camera  tab. Uncheck the According to the camera parameters  box if it is
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checked. 
Choose '50' in the Exposure (ms)  combo box. Check  Model perm. on the Exposure (ms)
panel.
Choose '0' in the Rolling shutter  combo box. Clear Model perm. on the Rolling shutter panel.
 

After a while you will see the image model.
 

4.5 Save the image in the 3D Video: 3D Video>Main menu>Save as *.png

5. Modeling image from 0.4MP analog camera

 

5.1 Open the Sensitivity and resolution   box and specify numbers of pixels  horizontal -
768 , vertical - 576. Close the box and save changes..

5.2 Open the 3D Video   . Place the yellow rectangle on the moving 3D model, by clicking the
middle mouse button (wheel). . 
5.3 By right clicking on the 3D Video, open the Image parameter panel . 
5.4  Choose the Camera  tab. Uncheck the According to the camera parameters  box if it is
checked.
Choose '20' in the Interlace .combo box. Check  Model on the Interlace.panel.
Choose '20' in the Exposure (ms)  combo box. Check  Model perm. on the Exposure (ms)
panel.
Choose '0' in the Rolling shutter  combo box. Clear Model perm. on the Rolling shutter panel.
 

After a while you will see the image model.
 

5.5 Save the image in the 3D Video: 3D Video>Main menu>Save as *.png

6. Here are the obtained images below. In the frame there is a car moving at a speed of 20 m/s (72
km/h) and a woman moving at a speed of 2 m/s (7,2 km/h)/
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See also: Measuring exposure time of IP camera , Measuring rolling shutter row time of IP camera593
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External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 
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10.25 Example 25  Calculating lengths of cables and getting Cable
report

Problem
 

There is a layout with the placed cameras. We need to determine the required cable length
separately for each brand of cable.

Order of work
 

1. Configure a separate line type for each brand of cables used in the project

 

1.1 Open the Options box , switch to Lines  tab.
1.2 In the Number box, select any unused number of line type.
 

 Do not select line types, used as system lines .
 

1.3 In the Name box, type a name of a cable brand, which will correspond to the selected line
type.
1.4 Check the Cable  box. Clear the Shadow  box.
1.5 When necessary, adjust the line Style, Color and Width on the screen and at printing.
1.6 To make lines of this type invisible on the 3D Video, set equal the maximum and minimum
heights on the 3D panel.
1.7 Repeat  steps 1.2  .. 1.6 for all brands of cables used.
1.8 Click OK in the Options box. 

2. Assign brands to cables of cameras

 

2.1 Activate any of cameras.
 

2.2 Assign brand to the signal cable
2.2.1 Click the menu item  Main menu>Cables>Signal cable>Calculate.
2.2.2 In the appeared Signal cable length calculation box  choose Cable brand  from the
adjusted at p.1  line types.
2.2.3 When necessary, adjust reserve for cable laying and connection.
2.2.4 Click OK in the Signal cable length calculation box.
 

2.3 Assign brand to the power cable
2.3.1 Click the menu item  Main menu>Cables>Power cable>Calculate.
2.3.2 In the appeared Power cable electrical parameters and length calculation box  choose
Cable brand  from the adjusted at p.1  line types.
2.3.3 When necessary, adjust reserve for cable laying and connection. Specify electrical
parameters.
2.3.4 Click OK in the Power cable electrical parameters and length calculation box.
 

2.4 Repeat  steps 2.1  .. 2.3 for all cameras, cables of which must be taken into account.
 

You can control a correct cable parameters of cameras in the Table of cameras .

3. Draw cables of cameras in horizontal and vertical projection

 

3.1 Activate any of cameras.
3.2 Choose Main menu>Signal cable  and draw the signal cable of this camera. 
3.3 Choose Main menu>Power cable   and draw the power cable of this camera. .
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When this item chosen, you can draw the signal cable of the active camera by successive clicks
in the graphics area. The end of each segment is the start of the next one. To stop drawing cable,
press ESC.
 

The status bar  displays the segment length and its projection to distance and height. 
 

Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the segment
is attached to the projection with its initial point. 
 

A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately. 
 

When copying  the cable segments between cameras and layouts a process of cable drawing
is accelerated considerably even in complex CCTV systems.
 

When drawing a cable the menu item Cable laying  might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
 

If  the Main menu>View>All cameras' cables  item is checked, cables of all cameras will be
visible, but only cables of the active camera can be edited. If this item is not checked, cables of
the active camera will be visible only. 

4. Draw the Main cables (which is not associated with cameras)

 

4.1 Draw the Main cables with the help of tools Line segment   and   Polyline  , using
the adjusted at p.1  line types.
 

Line type can be assigned before drawing lines or during editing lines on the Line type panel
. To change Line type of several selected  lines at once, use the Change line type  tool. 

5. Get the Cable report

 

Choose Main menu>Cables>Cable report . The Cable report includes lengths of the cables
attached to cameras and the main cables as well. Cable lengths is calculated for each brand (line
type) separately.

See also: Active camera's cables , All cameras' cables , Line segment , Polyline , Signal
cable , Power cable , Cable laying , Length calculation of line segments , Cable report
, PDF Report .
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10.26 Example 26  Checking Depth of Field in horizontal projection

Read before: Depth of Field .

Problem
 

We need to check that a camera has enough Depth of Field.

Order of work
 

1. Activate the camera.

2. Open the Depth of Field   box by clicking on the Depth of Field   button on the Toolbar. 

3. In the Depth of Field box: Specify  Aperture (f-number)  of the active camera. Click the Default
 button.

4. Check the sharpness area bounds in the horizontal projection. 
 

When the depth of field box is visible,
next to all cameras in the horizontal
projection the following lines are
displayed:

sharpness area bounds ;
focus plane ;
plane at the hyperfocal distance .

These lines are calculated according
to the depth of field parameters  of
each camera at the height of depth of
field measurement .
 

If the focus plane or the plane at the
hyperfocal distance not intersect the
horizontal plane at the height of
depth of field measurement within
the view area projection, then the
focus plane or the plane at the
hyperfocal distance are not
displayed. 
 

If the near or the far bound of the sharpness area  not intersect the horizontal plane at the height
of depth of field measurement within the view area projection, then this bound is not
displayed.
 

The absence of near and far bounds of the sharpness area indicates that the sharpness area
completely covers projection of view area, thus the depth of field does not reduce the resolution of
the camera.

5. If the displayed sharpness area is not enough:

Click the  Specify the focus plane  button  in the Depth of field calculation box.
Try to change focus distance by clicking on the view area projection until you get the desired
sharpness area.

 

If you can get the desired sharpness area, then the desired depth of field is achievable for the active
camera. 
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10.27 Example 27  Measuring exposure time of IP camera

The sensitivity of cameras depends on the exposure time. Within the validity of the Reciprocity
principle, the camera sensitivity is directly proportional to the exposure time.
 

However, increasing exposure time leads to
blurring of moving objects that is often
unexpected. Usually, when measuring sensitivity
of cameras and while accepting built CCTV
system a customer looks only at static images,
but moving targets are of interest.

The greater the exposure time and the greater
the velocity of an object on the screen, the more
the blur.

Automation of camera (AESC) constantly adjusts the exposure time (shutter speed) depending on
the illumination on the image sensor. The more light is, the less exposure time is set. But from a
certain threshold light AESC sets the maximum exposure time and further reducing light doesn't
increase the exposure time. Knowing the maximum exposure time and the threshold illumination is
very useful in designing CCTV systems.
 
VideoCAD offers a tool  for modeling blur of moving objects in dependence of the exposure time.
But to use this tool, you need to know the exposure time.
 
Knowing the maximum exposure time is also needed correct interpretation of results of measuring
sensitivity and sensitivity values in the camera specification. With a minimum illumination the
camera sets the maximum exposure time. Unless otherwise indicated, the sensitivity value in the
camera specification can be achieved at the maximum exposure time.

The maximum exposure time of standard analog cameras without light accumulation is 20ms for
PAL and 16,5 ms for NTSC. IP cameras and analog cameras with accumulation of light can use
exposure time up to 200ms and more. With latent increasing the maximum exposure time, many
manufacturers increase the certified sensitivity of their cameras.
Many cameras allow to modify the maximum exposure time, switching the "night", "supersensitive"
modes, etc. But these settings don't report the real value of the exposure time. If the camera has
several "night" modes, for their proper use it is necessary to know the maximum exposure time for
each of them.

Problem
 

There is a camera. It is necessary to measure its maximum exposure time and the threshold
illumination at which the camera switches to the maximum exposure time.

Equipment:
 

Oscilloscope. Any analog oscilloscope will suit.
 

Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
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In case of testing analog cameras, we need any PC-based video capture system, TV-tuner with
video input, etc. The System should allow to display live video on the computer screen and
separate frames. For testing IP cameras it is enough to have possibility to display video on the
screen and separate frames. 

 

Compact tungsten halogen lamp 12V, 10W.
 

Stabilized power supply unit for the lamp. 12V DC, without considerable ripples of output voltage.
 

Lens with F1.2 aperture, parameters of which are reliable, focal length is 4-8mm.  If the camera
allows to mount only mini-lenses (M12), the mini-lens with a known aperture (F2.0) is needed.

 

Stand. It is recommended for convenience and accuracy. 

If you want to measure only the maximum exposure time, and measuring the threshold
illumination is not required, then luxmeter, incandescent lamp and power supply are not needed.
Instead, it is required a manual iris lens.

Order of work
 

1. Set the lens on the camera, install the camera on the stand, point the camera at the screen of the
oscilloscope, connect camera to computer, display image from the camera on the computer screen.
 

2. Place the luxmeter sensor near to the oscilloscope screen.
 

3. Enable a "night" mode in the camera setting.
 

 

4. Set the oscilloscope sweep time - 50ms/div. Scan - automatic (If your oscilloscope has such
settings).
On the oscilloscope screen a flying spot must be visible. On the computer screen instead of the
spot, flickering segments will be seen.
 

5. Turn on the incandescent lamp. Turn off the ambient light.
 

If you need only to measure the maximum exposure time, then instead of changing light simple close
iris on the lens.
 

6. Set the minimum brightness of the oscilloscope spot, to make the segments on the computer
screen barely visible. Light of the spot should not affect operation of camera's automatics.
 

7. By moving the lamp away, reducing the illumination of the oscilloscope screen, detect a moment
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when the length of the segments on the computer screen becomes the maximum and no longer
increases with further decreasing light until the appearance of strong noise on the screen.
 

At the moment when the length of the segments becomes maximum, luxmeter shows the
threshold illumination.
 

As a result of our measurements, the threshold illumination was about 50lux. That is, when light is
less than 50lux, the testing  IP camera with 2 megapixel 1/3" CMOS sensor began to use the
maximum exposure time.
 

8. Save and view a frame in which a segment of the maximum length gets wholly. If you can not get
such frame, increase the oscilloscope sweep to 100ms/div.
 

The length of the segment in the frame in the scale of oscilloscope screen equals to the
camera's exposure time.
 

  

9. If necessary, by the method described above you can take a function of the exposure time in
dependance of the light.

See also: Image parameter panel>Camera>Exposure
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 
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10.28 Example 28  Measuring rolling shutter row time of IP camera

As a result of Rolling Shutter work , exposure of
different rows of the image sensor begins and
ends sequentially at different times, which
causes a horizontal shift of moving objects.
This effect occurs with many IP cameras with
CMOS image sensor and usually doesn't occur
with cameras with CCD image sensor.

 

An important parameter of the rolling shutter is the Row time - the difference in time between the
beginning exposure of neighboring rows. The less the row time is, the smaller the camera distorts
moving objects. Unfortunately this parameter is not given in the camera specification. But it is not
difficult to measure the row time in practice.
 
The row time may vary with different settings of the same camera.
 
VideoCAD offers a tool  for modeling distortions of moving objects depending on the row time. But
to use this tool, you need to know the row time.

Problem
 

There is a IP camera with Rolling shutter. It is necessary to measure its row time -  the difference in
time between the beginning exposure of neighboring rows.

Equipment:
 

Oscilloscope. Any analog oscilloscope will suit.
 

Low-frequency oscillator. Use any sine wave signal generator of any frequency in the range from
200 Hz to the upper limit of the oscilloscope bandwidth. You can use any homemade generator,
software generator for a computer, etc.

 

For testing IP cameras it is enough to have possibility to display video on the screen and separate
frames. 

 

A Lens, focal length is 4-8mm. 
 

Stand. It is recommended for convenience and accuracy. 

Order of work
 

1. Set the maximum image size in pixels in the camera setting.
 

2. Set the lens on the camera, install the camera on the stand, point the camera at the screen of the
oscilloscope, connect camera to computer, display image from the camera on the computer screen.
The oscilloscope screen must completely cover the field of view in vertical. But it is not necessarily
that the oscilloscope screen placed in the frame entirely. It is important that between the
oscilloscope screen and the field of view of the camera must not be skew.  On the computer screen,
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lines of the oscilloscope scale should be strictly parallel to the sides of the frame.
 

 

3. Set the oscilloscope sweep time - 50ms/div. Scan - automatic (If your oscilloscope has such
settings). Connect the Low-frequency oscillator to the oscilloscope.
On the oscilloscope screen a flying thin vertical line must be visible. On the computer screen instead
of the thin vertical line, thick inclined line will be seen. The thickness of the line in the scale of
oscilloscope screen equals to the camera's exposure time. The inclination of the line is
determined by the row time of camera's rolling shutter.
 

4. Save and view a frame in which the inclined line gets wholly. If you can not get such frame,
increase the oscilloscope sweep to 100ms/div. If inclination is not enough, decrease the oscilloscope
sweep to 20ms/div.
 

5. To calculate the row time, first read a difference between the edge of the line on the top and on
the bottom of the frame in the scale of the oscilloscope screen - frame reading time = 70ms. And
then divide the resulting time by the number of rows in the image (1200) and get the row time = 58
microseconds.
 

  
 

6. Repeat measurements for other frame sizes of the same camera.
 

In the tested by us IP camera the frame reading time wasn't changed when changing the frame size
from 640*480 to 1600*1200, and was about 70ms. Thus, the row time was from 58 to 146
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microseconds depending on the number of rows in the frame.
Perhaps the opposite situation, when the row time is stable, but the frame reading time  depends on
the number of rows in the frame.

See also: Image parameter panel>Camera>Rolling shutter
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf) 

378

http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf


Examples of work with VideoCAD 599

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

10.29 Example 29  Import of 3D models from SketchUp and Autodesk
3dsMax

VideoCAD has an opportunity of 3D modeling video surveillance scenes using constructions and 3D
models  distributed with the program.

The distribution kit of VideoCAD includes several most relevant 3D models for CCTV design. Though
the standard package tends to be enough for accomplishing most of tasks, there may appear a need
for library supplement.

Any 3D models and scenes which can be opened in SketchUp or Autodesk 3ds Max can be added
to the VideoCAD library.

For exporting 3D models to VideoCAD the Free SketchUp version is suitable. http://sketchup.com/

Lots of 3D models can be downloaded from Internet for free https://3dwarehouse.sketchup.com/
You can also create models and scenes in Google SketchUp or Autodesk 3ds Max independently.

Import 3D models is supported by VideoCAD Starter II , VideoCAD Lite  and VideoCAD
Professional  versions. It is not supported by VideoCAD Starter  version.

We offer two special packages for importing 3D models into VideoCAD.

These packages contain:

Plugin file;
User Manual with step-by-step description how to insert a new 3D model into the VideoCAD
library;
Example of ready 3D model files.

The first package for importing 3D models and scenes from Autodesk 3ds Max is free. You can
download it here: Import of 3D models and scenes from 3ds max to VideoCAD

The second package for importing 3D models and scenes from SketchUp is paid. Here is the User
manual.    Click here to order the package.
 

* This package is included in the VideoCAD Starter II Kit .
* * Plugin for SketchUP has several advanced features: export textures, transparent textures, semi-
transparent polygons and scale adjusting.

See also: 3D model , Drawing>Import DXF/DWG background , Work  with 3D models-territories
, Work  with layers and multi-levels projects , Export 3D view areas to general 3D design
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10.30 Example 30  Work with layers and multi-level projects

It is convenient when the project can be divided
into horizontal layers, unrelated, such as the
floors of building.

But there are problems with complex
organization on vertical when one camera should
work on several levels. In these cases, the levels
are interconnected and 2D planning is not
enough. In such cases, 3D modeling can be
indispensable.

 

Problem 
 

There is a project, divided into floor plans. We need to make CCTV project in which some cameras
are located between floors.

Order of work
 

1. Open Layers  box. Main menu>Drawing>Layers.
 

 
2. Click Add and add number of new layers equals to the number of levels in the project.
 

3. For each layer adjust Height , equals to the height of corresponded level.
 

 

4. Make active  one of the layers and then place cameras and constructions on it in the usual

276

277

276



Examples of work with VideoCAD 601

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

way. Cameras and construction will be placed relative to the height of the layer.
Other layers can be hidden , gray colored, make insensitive to snap  and selection  or
visualize by specified color .
 

5. Similarly, place the cameras and constructions on other layers (levels, floors), tentatively making
active the corresponding layer. It is convenient to keep the Layers box visible to switch between the
layers quickly..
 

6. In the 3D World  we can see full 3D model of our multi-level building. 
 

See also: Drawing>Import DXF/DWG background , Import of 3D models from SketchUp and
Autodesk 3dsMax , Work  with 3D models-territories , Layers
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10.31 Example 31  Work with 3D models-territories

VideoCAD can use not only 3D models of individual objects (people, cars, etc.), but also 3D models-
territories (buildings, stadiums, airports, towns, etc.).
Within the 3D models-territories cameras and other 3D models can be placed.

Problem 
 

There is a 3D model of the stadium. You need to place a camera in the room under the stands.

Order of work

1. Getting a file of the 3D model in *.vcm format

 

Export 3D model into a file is performed from SketchUP using special VideoCAD plugin . Steps
of the export are described in the instructions included with the plugin. Acting in accordance with
the instructions you will get the 3D model file in  *.vcm format.
 

It is recommended to simplify the 3D model before export, removing all unnecessary polygons. It
will increase the speed and usability of the 3D model in VideoCAD.

2. Loading the 3D model to VideoCAD

 

2.1 Choose Main menu>3D models>Add 3D model . Open the *.vcm. file
2.2 After opening the file, the 3D Models  window will appear, the 3D model will be loaded in the
window. Projection of the 3D model will be displayed in the 3D Models window.
2.3 Stretch the 3D Models window to increase resolution of the projection.
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3. Making projection of the 3D model to display in the Graphics window

 

3.1 Switch to the Navi . tab and mark the Enable navigation checkbox. 
3.2 With the help of the mouse and  tools  of 3D navigation reach the room under the stands,
where a camera should be installed. You can examine the 3D model in details.
 

404
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3.3 Switch to the View  tab,  then by changing value in the Height cutting>Top, cut a part of
the model above the room, to make the room opened from above.
 

401
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3.4 Switch to the Navi . tab and clear the Enable navigation checkbox. As a result you will
see horizontal section of the 3D model with the room under the stands opened.

3.5 Switch to the View  tab then using the tools on the tab achieve legibility of the room on the
section. You can change direction and intensity of light , incline the projection a little, visualize
edges , increase resolution , disable texture  and use PiP  to increase resolution of
small area on big projection.
Mark the Shadows  and Lock  checkboxes.
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3.6 Switch to the Model  tab and click Save Projection . Close the 3D Models window.
 

In the future, you can change the projection of already placed 3D models many times, with cutting,
highlighting the desired heights or areas of the 3D model.

4. Placing the 3D model on the layout

 

4.1 Select the new 3D model  in the menu on the Toolbar and place it by clicking in the
Graphics area of the Graphics window. If necessary, scale the model on the Current construction
parameter panel .
4.2 Zoom in and see on the projection location place for the camera. If the boundaries are not
visible, modify the projection in the 3D Models window.
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.

5. Creating a layout on the height of floor of the room

 

5.1 Open the 3D World . With the help of the mouse and  tools  of 3D navigation on Navi
tab reach the room under the stands, where a camera should be installed.
5.2 Put the mouse cursor on the floor and memorize floor height (see image below).
.
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5.3 Go to Main Menu> Drawing> Layers . In the Layers box, click Add. Set the height of the
new layer  equals to the height of the floor and make the layer active .

5.4 Click OK.
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6. Placing cameras and 3D models on the created layer

 

Place cameras and 3D models  in the Graphics window in the usual way, using the acquired
projection as background.
 

To make 3D models don't shield cameras , mark  the Graphics window>Main Menu >
View>Cameras over constructions .
 

Cameras and construction will be placed on the active layer  with the set height of the floor .
Height of cameras and constructions will be counted from the height of the layer.
Shadows  from the stadium walls will be taken into account.
 

You can simultaneously monitor the results in the form of projections in the Graphics window
and 3D form in the 3D World .
 

If the 3D model is complicated, do not use shadows  in the Graphics window when the 3D World
 is opened, close all unnecessary windows.

View area faces inside the 3D model in the 3D
World 

Active camera coverage inside the 3D model in
the 3D World 

View area projection in the Graphics window Camera image model in the 3D Video

See also: Drawing>Import DXF/DWG background , Import of 3D models from SketchUp and
Autodesk 3dsMax , Work  with layers and multi-levels projects , Export 3D view areas to general
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10.32 Example 32  Export 3D view areas to general 3D design
software

 

In many enterprises, projects of all building
systems are executed in a single software
environment of 3D design.
However, despite the enormous number of tools
of modern 3D design software, a lot  of CCTV
design problems are outside of their
opportunities.
For example, creation of image models from
cameras with known parameters in certain
conditions , modeling camera view areas with
the spatial resolution , lens distortion and
shadowing from obstacles etc.

These and other useful in CCTV design 
opportunities are available in VideoCAD.
Furthermore , VideoCAD has means of import
and export , which allows to use VideoCAD as
addition to other 2D/3D design software.

Means of import and export in 2D are described in the Example .  Saving images of individual
cameras is easy . Saving monitors is discussed here . In this example we consider import of
3D project from SketchUP and export of 3D models of the view areas to DXF format and import them
into SketchUP.

Free version of SketchUP does not support importing DXF format. To import DXF you need
SketchUP paid version or you can search an appropriate plugin for importing DXF format for the free
version of SketchUP.
 

Problem 

There is a project of a building in 3D. The project must be supplemented by view areas of CCTV
cameras, made with visualization of spatial resolution, taking into account lens distortion and
shadowing from obstacles.

Order of work
 

1. Import of a project into VideoCAD

 

The import is performed via SketchUP and special VideoCAD plugin. The SketchUP can open
files of the most of 3D formats.
See more: Work with 3D models-territories .

2. Choosing and placing cameras

 

Choosing and placing cameras, generation of image models of cameras are performed in the
usual way on the special layers  with set heights and using projection and sections of the 3D
model-territory as a background. 
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See more: Work with 3D models-territories .

3. Saving obtained view areas

 

3.1 When all cameras were placed, open the 3D World .
3.2 Activate  all the cameras are displayed alternately with the 3D World opened to calculate
all shadows completely.
3.3 Hide  the cameras whose view areas are not necessary to export.
3.4 Click on the Save & Print  button, in the pop-up menu select Export 3D view areas to DXF

 and save the *. dxf file.

4. Import of 3D view areas to the main 3D design software (for example

SketchUP)

 

4.1 Open your project in SketchUP.
4.2 Choose File>Import
4.3 In the appeared dialog click Options
4.4 In the appeared dialog choose unit of measure in imported file according to unit set in
VideoCAD (meters or feet) then click OK.
4.5 Choose just saved *.dxf file and click Open.
4.6 Depending on the number of view areas and their complexity, the import may take some
time. 
4.7 During import, a box with the results of the import will appear. Click Close.
4.8 When the import is ended, you will see the imported view areas in the SketchUP.

4.9 Align the view area with constructions in your project and you will get 3D project with exactly
calculated view areas.

5. How to make view areas semi-transparent in SketchUP

602

342

166

267

354

354



Examples of work with VideoCAD 613

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

 

You can make view areas semi-transparent. For this purpose:

5.1 Select view areas, right click then choose Entity info in the pop-up menu.

5.2 In the appeared dialog click on the square in the left-top corner - the Choose Paint dialog will
appear.

5.3 Shift the list of materials down and choose a material with color used for view area coloring.
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5.4 Click Edit - The Edit Material box will appear.

5.5 Set the transparency of the material using the Opacity slider. Click OK.
5.6 Click OK in the Choose Paint dialog.
5.7 Click again on the square in the Entity info dialog and set the opacity of other colors used in
the view areas.
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The result can look like this:

See also:Drawing>Save as , Drawing>Import DXF/DWG background , Options box>Export ,
Work  with background in AutoCAD format , Work  with 3D models-territories , Import of 3D
models from SketchUp and Autodesk 3dsMax
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10.33 Example 33  Using camera rotation around its own axis

Rotation of camera around its
own axis allows the change
the shape of the view area
projection. This feature can be
useful in CCTV design.
By turning a camera you can
exclude from the view area
unnecessary objects or vice
versa expand the view area in
the needed direction, without
replacing the lens to a short-
focus one, so without
sacrificing the spatial
resolution.
At this a little rotation doesn't
worsen readability of camera
image for an operator.

 

Problem 
 

Study the effect of camera rotation around its axis on the form of the view area projection.

Order of work
 

1. Create new camera  by the same
way as in the previous examples.
 

2. Place several 3D models  within the
camera's view area.
 

3. For better clearness choose View area
projections bounds >2 Levels, Fill
projections >Filling.
 

4. Open the 3D Video .
 

5. Open the Camera geometry  box
and try to change value in the Axial
rotation angle , watching on the form
of the view area projection in the 3D
Video.

The parameters in the Camera
geometry box can not reflect the shape
of view area rotated around its main
optical axis. So the rotation around the
axis within + -45 degrees does not affect
the parameters. The parameters of the
Camera geometry box continue to show
values as if the camera is not rotated.
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When the rotation angle is more than 45 degrees, the parameters abruptly change their values to
ones corresponded to the camera rotated on 90 degrees. 
 

In this position the lateral faces of the view area will become the upper and lower faces, and upper
and lower faces will become lateral ones.
 

When the rotation angle is more than 135 degrees, the parameters will reflect the initial position of
the camera.

When reducing the camera tilt angle, the axial rotation transforms the projection of view area to a
narrow beam. This is not the vertical projection, but the horizontal projection on the ground!

The beam can be endless.

The view area projection takes on even more unusual form when it is build taking into account the
rotation around camera's axis and lens distortion  at the same time. Below there is one of possible
example.

619
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See also: Axial rotation angle , Sensor and Lens>Distortion , About lens distortion297 310 654
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10.34 Example 34  Modeling lens distortion
 

There is a difference between the actual
values of view angles given in the
specification of cameras(lenses) and
angle values obtained by calculation.
The reason for the difference is the lens
distortion. Distortion can lead to a
significant deviation of the view area form
from a regular pyramid and warping of the
spatial resolution distribution.
See more: About lens distortion

Accounting distortion when designing
CCTV provides models of the view areas
and images more close to reality, and
thus more fully use cameras in the
project.

 

Problem 
 

There is a camera AXIS M1004–W/M1014/M1034-W. It is required to obtain a model of the view
area, the distribution of the spatial resolution and image from this camera with taking into account
lens distortion.
 

Camera parameters according to manufacturer's specification:
Sensor format - 1/4";
Lens focal length - 2,8mm;
Real horizontal view angle - 80 degrees.
Number of pixels 1280x800 (max)

 

It is recommended to measure real view angles practically .

Order of work
 

1. Create a camera by clicking the New camera   button and place it on the layout.
  

2. Open the Camera geometry   box and specify camera parameters:
Sensor format  - 1/4";
Lens focal length  - 2,8mm;
Aspect ratio : 16/10 (1280/800=16/10).

 

3. Click on the  button to open the Sensor and Lens  box.
In the box, pay attention to the difference between the calculated horizontal view angle - 65.5 degrees
and the actual view angle from the manufacturer's specification - 80 degrees. The difference indicates
that the lens distortion is present.
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4. On the Lens distortion panel check the  Horiz. checkbox and enter 80 to the field under it. Clear
the Vert. and Diag. checkboxes, because of the vertical and horizontal view angles are unknown.
 

 

5. Turn on modeling distortion, by checking the Simulate checkbox. After that we will see significant
change of view area in the Graphics window.
 

Without simulating distortion With simulating distortion
 

6. To observe influence of the distortion on the distribution of spatial resolution you should enter the

number of pixels of the camera (1280x800) in the Sensitivity and resolution    and turn on

modeling spatial resolution   . See Visualization of cameras' control area projections and
spatial resolution inside them . 
 

Without simulating distortion With simulating distortion
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7. To observe influence of the distortion on the image from the camera, open the 3D Video  

 and place several  3D models   within camera's view area.
 

Without simulating distortion With simulating distortion
 

8. To observe influence of the distortion on the form of the view area in 3D, open the 3D World   .
 

Without simulating distortion With simulating distortion
 

See also: Sensor and Lens>Lens distortion , About lens distortion , Measuring real view angles
, Specifying active area size of the image sensor
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10.35 Example 35  Measuring real view angles

Starting from the eighth version of VideoCAD, the
simulation accuracy of view areas of cameras in
VideoCAD is greatly improved because of the
possibility of simulating lens distortion .

Three view angles (horizontal, vertical, diagonal) are
computed inside VideoCAD from the lens focal length

 and image sensor size  without accounting
distortion. For most long-focus lenses distortion can
be ignored, but in case of short-focus lenses the
distortion introduces significant error in the calculation.
To simulate distortion we need to know the lens focal
length, image sensor size and at least one of the real
angles.

The value of the real angle can be taken from the manufacturer's specifications, as in the Example
. But not all manufacturers measure the real view angles of their cameras.

Lets consider a simple technique of practical measurement of camera view angles. Many variants of
the technique are possible depending on the conditions.
 

Problem 
 

There is a camera with a lens. It is necessary to measure the real angles: horizontal, vertical and
diagonal. To accurately modeling the view area, taking into account lens distortion.

The front nodal point of a lens and measurement inaccuracy

 

If the camera view area is in the form of a pyramid, the top of the pyramid will be in the front nodal
point of the lens. The front nodal point of the lens is located on the front principal plane within the
length of the lens on the main optical axis, but its exact position is unknown to us.
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If we assume that the front nodal point of the lens is in the middle, the possible error of measuring
the dimensions of the view area will be the ratio of half of the length of the lens by the distance from
the middle of the lens to the screen.
For example, if the physical length of the lens = 40mm, and the distance from the middle of the
lens to the screen = 1 meter, then the inaccuracy of measuring the size of the field of view =
40/2/1000 = 0.02, ie + -2%.
The inaccuracy of measurement of an angle will be less depending on the angle. For example, if
the angle is 90 degrees, the inaccuracy will be+ -1.3%.
 

If this accuracy is not sufficient, you should use more distance from the camera to the screen, but
it will require a larger screen, that is not always convenient.
 

Another way of reducing the inaccuracy is locating the front nodal point of the lens within the
length.
To do this, perform 2 measurements at different distances between the front edge of the lens and
the screen, for example 0.5 and 0.25 meters. Then, assuming that the view angles are constant,
solve the system of equations, where the unknown is the distance from the front edge of the lens to
the front nodal point.
 

Omitting the course of the solution, we present the resulting formula for the calculation.
 

dL=(S2 * L1 - S1 * L2) / (S1 - S2);
 

where:
dL - unknown distance from the front edge of the lens to the front nodal point;
L1 - distances between the front edge of the lens and the screen at the first measurement;
L2 - distances between the front edge of the lens and the screen at the second measurement; 
S1 - width (at measuring horizontal angle) of the field of view at the first measurement;
S2 - width (at measuring horizontal angle) of the field of view at the second measurement. 

Order of work
 

1. Fully open the lens aperture, if possible.
 

2. Focus the lens on the camera working distance. 
 

You should focus not on the distance to the screen but on a distance that will work  the camera on.
In most cases, this distance is the hyperfocal distance  at maximum aperture. Focusing on the458
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work ing distance is performed for a case, if the angles of view or the position of the front nodal point
will depend on the focus distance. 
 

3. Secure the camera in front of a flat screen. 
 

4. Close the aperture as possible to obtain a sharp image from the camera.
 

5. Adjust the camera position so that the main optical axis of the camera will be strictly
perpendicular to the screen. Mark the center of the image on the screen.
 

6. Watching the image, mark the extreme points on the screen width, height, and diagonal field of
view.
 

7. Measure the distances on the screen between the points on the boundaries and the marked
center of the image. Boundary points must be strictly symmetrical relative the center. If it is not the
case, then adjust the position of the camera and go back to step 5
 

8. Measure the distances between the points (field of view size in width, height and diagonal). 
 

9. Measure the distance from the front nodal point of the lens  to the screen.
 

 

10. Calculate the view angles using the formulas:
 

Ah=2 * ARCTAN(h / (2 * L));
Aw=2 * ARCTAN(w / (2 * L));
Ad=2 * ARCTAN(d / (2 * L));
 

where (see image):
 ARCTAN - arc tangent, inverse tangent function;
Ah,Aw,Ad - obtained real view angles in height, width and diagonal respectively;
h - distance between extreme points on height of the field of view;
w - distance between extreme points on width of the field of view;
d - distance between extreme points on diagonal of the field of view;
L - distance between lens front nodal point and the screen.

You can use the obtained angles in the Sensor and Lens  box for precise modeling view area of
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this camera. 

It is possible to make very simplified test on a camera already installed. 
1. Firstly measure sized and distances of real objects in cameras view area. 
2. Then construct 3D model in VideoCAD, place a camera.
3. Then choose angles of view to obtain image model equal to real image from the camera.

 

See also: Sensor and Lens>Lens distortion , About lens distortion ,, Modeling lens distortion310 654
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10.36 Example 36  Modeling panoramic cameras (Fisheye, 360°/180°)
  

Panoramic cameras are useful for monitoring
small spaces.
The view area of such cameras is a hemisphere.
Field of view is projected on the image sensor in
the form of a circle.
Therefore, the original image produced by the
image sensor is a circle in which the image of
the scene subjected to a strong barrel distortion.
Then, in the original image a target area is cut
out, distortion is corrected in this area and in
result an usual frame is obtained.
Users are interested in the output frame. The
original image in the form of a circle is used as
an intermediate.

VideoCAD allows to:
Simulate the output frames without distortion
with calculated pixel density;
Simulate camera field of view and distribution
of the spatial resolution in the Graphics
window and the 3D World .

See more Panoramic
 

Problem 
 

There is a camera AXIS M3007-PV. The camera is mounted on a bracket at 3m height at a distance
of 10 meters from a wall of 10 meters height. Camera is pointed down.
It is required to obtain a model of the control area, the distribution of the spatial resolution  and
image  from this camera.
 

Camera parameters according to manufacturer's specification, crucial for modeling:
Number of pixels 2592x1944 (5 MP)

Order of work

1. Create a camera by clicking the New camera   button. In the New camera box, in the
Camera icon combobox choose an icon for the new camera with panoramic, for example indoor/

panoramic .
 

A special icon is not obligatory. In the future it will be possible to change the icon in the   Camera
list  box. 
 

2. Place the camera on the layout. At a distance of 10 meters from the camera create a wall of 10 m

height using the   Rectangle   tool. 
 

3. Open the Sensitivity and resolution   box and specify number of pixels  on Horizontal -
2592 and on Vertical - 1944. Close the box and save changes.
 

The most important parameter that determines the image resolution of panoramic cameras, is
the number of pixels of the image sensor.
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Since the image sensor is rectangular in shape and view area of the camera is projected into a
circle, not all pixels are involved in image formation.
In VideoCAD the number of physical pixels on the sensor horizontally and vertically are
required. The number of pixels involved in the formation of the image (active pixels) will be
calculated by VideoCAD.
High precision of specifying the number of pixels is not required. So for a 2-megapixel camera,
you can enter 1200 * 900, for 3MP -1600 * 1200, for 5MP -2500 * 2000. Standard aspect ratio
should be supported. 
 

Lens focal length  and Image size at image processing  have no affect on the image
resolution of a panoramic camera. 

 

4. Open the Camera geometry   box and specify camera installation height  of 3 meters. 
 

5. Click on the  button to open the Sensor and Lens  box.
On the Panoramic panel mark the checkbox and specify angles of installation of the panoramic
camera. To point the camera down, choose:
Pan angle = 0; (this value is not important when the camera is pointed down);
Tilt angle=90.

The lens focal length boxes in the Graphics window and the Camera Geometry box will be

colored by aqua-green.
 

To limit too big size of the view area projection use the Maximum distance of drawing view area

 box in the Camera geometry   box .
 

6. Assign to the camera a Spatial resolution pattern  to visualize the spatial resolution (pixel

density distribution).  For this purpose open the   Spatial resolution box . Clear the Active
camera  checkbox, then choose the pattern "Home Office Scientific Development Branch 2009
(arbitrary resolutions)" in the Pattern  list. Then click Assign  to assign the chosen pattern to
the active camera.

 

Pattern criterion of spatial resolution  for panoramic cameras must be based on the spatial
resolution (Pixel per meter (Pixel per foot), Pixel for object), but not on the field of view size.
Criterion Field-of-view height,  % of Field-of-view for object are not suitable to panoramic
cameras, because of panoramic cameras have not a stable field of view.

 

7. Enable and adjust the spatial resolution visualization in the Graphics window. 

In the popup menu of the    Shadow  button on the Toolbar  of the Graphics window
choose Within projection. 

In the popup menu of the    Fill projection  button choose Filling

In the popup menu of the    Spatial resolution  button choose Discrete color. 
 

As a result we will see in the Graphics windows the spatial resolution distribution of the camera 
AXIS M3007-PV on the height  specified in the Spatial resolution pattern  assigned to the
camera.
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Considering the projection can be said, for example, that at a distance of 28 meters from the camera
at a height of (2 + 0.5) / 2 = 1.25m the yellow region ends, and hence the pixel density, according to
the selected pattern, equals 39 pixels per object of 1,64m height or 39 / 1.64 = 24 pixels/meter.
 

8. Open the   3D World  window. In the window we can see the distribution of spatial resolution
in the form of coverage on the surrounding objects.
Using the navigation in the 3D space , we can see spatial resolution at any point on the surfaces
around the camera , as well as we can detect invisible areas shaded by other objects.
 

 

9. Open the   3D Video  window. By directing the camera on regions of interest on the scene,
we can see with what resolution these regions will be displayed by our camera.
 

10. Place   3D model  of a man on the far border of yellow region, that is, where the pixel
density is 24 pixels / meter. And direct the camera on the 3D model.
Let's try to change the lens focal length  and make sure that only the size of the field of view is
changed. Resolution of the image will remain constant.
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Pan, tilt and rotation of the camera around its own axis, made in the usual way does not affect the
position of the panoramic camera. By rotation the camera in the usual way, you can view images
from the panoramic camera in different directions in the 3D Video . In this case, the view area will
be limited at 180 degrees from the main optical axis of the lens. Beyond this limit the image is cut
 

You can change the Lens focal length, thereby changing the field of view size, but the image
resolution in the 3D Video will always be maintained equal to the calculated resolution of the 
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panoramic camera.
If the calculated resolution is worse, the resolution of the 3D Video will be artificially reduced. If the
calculated resolution is better, then the PiP  mode will be launched in the 3D Video.
The Image line in the Titles  displays a virtual number of pixels for correct simulation of the
resolution. 
 

Distortion of a panoramic camera images in the 3D Video is not modeled.
The simulated resolution is exact only at the center of the frame. Towards the edges of the frame the
actual resolution is slightly worse than simulated, but this error is negligible. The smaller the view
angle, the more accuracy of simulating resolution on the edges of the frame.
For a more realistic model of the image, turn on modeling of compression  and smoothing , or
set the actual resolution of the lens  (for accurate simulation the lens resolution you also need to
specify the correct size of the image sensor ).
 

See also: Panoramic
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10.37 Example 37  Work with background in AutoCAD formats

Normal sequence of actions at work in VideoCAD is:
 

1. Loading a background
2. Placing cameras, constructions, 3D models on the baclground.
3. Printing or exporting result of the work.
 

See more: Choice of cameras' quantity and location on the original layout

When the background is in AutoCAD format (DXF or DWG), the additional possibilities are offered:
 

Adjusting visibility of layers of the background, chosing layout, hiding texts .
 

Import  constructions  from a 2D background in AutoCAD formats to 3D VideoCAD
constructions automatically. Use of this tool allows to reduce efforts of outlining background to
convert it to 3D constructions.
Adding cameras and constructions of VideoCAD to the background in AutoCAD format on
additional layers and then save the background to a file to work with it in AutoCAD.

 

Problem 
 

There is a floor plan in DXF format. We need to place cameras on it and save the file with the
cameras and their view area projections in the same format - DXF.

Order of work

1. Loading, scaling and adjusting visibulity of layers of the background

 

Loading and scaling the background is performed by the same way as in the previous examples
:
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1.1 Choose Main menu>Load
background>In horizontal projection . 
 

1.2 In the appeared dialog choose
background file in dxf or dwg format then
click Open.
 

1.3 In the appeared dialog Adjust

background  click  Ruler.
 

1.4 Specify by clicking 2 points on the
background image, the distance
between which is known to you (e.g., the
length of a building, a wall, etc.). In the  
Distance box the measured distance at
the current scale will appear.
 

1.5 Enter the known distance into the 
Real distance box.
 

1.3 If the loaded background is in DXF or
DWG format, the dialog includes tools to
select a layout and to control visibility of
layers of the background, as well as a
checkbox to hide texts.

To enable/disable layers: choose layers
name in the Layers list, then mark or
clear the Visible checkbox.
 

1.7 Click OK in the Adjust background
dialog.

2. Import of 2D constructions from the background to 3D constructions of

VideoCAD 

 

It is convenient to import 2D constructions from a background in AutoCAD formats to VideoCAD
3D constructions  automatically. Use of this tool allows to reduce efforts of outlining background
to convert it to 3D constructions.  Specially prepared background file is not required, but if a
background is pre-prepared in AutoCAD, then the efficiency of import will be higher.
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Order of work:
 

2.1 Load  and adjust (scale)  the
background, show it on the screen.
 

2.2 Choose Main menu>Drawing>Import DXF/
DWG background
 

2.3 In the appeared box adjust the Filter of
constructions, in order to make visible only
constructions you want to import.  You can filter
constructions by layout, layer, line type, color,
line weight, name.
 

2.4 Make active a layer  of VideoCAD, to
which you want to import.
 

2.5 On the Toolbar  choose a type of
VideoCAD construction to which you want to
import filtered constructions from the
background. You can import to Line segment
, Polyline , Inclined rectangle , Double line

, Wall , Aperture in wall . 
 

While importing to the Aperture in wall , you
can cut gaps in existing walls. While importing to
the Inclined rectangle  , you can make it
semitransparent.
 

2.6 On the Current construction parameter panel
 set parameters of the chosen VideoCAD

construction (line type , Heights, Thickness of
walls etc.).
 

2.7 Click Import. The result will be the same, as
if you have outlined selected constructions
manually.

Imported constructions are usual VideoCAD constructions, you can edit them. 
You can repeat steps 3..7 many times, to import different constructions from the background to
different construction types of VideoCAD, on different heights, to different layers, by different colors
etc.
Not all types of background constructions can be imported. In VideoCAD8 you can import lines and
polylines on the layout or in blocks.

3. Placing cameras

 

Place cameras on the background by the same way as in the previous examples . If lines on the
background was transformed to VideoCAD's constructions, you can use shadows . You can see
your project in 2D in the Graphics window  and in 3D in the 3D World . 
 

See previous examples .

4. Adding cameras and constructions of VideoCAD to the background file
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4.1 Move and scale working layout so that the background with cameras will be fully visible on the
screen and activate  one of the visible on screen cameras. 
4.2 Make invisible the layers  which you do not want to export. 
4.3 Go to Main Menu> Drawing>Save As > *. dxf or Main menu> Drawing> Save As> *.dwg.
4.4 In the appeared Options box
4.4.1 Mark the Add to DXF/DWG background  to add cameras and constructions of VideoCAD
to the file of the background on separate layers.
4.4.2 Clear the Simplified export , because of during the simplified export adding to background
is not supported.
4.4.3 Adjust Sizes  of cameras, illuminators, non scalable fonts, hatching and dash lines if
necessary.
 

On the Export tab only sizes of non scalable camera icons, illuminators and fonts is specified. If
scaling  of cameras, illuminators or a font  is enabled, then the size of cameras, illuminators
or fonts respectively will be exactly as displayed on the screen. 
 

4.4.4 If raster images (projections of 3D models) must be inserted into the exported file, mark the
Insert raster images . 
 

Raster images are exported to a separate <export file name>_img directory in the directory of
saving the exported DXF/DWG file. To the DXF/DWG file the references to the raster files are
written. You must move the folder with raster images along with the DXF/DWG file.
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4.5 When finish adjusting export, click OK. Standard file saving dialog will appear. Choose file
name and directory then click Save.

The resulting file will be a copy of the background supplemented by cameras and constructions
placed in additional layers.
 

Cameras with view areas are exported as AutoCAD blocks, view area bounds are exported as
polylines. In attributes of the block the most important parameters of the camera are recorded:
Name, Model, Lens focal length, Height of installation, Base height, Heights of view area lower and
upper bounds, View angles, Number of pixels, Spatial resolution pattern, Quality level. 
 

Illuminators are exported as AutoCAD blocks. In attributes of the block the most important
parameters of the  illuminator are recorded: Lamp type, Number and power of lamps, Height of
installation. 
Distribution by layers , set in VideoCAD is saved. 
 

 

See also: Drawing>Load background , Drawing>Adjust background , Drawing>Save as ,
Drawing>Import DXF/DWG background , Options box>Export , Export 3D view areas to
general 3D design software
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10.38 Example 38  Specifying active area size of the image sensor

The Image sensor size in VideoCAD implies the size of the entire light sensitive area of the image
sensor, which can form an image with the maximum number of pixels horizontally and vertically.
 

Active area of the image sensor in VideoCAD implies an area of the image sensor on which the
image is formed in a given mode of the camera. The sizes of the active area may be less than or
equal to the image sensor size. Active area can differ in different modes of operation of the same
camera.
 

 
 

Exactly the active area size and lens focal length determines the angles of view, and through
them influences on the results of camera modeling. Accuracy of specifying the active area size
greatly affects the accuracy of modeling the camera.

The traditional method of specifying the active area size of the image sensor

 

In the past, specifying the active area size was a simple task. Each camera specification
includes the image sensor format (type) in "vidicon" inches from the standard series (1/4 ",
1/3", 1/2 "..) which determines the size of image sensor. Although the translation of the format to
the size is not accurate, the accuracy was acceptable for most practical purposes.
 

Native Aspect ratio of image sensors used in CCTV cameras was 4:3. When camera's output
image had the same aspect ratio of 4:3, the active area occupied the entire image sensor. To get
image with the Aspect ratio of 16:9 only central area across the width of the image sensor was
used, and areas on the top and bottom of the image sensor was not used. Reducing the number
of pixels of the output image had no affect on the active area size.

In such circumstances, to uniquely specify the active area of the image sensor it was enough to
choose in the Image sensor size  box the Image sensor format from a list of standard formats
(1/4 ", 1/3", 1/2 "..) and choose the Aspect ratio of the output image in the Aspect ratio box  (
4:3, 16:9 ...).  
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Now this way might be used for specifying active area size of the image sensor of cameras of
previous generations, or in cases when accuracy of the simulation is not important.
For modern cameras, this method is not sufficiently accurate. An error may exceed 20-30%.
 

Image sensors with non-standard sizes have appeared, with fractional inch formats that do not
fall into the list of the standard formats (eg, 1/2.8", 1/2.9", 1/3.2", 1/1.9" ..).
Image sensors with aspect ratio different from 4:3 have appeared.
In specifications of some cameras the sensor size is indicated more accurately in the form of
diagonal length or side lengths, in millimeters.
Cameras can form images with different numbers of pixels and aspect ratios.
Some cameras in some modes use active area of the image sensor which does not touch the
edges of the image sensor.

 

Examples of errors during specifying size of the active area of image sensor

by the traditional way

 

Example 1:  A camera has an image sensor
of 1/3" with aspect ratio of 16:9, but the output
image has aspect ratio of 4:3.

The Image sensor format (1/3") determines the
length of diagonal (6mm). Aspect ratio of any
image sensor in the traditional way is always
assumed to be 4:3. Therefore, in camera
simulation the active area with diagonal of 6
mm and aspect ratio of 4:3 will be used, ie 4,8
* 3,6mm.
 

However, the real aspect ratio of the image
sensor is 16:9, so the actual size of the image
sensor with diagonal of 6mm will be 2,94mm to
5,23mm.
 

At the same time, the aspect ratio of the
output image (=aspect ratio of the active area)
is 4:3, so that the active area is formed by
''cutting' side areas from the Image sensor of
16:9 laterally. Therefore, the actual size of the
active area is 3.92 * 2,94mm.
 
Thus, the actual size of the active area image
sensor, and hence the field of view will be 20%
less than the calculated values.
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Example 2: Some cameras can produce
images with reduced number of pixels using
the active area in the central part of the image
sensor. The active area does not touch the
edges of the image sensor. The size of the
active area may depend on the number of
pixels of the output image.
 

For example, the same image sensor SONY
Exmor R IMX291LQR has format
1/2.8"(diagonal 6.46 mm) in the full HD1080
mode and 1/4.2" (diagonal 4.31 mm) in the
HD720 mode. In the HD720 mode the image
sensor uses only the central part of pixels.

If you use format 1/2.8" in the HD720 mode,
the actual size of the field of view will be 33%
less than calculated one.

Problem 
 

For accurate camera modeling we must specify the sizes of the active area of the image sensor in a
given mode of the camera.

Order of work

1. If side sizes of the active area of the image sensor in a given camera mode are known, then
enter them directly.

Direct specifying side sizes of active area of the image sensor

 

If you know the side sizes of active area of the image sensor in a given mode of the camera, simply
enter them in the Image sensor size  box separated by asterisk in the form W*H. Where W and
H - width and height of the active area of the image sensor in millimeters.
For example: 4.8*3.6
Thus the size of the active area image sensor was specified and the problem is solved.
 

However, in most cases, camera specifications don't give the side sizes of the active area for each
camera mode separately, so the program will have to calculate them. For the calculation it is
necessary to set the following parameters, are known in the most cases:
 

Image sensor size (it is better to set side sizes in millimeres , but possible via the length of
diagonal  (format, type) and aspect ratio of the image sensor).
Aspect ratio of the output image .
Crop  - a factor of decreasing active area size. The Crop is provided for cases when the active
area does not touch the edges of the image sensor. In other cases Crop=1.

 

On the basis of this information, VideoCAD will calculate size of the active area of the image sensor,
which will be used in camera modeling.
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You can specify the required parameters in the Image sensor size  and the Aspect ratio  boxes
in the Camera Geometry  box, but it is more convenient to do it in the special Sensor and Lens
box .
Open the Camera Geometry  box, and then clicking on the Sensor and Lens button

, open the Sensor and Lens  box.

2.1.1 If the image sensor side sizes in millimeters are known, then enter them directly.

Direct specifying the image sensor side sizes

 

If the camera specification contains the sensor side sizes (that is the maximum size of the active
area), then enter them to the  Image sensor size  box separated by hash, in the form W#H.
Where W and H - width and height in millimeters of the image sensor.
 
For example: For the camera WV-SFV631L the sensor sizes can be found in the string: Scanning
area 5.346 mm (H) x 3.336 mm (V)
Enter to the Image sensor size box  5.346#3.336
 

2.1.2 When the image sensor side sizes are unknown, specify them via the length of diagonal
(format, type) and aspect ratio of the image sensor.

Specifying image sensor size via the length of diagonal and the aspect ratio

The length of diagonal in "vidicon" inches as a format (type) almost always exists in camera
specification. For example, 1/2", 1/2.9". Enter the format to the Image sensor size  box. In the box you can
choose format from the list or type any value, for example, 1/3.15", 1/2.75". If you enter a value
which not found in the standard list, the Image sensor size box turns yellow and VideoCAD will
calculate diagonal from the format.
 

If a specifications give diagonal length in millimeters, it is preferable to use it. The value in
millimeters is usually more accurate.The diagonal length in millimeters must be typed with the
letter d, for example d6.0 - the length of diagonal is 6mm.
 

For example: For the camera WV-SFV631L the image sensor format can be found in the line:
Image Sensor Approx. 1/3 type;
In the specification of the image sensor SONY Exmor R IMX291LQR the length of diagonal line
can be obtained from the line: Diagonal 6.46 mm (Type 1/2.8)

To set the size of image sensor through the format or length of diagonal you must also specify the 
aspect ratio of the image sensor, since Image sensors with the same diagonal, but different
aspect ratios will have different sizes.
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One should distinguish between the aspect ratio of the image sensor and the aspect ratio of the
output image .
Aspect ratio of the output image is the ratio of sides of the image produced by the camera in the
given mode. It equals to the ratio of sides of the active area of image sensor in the given mode. 
The aspect ratio of the output image can be different from the aspect ratio of image sensor. A
camera with the same image sensor in different modes can produce images with different aspect
ratios.

 

You can learn the aspect ratio of image sensor by several ways:
 

1. From the camera specification.
 

For example: In the specification of the camera WV-SFV631L sensor sizes can be found from the
string: Scanning area 5.346 mm (H) x 3.336 mm (V)
Aspect ratio of the image sensor: 5.346 / 3.336 = 1.60 = 16:10
 

2. You can learn the aspect ratio of the image sensor visually, if you remove the camera lens. To
determine the aspect ratio of the image sensor, photograph it and calculate the ratio of the number
of pixels in the image of the image sensor vertically and horizontally.
 

 

3. It is possible to calculate a ratio of the maximum number of horizontal pixels to the maximum
number of vertical pixels in all possible modes of the camera. 
 

For example, a camera can produce images with the following number of pixels:
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90 
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1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
 

The maximum number of horizontal pixels - 1920, the maximum number of vertical pixels - 1200.
Expected aspect ratio of the image sensor 1920/1200=1,6=16:10

Enter the obtained values of the diagonal (format) and the aspect ratio of the image sensor to
the Image sensor size  box in the Camera Geometry  separated by space character. If the
aspect ratio of the image sensor is 4:3, it can be omitted. 
For example:

1/3"
1/3" 16:9
d6.0 16:9

 

 

Or enter the diagonal (format) and the aspect ratio of the image sensor separately to the 
Image sensor>Size and Image sensor>Aspect ratio in the Sensor and Lens  box.

2.2 Then you need to specify the aspect ratio of the output image.

Specifying aspect ratio of the output image

 

The Aspect ratio of the output image equals to the aspect ratio of the active area of the image
sensor. It equals to the ratio of number of pixels of the output image horizontally and vertically in
the given camera mode. The aspect ratio of the output image can be different from the aspect
ratio of image sensor . A camera with the same image sensor in different modes can produce
images with different aspect ratios.
 

For examples for the following number of pixels:
 

1920 / 1080=1.78=16:9. In the mode 1920 x 1080 the aspect ratio of the output image = 16:9
1600 / 1200=1.33=4:3.  In the mode 1600 x 1200 the aspect ratio of the output image =  4:3
 

Enter the Aspect ratio of the output image to the Aspect ratio  box in the Camera
Geometry.
 

 

It is convenient to use the Image sensor calculator , which can be invoked by the Calculator

button   in the Sensor and Lens box.

2.3 If it is possible that the active area does not touch the edges of the image sensor, you must set
the crop factor.

Specifying the Crop factor

 

Crop is a factor of decreasing active area size provided for case when the active area does not
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touch the edges of the image sensor.  In other cases Crop=1.
 

For example, the same image sensor has format 1/2.8"(diagonal 6.46 mm) in the full HD1080
mode and 1/4.2" (diagonal 4.31 mm) in the HD720 mode. In the HD720 mode the image sensor
uses only the central part of pixels.

 

When setting the crop factor one should be guided by the rules:
 

1. If, in a given mode, the camera uses the maximum number of pixels of at least one dimension
(horizontal and (or) vertical), it is used the whole width or height of the image sensor, then the Crop
factor equals one.
 

For example, a camera can produce images with the following number of pixels:
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90 
1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
 

The maximum number of horizontal pixels - 1920, the maximum number of vertical pixels - 1200.
The modes with maximum numbers of pixels: 1920 x 1080 and 1600 x 1200.

2. If in the given camera mode not the maximum number of pixels is used, it is necessary to
get know how the camera produces images with less than the maximum number of pixels. The 3
ways are possible:
 

1. By resizing the image with the maximum number of pixels of at least one of the direction.
2. Using only the central part of the image sensor, do not touch sides of image sensor.
3. Simultaneous use of 1 and 2 ways. The intermediate image is produced using the center
area of the image sensor, and then the resulting image is resized.
 

In the first case, the size of the active area of the image sensor is not dependent on the number of
pixels of the output image, therefore the Crop = 1.
In the second and third cases, the size of the active area of the image sensor decreases with the
number of pixels of the output image.

First of all it is necessary to search the specification information whether the image sensor size
(format) or angles of view depend on the number of pixels of the output image. If such information is
not available, it is likely that the Crop = 1. But if there is a suspicion that the camera reduces the
size of the active area, you can check the camera practically:
 

1. Display the image from the camera in the mode with the maximum number of pixels of the
output image.
2. Switch to the mode with reduced number of pixels and note whether the size of the field of
view is reduced.

 

If the size of the field of view is not reduced or it is reduced only in one direction, then the Crop = 1.
If the size of the field of view is reduced in both directions in proportion of reduction in the number
of pixels of the output image, it is necessary to separately calculate the horizontal and vertical
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ratio of the number of pixels in the given camera mode to the maximum number of pixels in
appropriate direction. Crop equals to the minimum of these ratios.
 

For example, if the camera has modes of 1920 x 1080 and 1280 x 720, and the image in 1280 x
720 mode is formed by a central area of the image sensor, then the Crop = 720/1080 =
1920/1280, or 0.67.
 

If the size of the field of view is reduced in both directions less than the reduction of the number of
pixels of the output image, it is necessary to separately calculate the horizontal and vertical ratios
of the field of view size in the given mode of the camera to the size  the field of view in the mode
with the maximum number of pixels. Crop equals to the minimum of these relations.
 

As you can see, in the most cases the Crop = 1. But on those rare occasions when the Crop <> 1
ignoring this fact can result to significant error. To calculate the crop factor it is convenient to use

the Image sensor calculator  that can be invoked by click ing on the Calculator  button  in
the Sensor and Lens  box.
 
Enter the Crop  to the Image sensor's active area> Crop  box in the Sensor and Lens  box.
You can enter a number with decimal point or ratio separated by slash /. 
 

For example:
0.67
720/1080

 

You can enter the Crop to the Aspect ratio  box in the Camera Geometry  separated by
space after the aspect ratio of the output image. 
 

For example: 16:9 0.67
 

 

As a result of specifying all parameters, on the image in the Sensor and lens box  the aspect ratios,
relative position and size of the active area on the image sensor will be schematically displayed.

Examples of image sensor images of real cameras:
 

Aspect ratio of
Image sensor

4:3 16:9 4:3 16:9 16:10 16:10 16:9
(1920*1

080)
Aspect ratio of
Active area of
Image sensor

4:3 16:9 16:9 4:3 16:9 4:3 16:9
(1280*7
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20)

Crop
1 1 1 1 1 1 720/10

80=0.6
7

Image

In the Image sensor's active area > Hor. Vertical Diag. boxes the calculated sizes of the active
area of the image sensor will be displayed. 
In the Lens > Calculated angles> Hor. Vertical. Diag. the calculated view angles will be
displayed.
 
The sizes of the active area may be adjusted or typed new values.

After setting all parameters for recording the result to the active camera, click Save.

3. After specifying all parameters it is recommended to verify correctness of the set active area size
using the obtained angles of view.

Verifying correctness of the set active area size using camera view angles

 

Sometimes camera specifications include view angles with a lens with known focal length.
Considering these angles as a result of practical measurements, it is possible to verify correctness
of the set active area size by comparing the angles from specification with the angles calculated by
VideoCAD in the Sensor and Lens box>Lens> Calculated angles> Hor. Vertical. Diag . The
comparison may confirm the correctness of the obtained size of the active area of the image sensor
or show an error. If an error will be detected, please carefully check all parameters you specified.
 

When verifying it is necessary to bear in mind the following:
You need to know which angle is given in the specification of the camera (horizontal, vertical or
diagonal) and compare it with the same calculated angle.
You need to know in what mode of the camera the angle is obtained and simulate this particular
mode.
When the lens focal length is less than 6mm possible discrepancy between the calculated angles
and angles from the specification because of lens distortion .
The difference between the calculated and specification's values of angles within 5% is normal,
due to measurement error, error of specifying the size of image sensor and lens focal length.

You can measure the view angles practically .

See also: About Lens distortion . 
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10.39 Example 39  Teaching materials

When studying VideoCAD the educational article series The principles of CCTV design in
VideoCAD is very useful.
 

The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
The principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification
area, license plate reading area. Spatial resolution."(*.pdf) 
The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf) 
The principles of CCTV design in VideoCAD. Part 4. Illumination and camera sensitivity in CCTV"(*.
pdf)
The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving objects."(*.pdf)
The principles of CCTV design in VideoCAD. Part 6. Lens distortion in CCTV design."(*.pdf)
 

... to be continued...
 
These articles contain a short theoretical material and illustrated step by step instructions on how to
use VideoCAD.
You can download the articles here http://www.cctvcad.com/CCTVCAD-Download.html

There you can also find:
 

VideoCAD User's Guide in *. pdf format
Package to import 3D models.
Other useful programs for CCTV design.

http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part1.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part2.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part2.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part3.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part4.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part5.pdf
http://cctvcad.com/Files/the_principles_of_cctv_design_in_videocad_part6.pdf
http://www.cctvcad.com/CCTVCAD-Download.html
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11 Recommendations on the program use

Precision in calculations
 

VideoCAD calculates results on the base of laws of geometrical optics, video sensor's
characteristics, lighting engineering and radiometry. Mathematical precision in VideoCAD
calculations is not less than ±1 %.
At the same time, parameters of real cameras and lenses are not so precise. 
The difference with reality depends on the accuracy of the input data.
A big influence on the accuracy of camera modeling has accuracy of specifying image sensor
sizes . For wide-angle lens consideration of lens distortion  is very important.
Nobody can guarantee that just your camera and lens have no significant inequality of focal length
value with the one declared in the specification. It is advisable to test a camera with a lens 
practically  in especially crucial cases.
If not performing such a test, it is recommended to leave a reserve about 10-15 % in the results. 

 

See also: About camera sensitivity, Measuring real view angles , Specifying active area
size of the image sensor , About lens distortion

Calculation of horizontal projections of person detection, identification

and license plate reading areas.
 

Horizontal projections of person detection, identification and license-plate reading areas are
calculated strictly according to the criteria numerical values specified. In case the projection sizes
are not suitable, it is recommended to understand, which criteria might cause the restrictions.
Probably, in your case it is possible to sacrifice some values and obtain a sufficient projection
with a less capacity of detection, identification or reading. 
 

See also: Spatial resolution .

Numerical values criteria of person identification and license plate

reading.
 

Criteria themselves are very subjective and depend on a number of external factors. 
For instance, the license plate reading capacity, beside lighting, depends on weather conditions,
road down-grade, etc. The person identification might depend on such factors as, whether people
in a place of surveillance are looking upwards or downwards, whether the familiar or unfamiliar
people are being identified, whether people in a place of surveillance wear headgear, etc. The
numerical values specified in the program by default are rough and are given with some reserve. It
is recommended to formulate your own numerical values of criteria proceeding from your
requirements, type them in VideoCAD and apply them according to actual conditions in a place of
surveillance. 
 

With the help of 3D modeling video surveillance scenes and image quality you can make own
criteria values, having several examples of images from your video system.    
In more detail the process of determination own criteria is viewed in the Example 6  Determining
person identification criteria by a real image . 
 

Eventually, you would be able to estimate the required quality level for each individual case.
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Program speed and system requirements
 

Recommended system requirements:

IBM compatible computer with 2 Core processor;
1 Gb of RAM;
40 Mb of free hard disk space;
SVGA video adapter with Open GL 3D Hardware support;
Windows 2000, Windows XP, Windows Vista, Windows 7, Windows 8, Windows 10 operating
system;
Wheel Mouse;

As with other CAD software, real system requirements greatly depend on complication of your
working materials. 
If you use a lot of 3D models, background file of tens of megabytes, you need more productive
hardware.
But you can simplify your materials and make the same work on outdated computer. Thus there
can't be clear system requirements which are correct in all cases.
Program speed depends on several factors. 
Redraw speed of the image depends on number and complexity of displayed 3D models
and the size of opened 3D Video. VideoCAD offers powerful but resource-intensive operations
for image processing, which can be enabled or disabled.
The speed is considerably decreased when modeling illumination , depth of field   exposure

, rolling shutter , animation . The speed is decreased in a less degree when modeling

interlace , using PiP , modeling lens distortion , using gradient ..
Compression  modeling and other additional image processing reduces speed to some extend.
You can quickly enable and disable all image processing with the help of the 3D Video>Main
menu>Speed>Disable image processing . 
Using the 3D Video>Main menu>Speed>Redraw 3D image only by clicking  you can avoid
unnecessary redrawing the 3D view.The 3D Video  and 3D World  windows opened
simultaneously decelerate program speed.
It is recommended to enable the resource-intensive operations only when needed and disable
them during normal operation.
VideoCAD Lite  and VideoCAD Starter  may seem less demanding of computer resources
because of absence of resource-intensive tools. However, these tools when they are not needed,
can be disabled in version Professional too.
 

See details: Errors in rendering 3D images

Mastering VideoCAD
 

To master the program it will be very useful to get acquaintance with The principles of CCTV
design in VideoCAD articles. See also Examples of work with VideoCAD .
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11.1 About camera sensitivity

Camera's ability to create images with a necessary quality in low light conditions has an important
value in many of outdoor video surveillance systems. 

 
Unfortunately, there is no unified standard of measuring sensitivity in CCTV industry. Cameras'
producers give values of sensitivity measured in there own methods. The values of sensitivity given in
specifications of many producers correspond to the image on which on the strong noise background
it is hardly possible to distinguish only silhouettes of large high-contrast objects.
Few producers give values of the sensitivity measured according to open standards. 
As a result, cameras with actually equal sensitivity, but produced by different manufactures, have
values that can differ in ten times in the specifications.

 
However for design calculation or modeling the cameras' sensitivity should be specified
unequivocally.

In VideoCAD sensitivity is defined through the Minimum scene illumination (lux) of a scene with
reflection factor = 0.75, at which the image from the camera with mounted lens with a known
aperture (F number) has known signal/noise ratio (dB) and video signal amplitude (IRE).
The scene is lit by a tungsten halogen lamp with colour temperature Tc=3100 +-200K. 
 

For the unequivocal description of sensitivity the following parameters should be specified:
 

Minimum illumination (lux);
Lens aperture (F);
Signal/noise ratio (dB);
Video signal amplitude (IRE);
Exposure time.

 

The definition is based on standard CEA 639 ' Consumer Camcorder or Video Camera Low Light
Performance'.
 

If precise modeling is required, it is recommended to measure  sensitivity of camera models in
use. 
The measurement results can be inserted to parameters of camera's model  in VideoCAD. After
that to obtain the image from the camera's model in any illumination conditions it is enough to assign

 necessary model to the active camera. 
Sensitivity of cameras' models, which are available in the Table of camera models , have been
measured in accordance with detailed procedure .
 

The method is based on standard CEA 639 ' Consumer Camcorder or Video Camera Low Light
Performance '.
 

At comparison of measured parameters in the Table of camera models with data of producers it is
possible to see, that the measured sensitivity of camera Pelco MC3710H-7X exact matches to the
value given in the specification. Cameras by JVC have the close sensitivity. 
Sensitivity of other tested cameras is essentially lower the values given in specifications.
 

Correspondence of sensitivity measuring method to the standard CEA 639 is declared also by Axis
Communications Inc.
 

If an installation firm does not have technical conditions to measure sensitivity of cameras practically,
at a choice of sensitivity value for camera models in VideoCAD it is necessary to be guided by
following practical rules for the defect-free, competently designed cameras without extended
dynamic range.
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1. Sensitivity  of black-white cameras with high resolution CCD image sensors (752x582 effective
pixels) 1.3" IT CCD, Sony Super HAD ™ CCD is 0.06-0.15lx at signal/noise  ratio =17dB, lens
aperture  F1.2.
 

2. Sensitivity of black-white cameras with high resolution image sensor (752x582 effective pixels)

1.3" Sony ExView HAD ™ CCD is 0.04lx at signal/noise ratio =17dB, lens aperture F1.2.
 

3. Sensitivity of high resolution color cameras (752x582 effective pixels) is approximately 1lx at
signal/noise ratio =17dB, lens aperture F1.2.
 

4. Sensitivity of cameras with standard resolution CCD image sensor (500x582 effective pixels) is
better than ones with high resolution CCD image sensors (752x582 effective pixels) approximately by
15-20 %. 
 

5. Sensitivity of day/night cameras (removable IR filter) in black-white mode is approximately
twice worse than the sensitivity of black-white cameras with the same image sensors.
 

6. Sensitivity of easy day/night cameras (permanent IR filter) in black-white mode is
approximately 1.5 times better than the sensitivity of color cameras with the same image sensors.
 

7. To obtain camera sensitivity with a lens with aperture different from F1.2 it is necessary to
multiply sensitivity with aperture F1.2 by the ratio of squared lens aperture by 1.44 (1.2 squared).
 

For example, a camera with 1.3" Sony ExView HAD ™ CCD and a lens with aperture F2.0 (mini, M12)
has sensitivity equal 0.04 * (2*2/1.44) =0.11lx. Where 0.04 lx is sensitivity at the aperture F1.2. 
 

8. Real sensitivity of cameras with extended dynamic range and complex digital image
processing can be insufficient despite good values in the specification. It is recommended to test
such cameras before usage in a project. During testing pay attention to possible strong reducing of
resolution in low light conditions.
 

Sometimes the high sensitivity is attained due to reducing of noises as a result of digital image
processing. Measuring shows good signal/noise ratio up to low illumination. However at the same
time the resolution decreases substantially.
 

VideoCAD can take into account the exposure time  at modeling sensitivity to simulate motion
blur , depending on the exposure time and speed of objects .
 

Reducing of resolution and increasing exposure time at decreasing illumination are typical for
cameras with night vision modes and some IP cameras as well. 
Use Sharpness  parameter for modeling of resolution reducing in VideoCAD.
 

9. IRE  value at sensitivity measuring for different cameras can differ substantially and equal from
20-50 for normal AGC gain (Normal AGC, Standard AGC) up to 90-100 for the high  AGC  gain (HI
AGC, Super AGC). 
 

Use Max. AGC  gain parameter for modeling boosted contrast without signal/noise ratio
enhancement. 

About IP camera sensitivity
 

Recall that the maximum exposure time of analog cameras is 20ms for PAL and 16.5 ms for NTSC.
Exactly for this exposure time the sensitivity values of simple analog cameras are shown above.
IP cameras in low light conditions automatically use the exposure time greater in several times.
This is not noticeable on static scenes, but leads to blurring of moving objects.
Sensitivity of IP cameras is strongly dependent on the size of pixels on the image sensor. The
smaller the size of each pixel ( smaller size of the image sensor or more the number of pixels on the
same size of the image sensor) - the worse the sensitivity.
Correctly measuring sensitivity of modern IP cameras is not an easy task. When light is decreased,
IP camera automatically turns on the noise reduction, merges neighboring pixels, reduces frame
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rate, multiplies exposure time, disables color. The black level rises and the noise is lost in black
together with dark image details. Meanwhile turning off this automation is impossible in many cases.
When the noise reduction system can not be disabled, the signal/noise ratio becomes not good
criterion of image quality.

In our tests, we got from an IP camera with 1/4" CMOS image sensor with 640 * 480 pixels and F2.0
lens, an image with SNR 17dB at 1,3 lux scene illumination, when the camera sets the exposure
time = 40ms. Increasing exposure time up to 160ms increases sensitivity to 0.3 lux.

2-megapixel IP camera with 1/3" CMOS sensor with resolution 1600 * 1200 pix and F1.2 lens, gave
out an image with SNR 17dB at illumination of 1.0 lux, with exposure time of 80ms. Increasing the
exposure time up to 240ms increases the sensitivity to 0,3 lux.

The exposure time was checked by our own technique .593
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11.2 About lens distortion

Studying the manufacturers specifications of lenses and cameras we can see that in many cases
the actual view angles obtained by measurement and listed in the specification do not coincide with
the calculated view angles for an ideal lens, based on the lens focal length  and the size of the
image sensor .
For example, the specification of the lens T2314FICS-3 (Computar) contains the following values:

With lens focal length of 2.3 mm and the size of the image sensor 1/3" real horizontal view angle is
113.30 deg., and the vertical view angle is 86.30 deg. But calculation gives lower values - 92.40 deg
. and 76.10 deg.
The form of the camera view area with this lens differs from the standard pyramid and therefore can
not be accurately calculated by lens calculators or modeled by CCTV design programs of previous
generation.
The cause of warping the view area is the Lens distortion. The Lens distortion arises from the fact
that the optical magnification of a real lens is not constant over the entire field of view. Optical
magnification varies depending on the distance from the center to the edges of the field of view.

Depending on whether the optical magnification of a lens is decreased or increased with distance
from the center of the field of view,  the barrel distortion and the pincushion distortion is
distinguished.
 

The titles barrel and pincushion are associated with the distortion of the image.  But the shape of
the field of view varies oppositely the title. Thus, with the barrel distortion the image resembles a
barrel, and the shape of the field of view resembles a pillow. With the pincushion distortion, the
image resembles a pillow, and the shape of the field of view - a barrel.

Lens distortion leads to warping:
 

shape of view area and field of view;
image from the camera;
distribution of the spatial resolution .

The Lens distortion should not be confused with the Perspective distortion (Fig. 7 ), which is
natural on all images obtained with wide-angle lenses. Perspective distortion does not change
pyramidal shape of the view area, rectangular shape of field of view and distribution of the spatial
resolution .

Barrel distortion

 

If by moving away from the center of the field of view the optical magnification decreases, then
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objects at the edges of the field of view seem compressed, and the spatial resolution decreases
from the center to the edges, and the field of view is stretched to the edges. Real angles in this
case are more than the calculated angles. This is called Barrel distortion. The Barrel distortion
is most common and usual for wide angle lenses.
 

In particular, the lens T2314FICS-3 has just the Barrel distortion. Let's consider a model of image
from this lens, the model of field of view, view area projections built with and without simulating
distortion. Position of the camera in both cases is constant.
 

Note the warping of distribution of the spatial resolution (Fig. 4 ). Barrel distortion increases
the field of view, but reduces the spatial resolution, the farther from the center of the field of view,
the stronger.

Without lens distortion
simulation

With simulation of barrel
distortion

Fig. 1,2. View of a cross-hatch. With barrel distortion the cross-hatch resembles a barrel.

Fig. 3,4. Field of view. With barrel distortion the cross-hatch resembles a pillow. The spatial
resolution decreases from the center to the edges.

655
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Fig. 5,6. View are and scene model.

Fig. 7,8. Camera image model. The slope of the men in the upper corners (Fig. 7) is caused not
by the lens distortion but by the perspective distortion, which is natural for any wide-angle
lens.

Fig. 9,10. View area projection. View area projection bounds  in the Projection mode.

Pincushion distortion

 

If by moving away from the center of the field of view the optical magnification increases, then
objects at the edges of the field of view seem stretched, and the spatial resolution increases from
the center to the edges, and the field of view is compressed to the edges. Real angles in this

173
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case are less than the calculated angles. This is called Pincushion distortion. The Pincushion
 distortion occurs seldom with teleobjective lenses.
 

Let's consider models built with and without simulating distortion. The models are given to illustrate
the pincushion distortion, they are not associated with a certain model of lens. Position of the
camera in both cases is constant.
 

Note the warping of distribution of the spatial resolution (Fig.14 ). Pincushion distortion
decreases the field of view, but increases the spatial resolution, the farther from the center of the
field of view, the stronger.

Without lens distortion
simulation

With simulation of pincushion
distortion

Fig. 11,12. View of a cross-hatch. With Pincushion distortion the cross-hatch resembles a pillow
.

Fig. 13,14. Field of view. With Pincushion distortion the cross-hatch resembles a barrel. The
spatial resolution increases from the center to the edges.
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Fig. 15,16. View are and scene model.

Fig. 17,18. Camera image model.  As the lens is teleobjective (narrow angles), the perspective
distortion is not unnoticeable (compare with Fig. 7 ).

Fig. 19,20. View area projection. View area projection bounds  in the 2 levels mode.

Modeling lens distortion in VideoCAD

 

Despite the complexity of internal calculations, simulation of lens distortion in VideoCAD is very
easy. The lens distortion in VideoCAD is defined by a combination of calculated view angle and
real view angle. The calculated view angles are calculated in the program from the lens focal
length  and format  or the actual size  of the image sensor.
 

The real angles are usually given in the specifications of cameras and lenses. If the angles are
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unknown, it is possible to get them by practical measuring .
 

To determine the lens distortion it is enough to set one of three real angles: horizontal, vertical or
diagonal. It is preferable to set the horizontal angle. Missed real angles will be calculated by
VideoCAD. For maximum accuracy, you can specify 2 or all 3 the real angles.

See more: Lens distortion , Modeling lens distortion , Measuring real view angles
See also: Specifying active area size of the image sensor
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12 Ordering and contacting

Contacting CCTVCAD Software

Order and Registration
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12.1 Contacting CCTVCAD Software

For the latest versions of our programs, please check our web site at
http://www.cctvcad.com

Any questions can be e-mailed to us at info@cctvcad.com
Technical questions can be e-mailed to us at support@cctvcad.com

We try to answer e-mail as quickly as possible.

You may also use our on-line form on our website http://www.cctvcad.com/CCTVCAD-Support.html.

Telephone support is available only by request. If you need telephone support, or just want to talk to
a live person, please contact us at one of the above addresses for the current hours of availability, as
they change often.

If you have ideas, suggestions, comments, criticisms, or questions, we would love to hear from you
about our programs! 

http://www.cctvcad.com
mailto:info@cctvcad.com
mailto:support@cctvcad.com
http://www.cctvcad.com/CCTVCAD-Support.html


Ordering and contacting 665

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

12.2 Order and registration

For the latest order options, visit the CCTVCAD Software web site at:

http://www.cctvcad.com/CCTVCAD-Order.html

For details of the registration please see VideoCAD registration procedure

http://www.cctvcad.com/CCTVCAD-Order.html
http://www.cctvcad.com/CCTVCAD-Registration%20procedure.html
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13 USB dongle

Dongle is a device used to protect applications and data against unauthorized usage and replication.
The dongle is attached to the computer's USB port.

VideoCAD 8 Professional can work only with USB Senselock dongle.
 

VideoCAD 8 Lite , VideoCAD 7 Starter  are registered only by personal registration code,
without dongle, without hardware locking. 

Dongle models
Operating instructions for USB dongles
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13.1 Dongle models

When ordering VideoCAD you can choose USB dongle from the following models:
 

The models differ in embodiment only. If you did not specify dongle model at your order, we will
choose model at our option. 

SenseLock EL-Genii
 

Senselock EL-Genii is featured as a cute, tiny
and fascinating gadget with fashionable color. Its
size is only 17x12x4mm, and weights 2.8 - 3.5g.
It is especially suited for notebook computers.

When any software with a common USB dongle
is used on a notebook computer, the dongle
often suffers unexpected impact or collision due
to its long body, which may lead to damage on
USB port. With a smart appearance and
exquisite body, Senselock EL-Genii effectively
avoids these situations, thus reduces the
possibility of damaging the computer and
secures the software running on it. 

SenseLock EL-STD
 

SenseLock EL-STD is a complete analog of
SenseLock EL-Genii, but in classic design. It is
suited for desktop computers.
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13.2 Operating instructions for USB dongles

Operating Instructions for USB Dongles

Dongle Operating and Storage Instructions
Possible problems
Warranty

Dongle Operating and Storage Instructions
 

1. Protect the dongle from physical damage (fall, toss, vibration, etc.), exposure to high and low
temperatures, aggressive environments, high voltage; all these may cause damage to the dongle.
2. Do not press too hard when connecting the dongle to the computer.
3. Do not expose the dongle (especially its connectors) to dust, dirt, damp, etc. In case dirt gets
into the dongle connectors arrange for their cleaning. Use a dry cloth to clean the case and
connectors. Never use organic solvents.
4. Do not disassemble the dongle. This may cause damage of the dongle's case, printed wiring
elements, and consequently lead to unstable functioning or failure of the  hardware.
5. In case of failure or improper functioning of the dongle, contact us.
 

Note: For stable functioning of the dongle it is required to use dongle driver. 
A set of drivers for various operating systems is supplied together with the VideoCAD.
The driver is installed automatically during VideoCAD installation. 
To install or reinstall driver manually choose All programs>VideoCAD>Dongle driver. Then choose
Install driver or Uninstall driver.

Possible problems
 

In case of any problems with USB dongle, first of all, do the following:
1. Stop VideoCAD, if it is running.
2. Disconnect the dongle from the USB port. 
3. Reinstall dongle driver.
3.1 Enter under LOCAL administrative account. No Domain account! 
3.2 Choose Start>All programs>VideoCAD8>Dongle driver
3.3 In the appeared box choose Install driver.
4. Connect the dongle to the USB port then follow the instructions .
 

If these actions don't solve your problem, try to install VideoCAD, dongle driver and the dongle on
other computer according to the instructions . 
 

Possible reason of problems is connected to installed dongle emulators for other software.

Warranty
 

The USB dongle is a material carrier of the VideoCAD license. In case of losing the dongle
the license is considered lost too. 

In case of dongle failure during one year after purchasing and the dongle has no any physical
damage marks, the Dongle can be exchanged free-of-charge.
In case of failure later than in one year after purchasing or the Dongle has physical damage marks,
the Dongle also can be exchanged, but after payment for the new Dongle and its delivery.
In any case sending the new Dongle can be performed only after receiving the broken one.
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1/1.8"     293

1/2'     293

1/2"     293

1/2.7"     293

1/3'     293

1/3"     293

1/3.2"     293

1/3.6"     293

1/4'     293

1/4"     293

10 layouts     215, 513

100 cameras     215

16:9     293, 431, 636

- 2 -
2 levels     171, 215

2 stage     480

2 stage+2 priority     480

2/3'     293

2/3"     293

- 3 -
3D constructions     357

3D H max     536

3D H min     536

3D image     169, 171, 213, 215

3D images     536, 548

3D model     169, 171, 213, 215, 549, 602

3D model height     171

3D model height above the ground     171, 283

3D model sizes     283

3D modeling     474, 480

3D modeling in VideoCAD     645

3D modeling layout     3

3D modelling     529
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3D models     89, 159, 213, 215, 357, 397, 475, 529,
531, 548

3D MODELS AND 3D Video     89

3D models of terrain     215

3D Models window     213, 215, 397

3D models-territories     602

3D navigation buttons     343, 404

3D object     536

3D objects     475

3D panel     480

3D translucent view area     215

3D Video     159, 169, 171, 213, 215, 357, 370, 529,
542, 546, 549

3D Video in separate thread     480

3D Video Main menu     359

3D Video size     385, 391

3D VIDEO WINDOW     89

3D view area     169, 171, 213, 215, 346

3D view areas     385, 611

3D visible     276

3D visualization     3, 89

3D Window     89

3D World     159, 169, 171, 213, 215, 342, 343, 346

3D WORLD WINDOW     89

3DS file (*.3ds)     599

- 4 -
4/3"     293

4:3     293, 431, 636

- 7 -
7 illuminators     566

768x576 pixels     408

- A -
a less capacity of detection     649

About camera sensitivity     331, 551, 651

About VideoCAD     213, 215

According to camera parameters     359, 371, 375,
381, 385, 391

According to camera parameters box     542

Active     276

Active area of image sensor     147, 636

Active area of the image sensor     636

Active camera     169, 318

active camera coverage     3, 89

actual image of test object     507

actual projection     289

Actual projections     536

Actual resolution     293

Actual view area projections     169, 171, 213, 215

ADC     381

Add     399

Add 3D model     213, 215

Add to DXF/DWG background     485

Add. cost 1..3     430, 431

Add. information     430, 431

Adding new 3D models     171, 215

Adding new 3D models to the library     215

Additional costs     431

additional elements     385

Additional features     430, 431

Additional illumination     566

Additional information     171, 213, 215, 293, 505, 509

Adjust background     215, 533, 631

adjust parameters of drawing export     485

Advanced     395

AES     331, 431

AESC     331, 339, 430, 431, 549, 551

After payment is confirmed     665

AGC     331, 430, 431, 549, 551, 567, 570

AGC (dB    

Max)     430, 431

ALC     339

Align     213, 215

Alignment     519

All cameras' cables     213, 215

All models     171, 419, 425

allow lens contamination     329

Already assigned shortcuts     479

Alt is pressed     162, 287

Alternating current     431

analog camera     585

Analog cameras     331, 431

Analog monitor     408, 417

analog recording     293

analog-to-digital conversion     331, 381

analyzing real images     494

Ang box     284

angle     169, 171, 213, 215, 282

angle between a direction on the camera and
horizontal     542



Index 675

© 2003-2016  CCTVCAD Software,   http://www.cctvcad.com

Angle of radiation     171, 215, 284, 562, 569, 570

Angle of radiation (deg.)     465

angle of radiation (degree     562

angle values     293

Angles of view (deg.)     430, 431

Angular     215

angular parameters     289

animated *.gif     357, 359, 412

animated gif     385

animated image     575

animated images     357, 407, 575

animated model of monitor     577

Animation     385, 408, 412, 577

Animation box     385

Any questions can be e-mailed     664

aperture     331, 454, 457, 536

aperture (F number)     651

Aperture (F)     430, 431

Aperture (f-number)     457

aperture changing     431

aperture corrector     331, 381, 431, 558

Aperture in Wall     169, 171, 213, 215, 280, 531, 536

Aperture limits     339, 549

aperure     549

Apply     558

Apply res.     318

Approximate calculation of IR illuminator     562

Approximate calculation of visible light luminaire    
562

Arc     169, 171, 213, 215

arrow keys     287

articles     649

AS4806     89, 215, 316

aspect ratio     89, 291, 308, 430, 431, 523, 636

Aspect Ratio of  active area of Image sensor     523

Aspect Ratio of Image sensor     89, 523

aspect ratio of output image     89

aspect ratio of the active area of the image sensor    
308

Aspect ratio of the output image     293, 308, 523

Assign     318, 425, 479

Assign model     425

assign new shortcuts     479

Assign to selected cameras     171, 289

assigned shortcuts     479

Assigning the pattern to cameras     326

At grid     215

At layout size     352

attenuate sensitivity     554

attenuation filters     554

Author     519

AUTO     293, 318, 326, 391, 457

Auto Iris     339

Auto iris amplifier DC     331

Auto Iris DC     430, 431

Auto Iris DC -Level+     331

Auto Iris lens     457

auto saving     490

AutoCAD     89, 147, 215, 531

AutoCAD blocks     89, 215

AutoCAD DWG     3, 89, 599

AutoCAD DWG/DXF     215

AutoCAD DXF     354, 485, 599

AutoCAD format     533

AutoCAD unit per meter     485

auto-dome camera     431

AutoDome cameras     431

Autofocus     430, 431

Automatic flip     431

Automatic focusing     431

automatic gain control     331, 549

automatic grid step selection     171

Automatic white balance     431

Autosaving     89

auxiliary constructions     289

average     339

Average brightness     554, 567, 570

average values of light efficiency     463

AWB     430, 431

axial light intencity (candel)     562

axial light intensity     461, 465

Axial light intensity (cd)     465

Axial radiant intensity (watt/steradian)     562

Axial rotation angle     291, 293

- B -
B/W     331, 431

Back light compensation     331, 431

Back view     343, 404

background     147, 215, 357, 359, 385, 531, 542

Background illumination (lx)     371, 549

Background illumination panel     371

background in AutoCAD     215, 631

Background light source     371, 549

Background only     213, 215
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Background res.     480

background resolution     359, 385

Backgrounds     162

barrel distortion     89

Base height     89, 291, 293

base heights     162

base point for the copying     536

base points     162

Basic parameters of camera     452

big size drawings     485

bitmap     531

bit-mapped fonts     477

black line     162

black&white     431

Black-and-white     213, 215

black-white     329

black-white mode     331

Black-white sensor sensitivity     469

BLC     331, 430, 431

BLC type     331

Blend/Hatch     318

BMP,WMF,EMF,GIF,TIF,PNG,JPG     485

BMP,WMF,EMF,GIF,TIFF,PNG,JPG,rPDF     89

Bold     477

bold parameters     430, 431

bottom     507

bottom of the graphics window     275

Bottom view     343, 404

bottom-left corner     274

boundary resolution     454, 457, 536

brand of cables     590

brightness     359, 381, 385, 480, 542

brightness drops     293

brightness limitation     560

Bring to front     213, 215

buttons of Constructions group     536

By calibrated attenuation filter     554

By calibrated manual iris lens     554

By limiting exposure time of electronic shutter     554

- C -
Cable     475, 590

Cable box     590

Cable brand     514, 515

Cable laying     213, 215

Cable report     89, 213, 215, 590

cable segment     515

Cables     162, 213, 215

cables of loaded camera     171

Cables only     517

Cables summary     519

Calculate from spectrum     463

Calculate shadow for active camera     490

Calculate shadow for active camera once     490

Calculate shadow from 3D models     490

Calculate shadows for active camera     213, 215

calculated parameters     289, 293

Calculating lengths of cables     590

Calculating lengths of cables and getting Cable report  
  527

CALCULATING SHADOWS IN THE VIEW AREA    
89

calculation method     536

Calculation of camera view area parameters     527,
534

Calculation of cameras' parameters and choice of their
relative locations     527, 536

Calculation of horizontal projections of person
detection    

identification and license plate reading areas    
649

calculation of IR illuminator     562

calculation of shadows from 3D models     580

Calculation of variants of cameras placing     536

calculation of visible light luminaire     562

calculation with incorrect values     289

Calculator     308, 523

calibrated lens     554

Calibrated manual iris lens     554

Call Help information     287

Camera     213, 215, 329, 331, 359, 370, 375

Camera and Illuminator     474, 483

Camera contol area     147

camera degradation     329, 480

Camera field of view     147

Camera Geometry     169, 171, 213, 215, 529

Camera Geometry box     289, 505, 534, 536, 542

Camera icon     485, 626

Camera installation height     529

Camera installation parameters     291, 293

Camera installation parameters (Geometric
parameters)     452

Camera list     159, 169, 171, 213, 215, 509

camera manual     293

Camera model     425

camera name     162
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camera names     213, 215, 477

camera number     171

Camera panel     549

Camera parameters     291, 293, 452, 534, 542

Camera resolution     293

camera rotation     89, 616

camera sensitivity     551

Camera sensor spectral sensitivity     371

Camera tilt angle     147, 289, 291, 293

camera type     509, 570

camera view angles     431

Camera view area     147, 645

camera voltage supply     515

Camera with attenuated sensitivity     554

camera with the minimal number     287

CAMERA, LENS AND DVR PARAMETERS     89

Cameras     89, 162, 357, 385, 519

cameras of extended quality     293

Cameras over constructions     213, 215

Cameras summary     519

Cameras view area     357

cameras with extended dynamic range     651

candela     465

candelas     469

captured by fields     381

cars with license plates     171, 215

Case     430, 431

CCD image sensor     375

CCD sensor     585

CCIR/PAL     431

CCTV design using Monitor window and PTZH frame  
  527, 546

CCTV project     548

CCTV projectExample 9  Choice of camera model
according to known scene illumination     527

CCTVCAD Lab Toolkit     551, 554, 558, 567, 570

CEA 639     331, 431, 651

Center     331

CGM     215, 485

change 3D model height     215

Change installation height     169, 171, 213, 215, 529

change lens focal     293

change lens focal length     529

Change line type     213, 215, 483

Change parameter     450

Change view area lower bound     169, 171, 213, 215

Change view area upper bound     169, 171, 213, 215,
536

CHANGES     89

changes radically     289

Changes the selection logic     287

changing aperture     431

Changing column width     422, 445

changing lens focal length     431

Changing row height     422, 445

changing the scale     162, 287

chart lines beating     558

Checking Depth of Field in horizontal projection     527

Choice of camera installation height and parameters    
527, 529

Choice of camera model according to known scene
illumination     527, 549

Choice of cameras' quantity and location     527, 531

Choice of cameras' quantity and location on the
original layout     527, 533

Choice of luminaire power and location     527, 566

choice of sensitivity value     651

choose a layout     513

choose USB dongle     670

Choosing install location for PTZ camera     527

chrominance     542

CIE 97     465, 480

CIE spectral response     551, 560

Circle     169, 171, 213, 215

clean environment     480

Clear     412

Clear cell     415

Clear filter     422, 445

Close     448

CMOS image sensor     375

CMOS sensor     585

codepage.     519

color     276, 329, 331, 430, 431, 475, 542

Color cameras     469

color filters     469

color of 3D objects     475

color sensors     472

color temperature     331, 431, 469, 472

Colors of regions     318

Colors of regions button     318

COLORS, FILLING AND HATCHING OF VIEW AREA
PROJECTIONS     89

comb filters     381

Combine to block     213, 215

Commands box     479

Common number     511

Common scale     485
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Common scale (unit/m    

unit/ft.)     485

Compatiability with AutoCAD versions     147

Compatible equipment 1..3     430, 431

Compatible software 1..3     430, 431

Compress columns     425

Compress/Expand     425, 448

compression     359, 381, 395, 430, 431, 480, 542

Compression rate     293

computer buzzes     395

Concentration     465, 562, 569, 570

conductor material     515

conductor temperature     515

Connect all cameras to this monitor     546

Connection of cameras     417

Connectors     430, 431

Considerable discounts     665

Constant coordinate system     162

Constructions     162, 213, 215

consumed electric power     570

Consumed electrical power     562

Consumption     430, 431

Contact us     213

Contacting CCTVCAD Software     664

Contast     385

context-sensitive help system     155

contrast     359, 381, 480, 542

Contrast %     430, 431

contrast loss of 10%     558

Control     430, 431

Control area horizontal projection     147

control area projections     580

control mouse more precisely     490

convenient at navigation     162

Coordinate system fixed to the loaded camera     162

coordinate systems     162

Coordinates of Illuminator     284

Coordinates of Illuminator in horizontal projection (C)  
  284

copper     515

Copy     162, 169, 171, 213, 215, 536

Copy selection     428, 450

Copy to All models     425

Copy to clipboard     213, 215, 354, 359, 509

Copy with base point     213

copying the image     417

Cost     430, 431

counting of the cursor current coordinates     162

Cover     519

Coverage     346

cracking software protection     665

create    

and rename layouts     274

Create a new camera model     425

Create camera     549

Create new camera     171, 215

create new layout     513

Create new project     215

Creating animated model of monitor     527

CREATION OF ANIMATED IMAGES     89

Creation of animated monitor     417

Criteria     213, 215, 316, 500, 503

Criteria editing box of license plate reading area    
159, 505

Criteria editing box of person detection area     159,
498, 505

Criteria editing box of person identification area     159,
505, 542

Criteria of person detection     331, 381

identification and license plate reading     452

criteria of the person detection     293

criteria values     498

criteria-editing box     495

criteria-editing box of license plate reading area     497

criteria-editing box of person identification area     496

Crop     308, 523, 636

Crop factor     89, 308, 431, 636

Crop, calculation     523

Crop-factor     523

Ctrl     162, 215, 287

Ctrl is pressed     171, 287

Ctrl+A     215, 287

Ctrl+Spacebar     287

Ctrl+TAB     287, 513, 536

Curr. aperture     339

Current     331

Current (A)     430, 431

Current AGC gain (dB)     452

Current angles of view     452

Current aperture     452

Current aperture value     339

Current construction parameter panel     279, 284,
529, 536, 562, 566

Current construction parameters panel     161

Current construstion parameters panel     282

current coordinate of the cursor     275

Current Electronic shutter exposure (1/s)     452
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Current exposure time     331

current font type     281

Current image resolution     385

Current image sizes     359, 385

current layout     162

Current lens focal length (mm)     452

current line type     280

current scale factor     275

Current signal/noise ratio (dB    

unweighted)     452

Currently assigned to box     479

cursor     275

Customizable shortcuts     287

Cut     169, 171, 213, 215

Cut selection     428

Cut with base point     213

Cuttin     352

Cutting     342

Cutting on Height     352

Cycle     554, 567, 570

- D -
dark blue lines     289

Dash     475

DashDot     475

DashDotDot     475

Data     425, 448

Database of camera models     3

Date     519

day     371

Day and Night     519

Day and Night tabs     371

Day/Night     329, 331, 359, 408, 412, 431, 469, 548

day/night cameras     472

DC     339

Default     457, 474

Default line type for 3D models     475

Default line type for cameras     171

default parameters     515

Degree of gamma correction     331

degrees     289

deinterlacing     381

DEL     287

Delete     162, 399, 425

delete a layout     513

delete all images     417

Delete background     213, 215

Delete model     425

Delete selected objects     287

Delete selection     428

Delete table view     448

delete the image     417

Delete view     425

demo-version     548

Depth cutting     352

Depth of Field     169, 171, 213, 215, 395, 454, 592

Depth of Field  box     592

Depth of field box     454

Depth of field calculation box     159, 454, 536

Depth of Field in horizontal projection     592

DEPTH OF FIELD IN THE HORIZONTAL
PROJECTION     89

depth-of-field     359, 375, 536

depth-of-field modeling     359

Depth-of-field parameters     452

Description     452

Description of all cameras     546

Design operator interface     3

Destroy     213, 215

Destroy block     213, 215

detailed analysis of view area     162

Determining person identification criteria by a real
image     527, 542

Determining spectral efficiency of light source     527,
567

Determining the Person identification criteria by the
image model     542

Determining the quality parameters of the image model
    542

Differences between versions of VideoCAD     53

Differences between VideoCAD 7 Starter II and
VideoCAD 7 Starter     53

Differences between VideoCAD 8 Lite and VideoCAD
Starter II     53

Differences between VideoCAD 8 Professional and
VideoCAD 8 Lite     53

different icons     483

different type hatchings     171, 215

diffused light     284

Digital  ZOOM     391

Digital cameras     431

digital image processing     431, 651

digital recording     293

Dimension     546

dimension lines     289

Direct current     431
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direct light     171, 284, 461

direction of the camera lens     162

Directories panel     399

dirty environment     480

Disable image processing     359, 395, 480

Discrete color     580

dispersion     461

Dispersion combo box     284

Display camera type     509

Display Properties     395

Display resolution     293

displayed information     162

Distance     215, 569

Distance (m. or ft.)     465

distance between camera location and test object    
507

distance to the camera location     275

distortion     430, 431, 490, 619

distortions of moving objects     585

Document     519

Dome     215, 583

dome camera     431

DOME-cameras     293

Dongle driver     671

dongle driver setup     665

dongle failure     671

Dongle models     670

Dongle Operating and Storage Instructions     671

dongles     671

Double line     169, 171, 213, 215

double-clicking the camera lens     171, 215

drag     162

Draw 3D Video in separated thread     395

Drawing     213, 215, 519

drawing export     485

Drawing of cameras' placement     546

DSP     430, 431

Dupl     399

DWG     215, 599

dX.Y     293, 308

DXF     215, 354, 599

DXF,DWG,PLT,CGM,SWF,vPDF     89

dynamic range of camera     331

- E -
easy day/night     331, 431

Edit     213, 215, 412, 425, 562

Edit  button     282

edit any parameters of construction     282

Edit font type     281

Edit line type     280

Edit loaded camera     162, 169, 171, 213, 215

Edit parameters of camera model     425

edit texts     162

Edit/Save     318

editing a rectangle or a mask     287

editing rectangle     287

editing state     162, 215

editing text     281

Editing the Spatial resolution pattern     326

effective pixels     431

Efficiency factor     465, 469, 562

Efficiency of the luminaire     465

EIA 1956     558

EIA/NTSC     431

EIA1956     89, 357, 359, 385

either lorries     497

electrical parameters     515

electronic shutter     331, 549, 554

EMF     485

Empty     422, 445

EN 50132-7     215, 316

EN50132-7     89

Enable navigation     404

Enabled     276

Environment     430, 431

Environment temperature range     431

equivalent illumination     570

Erase     169, 171, 213, 215

Erase all     213, 215

errors are visible on the image     395

Errors in 3D Video     395

Errors in rendering 3D images     395

ES     331, 430, 431

ESC     171, 287

especially crucial cases     649

Example 1     529

Example 2     531

Example 5     536

example of a video surveillance system project     548

Example of numeration     511

Examples directory     548

Examples of luminaire calculation     527, 562, 566

Examples of work with VideoCAD     527

Excel     419, 425, 443
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Exclude blinking     490

exemplary images     542

Exit     213, 215

Export     3, 213, 215, 419, 425, 443, 448, 474, 485

Export 3D view areas     354, 611

Export coverage     354

Export selection     428, 450

Export tab     485

Export table of camera models     425

Export to *.html     412, 577

Export to AutoCAD     89

Export to BMP    

EMF     485

Export to DXF     485

Export to Text     213

Export to VideoCAD3..6     213, 215

Exposure     359

exposure (ms     549

Exposure (ms)     331, 375, 430, 431, 585

exposure time     331, 357, 359, 375, 585, 593

Exposure time (milliseconds)     385

Exposure time limits     331

Extension     215

ExView     331

ExView HAD ™ CCD     431

eye contrast sensitivity     359

- F -
F number     651

F1     155, 159, 287, 443, 450

F1.2     549

face height     500

Faces     404

Faces and Edges     401

familiar or unfamiliar people     649

far space limit     480

feet     289

Field of view     318

field of view size     316

Field-of-view height     318

Field-of-view size     213, 215

Field-of-view size in point     169, 171

Fill projections     169, 213, 215

Fill Title-Block     215

Filling     169, 171, 213, 215, 580

Filter transmission coefficient     554

filtering     419, 443

Filtering by parameter value     422, 445

Find on layouts     415, 509

Find text     213, 215

finite total light flux     284

First registration     665

First registration key     665

fisheye     308, 438, 626

fix some parameters of construction     282

Fixed    

Mini     430, 431

Fixed iris     339, 549

Fixed views buttons     343, 404

Flip     430, 431

Flux/Illum. check box     284

F-number     339

Focal length     308, 430, 431

Focal plane     169, 171, 213, 215

Focus     430, 431

Focus distance     454, 457

focus plane     454, 475, 592

Font (codepage)     519

font color at printing     477

font color on the screen     477

Font height     519

font height in inches     477

Font type name box     281

Font type number box     281

Font type panel     161, 279, 281, 474

font typeface     477

font types     281, 474

Fonts     477

foot-candela     465

Form     430, 431

Format     308, 430, 431

format of measurements     215, 318

formatting your hard disk     665

Frame     519

frame rate     283, 357, 375, 575

Frame rate (fps)     359, 385

frame reading time     596

Freeze columns up to selected one     428, 450

From left to right     511

From top to down     511

front nodal point     622

Front view     343, 404

full frame or one field     542

full light flux     463

full screen     412, 507
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full version     548

full version of VideoCAD     665

fully closed aperture     339

fully opened aperture     339

Functions of mouse buttons     404

- G -
Gamma     331, 430, 431, 480, 549

gamma correction     549

General information on VideoCAD     3, 31, 45, 49

general view     391

genlock     431

geometrical and resolution parameters     507

geometrical distortions     649

Get from modeling     375

Getting started     155

GIF     485

Global shutter     585

Global snaps     169, 171, 213, 215

Google SketchUp     599

Graphical calculation of depth of field     536

graphical depth of field calculation     275

graphical edit state     507

graphical editing state     162, 171, 454

graphics area     161, 162

graphics card driver     395

graphics card features     395

graphics methods     536

Graphics window     161, 162

graphics window menu     287

graphics window size     275

green dash lines     289

green frame     391

green grass     570

grey     289

grey boxes     329

Grid     213, 215, 357, 385, 475

Grid selected step box     169, 171

grid step     215, 359, 385

ground     162

Ground color     480

Ground indication     475

Ground panel     346

ground projection of camera lens main optical axis    
507

Ground surface     357, 359, 385

- H -
H (%)     519

half frames     359, 381

halogen incandescent lamp     331, 431, 469, 472,
567, 570

hardware acceleration     395

Hatch and dash lines     485

Hatch style     171

hatching     215

hatchings     171

head of person     495

headgear     649

Height     276, 282, 318, 457, 477, 519

height above the ground     275, 507

Height above the ground (Height)     284

Height cutting     401

Height indication     475

height of camera installation     359, 385

height of depth of field measurement     592

height of illuminator     284, 566

height of installation     291, 293, 529

height of the 3D model     215

Height of view area lower bound     291, 293

height of view area upper bound     291, 293, 542

height.     507

Help     213, 215

Help Contents     213, 215

Help of parameter (F1)     419, 428, 443, 450

HI AGC     651

HID     665

HID identifies basis     665

HID is lost     665

HID might be lost     665

Hidden     276

hidden objects     215

hidden state     162, 215

Hide     162, 213, 215

hide any projection     162

Hide background     213, 215

Hide columns     425, 448

Hide horizontal projection     162, 169, 171, 213, 215

Hide panel     280, 281

Hide selected columns     425, 428, 450

Hide vertical projection     162, 169, 171, 213, 215

high  AGC gain     651

High AGC     331, 431
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high resolution     331

high resolution *.emf     215

high resolution monitors     490

High resolution on top     89, 215

high vehicles     497

high-frequency component     381

high-resolution cameras     536

hight resolution images     357, 381, 385

Hight resolution on top     213

hints     275

Home Office Guidelines for identification     316

Home Office Scientific Development Branch     215,
316

Homepage     213

Horiz. only     431

horizontal black line     289

Horizontal bounds     475

Horizontal line     169, 171, 213, 215

Horizontal number of pixels     385

Horizontal only     430

horizontal projection     275, 287

horizontal projection of view area     534

horizontal red line     162, 318

horizontal resolution     331, 536, 542

Horizontal resolution (TV-lines)     430, 431

Horizontal size     542

Horizontal smoothing     381

HTML file     577

human body     469, 570

human eye     371

human eye spectral sensitivity     472

hyperfocal distance     454, 457, 536, 592

- I -
I/O     431

icons of cameras     431

ID     404

identification     505, 542, 649

illumination     371, 395

Illumination (lux)     465

Illumination and camera sensitivity in CCTV     645

IllUMINATION AND LUMINARIES     89

Illumination at distance     465

illumination from the tested lamp     567

illumination from tungsten halogen lamp     567

illumination is insufficient     566

illumination modeling     566

Illumination modeling panel     480

illumination with filter     554

Illumination(lux)     284

Illuminator     169, 171, 213, 215, 284, 562, 566

Illuminator calculation     284, 461, 463, 465, 469, 562,
566, 569

Illuminator calculation box     159, 570

Illuminator calculation button     461, 562

Illuminator height above the ground     215

Illuminator icon     485

Illuminator icon (unit)     485

Illuminator parameters     461

Illuminators     359, 371, 385, 548

Image     359, 385

Image analyzer     159, 213, 215, 494, 551, 558

Image analyzer utility     570

Image compression     385

Image generation time     359

image in the 3D Video     359

image model     549

image of camera view area     289

Image paramerer panel     542

Image parameter panel     371, 381, 385, 536, 542,
549, 566

Image perameter panel     370

Image pixel beating     558

Image processing parameters     381, 542

image quality in the 3D Video     395

Image sensor     308, 430, 431, 472, 523

Image sensor calculator     89, 159, 308, 523

Image sensor format     291, 542, 548

image sensor format (type)     636

Image sensor model     431

Image sensor size     147, 291, 293, 308, 431, 534,
536, 542, 548, 636

Image sensor sizes     89, 308

image sensor type     469

Image sensor's active area     308, 523

Image size     381, 536

Image size in the 3D Video     357, 381, 385

Image size panel     558

Images     519

Images of video surveillance system     546

Imperial     215

Import     3

IMPORT AND EXPORT     89

Import DXF/DWG background     213, 215

Import from VideoCAD3..6     213, 215
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Import of 3D models     599

Import of 3D models and scenes from 3ds max to
VideoCAD     171

Import of 3D models from Google SketchUp     527

imprecise pointer devices     490

In construction mode     282

In Edit mode     282

Incandescent lamps     472

Incl     284

inclination angle     215, 566

Incline     401

Inclined rectangle     169, 171, 213, 215

incorrect value     289

increased relative IR sensitivity     331

increasing exposure time     651

individual case     649

infra-red (IR) illuminators     284

infra-red filter     331

infra-red LED illuminators     431

INHERITED ELEMENTS     89

Inner faces     346

input camera parameters     443

input-output     431

Insert in report     457

Insert model     399

Insert rastrer images     485

Install driver     665, 671

install location for PTZ camera     583

installation height     534, 536, 542

Installation parameters     534

IntelliMouse     162

interchange images' positions     417

Interface     89, 159, 474, 490

INTERFACE IMPROVEMENTS     89

Interface of the Table of camera models     421

Interlace     375

interlace distortions     357

Interlace scan     359, 381, 585

Interlaced     431

interlaced fields     542

interlacing effect     381

internal     431

Internet link     428, 430, 431, 450

inverse-square law     284

Invisible buttons     489

IP camera     585, 593, 596

IP cameras     331, 375, 381, 431, 651

IP cameras sensitivity     551

IR corrected lenses     431

IR correction     430, 431

IR filter     469, 472, 651

IR illumination     371

IR illuminator     570

IR illuminators     469

IR LED     430, 431, 469

IR radiation     469

IRE     331, 385, 430, 431, 549, 651

IRE at the minimum illumination     551

IRE of the image     359

IRE of video signal     431

Iris     430, 431

Iris control type     431

Iris type     339

irradiance     284, 570

ISO 12223     385

ISO/IEC 19794     89, 215, 316

IT CCD     651

Italic     477

iterative algorithms     649

- J -
JPEG     381

JPG     485

- K -
Kell factor     457

Key feature     430, 431

Keyboard     474, 479

keyboard shortcuts     161, 287, 479

Keywords     519

- L -
lack of image     395

lamp aging     480

Lamp panel     463

Lamp parameters     461, 463

Lamp position     359, 371

Lamp power     569, 570

Lamp power (watt)     463, 562

Lamp quantity     465, 562, 569

lamp specification     463

Lamp spectrum analyzer     159, 213, 215, 494
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lamp supply voltage     560, 567

Lamp type     463, 569, 570

Lamp type combo box     562

lamp with full light flux of 1000 lumen     465

lamp without reflector     465

Language     213, 215

latest versions of our programs     664

laws of geometrical optics     649

Layer;     452

layers     89, 159, 161, 169, 171, 215, 276, 600

Layout     162, 274, 452

Layout size     343

Layout tabs     161, 274

Layouts     159, 213, 215, 513, 519

LED     562

LED efficiency factor (watt/watt)     469

LED quantity     562, 570

Left click     391

Left view     343, 404

leg     495

length     282

Length calculation of line segments     159, 213, 215,
517

length of the velocity vector     283, 577

Lens     308, 329, 339, 430, 431

lens aperture     431, 548, 651

Lens aperture (F)     651

Lens calibration     554

lens distortion     3, 89, 308, 391, 619

lens focal length     169, 171, 291, 293, 359, 385, 454,
529, 534, 536, 542, 548

lens focal plane     215

Lens format     293, 431

Lens infra-red correction     431

lens manual     293

Lens mount type     431

Lens panel     549

Lens type     431

-Level+     339

Licence plate and test chart antialiasing     480

license plate area projection     497

license plate height     503

license plate in the 3D Video     480

License plate of cars     215

license plate reading     505, 542

License plate reading area     169, 171, 213, 215, 497,
503, 534

License plate reading area projections     475

License plate reading area size box     159

license plate reading areas     548

license plate reading criteria     497

LIDC     171

Light     346, 401

Light efficiency     463

Light efficiency (lm/watt)     463

light flux     472

Light flux (lumen)     284

Light flux (lumen)/Illumination(lux)     284

Light flux emitted by Illuminator (lm)     465

Light flux emitted by lamp (lm)     463, 562

Light intensity (cd)     465

Light intensity curve     562

Light intensity curve with lamp with full light flux of
1000 lumen     562

light intensity curves     465, 569, 570

Light intensity distribution curve     171, 215, 562

light reflected from the environment     569

light sensitivity     548

light source     331, 431

light sources     371

lighting     649

Lighting intensity level     293

line color at printing     475

line color on the screen     475

line design     475

line pair per millimeter     89

line pair per mm     430

line pairs per millimeter     339, 431

Line segment     169, 171, 213, 215, 590

Line spacing     519

line type     475, 517, 529, 590

Line type name box     280

Line type number box     280

Line type panel     161, 279, 280, 474

line types     162, 280, 474

line types as cables     517

line types for displaying the system objects     475

Line weight unit/pixel     485

line width at printing     475

line width on the screen     475

linear parameters     289

linelock     431

Lines     215, 475

lines of double thickness     162

Lines per picture height     89, 430, 454

lines per pixture height     385
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List of directories     399

live image     293

live monitoring     293

Live Video Analyzer     159, 213, 215, 494, 554, 567,
570

llumination without filter     554

LO AGC     331, 431

Load     399, 415, 425, 558

Load background     213, 215, 533

Load model database     425

Loaded camera     169, 171, 275, 507, 509

Loaded camera cables     213, 215

Loaded camera group     162

Loaded camera name     359, 385

loaded state of camera     162

Local snap     536

location plan of site     533

Lock     401

Lock constractions     213, 215

Lock panel     343

Logo     519

long-focus  lenses     536

long-focus lenses     454

Look around     89, 343, 404

looking upwards     649

losing the dongle     665, 671

low light conditions     651

low vehicles     497

lower limit of illumination     551

lower-range value     554

Low-frequency oscillator     596

lp/mm     339, 430, 431

LPH     89, 359, 385, 430, 431, 454

LPH - lines per picture height     147

lumens     469

lumens/watts     463

luminaire dirt depreciation     480

Luminaire panel     465

Luminaire parameters     465

luminance     542

luminescent     472

lux     465

luxes     469

Luxmeter     551, 560, 567, 569, 570

luxmeter sensitivity     472

luxmeter sensor     554, 567

luxmeters     554

- M -
M.O.D.     430, 431

M12     551

Main cables     590

Main menu     161, 479

main optical axis     162, 215, 293, 507

maintenance cycle     480

maintenance factor     566

Maintenance factor of cameras     329, 331, 480

Maintenance factor of illuminators     465, 480, 562

maintenance factors     549

Make the button invisible     489

Make the button visible     489

Manual Iris     339

Manual Iris Lens     567, 570

Margins     485

Mask     169, 171, 213, 215

Mastering VideoCAD     649

material carrier of the VideoCAD license     665, 671

Mathematical precision in VideoCAD     649

Max. AGC gain parameter     651

Max. frame rate (fps)     430

Max. humidity (%)     430, 431

Maximal angle between a direction on the camera and
horizontal     500

maximal distance of surveillance     293

maximal distances of the person detection     293

maximal F number     431

Maximal focal length     431

Maximal height of identification     500

Maximal height of license plate reading     503

Maximum     331, 391

Maximum AGC gain     331, 431

Maximum aperture     431

maximum aperture value     339

Maximum distance     89

Maximum distance of drawing view area     291, 293

Maximum height     475

maximum height of 3D construction     536

Maximum horizontal resolution     359, 385

Maximum humidity     431

Maximum level of brightness     551

maximum realistic quality     395

maximum scene illumination     331, 560

Maximum signal/noise ratio     560

measurement results     275
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measurement system     289

Measuring camera resolution     527, 558

Measuring camera sensitivity     527, 551

Measuring exposure     593

Measuring filter transmission coefficient     554

measuring formats     465

measuring illumination     551

Measuring low illumination     527, 551, 554

Measuring maximum scene illumination for a camera  
  527, 560

Measuring parameters of IR illuminator     527, 570

Measuring projector parameters     527, 569

Measuring real view angles     622

Measuring rolling shutter     596

measuring sensitivity     554

Medium fog    

strong snowfall     359, 371

Medium snowfall    

weak fog     359, 371

megapixel images     359, 573

megapixel resolution     391

Menu box     479

mercury high pressure lamp     549

Merge contour     213, 215

merging the cells     417

Meteorological visibility     359, 371

meters     289

Metric     215

Microphone     430, 431

middle mouse button     287

millimetres     507

Min. (F)    

Max. (F)     430, 431

Min. (mm)    

Max. (mm)     430, 431

Min. illum.     339

Min. illum. (lx)     331

Min. scene illumination (lx)     430, 431

mini-camera     431

mini-lens (M12)     554

mini-lenses     551

Minimal and maximal height     171

minimal F number     431

Minimal focal length     431

Minimal height of detection     498

Minimal height of identification     500

Minimal height of license plate reading     503

minimal number of pixels     331

minimal resolution     558

Minimal vertical resolution     498

Minimal vertical size of face image     500

Minimal vertical size of license plate image     503

Minimum aperture     431

minimum aperture value     339

Minimum distance     431

minimum exposure time     331

Minimum height     475

minimum height of 3D construction     536

Minimum illumination (lux)     651

minimum scene illumination     331, 549, 551, 554

Minimum scene illumination (lux)     651

Minimum scene illumination (lx)     549

Minimum vertical resolution     536

minus on the digital keypad     287

Mirror     169, 171, 213, 215

Miscellaneous     89, 474, 490

Model     359, 397, 399, 430, 431

Model color     431

Model combo box     329

Model cost     431

Model illumination     359, 371

Model illumination box     549

model monitors     407

Model name     431

Model of loaded camera     169, 171

Model panel     399

Model perm.     375, 585

Model permanently     359

Model sizes     431

Model space     395, 480

model video quality     357

Model weight     431

Modeling camera sensitivity     549

Modeling megapixel images     359, 527

MODELING MOVEMENT     89

modeling of resolution reducing     651

MODELING RESOLUTION     89

MODELING RESOLUTION OF MEGAPIXEL
CAMERAS     89

Modeling scene illumination     549

modern operating systems     649

Monitor     577

Monitor correction factors     490

Monitor diagonal     408, 417, 490

Monitor dimension     408, 417

Monitor list     408
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Monitor resolution     408

Monitor size factor     490

Monitor window     159, 169, 171, 213, 215, 407, 412,
415, 417, 546, 548, 577

Monitor window Main menu     412

Monitor window Pop-up menu     415

Monitor window Tool bar     408

More precise calculation of IR illuminator     562

More precise calculation of visible light luminaire    
562

Motion blur     375, 585

Mount     430, 431

Mouse     159

mouse wheel     162

Move     89, 169, 171, 213, 215, 343, 404, 536

Move background     213, 215

Move drawing     169, 171, 213, 215, 287

move drawing in the Graphics window     287

Move loaded camera     169, 171, 213, 215, 536

Move loaded camera name     213, 215

move the camera     529

Move to active layer     169, 171, 213, 215

moving 3D models     215, 375

Moving columns     422, 445

MS Excel     509

MS Word     509

MTF     89

multi-layer     215

multi-level projects     600

Multiply resolution     354, 401

Multizone     331

- N -
N/A     331

Name     276, 430, 431, 452, 475, 477

Name of Spatial resolution pattern     452

name of the font type     477

Name of the layout     385

name of the line type     475

names of project     215

narrow angle illuminator     570

Navi (navigation)     397

Navigation     342, 343, 404

near space limit     480

neglect illumination diminishing     284

neutral density optical filters     554

New     169, 171, 213, 215, 425

new camera     171

NEW FORMATS OF IMPORT AND EXPORT     89

NEW IN TABLE OF CAMERAS AND TABLE OF
CAMERA MODELS     89

NEW IN THE MONITOR WINDOW     89

NEW OBJECTS AND TOOLS     89

NEW PROJECT FORMAT     89

new project name     215

New shortcut key     479

Next cell     408

next layout in turn     287

Next screen     408

night     371

Night tab     549

night vision modes     651

no numerical values in the box     496, 497

nodal point     622

noise     480

non-round symmetrical light intensity distribution    
465

nonscalable     485

Nonscalable fonts     485

nonscalable icons     485

Nonscaleable fonts     485

non-standard     293

nonstandard image sensors     431

Normal     480

Normal AGC     651

normal AGC gain     651

normal environment pollution load     480

normal state     162

Not empty     422, 445

notch (not comb) filters     542

noth filters     381

NTSC     331

NTSC system     431

Number     452, 475, 477

number of effective pixels of image sensor     542

number of external factors     649

Number of frames     385

Number of lamps     465

number of lamps in the luminaire     562

number of LEDs in the illuminator     562

number of physical pixels     626

Number of pixels     331, 430, 431, 542

number of pixels of output image     381

Number of pixels of the image sensor     536

number of rows in the frame     596
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number of the displayed font type     477

Number.bmp     171, 480

numbers of effective pixels     331

numbers of pixels     585

Numerate     511

Numerate cameras     213, 215, 509, 511

Numerate cameras tool     215

Numeration order     511

Numeration pattern     511

numerical values     649

Numerical values criteria of person identification and
license plate reading.     649

- O -
object     162

Object height     318

Object height (width)     318

objects     162

obtaining different reports     443

Off     391

Omnidirectional light source     465, 562

On     391

On all layouts     511

ON check box     284

On sensor     331

ON/OFF grid displaying     169, 171

ON/OFF mode of automatic grid step selection     169,
171

One field     359, 381, 542

on-line form     664

Open     213, 215

Open earlier saved project     215

Open GL     395

Open Internet link     428, 450

Open Type     477

OpenGL hardware support     395

Opening Monitor window     417

Operating instructions for USB dongles     671

operating system     649

operator's workplace     407

Optical axis     169, 171, 213, 215

optical center     622

Options     213, 215, 474, 479, 480, 483, 485, 490

Options box     159, 280, 281, 474, 475, 477

Orbit     89, 343, 404

Order     213, 665

Order and registration     665

Order by ascending     422, 445

Order by descending     422, 445

orientation of the second line     287

Origin     213, 215

origin coinciding with the loaded camera     275

origin of coordinates     162, 275

Oscilloscope     596

Other     430, 431, 519

outdated graphic card     480

outdoor     431

outdoor video surveillance systems     651

Output     430, 431

output parameters     443

- P -
P 78.36.008-99     316

Page margins     519

Page Numbers     519

Page orientation     485

PAL     331

PAL system     431

Pan angle     308

Panoramic     308, 626

parameter boxes     289

parameter variation     329, 480

Parameters of 3D modeling     452

parameters of actual cameras     649

Parameters of camera model     430, 431

parameters of camera models     419

parameters of constructions     282

Parameters of Image processing     452

parameters of the camera     359, 370

Parameters of the model     404

parameters of the scene     359, 370

part of screen     507

particular view     391

passenger cars     497

Paste     169, 171, 213, 215, 419, 428, 536

Path     519

Pattern     318

Pattern criterion     318, 326

PC-based video capture system     551, 567, 570

PDF     215, 485

PDF document     215, 519

PDF files     89

PDF format     215

PDF Report     215, 519
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Peak     339

peaks     339

peak-to-peak amplitude     558

percentage     289, 507

Performance Testing of CCTV Perimeter Surveillance
Systems (Using the Rotakin Standard Test Target)    
215

permanent IR filter     431, 651

person detection     505, 531, 536, 542

Person detection area     169, 171, 213, 215, 495,
498, 534

person detection area projection     495

Person detection area projections     475

Person detection area size box     159

Person detection area, person identification area,
license plate reading area     645

person detection areas     548

person detection criteria     495

Person identification     531

Person identification area     169, 171, 213, 215, 496,
500, 534

person identification area projection     496

Person identification area projections     475

Person identification area size box     159

person identification areas     548

person identification criteria     496

person of any height     496

photometric parameters     461

photometric units     469

Physical diagonal of the Monitor window     490

Picture in Picture     370, 391, 573

PIN-HOLE lens     649

pink circle     162

pink color     162

pink grips     162

PiP     370, 391, 573, 585

PiP (picture in picture)     401

Pixel for object     318

Pixel per meter     318

pixels     507

Placement     519

Placement of images     417

Plane at the hyperfocal distance     475

Plate height     480

Plate width     480

PLT     215, 485

plus and minus keys     287

plus on the digital keypad     287

PNG     282, 485

PoE     431

Point     169, 171, 213, 215

point of origin     162

Points     215

Polyline     169, 171, 213, 215, 590

pop-up hint     159

pop-up list     289

Pop-up menu     421, 428, 444, 450

Pop-up panels     279

Position     391

Positions     215

Possible problems     671

Power (watt)     430, 431

power cable     169, 171, 213, 215, 475, 515, 590

Power cable electrical parameters and length
calculation box     159

Power cable parameters     452

power consumption     431, 562

power consumption of lamp     463

Power over Ethernet     431

Power supply     430, 431

power supply unit     551

power units     469

practical rules     651

precise drawing positioning     162

Precision in calculations     649

Predefined shortcuts     287

Preliminary monitor's adjustment     417

Press new shortcut key     479

Previous cell     408

Previous screen     408

previous VideoCAD versions     665

Print     213, 215, 354, 359, 412, 419, 425, 428, 443,
448, 450, 534

Print Color     475, 477

Print full table of camera models     425

Print width     475

Printer setup     213, 215

Printing     3

Priority     480

Processing     359, 370, 381, 430, 431

processing inside camera     381

processing parameters     381

Processing tab     536, 542, 558

processing the obtained image     370

Producer     430, 431

Producer of the model     431
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Program registration in the case of  the HID basis
 protection     665

Program registration in the case of USB dongle basis
 protection     665

Program speed problem     649

progressive     431

progressive scan     381

Project     213, 215

project export     514, 515

Project>New     534

Projection     291, 293

Projection panel     399

projections     162

projections of license plate reading area     147, 171

projections of person detection     534

projections of person detection area     147, 171

projections of person identification area     147, 171

projections of view area     289

Projector     465, 569, 570

projector illumination on an axis of radiation     569

Projector with halogen incandescent lamp     554

Protection     430, 431

Provider     430, 431

PTZ camera     431, 583

PTZH frame     359, 385, 546

- Q -
Quality level     495, 496, 497, 534, 536

Quality level box     505

quality level combo box     498, 500

quality level criteria     171

Quality level parameters box     159

Quality levels     213, 215

- R -
Radiant flux     284

Radiant intensity curve     562

radiant power     469

Radiation spectrums     472

Rain    

smoke     359, 371

Raster PDF     485

ratio parameters     289

reading     649

Real angles     308, 430, 431

Real distance     215, 533

Real frame size     359

Real illuminators     284

Real size     519

real view angles     622

Recalculate shadows     213, 215

Reciprocity     331, 431

Recommendations on the program use     649

Rectangle     169, 171, 213, 215, 529, 536

red     289

red color     162

red frame     509

red highlighted parameters     425, 431

red line     318

red lines     289

Redo     169, 171, 213, 215

Redraw 3D image only by clicking     359, 395, 480

Redrawing 3D Video     480

redrawn too slowly     480

reducing of noises     651

reflected from objects     284

Reflected light     171, 461

Reflecting ability     469

reflection factor     651

Refresh     448, 517

regions     316

registration     665

Registration box     665

registration key     665

Regulations of upgrading previous VideoCAD versions
to VideoCAD 6.0     665

reinstalling operation system     665

relative spectral efficiency factor     570

reliability requirements     293

Remote control     430, 431

removable IR filter     651

Remove     479

remove assigned shortcuts     479

removeble IR filter     431

Rename     412

rename a layout     513

RENAMINGS     89

REPORTS AS A TABLE     89

Required view area limitations     534

reserve     649

Reserve registration     665

reserve registrations     665

reserves     514, 515

resize 3D models     283
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Resol. (lp/mm)     339

Resolution     89, 318, 329, 346, 430, 431, 480, 542

Resolution (LPH)     331

Resolution (m. or ft.)     485

Resolution at distance     457

resolution decreases     651

resolution in any point     454

resolution in TV lines     558

Resolution of the lens     339

Resolution parameters     329

Resolution/Field of view     391

restoring normal width of columns     425

results of calculation     289

right part     275

Right view     343, 404

road down-grade     649

Rolling shutter     357, 375, 430, 431

Rolling Shutter effect     431

Rotakin     169, 171, 213, 215

Rotakin speed (rpm)     480

Rotate     162, 169, 171, 213, 215, 536

rotation angle in horizontal plane     284

Rotation angle/angle of radiation     284

round symmetrical light intensity distribution     465

row time     375, 430, 431, 585, 596

Ruler     215, 533

RULES OF UPGRADE     89

- S -
S/N (dB)     331, 549

S/N current     331

S/N max.     331

sacrifice some values     649

S-AGC     331, 431

Sampling     490

Save     213, 215, 425

Save and Print     354

Save as     213, 215, 354, 534

Save as *.bmp     359, 412, 536

Save as *.jpg     359, 536

Save as animated *.gif     359

Save as background     213, 215

Save as dialog box     425, 428

Save current table view     425

Save model database     425

Save project     169, 215

Save table view     448

save the drawing     215

Save the loaded camera     287

Save to camera     371, 375, 381, 385, 391

Save to project     169, 171, 213, 215

Save to selected cameras     371, 381, 385

Save view     425

Scalable     483

scalable typefaces     477

Scale     162, 169, 171, 213, 215

Scale background     213

Scale factor     485

Scale Hatching     89

Scaleable     477

scaling     275

Scaling factor when turning the mouse wheel     490

Scan     430, 431

Scan direction     430, 431

Scene     359, 370, 371, 566

scene illumination     549

Scene parameters     371, 452

scene reflection factor     331, 431

Scene tab     549

Screen     359, 385

Screen Acpect Ratio     408, 412

Screen color     475, 477

screen plane     162

screen resolution     357, 381, 385

screen resolution in Windows     573

Screen width     475

scroll bars     161

Search     419, 443

Searching by parameter value     422, 445

section area of power cable     515

segments     514, 515

Select all     213, 215, 287, 428, 450

Select all cells     428

select all objects     171, 215

Select all the objects     287

select objects     215

select objects by one     171

Select/Edit     162, 169, 171, 213, 215, 529, 536

Selected cameras     457

Selected only     511, 517

selected state     162

Selecting and editing cell     422, 445

Selecting camera (row)     445

Selecting column     422, 445

Selecting fragment     422, 445
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Selecting frame rate     575

Selecting frame rate on the basis of known target's
positions and velocities     527

Selecting model (row)     422

selection logic     287

selection window     171, 215

Send to back     213, 215

SenseLock EL-Genii     670

SenseLock EL-STD     670

Sensitivity     329, 430, 431

Sensitivity and resolution     159, 169, 171, 329, 331,
339, 359, 536, 542, 549

Sensitivity ans Resolution     213, 215

Sensitivity of black-white cameras     651

Sensitivity of cameras with standard resolution CCD    
651

Sensitivity of day/night cameras     651

Sensitivity of easy day/night cameras     651

Sensitivity of high resolution color cameras     651

Sensitivity parameters     329

sensitivity value     651

Sensor and Lens     89, 159, 291, 293, 308

sensor format     89

Sensor size panel     308

sensor sizes     308

separation of the luminance and chrominance     542

serial numeration     215

Serial numeration of cameras     159

Set     331

Set origin     162, 213, 215

Setting     395

Setting limit of electronic shutter     554

settings of the current printer     215

Setup.exe     665

Shadow     169, 213, 215, 475, 583

Shadow box     283, 590

Shadows     171, 276, 293, 401, 461

sharp+1     331, 431

sharp+2     331, 431

sharp+3     331, 431

Sharpness     381, 480, 542, 651

Sharpness area     454, 475

sharpness area bounds     454, 457, 592

sharpness area limits     536

Sharpness increasing     381

shift focus     431

shift from the lens main optical axis projection     507

shift from the projection of the main optical axis     275

Short Dash     475

Shortcuts keys     479

short-focus PIN-HOLE lens     649

Show 3D     509

Show all     213, 215, 425, 479

Show all columns     425, 428, 448, 450

show any layout     274

Show camera type     483

Show in 3D Video     415

Show loaded camera     169, 171, 213, 215

Show panel     359

Show this box before export     485

shutter     331, 431

shutter control     431

shutter speed     331

Sight direction     343, 404

signal cable     169, 171, 213, 215, 475, 514, 590

Signal cable length     452, 514

Signal cable length calculation box     159

Signal/noise (dB)     430, 431

Signal/noise (max    

weighted)     430, 431

signal/noise ratio     331, 385, 431, 549, 551, 651

signal/noise ratio (dB)     651

Simplified export     485

Simulate distortion     490

Simulating distortions     585

Simulating distortions of moving objects arising from
Exposure time, Interlace scan and Rolling shutter    
527

Size     404

Size (%)     391

Size and line type for icons of camera and illuminator  
  483

size of active area     293

size of active area of the image sensor     89, 431

size of output image     542

size of the image sensor     293, 431

Sizes     289, 430, 431

Sizes (unit)     485

SketchUP     3, 599, 611

smoothing     359, 381

Snap panel     161

Snap sensitivity     490

Snaps     276

sockets     431

Solid     475

Sony ExView HAD ™ CCD     331, 651
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Sony ExView HAD ™ sensors     469

Sony ExView HAD™ CCD     472

Sony ExView HAD™ CCD sensors     469

Sony Super HAD ™ CCD     651

Sort cameras     509

sorting     419, 443

Sorting by column data     422, 445

Space limits     480

Spacebar     215, 287

spatial resolution     89, 159, 169, 171, 213, 215, 316,
381, 580

Spatial resolution and rotation     490

Spatial resolution box     215, 316, 580

Spatial resolution criterion     316

Spatial resolution pattern     316, 326, 452

Spatial resolution patterns     519

Special sensor size     89

Specify the focus plane     592

Specifying active area size of the image sensor    
527, 636

specifying sensor size     308

spectral efficiency     463, 472, 567

Spectral efficiency factor     472, 567

spectral efficiency factors     371, 463

Spectral efficiency of IR radiation (lumen / watt)     469

Spectral efficiency of radiation     463

Spectral power distribution curve     463

spectral sensitivity     472

spectral sensitivity of cameras     331

spectrum of different light sources     494

Speed     359

Speed <> Accuracy     395, 480

Speed box     283

speed of moving 3D model     283

SPEED OPTIMIZATION     89

square grips     162

Stabilized power supply unit     570

Stairs     89, 169, 171, 215

Stand     551, 567

Standard AGC     651

Standard black-white CCD and CMOS     469, 472

Standard camera     431

Standard color sensors     469

standard of measuring sensitivity     651

standard resolution     331

Start     554, 567, 570

Start numeration on each layout     511

Starting index     511

status bar     161, 275

Step and direction of scaling     162

Step backward     343, 404

Step forward     343, 404

steradian     465, 562

Stop operation     169, 171, 536

Stop the current operation     287

Stretch another aspect ratio images     408, 412

strictly according to the criteria     649

Strike out     477

Style     475, 477

Style in Windows     477

Subject     519

Super AGC     331, 431, 651

Supply voltage     431

supply voltage and lamp parameters variation     480

SWF     215, 485

switch of time     371

switch of time in the project     359

Switch OFF illuminators     213, 215

Switch ON illuminators     213, 215

Switches and adjusments     430, 431

Synchro     430, 431

Synchronization type     431

system fonts     477

- T -
tab left part     475, 477

Table Interface     421, 422, 444, 445

Table of camera models     159, 169, 171, 213, 215,
359, 419, 422, 425, 428, 430, 431

Table of cameras     159, 169, 171, 213, 215, 443,
444, 445, 448, 450, 452, 534

Table of regions     318, 580

Table view list     425, 448

Table views     422, 445

table with all camera parameters     546

target region     391

teaching articles     155

Teaching materials     527, 645

technical conditions to measure sensitivity     651

Technical questions can be e-mailed     664

Television system     431

Temperature (C)     430, 431

test chart     359, 385, 558

test chart EIA1956     357

Test object     162, 169, 171, 213, 215, 357, 507
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Test object box     159

test object displaying     215

test object location     169, 171, 213, 215, 507

test object top     507

Text     162, 169, 171, 213, 215

Text 1     519

text boxes     289

Text report     215

Texts     162

Textures     89, 401

The button "Specify the focus plane in the vertical
projection"     457

the default lower bound     293

the part of the frame height covered by an object of the
specified height     316

The principles of CCTV design in VideoCAD     155,
645, 649

The rest shortcuts     287

Thick fog     359, 371

Thin lines     401

Thin lines of raster background     490

Three-megapixel IP camera     585

TIF     485

Tilt angle     308

tilting and panning the loaded camera     529

Time interval between fields     375

Times New Roman     519

Title     359, 385, 519

Title-Block     215

Titles     162, 213, 215, 477, 519

To selected cameras     318

Tool bar     161, 162, 421, 425, 444, 448, 489

TOOLS     89

Top view     343, 404

Total cost     430, 431

total length of cable     514, 515

total light flux of one lamp     562

Total smoothing     381

Transparence     346

Transparence box     171

Transparence of 3D images     282

transparence of Inclined rectangle     282

Transparency  of PNG     89

transparent by 70 %     171

transparent pixels     215

Troubleshoot     395

True Type     477

TrueType     519

tungsten halogen lamp     551, 560, 567, 570

TV lines     89

TV lines tab     558

TV system     430, 431

TVL     89

TV-lines     331, 431

TV-tuner     551, 567, 570

Type     430, 431

Type of current     430, 431

Type of hatching     318

Type of hatching combo box     318

type of the camera     171

typing     289

- U -
Unassigned     171

Underline     477

Undo     89, 169, 171, 213, 215

UNDO depth     490

Uninstall  driver     665

Uninstall driver     671

Unique model number     431

unweighted signal/noise ratio     359

Unweighted value     331, 431

Update     408, 412, 415

Update camera parameters     450

Update cameras of all models     428

Update cameras of the selected model     428

Updating images     417

Upgrading to VideoCAD 6.0     665

upper bound of detection area     495

USB dongle     665, 669

USB dongle basis     665

USB dongles     671

USB port     665

Used models     171, 419, 425

User forum     213

usual color     162

Utilities     89, 213, 215, 494

- V -
vandalproof     431

variants of camera placing     536

Variants of protection from unauthorized copying    
665
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varifocal lenses     293

vcm     602

Vector PDF     485

velocities     575

velocity vector     162, 283, 375, 575

velocity vectors     213, 215, 577, 585

Vert     404

Vert.(Horiz.) number of pixel     318

Vert./Hor.     318

vertical (upper) projection     162

vertical field of view size     316

vertical inclination angle     461

Vertical line     169, 171, 213, 215

vertical number of pixels     318, 498, 503

vertical number of pixels covered by an object of the
specified height     316

vertical projection     275

vertical rectangle     507

Vertical size     542

Vertical smoothing     381

vertical spatial resolution (pixels/meters, pixels/foot    
316

very clean environment     480

very subjective     649

VHS videorecorder     381

Video Drive     339

video motion detector     431, 536

video signal amplitude (IRE)     651

VideoCAD 3.0     89

VideoCAD 3.02     665

VideoCAD 4.0     89

VideoCAD 4.01     665

VideoCAD 5.0     89

VideoCAD 5.02     665

VideoCAD 6.0     89, 665

VideoCAD 6.1     89

VideoCAD 7.0     89

VideoCAD 8.1     89

VideoCAD font type     477

VideoCAD interface     159

VideoCAD Lite     31, 45, 49

VideoCAD Professional     3, 31, 45, 49

VideoCAD Starter     45

VideoCAD Starter II     49

VideoCAD Starter II Kit     45, 49

VideoCAD User's Guide     645

VideoCAD_Lite     665

Videotape recorder     293

View     213, 215, 342, 346, 359, 370, 385, 397, 401

View angle     343

view angles of  lens     293

view area     289, 496, 497

view area as two sections     89

View area bounds     475

View area edges     169, 171, 213, 215, 475

View area horizontal projection lower bound     534

view area is narrowing downwards     293

view area is narrowing upwards     293

View area length     291, 293

View area limitations     291, 293

View area lower bound     534, 536

View area lower bound distance     291, 293

view area lower bound height     326

View area lower bound width     534

View area projection bounds     169, 171, 475

View area projections     147

View area projections bounds     213, 215

View area upper bound     534, 536

View area upper bound distance     291, 293, 359,
385, 534, 536

view area upper bound height     326, 359, 385

view areas semi-transparent     611

Views     425, 448

Virt. post     385

Virtual illuminators     284

virtual post     357

virtual printer     215

virtual viewer     343, 404

visibility of additional elements     385

visibility of buttons on the Tool bar     489

Visibility of columns     422, 445

visibility range     371

Visible     276

Visible buttons     489

visible light projector     569

visible pixelization     395

Visualization of cameras' control area     580

Visualization of cameras' control area projections and
spatial resolution inside them     527

VISUALIZATION OF SPATIAL RESOLUTION AND
FIELD OF VIEW SIZE     89

VMD     430, 431

Voltage     430, 431

voltage slump     480

vPDF     485
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- W -
W (%)     519

W#H     293, 308

W*H     293, 308, 431

W:H     293, 308

Walk     89, 343, 404

Wall     169, 171, 213, 215, 280, 531, 536

warming up     570

Warranty     671

waterproof     431

watt     284

watt/m2     371, 570

watt/square meter     284

watts     469

watts/m2     469

Watts/square meter     371

watts/steradian     469

wavelength of radiation maximum     562

wavelengths     472

weather conditions     649

Weight     430, 431

weighted value     331

What's new in VideoCAD 3.0     89

What's new in VideoCAD 4.0     89

What's new in VideoCAD 5.0     89

What's new in VideoCAD 6.0     89

What's new in VideoCAD 6.1     89

What's new in VideoCAD 7.0     89

What's new in VideoCAD 8.0     89

What's new in VideoCAD 8.1     89

What's this?     155, 159

Wheel Mouse     159

white     289

white boxes     329

white paper     469, 570

whole range of heights     497

wide angle illuminator     570

wide-screen image     431

Width     282, 519

Width cutting     352

Width of view area lower bound     291, 293

Width of view area upper bound     291, 293

WINDOWS     89

Windows 2000     649

Windows 9x     649

Windows clipboard     215

Windows' clipboard     509

Windows Me     649

Windows Metafile     531, 533

Windows XP     649

Within projection     215

WMF     485

Work with Monitors     417

Working in 2D     3

- X -
X(%)     519

X/Y"     308

- Y -
Y (%)     519

yellow frame     391

your individual criteria     293

- Z -
Zero ground     147

Zoom     89, 343, 391, 404

Zoom frame     89, 343, 404

Zoom in     213, 215

Zoom in/zoom out     169, 171

Zoom out     213, 215

zooming     162
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